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Avvertenze tecniche
di sicurezza

/N
/N

Il presente manuale contiene avvertenze tecniche relative alla sicurezza delle persone e alla
prevenzione dei danni materiali che vanno assolutamente osservate. Le avvertenze sono
contrassegnate da un triangolo e, a seconda del grado di pericolo, rappresentate nel modo seguente:

Pericolo di morte

significa che la non osservanza delle relative misure di sicurezza provoca la morte, gravi lesioni alle
persone e ingenti danni materiali.

Pericolo

significa che la non osservanza delle relative misure di sicurezza puo causare la morte, gravi lesioni

alle persone e ingenti danni materiali.

i i Attenzione
significa che la non osservanza delle relative misure di sicurezza pud causare leggere lesioni alle

persone o lievi danni materiali.

Avvertenza

€ una informazione importante sul prodotto, sull'uso dello stesso o su quelle parti della
documentazione su cui si deve prestare una particolare attenzione.

Personale qualificato La messa in servizio ed il funzionamento del dispositivo devono essere effettuati solo in base alla

descrizione del manuale.

Interventi nel dispositivo vanno effettuati esclusivamente da personale qualificato. Personale
qualificato ai sensi delle avvertenze di sicurezza contenute nella presente documentazione & quello
che dispone della qualifica a inserire, mettere a terra e contrassegnare, secondo gli standard della
tecnica di sicurezza, apparecchi, sistemi e circuiti elettrici.

Uso conforme alle Osservare quanto segue:
disposizioni
i i Pericolo
Il dispositivo deve essere impiegato solo per 'uso previsto nel catalogo e nella descrizione tecnica e

solo in connessione con apparecchiature e componenti esterni omologati dalla Siemens.

Per garantire un funzionamento ineccepibile e sicuro del prodotto & assolutamente necessario un
trasporto, immagazzinamento, una installazione ed un montaggio conforme alle regole nonché un uso
accurato ed una manutenzione appropriata.

Marchio di prodotto SIMATICY, SIMATIC NET" e SIMATIC HMI™ sono marchi di prodotto della SIEMENS AG.

Tutte le altre sigle qui riportate possono corrispondere a marchi, il cui uso da parte di terzi, puo violare i

diritti di proprieta.

Copyright © Siemens AG 1997 All rights reserved

Laduplicazione e la cessione della presente documentazione sono
vietate, come pure I'uso improprio del suo contenuto, se non dietro
autorizzazionescritta. Le trasgressionisonopassibilidirisarcimento
dei danni. Tutti i diritti sono riservati, in particolare quelli relativi ai
brevetti e ai marchi registrati.

Siemens AG

Bereich Automatisierungs- und Antriebstechnik
Geschaeftsgebiet Industrie-Automatisierungssysteme
Postfach 4848, D-90327 Nuernberg

Esclusione della responsabilita

Abbiamo controllato che il contenuto della presente documenta-
zione corrisponda all’hardware e al software descritti. Non potendo
tuttaviaescludere eventualidifferenze, non garantiamounaconcor-
danzatotale. Il contenuto della presente documentazione viene co-
munque verificato regolarmente, e le correzioni o modifiche even-
tualmente necessarie sono contenute nelle edizionisuccessive. Sa-
remo lieti di ricevere qualunque tipo di proposta di miglioramento.

© Siemens AG 1997
Ci riserviamo eventuali modifiche

Siemens Aktiengesellschaft

6ES5998-0MA54
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Il presente manuale intende
e llustrare i concetti fondamentali del software di base e
* presentarne le principali funzioni.

Il software per la configurazione e la programmazione dei sistemi di automazione SlI-
MATIC S5 é stato creato secondo moderni principi ergonomici. Il suo funzionamento
e di facile apprendimento e ampiamente autoesplicativo.

Le singole istruzioni contengono anche la descrizione dei relativi comandi menu. Si
€ rinunciato a riportare consigli su come compilare le finestre di dialogo, poiché con-
tenuti nella Guida online.

Il presente manuale si rivolge a installatori, programmatori e personale addetto
all'assistenza che non dispongono di esperienza con il pacchetto software
STEP 5/ST, Versione 7.0.

Il presente manuale si riferisce al software di programmazione STEP 5/ST, Versione
7.0, al pacchetto software di base STEP 5 e costituisce la base per i software
opzionali.

Il software STEP 5 soddisfa i requisiti della norma DIN EN 61131-3 (int. IEC 1131-3) rela-
tiva ai linguaggi di programmazione per i controllori programmabili.

Il procedimento per l'installazione e I'autorizzazione del software STEP 5 € stato in-
trodotto in questo manuale. Queste informazioni sono illustrate nel capitolo 3 ed an-
che nelle informazioni di prodotto/File Leggimi.

Il presente manuale € suddiviso nelle seguenti sezioni:

¢ |a prima parte contiene informazioni sui concetti e le manovre fondamentali del
software di base per S5/ST nonché sulle operazioni preliminari per la pro-
grammazione. Si consiglia di leggere i primi quattro capitoli primi di iniziare a
lavorare;

* nella parte 2 sono descritte le modalita operative dell’editor nella lingua
specifica;

* |a parte 3 descrive il test, la gestione e la documentazione dei progetti;

* nella parte 4 sono descritte le modalita operative di speciali programmi
SIMATIC S5;



Avvertenze importanti

Convenzioni

Guida online

Supporto

Aggiornamento
costante delle
informazioni

e per facilitare I'apprendimento dello STEP 5/ST e 'operativita con questo pac-
chetto software, nella parte 5 & riportata un’applicazione esemplificativa. Ba-
sato sul tema "Comando di un impianto di lavaggio auto”, viene illustrato,
passo dopo passo, come editare, testare, documentare ed archiviare il relativo
programma;

¢ |a parte 6 offre una panoramica relativa alla gestione dati all'interno dello
STEP 5/ST.

Se si € gia realizzato un progetto, avendo acquisito in tal modo una certa
dimestichezza, ci si potra informare sullargomento di interesse leggendo,
separatamente uno dall’altro, i singoli capitoli del manuale.

I rimandi ad ulteriore documentazione sono indicati mediante un numero compreso
tradue barre/.../. Sulla base di questi numeri nell’'ultima parte del manuale & possibile
risalire al titolo esatto della documentazione.

Oltre al manuale e disponibile una Guida online integrata nel software che costituisce
un valido supporto attivabile richiamando il menu "Help” o premendo il tasto F1 o il
tasto F8 nel corso del lavoro.

Per ulteriori informazioni sulluso del software, che non sono contenute nella
documentazione su carta o nella Guida online, rivolgersi al personale di assistenza
presso le filiali e le rappresentanze Siemens. Gli indirizzi si trovano nell’appendice
di /70/ e di /100/, nei cataloghi e nel Compuserve (go autforum)

Per contattare il SIMATIC Customer Support telefonare al numero +49 (911)
895-7000 o inviare un fax al numero +49 (911) 895-7002. Eventuali richieste possono
essere inoltrate anche per mail tramite Internet oppure alla mailbox sopraindicata.

Nel caso di domande o commenti sul manuale, compilare il questionario che si trova
in fondo e spedirlo all'indirizzo indicato. E gradita anche una valutazione personale
del manuale stesso.

Per facilitare I'apprendimento del sistema di automazione SIMATIC S5, la Siemens
organizza dei corsi specifici. Per maggiori informazioni, rivolgersi al centro di
addestramento regionale o al centro di addestramento centrale in Germania:

D-90327 Norimberga, Tel. +49(911) 8953154.

Le informazioni relative ai prodotti SIMATIC vengono costantemente aggiornate e
sono accessibili:

* su Internet, all'indirizzo http://www.ad.siemens.de/simatic
¢ mediante fax polling n. 08765-93 02 77 95 00

Il SIMATIC Customer Support garantisce inoltre assistenza grazie a informazioni
attuali e download che possono essere di aiuto nell'utilizzo dei prodotti SIMATIC:

* su Internet, all'indirizzo
http://www.ad.siemens.de/support/htm|-00/

¢ tramite la mailbox del SIMATIC Customer Support, al numero
+49 (911) 895-7100

Per selezionare la mailbox, utilizzare un modem che abbia fino a V.34 (28,8 kBaud)
i cui parametri vanno impostati nella maniera seguente: 8, N, 1, ANSI, oppure colle-
garsi tramite ISDN (x.75, 64 kBit).

STEP 5/ST V7.0
C79000-G8572-C920-02
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Presentazione del prodotto 1

1.1 Contenuto di fornitura di STEP 5/ST V7.0

Sommario

Fornitura con il PG

L'esatta composizione della fornitura del software di sistema si puo leggere nelle infor-
mazioni sul prodotto fornite. Le informazioni sul prodotto vengono fornite assieme al
PG oppure assieme ai prodotti di STEP 5.

Il software di sistema Windows 95, STEP 5, Versione 7, ecc. &, ad esempio nel PG
740 depositato sul disco fisso in forma compressa e in cinque lingue; un fatto vantag-
gioso perl'utente che pudimpiegareil proprio software STEP 5 sul PG solodopo poche
operazioni di base.

1.2  Varianti rispetto alla versione 6.x

Sommario

Espansioni
funzionali

STEP 5/ST V7.0
C79000-G8572-C920-02

Con l'introduzione dello STEP 5/ST V7.0 viene offerto lo stesso pacchetto software
sia per PG che per PC. Per entrambi i sistemi di destinazione il pacchetto STEP 5/ST
prevede una protezione contro la riproduzione.

In STEP 5 V7.0 sono state effettuate modifiche ed espansioni funzionali, illustrate in
seguito, che sono:

¢ richiamo diuna Shell DOS all'interno dello STEP 5/ST; richiamo di comandi DOS,
senza uscire dallo STEP 5;

¢ funzionalita su server. L'autorizzazione deve essere installata anche sui disposi-
tivi locali;

¢ ['Editor AWL/Batch Compiler & compreso nella fornitura dello STEP 5/ST.
e Commutazione della lingua all'interno dello STEP 5;

¢ storia (funzione ripetuta) per campi d’'ingresso nei box di dialogo e nella manipola-
zione del progetto;

* sintassi ampliata per la lista dei blocchi (omogeneita per tutte le funzioni come
Editor e Stampante);

¢ annotazione del pacchetto opzionale selezionato; nel caso I'utente I'abbia sele-
zionato nella impostazione del progetto, ad un nuovo start dello STEP 5 puo es-
sere avviato automaticamente I'ultimo pacchetto opzionale attivo;

11
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* annotazione nel menu degli ultimi 5 file progetto utilizzati;
¢ ampliamento delle funzioni di Help e di Info nei menu e nei box di dialogo;
* integrazione nel menu della impostazione dei colori;

* integrazione nel menu dei pacchetti COM, che possono essere richiamati diretta-
mente nel menu a discesa Cambio come avviene gia per GRAPH 5/11;

* ¢’ orapossibile la stampa dei richiami FB anche in assenza e la stampa di gruppi
di blocchi.

Uso ergonomico L'uso ergonomico € stato migliorato:
e strutture di menu piu semplici: in genere soltanto 2 livelli;

* nuovi tasti veloci e hotkey; supporto dei tasti di commutazione SHIFT, CTRL e
ALT nei menu e nei box di dialogo;

* armonizzazione dei box di dialogo: struttura omogenea dei box di dialogo; suddi-
visione secondo Sorgente, Destinazione, Emissione e Opzioni;

* impostazione progetto come "schedario”; 'impostazione dei progetti € stata sem-
plificata, ampliata, configurata in modo chiaro e ordinata secondo temi, come
p.es.: AG, Blocchi, Simbolico, Documentazione, Eprom e Opzioni.

Prestazioni Le prestazioni sono state sostanzialmente potenziate:

* richiamo veloce e diretto degli Editor: possono essere richiamati direttamente
dall'impostazione progetto, dall'indice e dal REG.INT;

* integrazione del driver Eprom nel pacchetto base STEP 5/ST: il driver Eprom non
deve piu essere caricato residente nella RAM all'avviamento del PC/PG;

* rielaborazione dell’Editor per la Selezione Vie bus;
¢ miglioramento del tool di installazione;
¢ riduzione dello spazio necessario in memoria (RAM convenzionale);

* aumento delle prestazioni mediante tempi di caricamento ridotti.

Moderna L'architettura e stata rielaborata:
architettura DOS ¢ reale applicazione DOS;
¢ utilizzo dei percorsi DOS;
* abolizione della limitazione dei drive (non per i vecchi pacchetti COM);

e Utilizzo della memoria estesa (XMS e EMS).

STEP 5/ST V7.0
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Sommario

Sommario del
capitolo
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Il presente capitolo serve da guida per:

¢ [installazione del pacchetto di base STEP 5

¢ |a definizione del proprio ambiente di lavoro

* |a gestione dell’autorizzazione e del diritto d’'uso
¢ [installazione dell’hardware per STEP 5

¢ [|'operativita dei pacchetti COM

¢ le problematiche di compatibilita

Capitolo Argomento trattato Pagina
2.1 Requisiti software per l'installazione 2-2
2.2 Requisiti hardware per l'installazione 2-2
2.3 Programma di installazione INSTALL 2-3
2.4 Procedimento di installazione 2-7
2.5 STEP 5/ST V 7.0 su CD-ROM 2-19
2.6 Particolarita 2-20
2.7 Autorizzazione 2-25
2.8 Installazione dell’hardware per STEP 5 2-27
2.9 Utilizzo dei pacchetti COM 2-43
2.10 Compatibilita 2-44
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2.1 Requisiti software per l'installazione

Sistemi operativi

CONFIG.SYS

Windows 95
SYSTEM.INI

AUTOEXEC.BAT

Per poter utilizzare STEP 5/ST V7.0 si deve inoltre disporre almeno del sistema
operativo MS-DOS 5.0 . Si possono utilizzare:

* versioni MS-DOS successive,
e Windows 3.x e
e Windows 95.

WINDOWS NT non viene supportato.

Si raccomanda vivamente di introdurre nel file CONFIG.SYS i seguenti comandi e
parametri per STEP 5/ST V7.0:

DEVICE = C:\DOS\HIMEM.SYS

DOS = HIGH,UMB

DEVICE = C:\DOS\EMM386.EXE RAM NOEMS
FILES = 32 (deve essere . 32)

BUFFERS = 20

Se si utilizza Windows 95 & possibile inserire la seguente stringa nella sezione
[386ENh] del file SYSTEM.INI:

LocalLoadHigh=True

Questa stringa dovrebbe essere utilizzata solo se si verificano problemi di memoria
con i pacchetti COM. Questo parametro non € valido per il pacchetto base STEP 5.
Questa stringa non viene creata automaticamente dal programma di installazione,
perché potrebbe impedire I'avvio corretto del sistema.

STEP 5/ST V7.0 viene avviato richiamando il file S5.BAT dalla directory home
(nell'installazione standard DRASTEP5\S5_HOME) .

IIfile AUTOEXEC.BAT deve contenereiseguenticomandie parametriper STEP 5/ST
V7.0:

PATH C:\;C:\DOS;C:\STEP5\S5_HOME;
SET S5_HOME= C:\STEP5\S5_HOME
SET S5_SYSTEM= C:\STEP5\S5_SYS

Le stringhe vengono inserite o integrate dal programma di installazione.

Se si specifica la directory STEP 5 nelllistruzione PATH del file AUTOEXEC.BAT &
possibile eseguire I'avvio da una directory qualsiasi.

Perfareinmodocheidriverdirete SIMATIC NET venganorichiamatiautomaticamente,
si deve modificare il file AUTOEXEC.BAT con I'apposito programma S5DRV.BAT.

2.2  Requisiti hardware per l'installazione

Sommario

2-2

STEP 5/ST V7.0 per PC puo essere installato in dispositivi PC/AT 03 compatibili.
L'ampliamento della memoria deve prevedere uno spazio di memoria XMS di almeno
di 3 Mbyte = 4 Mbyte RAM.

Se si usano i tool P si deve eventualmente disattivare il disk cache controller.

STEP 5/ST V7.0
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2.3 Programma di installazione INSTALL

Sommario L'installazione viene eseguita con il programma Install.exe, che nel seguito verra
chiamato INSTALL. INSTALL, & un programma MS-DOS guidato damenu ed € quindi
eseguibile anche nella finestra DOS in Windows 3.x e Windows 95.

231 Prima di avviare l'installazione

Premesse Il dispositivo di programmazione deve disporre del drive C: nel quale INSTALL creera

STEP 5/ST V7.0
C79000-G8572-C920-02

le directory

C:\S5_INFO e
C:\SINEC .

INSTALL cerchera inoltre in questo drive i file di configurazione

C:\CONFIG.SYS e
C\AUTOEXEC.BAT.

Se il file C:AAUTOEXEC.BAT non e presente, INSTALL lo crea.

Per poter eseguire INSTALL il dispositivo di programmazione deve disporre dialmeno
400 Kbyte di memoria di lavoro MS-DOS libera.

Il programma di installazione ha bisogno della variabile d’ambiente TMP. In Windows
95 tale variabile viene impostata automaticamente, in Windows 3.x ein MS-DOS deve
essere impostata nel file di configurazione CAAUTOEXEC.BAT e deve puntare ad
una directory per dati temporanei (ad es. SET TMP=C\TMP).

Per la corretta rappresentazione dei caratteri semigrafici € consigliabile configurare
un driver ANSI nel dispositivo di programmazione. Verificare quindi che il driver DE-
VICE=ANSI.SYS sia caricato nel file di configurazione CONFIG.SYS

Quando si avvia il programma nella finestra DOS di Windows & consigliabile attivare
lavisualizzazione aschermointero, in modo danon nasconderne alcune parti. Questa
particolarita viene presa in considerazione anche nel file INSTALL.PIF fornito.

Prima di avviare linstallazione dal server si deve eventualmente eliminare la
protezione dalla scrittura delladirectory disistemadi STEP 5/ST del server utilizzando
le funzioni disponibili nel proprio sistema operativo. Se necessario, la protezione dalla
scrittura puo essere ripristinata dopo aver eseguito l'installazione.
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2.3.2 Operativita

Interfaccia INSTALL puo essere gestito siatramite mouse che tramite tastiera. Occorre fare atten-
operativa zione alle informazioni sull’'uso della tastiera al capitolo|2.8.6.

| awwo =) O [@f B3] == A

STEPS5/ST V7.00 INSTALL

Figura 2-1 Esempio di una maschera operativa

STEP 5/ST V7.0
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2.3.3 Awvio dell'installazione

Varianti all'avvio Per richiamare I'installazione, inserire il dischetto STEP 5/ST V7.0 Disk #1 nel drive
A:, passare al drive A: e avviare il programma INSTALL.

Tabella2-1  Possibilita di installazione

Sistema operativo Passi operativi

Richiamo in DOS A:
INSTALL

Awviare il file manager
selezionare A:
fare doppio clic su INSTALL.EXE

Awviare la Gestione risorse
selezionare A:
fare doppio clic su INSTALL.EXE

Selezionare il drive CD-ROM
Selezionare la directory STEP5.INS
Introdurre il richiamo INSTALL

Richiamo in WINDOWS 3.x

Richiamo in WIN95

Richiamo da CD

whpPRlwbhR whdE NP

INSTALL riconosce autonomamente il sistema operativo in cui & stato avviato

Sintassi per il ri- La sintassi completa per il richiamo dell'installazione ¢ la seguente:

chiamo INSTALL [/h<path>] [/s<path>] [/m] [/c] [/7]

Tabella 2-2  Parametri del comando di INSTALL

Parametro Descrizione

[/h<path>] Questo parametro consente di impostare il nome della directory
home di STEP 5/ST, sovrascrivendo I'impostazione standard
\STEPS. La directory home viene completata internamente con
il nome costante \S5_HOME!

[/s<path>] Questo parametro consente di impostare il nome della directory
di sistema di STEP 5/ST, sovrascrivendo I'impostazione
standard \STEP5. La directory di sistema viene completata
internamente con il nome costante \S5_SYS!

[/m] Questo parametro va utilizzato se il dispositivo di
programmazione e collegato ad uno schermo monocromatico.
INSTALL ottimizzera la visualizzazione dei menu in bianco e
nero.

Se esiste gia una directory home STEP 5/ST con un nome
uguale a quello impostato da INSTALL e se in tale directory si
trova il file @@ @@ @ @FT.DAT, INSTALL avviera
automaticamente il programma in bianco e nero. Cio non
avviene se e stato selezionato il parametro di richiamo /c.

[/c] Colore. E limpostazione di default del programma di
installazione. Consultare le indicazioni relative al parametro /m.

[/?] Questo parametro consente di visualizzare I'elenco dei
parametri di avvio disponibili.

STEP 5/ST V7.0
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2.3.4 Conclusione dell'installazione

2.35 Protocollo

Sommario

Come emettere
informazioni
dettagliate

"Guida online”

2-6

L'installazione puo essere conclusa in uno dei seguenti modi:
¢ dal menu eseguendo i comandi Annulla » Fine, oppure
¢ direttamente con la combinazione di tasti Ctrl + C

Sinoti che interrompendo il programma con Ctrl + Cl'installazione potrebbe risultare
incompleta. Se si vuole utilizzare STEP 5/ST dopo aver eseguito tale comando, si
consiglia di installarlo nuovamente.

Le fasi dell'installazione vengono registrate in un protocollo. Il relativo file Install.log
viene creato nella directory a cui punta la variabile d’'ambiente TMP. Se nel dispositivo
di programmazione non € stata configurata la variabile TMP, il file LOG viene scritto
in C:\.

Nelfile LOG vengono registrati tuttii messaggi del sistema operativo e del programma
di decompressione. Se si verificano degli errori durante I'installazione, si deve aprire
il file INSTALL.LOG con un editor di testi e controllarne il contenuto.

Il file LOG viene sovrascritto ad ogni installazione.

Dopo aver installato il software, nella directory C:\S5_INFO\File sitrovano file del
tipo *TXT (ad es. STEP5IL.TXT) oppure del tipo *WRI (ad es. SSPRODI.WRI). Con
I'apposito Editor (ad es. con EDIT o WordPad) & possibile leggere e stampare. Questi
file contengono informazioni dettagliate relative ai singoli componenti software.

Esempio: Con il comando MS-DOS
TYPE STEPS5I.TXT | MORE
€ possibile I'emissione a pagine del file STEPS5I.TXT .

E possibile digitare comandi MS-DOS con I'opzione /? per ottenere breviinformazioni
sulle funzioni e le opzioni consentite.

In Windows si ottiene in qualsiasi momento una guida attuale azionando il tasto F1.
E inoltre possibile richiedere informazioni mediante le registrazioni nel ment Help.

Anche in STEP 5 si ottiene una guida attuale nei PG azionando il tasto SHIFT + F8
oppure il tasto Help (PG 730/750/770).

Nel PG 720/740 questo tasto Help e sostituito dal tasto F, + F1.

STEP 5/ST V7.0
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2.4 Procedimento di installazione

Passi per L'installazione del software STEP5/ST avviene in piu passi.
l'installazione
Lingua
Tipi d’installazione
Standard Personalizzata Server Pool di dati
|
\ |
Locale ta
Server
Drive di Directory Directory
Destinazione SR di S EE
destinazione sorgente
Directory
home
WIN/DOS
Windows | DOS
Directory Directory Drive di
Windows sistema di destinazi
indow: e estinazione
"Esegui”
awvio
Fine
Figura 2-2  Procedimento di installazione

STEP 5/ST V7.0
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24.1 Scelta della lingua di dialogo

Il software di installazione e lo STEP5/ST sono in cinque lingue. Prima dell'installa-
zione vera e propria dello STEP5/ST, il programma d’installazione richiede la scelta
della lingua di dialogo desiderata. Nella fornitura standard sono disponibili 5 lingue.

[ ]} Bitte wéhlen Sie Ihre Dialogsprache !
[ ] Select your dialog language !

Vetillez choisir votre langue !
[ ]

Elija el idioma deseado, por favor

Scegliete la vostra lingua !

Figura 2-3  Scelta della lingua

Per la selezione si possono utilizzare il mouse, i tasti cursore su/giu o il tasto di
tabulazione . INSTALL visualizza la lingua di sistema del dispositivo di
programmazione configurata in COUNTRY=. Se COUNTRY non & stata impostata
viene scelto per default I'inglese.

1. Scegliere la lingua desiderata.
2. Premere F6 = Avanti per continuare con l'installazione.

Dopo la scelta della lingua di dialogo, il menu di guida appare nella lingua scelta. |l
Software STEP5/ST & sempre strutturato in cinque lingue .

2.4.2 Tipi di installazione

2-8

Sono disponibili quattro tipi di installazione. In questo modo I'utente pud personaliz-
zarsi il proprio ambiente di lavoro.

Con il tasto d'inserimento /ns oppure con il tasto funzionale F6 = Avantisi entra nella
maschera di base del programma di installazione. Qui € possibile decidere quale tipo
di installazione eseguire.

Selezionare il tipo di installazione

Standard Installazione completa nelle directory standard.
Personalizata Installazione personalizzata.

Server Trasferimento dei dati di sistema in un server.

Pool di dati Copia dei dischetti STEP 5/ST in un disco rigido.

Figura 2-4  Tipi di installazione

STEP 5/ST V7.0
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2.4.3 Installazione standard

Modifica del drive
di destinazione

STEP 5/ST V7.0
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Ilmodo piuveloce per ottenere un’installazione completa dello STEP5/ST sul disposi-
tivo di programmazione € quello di selezionare la voce di menu Standard.

Nell'installazione standard i nomi delle directory peridatidi STEP 5/ST sono impostati
per default e non possono essere modificati dall’'utente.

Sono disponibili i seguenti nomi delle directory di default:

Definizione Percorso Contenuto
Directory di sistema |C:\STEP5\S5_SYS STEP 5 /ST dati di sistema
Directory home C:\STEP5\S5_HOME |STEP 5 /ST dati di dispositivo

L'utente pud modificare solo la directory di destinazione di default.

Nell'installazione standard viene dapprimarichiesto di confermare o modificareil drive
di destinazione indicato per i dati STEP5/ST.

Specificare il drive di destinazione:

Figura 2-5  Selezione drive per installazione normale

Il drive selezionato, prima dell’abbandono della maschera, viene verificato per quanto
concerne I'idoneita relativa all'installazione dello STEP5/ST. La directory deve soddi-
sfare i seguenti criteri:

¢ il drive deve essere presente e pronto (ad es. supporto di trasferimento dati
inserito)

¢ [|'utente deve avere il diritto di accesso in scrittura alla directory
(nessun CD-ROM)

¢ il drive deve disporre di uno spazio di memoria sufficiente.

Se tali criteri non vengono soddisfatti, compaiono delle finestre con il relativo
messaggiodierrore.Inquestocasooccorre selezionare unaltrodrive oppure eliminare
le manchevolezze e riavviare nuovamente l'installazione.
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Integrazione
Windows

2-10

Avvertenza

E sconsigliabile scegliere un drive superiore a P:. STEP 5/ST pud essere
eseguito in qualsiasi drive, ma non tutti i pacchetti COM (menu Cambio di
STEP 5/ST) supportano drive superiori a P:. Se si seleziona un drive superiore a
P: che soddisfa i criteri descritti pill sopra, compare il relativo messaggio.

Se si esegue l'installazione nella finestra DOS del sistema operativo Windows 3.x
o0 Windows 95, nelle due maschere successive INSTALL chiede se sivuole integrare
STEP 5/ST in Windows. Se si stalavorando in MS-DOS senza aver avviato Windows,
le maschere non vengono visualizzate.

Installazione standard

Integra STEP 5/ST nell'interfaccia Windows.

[.l Non integrare in Windows.

Selezionare "Windows" se nel dispositivo di programmazione é presente
il sistema operativo Windows 3.x 0 Windows 95.
STEP 5/ST viene integrato nell'interfaccia di Windows e nei file di sistema di Windows.

Selezionare "DOS” se non si vuole integrare STEP 5/ST
nellinterfaccia di Windows.

Figura 2-6 Integrazione in Windows

Nella prima maschera viene chiesto se si vogliono integrare le icone di avvio di
STEP 5/ST nell'interfaccia utente di Windows. Se siseleziona Windows, il programma
eseguira le seguenti operazioni:

Si lavora con il sistema operativo Windows 95

* | programmi STEP 5/ST vengono inseriti nel sottomenu Simatic\Step5v70 del
menu di avvio di Windows. I file PIF dei programmi vengono copiati dalla directory
di sistema di STEP 5/ST nella directory del menu di avvio di Windows e adattati
ai nomi attuali delle directory home e di sistema di STEP 5/ST e di Windows,

e Un menu di awio Step5v7.0 gia esistente viene dapprima salvato come
Step5v70.~xx

Si lavora con il sistema operativo Windows 3.x

* | programmi STEP 5/ST vengono inseriti nel nuovo gruppo di programmi
STEP 5 V7.0 del Programm Manager di Windows. | file PIF dei programmi
vengono copiati dalla directory di sistema di STEP 5/ST nella directory di
Windows e adattati ai nomi attuali delle directory di sistema e home di STEP 5/ST
e Windows,

STEP 5/ST V7.0
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Adattare il file

gruppo
STEP5V70.GRP

Introduzione della
directory di
Windows

STEP 5/ST V7.0
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e |l file di sistema Step5v70.grp viene salvato come Step5v70.~xx e di nuovo
trasferito dalla directory di sistema STEP5/ST

¢ |l file di sistema di Windows Progman.ini viene salvato come Progman.~xx e
quindi completato con la nuova registrazione di menu Step5v70.

Avvertenza

Sotto Windows 3.x viene definito il file di gruppo per l'icona di avvio del pro-
gramma STEPS5/ST solo per I'impostazione della directory standard C:\STEP5\...

IIfile STEP5V70.GRPnon pud essere ulteriormente adattato da INSTALL. Se l'utente
ha modificato il drive di destinazione o i nomi delle directory, una volta conclusa
l'installazione dovra modificare manualmente il file STEP5V70.GRP nel Programm
Manager di Windows 3.x.

Per apportare tale modifica, scegliere nel menu File » Sottomenu » Nuovo... la
creazione di un nuovo gruppo di programmi e specificare come descrizione
STEP 5 V7.0ecomefiledelgruppoilseguente nomeelerelative directory diWindows:

dr:\Windows\STEP5V70.GRP
(per dr:\Windows  indicare la directory di Windows attuale).

Quando si confermano le modifiche nella finestra del Programm Manager compare
il gruppo STEP 5 V7.0 con le icone per I'avvio di STEP 5/ST.

Se si seleziona DOS queste operazioni non vengono eseguite.

Nella seconda maschera viene richiesto di confermare o specificare la directory di
Windows. INSTALL ha gia analizzato la configurazione del dispositivo di
programmazione e propone la directory di Windows attuale. L'impostazione di default
dipendedallavariabile d'ambiente WINDIR. Se quest’ultimanon esiste viene proposto
C:\Windows .

Installazione standard

Figura 2-7 Integrazione in Windows
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Esecuzione
dell'installazione

2-12

La directory di Windows scelta viene esaminata non solo per controllarne la sintassi,
come indicato nel capitolo Editazione delnome delle directory, maanche per verificare
che soddisfi i seguenti criteri:

* deve essere disponibile
e deve contenere il file Win.com.

Se questi criteri non vengono rispettati, compare il relativo messaggio d’errore. In
guesto caso si dovra selezionare la directory di Windows valida oppure passare alla
mascheraprecedente e selezionare lavoce dimenu DOS per annullare I'integrazione
in Windows.

Nella maschera di Avvio installazione standard si ottiene una visione riassuntiva del
tipo di installazione selezionato.

Sono visualizzate le directory in cui verra eseguita I'installazione, dopo aver premuto
il tasto funzionale F6 = Avanti.

Esecuzione - Installazione standard

Installazione nelle seguenti directory di destinazione

System =C:\STEP5\S5_SYS
Home =C:\STEP5\S5_HOME
SINEC =C:\SIENC\BIN

Info =C:\S5_INFO
Windows =C:\WIN.95

| file di configurazione AUTOEXEC.BAT e CONFIG.SYS e PROGMAN.INI, STEP5.GRP e
S5* PIF vengono integrati con i dati necessari per STEP 5/ST.

Viene eseguita una copia di backup dei file di configurazione e dei file home
(per ulteriori informazioni premere <F1>).

Figura 2-8  Awvio installazione

Durante l'installazione del sistema, nella finestra Installazione in corso ... compaiono
i nomi degli archivi di STEP 5/ST che vengono decompressi. Durante l'installazione
home viene visualizzata la finestra Installazione in corso, attendere.

Gli archivi di STEP 5/ST sono autoscompattanti. Il programma di decompressione
trasmette a INSTALL i seguenti messaggi di errore in una finestra:

e DISK_FULL,
e CTRL_C_ABORT,
* e il messaggio d’errore cumulativo ZIP_ERROR.

Se si verifica un errore nel programma di compressione, si deve eliminare la causa
e ripetere l'installazione. Nella ricerca dell'errore pud essere utile aprire il file di
protocollo Install.log con un editor ditesti e prendere visione del suo contenuto (vedere
il capitolo 2.3.5).

STEP 5/ST V7.0
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Conclusione
dell'installazione

Operazioni alla
fine
dell'installazione

STEP 5/ST V7.0
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Se siinstalla il pacchetto STEP 5/ST dai dischetti, dopo aver installato il contenuto
diun dischetto compare larichiesta diinserire il dischetto seguente. INSTALL verifica
che sia il dischetto corretto e, in caso contrario, ripete la richiesta.

A conclusione dell'installazione viene visualizzata una mascheradifine installazione.

Conclusione dell'installazione

Per consultare le informazioni piti aggiornate su questa versione,
premere il tasto funzione <F1>.

Per poter utilizzare il dispositivo di programmazione in una rete SINEC,
caricare i driver H1, L2. Premere il tasto funzione <F2>.

STEP 5/ST e eseguibile solo con I'apposita autorizzazione.
L'autorizzazione puo essere installata al termine dell'installazione
utilizzando I'apposito dischetto!

Le impostazioni effettuate diventano attive al successivo awvio
del dispositivo di programmazione.
Estrarre ['ultimo dischetto di installazione e avviare nuovamente il dispositivo di programmazione!

Readme S5DRV

Figura2-9  Conclusione dell'installazione

Premendo il tasto funzione F1, INSTALL richiama il file STEP5x.TXT (la x indica il
codice della lingua) che contiene le informazioni pit recenti sulla versione di STEP
5/ST installata.

Si puo far scorrere il testo in avanti e indietro riga per riga o pagina per pagina.
Si possono stampare sia un’unica videata che l'intero file.

Dopo un’installazione standard o personalizzata locale si possono caricare i driver
DOS H1 o L2 per la rete SINEC premendo il tasto funzione F2. INSTALL passa nel
programma S5DRV di STEP 5/ST per il caricamento dei driver MS-DOS, che puo
essere richiamato anche separatamente.
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24.4 Installazione personalizzata

Installazione per-
sonalizzata locale

2-14

Nell'installazione personalizzata la parte variabile dei nomi delle directory (ad es.
C:\Step5 ) per i dati di STEP 5/ST pu0 essere scelta liberamente dall’'utente.
INSTALL la completera con la parte invariabile (\S5_SYS e \S5_HOME).

Nella primainstallazione di STEP 5/ST V7.x sono impostati per defaulti seguenti nomi
di directory:

Definizione Percorso Contenuto
Directory di sistema |C\STEP5\S5_SYS dati di sistema STEP 5 /ST
Directory home C:\STEP5\S5_HOME |dati di dispositivo STEP 5 /ST

In ciascuna installazione successiva entrambi i nomi verranno ricavati dalle variabili
d’ambiente di STEP 5/ST S5_SYSTEM e S5_HOME impostate nell'installazione pre-
cedente.

Nell'installazione personalizzata si pud procedere in due modi. Si puod scegliere tra:

* un’'installazione locale completa dei dati di sistema o dei dati di dispositivo
oppure

* un’installazione integrativa dei dati di dispositivo da un server nella directory
home locale

Installazione personalizzata

[X] Locale Installazione completa.
[] dalserver Installazione dati dispositivo.

Selezionare 'Locale’ per effettuare l'installazione completa di STEP 5 in directory
impostabili in un dispositivo di programmazione.

Selezionare 'dal server’ se i dati di sistema sono gia disponibili in un server di rete e
si vogliono installare solo i dati del dispositivo nel dispositivo di programmazione locale.

Figura 2-10 Modalita di installazione

Se e stato selezionato Installazione personalizzata locale, confermare o specificare
in questa maschera la directory di destinazione del PG per i dati di sistema di
STEP 5/ST.

STEP 5/ST V7.0
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Installazione per-
sonalizzata dal
server
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Installazione personalizzata locale

Indicare una directory di sistema

[C:/STEPS5]

Installare i dati di sistema di STEP 5/ST nella directory di sistema del dispositivo
di programmazione o scegliere una directory diversa.

Verifica della convenzione MS DOS (8.3), dell'accessibilita in scrittura e della
memoria libera nel drive della directory di sistema impostata.

Figura 2-11 Installazione personalizzata locale

Se € stato selezionato Installazione personalizzata dal server confermare o
specificare in questa mascheraladirectory sorgente (solitamente una sorgente di dati
che sitrova in un server), dalla quale prelevare i dati di dispositivo di STEP 5/ST per
l'installazione nel PG locale.

Selezionare dal server se si vogliono installare i dati di dispositivo dello STEP 5/ST
in una directory home sul dispositivo di programmazione. In questo caso i dati di si-
stema devono gia essere presenti.

Disolitoidatidisistema STEP 5/ST sono disponibili su un server, al quale il dispositivo
di programmazione é collegato mediante una rete (vedere il paragrafo Installazione
server).

Installazione personalizzata dal server

Indicare la directory di sistema

[C:/STEP5]

Indicare dove si trova la directory di sistema centrale da cui il dispositivo di programmazione
leggera i dati di sistema di STEP 5/ST.

Verifica della convenzione MS DOS (8.3), dell'accessibilita in scrittura e della
memoria libera nel drive della directory di sistema impostata.

Figura 2-12 Installazione personalizzata dal server

E’ possibile definire in modo diverso la parte variabile del nome della directory di si-
stema e della directory home. La destinazione dei dati relativi ai due nomi di directory
puo trovarsi sul dispositivo di programmazione su differenti drive.

Fare attenzione che, in questo caso, alla richiesta della directory di sistema bisogna
indicare una sorgente dei dati.
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2.45 Installazione server

Questo menu va utilizzato se sivuole che i dati di sistema STEP 5/ST siano disponibili
centralmente per piu utenti in un server di rete.

Installazione server

Indicare la directory di sistema

[C:/STEPS5]

In quale directory di rete devono essere messi a disposizione centralmente i dati
di sistema dello STEP 5/ST? La directory di rete deve al momento essere scrivibile.

Dopo l'installazione ¢ possibile, per la sicurezza dei dati di sistema dello STEP 5/ST,
definire la directory con I'attributo di ‘protezione alla scrittura’.

Verifica della convenzione MS DOS (8.3), dell'accessibilita in scrittura e della
memoria libera nel drive della directory di sistema impostata.

Figura 2-13 Installazione server

La parte variabile del nome della directory (ad es. C:\Step5) per i dati di STEP 5/ST
pud essere scelta liberamente dall’'utente. INSTALL la completera poi con la parte
invariabile \S5_SYS.

Il seguente nome & impostato per default da INSTALL:

Definizione Percorso Contenuto
Directory di sistema |CASTEP5\S5_SYS |STEP 5/ST dati di sistema

Se si avvia l'installazione dal server di rete dal dispositivo di programmazione locale
e se, inuna precedente installazione, su tale dispositivo € stata impostata la variabile
d’ambiente S5_SYSTEM, viene impostato per default il contenuto di tale variabile.

Si pud confermare la directory di default o specificarne una diversa.

Avvertenza

Si noti che, quando si esegue I'installazione dal server, non vengono installati i
dati di dispositivo. Non viene creata la directory home di STEP 5/ST, non
vengono modificati i file di configurazione CONFIG.SYS e AUTOEXEC.BAT e
non viene eseguita l'integrazione in Windows.

STEP 5/ST V7.0
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Installazione home

Sara quindi possibile richiamare STEP 5/ST solo dopo aver installato nel dispositivo
diprogrammazione ancheidatididispositivo. Sidovra eseguire un’installazione home
nel seguente modo:

1. Dopo aver concluso l'installazione dal server avviare nuovamente INSTALL
dal dispositivo di programmagzione in rete nel quale si vuole utilizzare
STEP 5/ST.

2. Selezionare le voci di menu Personalizzata e Dal server.

3. Specificare il nome della directory di sistema della precedente installazione
dal server ed eseguire l'installazione home.

L'installazione home pud essere eseguita su un numero qualsiasi di dispositivi di
programmazione collegati in rete.

Avvertenza

Per proteggere i dati di sistema dello STEP 5/ST da accessi non autorizzati, &
possibile definire la directory di sistema ‘protetta alla scrittura’. A questo scopo,
dopo la conclusione dell'installazione Server, bisogna utilizzare i mezzi disponibili
nel proprio sistema operativo. Non bisogna dimenticare, prima di una nuova in-
stallazione server nella stessa directory, di rimuovere la protezione alla scrittura.

La sottodirectory ...S5_COM\ non puo essere protetta alla scrittural

2.4.6 Copia del pool di dati

STEP 5/ST V7.0
C79000-G8572-C920-02

Questa voce di menu consente di raggruppare tutti i dischetti di installazione di
STEP 5/ST in un’unica directory del disco rigido o in un drive di rete.

Copia del pool di dati

Indicare una directory di destinazione

[C)\S5_INST]

Indicare la directory in cui copiare il pool di dati dei
dischetti di installazione.

Verifica della convenzione MS DOS (8.3), dell’accessibi-
lita in scrittura e della memoria libera nel drive della
directory di sistema impostata.

Figura 2-14  Tipo di installazione Copia del pool di dati

Si noti che il tipo di installazione Copia del pool di dati viene proposto solo quando
si esegue l'installazione dai dischetti STEP 5/ST oppure dal CD STEP 5/ST.
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Il software contenuto nei dischetti € compresso e i dati e gli archivi vengono trasferiti
nella directory di destinazione scelta dall’'utente senza subire modifiche. Con il pool
didati & possibile eseguire un’installazione rapida di STEP 5/ST dal discorigido locale
odallarete. Il pool didatidi STEP 5/ST disponibile su un drive direte centrale permette
una migliore gestione ed archiviazione.

La seguente directory viene impostata per default da INSTALL:

Definizione Percorso Contenuto

Directory del pool di C:\S5_INST dati di installazione STEP 5/ST
dati

Si pud confermare questa directory di default oppure sceglierne un’altra.

Quando si esce dalla maschera, la directory di pool di dati scelta viene esaminata
per verificare che soddisfi i seguenti criteri:

e il drive deve essere presente e pronto (ad es. supporto di trasferimento dati
inserito),

¢ il drive deve disporre di uno spazio di memoria sufficiente,
e ['utente deve avere il diritto di accesso in scrittura alla directory.

Se tali criteri non vengono soddisfatti, compaiono delle finestre con il relativo
messaggio di errore. In questo caso si dovra scegliere una directory di destinazione
valida.

Dopolacopiadel pooldidati, STEP 5/ST nonpud essere eseguitoelosipuorichiamare
solo dopo aver eseguito un’installazione completa selezionando le voci di menu
Standard o Server.

STEP 5/ST V7.0
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25 STEP5/STV 7.0 suCD-ROM

Contenuto del CD Nel CD-ROM fornito si trova il seguente contenuto:
\STEPS5.INS tutti i file necessari all'installazione (Pool di dati)
¢ \DISK1 Contenuto del dischetto d’installazione 1
e \DISK2 Contenuto del dischetto d’installazione 2
¢ \DISK3 Contenuto del dischetto d'installazione 3
¢ \DISK4 Contenuto del dischetto d’installazione 4
\ACROBAT
e \DOS Acrobat Reader per MS-DOS

* \DISK1 Attenzione: I'’Acrobat Reader per MS-DOS puo essere installato solo
da dischetti

e \DISK2
* \WIN3 Acrobat Reader per WINDOWS 3.x e WIN95
\STEP5.DOC Manuale STEP 5/ST Versione 7.0

2.5.1 Installazione da CD-ROM

Lo STEP5/ST V7.0 pud essere installato tramite richiamo di INSTALL.EXE nelladirec-
tory \STEP5.INS del CD-ROM.

Dischetti su E’ possibile generare dei set di dischetti copiando semplicemente i file dalle directory
CD-ROM da DISK1 fino a DISK4. Si devono utilizzare dischetti da 3.5” con almeno 1.44 MB.
| dischetti devono essere di nuovo formattati.

Esempio : Il drive del CD-ROM ¢ E:

Introdurre E:CD\STEP5.INS

Inserire nel drive A: un dischetto da 3.5” HD formattato e vuoto
Introdurre COPY DISK1\*.* A:

Estrarre il dischetto e contrassegnarlo con STEP 5/ST V7.0 DISK1
COPY DISK2\*.* A:

Estrarre il dischetto e contrassegnarlo con STEP 5/ST V7.0 DISK2

N g M D oRE

Ripetere il procedimento per DISK3, 4 e DISK5.

STEP 5/ST V7.0
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2.6 Particolarita

2.6.1 Installazione di STEP 5 in MS-DOS

Per eseguire STEP 5/ST, V 7.0 in MS-DOS (versione 5.0 o superiore) &€ necessario
attenersi a quanto segue:

In MS-DOS STEP 5/ST V 7.0 pud essere avviato da qualsiasi directory specificando
il comando S5.

| pacchetti COM e i pacchetti opzionali di STEP 5/ST possono essere eseguiti solo
in MS-DOS. Se si verificano problemi di spazio di memoria, si dovra creare uno spazio
di memoria piu esteso possibile nel file CONFIG.SYS utilizzando il programma
EMMB386.EXE. Se si lavora esclusivamente in MS-DOS, € possibile aumentare la
memoria convenzionale di 96Kb (vedere I'esempio di configurazione).

In MS-DOS e possibile assegnare un’interfaccia stampante ad un’interfaccia seriale
per poter utilizzare anche le stampanti seriali.

Comandi MS-DOS Effetto
MODE COM2:,9600,n,8,1,p impostazione 9600 baud, 8 bit senza parity, 1
bit di stop, nessun watchdog
MODE LPT1:=COML: la stampante ¢ collegata alla COM1..

2.6.2 STEP 5 in Windows 3.x e Windows 95

Installazione di
STEP 5in
Windows 3.x

2-20

Nel caso si utilizzi il sistema operativo Windows, & possibile avviare lo STEP5 anche
dall'interfaccia operativa di Windows. A questo scopo occorre definire durante I'instal-
lazione lo STEP 5 come programma Windows. Selezionare pertanto Integrare lo
STEP 5 in Windows (vedere allo scopo il capitolo 2.4.3|Adattare il file gruppo
STEP5V70.GRP).

STEP 5/ST V7.0
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Consiglio

Avvertenza

Sotto Windows 3.x viene definito il file di gruppo per I'icona di avvio dello STEP 5/ST
soltanto per I'impostazione standard della directory C:\STEP5\...!

Allawio dello STEP5 sotto Windows bisogna chiudere tutte le applicazioni
MS-DOS.

Lo STEP 5/ST Versione 7 sotto Windows pu0 essere avviato solo tramite l'icona
STEP 5 sotto il Programm Manager nella finestra STEP 5!

Un avvio dello STEP 5/ST con S5.BAT in una finestra Windows (p.es. richiesta intro-
duzioni MS-DOS) e teoricamente possibile, ma non consentito, in quanto cid pud
portare ad una caduta del sistema a causa di una collisione di accesso o ad un errore
nelle funzioni di Online 0 EPROM.

| tasti COM e *** (commento e fine segmento) non sono attivi sotto WIN 3.x. Bisogna
utilizzare i corrispondenti tasti funzionali Fx.

Se si usano le funzioni online, si consiglia di utilizzare il modo di visualizzazione a
schermo intero. Se si utilizza il modo a finestre, possono verificarsi degli errori nella
comunicazione.

2.6.3 STEP 5 sotto Windows 95

Sommario

Stampa in WIN95 e
in rete

STEP 5/ST V7.0
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Per eseguire STEP 5/ST in Windows 95 attenersi a quanto segue:

e E possibile caricare altri programmi a condizione che non accedano alle risorse
utilizzate da STEP 5/ST (stampante, EPROM ...). STEP 5/ST deve essere
avviato una sola volta.

* Se si usano le funzioni online, si consiglia di utilizzare il modo di visualizzazione
a schermo intero. Se si utilizza il modo a finestre, possono verificarsi degli errori
nella comunicazione.

* Le funzioni di Windows Copia e Incolla non possono essere utilizzate in
STEP5/ST.

e Se sj utilizzano le funzioni online tramite ’AS511, non devono essere attive altre
applicazioni, altrimenti puo verificarsi un’interruzione del collegamento online. Si
consiglia di utilizzare soltanto il modo di visualizzazione a schermo intero.

* Le funzioni online tramite SINEC H1 / L2 non danno luogo a problemi se si
impiegano driver di Windows 95 attuali (VD).

Per poter stampare in Windows 95, la stampante deve essere configurata
correttamente. All'installazione della stampante, specificare che si intende stampare
da programmi DOS oppure selezionare successivamente un’interfaccia stampante
nelle proprieta della stampante.
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Avvio di
STEP 5/ST

WIN-NT

2-22

Per garantire la corretta esecuzione di STEP 5/ST V7.0 in Windows 95, sono stati
definiti come dotazione standard dei file PIF. Questi file vengono inseriti nei menu di
awvvio di Windows durante I'installazione in ambiente Windows 95.

Dopo l'installazione, STEP 5/ST pud essere richiamato dal menu di avvio Sima-
tic » Step5v70 » STEP 5/ST.

Sono disponibili i seguenti file PIF:

Nome Richiamo

Rappresentazione a schermo intero di  |richiamo di S5.BAT nel modo a
STEP 5 schermo intero

Rappresentazione a finestre di STEP 5 |richiamo di S5.BAT nel modo a finestre

Modo MS-DOS di STEP 5 richiamo di S5.BAT nel modo MS-DOS
con rispettivo AUTOEXEC.BAT,
CONFIG.SYS

Installazione driver S5 richiamo di S5DRV.BAT

Editor della tastiera S5 richiamo di SSKEDIT.BAT

Con I'impiego di file molto grandi e utilizzando pacchetti COM e pacchetti opzionali
si consiglia di avviare lo STEP 5/ST V7.0 sotto MS-DOS.

Avvertenza

Le funzioni di Windows Copia e Incolla hon possono essere utilizzate in
STEP5/ST.

E possibile caricare altri programmi a condizione che non accedano alle risorse
utilizzate da STEP 5/ST (stampante, EPROM ...).
STEP 5/ST deve essere avviato una sola volta.

STEP5/ST V7.0 pud essere eseguito in Windows NT solo offline. Inoltre non possono
essere elaborate le EPROM. L'installazione non riconosce Windows NT percio non
esegue alcuna integrazione nel menu di avvio.

STEP 5/ST V7.0
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264 Esempio di configurazione

MS-DOS 5.0

Ottimizzazione

/N

STEP 5/ST V7.0
C79000-G8572-C920-02

Qui di seguito vengono riportarti alcuni esempi, eventualmente adattabili al relativo
sistema. Se necessario si possono cancellare testi gia presenti (i commenti) per
liberare spazio di memoria DOS.

Le directory per STEP 5/ST contengono valori preimpostati per I'installazione stan-
dard.

La stringa DEVICE=...DISPLAY.SYS del file CONFIG.SYS e le due stringhe MODE
CON ...di AUTOEXEC.BAT possono essere private del commento (vale per sistemi
che utilizzano il set di caratteri standard per PC).

CONFIG.SYS:

DEVICE=C:\DOS\HIMEM.SYS
DEVICE=C:\DOS\EMM386.EXE NOEMS
DOS=HIGH,UMB

FILES=32

BUFFERS=20
COUNTRY=049,C:\DOS\COUNTRY.SYS
SHELL=C:\COMMAND.COM /P /E:2048

AUTOEXEC.BAT:

PROMPT $P$G
PATHHT=C:\DOS;C:\;C:\\STEP5\S5_HOME
SET S5_HOME=C:\STEP5\S5_HOME
SET S5_SYSTEM=C:\STEP5\S5_SYS

LH KEYB GR,,C:\\DOS\KEYBOARD.SYS

Se silavora solo con MS-DOS, ovvero senza applicazioni grafiche, la memoria di pro-
gramma puo essere incrementata modificando la stringa (di CONFIG.SYS)

DEVICE=C:\DOS\EMM386.EXE NOEMS

in

DEVICE=C:\DOS\EMM386.EXE NOEMS |=A000-B7ff
per liberare 96KB.

Pericolo

Questa modifica non puod essere eseguita se si utilizzano WINDOWS o WIN 95.
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WIN 3.x Durante linstallazione WfW 3.11 inserisce altre stringhe che non possono essere
modificate manualmente!

MS-DOS 5.0 CONFIG.SYS:

DEVICE=C:\DOS\HIMEM.SYS
DEVICE=C:\DOS\EMM386.EXE NOEMS
DOS=HIGH,UMB

FILES=32

BUFFERS=20
COUNTRY=049,C:\DOS\COUNTRY.SYS
SHELL=C:\COMMAND.COM /P /E:2048
DEVICE=C:\WINDOWS\IFSHELP.SYS

AUTOEXEC.BAT:

SET S5_HOME=C:\STEP5\S5_HOME
SET S5_SYSTEM=C:\STEP5\S5_SYS
LH KEYB GR,,C:\\DOS\KEYBOARD.SYS

WIN95 CONFIG.SYS:

DEVICE=C:\WINDOWS\HIMEM.SYS
DEVICE=C:\WINDOWS\EMM386.EXE NOEMS
DOS=HIGH,UMB

FILES=32

BUFFERS=20
COUNTRY=049,C:\WINDOWS\COUNTRY.SYS
SHELL=C:\COMMAND.COM /P /E:2048

AUTOEXEC.BAT:

PROMPT $P$G
PATH=C:\;C:\WINDOWS;C:\STEP5\S5_HOME
SET S5_HOME=C:\STEP5\S5_HOME

SET S5_SYSTEM=CASTEP5\S5_SYS

LH KEYB GR,,C:\\DOS\KEYBOARD.SYS

STEP 5/ST V7.0
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2.7 Autorizzazione

Sommario

Per poter utilizzare il pacchetto base STEP 5/ST o STEP 5/ST per micro PLC sideve
installare 'autorizzazione che da all’'utente il diritto di utilizzare STEP 5/ST. Senza
autorizzazione il programma & protetto e non € eseguibile.

2.7.1 Autorizzazione di STEP 5/ST per PC

Installazione /
disinstallazione
dell'autorizzazione

Procedimento

STEP 5/ST V7.0
C79000-G8572-C920-02

STEP 5/ST comprende un dischetto di autorizzazione con il quale si puo installare
o disinstallare I'autorizzazione nel calcolatore.

Per installare o disinstallare I'autorizzazione si deve disporre del dischetto di
autorizzazione con il programma AUTHORS.EXE.

Grazie ai testi della guida il programma & in gran parte autoesplicativo.
| testi sono disponibili in 5 lingue (tedesco, inglese, francese, italiano, spagnolo).

Tutte le funzioni del programma contenute nel file AUTHORS.EXE, compresilascelta
dei menq, la chiusura e I'annullamento, possono essere eseguite sia con il mouse
che con i tasti indicati per ogni voce di menu. Le funzioni sono selezionabili sia da
menu che con la barra di stato che compare in basso nello schermo.

Procedere come segue:
1. Inserire il dischetto di autorizzazione V7.0 nel drive A:
2. Specificare AA>SAUTHORS e confermare con INVIO.

Avvertenza

L'autorizzazione per STEP 5 non pu0 essere installata in un drive compresso (ad es.
DBLSPACE), ma solo in un drive fisico. Se si installa STEP 5 in un drive compresso,
si dovra installare l'autorizzazione in un drive fisico con il tool AUTHORS.EXE,
separatamente da STEP 5.

Per fare in modo che STEP 5 trovi l'autorizzazione nel drive scelto, si deve
modificare la stringa standard DriveAuth = C: nella sezione Opzioni del file
S5 HOME\S5@@ @ @CF.INI. La modifica pud essere apportata con un qualsiasi
editor di testo.

Indicare il drive fisico impostato con AUTHORS.EXE.
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2.7.2 Autorizzazione per i pacchetti UPGRADE

Sommario

Procedimento

2-26

Per poter installare l'autorizzazione per il pacchetto UPDATE si deve disporre del
dischetto di autorizzazione con il programma S5UPG7_0.EXE dei dischetti

e STEP 5/STV 7.0 - pacchetto base, UPGRADE oppure
e STEP 5/STV 7.0 - micro PLC, UPGRADE.

Per i PC e inoltre necessario il dischetto di autorizzazione per STEP 5/ST V6.5 con
contatore a 1. Sul disco rigido non deve essere presente alcuna autorizzazione per
STEP 5/ST V6.5.

Procedere come segue:

1. Inserire il dischetto di autorizzazione di V7.0 nel drive A:
2. Specificare A\>S5UPG7_0 e confermare con INVIO.

Per i PLC procedere come segue:
1. Inserire i dischetto di autorizzazione di V7.0 nel drive A:
2. Specificare A\>S5UPG7_0 e confermare con INVIO.

L'autorizzazione puo essere disinstallata come descritto pit sopra con il programma
AUTHORS.EXE.

Pericolo

Prima di configurare o riformattare un drive del disco rigido, si deve disinstallare
I'autorizzazione e farne una copia di backup che possa essere utilizzata in una
nuova installazione. Per questa operazione si deve utilizzare il dischetto di
autorizzazione originale, che va quindi conservato accuratamente.

STEP 5/ST V7.0
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2.8 Installazione dell’hardware per STEP 5

2.8.1 Collegamento di una stampante

Interfacce
stampante

Quale stampante
puo supportare il
software?

Perilfunzionamento parallelo di una stampante utilizzare l'interfaccia LPT1 (PORT 1,
Centronics, Printer), per il funzionamento seriale invece [linterfaccia per
COM1-COM4.

Stam- PROMMER stam- Mouse AG
e parallelo pante
parallela seriale
evtl. alla LPT 1 evtl. alla COM 1-4 evtl. alla COM 1-4
|
LPT 1 ‘ ‘ COM 1-4/ V.24 ‘ COM 1(2)/ TTY,
attiva
PG/PC

Il software puo gestire le stampanti (stampanti standard) della SIEMENS e stampanti
di altri produttori. | parametri di stampante per stampanti di altri produttori devono es-
sere impostati caricando il file *DR.INI oppure usando il riqguadro di selezione stam-
pante. Le riguardanti istruzioni si trovano nel manuale STEP 5.

Avvertenza
Collegare tra loro i dispositivi con i cavi di collegamento solo quando sono spenti.

Avvitare e fissare i cavi di collegamento, nel caso sia possibile. Si eliminano in
questo modo errori di trasmissione.

2.8.2 Collegamento del PG con AG

Interfaccia AG

STEP 5/ST V7.0
C79000-G8572-C920-02

Lo scambio dati con il controllore programmabile presuppone un’interfaccia TTY at-
tiva (20 mA) del PG.

Se l'interfaccia COM 1 disponibile e V.24, bisogna emulare l'interfaccia AG-S5 me-
diante un convertitore S5.
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PG con interfaccia Il controllore programmabile (AG) ed il PG sono collegati tramite un collegamento di-
COM 1, TTY attiva retto (4), fornito col PG, o tramite due cavi di collegamento. Se le interfacce non sono
occupate come descritto al capitolo 2.8.4,si deve commutarle corrispondentemente.

Stampante| | PROMMER | | Stampante Mouse AG
parallela parallelo seriale
™, (@8 4
evtl. alla LPT 1 evtl. alla COM 1-4 evtl. alla COM 1-4
AG-S!
3)
—
‘ LPT1 ‘ ‘ COM 1-4/ V.24 ‘ COM 1(2)/ TTY,
attiva
PG/PC
Collegamento del Il PG & spento.

PG con interfaccia

TTY attiva con AG Collegamento PG-AG direttamente con il cavo di collegamento (4) o tramite (3), (7)

o (8):

I connettoridel cavo dicollegamento (3) n. ord. 6ES5 731-6AG00 sono contrassegnati
dalle scritte PG 7xx COM 1 e AG-S5.

1. Inserire il connettore con la scritta PG 7xx COM 1 nell'interfaccia COM 1 del
PG.

2. Inserire I'altro connettore con la scritta AG-S5 nel connettore adatto del cavo
di collegamento (7) o (8) che porta ad AG.

Non é possibile uno scambio dei connettori di questo cavo, perché sono di tipo
diverso.

3. Collegare I'AG con il connettore rimasto. Avvitare o fissare il connettore per
sicurezza.

Cavi di collega- Cavo di collegamento (3), n. ordinaz. 6ES5 731-6AG00
mento per PG con

interfaccia TTY
attiva Cavo di collegamento (7), n. ordinaz. 6ES5 731-0xxx0 1)

Cavo di collegamento (4), n. ordinaz. 6ES5 734-2xxx0 1)

Cavo di collegamento (8), n. ordinaz. 6ES5 731-1xxx0 1)

D xxx € la sigla della lunghezza. | cavi sono disponibili in lunghezze da 1 a
1000 m. Le sigle corrispondenti alle diverse lunghezze disponibili sono indicate
nel catalogo ST 59 dei dispositivi di programmazione.
PG con In un PG con interfaccia V.24 bisogna convertire questa in un’interfaccia AG-S5 me-
interfaccia V.24 diante un convertitore V.24/TTY (Kdster-Box). Il PG é collegato mediante un cavo di

collegamento diretto con convertitore V.24/TTY integrato (6) oppure mediante il cavo
di collegamento (5) con il Kdster-Box. A seconda del tipo di AG, il Koster-Box € colle-
gato con il cavo di collegamento (7) o (8). | cavi di collegamento non sono compresi
nella fornitura.

STEP 5/ST V7.0
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Stampante| | PROMMER | | Stampante Mouse AG
parallela parallelo seriale

o [ ]

evtl. alla LPT 1 evtl. alla COM 1-4 evtl. alla COM 1-4

— —
LPT 1 COM 1-4/ V.24 COM 1(2)/ TTY,
attiva
PG/PC

Collegamento del Il PG é spento.
PG con interfaccia

V.24 con AG Collegamento PG - AG direttamente con il cavo di collegamento (6) oppure tramite

(), (7) o (8):

Il convertitore V.24/TTY (Kdster-Box) € configurato come indicato nel capitolo|8, Con-
vertitore V.24/TTY (KOster-Box).

1. Eseguire il collegamento tra l'interfaccia COM 1 del PG e l'interfaccia della
Koster-Box mediante il cavo di collegamento (5).

2. Inserire il connettore del cavo di collegamento (7) o (8) nel connettore a 25 poli
femmina della Koster-Box. Eseguire il collegamento con I'AG.

3. Awvitare o fissare i connettori per sicurezza.

Cavi di collega- Cavo di collegamento (5), n. ordinaz. Koster 224 22x 2)

mento per PG con . .

interfaccia V.24 Cavo di collegamento (5), n. ordinaz. 6ES5 734-1BD20 (lunghezza 3,20 m)
Cavo di collegamento (5), n. ordinaz. 6ES5 731-0xxx0 1)
Cavo di collegamento (5), n. ordinaz. 6ES5 731-1xxx0 1)

D xxx € la sigla della lunghezza. | cavi sono disponibili in lunghezze da 1 a
1000 m. Le sigle corrispondenti alle diverse lunghezze disponibili sono indicate
nel catalogo ST 59 dei dispositivi di programmazione.

2)

x indica il tipo di connettore del cavo di collegamento PG/Kdster-Box.

STEP 5/ST V7.0
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2.8.3 Collegamento del dispositivo di programmazione EPROM

Nei PG e incorporata un’interfaccia di programmazione EPROM. Nel caso siimpieghi
un PC come PG ¢ possibile collegare un dispositivo esterno EPROM. Per il collega-
mento all'interfaccia parallela o seriale sono disponibili diversi dispositivi.

Il dispositivo che viene collegato all'interfaccia parallela & commercializzato con il
nome di Prommer esterno .

Prommer parallelo Interfaccia: LPT 1

Collegamento

llcavoperilcollegamentoparallelovienefornitoassiemealprommeresterno. Quest'ul-
timo possiede un collegamento che serve inoltre come interfaccia parallela per una
stampante parallela.

PG-Prommer Stampante | |[PROMMER| | Stampante Mouse AG
parallela parallelo seriale
evtl. alla LPT 1 evtl. alla COM 1-4 evtl. alla COM 1-4
—
LPT 1 COM 1-4/ V.24 COM 1(2)/ TTY,
attiva
PG/PC
Collegamento del Il PG ed il prommer sono spenti.

PG con il Prommer

1. Prommer parallelo: mediante il cavo di collegamento LPT in dotazione, colle-
gare linterfaccia LPT1 sul PG con linterfaccia PC sul prommer esterno e col-
legare eventualmente la propria stampante parallela all'interfaccia printer del
prommer esterno.

2. Avvitare o fissare i connettori, nel caso sia possibile.

2.8.4 Panoramica sui cavi di collegamento all’AG, al Partner del PG, e al Prommer

N. cavi di N. ordinazione Collegamento
collegamento da (connettore al PG) a
3 6ES5 731-6AG00 PCCOM1 (PG 7xx: Cavo di collegamento:
25 poli, pin) - 708 (AG)
— 10 (Partner del PG)
4 BES5 734-2xxx0 1) PCCOM1,2 25 poli, femmina AG  15poli, femm.
5 Koster 224 22x PCCOM1, 2 Koster-Box
6 6ES5 734-1BD20 PCCOM1,2 25poli, femmina AG  15poli, femm.
7 6ES5 731-0xxx0 1) Cavo di collegamento 3 o Kdster-Box AG  25poali, pin
8 6ES5 731-1xxx0 1) Cavo di collegamento 3 o Kdster-Box AG  15poli, femm.
10 BES5 733-2xxx0 1) Cavo di collegamento 3 o Kdster-Box Partner del PG COM1
D xxx € la sigla della lunghezza. | cavi sono disponibili in lunghezze da 1 a 1000 m. Le sigle corrispondenti alle diverse lunghezze disponibili sono
indicate nel catalogo ST 59 dei dispositivi di programmazione. Per il funzionamento del Prommer & prevista una lunghezza massima di 3 m.
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Disposizione dei
connettori dell’in-
terfaccia TTY attiva

Lato PG Cavo di collegamento Lato AG
COMITTY . . 6ES5 734-2xxx0 connettore maschio
connettore maschio a 25 poli a 15 poli
attivo passivo
~~ 330 Ohm M
+U o 19— L — 00 —
}Z e
o . ——C 18 m—— - 2 — e —
] —»>
* 21
-y &—
330 Ohm
+U e 10 mmm — ] - 6 ) J
j <
<
— 9 | I 7 ‘
W1y T b
<
] 10 o >

Y .7@7

Involucro 1

o]
—<C 20

P 85 Schermo/

Involucro
L om 1 )—
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2.8.5 Installazione dei driver per STEP 5

Selezione / | driver MS-DOS per SINEC L2 e H1 (driver di rete SIMATIC NET) per STEP 5/ST
deselezione dei possono essere selezionati e deselezionati con il programma S5DRV.EXE.

driver per

STEP5/STV 7.0

Preimpostazioni

2-32

| driver vengono attivati o disattivati da una stringa del file AUTOEXEC.BAT. Il file
originale viene salvato prima della modifica nel file AUTOEXEC.S5. La modifica
diventa attiva quando si riavvia il PC.

Il richiamo del programma avviene in funzione del sistema operativo.

Tabella 2-3  Richiamo di S5DRV

Sistema operativo Richiamo
MS-DOS specificare il comando S5DRV
Windows3.x fare doppio clic sull'icona del driver STEP 5 nel gruppo
dei programmi di STEP 5
Windows95 fare clic su menu di avvio STEP5V70/S5 installazione
dei driver

Nessun driver DOS (esterno)

Driver DOS H1 per CP 141

Driver DOS H1 per CP 1413

Driver DOS L2 per CP 5410B

Figura 2-15 Tipi di installazione

Il programma S5DRV.EXE é guidato da menu e puo essere utilizzato con un mouse,
una trackball o i tasti cursore e i tasti funzione.

Il menu consente di selezionare i driver MS-DOS necessari per le funzioni di rete
SINEC L2, H1 (driver di rete SIMATIC NET) SIMATIC NET.

Alla fornitura i driver del software STEP 5/ST non sono attivati.
Lo stato attuale dei driver viene indicato nel seguente modo:
[X] = selezionato;

[ 1= non selezionato.

STEP 5/ST V7.0
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Avvertenza

E opportuno selezionare solo i driver necessari in modo da avere a disposizione
uno spazio di memoria piu esteso possibile per I'esecuzione di STEP 5/ST.

| driver MS-DOS per funzioni di rete SIMATIC NET (PROFIBUS SINEC L2, H1)
possono essere selezionati solo se nel PC é stato precedentemente installato
I'apposito software.

2.8.6 Editor di tastiera per STEP 5

File

STEP 5/ST V7.0
C79000-G8572-C920-02

L'editor di tastiera & necessario solo quando si vuole usare un PC come PG.

Con I'editor di tastiera (key editor) la disposizione della tastiera puo essere adattata
alle esigenze di STEP 5. E possibile aggiungere ulteriori combinazioni ad una combi-
nazione tasti esistente o modificare quelle esistenti.

Se sivuole utilizzare uno schermo a colori esterno sul dispositivo di programmazione
dotato di schermo in bianco e nero interno € possibile commutare il driver in questo
editor.

Se il PC é dotato di un’altra tastiera al posto di quella internazionale standard oppure
sidesideraimpostare ulterioricombinazioniditastiper STEP 5, unamodificadell'asse-
gnazione dei tasti potrebbe essere opportuna. Se il PC & invece dotato di una tastiera
standard (tastieraMFIl), basterannole predisposizioniimpostate e non occorre modifi-
care le assegnazioni.

Nell'editor &€ preimpostata la tastiera tedesca, € pero possibile impostare un’altra lin-
gua.

| file si trovano nella directory di sistema [DR:]\STEP 5\S5_SYS.

File Denominazione Contenuto

S50DS10X.EXE | Editor di tastiera | Editor, interfaccia operatore, gestione e docu-
mentazione.

S50DS10X.RES | File di risorse Identificazioni dei coperchi dei tasti messi a
scelta (deve essere caricato il corrispondente
driver keyboard).

S5KXS06X.S5K | File tastiera File con cambio di tastiera devono essere
STEP5.S5K copiati nella directory home e li possono
essere rielaborati. STEP5.S5K = File tastiera
per STEP5/ST V7.0 e S5KxS06K.S5K = File
tastiera per STEP5/ST V6.6.

STEP5.S5K File tastiera Occupazione della tastiera (nella directory
STEP 5; se questo file non ¢ esistente, STEP 5
utilizza I'impostazione default).
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Flusso dati
all'occorrenza editare
Utente lﬁ
; S50DS10X.EXE S50DS10X,RES
Tastiera PC Key Editor @I File di risorse
File tastiera Coi iare File di esempio:
STEP5.S5K STEP5.S5K
S5KxS06x.S5K
STEP5.EXE @I SW STEP 5
MS-DOS
HW PC
Premesse Se si desidera modificare I'occupazione dei tasti per STEP 5, si devono conoscere:
* |e denominazioni della tastiera S5,
¢ |e funzioni della tastiera S5 e
* |'organizzazione dei file del software S5.
| tasti specifici per S5 sono spiegati nel manuale STEP 5, nell’appendice.
STEP 5/ST V7.0
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Predisposizione
della tastiera S5
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(commutazione tra titolo e commento segmento) oppure F6 <Fine segmento>

Selezionare queste funzioni mediante i tasti SHIFT F6 <Comm. segm.>
(conclusione segmento attuale ed inizio di uno nuovo).

nella tastiera del PG 750/770 i tasti <COM> (Commento) e <***> (Fine

Si prega di osservare le seguenti restrizioni:
segmento) sono senza funzione.

C79000-G8572-C920-02

Avvertenze
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L omando cursore

Tastiera MFII
(IBM-AT)

Occupazione della
tastiera S5

Num / _
Lock
7 8 9

Home * Pg Up

4 5 6
- —
1 2 3
End Yy ||PgDn
Enter
0
Insert
+1

20
@
p=1

Tasti funzionali

F1| F2| F3 || F4| | F5| F6| F7| F8| | Fo || Fl0|| F11| F12
F1 || F2| F3| Fa| | F5 | F6 | F7| F8| | O |
@) | FB

Tabella 2-4  Richiamo dell’editor della tastiera

Richiamo Sistema operativo Richiamo
delleditor della MS-DOS Digitare il comando S5KEDIT:BAT.
tastiera
Windows 3.x Awvio del programma tramite un dop-
pio click sull’icona S5KEDIT 5 nel
gruppo di programmi STEP 5
Windows95 Click sul menu di avvio \STEP5V70\S5
editor della tastiera
STEP 5/ST V7.0
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I menu dell’editor
della tastiera

Editare Opzioni Finestra

Altri ‘

L 1 1

1

File
Aprire F2
Salvare F3

Salvare come ...

Inserire  Ins Lingua tastiera default

Cancellare Cancll commutare bianco/nero [f§ Z00m

~ colore

Cambiare directory

lavoro ...
Stampare

DOS

Alt-X

Fine

Seguente

F6
F5

Info ...

Alt-X Fine Alt-F3  Chiudere finestra Ins Inserire Canc Cancellare
Interfaccia utente
Menu Sottomenu Funzione Visualizzazione
File Aprire F2 Richiamo del file tastiera per I'editazione. | Box di scelta Aprire file
Salvare F3 Salvataggio del file tastiera attuale. Finestra attuale
Salvare come ... Memorizzazione del file attuale con un Box di scelta Salvare come
altro nome nella stessa o in un’altra
directory.
Cambiare directory Apertura di un’altra directory. Box di scelta Directory...
lavoro
Stampare Stampa del file corrente. Inalterata
DOS Passaggio al livello di comando DOS Riga di comando DOS
(ritorno con EXIT e Return)
Fine Uscita dall’editor Livello DOS
ALT + X
Editare Inserire Ins Inserimento o modifica dell’'occupazione | Ulteriore finestra Assegnare funzione S5 a
del coperchio di tasto nella posizione una nuova combinazione tasti
cursore.
Cancellare Canc Cancellazione dell’occupazione del Finestra con assegnazione cancellata
coperchio di tasto nella posizione
cursore.
Opzioni Linguatastiera default | Scelta di un file di risorse di un’altra Box di scelta .RES Aprire file
lingua (S50nS10X.RES)
Commutare Commutazione della rappresentazione Schermo monocromo o colorato
Bianco/Nero <—> schermo tra monocromo e colorato
Colore
Finestre Seguente F6 Con piu finestre aperte attualizzare quella | Finestra attuale
pit in basso.
Zoom Modifica della dimensione della finestra Finestra attuale
attuale.
Altri Info ... Informazioni sulla versione attuale Maschera Informazioni

STEP 5/ST V7.0
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Lingua tastiera
default

Selezione della
lingua

Apertura file

2-38

Sinecessita della funzione Selezione della lingua solo se si tratta di un nuovo file op-
pure se si desidera impostare una tastiera diversa da quella tedesca.

Altrimenti, per un nuovo file & impostata la tastiera tedesca.

1. Attivare il comando di menu Opzioni » Lingua tastiera default

Compatre il dialogo Aprire file per resource file (tipo di file *.RES) con una lista
di selezione dei resource file presenti.

2. Selezionare un resource file della lingua corrispondente oppure digitare un
nuovo nome secondo la sintassi seguente:
S50 x S10X.RES
X = tedesco

inglese

m m O

francese
| italiano
S spagnolo
3. Cliccare sulla casella Aprire .

E impostata la lingua della tastiera.

1. Attivare il comando di menu File » Aprire ( F2).
Compare una lista di selezione per file del tipo *.S5K.

2. Selezionare un file e digitare un nome di file.

3. Cliccare sulla casella Aprire .

Il file viene aperto per I'editazione. Un nuovo file viene predisposto con preim-
postazioni.

4. Aprire eventuali altri file ripetendo i passida 1 a 3.

STEP 5/ST V7.0
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Box di scelta
Aprire file

Inserimento di una
nuova assegna-

zione di tasti

Limitazioni

STEP 5/ST V7.0
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- [ ] Aprire file
Nome
‘ESEMPIO S5K ‘ ‘ Aprire ‘
File
ESEMPIO.S5K ‘ Uscire ‘
TEST.S5K
2\
<« >
C:\STEP5\*.S5K
ESEMPIO.S5K 378 Apr 15, 1993 11.35a

Premessa: e stato aperto un file di assegnazione tasti.

1. Selezionare il tasto desiderato (col click del mouse o con i tasti cursore).

La riga selezionata ha sottofondo colorato o grigio; il numero della riga si trova
sul bordo inferiore sinistro della finestra.

. Attivare il comando di menu Editare » Inserire oppure premere il tasto Ins

oppure INSERT.

Nella sezione in basso dello schermo compare un altro dialogo Assegnare
funzione S5 a una nuova combinazione tasti. L'identificazione della funzione si
trova nella prima riga del dialogo.

Avvertenza: Se e stato impiegato uno dei tasti PRINT o PAUSE si deve ren-
dere di nuovo attiva la digitazione alla tastiera premendo in successione CTRL
+ SHIFT.

Selezionare la nuova combinazione di tasti premendo i relativi tasti.

Si ottiene la richiesta Salvare assegnazione o il messaggio Il tasto (o combi-
nazione tasti) é gia stato assegnato internamente.

Cliccando sulla casella Sovrascr . o Inserire assegnare la nuova combina-
zione di tasti.

Peralcune combinazionitastiladenominazione deltasto visualizzato non corrisponde
al tasto alfanumerico stampato.

Il tasto D sulla tastiera PG non pu0 essere assegnato.

Gli hotkey (scorciatoie) che durante I'esecuzione dell’editor di tastiera sono
occupati dai programmi residenti, non possono essere assegnati.
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Denominazione
tasti nell’editor

Assegnazioni
default

Cancellazione di
assegnazione tasti

Salvare
assegnazioni tasti

2-40

T

(grigio)

PE
(num) .
@

o
| SIS

Coperchi di tasti presenti sono solo su una tastiera 101/102
sono contrassegnati con (101).

Coperchi di tasti presenti sono solo su una tastiera PG sono contrassegnati
con (PG).

Funzioni S5 valide solo per GRAPH 5 sono contrassegnate con (GRAPH 5).

Premessa: € stato aperto un file di assegnazione tasti.

1.

Selezionare I'assegnazione tasti desiderata.

La riga selezionata ha il sottofondo colorato o grigio; il numero della riga si
trova sul bordo sinistro inferiore della finestra.

Attivare il comando di menu Editare » Cancellare oppure premere il tasto
Canc o DEL.

L'assegnazione tasti nella riga selezionata viene cancellata sullo schermo.

Avvertenza: se € stato impiegato uno dei tasti PRINT o PAUSE si deve ren-
dere di nuovo attiva la digitazione alla tastiera premendo in successione CTRL
+ SHIFT.

Nel caso si voglia annullare la cancellazione dell'assegnazione, cliccare sulla
casella di chiusura sul bordo superiore sinistro della finestra e rispondere con
No alla richiesta Salvare le modifiche.

Con No vanno perdute tutte le modifiche che si sono avute dall'ultimo salva-
taggio dati.
Attivare il comando di menu File » Salvare oppure

il comando di menu File » Salvare come , per salvare il file sotto un altro
nome o un'altra directory.

STEP 5/ST V7.0
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Cambiare la
directory di lavoro

Attivazione
dell'assegnazione
tasti

Copia
dell'assegnazione

Stampare
I'assegnazione

Passaggio al
livello DOS

Commutazione da
schermo a colori a
schermo monocro-
matico
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1. Attivare il comando di menu File » Cambiare directory di lavoro

2. Navigare nella struttura indicata. Cliccando due volte sulla directory ne ven-
gono visualizzate le subdirectory.

3. Cliccare sulla directory desiderata e sulla casella Cambio .

4. Acquisire I'impostazione cliccando sulla casella Impostazione .

Conilcomando dimenu File » Salvare come sipuo copiare il propriofile (diassegna-
zione) in un nuovo file. Volendo attivare la nuova assegnazione di tasti per STEP 5,
si deve copiarla nella directory home STEP5/ST sotto il nome STEP5.S5K (per
STEP 5/ST V7) oppure S5KxS06x.S5K (per STEP 5/ST V6.6).

1. Aprirel'assegnazione tasti attivandoil comando dimenu File » Aprire edaprendo
il relativo file del tipo *.S5K.

Attivare il comando di menu File » Salvare come .
Commutare nella directory home dello STEP 5/ST

Sostituire I'asterisco con il nome del file tastiera STEP5 oppure S5KXS06K .

o v

Cliccare sulla casella Avanti oppure premere i tasti ALT + W.

1. Aprire'assegnazione tastiattivando il comando di menu File » Aprire ed aprendo
il corrispondente file del tipo *.S5K.

2. Attivare il comando di menu File » Stampare .

Il richiamo del livello di comando DOS é possibile solo se é disponibile una quantita
sufficiente di memoria di lavoro libera.

1. Attivare il comando di menu File » DOS.
Ci si trova nel livello di comando DOS.
2. Digitare i comandi DOS desiderati.

3. Digitare il comando EXIT per ritornare all’editor di tastiera.

Attivare sotto I'editor di tastiera il comando di menu Opzioni » Commutare bianco/
nero ++ colore .
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Verifica del file di
risorse

Informazioni

Ritorno al livello
DOS
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2.
3.
4.

Aprire sotto I'editor di tastiera un nuovo file del tipo *.S5K con il comando di menu
File » Aprire » digitare il nome del file

Memorizzare il file senza modifiche con File » Salvare.
Chiudere la finestra con i tasti ALT + F3.

Aprire di nuovo lo stesso file.

Risultato : Se allalettura delfile non si verificano errori, le assegnazioni sono corrette.

In caso contrario verificare se le combinazioni di tasti hanno una doppia occupazione.

Informazioni sulle versioni attuali si ottengono selezionando la funzione Info... nel
menu Altro.

Abbandonare la maschera cliccando su OK.

Perritornare al livello DOS premereitasti ALT + X oppure attivare il comando di menu
File » Fine.

STEP 5/ST V7.0
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2.9 Utilizzo dei pacchetti COM

STEP 5/ST V7.0
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Per il funzionamento dei pacchetti COM bisogna osservare i seguenti punti:

Nell'impiego dei pacchetti COM si puo utilizzare soltanto una directory DOS per
ciascun drive

Non si pud impostare un drive superiore a P:, in quanto i pacchetti COM sono stati
impiegati anche precedentemente al livello V7.0.

Nell'impiego dei pacchetti COM deve essere osservato che la directory di si-
stema dello STEP 5 V7.0 é diversa dalla directory di sistema dell'adattatore
COM. | pacchetti COM infatti utilizzano la propria directory di sistema
..\S5_SYS\S5_COM. Questa separazione & necessaria, in modo che i pacchetti
COM possano funzionare autonomamente.

| pacchetti COM possono essere agganciati per un avvio diretto nel menu Pull-
Down Cambio.

Il COM 155H e il COM 95F sono attivati sotto STEP 5/ST V7.0 sotto il menu Cam-
bio » Altri... come pacchetti opzionali. | legami esistenti nell'interfaccia operativa
della versione 6.x hon sono piu utilizzabili nella versione 7.0.

Alcuni pacchetti COM per poter essere elaborati richiedono i file specificati

Il file impostato DR:\<directory>\<nome file> impostato nella rispettiva
scheda sara quindi valido solo per la sessione di STEP 5.

| pacchetti COM accettano in parte i file specificati nelle impostazioni del progetto,
ma non vi possono accedere.

Per poter utilizzare i file impostati anche nei pacchetti COM, & necessario copiarli
nella directory del pacchetto COM.

La directory dei pacchetti COM deve ad esempio contenere i seguenti file:

Definizione Nome del file
File di programma ????2??ST.S5D
File simbolico ?2??2?2??Z0.INI
File piedinatura ??????F1.INI (80 caratteri)

??????F2.INI (132 caratteri)

File stampante ??2?2???DR.INI
File di emissione ?2?????LS.INI
File via ??????AP.INI (+ nome via)
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2.10 Compatibilita

STEP 5/ST & compatibile con la versione 6.6. La voce di menu Cambio » Altri...
consente di caricare parti della versione 6.6.

Per quanto concerne la compatibilita bisogna osservare i seguenti punti:

¢ Non viene piu supportato il PG 710 /Il (per STEP 5/ST V7.0 & necessario uno
spazio minimo di memoria di 4 Mbyte. Non € possibile effettuare I'upgrade di tali
PG).

¢ Non viene piu supportato il prommer seriale.

* |e macro tasti esistenti devono essere huovamente create.

* Non viene piu supportata la gestione dati BTRIEVE.

¢ Non viene piu supportata la diagnosi/ i dati di riferimento sulla base del CP 551.
* GRAPH 5/11 V6.x non & eseguibile in STEP 5/ST V7.0.

¢ |[file di progetto delle versioni precedenti (PJ.INI) possono essere convertiti in file
della versione 7.0 utilizzando gli appositi tool di conversione ed essere quindi in
grado di supportare le funzioni sopra descritte. Sempre tenendo presenti i criteri
di compatibilita (drive non superiori a J: 0 P:, non piu di una directory per drive)
sara poi possibile riconvertire il file nella versione 6.x.

* | nuovi file di progetto avranno I'estensione PX.INI.

* In alcuni casi, per poter utilizzare le funzioni pit avanzate del sistema DOS, &
necessario apportare piccole modifiche ai file utente della versione 6.x. Cio
riguarda sia i file di progetto (PJ.INI) che i file vie bus (AP.INI) e i file istruzioni di
comando (SU.INI).

* Quando si utilizzano queste nuove funzioni per operare con i drive DOS, viene
visualizzato un messaggio indicante che la compatibilita con le versioni
precedenti di STEP 5 non €& piu garantita.

STEP 5/ST V7.0
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Sommario lIsoftware STEP 5 é statorealizzato secondo criteriergonomici e pertantole sue moda-
lita operative sono autoesplicative.

Se non sihaalcunaesperienza con interfacce operative di questotipo, in questo capi-
tolo si possono trovare informazioni relative ai concetti e agli elementi operativi piu

importanti.
Sommario del Capitolo Argomento trattato Pagina
capitolo 3.1 Scelta delle funzioni nel menu principale 3-2
3.2 Elementi operativi 3-4
3.3 Scelta funzioni 3-6
34 Richiamo delle funzioni di Help 3-7
3.5 Interfaccia operatore: finestre di dialogo 3-8
3.6 Box di comando 3-9
3.7 Schedario e schede dello schedario 3-12
3.8 Scelta di file e directory 3-14
3.9 Scelta blocchi 3-16
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3.1 Scelta delle funzioni nel menu principale

Sommario

@ &

©

(A) Barra del titolo

(B) Barra di menu
(C) conimenu

(D) Superficie di
lavoro

(E) Sigla S5

3-2

Lefunzioni STEP 5vengono offerte tramite labarradi menut che contieneimenu princi-
pali ed i sottomenu. In questi menu si selezionano, per mezzo del mouse o della ta-
stiera, gli strumenti ed i servizi che si rendono necessari durante il lavoro con il PG.
Gliutenti che hanno gia lavorato con versioni precedentidi STEP 5 e che sono abituati
a lavorare con i tasti funzionali possono adoperare i menu in modo consueto.

Labarra del titolo ha come nome STEP 5. | pulsanti rappresentati nella barra del titolo
sono tipici di Windows 95. La barra del titolo non viene visualizzata nel modo Ingrandi-
sci o sotto MS-DOS.

Quando si seleziona un titolo di menu sulla barra di menu cliccandolo con il mouse
oppure posizionandoil cursore sultitolo e attivandolo quindi premendoil tasto diintro-
duzione , il relativo menu si apre. In un menu sono elencati dei temi relativi al punto
di menu e/o delle funzioni.

Le voci di menu, che presentano una freccia > sulla loro destra, conducono ad un
sottomenu.

Le voci di menu, che presentano dei puntini .... sulla loro destra, conducono ad un
finestra di dialogo.

Sulla superficie di lavoro, cioé sull'interfaccia grafica, vengono visualizzati i box di
sceltain cuisieffettuanoleimpostazioni, nonchéiboxdiinformazione, disegnalazione
e l'area di lavoro degli editor di programma.

Qui viene visualizzato se si sta lavorando con STEP 5/ST oppure con con un altro
pacchetto S5 (p. es. GRAPH 5).

STEP 5/ST V7.0
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(F) Barra delle La barra delle funzioni offre la possibilita di passare direttamente a certi box di scelta
funzioni o0 editor, senza bisogno di eseguire estese sequenze operative.

Pervisualizzare la disposizione degli ulterioritastifunzionali, premere il tasto ditabula-
zione TAB oppure cliccare il simbolo "»” che si trova a tutta destra.

Per attivare le funzioni sullabarra delle funzioni sihanno le seguenti possibilita (vedere
anche il capitolo|3.2):

¢ Cliccare con il mouse sul campo che contiene la designazione breve della
funzione.

¢ Le funzioni che si trovano nella fila inferiore si possono attivare premendo il
tasto funzionale indicato a sinistra (da F1 a F12).

* Le funzioni con sfondo grigio nella fila superiore vengono attivate tenendo pre-
muto il tasto SHIFT mentre si preme allo stesso tempo il tasto funzionale
indicato a sinistra (da SHIFT F1a SHIFT F12).

¢ Inalcunicasi e possibile anche la combinazione dei tasti funzionali con i tasti Ctrl/
SHIFT+Ctrl.

Informazioni pit dettagliate sulle funzioni, che sono legate ai tasti funzionali, si otten-
gono tramite il menu Help » Lista assegnazione tasti...Ctrl+F12

Listaassegnazione tasti... Ctrl+FI2
Info su versione STEP 5/ST... F12
Versione pacchetti S5...Ctrl+F11

Guida ai menu
Guida alle finestre

Indicazioni generali
Compatibilita
Informazioni hardware

Figura3-1  Comando di menu HELP

(G) Riga di Lariga diinformazione fornisce informazioni sul titolo di menu o il punto di menu (titolo
informazione del sottomenu o funzione di menu) che & stato selezionato ma non ancora attivato.
(H) Identificazione Questa riga di informazione fornisce informazioni relative al file progetto attuale
progetto (PX.INI) con cui si sta lavorando.
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3.2 Elementi operativi

Interfaccia
operatore

Hotkey

Barra di menu
superiore

Sottoment

Finestre di dialogo

Macro tasti

L'interfaccia dello STEP5/ST é stata concepita in modo tale che tutte le funzioni siano
raggiungibili sia con la tastiera che con il mouse.

Per lavorare in modo ottimale con la tastiera, nei menu, nelle finestre di dialogo e negli
schedari possono essere utilizzate lettere e cifre evidenziate con colori, gli hotkey ,
in modo da selezionare velocemente i singoli elementi operativi. Dopo aver attivato
un hotkey, il software salta da una qualsiasi posizione nellafinestra di dialogo al punto
corrispondente del video oppure attiva, nel menu, la funzione desiderata.

Conlacombinazione deitasti ALT+Lettera , viene richiamato il sottomenu desiderato
partendo da qualsiasi livello di annidamento. Cosi, per esempio, le combinazioni che
seguono significano:

ALT+D : Sottomenu File
ALT+T : Funzioni di test

In questi menu si opera soltanto sulle lettere e le cifre evidenziate dal colore, e sono
attivi solo gli hotkey dell'ultimo sottomenu.

Nelle finestre di dialogo, utilizzando gli hotkey, ci si pud spostare sui campi d’introdu-
zione. A questo scopo vengono premuti contemporaneamente il tasto di ALT con una
lettera o una cifra.

Nello STEP5esistelapossibilitadicreare unaregistrazione dioperazioni, peresempio
nell’'editor dei blocchi.

In questo modo l'utente pud automatizzare diversi passi. Il programma macro tasti
si richiama cosi:

CTRL+ALT+D

Viene visualizzata la finestra di dialogo Scelta macro, in cui si devono eseguire le se-
guenti impostazioni:

¢ Introduzione (Scelta) del file macro (...... TX.INI)

¢ Introduzione di un titolo

* Esecuzione di una macro tasti registrata

* Registrazione di una macro tasti secondo le proprie operazioni
¢ Esecuzione dei singoli passi di una macro tasti registrata

Se e stata impostata l'opzione [ ] Passo singolo esecuzione , deve
essere premuta ad ogni passo, durante I'esecuzione della registrazione, la combina-
zione dei tasti CTRL+ALT+T.

Terminare la registrazione con CTRL+ALT+D

L'interruzione controllata dell’esecuzione della macro tasti avviene con ESC.

STEP 5/ST V7.0
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Tasti della barra
delle funzioni
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Avvertenza

Le macro tasti non funzionano con il comando File » Comandi DOS oppure
Cambio » Altri .

Se si utilizzano gli hotkey, osservare la loro assegnazione dipendente dalla lingua
scelta.

Il punto di partenza e di arrivo di una registrazione deve essere assolutamente
rispettato (tenerlo presente !).

Le macro tasti (......TP.INI) delle versione di STEP 5 piu vecchie non possono
essere pil utilizzate o convertite.

La macro START@TX.INI avvia automaticamente, avviando lo STEP5/ST, I'ese-
cuzione di una registrazione.

| sottomenu richiamati sono parzialmente annidati. Un sottomenu puo essere chiuso
con il tasto d'interruzione ESC, senza attivare alcuna funzione. Con il tasto d'introdu-
zione Return viene attivata una funzione o viene aperto un sottomenu.

Per selezionare nel modo piu semplice possibile le funzioni che vengono richiamate
spesso, per la maggior parte dei sottomenu sono stati definiti dei tasti funzionali (F1
fino F12) che sono attivabili da qualsiasi punto del menu.

Per esempio F1 richiama il box di comando per I'editor dei blocchi, Shift+F3 l'indice
dei blocchi nellAG.

L'assegnazione dei tasti funzionali viene mostrata nel livello del menu principale nella
parte inferiore delvideo. Poiché questaassegnazione avviene anche tramite lacombi-
nazione di tasti funzionali con il tasto di Shift e Ctrl/Alt , con il tasto TAB pu0 essere
visualizzato il successivo livello di assegnazione.

Nelmenu, sotto Help » Lista assegnazionetasti viene data unapanoramicadeitasti
funzionali utilizzati.

L'assegnazione della barra delle funzioni &€ sempre visibile se il menu € attivo. Alcuni
pacchetti opzionali potrebbero utilizzare una propria assegnazione della barra delle
funzioni.

Coniltasto TAB si pudo commutare trailivellidiassegnazione della barra delle funzioni
e cosi vengono visualizzati uno dopo I'altro i successivi livelli ogni volta che si preme
il tasto. Con il mouse si puo cliccare, in basso a destra, su >>.
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3.3 Scelta funzioni

Richiamo di una Il richiamo di una funzione o di un editor si esegue in due passi:
funzione 1. selezionare la funzione nel menu principale o nel sottomenu;

2. riempire i campi d’introduzione nel box di comando e confermare questa introdu-
zione.

La funzione viene avviata/eseguita e |'editor viene richiamato.

Figura 3-2  Scelta funzioni nel menu principale e nei sottomenu

STEP 5/ST V7.0
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3.4 Richiamo delle funzioni di Help

Help Online

Richiamo dell’'Help
Online

STEP 5/ST V7.0
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L'Help Online offre informazioni relative al punto in cui & necessario avere maggiori
chiarimenti. In questo modo si possono avere informazioni veloci e precise senza do-
ver andare a consultare i manuali. Nell'Help Online si trova:

Temi dell’'Help : offre diverse possibilita di visualizzare informazioni di aiuto, ve-
dere figura 3-3.

Help relativo al contesto : campo d’introduzione </NFO F7> oppure tasto F7: vi-
sualizza informazioni relative all'oggetto evidenziato o alla finestra di dialogo.

Uso dell’'Help : vedere la figura 3-3, il comando di menu Help » Informazioni
sull'uso »oppureiltasto Help Shift+F8 offre una descrizione delle possibilita che
si hanno a disposizione per trovare precise informazioni nell’Help.

Info : fornisce informazioni sulla versione attuale dell’applicazione.

L'Help Online puo essere richiamato in diversi modi:

1.

3.

In una finestra di dialogo cliccando sul pulsante

Help Shift+F8 oppure premendo il tasto Shift+F8 . Si ottiene cosi un Help gene-
rale per questa finestra di dialogo. Questi testi di pill pagine si possono scorrere
e sfogliare.

Posizionare il puntatore del mouse in una finestra o in una finestra di dialogo sul
tema di cui si desidera I'Help e cliccare sul pulsante /nfo F7 oppure premere il
tasto F7.

Scegliere un comando di menu dal menu Help nella barra di menu.

jone  Documentazione Cambio ‘Help | ’

Lista assegnazione tasti... Ctrl+FI2
Info su versione STEP 5... F12
Versione pacchetti S5... Ctrl+F11

Guida alle finestre
Guida alle schede
Indicazioni generali
Compatibilita
Informazioni hardware

Figura3-3  Comando di menu Help
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3.5 Interfaccia operatore: finestre di dialogo

Introduzioni nelle
finestre di dialogo

Nelle finestre didialogo possono essere digitate informazioni necessarie per eseguire
un determinato compito. Sono disponibili 4 tipi di finestra di dialogo:

e d'informazione

Campi d'introduzione ——»

Box di comando (vedere capitolo 3.6)

Scelta blocco (vedere capitolo 3.9)

STEPS - S5KXS01Z

— Trasferisci
(X) File programma
X) AG

Schedario e schede dello schedario (vedere capitolo 3.7)

Scelta file/directory (vedere capitolo 3.8)

Trasferisci blocchi B

[NONAMEST.S5D]
—>C:\V_700.001\S5_SYS

— in
(X) File programma
X) AG

[NONAMEST.S5D]
—>C:\V_700.001\S5_SYS

— Scelta

(X) Lista blocchi
(X) Blocco [

(X) Tutto il file

] in[

Figura 3-4  Esempio di una finestra di dialogo (qui box di comando)

3-8
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3.6 Box di comando

Funzione Il box di comando € una finestra di dialogo per richiamare un editor o una funzione.
| dati utilizzati in questo formulario si ripercuotono parzialmente sugli elementi con
lo stesso nome nell'impostazione del progetto. | componenti delle finestre di dialogo,
che piu spesso ricorrono, sono illustrati sulla base dell’esempio della figura 3-5:

Elementi operativi L'uso delle finestre di dialogo €& stato, per quanto possibile, uniformato ai programmi
di Windows; questo per avere un’operativita piu omogenea.

Tabella 3-1 Le diverse finestre di operative

Elemento di Funzione
comando
() Campo di Scelta di una alternativa tra tante proposte, con i tasti cursore
scelta 0 mouse
[]1 Campo da Selezionare con una crocetta una o piu impostazioni con il
selezionare tasto F3, con il tasto di spazio o con il mouse.

Finestra con lista | Premendo F3 appare una finestra con una lista in cui ven-
di scelta: gono selezionate le impostazioni predisposte.

Se sono disponibili solo 2 possibilita, con F3 si puo commu-
tare dall’'una all’altra (toggle).

Finestra con lista |La scelta di un elemento della lista avviene con il tasto
Return o il doppio clic del mouse (vedere anche capitolo

3.803.9)
Campo d'intro- In un campo del genere I'introduzione di testi avviene tramite
duzione [...] tastiera, per esempio il nome del file.

Sono ammessi caratteri alfanumerici (senza dieresi).

<Storia F1 > |Scelta di una delle ultime 20 introduzioni

<Edita F2 > |Richiamo dell’editor per il file indicato

<Scegli F3 > | Attivazione della scelta tramite una finestra di dialogo, una
finestra con lista o selezionando con la crocetta un elemento.

< Info F7 > | Avvertenze per riempire i campi d’'introduzione

<Help Shift+F8 > | Help generico relativo alle finestre di dialogo

<Annulla ESC> |L'introduzione viene interrotta.

Leffetto di un campo <...> selezionato puo essere ottenuto anche con i tasti funzio-
nali (vedere tabella 3-2)

STEP 5/ST V7.0
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Tabella 3-2  Tasti funzionali per i campi < >

Effetto

Scelta di una delle ultime 20 introduzioni

Richiamo dell’editor per il file indicato

Attivazione della scelta tramite una finestra di dialogo, una
finestra con lista o selezionando con una crocetta un ele-
mento.

Avvertenze per riempire i campi d’introduzione

Tasti funzionali
F1 = Storia

F2 = Edita

F3 = Scegli

F4

F5

F6

F7 = Info
Shift+F8 = Help

Help generico relativo alle finestre di dialogo

In funzione della posizione in cui la barra verde del cursore si trova, sono ammessi
differenti tasti funzionali. Corrispondentemente i tasti funzionali disabilitati vengono
rappresentati in grigio.

Tabella 3-3  Tasti speciali per i campi d’introduzione

Tasti

Effetto

Num-5:

Commutazione tra modo inserimento e sovrascrittura

SHIFT+Del:

Il campo d’introduzione viene cancellato

Vale solo per i campi d’introduzione !

Tabella 3-4  Operativita tramite mouse e tastiera

Tasti

Effetto

Tasti cursore

Commuta tra i campi di scelta.

Tasti TAB

Commuta tra gli elementi operativi di una finestra di dialogo,
TAB posiziona in avanti a destra/sotto, Shift+TAB indietro a
sinistra/sopra.

ESC

L'introduzione viene interrotta.

Mouse

Posizionamento tramite semplice o doppio click del mouse.

Hotkey

Scelta diretta di un elemento operativo con ALT+Lettera o
ALT+Cifra.

Tasto
d’introduzione

Attiva una funzione con il tasto Return o di Conferma se le
registrazioni della finestra di dialogo sono corrette. Attiva-
zione di una maschera di ricerca nei campi d’'introduzione
con (?) e (*). Attivazione del drive/directory nell’apposito
campo.

3-10
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Memoria dei box di I box di comando dello STEP 5 utilizzano la cosiddetta "memoria” che memorizza sul

comando disco rigido gli ultimi dati indicati, in modo che durante I'impiego di STEP 5 e anche
per impieghi successivi il contenuto di queste finestre di dialogo rimane annotato per
il prossimo richiamo. La memoria comprende le seguenti parti:

e Stato dei campi d’'introduzione e particolari elementi operativi
® Storia dei campi d’'introduzione
* Emissione su video 0 non su video.

STEPS5 - S5KXS01Z

Trasferisci blocchi

—  Trasferisci

(X) File programma [NONAMEST.S5D]

X) AG —> C:\STEP 5\S5_DATEN
— in

(X) File programma [NONAMEST.S5D]

X) AG —> C:\STEP 5\S5_DATEN
— Scelta

(X) Lista blocchi [ ]
(X) Blocco [ ] in[ ]

(X) Tutto il file
— Opzione < Storia F1>

[X] Sovrascrivi con conferma

<Scegli F3>

< Info F7 >
< Help Shift+F8 >

[ <Trasferisci> "< Annulla ESC >

Figura3-5  Esempio di un box di comando

STEP 5/ST V7.0
C79000-G8572-C920-02 3-11



Interfaccia operatore

3.7 Schedario e schede dello schedario

Funzione Il contenuto della finestra di dialogo che si ottiene dopo il comando di menu File »
Progetto » Imposta F4 & organizzato in schede per una migliore visione. | nomi delle
singole schede si trovano sul margine superiore della finestra di dialogo. Per portare
in "primo piano” una precisa scheda si deve cliccare sul nome dello scheda.

3.7.1 Uso dello schedario

Fondamentalmente per usare le schede si usano gli stessi elementi disponibili per
le finestre di dialogo.

A

Lo schedario € costituito da piu "schede”, quando una scheda viene scelta copre tutte
le altre.

Con I'aiuto degli hotkey ALT+Cifra si pud commutare tra le schede. Una commuta-
zione tra le schede puo essere eseguita anche posizionando il mouse o tramite i tasti
cursore.

Tasti Effetto

F3 Il cursore deve stare sulla sigla del campo d’introduzione
1. | parametri impostati possono essere cambiati con F3
(per esempio SI/NO o RW/PROT).
2. FE’ stato attivato un box di scelta.
Selezionare tramite il cursore.

Le introduzioni vengono confermate col tasto di
introduzione o con un doppio clic.

3. FE’ stato visualizzato un box di scelta file.
In esso ci si puod spostare e selezionare un file
(box di comando).

ALT + Scheda Commuta su una pagina dello schedario, per esempio ALT+2
porta alla scheda 2

F7 Viene emesso un testo di informazione relativo al campo su
cui si trova il cursore.

Shift F8 Si ottiene I'Help operativo generale

STEP 5/ST V7.0
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Memoria Lo STEP 5, abbandonando lo schedario, memorizza la scheda corrente attiva come
pure la posizione del cursore nella scheda; questi vengono selezionati automatica-
mente con un nuovo accesso. Questo vale solo durante una seduta di STEP 5.

STEPS5 - S5KXS01Z

Figura 3-6  Finestra di dialogo: Schedario
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3.8 Scelta di file e directory

Funzione

Operativita

File

Maschera di ricerca

3-14

Lista file

Con questa finestra di dialogo possono essere scelti file (box di scelta file) o directory
(box di scelta directory) potendo cosi spostarsi sul drive e nelle directory. La struttura
dei due box di scelta € uguale.

Seilboxdicomandodarichiamare attende unnome didirectory (boxdisceltadirectory)
possono essere scelte directory DOS. Abbandonando questafinestra didialogo viene
acquisito il nome della directory scelta, ma non il nome di file eventualmente scelto.

Per alcuni tipi di file, questa finestra di dialogo, offre in pit un supporto che viene illu-
strato nell’Help del corrispondente box di scelta.

Traisingolicampi, sipud commutare con TAB (inavanti) e Shift+TAB (indietro). Avver-
tenze sull’'uso generale di un box di scelta file si ottengono premendo il tasto Shift+F8
o0 attivando il button <Help Shift+F8 >. In questo modo si possono avere informazioni
sui singoli elementi ed il loro utilizzo.

Premendo il tasto F7 o attivando </nfo F7> si ottengono informazioni supplementari
sul campo d’introduzione selezionato.

In questo campo d’introduzione puo essere digitato un nome di file 0 una maschera
diricercaperilnomedelfile. Segliultimiseicaratteridelnome delfile sono preassegnati
non possono essere modificati (per esempio ST.S5D).

In questo campo puo essere indicato anche una lettera per il drive o un percorso di
directory. Premendo il tasto di introduzione questi dati vengono acquisiti. In questo
modo vengono aggiornati il contenuto della lista di file ed il drive/directory. Con I'aiuto
di punti interrogativi come simboli per un posto fittizio, puo essere indicata una cosid-
detta maschera di ricerca.

Senelcampo Fileé stataindicatauna mascheradiricercautilizzandoipuntiinterroga-
tivi "???”, premendo il tasto d’interruzione viene aggiornata la lista di file.

All'interno di questa lista viene visualizzata ancora una volta, per controllo, la ma-
schera di ricerca. Fino a quando la maschera di ricerca € attiva, cioe ancora non &
stato scelto alcun nome di file, il box di scelta file pud essere solo interrotto.

Seilboxdicomando, dacuie stataavviatalasceltafile, permette diavere puntiinterro-
gativi nel campo del nome del file, il box di scelta file puo essere eventualmente con-
cluso con punti interrogativi nel campo File.

In questa finestra parziale viene visualizzata la lista completa dei file della directory
impostata. Questa visualizzazione viene definita da una eventuale maschera di ri-
cerca indicata.

Se si passa nel campo della lista, appare un cursore di colore verde o blu. Il cursore
blusignificacheancoranonestatosceltoalcunelementodellalistae nelcampod’intro-
duzione Filesuperiore non é statoindicatoalcunnomedifile. Incasocontrarioil cursore
appare verde. Introducendo un carattere alfanumerico (cifra o lettere), si tenta di posi-
zionarsi su un elemento della lista che inizi con questo carattere.

STEP 5/ST V7.0
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Drive/Directory  Conl'aiuto di questo campo con lista ci si pud spostare sul drive DOS e nella directory,
cioé sicambiail corrente percorso didirectory DOS. Introducendo un carattere alfanu-
merico (cifra o lettere), si tenta di posizionarsi su un elemento della lista che inizi con
questo carattere.

Ordinamento  Lalistadifile pud essere ordinata in senso crescente o decrescente per nome, tempo
(data e ora) e dimensione. La lista Drive/Directory puo essere ordinata in senso cre-
scente o decrescente.

Avvertenza

Nella lista di file o in drive/directory ci si puo spostare anche, introducendo carat-
teri alfanumerici, sull’elemento successivo che inizia con questi caratteri.

STEPS5 - S5KXS01Z

Figura 3-7 Finestra di dialogo: Scelta file/directory
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3.9

Scelta blocchi

Funzione

Operativita

3-16

Blocco

Lista blocchi

Tipi di blocco

Con questa finestra di dialogo vengono scelti i blocchi. Il box di scelta blocchi viene
richiamata con F3 o0 attivando <Scegli F3> in un campo d’introduzione per i blocchi.
Le possibili introduzioni si ottengono con F7 o attivando <Info F7>.

Con l'aiuto della scelta blocchi questa introduzione puo essere semplificata e limitata
ai blocchi effettivamente utilizzati. Tra i campi si commuta con TAB e Shift+TAB .
Sono disponibili i seguenti elementi:

* Blocco
¢ Lista blocchi

¢ Tipi di blocco

Traisingolicampisicommutacon TAB (in avanti) e Shift+ TAB (indietro). Informazioni
sull’'usogenerale diunboxdisceltafile siottiene premendoiltasto Shift+F8 oattivando
il button <Help Shift+F8> . In questo modo si possono avere informazioni sui singoli
elementi ed il loro utilizzo.

Premendo il tasto F7 o attivando </nfo F7> si ottengono informazioni supplementari
sul campo d’introduzione selezionato.

In questo campo d’introduzione pud essere introdotto un nome di blocco. Possono
essere utilizzati tutti i tipi di blocco visualizzati nella lista dei tipi di blocco. Questa lista
di tipi di blocco ammessi viene definita a seconda della finestra di dialogo in cui la
scelta blocco e stata richiamata.

In questafinestra parziale viene visualizzata la lista completa dei blocchi esistenti (nel
file programma e nell’AG) i cui tipi coincidono con il tipo di blocco impostato. Se si
passa nel campo della lista, appare un cursore di colore verde o blu. Il cursore blu
significache ancoranon é stato scelto alcun elemento dellalista e nel campo d’introdu-
zione "Blocco” superiore non é stato indicato alcun nome di blocco. In caso contrario
il cursore appare verde.

In questa lista dei tipi di blocco vengono elencati i correnti tipi ammessi. Dopo aver
scelto un tipo di blocco con il mouse (doppio clic o con il tasto d’introduzione) il conte-
nuto della lista di blocchi viene aggiornato.
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Avvertenza

Nella lista di file o in drive/directory ci si puo spostare anche, introducendo carat-
teri alfanumerici, sull’elemento successivo che inizia con questi caratteri.

STEP 5 Window Mode - S5KXS01Z

Figura 3-8  Finestra di dialogo: Scelta blocco
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Creazione e maodifica di progetti

Sommario

Informazioni sul
capitolo

Sommario del
capitolo

STEP 5/ST V7.0
C79000-G8572-C920-02

I progettirappresentanol'insieme dituttii datie i programmidiunasoluzione diautoma-
zione. Essi servono a memorizzare in modo ordinato i dati e i programmi relativi, du-
rante le fasi di creazione della soluzione di automazione. | compiti principali che si
affrontano creando un progetto sono quelli di approntare questi dati e di generare i
programmi.

La prima parte di questo capitolo descrive le componenti pitl importanti che costitui-
scono un progetto. Sulla base di questo capitolo, si prende confidenza con gli oggetti
pit importanti di un progetto STEP 5 e con i concetti usati. Nella seconda parte invece
viene descritto come vengono manipolati gli oggetti di un progetto, come per esempio
copia, trasferimento, confronti e cancellazione.

\\_ Editor Test AG Gestione J

Progetto >

Blocchi >

File DOS >

File PCP/M >

1 C:\STEP5\S5_DATEN\TEST1EPX.INI Qui vengono elencati al

2 C\STEP5\85_DATEN\TEST2EPX|N| massimo 5 file di progetto

3 C:\STEP5\S5_DATEN\TEST3EPX.INI gia memorizzati

Comandi DOS Ctrl+F10

Chiudi Shift+F4
Capitolo Argomento trattato Pagina
4.1 Impostazioni del progetto 4-2
4.2 Gestione dei blocchi 4-13
4.3 File DOS 4-22
4.4 File PCP/M 4-26
4.5 Comandi DOS CTRL+F10 4-30
4.6 Chiusura con SHIFT+F4 4-30
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4.1 Impostazioni del progetto

Sommario Prima di iniziare a programmare con lo STEP 5, definire le seguenti posizioni:
* una parte o anche tutti i nomi dei file necessari al programma utente,
* uno o piu directory del progetto in cui tutti i file vengono memorizzati e
* | parametri specifici, come tipo di rappresentazione o funzionamento,

Queste impostazioni devono essere eseguite con lo STEP 5 soltanto una volta. Indi-
cando una sola volta le directory in cui devono essere memorizzati i file appartenenti
ad un progetto, viene semplificata I'organizzazione del lavoro di programmazione.
Lo STEP5 memorizza tutte queste impostazioniin un file progetto (*PJ.INI), copiabile
e pertanto trasportabile. E quindi disponibile un elenco di tutti i dati rilevanti di un pro-
getto.

Questeimpostazioni sipossono modificare ed adattare anuove condizioniin qualsiasi
momento. Caricando un certo file progetto, sono subito disponibili questi dati e si pud
quindi iniziare a programmare senza dover eseguire nuovamente le impostazioni.

Struttura del Lafigura4-1mostracome sono organizzatiil file progetto edirelativifile di programma.

progetto Il file progetto si trova nella stessa directory di lavoro dei file. A questi file fanno riferi-
mento le impostazioni nel file progetto. Fanno eccezione il file stampante ed i file via.
Essi sitrovano, gia preconfigurati, nella directory di sistema S5_SYS, dopo una modi-
fica eseguita nella directory S5 _S5HOME.

Directory di progetto
‘ C:\ANLAGE1\MOTORHA  (Impostato nel file progetto)

File progetto (*PX.INI)

MOTORI1PX.INI
Con impostazioni dei file progetto

Directory di lavoro:  C:\ANLAGE1\MOTORHA
File programma: C:\MOTOR1ST.S5D
File QVL: C:\MOTOR1XR.INI
File simbolico: C:\MOTOR1ZO0.INI
File sequenziale: ~ C:\MOTOR1Z0.SEQ
File piedinatura: CA\SCHRMOF2.INI
File SYSID: C:\EPROM2SD.INI
File via: PFAD11AP.INI

File istruz. dicom.: C:\STEU11SU.INI
File stampante: DR210HDR.INI

File documentazione: C:\MOTORILS.INI

MOTOR1ST.S5D
MOTORLXR.INI
MOTOR1Z0.INI
MOTOR1Z0.SEQ

]
~—— Directory di sistema (55_HOME 0 S5_SYS)

-

Figura4-1  Organizzazione del file progetto e del relativo file programma.
La struttura del progetto qui rappresentata € una di quelle possibili (vedere capitolo 4.1.1 sotto
Opzione Schedario).

DR210HDR.INI PFADI1AP.INI

STEP 5/ST V7.0
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Funzioni Le seguenti funzioni sono disponibili nel menu File:
 File |
Progetto > e File » Progetto » Imposta F4 . Impostare tutti i parametri necessari per un pro-

getto selezionabile. Essi sono:

— Ifile che appartengono ad un progetto. Questi file sono fondamentalmente im-
postati o richiamati nei box di comando, di scelta o nelle maschere.

— | parametri come per esempio simbolico, rappresentazione (KOP, FUP, AWL),
set di caratteri, ecc. Se le impostazioni di un progetto sono state eseguite, solo
gueste possono essere modificate.

* File » Progetto » Carica... F10. Vengono caricate tutte le impostazioni di un pro-
getto selezionabile. Dopo che il progetto e stato caricato, vengono resi disponibili
solo quei file che appartengono al progetto da elaborare.

* File » Progetto » Salva. Tutte le impostazioni vengono salvate nel file specifico
del progetto.

* File » Progetto » Salva come ... Tutte le impostazioni vengono salvate in un file
(nuovo) specifico del progetto.

Avvertenza

Le impostazioni vengono mantenute anche se lo STEP 5 viene chiuso. Con la
prossima seduta vengono mantenute le ultime impostazioni.

Attivando il tasto < Edita F2 > si possono richiamare immediatamente gli editor
associati alle schede Blocco, Simbolico, Documentazione.

| file di sistema hanno nel loro nome un campo (per esempio *Z0.INI) che ¢ fisso e
che pud essere completato con 1 fino a 6 caratteri. Per esempio il file simbolico
BSP409Z0.INI e identificato conla parte rappresentatain grassetto ed e stato comple-
tato con la denominazione BSP409.

STEP 5/ST V7.0
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411 Impostazione progetto
 File | Primadiiniziarelaverae propria programmazione bisogna impostare tutti i parametri
Progetto > necessari per il progetto in una finestra di dialogo sotto forma di schedario. Selezio-
Imposta F4 nare il comando di menu File » Progetto » Imposta F4. In questo modo viene aperto

lo schedario (vedere figura 4-2).

La finestra di dialogo & organizzata in schedario (nella figura 4-2 € rappresentata la
scheda AG). | parametri impostati (per esempio nomi file) vengono automaticamente
registrati, successivamente, nel box di comando o di scelta interessati.

Figura4-2  Impostazione progetto (scheda 1 = AG)

Avvertenze | campi d'introduzione si raggiungono con i tasti Cursore o con il tasto TAB per spo-

operative starsi in avanti e SHIFT+TAB per spostarsi all'indietro. Altre informazioni si trovano
nel capitolo/3.7/ o nell’Help Online con il tasto SHIFT+F8 o selezionando < Help
Shift+F8 > .

STEP 5/ST V7.0
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Scheda AG

Tipo di
funzionamento

Offline

Online

Dinamico

Modifica

Senza
Stop

Ciclica

Tipo AG:

Interfaccia:

STEP 5/ST V7.0
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Funzionamento: Online Modifica: Ciclica
Tipo AG: AG 100U Identif-CPU CPU 90
Interfaccia: AS511

Parametri: COM1:STANDARD

Nome via [ ]

File via [NONAMEAP.INI]

—> in directory sistema
Opzione via: No

Non & impostato alcun collegamento con AG.

Esiste un collegamento con AG. Il test e la modifica dei programmi utente (blocchi)
nell’AG sono possibili tramite il collegamento fisico e logico:

* Se e stato impostato un nome di via, il collegamento avviene via bus.

* Se non e stato impostato alcun nome di via, il collegamento avviene diretta-
mente.

La costruzione del collegamento viene testata. Se non viene costruito alcun colle-
gamento, viene emessa la segnalazione Superamente tempo AG . Con l'inter-
ruzione del collegamento PG-AG, il PG & nuovamente utilizzabile solo dopo che
il tempo di controllo e trascorso.

Questo modo & impostabile solo se il collegamento avviene via bus. Il collega-
mento esiste solo durante I'accesso; in caso contrario viene abbattuto.

I modo Modifica dei programmi nell’AG & impostabile. Con F3 viene visualiz-
zato un box con i possibili tipi di modifiche. E impostabile:

Un programma nell’AG non puo essere modificato.
Un programma nell’AG pu0 essere modificato solo con I'AG in STOP.

Si ha la possibilita di modificare un programma nellAG anche durante I'elabora-
zione ciclica.

Se é stato costruito un collegamento con AG, qui viene indicato il tipo di AG.

Dopo aver premuto F3 vengono visualizzate le possibili interfacce tra le quali se
ne puo scegliere una. L'interfaccia AS511 € preimpostata. Con questa interfac-
cia € possibile la scelta del tipo di funzionamento diretto. Per le altre interfacce
deve essere editata la via di bus prima di poter scegliere il tipo di funziona-
mento.
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Parametri: Oltre all'interfaccia attivata sono possibili le seguenti impostazioni:
Standard: preimpostazione della rispettiva interfaccia
Per AS511: COM 1-COM 4 ed in piu i driver speciali 1-7

Con questi parametri € possibile parametrizzare (tempi di attesa, tempi d’interru-
zione ecc.) l'interfaccia H1 e L2. | parametri impostabili vengono letti per 'H1 da
S5@@@@H1.INI e per I' L2 da SS5@@@@L2.INI.

Per l'interfaccia AS511 i parametri dei file AS511S01.DAT-AS511S07.DAT sono
stati acquisiti in SS@@ @ @AS.INI.

Nome via Nome sotto cui viene memorizzata la via editata (capitolo 12.1 \Via bus). Se si
indica il nome via ed il file via, cambiando il tipo di funzionamento si tenta di co-
struire 0 abbattere il collegamento che e registrato sotto questa via.

Durante la costruzione del collegamento viene segnalato Attivazione col-
legamento in corso . Se non si verifica alcun collegamento, dopo aver ten-
tato di costruire il collegamento viene emessa la segnalazione Superamento
tempo AG .

File via Nome del file in cui vengono memorizzati i singoli nomi delle vie. Questo file si
trova nella directory S5_SYS\AP_INI gia preconfigurato e dopo la modifica si
trovera nella directory S5_HOME. Se un AP.INI viene creato per la prima volta
cioé nuovo, viene memorizzato sempre nella directory S5_HOME.

Opzione via

No 1 file che sono associati ad una via di bus non vengono acquisiti.

Richiesta Se i file sono associati ad una via di bus, e questa via € impostata, essi ven-
gono acquisiti globalmente nella preimpostazione solo dopo una richiesta.

Sempre Se i file sono associati ad una via di bus, e questa via &€ impostata, essi ven-
gono acquisiti globalmente nella preimpostazione senza richiesta.

STEP 5/ST V7.0
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Scheda Blocchi File programma  [NONAMEST.S5D ] RW

—> C:\STEP5\S5_Daten

Lista incrociata NONAMEXR.INI
—> C:\STEP5\S5_Daten

Rappresentazione: KOP
Indirizzi AWL: WORD

[ ] con commenti
[ ] con somma di controllo

File programma Al file puo essere dato qualsiasi nome di 6 caratteri, I'estensione & ST.S5D. In
€SS0 vengono gestiti tutti i blocchi S5.

Se viene scelto un nome di file programma gia esistente e per questo non esiste
alcuna lista incrociata (File XREF), appare un box in cui viene data la possibilita
di crearne immediatamente una.

1. Se non si indica alcun nome viene acquisito automaticamente I'ultimo
nome registrato.

2. Se si indicano meno di 6 caratteri , il nome viene completato con
caratteri @.

Modo file Modo impostabile con:
RW: E possibile la lettura e scrittura

PROT: Siriserva il diritto esclusivo di accesso al file.
Accessi da altri sistemi S5 non sono piu possibili.

Modo file dello STEP 5 impostato:

GESP: Il file &€ impegnato in scrittura. Un altro sistema S5 accede a
questo file. Non appena questo accesso & terminato
I'impostazione non € piu valida.

RO: E possibile solo la lettura.

Lista incrociata E il nome del file (*XR.INI) che contiene la lista incrociata. Viene solo visualiz-
zata e non € modificabile. Come essa viene creata € descritto nel capitolo 17.1
(Gestione, Genera XREF).

Rappresentazione Per I'editazione dei blocchi di programma si pud scegliere tra:
AWL, KOP, FUP.

Indirizzi AWL In AWL gli indirizzi relativi delle istruzioni vengono visualizzati con:
WORL a parole
Byte a byte
[X]Jcon commento Vengono emessi anche i commenti
[ Non vengono emessi i commenti alle righe, i commenti ai segmenti ed i titoli
dei segmenti

[X] consomma dicontrollo Accedendo ai blocchi in AG viene calcolata la somma di controllo (checksum)
durante la scrittura e controllata in lettura.

Premendo il tasto < Edita F2> si possono richiamare immediatamente gli editor associati. Le opzioni Sovrascrivi con conferma, Ag-
giorna lista attribuzione e Aggiorna XREF vengono desunte dal box di comando evidenziato.

STEP 5/ST V7.0
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Scheda
Simbolico

File simbolico 1)

Lista di
attribuzione 1)

Lunghezza
simbolico

Lunghezza
commento

[X] Visualizzazione
simbolica

(]

[X] Operandi simbolici

[]

File simbolico [NONAMEZO.INI ] RW
—> C:\STEP5\S5_Daten

Lista attribuzione [NONAMEZ0.SEQ ] RW
—> C:\STEP5\S5_Daten

Lunghezza simbolico [81]
Lunghezza commento [24]

[1 Visualizzazione simbolica
[ ] Operandi simbolici

E il nome del file simbolico (*Z0.INI). Se si imposta questo file insieme al campo
da selezionare con crocetta, [x] Visualizzazione simbolica , Si puo ope-
rare con gli operandi simbolici negli editor e nelle emissioni di documentazione.
Questo significa che agli operandi assoluti sono associati simbolici e commenti
simbolici. L'associazione viene creata con I'editor simbolico. Non appena questo
file & impostato, avviene automaticamente I'impostazione del file sequenziale.

La lista di attribuzione ¢ il file sorgente (*Z0.SEQ) che si imposta non appena &
stato denominato il file simbolico, editato con I'editor simbolico. Non appena si
conclude I'editazione si genera il file simbolico.

In caso di mancanza della lista di attribuzione, questa pud essere rigenerata a
ritroso dal file simbolico.

La lunghezza del simbolico, durante la creazione della lista, & impostabile libera-
mente e puo essere da 8 a 24 caratteri.

La lunghezza puo essere aumentata successivamente; € possibile invece un

accorciamento successivo solo fino alla lunghezza del simbolo piu lungo pre-

sente nel file. Si deve in questo caso cancellare il file simbolico (*Z*.INI) asso-
ciato.

La lunghezza del commento durante la prima generazione puo essere al mas-
simo di 40 caratteri.

La lunghezza puo essere aumentata successivamente; € possibile invece un
accorciamento successivo solo fino alla lunghezza del commento piu lungo pre-
sente nel file. Si deve in questo caso cancellare il file simbolico associato
(*Z*.INI).

E possibile l'introduzione e I'emissione di operandi simbolici.
Per fare cio deve essere indicato un file simbolico.

L'introduzione e I'emissione degli operandi simbolici avviene in assoluto

Gli operandi vengono visualizzati in simbolico. Se i simbolici sono pit lunghi di 8
caratteri, nelle rappresentazioni KOP e FUP vengono troncati.

Gli operandi vengono visualizzati in assoluto. Emissione simbolica nella riga 3 in
KOP/FUP. In AWL in assoluto e simbolico.

1) Iduefile Z0.INle Z0.SEQ sipossono scegliere liberamente. Non appena uno dei due viene impostato/ scelto nuovo, I'altro viene
aggiornato (cioé i due file hanno lo stesso nome fino alla estensione del file).

Attivandoiltasto <EditaF2> possono essererichiamatiglieditorassociati. Le opzioni Sovrascrivicon conferma, Aggiornalistaattribu-
zione e Aggiorna XREF vengono desunte dal box di comando evidenziato.
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Scheda
Documentazione File piedinatura [NONAMEFL1.INI ]
—> C:\STEP5\S5_Daten
File istr. Comando [NONAMESU.INI ]
—> C:\STEP5\S5_Daten
File stampante [NONAMEDRI.INI]
—> in directory sistema
Interfaccia stampante: da file stampante
Caratteri: ASCII Piedinatura: No
Documentazione su
(X) Stampante
( X File [NONAMELS.INI]
—> C:\STEP5\S5_Daten
File piedinatura E il nome del file piedinatura. In questo file viene memorizzata una piedinatura.
La piedinatura viene creata con I'editor piedinatura e viene emessa alla fine
della pagina se nel campo piedinatura € stata scelta la relativa grandezza.
Questa piedinatura viene emessa automaticamente con Documentazione. A
seconda di quanto indicato nel campo d’introduzione Piedinatura , viene regi-
strato
F1.INI : per una larghezza della piedinatura di 80 caratteri
F2.INI : per una larghezza della piedinatura di 132 caratteri.
File istruzioni In questo file si possono memorizzare i comandi per creare una voluminosa
di comando documentazione con il KOMDOK. Vedere Editazione delle istruzioni di co-
mando o editazione struttura (capitolc18.4).
File stampante In questo file devono essere memorizzati i caratteri di controllo della propria
stampante per commutare la densita di scrittura.
Ed anche i parametri:
e formato (A4 / A3)
* righe per pagina
* parametri opzionali
Il file si trova gia preconfigurato nella directory S5_SYS\AP_INI. Se viene edi-
tato un file di questo tipo, esso viene copiato nella directory S5_ HOME e quindi
vengono eseguite le modifiche. Se viene creato un nuovo DR.INI, questo
viene, di principio, memorizzato nella directory S5_ HOME.
Se non viene indicato alcun file sono validi i parametri della PT88.
Interfaccia dal file stampante:
stampante l'interfaccia stampante viene acquisita dai parametri della stampante (DR.INI).
LPT1, LPT2, LPT3:
Scelta dell'interfaccia stampante; queste impostazioni non si ripercuotono sui
parametri della stampante (DR.INI).
Set di caratteri E valido solo nell’emissione confortevole (vedere capitolo 18.1),
ASCIL:
La documentazione € realizzata solo con i caratteri del set di caratteri ASCII.
Per esempio: '—][——( )—]!

SEMI-GRAFICA:
La documentazione é realizzata con i caratteri del set di caratteri IBM
Per esempio: | —][——( )—|

STEP 5/ST V7.0
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Piedinatura
No:
80:
132:

Documentazione su
(X) Stampante

(X) File
[*LS.INI]

Nella documentazione non viene emessa alcuna piedinatura.
Viene emessa una piedinatura larga 80 caratteri.
Viene emessa una piedinatura larga 132 caratteri.

La documentazione viene emessa su stampante

Tutte le emissioni su stampante vengono scritte nel file indicato (*LS.INI). Se
questo file esiste gia, vengono aggiunti i nuovi dati.

1) lduefile Z0.INle Z0.SEQ sipossono scegliere liberamente. Non appena uno dei due viene impostato/ scelto nuovo, I'altro viene
aggiornato (cioé i due file hanno lo stesso nome fino alla estensione del file).

Attivandoiltasto <EditaF2> possono essererichiamatiglieditorassociati. Le opzioni Sovrascrivicon conferma, Aggiornalistaattribu-
zione e Aggiorna XREF vengono desunte dal box di comando evidenziato.

Scheda Opzioni

Directory di
progetto

[X] Conferma sempre
[X] Salva impostazione del

progetto

[1 Memorizza pacchetto
opzionale attivo

[ 1 Messaggi
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Directory di progetto [NONAMEST.S5D ]
—> C:\STEP5\S5_Daten

Uscendo da STEP 5/ST:
[X] Conferma sempre
[X] Salva impostazioni del progetto
[ ©] Memorizza pacchetto opzionale attivo

[1 Messaggi per incompatibilita con V6.x

Con l'indicazione di questo percorso DOS possono essere impostati (fino a
*AP.INI e *DR.INI), in modo uguale, i percorsi di tutti i file delle impostazioni del
progetto.

Chiudendo lo STEP 5 viene fatta una richiesta da confermare

Se si attiva questa opzione, le impostazioni di progetto modificate, dopo una
conferma, vengono salvate nel progetto attuale, abbandonando lo STEP 5 e
caricando un nuovo progetto.

Se questa opzione é stata attivata, un pacchetto opzionale (GRAPH 5, COM
155H, COM 95F) attivo al momento in cui si € abbandonato lo STEP 5, viene
avviato automaticamente richiamando ancora lo STEP 5

Con questa opzione si controlla automaticamente se le indicazioni dei percorsi
DOS corrispondono alle limitazioni della Versione 6.x dello STEP 5. Queste
sono:

— Drive A: fino J: per il file programma
— Drive A: fino P: per i restanti file
— Per ogni drive pu0 essere utilizzata al massimo una directory.

Se i criteri non vengono rispettati lo STEP 5 emette i corrispondenti messaggi.
Con questa opzione si puo ottenere che i file attualmente impostati siano com-
patibili con le impostazioni di progetto della Versione 6.x.
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Scheda EPROM

Tipo PROMMER
Nessuno
Interno
LPTn esterno

File SYSID

Tipo di
funzionamento

WORD
WORD/BLOCK
BYTE

STEP 5/ST V7.0
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Tipo PROMMER: Interno

File SYSID [NONAMESD.INI ]
—> C:\STEP5\S5_Daten

Funzionamento: WORD

Scelta con un doppio clic del cursore o con il tasto F3

Non viene utilizzato nessun PROMMER.

Viene utilizzato il PROMMER interno.

Viene utilizzato un PROMMER esterno collegato all'interfaccia parallela.
Contiene le identificazioni del sistema. La scelta viene eseguita tramite il box di
scelta file con un doppio clic del cursore o con il tasto F3

Se la funzione SYSID & OFF, i blocchi SYSID trovati sul modulo nel file SYSID
vengono memorizzati automaticamente. Se la funzione SYSID e ON, il blocco
contenuto nel file SYSID viene scritto sul modulo a partire dall'indirizzo 0.

E il tipo di memorizzazione dei dati (programmi e blocchi dati) sul modulo. Si
sceglie con un doppio clic del cursore o con il tasto F3.

Scrittura e lettura a parole, per esempio AG135 e AG150 (tutti i tipi)

Scrittura e lettura a byte, per esempio AG155 (tutti i tipi)

E obbligatorio con la CPU 946/947 (modulo di memoria 355). Per AG 155H il
primo carattere utile di un blocco si trova sul limite di un paragrafo (16 byte).

4-11



Creazione e maodifica di progetti

4.1.2 Caricamento del progetto
\ File Con questa funzione si caricano le impostazioni fatte al punto 4.1.1 e memorizzate
Progetto > in un file *PX.INI. Tutte le nuove impostazioni vengono sovrascritte con il carica-
Carica ...F10 mento. Dopo il caricamento valgono solo le impostazioni esistenti nel relativo file

PX.INI, queste sono pero modificabili. | parametri che sono stati preimpostati ven-
gono registrati automaticamente nei box di scelta, in quelli di comando o nelle ma-
schere in cui sono necessari.

Scegliere il comando di menu File » Progetto » Carica ... F10. Viene aperto il box
di comando Carica impostazioni progetto. In esso selezionare un file *PX.INI. Dopo
il caricamento tutte le impostazioni vengono caricate dal file *PX.INI.

4.1.3 Salvataggio del progetto

_ File Con cid vengono salvate le impostazioni attuali fatte al punto 4.1.1. Nel file *PX.INI.
Progetto > viene salvato quello che é attualmente impostato.
Sal . : . - . . .
ava Selezionare il comando di menu File » Progetto » Salva. Viene visualizzato un box
di segnalazione in cui si deve decidere se salvare o0 meno.
4.1.4 Salvataggio del progetto... come
\ File Con cid vengono salvate le impostazioni attuali fatte al punto 4.1.1. Esse vengono
Progetto > salvate nel file *PX.INI selezionabile .
Salva come...

4-12

Selezionare il comando di menu File » Progetto » Salva come ... . Viene visualizzato
il box di comando Salva impostazioni progetto. In esso selezionare un file *PX.INI
0 crearne uno nuovo.
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4.2 Gestione dei blocchi

_ File

Blocchi >

Con le funzioni di questo sottomenu vengono gestiti nella directory di lavoro i
blocchi ed i file di documentazione dei file programma.

Piu precisamente si puo:

e Emettere I'indice del contenuto

e Trasferire i blocchi ed i file di documentazione
¢ Confrontare i blocchi

* Cancellare i blocchi ed i file di documentazione

e Controllare e comprimere i blocchi nel file programma

421 Indice blocchi

Sommario

STEP 5/ST V7.0
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Possono essere emessi i seguenti indici blocchi:

Dal file programma impostato

¢ di tutti i blocchi

e di tutti i file di documentazione

e i tutti i blocchi registrati nella lista blocchi

e i tutti i blocchi di un tipo

Dal controllore programmabile la lista degli indirizzi dei blocchi
¢ dei blocchi registrati nella lista blocchi

e i tutti i blocchi

e i tutti i blocchi di un tipo in funzione del tipo di AG.

Avvertenza

Durante I'emissione sul video si ottiene un altro box di comando in cui scegliendo
un blocco visualizzato si passa direttamente nell’editor (vedere Emissione sul
video).
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_ File

Blocchi >
Indice ...F3

Introduzione

Selezionare il comando di menu File » Blocchi » Indice...F3. Viene visualizzato il
box di comando Indice blocchi: impostazioni. In esso effettuare la scelta (vedere
capitolo|3.9). Dopo l'impostazione e I'attivazione di < Emetti> vengono emessi gli
indici dei blocchi selezionati sul dispositivo desiderato.

Con I'emissione su video, premendo F2 si puo anche passare direttamente all’editor.

Chiarimento

Indice di

(x)File
programma

(X)AG

Scelta

Lista blocchi

[ ]

Emetti su

(x) Schermo
(x) Stampante
(x) File [

Opzione
Tipo protocollo:

[X]JAssieme a
preintestazione:

[X]FB con nome:

< Emetti >
(OK)

4-14

]

Questo campo indica il file programma attualmente impostato.

Questo nome puo essere editato, oppure tramite F3 pud essere sostituito con
un nome di file gia esistente servendosi del box di scelta file.

Indica su quale AG & memorizzato il blocco. L'introduzione avviene tramite /m-
postazione (vedere capitolo relativo) e solo in funzionamento Online.

Qui si trova la scelta blocco. | dati del blocco possono essere introdotti in asso-
luto o in simbolico (anche in modo misto). Se si vuole editare un blocco gia esi-
stente o visualizzare gli attuali tipi di blocco ammessi, premere F3 0 selezionare
il campo < Scegli F3 >. Una lista delle attuali possibili introduzioni viene offerta
dallo STE 5 se si preme F7 o selezionando il campo < Info F7 >.

Gli indici vengono visualizzati sullo schermo.
Gli indici vengono emessi su stampante.

Gli indici vengono scritti in un file selezionabile. Tramite doppio clic del mouse o
F3 si ottiene un box di scelta per selezionare il file.

Il protocollo si seleziona con un doppio clic del mouse sul campo d’introduzione
o con F3.

selezionando qui con una crocetta vengono emesse anche le preintestazioni del
blocco.

selezionando qui con una crocetta vengono emesse le FB con i nomi.

Il PG trasferisce i blocchi selezionati. Se si verificano degli errori, nel box di
scelta vengono offerte delle alternative che si possono scegliere secondo le pro-
prie esigenze.
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Esempi
d’introduzione

Blocco singolo

Lista blocchi

Gruppo di blocchi

Tipo di blocco

Blocco DOK

STEP 5/ST V7.0
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Lista blocchi [ ] L'indicazione del blocco avviene in assoluto o in
simbolico, sono possibili anche indicazioni miste.

Il blocco singolo viene indicato in assoluto o in simbolico.

[PB100O ]
[DX 14 ]
[OB 10 ]
[FKX 231 ]
[-Impiantol ]

E una lista con un massimo di 6 blocchi singoli. | blocchi sono separati tramite una
virgola. Se la virgola e seguita da un nome simbolico, immediatamente prima della
virgola deve essere inserito "\" per delimitare il simbolico.

[ PB100O, PB123 ]
[ -Impiantol)\, -Impianto2 ]

[ -Impiantol\, FB45, -Impianto2\,-Comando ]

Il gruppo viene identificato con 2 singoli blocchi. | blocchi sono separati tramite un
trattino. Se il trattino & seguito da un nome simbolico, immediatamente prima della
virgola deve essere inserito "\" per delimitare il simbolico. | due blocchi del gruppo
devono essere dello stesso tipo; il numero del primo blocco deve essere piu piccolo
di quello del secondo.

[ PB100 - PB123 ]
[ -Impiantol\- -Impianto2 ]
[ -Impiantol\- FB45 ]

Introduzione di tutti i tipi di blocco

[PB Jtutti i blocchi di programma

[B Jtutti i blocchi (ma senza blocco DOK)
[ OK Jtutti i commenti agli OB

[ DB Jtutti i blocchi dati

[# Jtutti i blocchi DOK

Blocco preceduto dal simbolo #

[ #MOT_P ]
[ #DBDO.003 ]
[ OK#OBDO.024 ]
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Emissione sullo L'emissione sul video avviene in un proprio box di comando:
schermo Blocchi-Indice-File programma: Emetti

Per editare e/o modificare procedere come segue:
1. Selezionare un blocco dalla lista.

2. Premere il tasto F2 o attivare < Edita F2 >. Lo STEP 5 apre a questo punto la
finestra dell’editor associato a questo blocco (Salto veloce nell’editor).

Figura 4-3  Blocchi-Indice-File programma: Emetti

1) Idue file Z0.INI e Z0.SEQ si possono selezionare liberamente. Non appena uno dei due viene impostato / scelto nuovo, I'altro
viene aggiornato (cioé i due file hanno lo stesso nome fino alla estensione del file).

Attivandoiltasto<EditaF2> possono essererichiamatigli editor associati. Le opzioni Sovrascrivicon conferma, Aggiornalistaattribu-
zione e Aggiorna XREF vengono desunte dal box di comando evidenziato.
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422 Copia di blocchi

Sommario

_ File

Blocchi >
Trasferisci
...F5

STEP 5/ST V7.0
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Con la funzione Trasferisci si copiano i blocchi dal dispositivo di programmazione
nell’AG e viceversa. Si puo0 trasferire:

* un gruppo di blocchi di un tipo,

e tutti i blocchi di un tipo

e un gruppo di blocchi mediante la lista blocchi,
e tutti i blocchi di un file programma,

* uno o tutti i blocchi di documentazione,

e tutto il file programma,

* da un file programma impostato ad un drive selezionabile con un file pro-
gramma selezionabile (File-File ), dove entrambi i file sono selezionabili.

e da un drive selezionabile con un file programma selezionabile al controllore
programmabile (File-AG ).

¢ dal controllore programmabile ad un drive selezionabile con un file programma
selezionabile (AG-File).

Avvertenza

Le preintestazioni dei blocchi dati e dei blocchi funzionali contengono informa-
zioni sul formato e sulle etichette dei salti che sono rilevabili solo dal PG. Per
questo esse non vengono trasferite nel’AG.

Trasferendo un blocco a cui € associata una preintestazione (FB/FV, FX/FVX, DB/DV,
DX/DVX), la preintestazione del blocco pud essere cancellata dall’AG al drive dopo
una richiesta. Poiché il PG prima della cancellazione chiede:

Sovrascrivere la preintestazione ?,
viene in questo modo evitata una perdita di dati indesiderata.

Nel modificare un blocco dati (DB e DX), editando in Online nell’AG e trasferendo
aritroso al file programma nel PG, il legame tra DB (DX) e DV (DVX) puo essere di-
strutto. Per questo motivo & significativo sovrascrivere la preintestazione del blocco
dati. | dati di questo blocco dati vengono visualizzati tutti nel formato che e stato prece-
dentemente preimpostato.

Con i blocchi funzionali (FB e FX), nel trasferimento a ritroso, potrebbero perdersi
i nomi delle etichette dei salti (per esempio FINE). Essi vengono rimpiazzati dallo
STEP 5 con dei nomi sostitutivi, per esempio M002.

Selezionare il comando di menu File » Blocchi » Trasferisci...F5 o CTRL F5.
Viene visualizzato il box di comando Trasferisci blocchi, in cui ci si pud spostare e
selezionare i singoli blocchi (- Interfaccia operativa grafica, vedere capitolo|3.9)

Avvertenza
Non tutti i blocchi che vengono visualizzati possono essere trasferiti; il trasferi-
mento dei blocchi dipende dallAG.

Possono essere trasferiti solo blocchi con una grandezza massima di 4 KW
(8KB).

I blocchi vengono trasferiti nel’AG secondo il seguente ordine:
SB, PB, FB, FX, OB, DB e DX.
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Introduzione

Chiarimento

Trasferisci da

(x)File
programma

(X)AG

in
(X)File
programma

(X)AG

Scelta

(x)Lista blocchi
[ ]

Blocco

[ I in [

(x)Tutto il file

Opzione

[x] N
Sovrascrivi con
conferma

< Trasferisci >

(OK)

Questo campo indica I'attuale file programma impostato.

Questo nome si puo editare o sostituire, tramite F3, con un nome di file gia esi-
stente, con l'ausilio del box di scelta file.

Indica su quale AG & memorizzato il blocco. L'introduzione avviene tramite
Imposta (vedere capitolo|4.1.1) e solo in funzionamento online.

In questo campo viene visualizzato il file programma.

Questo nome si puod editare o sostituire, tramite F3, con un nome di file gia esi-
stente, con l'ausilio del box di scelta file.

Indica su quale AG il blocco deve essere memorizzato. L'introduzione avviene
tramite Impostazione (vedere capitolo 4.1.1) e solo in funzionamento Online

Selezionando con una crocetta il parametro € possibile, nel successivo campo
d’introduzione, eseguire la scelta del blocco in assoluto o in simbolico (anche in
modo misto).

| tipi di blocco ammessi vengono visualizzati con F3. Informazioni relative alle
indicazioni nella lista blocchi si ottengono con F7. Esempi di introduzione si
trovano al caoitolo 4.2.1.

Se si vuole copiare un singolo blocco e memorizzarlo sotto un altro nome, si
deve evidenziare la riga e introdurre nel campo [ ] il blocco da copiare (per
esempio PB7) e nel campo in [ ] il nuovo nome del blocco (per esempio PB22). |
tipi di blocco nei due campi d’'introduzione devono essere compatibili. Informa-
zioni su questo tema si ottengono con F7.

Selezionando con una crocetta questo campo, viene selezionato tutto il file pro-
gramma compresi i blocchi di documentazione.

Le modifiche vengono acquisite soltanto dopo aver confermato la richiesta.

Il PG trasferisce i blocchi selezionati. Se si verificano degli errori, vengono pro-
poste nel box di scelta delle alternative selezionabili secondo le proprie esi-
genze.

Nel trasferimento in AG si dovrebbe fare attenzione che sono trasferibili solo i tipi di blocco selezionabili nel box di comando. Se si
sceglie un blocco errato queste trasferimento viene rifiutato.
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4.2.3 Confronto di blocchi

Funzione

_ File

Blocchi >
Confronta ...

Introduzione

Questa funzione permette di confrontare un blocco, un gruppo di singoli blocchi o tutti
i blocchi di un file programma con quelli di un altro file programma.

Il confronto avviene tra il file programma preimpostato nel PG ed un qualsiasi altro
file programma o i blocchi del programma utente nel’AG. E anche possibile confron-
tare il programma dell’AG con un file programma selezionabile.

Avvertenza

I blocchi dati che devono essere confrontati tra di loro, non possono essere pil
grandi di 2 KW.

Selezionare il comando di menu File » Blocchi » Confronta ..F6 o CTRL F6. Viene
visualizzato il box di comando Confronta blocchi, in cui ci si puo spostare e selezio-
nare (vedere capitolo 3.9).

Chiarimento

Confronta

(x)File
programma

(X)AG

con

(x)File
programma

(X)AG

Scelta

(x)Lista blocchi
[ ]

Blocco

[ ] con [
Emetti su

(x) Schermo

(x) Stampante
(x) File

< Confronta >

(OK)

Questo campo indica I'attuale file programma preimpostato.

Indicazione in quale AG il blocco € memorizzato o deve essere memorizzato.
L'introduzione avviene tramite la funzione Imposta (capitolo|/4.1.1) e solo in fun-
zionamento online.

In questo campo viene visualizzato il nome del file programma. Questo nome
puo essere editato o, tramite F3, sostituito con un nome di file gia esistente, con
I'ausilio del box di scelta file.

Indica in quale AG il blocco € memorizzato o deve essere memorizzato. L'intro-
duzione avviene tramite la funzione Imposta (capitolo 4.1.1) e solo in funziona-
mento online.

Selezionando con una crocetta il parametro, nel successivo campo d’introdu-
zione si puo eseguire la scelta del blocco in assoluto o in simbolico (anche in
modo misto). | tipi di blocco ammessi vengono visualizzati con F3. Informazioni
relative alle indicazioni nella lista blocchi si ottengono con F7.

Qui vanno introdotti due singoli blocchi che devono essere confrontati tra loro.

L’'emissione avviene sullo schermo.
L'emissione avviene sulla stampante impostata.
L'emissione avviene sul file impostato.

Il PG confronta i blocchi selezionati.

Confrontandoiblocchi si dovrebbe fare attenzione che sono ammessi solo i tipi di blocco che sono selezionabili nel box di comando.

STEP 5/ST V7.0
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42.4

Funzione

' File |

Blocchi >
Cancella...

Introduzione

Cancellazione di blocchi

Con questa funzione si possono cancellare:

¢ singoli blocchi

* un gruppo di blocchi di un tipo

e tutti i blocchi

* uno o piu file di documentazione (solo nel PG)
¢ tutto il file programma (solo nel PG)

* AG: cancellazione iniziale (solo nello stato di STOP)

Selezionare il comando di menu File » Blocchi » Cancella.... Viene visualizzato il
box di comando Cancella blocchi, in cui ci si puo spostare e selezionare (vedere
capitolo 3.9).

Chiarimento

Cancella

(x)File
programma

(X)AG

Scelta

(x)Lista blocchi

[ ]

(X)Tutto il file

(x)Cancellazione
totale AG

Opzione [x]
Cancella con
conferma

< Cancella >
(OK)
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Questo campo indica I'attuale file programma impostato.

Questo nome si puo editare o sostituire, tramite F3, con un nome di file gia esi-
stente, con l'ausilio del box di scelta file.

Indica in quale AG il blocco € memorizzato e deve essere cancellato. L'introdu-
zione avviene tramite la funzione Imposta (vedere capitolo 4.1.1) e solo in fun-
zionamento online.

Selezionando con una crocetta il parametro, nel successivo campo d’introdu-
zione si pud eseguire la scelta del blocco in assoluto o in simbolico (anche in
modo misto). | tipi di blocco ammessi vengono visualizzati con F3. Informazioni
relative alle indicazioni nella lista blocchi si ottengono con F7.

Selezionando con una crocetta il campo, viene cancellato tutto il file programma
compresi i blocchi di documentazione.

Tutti i blocchi presenti nell’AG vengono cancellati (solo nello stato di STOP).
L'AG crea nella memoria del’AG (RAM) definiti stati iniziali (vedere il manuale di
programmazione del relativo AG).

La cancellazione viene eseguita solo dopo aver confermato la richiesta di can-
cellazione.

La funzione viene eseguita.
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425 Compressione dei blocchi

_ File

Blocchi >
Comprimi

STEP 5/ST V7.0
C79000-G8572-C920-02

Selezionare il comando di menu File » Blocchi » Comprimi . La funzione elimina gli
spazi vuoti all'interno del file programma, che si sono creati cancellando o ricari-
cando dei blocchi. | blocchi dello STEP 5 vengono verificati e compattati nel file pro-
gramma. Eventuali errori vengono segnalati.

Nel corso del controllo, si pud stabilire se la struttura del file programma & in linea di
massima corretta oppure se é stata danneggiata a causa della caduta di corrente du-
rante il salvataggio o a causa della caduta del sistema.

Anche i file di 0 byte vengono considerati erronei.
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4.3 File DOS
' File ' Con le funzioni di guesto sottomenu vengono gestiti i file senza ritornare nel li-
File DOS > vello del sistema operativo. In breve queste sono:
* Emissione sul video di singoli file o gruppi di file da una directory selezionata.
* Copia di singoli file o gruppi di file (nome file sorgente # nome file destina-
zione).
* Cancellazione di singoli file o gruppi di file da una directory selezionata.
Avvertenze La scelta dei file avviene tramite il box di scelta file, che & associato ad ogni comando
operative dimenu. Lastrutturael'operativitain questo box disceltasono simili pertutte le funzioni

e sono descritte nel capitolo|3.8.]
Significato dei caratteri jolly

? Un punto interrogativo che si trova in un nome di file pud rappresentare qual-
siasi carattere.

* Inunnome difile, 'asterisco puo essere I'ultimo o I'unico carattere oppure I'esten-
sione del file. Il sistema operativo sostituisce I'asterisco tramite uno o piu punti
interrogativi fino alla fine del nome del file o dell’estensione.

Figura 4-4  Box di scelta file per i file DOS

STEP 5/ST V7.0
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431 Emissione di directory

Funzione

_ File

File DOS >
Indice ...

Campo
d'introduzione

La funzione elenca sul video la (le) directory di uno o piu file sotto forma di tabella.

Selezionare il comando di menu File » File DOS » Indice o CTRL+F7.Viene visualiz-
zato il box di scelta file Indice file DOS, in cui ci si puo spostare e selezionare. In fun-
zione dell'introduzione, in una finestra viene visualizzato un indice noto al DOS.

Chiarimento

File

Drive/Indice

Qui viene visualizzato il nome del file evidenziato dal cursore che si trova
nell’elenco dei nomi dei file.

Per cercare un determinato file o gruppo di file, si puo registrare il nome. Sono

vengono trovati, vengono visualizzati nel campo File dopo aver attivato < Ag-
giorna > o il tasto di Conferma .

Qui si puo selezionare un drive e una directory esistente. Non appena tutto cio
viene eseguito, il contenuto appare nel campo File.

Figura4-5 Indice File DOS

STEP 5/ST V7.0
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4.3.2 Copia di file DOS

Funzione

_ File

File DOS >
Copia. ...

File sorgente
[]
File destinazione

[]

Drive/Indice
sorgente
File sorgente

< Copia >

Procedimento
operativo

4-24

La funzione copia uno o piu file tra differenti drive (directory).
La copia avviene
¢ mantenendo il nome del file o

¢ utilizzando un altro nome di file (solo per file singoli)

Selezionare il comando di menu File » File DOS » Copia o CTRL+F8. La funzione
copia uno o piu file tra differenti drive (directory).

Nome del file che si vuole trasferire.

Nome del file trasferito

Le avvertenze operative si ottengono con F7 o < Info F7 >

Qui si seleziona il drive e la directory sorgente. Questa viene visualizzata nel
campo Drive sorgente.

Visualizza i file esistenti nel drive sorgente. E’ possibile effettuare la scelta con il
cursore o cliccando col mouse. Tutti i file vengono visualizzati solo se nel campo
File sorgente sono stati registrati punti interrogativi (o *.*).

La funzione viene eseguita.

Per la copia procedere come segue:

1. Nel campo Drive/Indice sorgente selezionare il drive e la directory da dove si
vuole trasferire (copiare) uno o piu file.

2. Sipossono trasferire o singoli file o tutti quelli elencati nel campo File
sorgente.

Singoli file : Introdurre il nome del file nel campo File sorgente (non sono am-
messi i caratteri jolly) o scegliere il file nel campo File sorgente cliccando con il
mouse.

esempio si vogliono trasferire solo ifile programma dello STEP 5, indicare come
criterio di ricerca *ST.S5D.

3. Se il file di destinazione deve essere memorizzato sotto un altro nome, intro-
durre il nuovo nome 0 un nome generico.

Se é stato introdotto un criterio di ricerca per il file di testo da trasferire, per
esempio MOTORE1.DOC, nel campo Destinazione & possibile scegliere il tipo
di file MOTORE2.TXT.

4. Cliccare su < Copia > per avviare la copia.

STEP 5/ST V7.0
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Figura 4-6  Copia di file DOS

433 Cancellazione di file DOS

Sommario La funziona cancella i file (uno o tutti) da una directory impostata.
' File ' Selezionare il comando di ment File » File DOS » Cancella
File DOS >

Viene visualizzato il box di comando Cancella file DOS, in cui ci si pud spostare e

Cancella ... - ;
selezionare (capitolo 3.6).
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4.4  File PCP/M

' File . Sono disponibili le seguenti possibilita:
File PCP/M >

* Emettere la directory dei file PCP/M delle aree USER selezionabili

¢ Convertire file PCP/M in file DOS, sotto il quale si possono eseguire ed anche
rielaborare.

¢ Convertire file STEP 5, che sono stati creati con lo STEP 5, in file PCP/M. |
file convertiti possono essere eseguiti e anche rielaborati sotto il sistema ope-
rativo PCP/M.

A questo proposito sono disponibili delle funzioni che elaborano supporti dati
PCP/M cioé FD (Floppy Disk) formattati sotto PCP/M.

e Cancellare file PCP/M

Avvertenze La scelta dei file avviene tramite un box di scelta che & associato ad ogni comando
operative dimenu. Lastrutturael'operativitain questo boxdisceltasono simili pertutte le funzioni
e sono descritte nel capitolo 3.8.|

Figura 4-7 Box di scelta file per i file PCP/M

STEP 5/ST V7.0
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4.4.1 Emissione di directory

Sommario

_ File

File PCP/M >
Indice ...

Box di scelta file

File

Drive
User
File

Drive
User
File sorgenti

< Copia >

STEP 5/ST V7.0
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Una directory difile di un’area USER selezionabile viene emessa da un supporto dati
PCP/M (dischetto).

Selezionare il comando di menu File » Indice.... Viene visualizzato il box di scelta
Indice file PCPM, in cui ci si pud spostare e selezionare (- Interfaccia operativa gra-
fica, box di comando) In funzione dell'introduzione viene visualizzata, in unafinestra,
una directory nota dal PCP/M.

File File STEP 5 ( per esempio *.F1.INI)
Byte Numero di byte del file

Recs Numero di record

Attrib. Modo di accesso al file

Si hanno le seguenti possibilitd d’introduzione:

Viene visualizzato il nome di file evidenziato dal cursore nella directory.
Per cercare un determinato file o gruppo di file, si puo registrare qui il nome.

se vengono trovati, vengono visualizzati nel campo File.

E il drive su cui si trovano i file. Questo campo serve come informazione, in
esso non e possibile alcuna introduzione.

E 'area USER in cui si trova la sorgente. Questo campo serve come informa-
zione, in esso non e possibile alcuna introduzione.

Indicazione dei file esistenti nel drive e nellarea USER impostati. Non & possi-
bile alcuna introduzione.

Sono elencati i drive esistenti (solo A e B). Di questi se ne pud scegliere uno.
Elenco di tutte le aree USER. Tra queste se ne puo scegliere una.

Sono elencati i file sorgenti esistenti sul drive. La scelta puo essere effettuata
con il cursore o cliccando col mouse. Tultti i file vengono visualizzati solo se nel
campo Criterio di ricerca sono stati registrati punti interrogativi (o *.*).

La funzione viene eseguita.
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4.4.2 File PCP/M — Copia PCP/M —> DOS

Sommario

_ File

File PCP/M >
Copia
PCP/M -> DOS

Box di scelta file

File sorgente

Drive sorgente

User sorgente

File sorgente

Drive: —
User: —

File
destinazione

[x] N
Sovrascrivi con
conferma

< Copia >
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Con questa funzione si possono convertire file PCP/M in file MS-DOS.

Selezionare il comando di menu:
File » Copia PCP/M —> DOS...

Viene visualizzato il box scelta file Copia File PCP/M in DOS, in cui ci si puo spostare
eselezionare (- Interfaccia operativa grafica, box di comando). In funzione dell'intro-
duzione viene visualizzato, in una finestra, un indice noto al PCP/M.

Chiarimenti sul box di scelta file:

Nome del file che deve essere trasferito.

Se si vuole trovare un determinato file o un gruppo di file, qui si puo registrare
un nome o una maschera di ricerca introducendo delle Wildcard (? o *).

Maschera di ricerca: per esempio ???A** | ??AB??.1?7?

Usando una maschera di ricerca vengono aggiornati i nomi di file elencati nel
campo File sorgenti. Vengono visualizzati solo i file che rispondono al criterio di
ricerca.

Qui viene selezionato il drive da cui si deve trasferire. Questo viene visualizzato
nel campo Drive. La scelta viene effettuata con un doppio clic del mouse o con
F3.

Qui viene scelta I'area USER. Questa viene visualizzata nel campo User. La
scelta viene effettuata con un doppio clic del mouse o con F3.

Vengono visualizzati i file esistenti nel drive sorgente. La scelta si puo effettuare
con il cursore o cliccando col mouse. Tultti i file vengono visualizzati solo se nel
campo Criterio di ricerca sono stati registrati punti interrogativi (0 *.*).

Drive da cui si deve trasferire. Questo campo serve come informazione, in esso
non é possibile alcuna introduzione.

Area USER in cui si trova il sorgente. Questo campo serve come informazione,
in esso non é possibile alcuna introduzione.

Nome del file in cui si trasferisce.

L'indicazione di un file di destinazione avviene introducendo un nome di file
senza Wildcard, per esempio ABCDEFGH.123. Questa indicazione & possibile
solo se si utilizza come file sorgente un singolo file senza Wildcard.

L'indicazione di piu file di destinazione avviene introducendo le Wildcard (? o *)
nel nome del file, per esempio ????????.??? o**  Questa indicazione
possibile se come sorgente si usa un singolo file o piu file (con Wildcard).

Opzione: i file vengono sovrascritti solo dopo la conferma alla richiesta di sovra-
scrittura.

La funzione viene eseguita.
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4.4.3 File PCP/M — Copia DOS —> PCP/M

Sommario

" File

File PCP/M >
Copia

DOS->PCP/M

Box di scelta file

File sorgente

Drive/lndice
sorgente

File sorgente

File
destinazione

Drive;: —
User. —

[x] -
Sovrascrivi con
conferma

< Copia >

STEP 5/ST V7.0
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Con questa funzione si possono convertire file MS-DOS in file PCP/M.

Selezionare il comando di menu:
File » Copia DOS —> PCP/M

Viene visualizzato il box scelta file Copia File DOS in PCP/M, in cui ci si puo spostare
eselezionare (- Interfacciaoperativa grafica, box dicomando). Infunzione dell’intro-
duzione viene visualizzato, in una finestra, un indice noto al PCP/M.

Chiarimenti sul box di scelta file:

Nome del file che deve essere trasferito.

Se si vuole trovare un determinato file o un gruppo di file, qui si pud registrare
un nome o una maschera di ricerca introducendo delle Wildcard (? o *).
Maschera di ricerca: per esempio ???A** | ??AB??.1?7?

Usando una maschera di ricerca vengono aggiornati i nomi di file elencati nel
campo File sorgenti. Vengono visualizzati solo i file che rispondono al criterio di
ricerca.

Qui viene scelto il drive/indice da cui si deve trasferire. Questo viene visualizzato
nel campo Drive/User. La scelta viene effettuata con un doppio clic del mouse .

Vengono visualizzati i file esistenti nel drive/indice sorgente. La scelta si puo ef-
fettuare con il cursore o cliccando col mouse. Tutti i file vengono visualizzati solo
se nel campo Criterio di ricerca sono stati registrati punti interrogativi (o *.*).

Nome del file in cui si trasferisce.
L'indicazione di un file di destinazione avviene introducendo un nome di file

senza Wildcard, per esempio ABCDEFGH.123. Questa indicazione € possibile
solo se si utilizza come file sorgente un singolo file senza Wildcard.

L'indicazione di piu file di destinazione avviene introducendo le Wildcard (? o *)
nel nome del file, per esempio ????????.??? o0**  Questaindicazione e
possibile se come sorgente si usa un singolo file o piu file (con Wildcard).

Drive in cui si deve trasferire.

Area USER in cui si trova il file destinazione.

Opzione: i file vengono sovrascritti solo dopo la conferma alla richiesta di sovra-
scrittura.

La funzione viene eseguita.
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4.4.4 Cancellazione di file PCP/M

Sommario

_ File

File PCP/M >
Cancella ...

| file PCPM presenti su un supporto PCP/M vengono cancellati. Si puo cancellare
un singolo file o tutti i file selezionati in un'area USER.

Selezionare il comando di menu:
File » File PCP/M » Cancella...

Viene visualizzato il box scelta file Cancella file PCP/M, in cui ci si pud spostare e
selezionare (- Interfaccia operativa grafica, box di comando). |l significato dei campi
d’introduzione € quello descritto nel capitolo|4.4.2.

Avvertenza
Tutti i file in un’area USER vengono visualizzati solo quando nel campo File sono
registrati punti interrogativi.

45 Comandi DOS CTRL+F10

Richiesta d'intro-
duzione MS-DOS

S5SHELL.BAT

Conclusione
dell'introduzione

Selezionare il comando di menu File » Comandi DOS o premere CTRL+F10. Viene
visualizzataladisponibilitaalleintroduzioniMS-DOS. Ora € possibile digitare comandi
MS-DOS.

Viene caricato il processore di comando attuale (per lo piu COMMAND.COM).

Seviene creato unfile SSSHELL.BAT nelladirectory home, esso eseguira, al richiamo
dellafunzione, comandi DOS. In questo modo possono essere avviati, ad es., file ma-
nager come i DOSSHELL (di MS-DOS 5.0).

I comandi DOS devono essere utilizzati per eseguire funzioni ausiliari con le risorse
del sistema operativo.

Attenzione: non caricare programmi residenti come DOSKEY, KEYB, ecc., e non
attivare funzioni per drive come SUBST 0 ASSIGN. Cio vale anche peril collegamento
in rete.

Digitare il comando EXIT per concludere 'introduzione e sivuole ritornare all’'interfac-
cia operativa dello STEP 5.

4.6 Chiusuracon SHIFT+F4

Funzione

4-30

Con il comando di menu File » Chiudi o SHIFT+F4 si conclude lo STEP 5. Segue,
in funzione dell'impostazione del progetto (vedere capitolo 4.1.1, Scheda Opzioni ),
una domanda di sicurezza.

* Confermare con Chiudi se si vuole veramente abbandonare lo STEP 5.

* Confermare con Annulla se il programma deve ritornare nell’interfaccia
operativa.

STEP 5/ST V7.0
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Parte 2:
L'editazione con STEP 5

Funzioni comuni in

AWL, KOP, FUP F1
Editazione della lista

istruzioni (AWL) F1
Editazione di

schemi a contatti F1
Editazione

di schemi logici F1
Editazione

di blocchi dati F2
Editazione

maschere DB Ctrl+F1
Editazione della lista

di attribuzione F7

Vie bus F8
Parametri stampante  Ctrl+F4
Editor di piedinatura  Ctrl+F5

© 00 ~N O O

10
11
12
13
14
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Funzioni comuni in AWL, KOP, FUP

Sommario Inquesto paragrafo sono rappresentate tutte le funzioniche sipossono utilizzare, nelle
rappresentazioni, durante 'editazione.

\_ Test AG Gestione Docu(

Blocco STEP 5 ... F1
Blocco dati ... F2
Maschera DB ... Ctrl+F1
Lista di attribuzione F7
Vie bus F8

Parametri stampante  Ctrl+F4
Editor piedinatura  Ctrl+F5

Sommario del Capitolo Argomento trattato Pagina
capitolo 5.1 Scelta dell’Editor 5-2
5.2 Assegnazione dei tasti funzionali in Emissione 5-6
5.3 Editazione commenti 5-8
54 Aggiunta, inserimento, trasferimento, cancellazione di un 5-17
segmento
55 Generazione e visualizzazione lista incrociata, cambio 5-22
blocco
5.6 Ricerca di operandi, segmenti ed indirizzi 5-26
5.7 Editazione di operandi simbolici nel blocco 5-27
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Funzioni comuni in AWL, KOP, FUP

5.1 Scelta dell’editor

Sommario Per I'editazione
¢ dei blocchi STEP 5 nelle rappresentazioni AWL, KOP, FUP
¢ dei blocchi di commento,
* dei blocchi di documentazione e
¢ dei commento dell'impianto

bisogna scegliere un’editor. La rappresentazione dipende dalla Impostazione pro-
getto (vedere File » Progetto »Imposta F4 capitolo4.1.1), mapuo essere modificata
anche durante 'editazione in emissione tramite tasti funzionali.

\ Editor \ Selezionare il comando di menu Editor » Blocco STEP 5 . Sul video appare il box
Blocco STEP5S di dialogo rappresentato nella figura 5-1.

STEPS - S5KXS01Z

0| @] e3) == Al

H= K

Edita blocchi STEP 5
— Sorgente
(X)" File programma NONAMEST.S5D

(X) AG —> C:\STEP5\S5_ST

— Scelta

Lista blocchi [ ]
Crit. ricerca [ ]

— Opzioni :
[X] Sovrascrivi con conferma < Storia F1>
[X] Aggiorna lista attribuzione :
[X] Aggiorna XREF <Scegli F3>

< Info F7 >
< Help Shift+F8 >

[ Editas = Annulla ESC >

Figura 5-1 Box di dialogo per I'editazione di blocchi STEP 5

Introdurre oraleindicazionirelative alla Sorgente, alla Scelta e alle Opzionidesiderate.
I significato dei campi & descritto nei dettagli come segue:

STEP 5/ST V7.0
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Funzioni comuni in AWL, KOP, FUP

Sorgente

Scelta
Lista blocchi

Blocco singolo

Lista blocchi

Area blocchi

STEP 5/ST V7.0

C79000-G8572-C920-02

[x] File programma

Indicazione di dove € memorizzato o dove deve essere memorizzato il blocco. L'intro-
duzione avviene tramite I'lmpostazione progetto (vedere capitolo|4.1.1),

[X] AG

Indicazione dell’AG in cui € memorizzato o dove deve essere memorizzato il blocco.
L'introduzione avviene tramite I'lmpostazione progetto (vedere capitolo 4.1.1) e sol-
tanto in funzionamento Online.

Lista blocchi [ ]

Inquestocampod’introduzione sono possibili,asecondadelboxdidialogo, le seguenti
indicazioni:

* Blocco singolo

e Lista blocchi

* Gruppo di blocchi

¢ Tipo di blocchi

¢ Blocchi DOK

Un elenco delle introduzioni attualmente possibili viene fornito premendo F7 oppure
selezionando il campo <INFO F7>.

Sesivuole editare unblocco gia esistente oppure se sivuole visualizzare itipidiblocchi
attualmente consentiti, premere F3 oppure selezionare il campo <Scegli F3>.

L'indicazione deiblocchipud avvenireinassolutooin simbolico, e sono possibilianche
indicazioni miste.

Blocco singolo, indicazione assoluta o simbolica

[PB100 ]
[DX 14 ]
[OB 10 ]
[FKX 231 ]
[-Impiantol ]

Lista di max. 6 blocchi singoli. | blocchi sono separati da una virgola. Se la virgola
segue unnome simbolico, bisogna assolutamente anteporre una”\" allavirgola stessa
per concludere il simbolo.

[ PB100 , PB123 ]
[ -Impiantol\, -Impianto2 ]
[ -Impiantol\, FB45, -Impianto2\,-Comando ]

Indicazione del gruppo con 2 blocchi singoli. | blocchi sono separati da una lineetta.
Se lalineetta segue un nome simbolico, bisogna assolutamente anteporre una™\” alla
lineetta stessa per concludere il simbolo. | due blocchi dell'indicazione del gruppo de-
vono essere dello stesso tipo, il numero del primo blocco deve essere inferiore al nu-
mero del secondo.

[ PB100 - PB123 ]
[ -Impiantol\- -Impianto2 ]
[ -Impiantol1\- FB45 ]
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Tipo di blocchi

Blocco DOK

Scelta
Criterio di scelta

Indicazione di tutti i tipi di blocchi

[PB Jtutti i blocchi di programma
[B Jtutti i blocchi

[ OK Jtutti i commenti a OB

[ DB Jtutti i blocchi dati

[# Jtutti i blocchi DOK

Blocco preceduto dal carattere #

[#MOT_P ]

[ #DBDO0.003 ]

[ OK#0OBDO.024 ]
Criterio di scelta [ ]

Se sivuole eseguire in uno o pit blocchi unaricerca secondo un criterio, occorre intro-
durre i blocchi (max. 6) in assoluto o in simbolico nell'apposita lista.

Successivamente bisogna indicare come criterio di ricerca un operando in assoluto
oinsimbolico. I criteridiricercaconsentitisipossonovisualizzare premendo F7 oppure
selezionando <Info F7>. Laricerca secondo il criterio introdotto viene eseguita auto-
maticamente in tutti i blocchi indicati.

Avvertenza

E’ possibile indicare blocchi di commento, blocchi di documentazione e file di
documentazione, ma all'interno di questi non € possibile eseguire nessuna ri-
cerca.

Si abbandona il campo con il tasto d’'introduzione oppure selezionando un altro
campo con il mouse. La ricerca secondo il criterio introdotto viene eseguita in tutti i
blocchi indicati.

Ilsegmentoin cui e statotrovatoil criterio appare inmodo Emissione. Seil primo blocco
introdotto non esiste, viene visualizzato, dopo la conferma dei parametri e le opzioni,
il primo segmento (vuoto) di questo blocco in modo Editazione. Dopo I'abbandono
del blocco laricerca viene eseguita negli altri blocchi indicati. Se dopo il primo blocco
€ indicato un blocco non esistente, questo viene saltato nella ricerca.

Per cercare altre posizioni con il criterio di ricerca:

* con F3 = Cerca nel segmento successivo,

e con Conferma nel blocco successivo e confermare con il tasto
d’introduzione

Avvertenza

Se un editor viene selezionato con ricerca e se viene modificato il blocco, occorre
memorizzare il blocco modificato prima di proseguire con la ricerca.

STEP 5/ST V7.0
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Opzioni

STEP 5/ST V7.0
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1. Azionare in modo Editazione il tasto F7 = Conferma e confermare con Sij il
messaggio Acquisire segmento modificato? . L'editor passa nel modo
Emissione.

2. Azionare nuovamente il tasto F7 = Conferma e confermare con Si il
messaggio Acquisire segmento modificato”

Confermando ancora con Siil messaggio Proseg.? ,viene continuata laricerca,
confermando con No si ritorna al menu principale.

[xX] Sovrascrittura con conferma (si)

Le modifiche vengonoaccettate solodopolaconfermadellamemorizzazione. I blocchi
interessati vengono richiesti singolarmente:

Blocco di programma, blocco di commanto, blocco di documentazione, file di docu-
mentazione.

[ ] Sovrascrittura con conferma (no)

I blocchi modificati vengono sovrascritti senza conferma. Per i blocchi di programma
OB, PB, SB, FB/FX viene richiesta sempre la conferma.

[X] Aggiornamento lista attribuzione (si)

Se si vogliono editare operandi simbolici, cioé modificare il file simbolico *ZO.INI,
durante la memaorizzazione aggiornata la lista attribuzione *Z0.SEQ.

[ 1 Aggiornamento lista attribuzione (no)

La lista di attribuzione non viene aggiornata. In un secondo tempo questa puo essere
generata o aggiornata con la funzione INI > SEQ.

[X] Aggiornamento XREF (si)

Lalistaincrociata (file *XR.INI) viene aggiornata nel caso un blocco venga modificato.

[ 1 Aggiornamento XREF (nein)

Lalistaincrociata nonviene aggionata. In un secondo tempo questa si pud aggiornare
0 generare con la funzione Gestione » Genera XREF (vedere capitolo|17.1),



Funzioni comuni in AWL, KOP, FUP

5.2 Assegnazione dei tasti funzionali in Emissione

Sommario Tramite la seguente descrizione dei tasti si ottiene una panoramica sugli strumenti
elefunzioniasupporto del lavoro di editazione. Queste funzioni possono essere utiliz-
zate indipendentemente dal tipo di rappresentazione.

F Indirizzi F  N.Bibl. F  Simb. SIM F commriga F  —>KoP F Commsegm F Salva F Help

1 Vis simb. 2 Riferim. 3 Cerca 4 5 Funz segm 6 Edita 7 Conferma 8 Annulla

Tabella5-1  Tasti funzionali in Emissione

Tasti funzionali Significato

= Simb. SIM/ABS/
AUS

F1 Editazione degli operandi simbolici direttamente nel blocco.

= Vis. simb.

F2 Generazione, visualizzazione dei riferimenti (lista incrociata), cambio blocco.

= Riferim.

F3 Ricerca di un singolo operando.

= Cerca

F4 -

F5 Funzioni segmento: copia, annota, inserimento, aggiunta, cancellazione segmento
= Funz segm

F6 Cambio in Editazione, possibile anche con il tasto CORR.

= Edita

F7 Memorizzazione del blocco, se questo & stato modificato o ritorno al menu princi-
= Conferma pale.

F8 Ritorno al menu principale. Le modifiche nel blocco vanno perse.

= Annulla

SHIFT F1 Visualizzazione, a byte o a word, degli indirizzi relativi delle istruzioni; solo in AWL
= Indirizzi (- Editazione lista istruzioni; visualizzazione indirizzi)

SHIFT F2 Introduzione del numero di biblioteca

= N. bibl.

SHIFT F3 Attivazione/disattivazione simbolico

SHIFT F4 Attivazione/disattivazione di commenti di riga e di simbolico

= Senza Comm/riga

SHIFT F5 Commutazione nella rappresentazione visualizzata KOP, FUP o AWL.
= - KOP

SHIFT F6 Editazione del titolo segmento o del commento segmento.

= Comm segm

SHIFT F7 Salva il blocco senza conferma. L'editor non viene abbandonato.

= Salva

SHIFT F8 Chiarimento dei tasti funzionali.

= Help

5-6
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521 Introduzione del n. di biblioteca  (SHIFT F2)

Sommario

Premessa

Procedimento

Il numero di biblioteca € un numero di 5 cifre (da 0 a 99999) per l'identificazione dei
blocchi.

E aperto il blocco, in cui deve essere introdotto il numero di biblioteca. Lo STEP 5
si trova in modo Emissione.

Procedere come segue .

1. Premere SHIFT F2 = N. bibl.
Il cursore si trova nel campo BIB visualizzato.

2. Introdurre il N. bibl. desiderato o modificare quello indicato.
3. Abbandonare il campo BIB: premere il tasto di introduzione

Se vengono introdotte tutte le 5 cifre del numero di biblioteca, il cursore abbandona
automaticamente il campo. Se non si desidera introdurre nessun numero, bisogna
abbandonare il campo con ESC.

5.2.2 Cambio della rappresentazione (SHIFT F5 = -> KOP)

Sommario

Premessa

Procedimento

STEP 5/ST V7.0
C79000-G8572-C920-02

Conquestafunzione sicambialarappresentazione, senzadovereritornare nellaimpo-
stazione progetto (capitolg 4.1.1).

Lo STEP 5 sitrova in modo Emissione. Il segmento visualizzato deve essere traduci-
bile nella rappresentazione desiderata.
Premere SHIFT F5 = -~ KOP o eseguire un click col mouse.

Sulvideo viene visualizzato il segmento come schema a contatti. Se il segmento non
e rappresentabile in KOP o FUP, lo STEP 5 segnala: KOP/FUP nontraducibile

La visualizzazione del tasto funzionale & ora - FUP.
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5.3 Editazione commenti

Sommario

Per i blocchi STEP 5, OB, PB, SB, FB e FX, si possono prevedere diversi
commenti:

* commenti impianto

e commenti istruzione (Editazione lista istruzioni, capitolo 6)

* commenti segmento

¢ titolo segmento

e commenti operando (Editazione lista di attribuzione, capitolo 11)

| commenti relativi ai blocchi dati DB e DX si trovano nel paragrafo Editazione blocchi
dati (vedere capitolc 9).

Tipi di commento

Dove possono essere editati? Dove viene
memorizzato?

Commento impianto

File di documentazione # File di documentazione

Commento istruzione

AWL : OB, PB, SB, FB, FX OK, PK, SK, FK, FKX
Blocco di documentazione:
OK, PK, SK, FK, FKX

Commento segmento | AWL, KOP, FUP : OB, PB, SB, FB, FX #OBDO.nnn, #”BDO.nnn,
File di documentazione: #SBDO.nnn, #FBDO.NNnN,
#0OBDO.nnn, #PBDO.nnn, #SBDO.nnNn, #FXDO.nnn
#FBDO.nnn, #FXDO.nnn

Titolo segmento AWL, KOP, FUP: OB, PB, SB, FB, FX OK, PK, SK, FK, FKX

Blocco di documentazione:
OK, PK, SK, FK, FKX

Commento operando AWL, KOP, FUP: OB, PB, SB, FB, FX *Z0.INI
Lista di attribuzione *Z0.SEQ
531 Commento impianto

Sommario

5-8

Uncommentoimpianto & unfile ditesto (file didocumentazione) e non € legato, contra-
riamente al commento segmento, ad un blocco. Il numero dei caratteri di tutti i com-
menti impianto in un file-programma non deve superare i 16 caratteri per blocco; il
numero dei possibili file di documentazione, in un file programma, non deve superare
i 255 blocchi per file.

Un commento impianto viene memorizzato sul dischetto o sul disco fisso e non trasfe-
rito nellAG o EPROM/EEPROM.

Editando il commento impianto si possono richiamare i comandi e gli help di editor
per I'elaborazione dei testi.

STEP 5/ST V7.0
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Denominazione Il nome inizia sempre col carattere #, dopo si possono introdurre fino ad un massimo
di 8 caratteri, p.es. #£ESEMPIO. Prima di introdurre un commento impianto, bisogna
tener presente cheil secondo carattere delnome delfile non pud essere un”due punti”.

Operativita con Per l'introduzione oppure la modificazione del commento impianto procedere come
I'editor segue:

1. Selezionare il comando di menu Editor » Blocco STEP 5.

2. Introdurre e confermare il nome del blocco documentazione iniziando col ca-
rattere #.

Introdurre il testo coi tasti alfanumerici. L'editor dei test contiene le funzioni:

F F F F F
1 Inserisci. 2 Cancella 3 Comando 4 5 Ins.riga

F1 Commutazione nel modo Inserimento o Sovrascrittura.
= Inserisci E visualizzato il modo selezionabile.

F2 Cancellazione stringa di caratteri nel testo.

= Cancella

F3 Commandi per accelerare I'elaborazione del testo.

= Comando

F5 Inserimento di una riga nella posizione del cursore.
=Ins. riga

F6 Cancellazione di una riga nella posizione del cursore.
= Canc. riga

F : Si puo inserire in un testo dei caratteri ASCII. Procedere come segue:
1 Inserisci 1. Premere F1 = Inserisci (Commutazione nel modo Inserimento)
2. Introdurre la stringa di caratteri desiderata.

3. Concludere l'inserimento, commutare nel modo Sovrascrittura,
premere F1 = Sovrascr.

L'introduzione del testo da inserire € conclusa.

F : In un testo si possono cancellare stringhe di caratteri con qualsiasi lunghezza e
2 Cancella parti di testo.

1. Posizionare il cursore sul primo carattere da cancellare.
2. Premere F2 = Cancella
Lo STEP 5 emette il carattere iniziale @ nella posizione del cursore.
3. Posizionare il cursore sull'ultimo carattere da cancellare.
4. Premere F2 = Cancella

La parte di testo delimitata & cancellata. Le successive parti di testo vengono
compattate automaticamente.

STEP 5/ST V7.0
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F

3 Comando

Tabella5-2 Comandi

L'editor dei testi comprende otto comandi per velocizzare I'elaborazione del testo.
I comandi si richiamano con F3 = Comando. Come si utilizzano tutti comandi:

1. Posizionare il cursore nel testo.

2. Premere F3 = Comando.

3. Introdurre uno degli otto possibili comandi.

4. Attivare il tasto di introduzione e premere Conferma .

Il PG esegue il comando.

Comando Effetto dei comandi
JTT (jump to the top = salta all'inizio).
Da una qualsiasi posizione, il cursore salta all'inizio del commento.
JTE (jump to the end = salta alla fine).

Da una qualsiasi posizione, il cursore salta alla fine del commento.

ST1, ST2, ST3, ST4

(set label 1 = impostare il marchio 1).
In un testo si possono impostare al massimo 4 marchi.

JT1,JT2,JT3,JT4

(jump to label 1 = salta al marchio 1).
Da una qualsiasi posizione del testo, il cursore salta sul marchio desiderato.

Fixyzrst/ (find = trovare).
Il cursore salta alla parte di testo desiderata xyzrst , altrimenti lo STEP 5 segnala:
Non trovato

CTm, Tn (copy = dove m ed n possono assumere i valori 1, 2, 3 0 4).
Copia il testo dal marchio Tm (compreso) al marchio Tn. L'attuale posizione del
cursore non puo trovarsi tra i marchi, altrimenti lo STEP 5 segnala: Vietato tra
due marchi . | marchi vengono "spostati”, durante la copia, insieme alla parte di
un testo.

MTm, Tn (move = spostare, dove m ed n possono assumere i valori 1, 2, 3 0 4).

Viene spostato il testo compreso tra i marchi Tm e Tn. L'attuale posizione del
cursore non puo trovarsi tra i marchi, altrimenti lo STEP 5 segnala: Vietato tra
due marchi

DT1, DT2, DT3, DT4

(delete = cancellare).

I marchi si possono cancellare in qualsiasi sequenza.

5-10

Avvertenza

Il carattere di comando della stampante $EJECT genera un cambio pagina in un
commento segmento, blocco o impianto.

Bisogna scrivere $EJECT in ogni caso in lettere maiuscole, altrimenti lo STEP 5
non riconosce il comando.
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Esempio La riga vuota (7) ed il titolo nella riga (8) si devono copiare nella riga (2). In questo
modo si prende conoscenza del procedimento mediante la funzione di comando.

-

Comando stampante 1
(2) 1

Copia di testi T

Spostamento di testi 1

Impostazioni di marchi 1

Cancellazione di marchi 1
(7) j
(8) ELABORAZIONE DI TESTI: 1

L’editor permette la scrittura di...

F F F F F
1 Inserisci 2 Cancella 3 Comando 4 5 Ins. riga

Figura5-2  Comando stampante
Prima di tutto si deve selezionare il testo da copiare, questo avviene impostando |l
marchio di inizio e di fine:
Definizione dell'inizio
1. Posizionare il cursore sulla freccia nella riga (7) e attivare F3 = Comando.
Il cursore salta nell'angolo in alto a sinistra del video.

2. Digitare la stringa di caratteri ST1 e premere quindi Conferma .
Il cursore ritorna nel testo.

Definizione della fine

1. Posizionare il cursore nella posizione dopo l'ultimo carattere (qui freccia) nella
riga (8) ed premere F3.

Il cursore salta di nuovo nell'angolo sinistro del video.

2. Digitare la stringa di caratteri ST2 e premere quindi Conferma .
Il cursore ritorna nel testo.

Copia del blocco di testo
1. Posizionare il cursore sulla freccia nella riga (2) e premere F3.

2. Digitare la stringa di caratteri CT1,T2 e premere quindi Conferma . La parte di
testo scelta, compresa la riga vuota, viene inserita nella riga (2) come si puo
rilevare nella figura seguente. | marchi si trovano all'inizio e alla fine del testo
copiato.
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5.3.2

Sommario

5-12

Comando stampante 1

()T
ELABORAZIONE DI TESTI : 1
Copia di testi 1
Spostamento di testi 1
Impostazione di marchi

(7) Cancellazione di marchi 1

(8)1
ELABORAZIONE DI TESTI: 1
L'editor permette la scrittura di ...

F F F F F
1 Inserisci 2 Cancella 3 Comando 4 5 Ins. riga

Figura5-3  Comando stampante

Spostamento di un testo

Un blocco ditesto marcato viene spostato, chiudendo automaticamente glispazirima-
stivuotineltesto. lltesto marcato per la copiatura viene spostato nell’attuale posizione
del cursore introducendo il comando MT1, T2 ed infine premendo il tasto di introdu-
zione e Conferma .

Commento segmento

I commenti segmento sono dei testi con cui si possono commentare programmi in
segmenti o in blocchi. Il numero dei caratteri di tutti i commenti segmento in un file
programmanon deve superare 16 k caratteri per blocco; il numero dei possibili blocchi
di documentazione in un file programma non deve superare i 255 blocchi per file.

Icommentisegmento sieditano direttamente neiblocchi, nonnelbloccodidocumenta-
zione. Se si vuole editare direttamente nei blocchi di documentazione, procedere
come descritto nel capitolo 5.3.1. Tenere presente:

* |l blocco ed i file di documentazione vengono memorizzati nel file programma.

¢ | file di documentazione non possono essere trasferiti nel’AG o nel modulo
EPROM/EEPROM.

¢ || numero del blocco ed il numero del file di documentazione sono in relazione
tra loro, p. es. al PB 13 & abbinato #PBD0.013 .

* Ad ogni tipo di blocco e associato un corrispondente file di documentazione
che é identificato tramite il carattere "#” posto all'inizio dello stesso:
OBn - #0OBDO.nnn
PBn - #PBDO.nnn
SBn - #SBDO.nnn
FBn - #FBDO.nnn
FXn - #FXDO.nnn

Avvertenza

Un cambio pagina viene generato col comando della stampante $EJECT. Que-
sta stringa di caratteri va scritta in ogni caso in lettere maiuscole.
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Premessa Nell'impostazione progetto € stato selezionato [x] con commenti (capitolo|4.1.1) op-
pure é stato impostato nell’Editor con SHIFT F4.

F Senza comm. F ->KOP F Comm.seg. F Salva F Help

4 Diagnosi 5 Funz.segm. 6 Edita 7 Conferma 8 Annulla

F Titolo F Commento F Help

5 6 7 8 Indietro
JL

F F F F F
1 Inserisci 2 Cancella 3 4 5 Ins.riga

Operativita con Per introdurre o modificare un commento segmento procedere nel seguente modo:
Feditor 1. Selezionare il comando di menu Editor » Blocco STEP 5 .

2. Introdurre il nome del blocco e confermare.

3. Premere SHIFT F6 = Comm. Segm. e SHIFT F7 = commento

Lo STEP 5 apre un campo di editazione vuoto per il commento segmento o
con il testo gia introdotto. In questo modo il commento viene associato al se-
gmento; lo STEP 5 crea una sequenza di caratteri (7 caratteri) $1 @ col nu-
mero del relativo segmento, che non pud essere cancellato. In caso contrario
andrebbe persa I'associazione tra segmento e commento. Premere Inserisc i.

4. Editare il testo con la tastiera alfanumerica.
5. Concludere ogni riga con il tasto di introduzione
La fine della riga & marcata con una freccia verticale.

All'introduzione di testi "a piu righe”, alla fine di ogni riga viene automatica-
mente settata un’interlinea.

Inserimento

caratteri F F F F
1 Inserisci 2 Cancella 5 Ins. riga 6 Canc.riga

g

1 Titolo

1. Posizionare il cursore sul carattere del testo, da dove bisogna inserire i carat-
teri.

2. Premere F1 = Inserisci
Inserire il testo.

4. Concludere l'inserimento: premere F8 = Fine.

STEP 5/ST V7.0
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Cancellazione e c
caratteri 1 Inserisci 2 Cancella
F F
1 2 Cancella

Posizionare il cursore sul primo carattere da cancellare.
Premere F2 = Cancella

Posizionare il cursore dopo I'ultimo carattere da cancellare.

P w Dnp o

Premere F2 = Cancella

Inserimento riga
F F F F

1 Inserisci 2 Cancella 5 Ins.rlga 6 Canc.riga

1. Posizionare il cursore nella riga davanti a cui deve essere inserita una riga
vuota.

2. Premere F5 o cliccare il campo Ins. riga .

Cancellazione
riga F F F F
1 Inserim. 2 Cancell. 5 Ins. Riga 6 Canc.riga

1. Posizionare il cursore nella riga che deve essere cancellata.

2. Premere F6 o cliccare il campo Canc. riga .

Conclus. del com- Premere F8 = Indietro.

mento segmento Lo STEP 5 emette sul video il corrispondente segmento. Il testo fino ad ora introdotto
viene mantenuto. Se si memorizza il segmento, lo STEP 5 memorizza anche il com-
mento segmento.

Memorizz. del Premere Conferma .
commento
segmento

STEP 5/ST V7.0
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5.3.3 Titolo segmento

Sommario

Premessa

Operativita con
I'editor

STEP 5/ST V7.0
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Col titolo segmento si contrassegna un segmento. Un titolo segmento € lungo
massimo 32 caratteri. Esso si puo introdurre direttamente nel blocco o
separatamente nel corrispondente blocco commento. Si consiglia il primo metodo,
poiché modificando e memorizzando, le associazioni vengono aggiornate. Lo
STEP 5 deposita il titolo segmento nel blocco commento. Fare attenzione:

¢ |l blocco commento viene memorizzato nel file programma.

* | blocchi commento non possono essere trasferiti nel’AG o in un modulo
EPROM/EEPROM.

¢ |l numero del blocco ed il numero del blocco commento sono in relazione tra di
loro, p.es. al PB 13 & associato PK 13.

¢ Il nome del blocco commento viene attribuito automaticamente dallo STEP 5 :
OBn - OKn
PBn - PKn
SBn - SKn
FBn - FKn
FXn - FKXn

Nella maschera Imposta progetto si dovrebbe selezionare [x] con commenti (capitolo
4.1.1)! Nella rappresentazione AWL si pud commutare con SHIFT F4 = Comm.riga.
Il segmento, in cui si deve introdurre un titolo, deve essere richiamato. Lo STEP 5
si trova in modo Emissione o Editazione.

F Senza comm. F —>KOP F Comm. Seg. F Salva F Help
4 5 Funz.segm. 6 Edita 7 Conferma 8  Annulla
F F Titolo F Commento F  Help
5 6 7 8 Indietro

Per introdurre o modificare un titolo segmento procedere nel seguente modo:
1. Selezionare il comando di menu Editor » Blocco STEP 5 .
2. Introdurre il nome del blocco di documentazione e confermare.

3. Premere SHIFT F6 = Comm. seg. e SHIFT F6 = Titolo oppure COM e
SHIFT F6 = Titolo.

Il cursore salta nel campo d’introduzione del titolo segmento.
4. Introdurre il testo o correggere un testo gia esistente.
5. Premere il tasto di introduzione .

Il titolo viene memorizzato temporaneamente, la memorizzazione definitiva
avviene pero soltanto alla memorizzazione del blocco generato nel file pro-
gramma.
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5.34 Visualizzazione commento operando

Sommario

Premessa

Visualizzazione in

KOP/FUP

Visualizzazione in
AWL

5-16

Nel segmento attuale (aperto) si possono visualizzare in ogni momento i commenti
agli operandi simbolici.

Nelle "Impostazioni” é statointrodottoil file simbolico e si é scelto Simbolico: Sie Visua-
lizzazione : Sim.. Se no, si pud commutare con SHIFT F3 = Simb SIM.

Posizionare il cursore nel segmento, su un operando simbolico. L'operando simbolico
col commento all'operando viene visualizzato nella terza riga del video.

Indipendentemente dall'impostazione di progetto”Commenti: Si/No” (vedere capitolo
4.1.1) é possibile commutare il video tra commento operando e commento istruzione
con SHIFT F4:

* senza commenti
* commenti riga (commenti istruzione)
e commenti simbolo (commenti operando)

L'impostazione selezionata viene inserita nell’impostazione progetto.

F Senzacomm F —>KOP F Comm. segm. F Salva F Help
4 5 Funz.segm. 6 Edita 7 Conferma 8 Annulla

STEP 5/ST V7.0
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5.4  Aggiunta, inserimento, trasferimento, cancellazione di un segmento

Sommario

STEP 5/ST V7.0
C79000-G8572-C920-02

F Senzacomm.F —>KOP F Comm. Segm.F Salva F
4 5 Funz.segm. 6 Edita 7 Conferma 8
F Cancell. F F F F
4 Annota 5 Inserisci 6 Aggiungi 7 8

Help
Annulla

Help
Indietro

Il segmento si trova in modo Emissione.

Se si vuole elaborare i segmenti nel blocco, cioe:

* aggiungere o inserire,

* annotare (memorizzazione intermedia)

e cancellare,

guesto si pud eseguire tramite i tasti funzionali o tramite i tasti nella parte numerica
della tastiera (- Appendice, Tastiera).

Funzione di elaborazione
segmento

Tasti funzionali

Tasti nella
parte numerica

Memorizz. intermedia
segmento

F4 = Annota

Inserim. segm. prima di
quello att.

F5 = Inserisci

Inserisci
segmento

Aggiunta segmento dopo
quello attuale

F6 = Aggiungi

Fine segmento

Cancellazione segmento SHIFT F4 = Cancella Cancella
segmento

Per sfogliare i segmenti F1=-1 -

esistenti Fl= +1 +
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541

Operativita

Aggiunta o inserimento di un nuovo segmento

Procedere come segue:

1.

Aprire il segmento precedente o successivo al nuovo segmento che si deve
inserire 0 aggiungere.

Premere F5 = Funz. segm.

F Cancella F F F F  Help
4 Annota 5 Inserisci 6 Aggiungi 7 8 Indietro
A L
F
1 Nuovo 2 Buffer 3 Dasegm.

Premere ancora F5 = Inserisci se si vuole inserire prima dall’attuale segmento,
0 premere F6 = Aggiungi se si vuole aggiungere dopo il segmento attuale.

Premere F1 = Nuovo.
Lo STEP 5 emette un nuovo segmento.

5.4.2 Copia di un segmento

Sommario

Premessa

5-18

Si puo copiare un segmento nello stesso blocco o in un altro blocco dello stesso file
programma. |l titolo ed il commento segmento vengono in ogni caso copiati. Dopo
la copia si consiglia di aggiornare la lista incrociata se nel box di comando non € stato
gia scelto Aggiornamento XREF.

Ilbloccoin cuisivuole copiare il segmento sitrova nelfile programma. La copiaavviene
in emissione.

Copia del segmento nello stesso blocco

Avvertenza

Segmenti all'interno di un blocco funzionale che contengono delle funzionalita
specifiche di FB, per esempio l'identificatore, non si possono copiare in un’altra
posizione all'interno del blocco.

Nel copiare un segmento, le marche di salto con nomi definiti in modo simbolico
(p.es. MARK) possono essere rappresentate solo in forma assoluta (p.es.
MO0001).

STEP 5/ST V7.0
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Copia

Procedere come segue:
1.

Aprire il segmento precedente o successivo a quello che si deve inserire co-

piato.

Premere F5 = Funz. segm.

F Cancella
4 Annota

1 Nuovo

F F F  Help
5 Inserisci 6 Aggiungi 7 8 Indietro
F F

2 Buffer 3 Dasegm.

STEP 5/ST V7.0
C79000-G8572-C920-02

Premere ancora F5 = Inserisci, se si vuole copiare prima dell’attuale seg-
mento, o0 premere F6 = Aggiungi se si vuole copiare dopo il segmento attuale.

Premere F3 = Da segm.

Lo STEP 5 emette la riga di segnalazione N. segm.

Introdurre il numero del segmento da copiare (p.es. 2) e premere il tasto di
introduzione .

Il segmento viene copiato.
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Copia del
segmento in un
altro blocco

A questo scopo procedere come segue:

1. Emettere il segmento da copiare tramite pagina avanti/indietro .

2. Premere F5 = Funz. segm.

Memorizzazione intermedia di un segmento

3. Premere F4 = Annota.

Il segmento viene memorizzato temporaneamente.

4. Premere F8 = Indietro.

Ritorno nell’editor del blocco in modo Emissione.

5. Salvare le modifiche con SHIFT + F7 oppure F7 = Conferma. Nel caso non si
siano apportate modifiche, abbandonare il blocco con ESC = Annulla

Copia segmento

6. Cambiare nel blocco di destinazione con F2 = Riferim. oppure tramite Menu.

7. Premere F5 = Funz. segm.

F Cancella
4 Annota

1 Nuovo

F F F Help
5 Inserisci 6 Aggiungi 7 8 Indietro
F F

2 Buffer 3 Dasegm.

8. Premere ancora F5 = Inserisci, se si vuole copiare prima dell’attuale seg-
mento, 0 premere F6 = Aggiunta se si vuole copiare dopo il segmento attuale.

9. Premere F2 = Buffer.

Viene copiato il segmento memorizzato temporaneamente.

10.Premere F8 = Indietro.

Ritorno nell’editor del blocco in modo Emissione.

5-20

STEP 5/ST V7.0
C79000-G8572-C920-02



Funzioni comuni in AWL, KOP, FUP

54.3 Cancellazione di un segmento

Sommario

Si possono cancellare i segmenti singolarmente. In questo caso anche il titolo ed il
commento segmento vengono cancellati. Dopo la cancellazione si deve aggiornare
la lista incrociata (XREF).

Premessa E aperto il segmento da cancellare. Lo STEP 5 si trova in modo Emissione.
Esecuzione Per cancellare, procedere come segue:
1. Premere F5 = Funz. segm.
2. Premere SHIFT F4 = Cancella e confermare con Si se si vuole veramente
cancellare.
Il segmento cancellato, con titolo e commento, viene scritto in un buffer inter-
medio. Esso puo essere nuovamente inserito prima o dopo di un qualsiasi
segmento ed anche in un altro blocco.
3. Premere F8 = Ritorno.
Ritorno nell’editor del blocco in modo Emissione.
Avvertenza
Si puo cancellare un segmento anche con SHIFT e Cancellazione segmento
nella parte numerica della tastiera.
544 Trasferimento / spostamento di un segmento
Sommario Si puo trasferire un segmento nello stesso blocco o in un altro blocco dello stesso
file programma. Questa funzione € composta da — Copia segmento (capitolo
5.4.2) e - Cancellazione segmento (capitola 5.4.3)|. Dopo il trasferimento si deve
aggiornare la lista incrociata [¢apitolo 17.1).
Esecuzione La procedura per il trasferimento € la stessa di quella per la copia segmento

STEP 5/ST V7.0
C79000-G8572-C920-02

(- Copiaturadiunsegmentoinunaltro blocco) conl'unicadifferenza, che dopol’anno-
tazione (memorizzazione intermedia) sideve cancellare con F4 il segmento esistente
nella precedente posizione.

e Premere SHIFT F4 = Cancella e confermare con Si.
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5.5 Generazione e visualizzazione lista incrociata, cambio blocco

Sommario

Premessa

5-22

I riferimenti incrociati di tutti i blocchi di un file programma sono depositati in un
file programma *XR.INI separato. A questi dati si pud accedere nella finestra di
editazione (vedere capitolo 5.2) modo Emissione) tramite la funzione F2 =
Riferim.

Con questa funzione & possibile:

Generare la lista incrociata tramite F1 = Gen. XREF.

Visualizzare la lista incrociata di un operando sul video tramite F2 = Vis.
XREF.

Attivare il cambio blocco, selezionando, col cursore, nella lista incrociata, un
determinato riferimento ed attivare il salto col tasto F2 = Salta,

Eseguire il cambio tramite I'indicazione del blocco e del segmento con il tasto
F4 = Bloc deste

nel caso sia stato eseguito un cambio blocco, ritornare nel blocco originario
col tasto F5 = Bloc orig.

In una lista incrociata si possono visualizzare i seguenti operandi:

Ingressi/uscite
Merker/merker estesi
Temporizzatori/contatori
Richiami blocco
Periferie

Dati e simboli

Lo STEP 5 si trova in modo Emissione. Il file XR.INI esiste ed & aggiornato. Ad esso
si accede:

impostando nel box di comando Edita blocchi STEP 5 - Aggiorna XREF, in
questo modo XR.INI viene aggiornato durante la memorizzazione del blocco,

o con la funzione di gestione -~ Genera XREF.

STEP 5/ST V7.0
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551 Generazione lista incrociata (Funzione Gen. XREF)

Sommario

Limitazioni della

Con questa funzione si genera la lista incrociata (riferimenti) relativa al file di pro-
gramma impostato con il nome *XR.INI.

Dopo l'attivazione della funzione la procedura di esecuzione si esegue automatica-
mente.

Lalistaincrociata generata si necessita nell’editor blocco durante la documentazione
in formato KOMDOK ed in GRAPH 5 per I'elaborazione delle funzioni F2 = Riferim.

Per la generazione XREF all'interno dell’editor, lo spazio di memoria a disposizione

funzione e minore di quello nel caso di una generazione XREF che viene direttamente avviata
dal menu. Per questo motivo il trasferimento di dati ai file temporanei, nel caso di file
di programma estesi, deve avvenire in un momento anticipato. Cio rende piu lenta
la generazione XREF.

55.2 Visualizzazione lista incrociata (Funzione "Vis. XREF")

Sommario A questo scopo procedere come segue:

STEP 5/ST V7.0
C79000-G8572-C920-02

1.

Posizionare il cursore sull'istruzione con I'operando, di cui si deve visualizzare
la lista incrociata, o, se 'operando non si trova nell’attuale segmento, prose-
guire con il passo 2.

Premere F2 = Riferim.
Premere F2 = Vis. XREF.
Lo STEP 5 segnala: Visualizz. XREF dell'operando : p.es. E 32.0.

Confermare o sovrascrivere I'operando e premere Conferma o il tasto di in-
troduzione . Viene visualizzata la lista incrociata dell'operando, per esempio:

F4 = Sovrapp/Singolo:

Sovrapp: |a lista incrociata contiene anche quegli indirizzi di byte, parola o
doppia parola dai quali I'indirizzo bit o byte dell’operando visualizzato & so-
vrapposto.

Singolo: solo dati di riferenza dell'operando indicato. Con cio la sovrapposi-
zione pud essere disabilitata quando si elaborano liste incrociate estese o
guando lo spazio in memoria non € sufficiente.

F5= ConDopp/SenzaDopp:

ConDopp: Se un operando € presente piu volte con lo stesso operatore in un
segmento di un blocco, questo viene anche visualizzato piu volte.
SenzaDopp: L'operando con lo stesso operatore presente piu volte nel seg-
mento viene visualizzato solo una volta: consigliabile per liste incrociate
estese o0 quando lo spazio in memoria non € sufficiente.

Ritorno al livello precedente con F8 = Indietro opp. premendo ESC. Se si
vuole saltare ad un altro blocco, proseguire premendo F2 = Salta.
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e FB 10 C:PROEXAST.S5D BIB=2 LUN=175
Riferimenti

E 32.0 PRINC-ON Commut. princ. a chiave "Impianto ON”

EB 32 INGR B Caricam. byte ingr. 32 per test

PB 10:1/L EB PB 10:1/T EB PB 10:2/L EW PB 10:2/T EW 1

PB 10:3/U PB 10:3/= PB 10:2/UN FB 10:2/0

FB 10:3/U

12
Salto a: PB 10
F F F F F F F F  Help
1 2 Salta 3 4 Sing. 5 SenzaDopp. 6 7 8 Indietro
F F F F F F F F  Help
1 2 Salta 3 4Sovrapp. 5 ConDopp. 6 7 8 Indietro
Figura5-4  Visualizzazione dei riferimenti incrociati

Quando ci si trova nel menu Help (SHIFT F8) e si conferma l'interrogazione Avanti?
con Si, si ottengono delle informazioni dettagliate sulle funzioni.

Avvertenza

I comandi contrassegnati con # sono comandi con funzioni di elaborazione (B
MW...o B DW). In questo caso, non si conosce il comando eseguito
effettivamente durante il tempo di esecuzione.
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553 Cambio blocchi

Salto ad un blocco

Cambio blocco

STEP 5/ST V7.0
C79000-G8572-C920-02

A guesto scopo procedere come segue:

1.

Selezionare col cursore, nella lista dei riferimenti, il blocco al quale si deve
saltare.

Premere F2 = Salta.
Visualizzazione del blocco selezionato.
Ritorno al segmento originario:

F8 = Indietro
F5 = Bloc orig.

A questo scopo procedere come segue:

1.
2.

Premere F2 = Riferim.

Premere F4 = Bloc dest.

Lo STEP 5 segnala Salto al blocco : segmento: 1

Introdurre il blocco o eventualmente sovrascrivere il numero del blocco.
Premere Conferma .

Visualizzazione del blocco selezionato.
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5.6 Ricerca di operandi, segmenti ed indirizzi

Sommario Conlafunzione Cerca, si possono trovare velocemente nel blocco aperto determinati
elementi, p.es. operandi. La ricerca viene effettuata dalla posizione del cursore in
avantioppure dalprimosegmentoinavanti. Selo STEP 5hatrovato I'elemento, questo
viene visualizzato nel corrispondente segmento.

Cosa si puo cercare ?

* Operandi assoluti E, M, S, A, T, Z
e Rijchiami di blocchi OBn, PBn, SBn, FBn, FXn, D
Bn, DXn

e Byte/word di periferie  PYn, PWn
e Dati DRn, DLn, DWn, DDn, Dn.m
e Operandi simbolici p.es. -INGRESSO

¢ Attribuzioni di operandi assoluti o simbolici

p.es. *Al1.0,* -INGRESSO
* Segmento
* Indirizzi
Premessa Lo STEP 5 si trova in Emissione.
Esecuzione Ricerca nel blocco

1. Premere F3 = Cerca.

2. Introdurre nella maschera il criterio di ricerca in assoluto o in simbolico, p.es.
E 1.1

3. Awviare la ricerca:

dal 1° segmento - premere F2 = Da segml1 o

dalla successiva riga d’istruzione - premere F3 = Avanti
Altre ricerche

Premere F3 = Cerca, vedere sopra.

Ricerca di segmenti

1. Introdurre il segmento come numero decimale

Ricerca di indirizzi

1. Introdurre I'indirizzo come numero esadecimale. Il carattere finale del numero
deve essere una H. In KOP/FUP viene cercato solo il segmento relativo a
questo indirizzo. In AWL viene determinata I'esatta posizione del cursore rela-
tiva a questo indirizzo. Se l'indirizzo € troppo grande, viene visualizzata la fine
del blocco come risultato della ricerca.

STEP 5/ST V7.0
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5.7 Editazione di operandi simbolici nel blocco

Sommario

Premesse

Procedimento di
editazione

STEP 5/ST V7.0
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Gli operandi simbolici si possono editare direttamente nel blocco mediante una lista.
Questa lista € un estratto del file simbolico *Z0.INI. Vengono visualizzati tutti gli ope-
randi del segmento aperto.

Dopo una modifica si deve aggiornare il file sorgente sequenziale *Z0.SEQ:

e tramite 'impostazione nel box di comando Blocchi STEP 5 3 Aggiorna file
sorgente seq.), memorizzando il blocco, viene aggiornato *Z0.SEQ,

e oppure si genera il file sorgente sequenziale dal file simbolico (- Gestione »
Liste di attribuzione» Converti INI > SEQ).

Nelle Impostazioni (- Progetto, capitolo 4.1.1) & selezionato Simbolico: Si. Se no,
commutare con SHIFT F3.

Lo STEP 5 si trova in Emissione.

A gquesto scopo procedere come segue:
1. Premere F1 = Vis. simb.

Sul video viene visualizzata la lista con gli operandi.
2. Selezionare I'operando tramite cursore allungato.

3. Premere F2 = Edit. simb.
Il cursore dei caratteri si trova nella colonna del simbolo.

FILE-SIMBOLICO: C:ALPHA1Z0.INI
OPERANDO SIMBOLO COMMENTO
E 3.1 ING 3-1 INGRESSO 3.1
E 43 ING 4-3
E 44 -
M 2.5 MERK. 25 MERKER 25

Figura5-5  File simbolico

4. Introdurre i nomi simbolici con lettere maiuscole e minuscole.

5. Posizionare il cursore con SHIFT e Cursore a destra oppure premendo il tasto
di introduzione nella colonna del commento.

6. Introdurre il commento con lettere minuscole e maiuscole.
7. Concludere la riga editata: premere F2 = Inserisci

8. Concludere 'editazione: premere F8 = Indietro e Conferma .

Avvertenza

| nomi simbolici dovrebbero iniziare senza una lineetta davanti al nome. Non &
possibile 'uso delle metafonie (&, U, 6).
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Editazione della lista istruzioni (AWL)

Sommario

Esempio

Sommario del
capitolo

STEP 5/ST V7.0
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L'istruzione STEP 5 & la piu piccola unita di un programma. Essa rappresenta, per
il processore, un comando operativo. Nellarappresentazione in Lista istruzioni(AWL)
perognirigavieneintrodotta un’istruzione, scrittain modo assoluto o simbolico (possi-
bili blocchi;: OB, PB, SB, FB/FX). Un’istruzione € costituita da una parte operazione
e da una parte operando:

Operazione Operando
Istruzione assoluta UN E1l1
Istruzione simbolica UN -Ingresso

\_ Test AG Gestione Docu(

Blocco STEP 5 ... F1
Blocco dati ... F2
Maschera DB ... Ctrl+F1
Lista di attribuzione F7
Vie bus F8

Parametri stampante  Ctrl+F4
Editor piedinatura  Ctrl+F5

Capitolo Argomento trattato Pagina
6.1 Operativita generale con I'Editor AWL 6-2
6.2 Semplice funzione di editazione 6-3
6.3 Blocchi funzionali 6-5

Per ogni segmento si possono editare 255 istruzioni.

Avvertenza

Un esempio dettagliato relativo all’editazione di liste istruzioni si trova nel capitolo
24 STEP 5 in un impiego pratico
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6.1 Operativita generale con I'Editor AWL

Premessa

Richiamo
dell’Editor

\ Editor

Blocco STEP 5

Suddivisione del
video

Introduzione
istruzioni

Correzione
istruzioni

Memorizzazione
blocco

6-2

Verificare per I'editazione I'impostazione progetto con il comando di menu File » Pro-
getto » Imposta F4 . Controllare I'esattezza delle registrazioni per quanto concerne
File programma, File simbolico, Funzionamento, Rappresentazione e Commenti.

Le istruzioni vengono introdotte sempre in Editazione. Richiamando un nuovo blocco
lo STEP 5 si trova in Editazione, richiamando un blocco gia esistente ci si trova in
modo Emissione. In questo caso commutare il modo con F6 = Edita.

Selezionare il comando di menu Editor » Blocco STEP 5 . Il box di dialogo Edita
blocchi STEP 5 appare sullo schermo.

Dopo aver dato un nome al blocco, si consiglia 'opzione Aggiorna XREF e, nel caso
siutilizzino operandi simbolici, siconsigliaanche diselezionare Aggiorna Lista attribu-
zione.

Dopo la conferma di questo ordine con Edita, viene richiamato I'Editor AWL.

Sul video compare un campo operativo per I'introduzione delle istruzioni.

Tramite il tasto SHIFT F8 = Help si ottengono chiarimenti relativi ai singoli tasti funzio-
nali.

L'introduzione dell’istruzione & senza formato, cioé lo STEP 5 introduce automatica-
menteiblank dopo la confermadellariga. Ognirigasiconclude conil tasto diintrodu-
zione .

Introdurre laprimaistruzione o posizionareil cursore sullarigadesiderataedintrodurre
listruzione, p.es. UN | 1.1 o UN-INGRESSO e premere il tasto di introduzione

Posizionare il cursore sull'istruzione e sovrascrivere. Si possono cancellare i singoli
caratteri con DEL .

Premere Conferma . Lo STEP 5 commuta in modo Emissione. Premere nuovamente
Conferma .

STEP 5/ST V7.0
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6.2 Semplice funzione di editazione

6.2.1 Visualizzazione indirizzi

Sommario

Procedimento

Con questa funzione si possono visualizzare gli indirizzi relativi delle istruzioni a
byte o a word durante I'editazione in AWL. Durante la visualizzazione degli
indirizzi non si pud editare nessuna istruzione ed introdurre nessun numero di
biblioteca.

Procedere come segue:

1. Premere SHIFT F1 = Indirizzi. In questo modo si attiva la visualizzazione con
indirizzi.
Lo STEP 5 emette gli indirizzi relativi a word.

2. Impostare gli indirizzi AWL su WORD o BYTE
(vedere - Progetto Capitolo 4.1.1)

3. Premere SHIFT F1 = Indirizzi. In questo modo si disattiva la visualizzazione
con indirizzi. Lo STEP 5 ritorna nella lista istruzioni senza indirizzi.

Avvertenza

Con emissione online da AG, lo STEP 5 mostra gli indirizzi a byte o a word a se-
condo del tipo di AG. In questo caso, con la seconda attivazione di SHIFT F1 =
Indirizzi, I'indicazione degli indirizzi sparisce. Il formato dell’'emissione indirizzi &
esadecimale.

6.2.2 Commento istruzioni

Sommario

STEP 5/ST V7.0
C79000-G8572-C920-02

I commenti alle istruzioni vengono memorizzati come i — Titoli segmento nei
blocchi di commento. Durante I'introduzione dei titoli segmento, che &
indipendente dalla rappresentazione, si puo associare solo in editor AWL un
commento (di riga) ad una singola istruzione. Ogni commento istruzione puo
essere lungo al max. 32 caratteri (larghezza campo).

Si puo introdurre un commento istruzione direttamente durante la programmazione
dellalistaistruzioni; ilrelativo blocco dicommento viene creato memorizzandoilblocco
STEP 5.

I commenti alle istruzioni si possono anche scrivere separatamente nel blocco com-
mento. Si consiglia il primo metodo, poiche cosi le associazioni, durante le modifiche
e larelativa memorizzazione, vengono aggiornate automaticamente. | nomi dei bloc-
chi commenti vengono associati automaticamente dallo STEP 5:

OKn a OBn,
PKn a PBn,
SKn a SBn,
FKn a FBn,

FKXn a FXn.
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Premessa Nelle impostazioni & selezionato [x] con commenti ( —» Progetto, capitolo 4.1.1), in
caso contrario € possibile commutare con SHIFT FA4.

Lo STEP 5 si trova in modo Editazione.

Esecuzione Procedere come segue:
1. Posizionare il cursore sull'istruzione desiderata.

2. Posizionare il cursore verso destra nel campo commento (SHIFT e cursore a
destra ).

3. Editare il testo con massimo 32 caratteri o correggere un testo gia esistente.
Dopo il 32° carattere, il cursore salta all'inizio del campo di commento.

4. Premere il tasto di introduzione

6.2.3 Memorizzazione del commento

Sommario Memorizzando per la prima volta il blocco con i commenti, viene creato automatica-
mente il blocco commento (OK, PK, SK, FK/FKX).

Se il blocco commenti esiste gia, lo STEP 5 segnala:
Conferma del commento?

Con Conferma si memorizza il commento, con ESC = Annulla viene perduto.

STEP 5/ST V7.0
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6.3 Blocchi funzionali

Sommario

Costituzione del
FB

Intestazione
blocco

Corpo del blocco

STEP 5/ST V7.0
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Un blocco funzionale (FB, FX) € un blocco di programma STEP 5, simile all'OB,
PB, SB. Mentre questi possono contenere solo le operazioni fondamentali, nel
blocco funzionale si possono programmare tutte le operazioni STEP 5:

* operazioni fondamentali,
® operazioni complementari
e operazioni simboliche.

Ogni blocco funzionale puo trovarsi solo una volta nella memoria di programma del
controllore programmabile. Durante la programmazione si definisce la funzione del
blocco, in cui gli operandi introdotti possono essere i cosiddetti operandi formali, che
esercitano la funzione di posto fittizio. Conirichiami ( Richiamo del blocco funzionale)
di un blocco di livello superiore, gli operandi formali vengono sostituiti dagli operandi
attuali.

Un blocco funzionale € costituito da:
* un’intestazione del blocco (FV, FXV),
* una testata del blocco (come tutti i blocchi),

¢ un corpo del blocco (come tutti i blocchi).

Contiene le sigle delle etichette dei salti che sono state introdotte nel blocco. L'intesta-
zione del blocco viene

* creata automaticamente da STEP 5 traducendo il blocco,

* memorizzata come FV e FXV nel file programma preimpostato,
* non trasferita né in AG e né su EPROM/EEPROM,

¢ cancellata assieme al FB o FX.

Se trasferendo un blocco funzionale dalla memoria AG nel file programma preimpo-
stato I'intestazione del blocco non esiste, lo STEP 5 segnala:

Intestazione blocco non esistente.

Ilcorpodelblocco contieneilprogrammaSTEP 5 ed unalistaconiparametridelblocco
ditutti i segmenti del blocco funzionale. Questa lista di parametri contiene tutte le indi-
cazioni per

* rappresentare graficamente il blocco (p.es. parametro d’ingresso e di uscita),

¢ poter controllare I'introduzione corretta del tipo di parametro durante I'introdu-
zione degli operandi attuali (parametrizzazione).
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6.3.1 Editazione di blocchi funzionali

Sommario Un blocco funzionale puo contenere, oltre alle istruzioni STEP 5, un nome del blocco
ed una lista di parametri degli operandi formali. In un segmento si possono program-
mare salti.

* La programmazione € anche possibile in KOP e FUP. Ad eccezione del primo
segmento si possono utilizzare all'interno di un segmento tutti i nuovi elementi
di linguaggio in modo grafico (-~ Editor, KOP/FUP)

¢ Gli operandi formali definiti nel primo segmento non possono essere utilizzati
nei segmenti di KOP e di FUP.

¢ |l nome di FB viene visualizzato nella funzione Indice

(Editor » Blocco STEP5 con opzione [x] FB con nome).

FB 200 C:DIR@@@ST.S5D BIB=12345 LUN=45
Segmen’(o 1 EMISSIONE
Nome : ESEMPIO ESEMPIO 1 & il nome di FB 200
Sigla :ING1 E/A/DIBITIZ: E BI/BY/WI/D: BI
Sigla  :ING2 E/A/DIBITIZ: E BI/BY/WI/D: BI
Sigla  :USC E/A/DIBITIZ: A BI/BY/WI/D: BI
Sigla :BAUS E/A/D/IBITIZ: B
Sigla :TEMP E/A/IDIBITIZ: T
Sigla : CONT E/A/DIBITIZ: Z

:B =BLOCCO Richiamo blocco A DB

U =ING1

U =ING2

:SPB = MARK Salto condizionato a MARK

1L — Parola dati10 Caricare la DW 10

T MW 2
MARK : Sl =TEMP Etichetta salto; start tempo

‘U =TEMP

= =USsC
Dok ok Fine segmento

F Indirizzi  F N. bibl. FSimb. SIM  FSenz comm F —>KOP F Comm.segm F Salva F Help

1Vis simb. 2 Riferim. 3 Cerca 4 5Funz segm. 6 Edita 7 Conferma 8 Annulla

Figura 6-1  Esempio di blocco funzionale (FB 200)

Tabella 6-1  Significato delle definizioni dei campi

Campo Descrizione
Nome Il nome (del blocco) pud essere lungo 8 caratteri e deve
iniziare con una lettera.
Lista dei La lista parametri contiene la sigla, la specie ed il tipo degli
Parametri: operandi formali. In un blocco funzionale si possono intro-

durre al massimo 40 operandi formali.

Sigla Sigla di operandi formali, lunga al massimo 4 caratteri, di
cui il primo carattere deve essere una lettera

STEP 5/ST V7.0
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Editazione nuovi
blocchi funzionali

STEP 5/ST V7.0
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Tabella 6-1  Significato delle definizioni dei campi, continuazione

Campo Descrizione

E/A/D/BITIZ

Parametro d’ingresso

Parametro d’'uscita

Dato (costante)

Richiamo blocco (A DBn/DXn, SPA OBn, PBn, SBn,
FBn/FXn)

Temporizzatore

Contatore

WO X>m

N —

BI/BY/W/D Bl Operando con indirizzo a bit

BY Operando con indirizzo a byte
W Operando con indirizzo a word
D Operando con indirizzo a doppia word

Lo STEP 5 si trova nel modo Editazione (AWL). Il segmento 1 & aperto. Per l'utilizzo
degli operandi simbolici deve esistere un file simbolico e nelle impostazioni deve es-
sere selezionato Simbolico: Si. Per un nuovo blocco funzionale procedere come se-
gue:

1.

Introdurre un nome con massimo 8 caratteri, p.es. ESEMPIO

Se il nome & lungo 8 caratteri, il cursore salta nel campo commento
(- Commento istruzione).

Premere il tasto di introduzione

Viene aperta la lista dei parametri degli operandi formali e viene visualizzato
Sigla.

FB 200 C:BUCH@@ST.S5D LUN=0
Segmento 1 Editazione
Nome : ESEMPIO

Sigla :

Figura 6-2 Lista dei parametri per operandi formali

3.

Introdurre una stringa di caratteri con massimo 4 caratteri per il primo ope-
rando formale.

Dopo 4 caratteri il cursore salta nel successivo campo d’introduzione. Con
meno di 4 caratteri bisogna premere il tasto di introduzione

Introdurre la specie dell'operando formale, p.es. E. Il cursore salta nel succes-
sivo campo d'introduzione.

Introdurre il tipo dell'operando formale, p.es. B/

Se vengono introdotti meno di 2 caratteri, premere il tasto di introduzione . Il
cursore salta nella successiva riga della lista dei parametri.

Introdurre altri parametri.
Concludere la lista dei parametri: premere il tasto di introduzione

Il cursore salta nella prima riga del corpo del blocco. Lo STEP 5 attende l'intro-
duzione della prima istruzione.
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Modificazione del
blocco funzionale

Procedimento

Avvertenza

Un inserimento successivo tra righe di parametri gia esistenti & possibile solo se i
parametri gia introdotti non sono stati utilizzati nel corpo del blocco.

Richiamandoil blocco funzionale, agli operandi formali vengono associati gli operandi
attuali. Lo STEP 5 si trova in modo Editazione. Il blocco funzionale richiamato deve
esistere nel file programma.

Per modificare, procedere come segue:
1. Introdurre il richiamo blocco:
SPA FB per il richiamo assoluto di un FB
SPB FB per il richiamo condizionato di un FB
BA FX  per il richiamo assoluto di un blocco funz. suppl.
BAB FX per il richiamo condizionato di un blocco funzionale suppl.

2. Premere il tasto di introduzione
Lo STEP 5 emette il nome del FB.

3. Premere il tasto di introduzione
Lo STEP 5 emette nella riga successiva il primo operando formale ed attende
I'introduzione del primo operando attuale.

4. Introdurre I'operando attuale assoluto o simbolico e premere il tasto di intro-
duzione .

Avvertenza

Con BI, T, C gli operandi attuali assoluti devono essere introdotti con un blank,
per esempio E 1.0.

5. Introdurre tutti gli altri operandi e di volta in volta concludere con il tasto di
introduzione .

Si puo fare emettere la specie ed il tipo del parametro come stabilito nella lista dei
parametri.

1. Premere il tasto di introduzione nella riga dell'operando formale o posizio-
nare il cursore a destra.

Lo STEP 5 presenta il parametro come definito nella lista dei parametri.
2. Confermare I'assegnazione o sovrascrivere.

3. Premere il tasto di introduzione

Avvertenza
Per linserimento di segmenti utilizzare i tasti funzionali F5 o F6. L'utilizzo del co-
mando AWL *** pud portare a strutture di programma non desiderate.

STEP 5/ST V7.0
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Sommario

Sommario del
capitolo
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Nella rappresentazione Schema a contatti KOP i compiti di comando sono descritti
conisimbolicircuitalielettromeccanici. Simulando la simbologia a contattidei comandi
arele, le operazioni del blocco vengono rappresentate sul video, in questa caso, con
contatti (in apertura, in chiusura) bobine di uscita e simboli funzionali per contatori,
temporizzatori ed operazioni di calcolo.

\_ Test AG Gestione Docu (
4 ‘Blocco STEP5...  FL

Blocco dati ... F2
Maschera DB ... Ctrl+F1
Lista di attribuzione F7
Vie bus F8

Parametri stampante  Ctrl+F4
Editor piedinatura  Ctrl+F5

La programmazione nella rappresentazione con schema a contatti € possibile nei se-
guenti blocchi STEP 5:

¢ Blocchi organizzativi OB

¢ Blocchi di programma PB

* Blocchi sequenziali SB

¢ Blocchi funzionali FB

* Blocchi funzionali supplementari FX.

I corrispondenti commenti segmento vengono depositati nei blocchi OBDO.nnn,
PBDO.nnn ecc.; i titoli segmento vengono memorizzati nei blocchi commento OK,
PK ecc.

Si consiglia di creare e di correggere i commenti di un blocco durante I'editazione e
non di elaborarli nei cosiddetti blocchi di documentazione e di commento.

Capitolo Argomento trattato Pagina
7.1 Operativita generale con I'Editor KOP 7-2
7.2 Semplice funzione di editazione 7-4
7.3 Esempio di editazione di combinazioni 7-7
7.4 Funzioni complesse 7-9
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7.1 Operativita generale con I'Editor KOP

Premessa

Richiamo
dell’Editor

\ Editor

Blocco STEP 5

Suddivisione del
Video

Introduzioni

7-2

Verificare per I'editazione I'impostazione progetto con il comando di menu File »
Progetto » Imposta F4 . Controllare I'esattezza delle registrazioni per quanto con-
cerne File programma, File simbolico, Funzionamento, Rappresentazione e Com-
menti.

Per I'editazione di blocchi esistenti € possibile selezionare il tipo di rappresentazione
con SHIFT F5 = KOP, indipendentemente dalla rappresentazione gia utilizzata.

Selezionare il comando di menu Editor » Blocco STEP 5 . Il box di dialogo Edita bloc-
chi STEP 5 appare sullo schermo.

Dopo aver denominato il blocco, si consiglia I'opzione Aggiorna XREF e, se si utiliz-
zano operandi simbolici, selezionare anche Aggiorna File-Sorg. Seq..

Confermando questo comando con Edita, viene richiamato I'editor dello schema a
contatti.

Sulvideo appare un campo operativo (figura 7-1) ed i tasti funzionali con i simboli per
I'introduzione dei contatti e I'elaborazione dei segmenti KOP.

Il video € suddiviso in 48 campi (8 colonne, 6 sezioni orizzontali), una sezione é alta
3 righe. Le combinazioni vengono editate nelle prime 7 colonne, I'ottava colonna e
riservata alle uscite.

La sigla dell’'operando ed il relativo contatto sono di volta in volta associati in uno dei
48 campi.

llcontenutodelvideosipuodfarscorrereversol'altooversoilbassosecondounmultiplo
massimo di 2,5. Tramite il tasto SHIFT F8 = Help si ottengono chiarimenti relativi ai
singoli tasti funzionali.

Introdurre nei campi di editazione, suddiviso inrighe e colonne, montanti elettrici, dira-
magzioni, contatti, uscite ed elementi funzionali, mediante soft key o mouse.

| collegamenti ed i simboli, con tutti i contrassegni, vengono creati automaticamente
(p.es.isegnalidiingresso/uscita pericontatori o funzionidicalcolo). | campidiintrodu-
zione perinomi e le parametrizzazioni sono preassegnati e raggiungibili automatica-
mente col cursore. Le configurazioni non ammesse non sono accettate dallo STEP 5.

STEP 5/ST V7.0
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Rappresentazione

La figura 7-1 illustra come esempio un segmento nella rappresentazione a contatti

KOP
@
T PB3 -PROG 3 C:ESEMP@ST.S5D BIB=12345 LUN=19
@ Segmento 1 Titolo segmento Editazione
| E11 -ING 1 Input 1.1
3) M 3.0
-ING 1 E 22
4 11 11 S
E 31
5
11
E 3.2
(6) 1
)
() M 33
() 1
E 4.2 F 20
I "
(22) E 55 A 10
] R _
(23) [ Q -0-
(24) Riga di segnalaz.
(25) F Aritmet. F Blocchi F Sposta F Convers. F Confronto F Comm.seg. F Extra F Help
1 ﬂ E 2 ﬂ/E 3 { 4 - 5 Oper.bin. 6 Finesegm. 7 Conferma 8 Annulla
Figura7-1  Segmento nella rappresentazione a contatti (esempio)

Righe del Video

Le singole righe del video hanno il seguente significato

Tabella7-1  Contenuto delle righe del video
Riga Contenuto Chiarimento
(1) PB3 Tipo e numero di blocco
-PROG3 Sigla simbolica del blocco
C:ESEMP@ST.S5D Drive e file programma
BIB=12345 Numero di biblioteca
LUN=19 Lunghezza del blocco in word
2 Segmento 1 Numero del segmento
Titolo segmento Testo con massimo 32 caratteri
Editazione Modo di elaborazione dello STEP 5
3 Operandi simbolici Attribuzione Operando assoluto - Operando simbolico - Com-
mento operando, se il cursore si trova su una sigla di un operando.
(4).. (22) | Area di editazione Campo d’introduzione per le combinazioni, i richiami e gli operandi
(23) Riga di Segnalazioni o richieste STEP 5 (rosso o verde)
segnalazione
(24) (25) | Tasti funzionali L'assegnazione dei tasti viene definita in relazione alle funzioni

STEP 5/ST V7.0
C79000-G8572-C920-02

7-3




Editazione di schemi a contatti

7.2  Semplice funzione di editazione

Operazioni
combinatorie

Sigle degli
operandi

7-4

Dopo aver scelto KOP lo STEP 5 apre il blocco, definito nel box di comando, dal primo
segmento. Questo &, con lanuova editazione, vuoto fino alla barra conduttrice situata
al margine sinistro.

Conitastifunzionaliintrodurre ora contatti, uscite ed elementi funzionali (tabella 7-2).
Nella colonna sinistra di queste tabelle € indicata I'operazione per I'elaborazione del/
dei contatto( i ), che vengono chiamati in modo Editazione con la sequenza dei tasti
indicata.

Tabella 7-2  Operazioni combinatorie in KOP (schema a contatti)

Operazione Tasti (funzionali) Chiarimento

|_| |_| F1 Contatto in chiusura
|—| yd |—| F2 Contatto apertura
—?— F3 Diramazione, congiunz.

— F4 Uscita

Oper. Bin. F5 Richiamo di funz. compl.
—(#y— F5+F4 Connettore
I_(/ )_| F5+F5 Connettore negato

[-] (Cursore destra ) | Elemento vuoto

Avvertenza

In KOP sono consentite per le uscite solo assegnazioni (=). Le funzioni Imposta
(S) e Resetta (R) create in AWL vengono visualizzate in KOP con S e R.

Dopo l'introduzione di un simbolo KOP, il cursore salta nel campo del nome (mass.
8 caratteri) dell'operando. Se nelle "Impostazioni” sono stati indicati piu di 8 caratteri
per il nome di un operando simbolico, lo STEP 5 emette solo i primi otto caratteri. Fare
attenzione che anche i pit lunghi nomi simbolici di operando si differenziano bene
nei primi otto caratteri per poter essere assegnati univocamente.

Esempio: Si ha la seguente assegnazione:

Operando Simbolo Commento
M 100.1 Merker 100
M1.1 Merker 1.1
M 1.7 Merker 1.7

I nomi simbolici di operando vengono visualizzati o stampati in modo seguente:
-Merker 1 -Merker 1 -Merker 1

— —— ——4/— | —(—

STEP 5/ST V7.0
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Editazione degli
operandi simbolici

Editazione dei
montanti elettrici
in serie e parallelo

Inserimento di
contatti
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Sono possibili due metodi per la denominazione di un operando:

1. Introduzione immediata dopo I'editazione di un simbolo (posizionamento auto-
matico del cursore),

di introduzione .

2. Introduzione delle sigle degli operandi nei campi di nomi del segmento termi-
nato, in questo si & aiutati dal cursore allungato.

In modo Emissione lo STEP 5 emette, premendo F1 = Vis. simb., una lista degli ope-
randi scritti in modo assoluto e simbolico per il segmento aperto.

In questa lista si puo editare. Fare attenzione che i nomi simbolici di operando si diffe-
renziano nei primi otto caratteri, cioé che € possibile assegnare questi univocamente
anche quando si utilizzano dei nomi piu lunghi. Sul video e durante la stampa sotto
KOP e FUP i nomi simbolici degli operandi sono troncati dopo i primi otto caratteri.

Dopo le modifiche si consiglia di aggiornare il file sorgente sequenziale, se questa
funzione non é stata selezionata nel box di comando.

L'introduzione di un primo contatto nella posizione assegnata del cursore allungato
nel segmento vuoto, crea un montante elettrico ininterrotto incluso il simbolo d’uscita.
Nel montante elettrico si possono inserire fino a 7 contatti, posizionando il cursore
sull'elemento vuoto desiderato e introducendo la funzione voluta (vedere tabella 7-2).

Altri montanti, disposti in parallelo, vengono connessi con questo montante elettrico
ininterrotto. La costruzione di un circuito di corrente in parallelo va proseguita fino al
punto di congiunzione, eventualmente introducendo degli elementi vuoti; solo dopo
di cio & possibile introdurre le sigle e le correzioni.

Un montante elettrico in parallelo si pud sempre collegare alla barra conduttrice. Le
diramazioni sipossono creare dopo aver posizionato il cursore allungato sotto un con-
tatto. Il punto di diramazione viene generato automaticamente prima di questo con-
tatto. Il punto di congiunzione si determina, eventualmente, con elementi vuoti tramite
il tasto F3 = Congiunzione.

Sottounelementovuotole diramazionirichieste vengonorespinte conlasegnalazione
Connessione parallela non ammessa

L'inserimento di un elemento vuoto & sempre possibile. L'inserimento in un montante
elettrico richiede un inserimento orizzontale con SHIFT F7 = Extra, F6 = Ins. oriz. op-
pure il tasto di inserimento orizzontale
in serie
¢ Posizionare il cursore allungato sul contatto dopo il punto d’inserimento e pre-
mere SHIFT F7 = Extrae F6 = Ins. oriz.
Tutte le righe del segmento vengono spostate di una colonna verso destra.

* Posizionare ora il cursore allungato sull’elemento libero inserito ed introdurre il
contatto tramite F1 o F2 o il connettore tramite F5 = Oper. bin. + F4=# 0 F5 =
/.

Con memorizzazione (Conferma) o nuova costruzione (Meta Video) vengono
tolti gli elementi vuoti eccedenti.
in parallelo

Imontantielettriciin parallelosicreanoall'interno diun segmento come descritto sopra,
posizionando il cursore allungato sotto il contatto prima del quale si vuole connettere
il montante in parallelo.

e Editare quindi con F1 ... F4il contatto desiderato.

Lo STEP 5 inserisce ora il segmento senza attivare SHIFT F7 = Extra, F7 =
Ins. vert. o il tasto di inserimento verticale e crea il posto per un nuovo mon-
tante elettrico parallelo.
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Nuova emissione
segmento

7-6

Una nuova emissione di un segmento editato in una forma non ottimale (p.es. con
inserimenti ripetuti), si ottiene premendo SHIFT F7 = Extrae F2= Nuova em., anche
seilsegmentonon & stato fornito dituttii parametri. Il video viene in questo caso nuova-
mente ricostruito e la rappresentazione viene messa in ordine in modo "ottimale”.

Avvertenza

Si puo abbandonare un segmento o un blocco solo se tutti i nomi ed i parametri
sono stati introdotti correttamente.

STEP 5/ST V7.0
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7.3 Esempio di editazione di combinazioni

Posizione di
partenza

Contatto in serie e
in parallelo

Inserimento
implicito

Sostituzione di un
elemento vuoto
tramite un contatto

Ponticellatura

STEP 5/ST V7.0
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Dopoaverpremutounavolta F1= Contattoinchiusura,introdottolasigladell’operando
E 10.0, premuto il tasto di introduzione e per l'uscita A 10.0 e premuto il tasto di
introduzione .

E 10.0 A10.0

Contatto in serie:

1. Posizionare il cursore sulla colonna 2 ed attivare F2 = Contatto in apertura,
introdurre E 10.2 e premere il tasto di introduzione

Contatto in parallelo:

2. Posizionare il cursore sotto il contatto E 10.0 e premere F1 = Contatto in chiu-
sura. Il ramo in parallelo viene concluso tramite la sequenza dei tasti (- cur-
sore a destra ) ed F3 = Congiunzione, introdurre la sigla E 10.2 e premere il
tasto di introduzione

E100 E10.1 A10.0
/I 1 1 1 1 1 —i
E10.2

Inserimento di un contatto in chiusura in un ulteriore ramo in parallelo:

3. Posizionare il cursore allungato sotto il contatto E 10.0 ed attivare F1 = Con-
tatto in chiusura e F3 = Congiunzione

Il contatto E 10.3 viene generato posizionando il cursore sull’elemento vuoto ed atti-
vando F2 = Contatto in apertura.

E100 EI101 A10.0
——/] ——
2?2?7777
}7
E10.2 E103
——

La seguente ponticellatura si ottiene:

4. Nel montante elettrico superiore: cursore sulla colonna 2 e premere F2 = Con-
tatto in apertura, poi cursore sulla colonna 3 e premere F1 = Contatto in chiu-
sura.

5. Editazione del ramo in parallelo: posizionare il cursore sotto il contatto E 10.0,
con F2 = Contatto in apertura ed F3 = Congiunzione e cosi posizionare il cur-
sore sulla colonna 2 del ramo parallelo e premere F1 = Contatto in chiusura ed
F3 = Congiunzione.

E 10.0 E 10.1 E 104 A 10.0
/o

E10.2 | E10.3

/
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Connessione dopo
un contatto

Assegnazione

Editazione di
connettori

Come connettere un montante in parallelo dopo il primo contatto viene mostrato nel
seguente segmento.

6. Nel montante elettrico superiore: cursore sulla colonna 2 e premere F2 = Con-
tatto in apertura per E 10.1.

7. Editazione del ramo in parallelo: posizionare il cursore sotto il contatto E 10.0,
con F2 = Contatto in apertura, F1 = Contatto in chiusura e F3 = Congiunzione.

ElOO 5101 A10.0
| 1 1 1 1 —( )
E{ms ElO}G_j

Aggiunta di un’uscita o di un’assegnazione:

8. Posizionare il cursore allungato sotto l'uscita A 10.0 e premere F4 = Uscita.

E 10.‘0 A10.0

s
Co—

Connettori e connettori negati (tabella 7-2) sono dei merker di appoggio in combina-
zioni binarie. Simemorizzail RLC generato fino a quel punto. Il connettore viene intro-
dotto in KOP come un contatto. Se esso si trova dopo I'ultimo contatto del montante
elettrico, viene rappresentato, dopolaconfermaelamemorizzazione, come un’uscita.

Immediatamente dopolaconnessione delramoin paralleloil risultato provvisorio deve
essere memorizzato nel merker M 10.7.

E100 ElOl E104 A10.0

| | | | | —i
E{lOS ElO‘G_j

Poiché in questo punto non & possibile eseguire un’'inserimento orizzontale, bisogna
prima di tutto cancellare il contatto E 10.4 e reinserirlo dopo il connettore:

9. Posizionare il cursore sul contatto sotto E 10.4 e premere DEL.

10.Posizionare il cursore sull’elemento vuoto e premendo F5 = Oper. bin. e
F4 = Connettore viene generato un connettore che verra siglato con M 10.7.
Infine inserire di nuovo il contatto E 10.4.

ElOO ElOl M10.7 E10.4 A10.0

|/ )+ | —( )
E{ms Elod

STEP 5/ST V7.0
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7.4  Funzioni complesse
Sommario Inmodo Editazione, con SHIF Tetastifunzionalioppure F5:= Oper. bin.sonorichiama-
bili le seguenti funzioni:
Tabella 7-3  Funzioni complesse in KOP
Operazione Tasti (funzionali) Chiarimento
Aritmet. SHIFT F1 (1) Operazioni aritmetiche:
ADD, SUB e F1, F2 Somma, sottrazione, moltiplicazione, divisione
MULT, DIV F3, F4
(per FB/FX) SHIFT F1 (8) Operazioni combinatorie, digitali
AND e F5 Combinazione AND, a word
OR F6 Combinazione OR, a word
XOR F7 Combinazione OR esclusivo, a word
Blocchi SHIFT F2 (2) Richiami di blocchi, e cioe:
SPAFB,SPBFB |e F1, SHIFT F1 |FB assoluto, FB condizionato
BA FX, BAB FX F2, SHIFT F2 | FX assoluto, FX condizionato
SPA..., SPB... F4, SHIFT F4 | OB, PB, SB assoluto,...condizionato
A DB, AX DX F6, SHIFT F6 |DB, DX
(Spostam.) SHIFT F3 (3) Operazioni di trasferimento e di caricamento
L/T e F7 Trasferimento e caricamento dell’operando
Spostamento SHIFT F3 (4) Operazioni di SHIFT e rotazione
(per FB/FX) e F1, SHIFT F1 | SHIFT verso sinistra word/doppia word
SLW, SLD SRW F2, SHIFT F2 | SHIFT verso destra della word
SVW, SVD F3, SHIFT F3 | SHIFT verso destra word/doppia word con segno
RLD, RRD SHIFT F4 Rotazione sinistra, destra
SHIFT F5
Conv. (per FB/FX) | SHIFT F4 (6) Operazioni di conversione
DEF, KEW e F1, SHIFT F1 | BCD->DUAL, gener. del compl. ad 1, a 16 bit
DUF, Kzw F2, SHIFT F2 | DUAL->BCD, gener. del compl. a 2, a 16 bit
DED, KzZD F3, SHIFT F3 | BCD->DUAL, gener. del compl. a 2, a 32 bit
DUD F4 DUAL->BCD, a 32 hit
FDG, GFD F5, F6 V. fissa -> V. mob., V. mob. -> V. fissa, a 32 bit
Confronto SHIFT F5 (7) Operazioni di comparazione
= >< e (tra due operandi):
> = <= F1, F2 Comparazione su "uguale”, "diverso”
F3, F5 Comparazione su "maggiore o uguale”, "minore o
uguale”
>< F4, F6 Comparazione su "maggiore”, "minore”
Oper. Bin. F5 (9) Operazioni di conteggio  (contatori):
ZR, ZV e F1, F2 Il valore di conteggio viene incrementato, decremen-
tato di 1
Oper. Bin. F5 (10) Operazioni di tempo (temporizz.):
Sl, SV e SHIFT F1/F2 | Start di un tempo con impulso, i. prolung.
SE, SA SHIFT F3/F5 | Start di un tempo come ritardo all’eccitazione/disec-
SS SHIFT F4 citazione
Start di un tempo con ritardo all’'eccitazione memoriz-
zata
F5 (5) Operazioni di memorizz., binaria:
S e SHIFT F6 Reset prioritario della memoria
R SHIFT F7 Set prioritario della memoria
F6 e F4 Connettore

STEP 5/ST V7.0
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Regole di
rappresentazione

7-10

Per la rappresentazione delle operazioni non elementari in KOP, riassunte nella
tabella 7-3 vale quanto segue:

1.

Tutte le operazioni da (1) a (10) nella tabella vengono rappresentate con ca-
selle in cui a sinistra si trova I'operando prima dell’elaborazione ed a destra il
risultato. Nelle caselle stesse STEP 5 introduce I'operazione selezionata col
tasto funzionale.

E possibile solo una funzione complessa per segmento, cioé durante I'edita-
zione si deve aprire sempre un nuovo segmento.

Alcuni elementi funzionali sono "allungabili”, cioé il numero di ingressi puo es-
sere aumentato, fino a quando I'operazione lo permette. Posizionando il cur-
sore sul "bordo superiore” della casella ed attivare I'inserimento verticale per
allungare la casella stessa.

La funzione shift/rotazione (4) richiede nella casella I'introduzione del parame-
tro di spostamento n, cioé il numero delle posizioni di bit, di cui il contenuto
dell'accumulatore deve essere spostato verso destra o verso sinistra. Il mas-
simo spostamento possibile dipende dal formato dell'operando ed € di 16 o 32
posizioni.

Le funzioni Aritmetiche e Confronto permettono l'introduzione di un altro tipo di
operando nella casella. E sempre preimpostato il tipo Numero a virgola fissa =
F

Avvertenza

Il tipo pud essere modificato solo una volta direttamente in seguito al richiamo
della casella.

STEP 5/ST V7.0
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7.4.1 Operazioni aritmetiche

Sommario

Esempio

STEP 5/ST V7.0
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Le operazioni ADD, SUB, MULT, DIV combinano di volta a volta due operandi negli
accumulatori 1 e 2 e generano un risultato nell’accumulatore 1. La funzione corris-
ponde alle instruzioni (AWL):

* caricamento operando 1

* caricamento operando 2

* esecuzione dell'operazione scelta;

¢ trasferimento del risultato nell'operando (ACCU 1)

Tipi di operandi: KF, DW, EW...

Editazione di una operazione di somma di due numeri a virgola fissa:

1. Premere ***0 F6 = Fine Segm. e quindi attivare SHIFT F1 = Aritmet.,
2. Scegliere I'operazione desiderata, qui F1 = ADD.

Lo STEP 5 emette la casella con gli ingressi/uscite non definiti ed il formato dell'ope-
rando preimpostato F.

2?7?7777 —|+ F KF +12345 —+ F

2727777777 — 222222777 DW 12 — . DW 14

3. Confermare il formato operando premendo il tasto di introduzione

4. Introdurre il primo operando, qui KF + 12345, e premere il tasto di introdu-
zione.

5. Introdurre il secondo operando, qui DW 12 e premere il tasto di introduzione

6. Definire 'operando (DW 14), in cui deve essere trasferito il risultato, e conclu-
dere con il tasto di introduzione

Il segmento assume ora la forma rappresentata sulla parte destra del video.

7-11
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7.4.2 Richiami di blocchi

Sommario Con l'aiuto dei richiami di blocchinello STEP 5, che rendono possibile, da un qualsiasi
blocco, il richiamo di ulteriori blocchi nel programma utente, & semplice realizzare un
programma strutturato. Un richiamo di blocco viene rappresentato in KOP o come
uscita (assegnazione) o come richiamo di blocco funzionale (FB/FX) rappresentato
come casella.

In un segmento vuoto introdurre un richiamo direttamente tramite i tasti funzionali.
Nei segmenti esistenti i richiami si possono inserire 0 aggiungere con/senza inseri-
mento implicito.

Avvertenza

Un segmento in KOP contiene solo un richiamo assoluto del blocco o una combi-
nazione col richiamo condizionato del blocco. Per questo, attivando il tasto F4 =
Uscita, viene assunta un’assegnazione di default: SPA oppure = (assegnazione).

Esempio 1 Richiamo condizionato di un blocco di programma

1. Posizionare il cursore sotto il simbolo di uscita e premere SHIFT F2 = Blocchi
e SHIFT F4=SPB ....

2. Introdurre il blocco destinazione, qui PB 24, nel campo d’introduzione tramite il
simbolo di richiamo e concludere con il tasto di introduzione

E100 E10.1 A10.0
/I 1 1 1 1 —(
E102 PB 24
—(SPB-|
Esempio 2 Richiamo condizionato di un blocco di programma

1. Premere SHIFT F2 = Blocchie F4 = SPA ....

STEP 5/ST V7.0
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Esempio 3

Richiamo assoluto di un FB in un segmento vuoto
1. Premere SHIFT F2 = Blocchie F1 = SPA FB.

L'editor emette la "parte superiore” del blocco col cursore nel campo della sigla.
2. Introdurre il nome del blocco richiamato, qui FB 10.

Il blocco funzionale viene visualizzato con i suoi operandi nella forma rappresentata
sulla sinistra.

3. Posizionare il cursore sul campo d’introduzione del primo operando attuale.
Introdurre la sigla in assoluto o in simbolico. Premendo il tasto d’introduzione
si salta nei campi successivi.

Il segmento ha pertanto I'aspetto rappresentato nella parte destra della figura.

FB 10 FB 10

TEST TEST

????72????  —ING1l USC [—?2?22?22?2?? E1.0 - ING1 USC —A10

?????2???? —ING2 E1.2 - ING2

?????2???? —ING2 T32 —ING2

222222222 — NUM Z8 — NUM

7.4.3 Operazioni di caricamento e trasferimento

Sommario

STEP 5/ST V7.0
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La funzione viene rappresentata con una casella, in cui a sinistra si trova I'operando
ed a destra il risultato. La funzione SHIFT F3 = Sposta e F7 = L/T corrisponde alle
istruzioni (AWL):

¢ caricamento dell'operando (DW, DD, EW...),
¢ trasferimento dell'operando (DW, DD, EW...).

Dopolacreazione dellacasella (vedere sopra) sidevono introdurre soltanto i due ope-
randi preimpostati tramite [????7].
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7.4.4

Sommario

Esempio

7.4.5

Sommario

7-14

Operazioni di shift e rotazione

Le operazioni di shift e di rotazione appartengono alle operazioni complementari (solo
FB/FX). Un’operazione di shift/rotazione viene rappresentata in un segmento vuoto
con una casella, in cui a sinistra si trova I'operando nel’ACCU 1 prima della operazione
di shift ed a destra il risultato. Premendo il tasto funzionale SHIFT F3 = Sposta ed
attivando la funzione desiderata nel secondo livello dei tasti, lo STEP 5 crea la casella
"non definita” in cui é introdotta la funzione scelta.

Il cursore dei caratteri lampeggia sotto il parametro n. Qui introdurre il numero di posi-
zioni di bit di cui deve essere shiftato il contenuto dell’operando.

Alla funzione corrispondono le istruzioni (AWL):
e caricamento dell'operando
¢ shift/rotazione dell'operando di "n” posizioni di bit

¢ trasferimento del risultato dell'operando (ACCU 1).

Spostare I'operando EW 12 di 7 posizioni a destra e trasferirlo nella DW 12.
1. Premere ***oppure F6 = Fine segm. e quindi attivare SHIFT F3 = Sposta
2. Scegliere I'operazione desiderata, qui F1 = SRW.
Lo STEP 5 emette la casella ( a sinistra).
3. Posizionare il cursore sul parametro n nella casella, qui 0, e digitare la cifra 7.

4. Introdurre la sigla dell’'operando di ingresso/uscita.

Avvertenza

Una modifica successiva del parametro n € possibile tramite selezione della ca-
sella allungata e posizionamento del cursore con Shift —> sul parametro.

Operazioni di memorizzazione

Conlafunzione dimemorizzazione il RLC viene memorizzato. Il comportamento della
funzione di memorizzazione si definisce durante il richiamo, scegliendo, dopo aver
premuto F5 = Oper. bin., Set prioritario con F6 0 Reset prioritario con F7= Sceglinel
secondo livello ditasti. Lo STEP 5 introduce I'operando prioritario in alto nella casella.

La funzione di memorizzazione viene rappresentata come una casella con due in-
gressi ed una uscita, S e I'ingresso di set, R € I'ingresso di reset e Q € l'uscita. In un
segmento puo essere inserita solo una funzione di memorizzazione.

La funzione di memorizzazione corrisponde alle seguenti istruzioni (AWL):

e U(N) primo operando d’ingresso
e S(R) operando
e U(N) secondo operando d’'ingresso

STEP 5/ST V7.0
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e R(S) operando
e U operando
o = operando (assegnazione)

Tipi di operando: M m.n, Am.n, D m.n ...

Lafunzione dimemorizzazione reagisce nel seguente modo alle variazioni dei segnali
d’'ingresso, corrispondentemente alla scelta della funzione:

Stato all'ingresso Uscita binaria Q
S R
0 0 Il vecchio stato rimane memorizzato
0 1 0
1 0 1
1 1 0 per S/IR
1 per R/S

Dopo aver premuto F5= Oper. bin. e lafunzione desiderata nel secondo livello di tasti,
lo STEP 5crea, nellaposizione del cursore allungatoinun segmentoin KOP, lacasella

"non definita”.

Esempio Editazione di una funzione di memorizzazione con Reset prioritario.

1. Posizionare il cursore su un elemento vuoto o sul contatto per I'ingresso di
set/reset e premere F5 = Oper. bin.e F7 = S.

Lo STEP 5 emette la casella o la inserisce nel segmento.

2????7?77?7

2?7?7??7??7?7? 1R Q[ ??2??27?7°77°7?

M 1.0
E21
—s
E22 A14.0
FH+RrR o ‘ e

2. Introdurre la sigla dell'operando della cella di memoria, qui M 1.0 e premere il

tasto di introduzione

3. Introdurre il contatto di chiusura E 2.1 ed E 2.2. Abbandonare il campo di intro-
duzione corrispondente con il tasto di introduzione

4. Introdurre l'uscita (Q) per l'interrogazione dello stato del segnale binario, qui
A 14.0 e premere il tasto di introduzione e poi Conferma . Si puo anche in-
trodurre F4 =—()—, A 14.0 e poi premere il tasto di introduzione

STEP 5/ST V7.0
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7.4.6 Operazione di conversione

Sommario Le operazionidiconversione (DUAL ~ BCD, complementoad 1 ed a2) appartengono
alle operazioni complementari (solo FB, FX). Una operazione di conversione viene
rappresentataconunacasellainunsegmentovuoto,incuiasinistrasitroval’'operando
nel’ACCU 1 primadellaconversione ed adestrail risultato. Dopo aver premutoil tasto
funzionale SHIFT F4 = Convers. e la funzione desiderata nel secondo livello di tasti,
lo STEP 5 crea la casella in cui € introdotta I'operazione scelta.

Alla funzione corrispondono le istruzioni (AWL):

* caricamento dell'operando

e conversione dell’'operando

¢ trasferimento del risultato nell'operando (ACCU 1)
Tipi di operando: DW, DD, EW...

Dopolacreazione dellacasella (vedere sopra) sidevonointrodurre soloidue operandi
preimpostati con [?7?2777].

7.4.7 Operazioni di comparazione

Sommario Le operazionidicomparazione combinano due operandidigitalinegliACCU 1e ACCU
2 in un risultato binario nellACCU 1.

Alla funzione corrispondono le istruzioni (AWL):

e caricamento dell'operando 1

e caricamento dell'operando 2

* esecuzione dell’'operazione di comparazione scelta;
¢ risultato logico combinatorio.

Una operazione di comparazione viene rappresentata in un segmento vuoto con una
casella, in cui a sinistra si trovano gli operandi nel’ACCU 1 e 2 ed a destra il risultato
logico.

Dopo aver premuto SHIFT F5 = Confrontoe lafunzione desiderata nel secondo livello
ditasti,lo STEP 5crealacasella’nondefinita”,incui€introdottalafunzione desiderata.
Nella casella si trova a sinistra I'operazione di comparazione scelta

(I'=, ><, >=, >, <=, <) ed a destra il formato degli operandi:

F = numero in virgola fissa (16 bit)
D = doppia word (32 hit)
G = numero in virgola mobile (32 bit)

Avvertenza

Il tipo pud essere modificato solo una volta direttamente in seguito al richiamo
della casella.

Modifica del tipo:

1. Posizionare il cursore allungato sul tipo

2. Posizionare con Shift + cursore a destra il cursore piccolo sulla sigla del tipo
3. Modificare il tipo

STEP 5/ST V7.0
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Esempio Editazione di un’operazione di comparazione tra due numeri in virgola fissa.
1. ***0 F6 = Fine segm., e quindi premere SHIFT F5 = Confronto.
2. Scegliere I'operazione desiderata, qui F2 = >< Comparazione su “diverso”.

Lo STEP 5 emette la casella con ingressi/uscite "non definiti” ed il formato dell'ope-
rando preimpostato F.

277777777 |>< F

2727?77 Q |- 27777777
KF +100
— > F
M12.1
DW34 | Q ‘ ‘ ‘ ‘ O

3. Confermare il formato dell’operando premendo il tasto di introduzione
4. Introdurre il primo operando, qui KF + 100, e premere il tasto di introduzione

5. Introdurre il secondo operando, qui DW 34, e premere il tasto di
introduzione .

6. Con il cursore sull'uscita: premere F4 —()—.

7. Denominare I'operando a cui deve essere attribuito il risultato, qui M 12.1 e
concludere con il tasto di introduzione

Il segmento ha ora la forma rappresentata sotto.

7.4.8 Operazioni combinatorie, digitali

Sommario Le operazioni combinatorie digitali appartengono alle operazioni complementari (solo
FB, FX). Le operazioni AND, OR, XOR combinano, di voltain volta, due operandi digi-
talinegli ACCU 1 e 2 in unrisultato nellACCU 1. Le funzioni corrispondono alle istru-
zioni:

e caricamento dell'operando 1 (DW, EW, MW...),
e caricamento dell'operando 2 (DW, EW, MW...),
e combinazione degli operandi a word (UW, OW, XOW),
¢ trasferimento del risultato nelloperando (DW, EW, MW...).

Esempio Combinazione AND a word di due operandi.
1. ***0 F6 = Fine segm. e quindi attivare SHIFT F1 = Aritmet.
2. Scegliere la funzione desiderata, qui F5 = AND.

STEP 5/ST V7.0
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7.4.9

Sommario

7-18

Lo STEP 5 emette la casellacon gliingressi/uscite "non definiti” ed il formato preimpo-
stato UW.

299997977 — UW Ew 124 — UW

7?7?7777 — — P?7??°?7?7?77 MW 10 — — DW 16

Confermare il formato dell’operando premendo il tasto di introduzione
Introdurre il primo operando, qui EW 124, e premere il tasto di introduzione

Introdurre il secondo operando, qui MW 10 e premere il tasto di introduzione

2 e

Denominare I'operando in cui bisogna trasferire il risultato, qui DW 16 e
premere il tasto di introduzione

Il segmento ha ora la forma rappresentata sulla destra.

Operazioni di conteggio

Un’operazione di conteggio viene rappresentata come una casella in un segmento
vuoto. L'operando del contatore si trova sopra la casella. A seconda della scelta nel
secondo livello di tasti, F1 = conteggio Indietro, F2 = conteggio Avanti”, il primo degli
ingressi del contatore & per il conteggio indietro ZR o per il conteggio in avanti ZV ed
il secondo ingresso & di volta in volta complementare. Questo é condizionato dall’esi-
genzacheilprimoingressodiun contatore deve essere, nellarappresentazione, sem-
pre connesso.

Dopo aver premuto F5= Oper. bin. e lafunzione desiderata nel secondo livello di tasti,
lo STEP 5 crea una casella "non definita” con i seguenti ingressi/uscite:

ZR Decrementa di 1 il valore del contatore quando il RLC, a questo ingresso,
cambia da 0 ad 1 (fronte di salita).

ZV  Incrementa di 1 il valore del contatore quando il RLC, a questo ingresso,
cambia da O ad 1.

S Il valore di conteggio acquisice il valore all'ingresso ZW quando a questo
ingresso di "set” si presenta un fronte positivo (0 - 1).

ZW Valore da impostare nel contatore, codificato in decimale (BCD)
0 ... 999, tipi di operando: KZ, EW, MW, AW, DW.

R Il contatore viene resettato al valore 0, quando a questo ingresso &
presente una stato. L'uscita Q viene impostata a 0.

DU Contenuto attuale del contatore, codifica duale.
DE Contenuto attuale del contatore, codifica BCD.

Q L'uscita visualizza, con uno stato di segnale binario, se il contenuto del
contatore & zero = "0” oppure > zero: = 1.

Operando di conteggio: C0..C255
Campo di conteggio: 0...999

STEP 5/ST V7.0
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Esempio
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Editazione di una funzione di conteggio in avanti.

1. ***0 F6 = Fine segm. e quindi premere F5 = Oper. bin.e F2 = ZV.

Lo STEP 5 emette una casella con ingressi/uscite non definiti.

irararirirarirird

229977222 —{zV
222222227 —ZR
222277222 S
222997222 —| ZW DU [~ 222222722
DE — 7222227222
297997222 —|R Q- ??2?272727?
E 320 210
— 2z
—zrR
M2.0
— s
KZ255  —|ZW DU[~ DW 64
DE [~
E321 Dw 66 M12.1
— —+HR Q b

2. Introdurre I'operando (Z10) e premere il tasto di introduzione

Introdurre I'operazione per ZV, qui premere F1 = Contatto in chiusura ed

introdurre la sigla E 32.0. Concludere con il tasto di introduzione

Tramite DEL saltare I'operazione per ZR.

Introdurre 'operazione per impostare il contatore, qui premere F1 = Contatto in

chiusura, introdurre la sigla M 2.0. Concludere con il tasto di introduzione

6. Introdurre il valore di conteggio, qui KZ 255, e premere il tasto di

introduzione.

7. Introdurre I'operazione per I'ingresso di reset, qui premere F1 = Contatto in chiu-
sura, introdurre la sigla E 32.1 e premere il tasto di introduzione

Introdurre il trasferimento del valore di conteggio negli operandi DW 64 e
DW 66 e premere il tasto di introduzione

All'uscita Q: F4 = —( )—, introdurre M 12.1 e premere il tasto di introduzione

7-19



Editazione di schemi a contatti

7.4.10 Operazioni di temporizzazione

Sommario Con le operazioni dei temporizzatori vengono realizzate e controllate tramite pro-
grammale sequenze temporali. L'andamento dellafunzione del temporizzatore viene
definita tramite il richiamo, scegliendo, dopo aver premuto F5, la funzione desiderata
nel secondo livello di tasti con SHIFT F1 ... SHIFT F5. Lo STEP 5 introduce questo
andamento simbolico all'ingresso distartnellacasella. L'operando deltemporizzatore
si trova sopra la casella.

Una funzione di tempo viene avviata se il RLC all'ingresso di start cambia. Con un
ritardo alla diseccitazione (SA) il RLC deve cambiare da 1 a 0, in tutti gli altri casi da
0 ad 1. | parametri all'ingresso di start hanno il seguente significato (vedere anche
SHIFT F8 = Help):

Sim- Tasto Significato
bolo
1-—— |[SHIFT F1 =Sl | Startcome impulso

1--V |[SHIFT F2 =SV | Start come impulso prolungato
T!-10 | SHIFT F3 =SE | Start come ritardo all'eccitazione
T!-1S | SHIFT F4 =SS | Start come rit. all’eccit. memor.
0!'-IT | SHIFT F5 =SA | Start come ritardo alla diseccitaz.

Dopo aver premuto F5= Oper. Bin. e lafunzione desiderata nel secondo livello di tasti,
lo STEP 5 crea una casella "non definita” con i seguenti ingressi /uscite:

Simbolo Operando per I'avviamento della funzione di tempo (il simbolo
corrispondente alla funzione si desume dalla soprastante tabella).
T™W Ingresso per l'introduzione della durata del tempo

Tipo di operando: KT, EW, DW ...

La durata del tempo € composta da un valore di tempo e da una
base tempi. Il valore di tempo rappresenta il numero di periodi di
tempo, in cui la funzione dura. La base tempi indica con quale
cadenza temporale il valore di tempo viene modificato.

p.es. KT =n.i;

n = valore di tempo: 0 ... 999;

i = base tempi: 0=0.01s,1=0.1s, 2 = 1s, 3 =10s.

R Ingresso di reset della funzione di tempo: quando I'operando
assume il valore, il tempo e Q = 0.

DU Valore di tempo attuale, codifica duale.
DE Valore di tempo attuale, codifica BCD.
Q L'uscita indica con uno stato di segnale binario se il tempo scorre

(Q =1) o non scorre, cioé trascorso, (Q = 0).
Numero del temporizzatore: T O ... T 255

STEP 5/ST V7.0
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Esempio
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222772772722 —{ 0! T

Editazione di una funzione di tempo con ritardo alla diseccitazione.

***0 F6 = Fine segm. e quindi premere F5 = Oper. bin. e SHIFT F5 = SA.

Lo STEP 5 emette la casella.

pirariririririvird

227777272722 — TW DU |- 2222722222

27?2?7777 R Q[ ????27?977
E 20.0 T20
[———— 0! IT

KT100.1 —|TW DU~ DW 20

DE |~ DW 22

E 20.3 M22.1

| — R Q : : : : : O

Introdurre il numero del temporizzatore, qui T 20 e premere il tasto di
introduzione .

Introdurre I'operando per attivare la cella del temporizzatore, qui premere
F1 = Contatto in chiusura ed introdurre la sigla E 20.0 e premere il tasto di
introduzione .

Introdurre la durata di tempo KT 100.1 (10s) e premere il tasto di
introduzione .

Introdurre I'ingresso di reset F1 = Contatto in chiusura ed E 20.3, e premere |l
tasto di introduzione

Introdurre il trasferimento del valore del temporizzatore negli operandi DW 20

e DW 22 di volta in volta concludere con il tasto di introduzione

. All'uscita Q: F4 = —( )—, introdurre M 22.1 e confermare.
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Sommario

Sommario del
capitolo
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Nella rappresentazione a schema logico FUP i compiti di comando sono descritti tra-
mite il collegamento dei simboli delle funzioni. Simulando i simboli grafici secondo
DIN 40700, le funzioni sono rappresentate sul video con i simboli delle operazioni
(DIN 40719, DIN 19339).

\_ Test AG Gestione Docu(
a
‘Blocco STEPS5...  F1L

Blocco dati ... F2
Maschera DB ... Ctrl+F1
Lista di attribuzione F7
Vie bus F8

Parametri stampante  Ctrl+F4
Editor piedinatura Ctrl+F5

La programmazione nella rappresentazione con schema logico & possibile nei se-
guenti blocchi STEP 5:

* Blocchi organizzativi OB

¢ Blocchi di programma PB

¢ Blocchi sequenziali SB

¢ Blocchi funzionali FB

* Blocchi funzionali supplementari FX.

I corrispondenti commenti segmento vengono depositati nei blocchi OBDO.nnn,
PBDO.nnn ecc. | titoli segmento vengono memorizzati nei blocchi commento OK, PK
ecc.

Si consiglia di creare e di correggere i commenti di un blocco durante I'editazione e
non di elaborarli nei cosiddetti blocchi di documentazione o di commento.

Capitolo Argomento trattato Pagina
8.1 Operativita generale con I'Editor FUP 8-2
8.2 Semplice funzione di editazione 8-4
8.3 Funzioni complesse 8-9
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8.1 Operativita generale con I'Editor FUP

Premessa

Richiamo
dell’editor

\ Editor

Blocco STEP 5

Suddivisione del
video

Introduzione

8-2

Verificare per I'editazione I'impostazione progetto con il comando di menu File » Pro-
getto » Imposta F4 . Controllare I'esattezza delle registrazioni per quanto concerne
File programma, File simbolico, Funzionamento, Rappresentazione (FUP) e Com-
menti.

Per I'editazione di blocchi esistenti € possibile selezionare il tipo di rappresentazione
con SHIFT F5 = FUP, indipendentemente dalla rappresentazione gia utilizzata.

Selezionare il comando di menu Editor » Blocco STEP 5 . Il box di dialogo Edita
blocchi STEP 5 appare sullo schermo.

Dopo aver denominato il blocco, si consiglia I'opzione Aggiornamento XREF e, nel
caso si utilizzino operandi simbolici

Confermando questo comando con Edita, viene richiamato I'editor dello schema lo-
gico.

Confermando questo comando con OK, viene richiamato I'editor dello schemalogico.
Sul video compare un campo operativo (figura 8-1) e la barra dei tasti funzionali con
i simboli per l'introduzione delle funzioni e I'elaborazione dei segmenti FUP.

Il video & suddiviso in 48 campi ( 8 colonne , 6 sezioni orizzontali), una sezione ¢ alta
3 righe. | simboli dello schema logico vengono editati nelle colonne da 2 a 7.

Il contenuto del video si pud fare scorrere verso I'alto o verso il basso secondo un
multiplo massimo di 2,5. Tramite il tasto SHIFT F8 = Help si ottiene chiarimenti relativi
ai singoli tasti funzionali.

Introdurre nel campo di editazione, suddiviso in righe e colonne, i simboli dello schema
logico delle funzioni desiderate, mediante tasti funzionali o mouse. Un simbolo da
solo occupa la larghezza di una colonna. Le sigle degli ingressi/uscite necessitano,
in piu, prima e dopo, ciascuna una larghezza della colonna.

Nella costruzione del segmento si &€ molto supportati dallo STEP 5. | collegamenti
ed i simboli, con tutti i contrassegni, vengono creati automaticamente (p.es. i segnali
di ingresso/uscita per i contatori o funzioni di calcolo). | campi di introduzione per i
nomi e le parametrizzazioni sono preassegnati e raggiungibili automaticamente col
cursore. Le configurazioni non ammesse non sono accettate dallo STEP 5.

STEP 5/ST V7.0
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Rappresentazione

in FUP
®
PB 3 -PROG 3 C:ESEMP@ST.S5D BIB=12345 LUN=19
2 | -Segmento 1 Titolo segmento Editaz.
@ —1 e ANG 1 Ingresso 1.1
@B —|
E 11
E 22 & >=1
E 31
E 32
@ E 33 0
E 4.2 M 3.0
M_2.0 & L ||
=0 -
R R
BE
(22)
(23)
(24) Riga di segnalazione
(25) F  Aritmet. F Blocchi F  Sposta F F Confronto F Comm.Segm F Extra F Help
1 & 2 >=1 3 —{ 4 —0 5 Oper.bin. 6 Finesegm 7 Conferma 8 Annulla
Figura8-1  Segmento rappresentato in schema logico (Esempio)

Righe del Video

Le singole righe del video hanno il seguente significato:

Tabella8-1 Contenuto delle righe del video

Riga Contenuto Chiarimento
Q) PB Tipo e numero del blocco
—PROG3 Sigla simbolica del blocco
C:ESEMP@ST.S5D Drive e file programma
BIB=12345 Numero di biblioteca
LUN=19 Lunghezza del blocco in word
2) Segmento 1 Numero del segmento
Titolo segmento Testo con max 32 caratteri
Editazione Modo di elaborazione dello STEP 5
3) Operandi simbolici Attribuzione "Operando assoluto” - "Operando simbolico” —
commento operando, se il cursore si trova su una sigla di un
oprando
4) ... Campo di Campo d’introduzione per le combinazioni, i richiami e gli operandi
(22) editazione
(23) Riga di Segnalazioni o richieste STEP 5 (rosso o reverse)
segnalazione
(24) ... Tasti funzionali L'assegnazione dei tasti viene definita in relazione alle funzioni
(25)

STEP 5/ST V7.0
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8.2 Semplice funzione di editazione

Operazioni
combinatorie

Sigle di operandi

8-4

Dopo aver scelto FUP lo STEP 5 apre il blocco, definito nel box di comando, dal primo
segmento. Questo & inizialmente vuoto per una nuova editazione.

Conitasti funzionaliintrodurre ora i simboli di base dello schema logico per le combina-
zioni AND/OR degli operandi binari (tabella 8-2). Nella colonna sinistra di questa ta-
bella & indicata I'operazione per I'elaborazione del/degli operandof/i, che vengono chia-
mati in modo Editazione con la sequenza dei tasti indicata.

Tabella 8-2  Operazioni combinatorie in FUP (Schema logico)

Operazione Tasti funzionali Chiarimento
& F1 Combinazione AND

>=1 F2 Combinazione OR

— F3 Ingresso
—O0 F4 Ingresso negato

Oper. bin. F5 Richiamo funzioni complesse
# F5e F4 Connettore

/ F5e F5 Connettore negato
Avvertenza

In FUP sono consentite per le uscite solo assegnazioni (=). Le funzioni Imposta
(S) e Resetta (R) create in AWL vengono visualizzate in FUP con S e R.

Dopol'introduzione diun simbolo FUP il cursore dei caratteri salta nel campo delnome
(max. 8 caratteri) perilprimooperando. Se nellamaschera /mpostasono statiimpostati
piu di 8 caratteri per la denominazione di un operando simbolico, lo STEP 5 emette
soloiprimi8caratteri. Fare attenzione che ancheipitlunghinomisimbolicidioperando
sidifferenziano bene nei primi otto caratteri per poter essere assegnati univocamente.

Esempio : Si ha la seguente assegnazione:

Operando Simbolo Commento
M 100.1 Merker 100
M1.1 Merker 1.1
M 1.7 Merker 1.7

I nomi simbolici di operando selezionati vengono visualizzati e stampati in FUP tutti
come Merker 1.

Per la denominazione dell’operando sono possibili due metodi:
1. Introduzione immediata dopo I'editazione di un simbolo (posizionamento auto-

ritornare premendo il tasto di introduzione

2. Introduzione delle sigle degli operandi nei campi dei nomi del segmento termi-
nato, in questo si & aiutati dal cursore allungato.

STEP 5/ST V7.0
C79000-G8572-C920-02



Editazione di schemi logici

Editazione degli
operandi simbolici

Riconfigurazione

In modo Emissione lo STEP 5 emette, dopo aver premuto F1 = Vis.simb., una lista
degli operandi scritti in modo assoluto e simbolico per il segmento aperto.

In questa lista si puo editare. Fare attenzione che i nomi degli operandi simbolici si
differenzino nei primi otto caratteri, cioe siano univoci, anche se si utilizzano sigle piu
lunghe. Sul video e nella stampa in KOP e FUP infatti i nomi degli operandi simbolici
sono tagliati dopo i primi otto caratteri.

Avvertenza

La modifica dell'operando di un connettore & possibile solo dopo la cancellazione
ed una nuova introduzione.

Una nuova emissione di un segmento editato in una forma non ottimale (p.es. con

segmento inserimenti ripetuti), si ottiene premendo F7 = Extra e F2 = Nuova em. , anche se il
segmento non é stato fornito di tutti i parametri. Il video viene in questo caso nuova-
mente ricostruito e la rappresentazione viene messa in ordine in modo "ottimale”.
Avvertenza
Si pud abbandonare un segmento o un blocco se tutti i nomi ed i parametri sono
stati introdotti correttamente.

8.2.1 Editazione, modifica, cancellazione delle funzioni

Sommario L'introduzione di un primo operatore nella posizione assegnata del cursore allungato
nel segmento vuoto crea un blocco funzionale con due operandi d’ingresso ed uno
d’uscita. Una catena funzionale seriale puo comprendere al massimo 5 operatori AND/
OR.

Modifica del Il numero degli operandi di ingresso puo essere aumentato (vedere I'esempio):

segmento

STEP 5/ST V7.0
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1. tramite I'aggiunta, posizionando il cursore allungato sull'ingresso piu basso
della casella.

2. tramite inserimento e posizionamento in un blocco funzionale
(limite = 2 1/2 x altezza del video)

La conversione di un ingresso in un blocco funzionale € possibile:

3. posizionando il cursore sulla sigla dell'operando e premendo F1 =& o
F2=>=1.

Un ingresso si inverte :
4. posizionando il cursore sulla sigla dell’'operando e premendo F4 = Ingresso o
F5 = Ingresso negato.

L'attuale ingresso € il complementare del precendente. Una funzione editata si modi-
fica posizionando il cursore sulla sigla dell’'operando nella casella e sovrascrivendola
con l'operazione desiderata.
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Cancellazione

Esempio

8-6

Per la cancellazione (tasto DEL) di operandi e funzioni nel segmento valgono le se-
guenti regole:

1. Uningresso, che si trova sotto il cursore allungato, viene cancellato. L'ele-
mento funzionale stesso viene accoriciato dell'ingresso cancellato cioé di una
riga, vedere figura 8-2 (A).

2. Lattivazione della funzione di cancellazione su un ingresso connesso provoca
la rimozione dell’elemento funzionale o della catena funzionale prima di que-
sto ingresso. Lo stesso ingresso viene per questo rappresentato "non definito”,
vedere figura 8-2 (B).

3. Un elemento funzionale con due operandi d'ingresso viene rimosso. Di volta in
volta I'operando rimanente occupa l'ingresso del blocco successivo che si li-
bera, vedere figura 8-2 (C).

4. Un elemento funzionale con due ingressi, di cui uno & connesso, viene ri-
mosso dal segmento dopo aver cancellato I'operando. Gli elementi funzionali
connessi in serie all’altro ingresso operano direttamente sul blocco succes-

sivo.
Cursore allungato + DEL
E100 —& K
E10.1 — <1 |, —_> E100 —& (A)
E200 4/ // E10.1 — <1
E100 —&
101 — }—=1 — E100 —J& (B)
E20.0 — ]
E10.1 <1
E201 —4// N
— E20.0 — —
E100 —&
E10.1 — —AZY 292972772 <1 (©)
E20.0 — :> E200 —|
E20.1 — E201 —
E100 —2&/
E10.1 —
E200 — <1 — E101 —<1 (D)
E20.1 —] E20.0 —
E201 —
Figura8-2  Cancellazione di operandi e funzioni (esempio)

Se sivuole contrassegnare un operando d’ingresso come "non definito”, & sufficiente
digitare nel primo carattere del campo d’'introduzione un punto interrogativo.

STEP 5/ST V7.0
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Aggiunta di
operandi

Aggiunta di un
elemento
funzionale

Inserimento di
operandi
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Posizionare il cursore allungato sotto il bordo inferiore dell’elemento funzionale e pre-
mere F3. Viene aggiunto, sotto nel blocco, un operando non definito (A).

(A)
E100—<1 E100 — =t
E20.0 —; E200 T
_— g 272222277 —

Cursore allungato +F3

Figura 8-3  Aggiunta di operandi

Posizionare il cursore allungato sull’operando d’ingresso, che si vuole sostituire con
un elemento funzionale e premere F1 oppure F2.

Lo STEP 5 aggiunge I'elemento funzionale scelto con due ingressi, eventualmente
con l'inserimento orizzontale implicito, prima dell'ingresso. La sigla dell’operando
viene trasferita all'ingresso superiore del nuovo elemento (B).

Inserimento orizzontale e verticale, significa che, in questo caso, lo spostamento del
segmento verso destra e verso il basso avviene implicitamente.

E100 —&
2292277 —| <1

E200 —
(B)

Figura8-4  Aggiunta di un blocco funzionale

Procedere come segue:

1. Posizionare il cursore allungato sull'ingresso dell’elemento funzionale, in cui si
vuole inserire 'operando d’'ingresso.

2. Premere SHIFT F7 = Extra, F7 = Ins. vert. e quindi premere F3 = Ingresso.

Nel blocco viene inserito un operando non definito. Dopo la denominazione di un ope-
rando si puo invertire I'ingresso tramite F4.

Cur. all. + F7 (Ins. vert))

E100 & ¢+ F3 (Ingr)) E100 —&
E10.1 —| <1 J E10.1 —| <1
JE 200 — - 27227277 —
E200 —

Figura 8-5 Inserimento di operandi
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Inserimento di un
elemento
funzionale

Editazione di
connettori

Procedere come segue:

1. Posizionare il cursore allungato sull'ingresso dell’elemento, prima del quale si
vuole inserire una funzione.

2. Premere SHIFT F7 = Extra, F6 = Ins. oriz. e scegliere la funzione desiderata,
qui F1 =&.

E 10.0 & E 10.0 | &
E 10.1 — T VY E 10.1 — &
£ 2007 22222277 — <1
| <
, E 20.0 —|
Cur.all. +F7 (Ins.oriz) + F1 (&)

Figura 8-6 Inserimento di un blocco funzionale

Lo STEP 5 aggiunge I'elemento funzionale scelto, in modo tale che I'ingresso super-
iore risulti collegato. L'operando all'ingresso inferiore &€ non definito.

| connettori ed i connettori negati sono merker di appoggio in combinazioni binarie.
Un connettore viene introdotto in FUP come un elemento funzionale. Se esso sitrova
dopo l'ultimo blocco di un segmento, viene gestito e rappresentato come un’uscita.

Inserimento

All'uscita dell’elemento AND, il risultato intermedio deve essere acquisito dal merker
M 20.1:

1. Siglare il connettore, p.es. con M 20.1 (A) e premere il tasto di introduzione
Accumulo di connettori

2. Un accumulo di connettori si ottiene quando si posiziona il cursore sul connet-
tore e si preme nuovamente F5 = Oper. bin. e F4 =# o0 F5 =/ e si introduce la
sigla del merker, qui M 30.1.

Con l'inserimento implicito, il connettore introdotto prima, viene spostato di volta in
volta di una riga verso il basso.

Connettore prima dell’'uscita

L'introduzione del connettore M 20.1 primadell’uscita porta alla rappresentazione (B).

E 10.0 — & Cursore all. +F6 = Ins. orizz.)

] / +F5 =Oper.bin.) +F4 (#)
E 10.1 cfeds

E200 — —o—|:| A10.1
E 10.0 —&
E 10.1 — — /M30.1
#M20.1 — =<1
E200 —| - Al10.1
A) M20.1  (B)

Figura 8-7 Editazione di connettori

Un connettore viene cancellato posizionando il cursore e premendo DEL.
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8.3  Funzioni complesse

Sommario In Editazione con SHIFT e tasti funzionali oppure F5: = Oper. Bin. sono richiamabili
le seguenti funzioni:

Tabella 8-3  Funzioni complesse in FUP

Operazione Tasti (funzionali) Chiarimento
Aritmet. SHIFT F1 (1) Operazioni aritmetiche:
ADD, SUB e F1, F2 Somma, sottrazione,
MULT, DIV F3, F4 moltiplicazione, divisione
(per FB/FX) SHIFT F1 (8) Operazioni combinatorie, digitali
AND e F5 Combinazione AND, a word
OR F6 Combinazione OR, a word
XOR F7 Combinazione OR esclusivo, a word
Blocchi SHIFT F2 (2) Richiami di blocchi, e cioé:
SPA FB, SPB FB e F1, SHIFT F1 FB assoluto, FB condizionato
BA FX, BAB FX F2, SHIFT F2 | FX assoluto, FX condizionato
SPA..., SPB... F4, SHIFT F4 OB, PB, SB assoluto,...condizionato
A DB, AX DX F6, SHIFT F6 | DB, DX
(Spostam.) L/T | SHIFTF3 (3) Operazioni di trasferimento e di caricamento
e F7 Trasferimento e caricamento dell’operando

Spost. (per FB/FX) | SHIFT F3 (4) Operazioni di SHIFT e rotazione
SLW, SLD e F1, SHIFT F1 SHIFT verso sinistra word/doppia word
SVW, SVD F2, SHIFT F2 SHIFT verso destra della word SHIFT verso destra word/
RLD, RRD F3, SHIFT F3 | doppia word con segno
SRW SHIFT F4 Rotazione verso sinistra, destra

SHIFT F5
Convers. SHIFT F4 (6) Operazioni di conversione
(per FB/FX) e
DEF, KEW F1, SHIFT F1 BCD->DUAL, gener. del compl. ad 1, a 16 bit
DUF, KzwW F2, SHIFT F2 DUAL->BCD, gener. del compl. a 2, a 16 bit
DED, KZD F3, SHIFT F3 BCD->DUAL, gener. del compl. a 2, a 32 bit
DUD F4 DUAL->BCD, a 32 bit
FDG, GFD F5, F6 Virg. fissa -> Virg. mob., Virg. mob. -> Virg. fissa, a 32 bit
Comparaz. SHIFT F5 (7) Operazioni di comparazione (tra due operandi):
I = >< e F1, F2 Comparazione su "uguale”, "diverso”
>= <= F3, F5 Comparazione su "maggiore o uguale”, "minore o uguale”
> < F4, F6 Comparazione su "maggiore”, "minore”
Oper. Bin. F5 (9) Operazioni di conteggio(contatori):
ZR, ZV e F1, F2 Il valore di conteggio incrementato , decrementato di 1
Oper. Bin. F5 (10) Operazioni di tempo (temporizzatori):
SI, SV e SHIFT F1/F2 Start di un tempo con impulso, i. prolungato
SE, SA SHIFT F3/F5 Start di un tempo come ritardo all’eccitazione/diseccita-
SS zione

SHIFT F4 Start di un tempo con ritardo all’eccitazione memorizzata
S F5 (5) Operazioni di memorizzazione, binarie:
R e SHIFT F6 Reset prioritario della memoria

SHIFT F7 Set prioritario della memoria
# F6 e F4 Connettore

STEP 5/ST V7.0
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Regole di
rappresentazione

8-10

Perlarappresentazione delle operazioninonelementariin FUP, riassunte nellatabella
8-3:

1.

Tutte le operazioni da (1) a (10) nella tabella 8-3 vengono rappresentate con
caselle in cui a sinistra si trova I'operando prima dell’elaborazione ed a destra
il risultato. Nelle caselle stesse STEP 5 introduce I'operazione selezionata col
tasto funzionale.

Piu funzioni complesse possono essere combinate in un segmento. Per que-
sto si deve prestare attenzione all’'omogeneita del tipo di dati.

Una combinazione di elementi funzionali complessi con elementi funzionali
binari &€ possibile solo con I'elemento funzionale complesso Confronto. Dira-
mazioni in paralello non sono ammesse.

Alcuni elementi funzionali sono "allungabili”, cid vuol dire che il numero degli
ingressi puo essere aumentato, fino a quando I'operazione lo permette.

La funzione "shift/rotazione” (4) richiede nella casella I'introduzione del para-
metro di shift "n”, cioé il numero di posizioni di bit, di cui il contenuto dell’'ope-
rando deve essere shiftato verso destra o verso sinistra. Lo spostamento mas-
simo possibile dipende dal formato dell’operando, 16 o 32 posizioni.

Le funzioni Aritmetica e Confronto permettono di introdurre, nella casella un
altro tipo di operando. Preimpostato & sempre il tipo numero in virgola fissa =
F

Avvertenza

Il tipo puo essere modificato solo una volta direttamente in seguito al richiamo
della casella.

STEP 5/ST V7.0
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8.3.1 Operazioni aritmetiche

Sommario

Esempio

STEP 5/ST V7.0
C79000-G8572-C920-02

Le operazioni ADD, SUB, MULT, DIV combinano di volta a volta due operandi negli
accumulatori 1 e 2 e generano unrisultato nell’'accumulatore 1. Le operazioni aritmeti-
che si possono mettere in cascata con altre funzioni complesse:

All'ingresso piu alto:

* Operazioni aritmetiche

* Operazioni di shift

* Operazioni di conversione

* Operazioni combinatorie, digitali

All'uscita:

* Operazioni aritmetiche

* Operazioni di spostamento

* Operazioni di conversione

* Operazioni di confronto

* Operazioni combinatorie, binarie

La funzione aritmetica corrisponde alle istruzioni (AWL):
* caricamento operando 1

* caricamento operando 2

* esecuzione dell'operazione scelta;

¢ trasferimento del risultato nell'operando (ACCU 1)
Tipi di operandi : KF, DW, EW...

Editazione di una operazione di somma di due numeri a virgola fissa:
1. Premere *** 0 F6 = Fine segm. e quindi attivare SHIFT F1 = Aritmet,
2. Scegliere 'operazione desiderata, qui F1 = ADD.

Lo STEP 5 emette la casella con gli ingressi/uscite non definiti ed il formato dell’'ope-
rando preimpostato F.

Yedaddadds _ |+ F KF +12345 _+ F

27772777772 2777777272 DW 12

_ | DW 14

Figura 8-8  Editazione di un’'operazione di addizione

3. Confermare il formato operando con il tasto di introduzione

4. Introdurre il primo operando, qui KF + 12345, e premere il tasto di introdu-
Zione.

5. Introdurre il secondo operando, qui DW 12 e premere il tasto di introduzione

6. Denominare I'operando (DW 14), in cui deve essere trasferito il risultato, e
concludere con il tasto di introduzione

Il segmento ha ora la forma rappresentata a destra.
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Inserimento di un
ingresso

Aggiunta di un
ingresso

Inserimento di fun-
zione complessa
all'ingresso

Inserimento di una
funzione com-
plessa all’'uscita

8-12

Posizionare il cursore allungato tra i due ingressi, premere F3 = Ingresso e scrivere
l'ingresso.

Cursore all. +F3 (Ingr.)
DW 10 — x F| / DW'10 — x F
A 227272727 —|
DW 12 — — DW 14
Dw 12 — — Dw 14

Figura 8-9 Inserimento ingresso

Posizionare il cursore allungato sotto il bordo inferiore dell’elemento funzionale, pre-
mere F3 = Ingresso e scrivere l'ingresso.

DW 10 —Ax F Dw 10 — X F
DW 12 —
DW 12 — — DW 14
7 / 000?777 — — DW 14
~
curs. all. =~ +F3  (Ingr)

Figura 8-10 Aggiunta ingresso

Posizionare il cursore allungato sul primo operando d’ingresso, scegliere la funzione
complessa, qui SHIFT F1 = Aritmet. ed F1 = ADD e scrivere il campo.

Cursore all. + Shift  F1 (Aritmet.)
P +F1 (ADD)
ALY/ — x F DW10 —{+F
DW 12 — — DW 14 2?7?°7?7°7?7°7? — x F

DW 12 — — DW 14

Figura 8-11 Inserimento funzione complessa all'ingresso

Posizionare il cursore allungato sull’'operando d’uscita, scegliere la funzione com-
plessa, qui SHIFT F1 = Aritmet. ed F1 = ADD e scrivere il campo.

pwio —{XxF DW 10— x F
DW12  — A A K DW 12— +F
Pl
Cursore all. +Shifz‘/ F1  (Aritmet) 992992999972 _| | DW 14
+F1 (ADD)
Figura 8-12 Inserimento funzione complessa all’'uscita

STEP 5/ST V7.0
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8.3.2

Sommario

Esempio 1

Esempio 2

Esempio 3

STEP 5/ST V7.0
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Richiami di blocchi

Con l'ausilio dei richiami di blocchi nello STEP 5, che rendono possibile, da un qualsiasi
blocco, il richiamo di ulteriori blocchi nel programma utente, &€ semplice realizzare un
programma strutturato. Un richiamo di blocco viene rappresentato in FUP con una
casella. Per ogni segmento € possibile richiamare un solo blocco. In un segmento
vuoto introdurre un richiamo direttamente tramite softkey.

Richiamo condizionato di un blocco di programma

1. In un segmento vuoto premere SHIFT F2 = Blocchie SHIFT F4 = SPB ....

2. Introdurre gli operandi d’'ingresso, qui E 10.1 ed E 10.2. Introdurre il blocco di
destinazione a destra e concludere con il tasto di introduzione

P?????7?7?2— &

E102 — PB 24

Figura 8-13 Richiamo condizionato di un blocco di programma

Richiamo assoluto di un blocco di programma
1. In un segmento vuoto premere SHIFT F2 = Blocchie SHIFT F4 = SPA ....

2. Introdurre il blocco di destinazione a destra, qui PB 24, e concludere con il
tasto di introduzione

Figura 8-14 Richiamo assoluto di un blocco di programma

Richiamo assoluto di un FB  in un segmento vuoto

1. Premere SHIFT F2 = Blocchie F1 = SPA FB.

L'editor emette il "bordo superiore” del blocco col cursore nel campo della sigla.
2. Introdurre il nome del blocco richiamato, qui FB 10.

Il blocco funzionale viene visualizzato nella forma rappresentata a sinistra con i suoi
operandi formali.

3. Introdurre la designazione del blocco in modo assoluto o simbolico. Premendo
il tasto di introduzione si salta nei campi successivi.

FB 10 FB 10
TEST TEST
?2???7°7?°7? —|ING1 USC [— ?22?2?227?2?? E1.0 —|ING1 USC —A1l0
?2???797?77? —|ING2 E 1.2 —|ING2
?2?0?°7°7? —ING2 T32 —|ING2
?77?2?777?? —{ NUM Z8 —|NUM

Figura 8-15 Richiamo assoluto di un FB

Il segmento assume la forma rappresentata a destra.
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8.3.3

Sommario

8.3.4

Sommario

Esempio

8-14

Operazioni di caricamento e trasferimento

La funzione viene rappresentata con una casella, in cui a sinistra si trova I'operando
ed a destra il risultato.
La funzione SHIFT F3 = Sposta e F7 = L/T corrisponde alle istruzioni (AWL):

e caricamento dell'operando (DW, DD, EW...),
¢ trasferimento dell'operando (DW, DD, EW...).

Dopolacreazione dellacasella (vedere sopra) sidevono introdurre soltanto i due ope-
randi preimpostati tramite [????7].

Operazioni di shift e rotazione

Le operazioni dishifte dirotazione appartengono alle operazioni complementari (solo
FB/FX). Un'operazione di shift/rotazione viene rappresentata in un segmento vuoto
conunacasella,incuiasinistrasitroval’operandonellACCU 1 primadellaoperazione
di shift ed a destra il risultato.

Dopo aver premuto il tasto SHIFT F3 = Sposta, ed attivato la funzione desiderata nel
secondo livello di tasti, lo STEP 5 crea la casella "non definita” in cui € registrata la
funzione scelta.

Il cursore dei caratteri lampeggia sotto il parametro n. Introdurre qui il numero di posi-
zioni di bit di cui deve essere shiftato il contenuto dell'operando.

Alla funzione corrispondono le istruzioni (AWL):
¢ caricamento dell'operando
¢ shift/rotazione dell'operando di "n” posizioni di bit

¢ trasferimento del risultato dell'operando (ACCU 1).

Shiftare 'operando d’ingresso EW 12 di 7 posizioni a destra e trasferirlo nella DW 12.
1. Premere ***oppure F6 = Fine segm. e quindi attivare SHIFT F3 = Sposta
2. Scegliere I'operazione desiderata, qui F1 = SRW.

Lo STEP 5 emette la casella ( a sinistra).

???27?????? —SRWO ?0?°°°°77? EW12 —SRW7 DW 12

Figura 8-16 Operazione di shift dell'operando d’ingresso

3. Posizionare il cursore sul parametro n nella casella, qui 0, ed introdurre la
cifra 7.

4. Introdurre la sigla dell’operando di ingresso/uscita.

Avvertenza

Una successiva modifica del parametro n non e possibile.

STEP 5/ST V7.0
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8.3.5

Sommario

Esempio
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Operazioni di memorizzazione

Con la funzione di memaorizzazione il RLC viene memorizzato in modo statico all’e-
sterno del processore. Il comportamento della funzione di memorizzazione viene fis-
sato col richiamo, scegliendo, dopo aver premuto F5= Oper. bin., nel secondo livello
di tasti, F6 = Set prioritario ed F7 = Reset prioritario. Lo STEP 5 introduce di volta in
volta in lato nella casella 'operando con effetto prioritario.

La funzione di memorizzazione viene rappresentata come una casella con due in-
gressi ed una uscita, S e I'ingresso di set, R € I'ingresso di reset e Q & l'uscita. In un
segmento puod essere inserita, di volta in volta, solo una funzione di memorizzazione.

Alla funzione di memorizzazione corrispondono le seguenti istruzioni (AWL):

e U(N) 1. operando d’ingresso
e S(R) Merker
e U 2. operando d’'ingresso
e R(S) Merker
e U(N) Merker
e = Uscita

Tipi di operando: M m.n, Am.n, D m.n ...

La funzione di memorizzazione reagisce in modo seguente alle variazioni dei segnali
d’'ingresso, a seconda della scelta della funzione:

Stato all'ingresso Stato all’'uscita Q
S R
0 0 Il vecchio stato rimane memorizzato
0 1 0
1 0 1
1 1 0 per elemento S/R, 1 per elemento R/S

Dopoaverpremuto F5= Oper. bin. e, nelsecondo livello ditasti, lafunzione desiderata,
lo STEP 5 crea, nella posizione del cursore allungato in un segmento in FUP, una
casella "non definita”.

Editazione di una funzione di memorizzazione con set prioritario.

1. ***0 F6 = Fine segm., e quindi premere F5 = Oper. bin.ed F7 = S.

0?7°??7?
2?99?7777 S
2797979777 - R Q——m 7?7?7?7°7°7?7?
M 1.0
E21 S
E22 —-R Qf—m A14.0

Figura 8-17 Editazione di un’'operazione di memorizzazione

8-15



Editazione di schemi logici

8.3.6

Sommario

8.3.7

Sommario

8-16

2. Introdurre la sigla dell'operando della cella di memoria, qui M 1.0 e premere il
tasto di introduzione

3. Introdurre gli operandi d’'ingresso, qui rispettivamente E 2.1 ed E 2.2. Abban-

donare il campo di introduzione corrispondente con il tasto di introduzione

4. Introdurre l'uscita (Q) per l'interrogazione dello stato del segnale binario, qui

A 14.0 e premere il tasto di introduzione e poi Conferma .

Operazioni di conversione

Le operazioni di conversione (DUAL ~ BCD, complemento ad 1 ed a 2) appar-
tengono alle operazioni complementari (solo FB, FX). Un’operazione di conver-
sione viene rappresentata con una casella, in cui si trova I'operando nellACCU 1
prima della conversione ed a destra il risultato. Esse si possono mettere in cas-
cata all'ingresso ed all'uscita con altre funzioni complesse.

Dopo aver premuto il tasto funzionale SHIFT F4 = Convers. e la funzione desiderata
nel secondo livello di tasti, lo STEP 5 crea la casella in cui € registrata I'operazione
scelta. Alla funzione corrispondono le istruzioni:

e caricamento dell'operando

e conversione dell’'operando

¢ trasferimento del risultato nell'operando (ACCU 1)
Tipi di operando:  DW, DD, IW...

Dopolacreazione dellacasella (vedere sopra) sidevonointrodurre soloidue operandi
preimpostati con [?????].

Operazioni di comparazione

Le operazionidicomparazione combinano due operandidigitalinegliACCU 1e ACCU
2 in un risultato binario nel’lACCU 1.

Esse si possono mettere in cascata all'ingresso ed all'uscita con altre funzioni com-
plesse. Alla funzione corrispondono le istruzioni (AWL):

e caricamento dell'operando 1
e caricamento dell'operando 2
* esecuzione dell'operazione di comparazione scelta;
¢ risultato logico combinatorio.

Un’operazione di comparazione viene rappresentata in un segmento vuoto con una
casella, in cui a sinistra si trovano gli operandi nellACCU 1 e 2 ed a destra il risultato
logico.

Dopo aver premuto SHIFT F5 = Confrontoe lafunzione desiderata nel secondo livello
ditasti,lo STEP5crealacasella”’nondefinita”, in cuié introdottalafunzione desiderata.

STEP 5/ST V7.0
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Esempio
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Nella casella si trova a sinistra I'operazione di comparazione scelta
(' =, ><, >=, >, <=, <) ed a destra il formato degli operandi:

F = numero in virgola fissa (16 bit)
D = doppia word (32 bit)
G = numero in virgola mobile (32 bit)

Avvertenza

Il tipo puo essere modificato solo una volta direttamente in seguito al richiamo
della casella.

Modifica del tipo:

1. Posizionare il cursore allungato sul tipo

2. Posizionare con Shift + cursore a destra il cursore piccolo sulla sigla del tipo
3. Modificare il tipo

Editazione di un'operazione di comparazione tra due numeri in virgola fissa.
1. ***0 F6 = Fine segm., e quindi attivare SHIFT F5 = Confronto.
2. Scegliere I'operazione desiderata, qui F2 = >< Comparazione su "diverso”.

Lo STEP 5 emette la casella con ingressi/uscite "non definiti” ed il formato dell’'ope-
rando preimpostato F

272727277 | >< F

2722727277 Q = 229222272
KF+100 | >< F

DW 34 - Q = M 12.1

Figura 8-18 Editazione di funzioni di comparazione

3. Confermare il formato dell’operando premendo il tasto di introduzione
4. Introdurre il primo operando, qui KF + 100, e premere il tasto di introduzione

5. Introdurre il secondo operando, qui DW 34, e premere il tasto di
introduzione .

6. Spostare il cursore verso destra e denominare I'operando a cui deve essere
attribuito il risultato, qui M 12.1 e concludere con il tasto di introduzione

Il segmento ha ora la forma rappresentata sotto.
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8.3.8

Sommario

Esempio

8.3.9

Sommario

8-18

Operazioni combinatorie digitali

Operazioni combinatorie digitali appartengono alle operazioni complementari (solo
FB, FX). Esse sipossono mettere in cascataall'ingresso ed all’'uscita con altre funzioni
complesse.

Gli operatori AND, OR, XOR combinano, di volta in volta, due operandi digitali negli
ACCU1eACCU 2inunrisultato nel’ACCU 1. Lefunzionicorrispondono alle istruzioni:

e caricamento dell'operando 1 (DW, EW, MW...),
e caricamento dell'operando 2 (DW, EW, MW...),
* combinazione degli operandi a word (UW, OW, XOW),

¢ trasferimento del risultato nell’'operando (DW, EW, MW...).

Combinazione AND a word di due operandi.
1. ***0 F6 = Fine segm. e quindi attivare SHIFT F1 = Aritmet.
2. Scegliere la funzione desiderata, qui F5 = AND.

Lo STEP 5 emette la casellacon gliingressi/uscite "non definiti” ed il formato preimpo-
stato UW.

?0°7°777? uw EW124 _ JUW

22777277772 22777277772 MW 10 | | _DW 16

Figura 8-19 Combinazione AND

3. Introdurre il primo operando, qui EW 124, e premere il tasto di introduzione
4. Introdurre il secondo operando, qui MW 10 e premere il tasto di introduzione

5. Denominare I'operando in cui bisogna trasferire il risultato, qui DW 16 e
premere il tasto di introduzione

Il segmento ha ora la forma rappresentata sulla destra.

Operazioni di conteggio

Un’operazione di conteggio viene rappresentata come una casella. L'operando del
contatore si trova sopra la casella. A seconda della scelta nel secondo livello di tasti,
F1 = contatore Indietro, F2 = contatore Avanti’, il primo degli ingressi del contatore
e per il conteggio indietro ZR o per il conteggio in avanti ZV ed il secondo ingresso
e di volta in volta complementare. Questo € condizionato dall’esigenza che il primo
ingresso di un contatore deve essere, nella rappresentazione, sempre connesso.

STEP 5/ST V7.0
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Dopo aver premuto F5= Oper. bin. e lafunzione desiderata nel secondo livello di tasti,
lo STEP 5 crea una casella "non definita” con i seguenti ingressi/uscite:

ZR Decrementa di 1 il valore del contatore quando il RLC, a questo ingresso,
cambia da 0 ad 1 (fronte di salita).

ZV Incrementa di 1 il valore del contatore quando il RLC, a questo ingresso,
cambia da O ad 1.

S Il valore di conteggio acquisice il valore all'ingresso ZW quando a questo
ingresso di "set” & presente un fronte positivo (0 - 1).

Z  Valore da impostare nel contatore, codificato in decimale (BCD) O ... 999,
W tipi operandi: KZ, EW, MW, AW, DW.
R Il contatore viene resettato a 0, quando a questo ingresso € presente una

stato. L'uscita Q viene impostata a O.
DU Contenuto attuale del contatore, codifica duale.
DE Contenuto attuale del contatore, codifica BCD.

Q L'uscita visualizza, con uno stato di segnale binario, se il contenuto del
contatore € zero = 0 opp. > zero: = 1.

Operando contatore: CO0...C 255
Campo di conteggio: 0 ... 999

Esempio Editazione di una funzione di conteggio in avanti.
1. ***0 F6 = Fine segm. e quindi premere F5 = Oper. bin.e F2 = ZV.

Lo STEP 5 emette una casella con ingressi/uscite non definiti.

?2?2?2?7?77
2?7?7777 —|ZV
2?7?7777 —|ZR
?2????7???  —|S
2?77?7777  —|ZW DU 122222722272
DE [~ 2222727777
?2???2?7??? —R Q | = ?2???7?7???
Z10
E 32.0 AV
—ZR
M 2.0 —S
KZ 255 —ZW DU [~ DW 64
DE DW 66
E32.1 —R Q = M12.1

Figura 8-20 Editazione di una funzione di conteggio
2. Introdurre 'operando (Z10) e premere il tasto di introduzione
3. Introdurre 'operando per ZV, qui E 32.0, premere il tasto di introduzione

4. Tramite DEL saltare I'operando per ZR.
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8.3.10

Sommario

8-20

5. Introdurre I'operazione per impostare il contatore, qui M 2.0 e premere il tasto
di introduzione .

6. Introdurre il valore di conteggio, qui KZ 255, e premere il tasto di
introduzione.

7. Ingresso di reset, qui introdurre operando E 32.1, e premere il tasto di
introduzione .

8. Introdurre il trasferimento del valore di conteggio negli operandi DW 64 e DW
66 e premere il tasto di introduzione

9. All'uscita Q: F4 = —()—, introdurre M 12.1 e premere il tasto di introduzione

Operazioni di temporizzazione

Con le operazioni di tempo vengono eseguite e controllate tramite programma le sequenze
temporali. Landamento della funzione temporale viene fissato col richiamo, scegliendo,
dopo aver premuto F5, la funzione desiderata nel secondo livello di tasti con SHIFT F1
... SHIFT F5. STEP 5 introduce questo andamento, in modo simbolico allingresso di start
nella casella. L'operando del temporizzatore si trova sopra la casella.

Una funzione temporale viene awvviata se il RLC allingresso di start cambia. Con un ritardo
alla diseccitazione (SA) il RLC deve cambiare da 1 a 0, in tutti gli altri casi da 0 ad 1.
| parametri allingresso di start hanno il seguente significato:

Tasto Significato

Simbolo
1—--—
1--V
TI-10
T!-1S
0!-1T

SHIFT F1 =S| | Start come impulso

SHIFT F2 = SV | Start come impulso prolungato
SHIFT F3 = SE | Start come ritardo all’eccitazione
SHIFT F4 = SS | Start come ritardo all’eccitaz. mem.

SHIFT F5 = SA | Start come ritardo alla diseccitazione

Dopo aver premuto F5= Oper. bin. e lafunzione desiderata nel secondo livello di tasti,
lo STEP 5 crea una casella "non definita” con i seguenti ingressi /uscite:

Simbolo

™

DU
DE

Operando per I'avviamento della funzione di tempo (il simbolo corri-
spondente alla funzione di tempo si desume dalla soprastante ta-
bella)

Ingresso per l'introduzione della durata del tempo

Tipo di operando: KT, EW, DW ...

La durata del tempo & composta da un valore di tempo e da una
base tempi. Il valore di tempo rappresenta il numero di periodi di
tempo, in cui la funzione dura. La base tempi indica con quale ca-
denza temporale il valore di tempo viene modificato.

p.es. KT =n.i;

n = valore di tempo: 0 ... 999;

i = base tempi: 0 =0.01s,1=0.1s,2 =1s, 3 =10s.

Ingresso di reset della funzione di tempo: quando I'operando as-
sume il valore 1, il tempo e Q = 0.

Valore di tempo attuale, codifica duale.
Valore di tempo attuale, codifica BCD.

L'uscita indica con uno stato di segnale binario se il tempo scorre
(Q = 1) o non scorre, cioe trascorso, (Q = 0).
Numero del temporizzatore: T O ... T 255

STEP 5/ST V7.0
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Esempio
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Editiazione di una funzione tempo con ritardo alla diseccitazione.

1.

Premere ***0 F6 = Fine segm. e quindi F5 = Oper. bin. e SHIFT F5 = SA.

2?7?2?77?7?

272772227272 {01 _ IT

2?7???7??7?7?

2
N
N
N
N
N
N
N
N]

|
py)

o)

I

E 20.0 - o T

KT 100.1 — TWDU] DW20
DE— DW 22

E20.3 —R Q— = M22.1

Figura 8-21 Editiazione di una funzione tempo con ritardo alla diseccitazione

2.

Introdurre il numero del temporizzatore, qui T 20 e premere il tasto di
introduzione .

Introdurre I'operando per attivare la cella del temporizzatore, qui introdurre
E 20.0 e premere il tasto di introduzione

Introdurre la durata di tempo KT 100.1 (10s) e premere il tasto di
introduzione .

Ingresso di reset, qui introdurre E 20.3, e premere il tasto di introduzione

Introdurre il trasferimento del valore del temporizzatore negli operandi DW 20
e DW 22, concludere ogni volta con il tasto di introduzione

All'uscita introdurre M 22.1 e premere il tasto di introduzione

8-21
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Sommario I blocchi dati contengono dati fissi o variabili con i quali opera il programma utente.

Il titolo del blocco ed i commenti alle righe vengono memorizzati nel relativo blocco
commento DK/DKX. Un commento del blocco viene memorizzato dallo STEP 5 nel
blocco di documentazione DBDO.nnn/DXDO.nnn.

Entrambi i tipi di blocco di commento sono creati automaticamente con la conferma
del DB/DX editato. Essinonvengonotrasferitiin AG o su EPROM/EEPROM. Sebbene
I'editazione sia possibile anche direttamente in questi blocchi di commento, si consi-
glia di effettuare I'introduzione dei titoli e dei testi di commento nel DB/DX, poiché qui
sono riconoscibili tutte le associazioni.

\_ Test AG Gestione Docu(

Blocco STEP 5 ... F1
‘Bloccodati... ~  F2
Maschera DB ... Ctrl+F1

Lista di attribuzione F7
Vie bus F8

Parametri stampante  Ctrl+F4
Editor piedinatura  Ctrl+F5

Dopol'introduzione durante I'editazione di un blocco dati, le singole funzioni dell’editor
sono descritte in ordine alfabetico.

Sommario del Capitolo Argomento trattato Pagina
capitolo 9.1 Struttura di blocchi dati 9-2
9.2 Editazione blocchi dati 9-4
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9.1  Struttura di blocchi dati

Sommario Un blocco dati creato con I'editor viene memorizzato nel file programma preimpostato
(- Progetto) ed ¢ costituito dalle seguenti parti:

1. Intestazione del blocco

2. Testata del blocco

3. Corpo del blocco ed eventuali
4. Commenti

Di questi solo la testata del blocco (2) ed il corpo del blocco (3) sono trasferiti nella
memoria AG, durante il caricamento del programma STEP 5.

Identificazione blocco
Tipo di blocco | N. di blocco
Identificaz. PG | N u m. Testata del blocco
di biblioteca 5 parole dati
Lung. blocco con test. (num. parole)
DW 0 4 1 5 5
DW 1 5 4 2 0
DW 2 3 1 3 2
Dw 3 3 8 3 2
DW 4 4 C 6 5
DW 5 7 4 7 A
DW 6 0110 0111 1000 0111
Corpo del blocco
max. 2043 parole dati
DW 2042

Figura9-1  Struttura di un blocco dati

Intestazione del L'intestazione del blocco contiene i formati dei dati delle parole dati indicate nel corpo
blocco delblocco. Lalunghezza dell’'intestazione dipende dal numero e dal cambio di formati
nel DB. Per un DBn lo STEp 5 crea un DVn, per un DXn un DVXn. Cancellando un
DB o DX viene cancellata automaticamente la corrispondente intestazione del blocco.

Intestaz.
Testata Testata
Corpo Corpo

File programma Memoria AG

Figura9-2  Intestazione del blocco

STEP 5/ST V7.0
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Testata del blocco

Corpo del blocco

STEP 5/ST V7.0
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Seduranteiltrasferimento diun blocco datidallamemoria AG o daun modulo EPROM/
EEPROM nel file programma preimpostato, I'intestazione del blocco non esiste, sul
video appare la segnalazione:

Intestazione blocco non esistente

ed unariga con i formati da scegliere. Si puo cosi impostare il formato dei dati deside-
rato.

La testata del blocco ha sempre una lunghezza di 5 parole dati, in cui il dispositivo
di programmazione memorizza:

¢ [identificazione di inizio blocco

¢ il tipo di blocco (DB, DX)

* il numero del blocco (numero tra 0 e 255)

¢ [identificazione del dispositivo di programmazione
* il numero di biblioteca (numero tra 0 e 99999)

¢ |alunghezza del blocco (incl. lungh. testata del blocco)

Il corpo del blocco contiene, in ordine crescente, le parole dati, iniziando con la parola
dati 0. Ogni parola dati occupa una word (16 bit) nella memoria. Con queste parole
dati puo operare il programma utente.

Un DB editato comprende fino a 2043 parole dati. Al contrario, un blocco dati creato
nel programma utente, puo contenere al massimo 4091 parole dati. La possibile lun-
ghezza di un blocco dati dipende anche dalla capacita della memoria dell’AG.
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9.2 Editazione blocchi dati

Richiamo
dell’Editor

\ Editor

Blocco dati...

Suddivisione del
video

Introduzione

Memorizzazione
blocco

Interruzione
funzione

9-4

Selezionare il comando di menu Editor »Blocco dati... |lbox di dialogo Edita blocchi
dati appare sullo schermo.

Se si vuole editare o elaborare un blocco dati, bisogna introdurlo in modo assoluto
(p.es. DB 15) o col suo nome simbolico.

Se si vuole ricercare in uno o piu blocchi dati una determinata parola dati, introdurre
nella lista blocchi il blocco o i blocchi (max.6) in assoluto o un blocco simbolico, in
cui si deve eseguire la ricerca. Il numero della parola dati cercata, p.es. 123, deve
essere indicata nella scelta.

Una lista delle possibiliintroduzioni € data dallo STEP 5, premendo SHIFT F8 =Help.

Dopo la conferma di questo ordine con Edita viene richiamato I'Editor dei blocchi dati.

Lafigura9-3 mostrail campo dieditazione dell’Editor DB conitastifunzionalidel menu
principale e un blocco dati emesso.

Tramite il tasto SHIFT F8 = Help si ottengono chiarimenti relativi ai singoli tasti funzio-
nali.

Nelle righe e colonne in cui & suddiviso il campo di editazione si possono introdurre
con i tasti funzionali o con il mouse i dati desiderati.

Premere F7 = Conferma oppure il tasto di conferma

Premere ESC.

Se si interrompe la sequenza prevista mediante un’altra operazione, il PG segnala:
Chiudere dapprima il fattore di ripetizione! L'operazione a questo
punto non puo essere eseguita, poiché I'editor si trova in modo Ripetizione; questa
situazione deve prima essere conclusa.
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Campo di La figura 9-3 mostra il campo di editazione dell’editor DB con soft key del menu princi-
Editazione pale e I'emissione di un blocco dati.
(€] @ () (©) (]
BIB=
DB2 C:DATI@@ST.S5D (13)LUN= 37 122
®@ @@ 10 Titolo blocchi dati v
vy Iy v (1) 12 Commento parola dati
1: KH = FFFF; v v Numero esadecimale, limite superiore
2: KF = -32768; Numero a virg. fissa, limit inf.
3: KF = +32767; Numero a virg. fissa, limite sup.
4: KG = -1469368 - 38; K Numero a virg. mobile, limite inf.
6: KG = +1701412+39; Numero a virg. mobile, limite sup.
8: KT = 001.0; Valore e base tempi, 0.1s
9: KT = 999.3; Valore e base tempi, 9990 s
10: KZ = 000; Valore di conteggio, limite inf.
11: KZ = 999; Valore di conteggio, limite sup.
12: KY = 000,001; Byte o indirizzo di un DB
13: KY = 255,255; Byte o indirizzo diun DB
14: KM = 00000000 00000000; Codice a bit, valore limite inf.
15: KM = 11111111 11111111; Codice a bit, valore limite sup.
16: KS = 'Riga ditesto con 24 caratteri”; Caratteri ASCII delimitati da *’
28: S = 'FINE’; Caratteri ASCII delimitati da '’
30:
F F' N.bibl. F F RigaAv. F RigalInd. F Titolo F Commento F Help
linser. DK 2Canc.DK 3 Inser. DF 4Canc.DF 5 Test. KG 6 7 Conferma 8 Annulla
Figura9-3  Campo di Editazione dell’editor DB (esempio)
Campi video I singoli campi del video hanno il seguente significato:

d’introduzione

Tabella9-1  Contenuto delle righe del video
N. Campo di Chiarimento
introduzione
(1) |Campo DB Visualizza il numero del DB (qui: DB2), indicato compilando il box di co-
mando.
2) File Programma Campo con l'indicazione del drive e del nome del file programma (qui: C:

con file programma DATIxxST.S5D).

DwW

(3) |Campo BIB In questo campo si puo indicare un numero di biblioteca del DB con un
massimo di 5 cifre (da 0 a 99999).

(4) |Campo LUN Emissione della lunghezza del blocco in word, compresa la testata. Dopo la
barra si trova la lunghezza della intestazione del DB. Dopo ogni introdu-
zione completa di una riga, la lunghezza viene aggiornata.

(5) |Campo titolo Qui si puo introdurre un titolo per il blocco dati della lunghezza massima di
32 caratteri.

(6) |Campo del numero Emissione del numero della parola dati (DW) da elaborare. Per i formati

che comprendono piu parole dati, viene emesso il numero della DW piu
bassa. Si puo saltare all’'ultima parola dati del blocco dati se si introduce il
numero dell'ultima parola dati o un numero pagine.

STEP 5/ST V7.0
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Tabella 9-1

Contenuto delle righe del video, continuazione

N.

Campo di
introduzione

Chiarimento

)

Campa

In questo punto, come nel campo formato, si possono inserire o cancellare
righe tramite i tasti funzionali. Non appena si abbandona, col cursore, la
riga interessata, vengono aggiornati tutti i numeri delle DW successive.

(8)

Fattore di
ripetizione

Con l'ausilio del fattore di ripetizione, si pud duplicare un blocco con un
massimo di 12 parole dati dello stesso formato. Il fattore di ripetizione in-
dica quante volte le parole dati marcate devono essere ripetute nel DB. ||
fattore di ripetizione piu alto & 255.

Per la duplicazione sono comprese tutte le parole dati, partendo dal fattore
di ripetizione fino alla posizione del cursore, incluso. Lo STEP 5 aggiorna
automaticamente i numeri delle DW successive. | commenti delle parole
dati non vengono duplicati, essi rimangono nella posizione originaria.
Prima dell’esecuzione, I'editor DB controlla se le parole dati da duplicare,
piu le parole dati gia esistenti, superano il numero massimo di 2043 parole
dati (senza la testata del DB). Se cosi €, lo STEP 5 emette la segnala-
zione: Memoria o buffer interno pieno . Pertanto la funzione non
viene eseguita.

9)

Campo del
formato

In questo campo si introduce il formato di parole dati desiderato. Se un for-
mato € gia introdotto, questo si pud sovrascrivere. Se un formato non &
rappresentabile, appare I'identificazione F nel campo di errore del formato.
Per la conversione di un formato che necessita di piu parole dati (KG), la
successiva parola dati viene anch’essa convertita. Se si possono rappre-
sentare insieme piu parole dati (C, KC), viene modificata solo una parola
dati.

(10)

Campo di
editazione

Introdurre qui i dati nel formato attuale. Se durante la modifica del formato
si incontrano dati non interpretabili nel campo di errore viene segnalato F

(11)

Campo di errore
formato

Per formati di dati che necessitano di pit DW (KC, C, KG), & possibile che
un commento, assegnato sia alla prima che ad altre DW, non venga
emesso sul video. Una "K” in questo campo contrassegna un commento
"soppresso .

12)

Campo del
commento

Per i formati dei dati che necessitano di pit parole dati, (KC, C, KG), un
commento che e associato a parole dati successive, non puo essere
emesso sul video. Una K in questo campo identifica il commento sop-
presso.

(13)

Campo del
commento

Introdurre qui, se si desidera, per ogni parola dati un testo della lunghezza
massima di 32 caratteri. Dopo il trentaduesimo carattere, il cursore salta
indietro all'inizio di questa riga di commento. La riga di commento si abban-
dona con il tasto di introduzione .Lo STEP 5 emette il commento "sop-
presso” solo dopo la modifica del formato dei dati.
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Tasti funzionali Tasti funzionali nel menu principale

F F  N.bib. F F RigaAV. F RigaInd. F Titolo F Commento F Help

1 Inser DK 2 CancDK 3 Inser-DF 4 CancDF 5 TestKG 6 7 Conferma 8 Annulla
Tasti Chiarimento

F1 = Inser. DK Inserimento del commento di una parola dati, cio vuol dire
spostare tutto il campo dei commenti di una riga verso il
basso.

F2 = Canc. DK | Cancellazione del commento di una parola dati, viene spo-
stato tutto il campo dei commenti di una riga verso l'alto.

F3 = Inser. DF Inserimento di un formato, cio vuol dire spostare tutto il
campo dei formati di una riga verso il basso.

F4 = Canc. DF | Cancellazione di un formato, viene quindi spostato tutto il
campo dei formati di una riga verso I'alto. Nell'ultima riga di
un DB con formato "KG”, questa funzione viene eseguita
solo se si esegue precedentemente una conversione KM.

F5 = Test-KG Test del numero in virgola mobile: il numero in virgola mobile
che si trova nel campo dati viene emesso in esadecimale
nella forma: "esponente (1 byte) e mantissa (3 byte)”. Si ab-
bandona con Conferma .

F7 = Conferma | Il blocco dati viene memaorizzato nel file programma preimpo-
stato.
F8 = Annulla Conclusione dell’'editazione senza memorizzazione.
SHIFT F2 Introduzione del numero di biblioteca.
= N. bibl.
SHIFT F4 Shift di una riga verso il basso.
= Riga Av.
SHIFT F5 Shift di una riga verso l'alto.
= Riga Ind.
SHIFT F6 Titolo del blocco.
= Titolo
SHIFT F7 Commento del blocco.
= Commento
SHIFT F8 Visualizazzione dei chiarimenti relativi ai tasti funzionali.
= Help
9.2.1 Editazione del commento del blocco
Sommario Icommentidelblocco sonotesticon cuisipossonocommentareiblocchidati. llnumero

di caratteri di tuttii commenti blocco € massimo 16 k. | commenti blocco vengono me-
morizzati in un file di documentazione (File-Dok):

¢ Il blocco e il file di documentazione sono memorizzati nel file programma preim-
postato. Possono essere memorizzati sotto S5-DOS al massimo 255 file di docu-
mentazione in un file programma.
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¢ jfile di documentazione non vengono trasferiti in AG o su modulo EPROM/EE-
PROM.

¢ il numero del blocco ed il numero del file di documentazione sono legati tra
loro, p. es. al DB 15 appartiene il #DBDO0.015.

* ai blocchi sono associati i file di documentazione e contrassegnati col carat-
tere # all'inizio del nome del file:

DBn - #DBDO.nnn
DXn - #DXDO.nnn

Avvertenza

Un cambio pagina si genera col carattere di comando della stampante $SEJECT.
Questa stringa di caratteri deve essere scritta in lettere maiuscole, altrimenti lo
STEP 5 non riconosce il comando.

Premessa Nelle Impostazioni @ stato scelto [X] Commenti: Si(— Progetto). E emesso sul video
il menu principale dell’editor DB. Il DB deve contenere come minimo una parola dati
(DW).

Procedimento Procedere come segue:

1. Attivare SHIFT F7 = Commento oppure premere due volte il tasto COM.

Lo STEP 5 apre il campo di editazione vuoto per il commento del blocco o con
un testo gia esistente. Con cio I'editor esegue un’associazione del testo al
blocco, creando automaticamente una stringa di 7 caratteri $1 @

Questa stringa di caratteri non deve essere cancellata o modificata, altrimenti
lo STEP 5 non pud piu associare il commento del blocco al rispettivo blocco
dati.

2. Editare il testo con la tastiera alfanumerica.
3. Concludere ogni riga con il tasto di introduzione

La fine della riga viene marcata con una freccia verticale. Quando si fanno
introduzioni di testo "a piu righe”, alla fine di ogni riga viene automaticamente
settato il ritorno a capo.

Inserimento Con F1 = Inserisci/Sovrascr. si cambia il modo di scrittura. Viene visualizzato sempre
caratteri il modo selezionabile.

1. Posizionare il cursore nel punto del testo, in cui si deve eseguire I'inserimento.
2. Premere F1 = Inserisci ed inserire il testo.

3. Concludere l'inserimento: F8 = Indietro o premere Conferma .

F F F F

1 Inserisci 2 Cancella 5 Ins.riga 6 Canc.riga
F

1 Sovrascr.

STEP 5/ST V7.0
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Cancellazione
caratteri

Conclusione /
Memorizzazione
commento blocco

Posizionare il cursore sul primo carattere da cancellare.

1. Premere il tasto F2 = Cancella

2. Posizionare il cursore dopo l'ultimo carattere da cancellare.
3. Attivare F2 = Cancella

Premere F8=Indietroo Conferma.Lo STEP 5emette sulvideoil blocco dati da editare.
Il testo introdotto fino a questo punto viene mantenuto. Memorizzando il blocco dati,
lo STEP 5 memorizza alla fine anche il commento del blocco.

Premere Conferma .

9.2.2 Introduzione del titolo del blocco

Sommario

Premessa

Introduzione del
titolo del DB

Coniltitolodel blocco sipuodidentificare il blocco stesso. Untitolo del blocco puo essere
lungo al massimo 32 caratteri. Si possono utilizzare lettere minuscole e maiuscole,
senza accenti.

Il titolo viene memorizzato nel blocco di commento per il relativo DB, ed il suo nome
viene associato automaticamente dallo STEP 5: DKn a DBn. Il numero del blocco
di commento corrisponde p. es. al DB 123 corrisponde DK 123.

Nella maschera Imposta & stato scelto Commenti : Si (- Progetto). E emesso sul
video il menu principale dell’editor DB. Nel DB deve essere introdotta come minimo
una parola dati (DW).

Premere SHIFT F6 = Titolo o premere il tasto COM. Il cursore salta automaticamente
nel campo del titolo del blocco. Dopo

1. introdurre il testo o correggere un testo gia esistente.
2. Premere il tasto di introduzione

Iltitolo viene temporaneamente mantenuto, maviene memorizzato nelfile programma
solo memorizzando il blocco nel relativo blocco di commento.

9.2.3 Influenza sulla lunghezza dell'intestazione del blocco

Sommario
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Lalunghezza dell'intestazione del blocco dipende dal numero e dai cambi di formato
deidati. Sele parole dati (DW) conlo stessoformatovengonointrodotte nel DB possibil-
mente una dopo l'altra e sievita di cambiare spesso il formato, I'intestazione del blocco
risulta piu corta.
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Esempio Punto di partenza:
Cambio del formato dei dati: DW0/1=KH, DW2/3=KF, DW4=KH e DW5=KF. L'intesta-
zione del blocco ha una lunghezza di 10 parole dati.
DB3 LUN=11/10
0: KH = FFFF;
1: KH = 1A2B;
2: KF = +12345;
3: KF = -00099;
4: KH = 80F1;
5: KF = +06787;
| formati dei dati vengono riuniti: dalla DW 0 a DW 2=KH, dalla DW 3 a DW 5= KF.
L'intestazione del blocco ha una lunghezza di 6 parole dati:
DB3 LUN=11/6
0: KH = FFFF;
1: KH = 1A2B;
2: KH = 80F1;
3: KF = -00099;
4: KF = +06787;
5: KF = +12345;
Per emettere i blocchi dati da AG deve esistere, nelfile programma, la corrispondente
intestazione del blocco, altrimenti lo STEP 5 emette la segnalazione:
Intestazione blocco non esistente
In questo caso si deve scegliere uno dei formati proposti (KM, KH, KY...).
9.24 Introduzione del n. di biblioteca
Sommario Il numero di biblioteca & un numero di 5 cifre (da 0 a 99999) e serve ad identificare
il blocco STEP 5.
Premessa E aperto il blocco, in cui deve essere inserito il numero di biblioteca. Il corpo del DB

Procedimento

9-10

deve contenere come minimo una parola dati.

Procedere come segue:
1. Premere SHIFT F2 = N. bibl.
Il cursore si trova ora nel campo BIB.
2. Introdurre il numero di biblioteca desiderato o modificare quello indicato.
3. Abbandono del campo BIB: F7 = Conferma o Conferma .

Se non si vuole introdurre nessun numero, abbandonare il campo con F8 = Annulla
o con ESC.
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9.25

Sommario

Esempio

9.2.6

Sommario
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Modifica del formato dei dati

| formati dei dati si possono modificare, posizionando il cursore sul corrispondente
campo del formato e sovrascrivendo.

Il formato nella DW 1 deve essere modificato in una rappresentazione a bit.
1: KH = FFFF;

1. Posizionare il cursore sul campo del formato.

2. Introdurre i caratteri KM.

Risultato:

1: KM =11111111 11111111,

Introduzione di parole dati

Se nel file programma non esiste ancora nessun DB col numero del DB introdotto,
lo STEP 5 segnala:

Elemento dati non esistente
Lo STEP 5 attende 'introduzione delle parole dati (DW). Se il DB esiste, viene visualiz-
zato a partire dalla DW 0.

Inun blocco dati (corpo) si possono introdurre al massimo 2043 parole dati (DW). Per
i formati che comprendono piu parole dati, lo STEP 5 emette la parola dati pit bassa.

Formato Valore limite Sigla formato
inferiore superiore
KH 0000 FFFF Numero esadecimale
KF -32768 +32767 Num. in virgola fissa
KG -1469368-38 +1701412+39 Num. in virg. mobile
KT 000.0 999.3 Val. tmp. + base tmp.
Kz 000 999 Valore di conteggio
KY/A 000.000 255.255 Byte/ indir. di un DB
KM 00000000.000000 | 11111111.11111111 | Rappresentaz. a bit
00
KC/C Caratteri ASCII, max. 24 caratteri/riga | Formato testo

La seguente tabella mostra il numero di parole dati (DW) che vengono occupate dai
cosiddetti formati.

Formato DW occupate
KH, KF, KT, KC, KY, KM 1
KG 2
KC, C dalal2
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Procedimento

Esempio 1

Esempio 2

9-12

BPer l'introduzione di parole dati procedere come segue:

1.

Introdurre il formato dati desiderato nel relativo campo.
Lo STEP 5 aggiunge automaticamente il segno di "uguale”.

Dopo il carattere di "uguale” introdurre i dati secondo il formato indicato.

Lo STEP 5 aggiunge automaticamente un "punto e virgola” ed emette la suc-
cessiva riga di editazione, in cui € ripetuto il formato dati scelto.

L'introduzione di formato dati diversi viene spiegato nei seguenti esempi.

Numeri esadecimali:

In DW O si deve introdurre KH = 0000 e in DW 1 KH = FFFF.

1.

Introdurre i caratteri KH.
Lo STEP 5 aggiunge automaticamente il segno di "uguale”.

Introdurre i caratteri esadecimali 0000.
Lo STEP 5 conclude la riga ed emette la successiva con il formato KH.

Introdurre i caratteri esadecimali FFFF.
Il cursore si trova ora sulla DW 2.

Numeri in virgola mobile:

Nella DW 2 si deve introdurre il numero in virgola mobile -0,1469368*10-38 e nella
DW 4 il numero +0,1701412*1039. Per alcuni numeri negativi in virgola mobile pos-
sono subentrare errori nell’arrotondamento.

Il cursore si trova sulla DW 2.

0 KH = 0000;

1 KH = FFFF;

2: KH =

1. Posizionare il cursore sul campo del formato.

2. Introdurre i caratteri KG.

3. Introdurre i valori -1469368 -38 e +1701412 +39
Risultato:

1 KH = FFFF;

2: KG = -1469368-38;

4: KG = +1701412+39;

STEP 5/ST V7.0
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Esempio 3 Caratteri ASCII:

Dalla DW 6 si devono introdurre i caratteri Riga di testo con 24 car con formato KC
e C nella DW 18 Fine.

Il cursore si trova sulla DW 6.

4: KG = +1701412+39;

6 KG =

1. Posizionare il cursore sul campo del formato.
2. Introdurre i caratteri KC.
3

. Introdurre Riga di testo con 24 car , il cursore salta alla riga successiva sulla
DW 18.

4. Sovrascrivere il formato dati KC con C. Introdurre i caratteri FINE.

| caratteri FINE sono caratteri ASCII e non significano fine blocco.

Risultato:

4 KG = +1701412+39;

6: KC = Rigatesto con 24 car,
18: C =

FINE

STEP 5/ST V7.0
C79000-G8572-C920-02 9-13
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9.2.7 Introduzione dei commenti alle parole dati

Sommario I commenti delle parole dati sono testi, che si possono introdurre in ogni riga di un
formato dati.

Un commento della parola dati € lungo al massimo 32 caratteri ed € sempre assegnato
alla prima parola dati (per formati KC, C e KG). Si possono utilizzare lettere maiuscole
e minuscole (senza accenti). | commenti delle parole dati vengono memorizzati nel
blocco commenti per il relativo blocco. Il nome del blocco commenti viene attribuito
automaticamente dallo STEP 5: DKn a DBn. Il numero del blocco commenti
corrisponde al numero del blocco, p. es. al DB 123 corrisponde il DK 123.

Premessa Nelle impostazioni & selezionato [x] con commenti (- Progetto, capitolo|4.1.1), Sul
video viene visualizzato il menu principale dell’'editor DB. Il DB contiene come minimo
una parola dati (DW).

Procedimento Procedere come segue:

1. Posizionare il cursore con SHIFT e cursore a destra nel campo del
commento desiderato.

2. Introdurre un testo con un massimo di 32 caratteri o correggere il testo gia
esistente.

Dopol'introduzione di 32 caratteriil cursore saltaautomaticamente all'inizio del campo
commento.

3. Premere il tasto di introduzione

9.2.8 Memorizzazione del commento

Sommario Memorizzando perlaprimavoltailblocco daticonicommenti, viene creato automatica-
mente il blocco commenti.

Se il blocco commenti esiste gia, lo STEP 5 segnala:
DKn gia nel file destinazione, sovrascrivere?

Con il tasto Conferma si memorizza il commento.

STEP 5/ST V7.0
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9.2.9 Duplicazione di parole dati

Sommario

Esempio

STEP 5/ST V7.0
C79000-G8572-C920-02

Con questa funzione si puo duplicare un blocco di parole dati (da 1 a 12 parole dati
di un () formato). Il fattore di ripetizione "n” indica quante volte le parole dati marcate
devono essere ripetute nel DB. Come fattore di ripetizione si pud indicare un numero
da 2 a 255. Per la duplicazione di un blocco di parole dati si deve prestare attenzione
alla lunghezza massima di un DB (2043 parole).

Se le parole dati non stanno nel DB, lo STEP 5 segnala:
Memoria o buffer interno pieno
La funzione non viene allora eseguita.

Nella duplicazione si considera il blocco di parole dati originario, cid vuol dire che il
blocco diparole dati daduplicare esistera nvolte. | numeri delle parole dati successive
vengono aggiornati. | commenti delle parole dati non vengono duplicati.

Quando si introduce un fattore di ripetizione ad una o due cifre, questo numero deve
essere completato con deiblank o conil carattere <o abbandonare il campo col tasto
cursore adestra .Posizionare quindiil cursore sull'ultima parola dati che sideveripro-
durre. Premendo il tasto di introduzione , la funzione viene eseguita.

Le parole dati (DW) 1 e 2 devono trovarsi due volte nel DB. Sul video € emesso il menu
principale dell’editor.

Punto di partenza: — | Risultato:

0:  KF=+00123; Of KF :_;0012,3;

1:  KH=8F1A; 1:  KH=8F1A

s kYoo

S KH=00L25 4: KH=4BBB;
TS~ |5 KY=001,255

1. Posizionare il cursore con SHIFT e cursore a sinistra dopo 1..
2. Introdurre la cifra 2.

3. Posizionare il cursore a destra nel campo di editazione sul numero 8,
introducendo il carattere <e premendo due volte cursore a destra , oppure
quattro volte cursore a destra oppure due volte blank e due volte cursore a
destra .

4. Posizionare il cursore verso il basso sul numero 4 nella DW 2.

5. Duplicazione delle parole dati (DW): premere il tasto di introduzione
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9.2.10  Test di numeri in virgola mobile

Sommario Inumeriinvirgolamobile sono numerinoninteripositivio negativi, che sonorappresen-
taticome numeriesponenziali. Nel PG siintroduce come formato dati KG. Nellamemo-
ria AG essi occupano sempre due parole (32 bit). La mantissa occupa 3 byte, I'espo-
nente 1 byte. Con la funzione F5 = Test KG i numeri in virgola mobile si possono
rappresentare e modificare nel formato esadecimale.

Premessa E emesso sul video il menu principale dell’editor DB. Il DB contiene come minimo
una parola dati (DW).

Esempio o ) _
Test del numero in virgola 0,1234567+12 in formato esadecimale.

Nella parola dati 1 si trova il numero in virgola mobile.

KG =+ 1234567+ 12
1. Posizionare il cursore sul + della mantissa.
2. Premere F5= Test KG.

Accanto al numero in virgola mobile & ora visualizzato il suo valore in
esadecimale:

KG = + 1234567+ 12 25 72FA5SF
Esponente Mantissa

3. Conclusione della visualizzazione: premere ESC o Conferma . Si
possono modificare I'esponente e la mantissa in formato esadecimale.

4. Conferma delle modifiche: premere Conferma .
5. Abbandono e perdita delle modifiche: premere ESC.

STEP 5/ST V7.0
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9.2.11 Inserimento / Cancellazione righe

Inserimento riga Si ha la possibilita tramite tasti di inserire o cancellare, nel DB, righe di DW e di com-

Cancellazione
riga

STEP 5/ST V7.0

C79000-G8572-C920-02

mento:

Cursore su

Tasto

Campo

Campo
formato

Campo
editaz.

Campo
comm.

Risultato

Inserim.
verticale

Riga inserita, la parola dati
e la riga di commento ven-
gono spostate di una riga
verso il basso a partire dal
cursore.

F3 = Inser.
DF

Formato dati inserito, il for-
mato dei dati viene spostato
di una riga verso il basso a
partire dal cursore, il com-
mento no.

F1 = Inser.
DK

Riga di commento inserita,
le DW rimangono al loro po-
sto, i commenti vengono
spostati di una riga in basso
a partire dal cursore.

Cursore su

Tasto

Campo

Campo
formato

Campo
editaz.

Campo
comm.

Risultato

Tasto di
cancell.

Parola dati e commento
cancellati, le righe succes-
sive vengono spostate di
una riga verso l'alto.

F4= Canc.
DF

Formato dati cancellato, i
formati dei dati successivi
vengono spostati di una riga
verso l'alto, i commenti no.

F2= Canc.
DK

Riga di commento cancel-
lata, i commenti successivi
vengono spostati di una riga
verso l'alto.

Sfondo grigio = funzione possibile in questa posizione del cursore.

Avvertenza

Con F3 = Inser. DF 0 F4 = Canc. DF il contenuto di blocchi dati puo essere cam-
biato a causa di errori di arrotondamento se il formato KG & usato.
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Sommario

Singole maschere
DB

Sommario del
capitolo
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Le maschere DB sono blocchi dati speciali per i controllori S5-135U, S5-155H e
S5-155U. | parametri da introdurre dipendono dalla CPU del controllore programma-
bile (AG). Queste maschere DB sono legate al ripettivo AG e non contengono com-

menti.

\_ Test AG Gestione Docu(

a

Blocco STEP 5 ... F1
Blocco dati ... F2

Lista di attribuzione F7
Vie bus F8

Parametri stampante  Ctrl+F4
Editor piedinatura Ctrl+F5

Con le singole definizioni sono elencate le seguenti maschere DB utilizzabili:

DB 1

Essa contiene una lista degli ingressi e delle uscite digi-

Suddivisione periferia tali (periferie con relativi indirizzi dei byte da 0 a 127), i

merker di accoppiamento d’ingresso e uscita per
S5-135U e la lunghezza del blocco tempo.

DX 0 Impostazioni di terminate funzioni del programma di si-

per S5-135U stema per S5-135U, p. es. per I'elaborazione dell’avvia-
mento dell’AG nel funzionamento multiprocessore.

DX 0 Impostazioni di determinate funzioni del programma di

per S5-155U sistema per S5-155U, p.es. nuovo avviamento, riavvia-

S5-155H mento, interrupt di processo etc.

Capitolo Argomento trattato Pagina
10.1 Editazione maschera DB 10-2
10.2 Editazione maschera DX 0 (S5-135U) 10-4
10.3 Editazione maschera DXO0 (S5-155U) 10-6
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10.1 Editazione maschera DB

Suddivisione Nel funzionamento multiprocessore, ad ogni unita centrale bisogna associare gli in-

periferia DB1 gressied uscite digitali, i merker diaccoppiamento e lalunghezza del blocco temporiz-

per il S5-135U zatori. PG emette pertanto sulvideo unatabellain cuisipossonointrodurrele associa-
zioni come numeri decimali. | valori numerici sono memorizzati nel DB senza spazi
tra di loro.

Impostazioni Impostazioni per I'editazione:

File programma Nome del file programma attuale

Funzionamento: Online, se & collegato un AG o se si desidera editare diret-
tamente in AG.

Informazioni relative alle Impostazioni si trovano sotto File » Progetto » Imposta

F4.
Scelta dell’editor
\ Editor \ Selezionare il comando di menu Editor » Maschera DB... . Il box di dialogo Edita
Maschera DB... maschera DB appare sul video.

1. Selezionare se il blocco deve essere editato nel file programma o in AG
2. Indicare il blocco, p.es. DB 1

3. Nellascelta (F3 = Scegli) selezionare la maschera DB 1 Suddivisione della perife-
ria e confermare con Edita i valori introdotti.

Il PG emette la maschera di suddivisione periferia:

STEP 5 Window Mode - S50XSOLZ

(FCanc riga falCanc elem F F F F F Help
iMIns. riga pdIns. elem 4 5 6 4 Conferma gf Annulla

Figura10-1 Maschera di suddivisione della periferia

STEP 5/ST V7.0
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| valori contatori ammessi risultano dal tipo di controllore programmabile. Questo si
puo ottenere dalla lettura del manuale del controllore programmabile.

Introduzione dei Il cursore € posizionato nel primo campo della maschera DB. Per I'introduzione proce-
dati dere come segue :

1. Posizionare il cursore nel campo in cui si deve introdurre un nuovo valore o
sovrascrivere.

2. Introdurre il numero decimale con la tastiera.

Dopo tre cifre, il cursore salta automaticamente nel successivo campo. |l tasto
di introduzione comanda il salto alle successive righe.

Inserimento riga/ Posizionareilcursore sullariga, primadellaquale unariga/elementodeve essereinse-
elemento rita/o e premere F1 = Ins.riga oppure F2 = Ins.elem.

Cancellazione riga/ Posizionare il cursore sulla riga o sull'elemento che deve essere cancellata/o e pre-
elemento mere SHIFT F1 = Canc.riga oppure SHIFT F2 = Canc.elem.

Cancellazione Premere DEL o sovrascrivere con dei blank.

carattere

Conferma Premere Conferma .

maschera

STEP 5 Window Mode - S50XSOLZ

[JCanc. riga  gCanc elem [
iMIns. riga paIns. elem [dConferma KR Annulla

Figura 10-2 Esempio di una maschera DB compilata per un AG 135 U

STEP 5/ST V7.0
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10.2 Editazione maschera DX 0 (S5-135U)

DX 0
per S5-135U

Impostazioni

| Editor |
Maschera DB...

Editazione

STEP 5 Window Mode - S50XSOLZ

I DX 0 contiene i dati di sistema S5-135U ed & associato in modo fisso all’AG come
maschera DB. La parametrizzazione della maschera si trova descritta nelle istruzioni
di programmazione AG.

Informazioni piu precise relative alle impostazioni si possono trovare sotto il comando
di menu File » Progetto » Imposta F4 (vedere capitolo/4.1.1)

File programma:  nome del file programma attuale.

Funzionamento: online, se € collegato un AG o se si desidera editare diretta-
mente in AG.

Selezionare il comando di menu Editor » Maschera DB... |l box di dialogo Edita
maschera DB appare sul video.

Procedere come segue:
1. Scegliere se il blocco deve essere editato nel file programma o in AG.
2. Introdurre il blocco, per esempio DX O.

3. Nella scelta (F3 = Scegli) selezionare la maschera DX 0 per AG 135 U e confer-
mare con Edita i valori introdotti.

4. Confermare i valori introdotti con EDITA o il tasto di introduz .. || PG emette la
maschera DXO per la pagina 1:

Figura 10-3 Maschera DX 0 per AG 135 U, pagina 1

10-4
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Barra delle F3 Selezionare, nella posizione del cursore, i possibili parametri oppure
funzioni = Scegli

F3 Introduzione del parametro, nella posizione del cursore, tramite ta-

= Immetti stiera.

F6 Passaggio alla pagina successiva o precedente.

= Avanti

F7 Acquisizione e memorizzazione delle introduzioni.

= Conferma

F8 Ritorno al menu precedente.

=Annulla

I valori dei contatori ammessi risultano dal tipo di controllore programmabile. Questo
si puo ottenere dalla lettura del manuale del controllore programmabile.

Nella maschera, i valori diversi dalla impostazione di base sono registrati in rosso,
odinreverse. Il cursore sitrova nel primo campo di introduzione della maschera DXO.

DXO0 per S5-135U Con F6 = Avanti si ottiene la pagina 2 della maschera DX 0
pagina 2

STEP 5 Window Mode - S50XSOLZ

Figura 10-4 Maschera DX 0 per AG 135 U, pagina 2

Introduzione dei Procedere come segue:

dati . . . o -
1. Posizionare il cursore nel campo, in cui si vuole modificare un valore.

2. Selezionare i parametri con F3 = Scegli o, se nella riga dei tasti funzionali &
visualizzato F3 = Immetti, introdurre i parametri con la tastiera.

3. Richiamo della seconda pagina della maschera DB: premere il tasto F6 =
Avanti, ed introdurre i parametri come nella prima pagina.

4. Conferma DX 0: premere Conferma o abbandonare I'introduzione premendo il
tasto di introduzione

STEP 5/ST V7.0
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10.3 Editazione maschera DX0 (S5-155U)

DX 0
per S5-155U

Impostazioni

\ Editor \
Maschera DB...

Scelta dall’editor

I DX 0 contiene i dati di sistema S5-155U ed & associato in modo fisso all’AG come
maschera DB. La parametrizzazione delle maschera sitrova descritta nelle istruzioni
di programmazione AG.

Impostazioni per I'editazione:

File programma:  nome del file programma attuale.

Funzionamento: Online, se é collegato un AG o si desidera editare diretta-
mente in AG.

Selezionare il comando di menu Editor » Maschera DB... . Il box di dialogo Edita
maschera DB appare sul video.

Procedere come segue:
1. Scegliere se il blocco deve essere editato nel file programma o nell’AG.

2. Introdurre il blocco, p. es. DX 0

3. Nella scelta (F3 = Scegli) selezionare la maschera DX 0 per AG 155 U, CPU
946/947 e confermare con Edita i valori introdotti.

4. Confermare i valori introdotti.

Il PG emette la maschera DX 0 con la pagina 1:

Figura 10-5 Maschera DX 0 per AG 155 U, pagina 1

10-6
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Tasti funzionali F3 Selezionare, nella posizione del cursore, i possibili parametri oppure
= Scegli
F3 Introduzione del parametro, nella posizione del cursore, tramite
= Immetti tastiera.
F6 Passaggio alla pagina successiva o precedente.
= Avanti
F7 Acquisizione e memorizzazione delle introduzioni.
= Conferma
F8 Ritorno al menu precedente.
=Annulla

Nella maschera, i valori diversi dalla impostazione di base sono registrati in rosso,
odinreverse. | valorideicontatoriammessirisultano daltipo dicontrollore programma-
bile.

DXO0 per S5-155U Con F6 = Avanti si ottiene la pagina 2 della maschera DX 0
pagina 2

STEP 5 Window Mode - S50XSOLZ

Figura 10-6 Maschera DX 0 per AG 155 U, pagina 2

Introduzione dei Procedere come segue:

dati - . . - .
1. Posizionare il cursore nel campo, in cui si vuole modificare un valore, p.es.

Funzionamento S5-155U o S5-150U.

2. Selezionare i parametri con F3 = Scegli 0, se nella riga dei tasti funzionali &
visualizzato F3 = Immetti, introdurre i parametri con la tastiera.

3. Richiamo della seconda pagina della maschera DB: premere il tasto F6 =
Avanti, ed introdurre i parametri come nella prima pagina.

4. Conferma DX 0: premere Conferma o abbandonare l'introduzione premendo
ESC = Annulla.

STEP 5/ST V7.0
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Editazione della lista di attribuzione

Sommario

Sommario del
capitolo
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11

Laprogrammazione simbolica permette diintrodurre al posto di un operando assoluto,
p.es.E 1.1, unaqualsiasistringadi caratteri, p. es. TASTO ON. Prima di programmare
con gli operandi simbolici, si deve creare una lista di attribuzione tra operandi assoluti
e operandi simbolici, con I'aiuto dell’editor simbolico dello STEP 5. Contemporanena-
mente in questa lista di attribuzione ad ogni operando pud essere associato un com-
mento dell'operando.

S

\_ Test AG Gestione Docu(

a

Blocco STEP 5 ... F1

Blocco dati ... F2

Maschera DB ... Ctrl+F1
'Lista di attribuzione ~ F7
Vie bus F1

Parametri stampante  Ctrl+F4

Editor piedinatura  Ctrl+F5

Capitolo Argomento trattato Pagina
11.1 Operativita generale con I'editor 11-2
11.2 Generazione lista di attribuzione 11-6
11.3 Ausili per I'editazione 11-9
114 Modifica della lista di attribuzione 11-14
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Editazione della lista di attribuzione

11.1 Operativita generale con I'editor

Premesse

Richiamo
dell’editor

\ Editor

Lista attribu-
zione F7

Procedimento

11-2

Le lunghezze dell’'operando simbolico e del commento operando sono impostabili
(File » Progetto » Imposta F4, Scheda Simbolico, vedere capitolg 4.1.1)

* Operando simbolico: da 8 a 24 caratteri (preimpostato 8),
e Commento: max. 40 caratteri (preimpostato 40).

Le impostazioni valgono per tutta la lista di attribuzione. Un successivo aumento della
lunghezza & possibile, mentre una diminuzione & possibile solo fino alla piu grande
lunghezza di commento veramente esistente nel file. Cancellare prima i file

INI).

Le introduzioni e le modifiche delle attribuzioni avvengono nel file sorgente sequen-
ziale. Dopo l'editazione, questo file viene compilato in fase di memorizzazione, nel
file simbolico finale (*Z0.INI).

Nelle impostazioni deve essere introdotto il nome del file simbolico. Questo nome
viene acquisito automaticamente per il file sorgente sequenziale.

Selezionare il comando di menu Editor » Lista attribuzione. Viene richiamato diret-
tamente I'editor per il file sorgente sequenziale (*Z0.SEQ). Lo STEP 5 emette una
lista di attribuzione (vuota), in cui - secondo colonne separate - si introducono:

e operandi assoluti,

e operandi simbolici,

e commenti degli operandi e

* . commenti aggiuntivi, che iniziano con un "punto e virgola”.

* . Cambio pagina (sequenza caratteri.PA)

La creazione della lista di attribuzione richiede il seguente procedimento:

1. Si edita la lista di attribuzione come file sorgente sequenziale (terminazione
del nome *Z0.SEQ).

2. Lalista di attribuzione viene compilata durante la memorizzazione e trasferito
nel file simbolico (tre nomi con terminazione Zx.INI, x =0, 1, 2). Se durante la
compilazione si verificano errori, lo STEP 5 li registra in file errori (termina-
zione del nome *ZF.SEQ). Questo file si puo visualizzare o emettere sotto
- Gestione, Liste di attribuzione, Emetti lista errori.

Se durante I'editazione della lista di attribuzione sono stati assegnati dei testi ai
tastifunzionali (- Tastifunzionaliprogrammabili), viene memorizzatoilfile aggiun-
tivo *ZT.SEQ.

STEP 5/ST V7.0
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Lista di attribuzione File simbolico

NOME@@Z0.INI

Compilazione
NOME@@Z0.SEQ P » NOME@@Z1.INI
‘ NOME@@Z2.INI
- - Erroredur. — - ——— - —
NOME@@ZT.SEQ - —» NOME@@ZF.INI:
L - —_— & la compilazioneL_ _ o
File per tasti File errori

funzionali programmati

Figura 11-1 Creazione lista attribuzione

3. Il file simbolico memorizzato € utilizzato per la compilazione del programma
utente in codice eseguibile e per 'emissione.

Tipi di operandi Nella seguente tabella si trovano elencati tutti i tipi di operando, a cui si puo attribuire
consentiti una sigla simbolica nella lista di attribuzione.

Tabella 11-1 Panoramica dei tipi di operandi consentiti

Operando Operando

Chiarimento Chiarimento
A Uscita M Merker
AB Byte d’uscita MB Byte di merker
AD Doppia w. d’'uscita MD Doppia w. di merker
AW Word d’uscita MW Word di merker
D Bit in parola dati OB Blocco organizzativo
DB Blocco dati PB Blocco di programma
DD Doppia parola dati PY Byte di periferia

DL Parola dati, byte sin. PW Word di periferia

DR Parola dati, byte destro | QB Byte di per. ampliata

DW Parola dati QW Word di per. ampliata

DX Blocco dati suppl. S Merker supplem.

E Ingresso SB Blocco sequenziale

EB Byte d’ingresso SD Doppia word di merker supplem.
ED Doppia w. d’ingr. SW Word di merker supplem.

EW Word d’'ingresso SY Byte di merker supplem.

FB Blocco funzionale T Temporizzatore

FX Blocco fun. supplem. Z Contatore
Avvertenza

Anche ai blocchi immagine (BB) possono essere attribuite delle sigle simboliche.

STEP 5/ST V7.0
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Configurazione del Le righe e le zone del campo di editazione hanno il seguente significato:
video @ @ @)
. L4 . |4 Ld
File seq.: C:ESEMP1Z0.SEQ Riga: 1 - Inserimento -
‘ Operando ‘ ‘ Simbolo H Commento
)
Ma

®) F‘Testo 1 ‘ F‘Testo 2 ‘ F‘Testo 3 ‘ F‘Testo 4 ‘ F‘Modo ‘ F‘Pag. Av. ‘F‘Pag. Ind.‘ F‘Help ‘
‘1 Annota 2 Copia 3 Cancella 4 Cerca 5 Sostit. 6 Salva 7 Conferma 8 Annulla

Figura 11-2  Configurazione del video con righe e zone del campo di editazione

Righe del video

Tabella 11-2 Righe del video

Riga

Chiarimento

@)

Drive e nome del file sorgente sequenziale (lista di attribuzione). Il
nome € assegnato tramite il nome del file simbolico nella maschera
Imposta. Sono visualizzati fino a 32 caratteri del nome completo del
file. Nel caso questo sia piu lungo, viene emesso in modo accorciato.

)

Numero della riga in cui si trova il cursore.

®3)

Visualizzazione del modo, con SHIFT F5 = Modo, commutabile tra
Inserimento e Sovrascrittura.

(4)

Zona di Editazione Questa zona € suddivisa in tre colonne:

® Operando
Colonna per l'introduzione degli operandi assoluti, la larghezza della
colonna non e modificabile.

* Simbolo

Colonna per l'introduzione degli operandi simbolici, la larghezza della
colonna dipende dall'impostazione effettuata

e Commento

Colonna per l'introduzione del commento dell'operando. La larghezza
della colonna dipende dall'impostazione.

®)

Tasti funzionali

Tasti funzionali per richiamare le funzioni di editazione

11-4

STEP 5/ST V7.0
C79000-G8572-C920-02



Editazione della lista di attribuzione

Tasti funzionali

STEP 5/ST V7.0
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Funzione dei tasti:

F1* Memorizzazione di un testo selezionato (riga, blocco di testo o testo

= Annota digitato) nella memoria buffer, da dove questo puo essere copiato in
qualsiasi punto della lista di attribuzione tramite F2* = Copia. Memo-
rizzazione dei testi digitati, che possono essere richiamati tramite i
tasti funzion. da SHIFT F1 = Testo 1 a SHIFT F4 = Testo 4.

F2* Richiamo di un testo annotato tramite F1*= Annota dalla memoria

= Copia buffer e copiato nella posizione del cursore.

F3* Cancellazione della riga in cui si trova il cursore, o cancellazione di un

= Cancella testo selezionato. Il testo cancellato viene acquisito nella memoria
buffer e consente il trasferimento di parti di testo tramite F2* = Copia.

F4* Ricerca di operandi, righe, testi o stringhe, eventualmente anche ini-

= Cerca zio e fine nella lista di attribuzione. L'introduzione del criterio di ricerca
deve esattamente coincidere, per quanto riguarda le lettere maiuscole
0 minuscole, con la stringa di testo cercata.

F5* Sostituzione di una qualsiasi stringa di caratteri (max. 20 caratteri in-

= Sostit. cluso i blank) con un’altra.

F6 Salvataggio del file sorgente senza compilazione, p. es. in caso di

= Salva interruzione dell’'editazione. La lista di attribuzione editata puo essere
ulteriormente elaborata.

F7 Conclusione dell’editazione e memorizzazione della lista di

= Conferma | attribuzione. L'avvio della compilazione con la creazione del file sim-
bolico viene attivata automaticamente.

F8 Interruzione dell’'editazione senza memorizzazione della lista di

= Annulla atrribuzione.

SHIFT F1 Emissione del testo 1 tramite un tasto funzionale.

=Testo 1

SHIFT F2 Emissione del testo 2 tramite un tasto funzionale.

= Testo 2

SHIFT F3 Emissione del testo 3 tramite un tasto funzionale.

= Testo 3

SHIFT F4 Emissione del testo 4 tramite un tasto funzionale.

= Testo 4

SHIFT F5 Selezione del modo di editazione: inserimento o sovrascrittura.

= Modo

SHIFT F6 Una pagina avanti.

= Pag. Av.

SHIFT F7 Una pagina indietro.

= Pag. Ind.

SHIFT F8 Visualizzazione dell'assegnazione dei tasti funzionali.

= Help

Tasti con * richiamano ulteriori livelli di tasti
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11.2 Generazione lista di attribuzione

Procedimento

Commento
operando

Commenti
aggiuntivi

11-6

Introdurre la stringa di caratteri dell’operando assoluto, p. es. E 1.1.
1. Posizionare il cursore, con il mouse o con TAB, nella colonna del simbolo.
2. Introdurre la stringa di caratteri del simbolo senza lineetta, p. es. Segnale 1.

Nellalista di attribuzione non sideve introdurre la lineetta prima dell’operando simbo-
lico. Lalarghezza della colonna corrisponde alla lunghezza del simbolo preimpostato
(vedere capitolc 4.1.1,|scheda 3). Mancando 'introduzione del simbolo (il campo sim-
bolo & vuoto), durante la compilazione viene chiesto:

Acquisizione operando assoluto come simbolo?

Si La stringa di caratteri dell’'operando assoluto € compilata come operando
simbolico nel file simbolico. Nella lista di attribuzione il campo rimane
vuoto. Solo dopo la compilazione (- Gestione, - INI > SEQ) I'operando
simbolico viene introdotto nel file sorgente sequenziale.

No L'operando assoluto non viene registrato come operando simbolico, il
campo rimane vuoto.

Sesivuole aggiungere untestodichiarimentoall’operando simbolico, € adisposizione
una colonna di commento con una larghezza massima di 40 caratteri. Il commento
operando puo essere introdotto anche se nelle Impostazioni (vedere capitolo 4.1.1,
scheda 3) si € introdotto il parametro Commenti: No. || commento operando (lettere
maiuscole e minuscole) non & memorizzato separatamente, ma € memorizzato
anch’esso nel file simbolico.

1. Posizionare il cursore, con il mouse o con TAB, nella colonna del commento.

2. Introdurre la stringa di caratteri del commento operando, p. es. Commento di
esempio .

3. Abbandonare la riga con il mouse o premere il tasto di introduzione

Nel caso lo spazio per il commento non sia sufficiente, si pud introdurre un commento
aggiuntivo. In questo caso, digitare nel campo Operando, nella prima colonna, il carat-
tere (;) che contrassegna I'opzione di commento aggiuntivo della riga. Il carattere (;)
sempre deve trovarsi nella prima colonna del campo Operando. L'introduzione dei
commenti aggiuntivi &€ possibile in qualsiasi riga.

Ilnumerodicolonne che sonoadisposizione perl'introduzione diuncommentoaggiun-
tivo corrisponde alla somma della lunghezza degli operandi (10 caratteri), della lun-
ghezzacommentoesimbolicoedelle colonnediseparazione. Asecondadell'imposta-
zione, sono possibili lunghezze di commento aggiuntivo tra 19 e 76 colonne (=
caratteri).

STEP 5/ST V7.0
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Cambio pagina

Conclusione
dell’editazione

Caratteri speciali
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Il carattere speciale ”;” (figura 11-3) non puo essere cancellato dall’editor. Se sivuole
cancellare questo carattere, bisogna cancellare tutta la riga (- F3 = Cancella, F1 =
Riga).

Avvertenza

I commenti aggiuntivi ed i caratteri di comando della stampante si trovano solo
nella lista di attribuzione. Se si crea una lista di attribuzione dal file simbolico con
la funzione - Gestione, Compila INI > SEQ, i commenti aggiuntivi e i caratteri di
comando della stampante (.PA) vanno persi.

Se la lista di attribuzione occupa piu pagine, si puod eseguire, tramite I'introduzione
di un carattere di comando, una suddivisione in pagine, pertanto

* introdurre nel campo Operando, iniziando dalla prima colonna dei caratteri, la
stringa di caratteri .PA.

In questariganon € ammessa nessun’altra introduzione. Il carattere di comando ese-
gue un cambio pagina durante la stampa. Il carattere di comando non viene acquisito
nel file simbolico (*Z0.INI).

Procedere come segue:
1. Premere F6 = Conferma.

Il file sorgente sequenziale viene memoriazzato e compilato nel file simbolico.
Se la compilazione é senza errori, lo STEP 5 segnala:
n righe elaborato, nessun errore trovato (n = numero di righe).

2. Eseguire un click su OK o premere il tasto di introduzione
Lo STEP 5 abbandona I'editor e ritorna nel menu.

Per il simbolico si possono utilizzare gli spazi e la maggior parte dei caratteri speciali,
ad eccezionedella™\". | caratteri non consentiti vengono rifiutati con una segnalazione
di errore.

Avvertenza

Si consiglia, se possibile, di non utilizzare caratteri di spazio iniziali o finali per i
simboli, in quanto essi sono difficilmente riconoscibili, quando vengono
visualizzati sullo schermo o stampati all'interno di liste di attribuzione e
programmi STEPS5.

Con la funzione Correggi file simbolico occorre attribuire un simbolo a ciascun
operando affinché non vengano creati simboli composti da molti caratteri di
spazio.
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Errori in editazione

11-8

Se durante la compilazione si verifica un errore, lo STEP 5 segnala:

trovato un errore nella riga n. Il parametro assoluto non
conforme a SGOP . (SGOP = sigla operando).

L'editor rimane attivo, la riga errata viene rappresentata nella parte piu alta del video.
Dopo I'eliminazione dell’errore nel file sorgente sequenziale, tramite la memorizza-
zione, si attiva una nuova riga compilazione.

Se si verificano piu errori, lo STEP 5 segnala:

n righe elaborate, n errori trovati, visualizzare lista er-
rori?

Si la lista errori viene visualizzata

No I'editor viene abbandonato

Lo STEP 5 ha registrato gli errori nel file *ZF.SEQ.

Questa lista errori pu0d essere emessa, richiamando la funzione di gestione
- Liste di attribuzione, Emetti lista errori.

File seq.: C:ESEMP1Z0.SEQ Riga: 12 - Inserimento - 139kB

Operando Simbolo Commento

E 1.0 Segnale Commento di esempio

EW 124 IWORD124 Word d’'ingresso 124

A 1.0 USC. 1.0 Uscita 1.0

AB 122 ABYTE122 Byte d'uscita 122

AD 100 AD-100 Doppia word d’'uscita 100

M 1.0 MERK. 10 Merker 10

S4095.7 S-MERK Nuovo merker 4095.7

; Un commento aggiuntivo inizia con un "punto e virgola”.

; Lunghezza del commento = somma delle colonne:

; Operando + simbolo + commento + colonne di separazione

SW 64 S-F 64 Nuovo merker, parola di merker 64
Z6 Contat. 6 Contatore 6

F Testol F Testo2 F Testo3 F Testo4 F Modo FPag.Av. FPag.Ind. F Help
1 Annota 2 Copia 3 Cancella4 Cerca 5 Sostit. 6 Salva 7 Conferma 8 Annulla

Figura 11-3 Esempio per una lista di attribuzione nella lista di attribuzione
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11.3 Ausili per I'editazione

Sommario

F1 = Annota

STEP 5/ST V7.0
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Lo STEP 5 agevola la creazione della lista di attribuzione tramite le funzioni di edita-
zione, che si richiamano e si utilizzano tramite tasti funzionali.

F Testol F Testo2 F Testo3 F Testo4 F Modo
1 Annota 2 Copia 3 Cancella 4 Cerca 5 Sostituisci

F F F F F F Pag. Av.
1 Riga 2 Testo 3lniz.blc. 4 Fineblc. 5 File 6 Tast. fz.

Si memorizzano le righe selezionate, qualsiasi stringa di caratteri (digitata) e blocchi
dirighe, in una memoria buffer (Annota) da dove questi possono essere successiva-
mente trasferiti (Copia). | blocchi di testo sono trasferibilianche in un altro file sorgente
sequenziale.

F1 Annota la riga in cui si trova il cursore per copiarla in un altro punto.

= Riga

F2 Annota un testo digitato (max. 40 caratteri) per copiarlo.

= Testo

F3 Viene contrassegnato I'inizio di un blocco di caratteri (inclusa la riga in

=Iniz. blc.  cui si trova il cursore).

Avvertenza sul fattore di ripetizione
Come carattere iniziale di blocco viene settato @ fintantocheé il blocco &
selezionato.

F4 Viene contrassegnata la fine di un blocco di caratteri (inclusa la riga in
= Fine blc.  cui si trova il cursore).
Il blocco é trasferibile anche in un altro file sorgente sequenziale, - F5

= File
F5 Il contenuto di un’altra lista di attribuzione, il cui nome deve essere
= File indicato, viene inserito a partire dalla riga in cui si trova il cursore. Il

file deve essere stato precedentemente memorizzato.

F6 Quattro tasti funzionali possono essere associati a qualsiasi testo digi-

=Tastifz.  tato (massimo 40 caratteri), in questo modo si possono richiamare,
durante I'editazione, caratteri ripetitivi (- Tasti funzionali programma-
bili).
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F2 = Copia

11-10

F Testol F Testo2 F Testo3 F Testo4 F Modo
1 Annota 2 Copia 3 Cancella 4 Cerca 5 Sostit.

F F F F F
1 Riga 2 Testo 3 Blocco 5 File

N

Si inserisce una riga, qualsiasi stringa di caratteri (digitata) e blocchi di righe prima
della riga in cui si trova il cursore, cioe si la copia dalla memoria buffer. Il numero di
copie € introdotto in cifre come "fattore di ripetizione”. Si pud anche introdurre un’ulte-
riore file sorgente sequenziale nella lista di attribuzione attuale.

Avvertenza sul fattore di ripetizione

Non € possibile posizionare il cursore sul campo di introduzione del fattore di ripeti-
zione, questo salta nella riga Fattore di ripetizione solo dopo l'introduzione di un va-
lore.

F1 La riga annotata o una riga precedentemente memorizzata nel buffer

= Riga tramite cancellazione, viene inserita prima della riga in cui si trova il
cursore.

F2 Il testo digitato ed annotato viene inserito prima della riga in cui si trova

= Testo il cursore.

F3 Il blocco di righe annotato o un blocco di righe precedentemente me-

= Blocco morizzato nel buffer tramite cancellazione, viene inserito prima della
riga in cui si trova il cursore.

F5 Il blocco di righe annotato viene trasferito (copiato) in un’altra lista di
= File attribuzione, di cui si deve introdurre il nome. Il file deve essere prece-
dentemente aperto; un contenuto gia esistente viene sovrascritto.

Avvertenza

Se incautamente si & sovrascritto il file, si puo rigenerare il file sorgente sequenziale
originario, creando il file sorgente sequenziale dal file simbolico — Gestione,
Converti INI > SEQ. Pero, alla compilazione non vengono acquisiti caratteri di co-
mando e di commento.
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F3 = Cancella
F Testol F Testo2 F Testo3 F Testo4 F Modo
1 Annota 2 Copia 3 Cancella 4 Cerca 5 Sostit.

F F F F F
1 Riga 2 3 Iniz. blc. 4 Fine blc. 5

Con questa funzione si cancella una riga o un blocco. La riga o il blocco cancellato
vieneregistrato nel buffer. Unblocco annotato precedentemente vaperso. llcontenuto
del buffer si pud copiare in un altro punto - F2 = Copia.

F1 Cancella la riga nella posizione del cursore. La riga viene memorizzata
= Riga nel buffer.

F3 Contrassegna l'inizio di un blocco.

= Inizi. bl.

Avvertenza sul fattore di ripetizione
Come carattere iniziale di blocco viene settato @ fintantoche il blocco &
selezionato.

F4 Contrassegna la fine di un blocco. Appena questo tasto viene premuto
= Fine bl. o si esegue un "click” con il mouse, il blocco viene cancellato e memo-
rizzato nel buffer.

F4 = Cerca
F Testol F Testo2 F Testo3 F Testo4 F Modo
1 Annota 2 Copia 3 Cancella 4 Cerca 5 Sostit.
F F F F
F Testo+ 2 Testo— 3Operando+ 4Operando— 5 Riga

F Pag. Av. F Pag. Ind.
6 Inizio 7 Fine

Ilcursore viene posizionato in una determinata riga o all'inizio/fine di un testo. E possi-
bile la ricerca secondo operandi o qualsiasi stringa di caratteri.

F1 Ricerca secondo una stringa di caratteri nei commenti operando o nel

=Testo+ commento aggiuntivo a partire dalla posizione del cursore (dopo ;).

F2 Ricerca secondo una stringa di caratteri nei commenti operando o nel

= Testo — commento aggiuntivo prima della posizione del cursore (dopo ;).
Avvertenza

L'introduzione della stringa di caratteri da ricercare deve coincidere esattamente,
per quanto riguarda le lettere maiuscole e minuscole, con quanto ricercato.

STEP 5/ST V7.0
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F3 Ricerca di un operando assoluto a partire dalla posizione del cur-
= Operando + sore.

F4 = Ricerca di un op. assol. prima della pos. del cursore.

Operando —

F5 = Riga Salto alla riga con il numero di riga indicato.

F6 = Inizio Posiziona il cursore all'inizio del file.

F7 = Fine Posiziona il cursore alla fine della lista di attribuzione.

F5 = Sostit.
F Testo 1l F Testo2 F Testo3 F Testo4 F Modo
1 Annota 2 Copia 3 Cancella 4 Cerca 5 Sostit.
F F F
1 Con conf. 2 Senz. conf. 3 4 Tutti 5

Una stringa di caratteri (massimo 20 caratteri) viene sostituita con o senza conferma
da un’altra stringa di caratteri.

F1 La stringa di caratteri viene cercata e sostituita n volte (n = fattore
=Con di ripetizione) nella lista di attribuzione, a partire dalla posizione del
conf. cursore, tramite una nuova stringa di caratteri introdotta. Prima di

ogni sostituzione viene richiesta una conferma:

Si  Sostituzione dei caratteri.

No | caratteri non vengono sostituiti, il cursore salta sulla succes-
siva stringa di caratteri (se n > 1 se viene di nuovo richiesta
la conferma.

Interruzione: La funzione viene interrotta.

F2 La stringa di caratteri viene cercata e sostituita n volte (n = fattore

= Senz. di ripetizione) nella lista di attribuzione, a partire dalla posizione del

conf. cursore, tramite una nuova stringa di caratteri introdotta, senza la
richiesta di conferma.

F4 La stringa di caratteri cercata viene sostituita in tutti i punti nella

= Tutti lista di attribuzione tramite la nuova stringa di caratteri introdotta.

STEP 5/ST V7.0
11-12 C79000-G8572-C920-02



Editazione della lista di attribuzione

Tasti funzionali
programmabili

Programmazione

STEP 5/ST V7.0
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Potendo associare a qualsiasi stringa di caratteri (di volta in volta max. 40 caratteri)
quattro tasti funzionali, si ha la possibilitd di inserire stringhe di caratteri ripetitive in
qualsiasi punto della lista di attribuzione. L'assegnazione dei tasti viene memorizzata
nel file *ZT.SEQ.

Nella maschera Imposta (- Progetto) é stato scelto Simbolico: Si.
1. Premere F1 = Annota.
Lo STEP 5 emette il successivo livello di tasti.
2. Premere F6 = Tast. fz.
Viene visualizzato I'editor dei tasti funzionali. Il cursore lampeggia nella primariga.
3. Digitare la stringa di caratteri ed abbandonare con il tasto di introduzione

4. Muovere il cursore da riga a riga con il tasto di introduzione o con i tasti cur-
sore in alto/basso .

I mouse non puo essere utilizzato, tranne che per attivare la Conferma tramite
F7 = Conferma.

Tasto : Testo :
Shift F1 . Esempio
Shift F2 : Commento operando
Shift F3 . Segnalazione:
Shift F4 : Impianto in funz,
F F F F F F
\1 4 5 6 7 Conferma

5. Cancellazione caratteri con DEL, nella posizione del cursore, a sinistra del
cursore, con backspace .

Si conclude I'editazione

6. premendo Conferma o interrompendo con ESC.
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11.4 Modifica della lista di attribuzione

Sommario

Procedimento di
modifica delle
"lunghezze dei
campi”

Inserimento righe

Sovrascrittura di
file

11-14

Se si desidera modificare una lista di attribuzione creata o compilata, viene offerta
per'editazione lalista di attribuzione, nel caso esista. Se manca la lista di atribuzione,
questo viene automaticamente creata dal file simbolico ed emessa.

Si deve osservare, durante I'editazione, di non superare la lunghezza preimpostata
dei commenti operando e degli operandi simbolici. Se tuttavia si vuole utilizzare, in
una lista di attribuzione creata, simboli di operandi e testi di commento piti lunghi, esi-
stono in tal senso 2 possibilita:

1. Sideve creare unanuova lista di attribuzione (File » Progetto » Imposta , scheda
3) e quindi copiare e memorizzare la lista di attribuzione esistente in questo nuovo
file mediante le funzioni di editazione F2 = Copia e F5 = File

» Cancella. INI); successivamente si possono aumentare le lunghezze dei sim-
boli e dei commenti (in File » Progetto » Imposta , scheda 3).Al successivo avvio
dell'editor si opera con i nuovi valori.

Procedere come segue:

1. Nella maschera Imposta (pagina 1) introdurre Drive e Nome del nuovo file
simbolico da creare, nella pagina 2 Lunghezza simbolico e commento. Queste
lunghezze devono essere uguali 0 maggiori di quelle esistenti.

2. Richiamare I'editor della lista di attribuzione (- Editor » Lista di attribuzione )
Lo STEP 5 emette una nuova lista di attribuzione vuota.

3. Copiare il file da modificare in quello attuale, attivando F2 = Copia e F5 = File.
Lo STEP 5 segnala: Nome file Z0.SEQ

4. Introdurre qui Drive e Nome file della lista di attribuzione esistente e conclu-
dere con il tasto di introduzione

Dopo la copia del file si giunge tramite F8 = Indietro nel modo Editazione
(Inserisci). Editare come al solito. Se si vuole sovrascrivere, commutare in
"Sovrascrittura” col tasto F8 = Modo.

Sipossonoinserire righe in un qualsiasi punto. Nel modo Inserimento, il tasto diintro-
duzione creaunarigavuotasottolarigaconilcursore. L'inserimento verticale inseri-
sce una riga vuota sopra la riga con il cursore. Nel modo Sovrascrittura, con il tasto
di introduzione si posiziona il cursore all'inizio della riga successiva.

Memorizzando la lista di attribuzione modificata, il file simbolico ed il file sorgente se-
quenziale esistenti vengono sovrascritti con lo stesso nome senza larichiesta di con-
ferma.
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Sommario Il collegamento online tra dispositivi di programmazione e AG non é realizzato soltanto
direttamente mediante un cavo di collegamento (collegamento punto a punto), ma
anche tramite i sistemi di bus SINEC H1, SINEC L1 o SINEC L2, ed anche con bus
AG (per S5-155U).

Questa connessione si genera, si memorizza e si attiva con la funzione Vie bus.

Sommario del Capitolo Argomento trattato Pagina
capitolo 12.1 Funzione vie bus 112-2)
12.2 Editazione vie bus 12-3
12.3 Esempio 12-7
STEP 5/ST V7.0
12-1
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Vie bus

12.1 Funzione vie bus

Informazioni

Assegnazione
Via > File

12-2

Le vie sono connessioni stabili tra un PG ed un determinato partner. Tramite queste
vie si possono eseguire tutte le funzioni di programmazione, secondo un protocollo,
come con un collegamento diretto punto a punto. Una via é costituita da:

* nodo di start, che € il punto iniziale della connessione (p.es. PG/AS511, PG/
CP-H1. PG/CP-L2),

* bus (1 o piu)

* nodi(p.es. CP),

* nodo finale (p.es. CPU)

Gli indirizzi dei partner si editano e si memorizzano in offline.

* Sotto un nome via (Progetto » Imposta ) viene memorizzata una via editata
€ puo essere attivata in qualsiasi momento, se esiste fisicamente.

¢ Inunfile via (Progetto » Imposta ) si possono memorizzare piu vie, ciascuna
con il proprio nome via, e quindi attivarle con il loro nome.

* Questa funzione consente I'Attivazione di una via. Cio pud avvenire pero sol-
tanto in online.

* Questa funzione consente anche la Disattivazione di una via.

Ad ogni via si possono associare 4 file:

¢ File di programma ...ST.S5D

¢ File simbolici ...ZO.INI

* File stampante ... DR.INI

¢ File di piedinatura ...F1.INI opp. ...F2.INI

Questi nomi difile vengono memorizzati nel file via, assieme al nome di via. L'associa-
zione non influisce sui file esistenti. Si possono associare anche file che ancora non
esistono e che devono essere creati. Con I'associazione di file ad una via non risulta
di consequenza alcuna modifica nelle impostazioni del progetto. Perimpostare questi
file nelprogetto attuale occorre selezionare larelativavia nelle impostazionidiprogetto
(con impostazione di Opzione via = senza o con conferma).

G/AS51 Nome Via: ESEMP1

KOR/MUX }

CP-H1 Indirizzo: 0

SINEC H1 Indirizzo
cP-H1 Ethernet: 080006010000

‘ : ‘ Password:

‘ PUNTO FIN.

Figura 12-1 Esempio di una via editata
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12.2 Editazione vie bus

Impostazioni

Operativita

Sideve impostare I'interfaccia per il nodo di start (AS 511, H1 o L2). Informazioni rela-
tive a questa impostazione si trovano sotto Progetto » Imposta (vedere capi-
tolo/4.1.1).

\ Editor

\ Dopo la selezione della funzione Vie bus, € visualizzato il box di scelta funzioni/

Vie bus F8

Impostazioni vie
bus

predisposizioni, in cui definire
¢ file via

* nome via

Come e cosa introdurre nel box di scelta funzioni/predisposizioni € illustrato nella se-
guente tabella riassuntiva:

Livello di tasti Chiarimenti
1 2
F1 Edita:
L'editor vie & avviato. Si puo ora editare la Via di Bus nel campo operativo visua-
lizzato. Ai tasti funzionali sono assegnate nuove funzionalita.
F2 Stampa
Si accede alle funzionalita relative alla Stampa Vie Bus
F3 Indice
Stampa dell'indice (vie) del file via indicato.
F4 Tutte vie
Stampa di tutti i nomi via del file via indicato.
F5 Via att.
Stampa il contenuto del nome file impostato del file via indicato.
F8 Annulla
Ritorno al livello precedente (scelta funzione).
F3 Scegli:
Viene visualizzato il box di Scelta File Via e Nome Via. Qui sono presentati tutti i
File di Via. Si puo confermare il nome del file o il nome della via sul quale si trova
il cursore.
F4 Attiva
Con questa funzione viene presentata sul video la via impostata. L'attivazione fino
al punto finale pud essere eseguita a passi con la funzione F3 = Success., oppure
in un colpo solo (F5 = Tutt)). | nodi selezionati sono contrassegnati con ™. Per le
CP H1, L2 e L1 si puo leggere l'identificazione di sistema con F1 = SISID.N. Que-
sti dati non sono modificabili.
F5 Disattiva
Viene disattivata la connessione attivata con F4. Il percorso € indicato tramite la
via impostata.
F6 Cancella
Viene cancellata la via definita dal proprio nome file via preimpostato.
F8 Annulla
Ritorno all’'ultimo menu. Si abbandona la funzione Vie bus.

STEP 5/ST V7.0
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Vie bus

Editazione
(vie bus)

Selezione nodi

Nodo di start

12-4

F1 Siinizia I'editazione di una via bus.
1. Nome via esistente.

La via viene quindi rappresentata completamente nella relativa area operativa.
I singoli nodi si possono cancellare con F6, cominciando con I'ultimo nodo.
Inserire nuovi nodi con i relativi tasti funzionali.

2. Nuova definizione via.

Si pud generare una via combinando in sequenza i nodi selezionabili. Configu-
razioni di vie non consigliabili sono accompagnate dalla segnalazione:

Via non prioritaria

Avvertenza

Le vie segnalate con Via non prioritaria vengono ugualmente memoriz-
zate. Siemens tuttavia non da garanzie per queste vie.

Premendoitastifunzionalioraindicati, viene rappresentato graficamente ilnodo asso-
ciato al relativo tasto. Successivamente & visualizzato un nuovo livello di tasti funzio-
nali, in cui selezionare un altro nodo o bus. In questi successivi livelli di tasti funzionali
sono indicati solo i nodi o i bus selezionabili per la configurazione scelta.

Indirizzi dei nodi:

Ad ogni nodo & assegnato un indirizzo tramite ponticelli, selettori 0 parametrizzazione
software. L'editor riconosce due indirizzi di nodi:

* Indirizzo (KOR/MUX, CP L1 e CP L2). In editazione bisogna introdurre I'indi-
rizzo decimale nel campo Indirizzo.

— Indirizzo KOR/MUX da 1 a 30.
— Indirizzo CP L1 da 1l a 30.
— Indirizzo CP L2 da 0 a 32.

* Indirizzo Ethernet . (riguarda solo il sistema di bus CP H1)
Gli indirizzi devono essere introdotti come numeri esadecimali.

Nel livello superiore del campo di editazione si possono selezionare i seguenti nodi
di start:

F2  PG/AS511
F3  PG/CP-H1
F4  PG/CP-L2

In Editazione questi nodi di start sono indipendenti dal tipo di interfaccia selezionata.
In funzione del nodo di start scelto, i tasti funzionali sono associati in parte a diversi
nodi.
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C79000-G8572-C920-02



Vie bus

Tasti funzionali

STEP 5/ST V7.0
C79000-G8572-C920-02

Inmodo Editazione (F1)itastifunzionali sono associati per tuttiilivelli di funzioni come

segue:

Funzione Chiarimento
F1= PUNTO FIN. | aggiunta di un nodo finale.
F2 = KOR-MUX | aggiunta bus del tipo AS511.
F3=CP-H1 aggiunta di un nodo del tipo CP-H1.
F3= BUS-AG aggiunta bus del tipo Bus-AG (bus posteriore). Consentito

solo per S5-155U.

F3= PG/CP-L2 nodo finale del tipo PG/CP-L2.
F4=CP-L2 aggiunta di nodo del tipo CP-L2.
F4 = PG/CP-H1 nodo finale del tipo PG/CP-H1.
F5=CP-L1 aggiunta di nodo del tipo CP-L1.

F6 = Canc. elem

Viene cancellato dalla via I'ultimo nodo e/o bus.

F7 = Conferma

La Via editata viene memorizzata, lo STEP 5 ritorna al
livello precedente.

— Con F3e cursore sul campo di introduzione File Via o
Nome Via si visualizza il box Scellta file e i file di via
contenuti.

— Con F3 e cursore sul campo di introduzione Nome Via si
visualizza un box di scelta, in cui sono presentate tutte le
vie esistenti nel file via impostato.

SHIFT F7 = File

Editazione di file associati a questa via.

F8 = Annulla

Ritorno al menu precedente, senza memorizzare.

SHIFT F8 = Help

Informazioni relative al significato dei tasti funzionali
attualmente visualizzati.
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Vie bus

Editazione
(file alla via)

Dopo la selezione della funzione File vengono visualizzate le quattro registrazioni file
per la via attuale. Queste possono essere editate e nuovamente memorizzate.

Conunanuovaviaoppure dopo lacancellazione delle registrazionifile vengono visua-
lizzati solo i nomi file.

Livello di tasti Chiarimenti
1 2

F1 Imposta progetto
I nomi dei file vengono presi dall’impostazione progetto.

F3 Scegli
Viene visualizzato il box "Scelta file”. In questo sono elencati i file esistenti del
tipo relativo (indipendentemente dalla posizione del cursore). Selezionarne uno e
cliccare con Conferma.

Shift F3 Cancella
Vengono cancellate le 4 registrazioni file per questa Via. Cio non provoca una
modifica nei file esistenti, ma viene soltanto annullata I'associazione tra questa
Via e i file.

F4 80/132 C.
Con F4 si pud commutare tra i file di piedinatura. Se si richiama la funzione F3 =
Scegli, sono elencati i file piedinatura corrispondenti all’impostazione attuale.

F7 Conferma
Memorizzazione intermedia delle registrazioni file finora editate e ritorno al menu ri-
chiamato. Queste registrazioni file vengono memorizzate nel file via solo dopo la me-
morizzazione della via stessa.

F8 Annulla
Interruzione dell’editazione e ritorno al menu richiamante. Tutte le modifiche apportate
nelle registrazioni file vengono annullate.

Se compare la segnalazione di errore Drive non conforme allimpostazione progetto 0 se viene visualizzata

alla richiesta di indicazione indice Indicare il drive dall'impostazione progetto , bisogna controllare che

I'indicazione del drive dei file utilizzati sia conforme con quella dellimpostazione progetto, nel caso i file selezionati deb-
bano essere acquisiti nel progetto attualmente impostato (Opzione Via nell'impostazione progetto selezionata su Con-

ferma o Sempre).

Con il tasto funzionale F1 Imposta progetto € possibile acquisire nel file via i file del progetto attualmente impostato e
quindi selezionare ed editare (F3) i nomi dei file.

12-6
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12.3 Esempio

Esempio di Si deve editare la seguente via:

editazione

PG/AS511

CP-H1 CP-H1
Indir.2 ™ Indirizzo = P.FIN.
) Ethernet: 080006010001

KOR/MUX con indir. 0

E preimpostata I'interfaccia AS511. Deve essere selezionata la funzione Editor » Vie
bus F8.

Operativita E visualizzato il box di scelta Scegli via bus.

1.
2.
3.

STEP 5/ST V7.0
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Introdurre il file via.
Introdurre un nuovo nome via.
Premere F1 = Edita

Sono visualizzati i nodi di start ed i tasti funzionali assumono nuove funzioni.
F2=PG/AS511
F3=PG/CP-H1
F4=PG/CP-L2

Premere F2 = PG/AS511.

Viene aggiunto il bus KOR/MUX.
Attivare F2 = KOR/MUX

Viene aggiunto il bus KOR/MUX.

. Attivare F3 = CP-H1.

Viene aggiunto il nodo CP-H1 con il bus SINEC H1.

. Attivare F3 = CP-H1.

Viene aggiunto il nodo CP-H1.

Successivamente si possono introdurre I'indirizzo MUX, l'indirizzo Ethernet e, se
e il caso, la password, necessari per questi nodi. A questo scopo spostare il cur-
sore su questi campi tramite gli appositi tasti.

. Attivare F1 = PUNTO FIN.

Viene aggiunto il punto finale, I'arrivo del collegamento bus. Come conlusione
del procedimento di editazione & visualizzata la seguente figura.

12-7



Vie bus

PG/AS511 Nome-Via : ESEMP1

KOR/MUX
CP-H1 Indirizzo : 0

Indirizzo
SINEC H1 Ethernet: 080006010001
CP-H1

Password:
PUNTO FIN.

La via bus & editata completamente. Deve essere memorizzata.
10. Attivare F7 = Conferma.

In questo modo la via € memorizzata nel file via ed & possibile attivarla in
qualsiasi momento.

STEP 5/ST V7.0
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Sommario Prima di stampare i vari file o prima di emetterli in un file pronto per la stampa, si deve:
* impostare i parametri per la stampante
* selezionare I'editor di piedinatura ed introdurre i testi (vedere capitol

Sommario del Capitolo Argomento trattato Pagina
capitolo 13.1 Impostazione parametri stampante 13-2
STEP 5/ST V7.0

13-1
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13.1 Impostazione parametri stampante

Sommario

Impostazioni

Operativita
\ Editor \

Parametri
stampante

13-2

Al dispositivo di programmazione possono essere collegati vari tipi di stampante e
percio é richiesta una parametrizzazione specifica per ogni stampante. Le imposta-
zioni vengono memorizzate in un file stampante (*DR.INI nella directory di sistema).

Per i diversi tipi di stampante sono disponibili file stampante gia predisposti. In essi
sono contenuti le impostazioni specifiche per la stampante ed il tipo di emissione (for-
mato vertivale, trasversale). Cliccando su File stampante nel box Imposta, pagina 2
si ottiene i file stampante (*DR.INI) disponibili nella directory di sistema. (Quando si
preme il tasto F3 viene visualizzato un box di scelta per stampante).

Nello schedario File » Progetto » Imposta (- Documentazione) selezionare il file
stampante del tipo *DR.INI. L'asterisco (*) € indicato al posto del nome di sei caratteri
del file stampante. Informazioni relative, come impostare il file, si trovano nel capitolo
4.1.1.

Viene definito un set di caratteri di comando specifica per la stampante, memorizzato
in un file stampante di tipo *DR.INI. Esso comanda fondamentalmente I'emissione
diretta sulla stampante. Con 'aiuto del box Parametrizzazione stampante € possibile
inserire i parametri in questo file.

E visualizzata la maschera di editazione Parametri stampante (vedere I'esempio sot-
tostante). llfile stampante C:HP3Q@ @DR.INI perlastampante HP 11 (C) & stato sele-
zionato nella scheda File » Progetto » Imposta (- Documentazione).

File stampante C:\STEP5\S5_HOME\HP3Q@ @DR.INI Edita
Nome Stampante: HP IIl (C)

Formato pag: : ( ) DIN A4 (X) DIN A3 Righe/Pagine: [58]

Skip_Over () Ja (X) Nein Busy : (X) Ja ( ) Nein
Tempo attesa: : [CR 0 * 25 MS] [LFO *25MS ]

Interfaccia: LPT1 () LPT2 () LPT3 () Default  (X)
Funzioni caratteri comando Sequenza caratteri comando

Sequenza iniziale

Sequenza finale

Passo di stampa (10 car/poll)
Passo di stampa (12 car/poll)
Passo di stampa (17 car/poll)
Tabulatore orizzontale

1B, 45, 00, 1B, 26, 6C, 31, 6F, 38, 44]
1B, 45, 00, 1B, 28, 31, 30, 55;
1B, 26, 6B, 31, 30, 48;
1B, 26, 6B, 30, 39, 48;
1B, 26, 6B, 30, 36, 48;

—_——————
——

Indice colonna sinistra 00; ]

F F F F F F F F Help
2 3 Scegli 4 S5Swvacome 6 Salva 7 Info 8 Annulla

F F P P F F F F Help
2 3 Edita 4 5 Svacome Sava 7 Info 8 Indietro
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Parametri del box
di dialogo

Di seguito vengono illustrati i parametri della stampante.

Campo
d’introduzione

Chiarimento

File stampante

Qui vengono memorizzate le impostazioni per la stampante. Il nome puo essere
impostato sotto File » Progetto » Imposta » Documentazione oppure si puod se-
lezionare con F5 = Salva come, nel box di scelta file, il File stampante e il Nome
stampante.

Formato pagina

A4 A3

Righe/Pagina Numero di righe per pagina.

Skip_over: Per il cambio di pagina viene emesso il carattere di comando FF (form feed). Cor-

Si rispondentemente all'impostazione RIGHE/PAGINE, quando non vi sono piu righe

No con contenuto, il resto della pagina viene emesso con righe vuote.

Busy Non rilevante per PT88/PT89/PT10. Solo stampanti di vecchio tipo ne fanno uso.
Dopo ogni carattere trasferito alla stampante, si attende una risposta prima di in-
viare un nuovo carattere. Questo vale solo per un determinato TEMPO DI AT-
TESA.

No Non si attende una risposta.

Si Si attende una risposta.

Tempo Att. Viene impostato il tempo di attesa della risposta (in millisecondi).

CR - per cambio riga
LF - per cambio pagina
Interfaccia Si puo scegliere tramite quale interfaccia - LPT1, LPT2 o LPT3 - I'informazione

viene trasferita alla stampante. L'interfaccia scelta viene contrassegnata. DE-
FAULT ¢ assegnato a LPT1. | file stampante sono preimpostati a LPT1 (X).
Quando il PG viene fornito, LPT1 (S5LPT1) e assegnato all'interfaccia parallela.
Non sono assegnate ulteriori interfacce a LPT2 e LPT3 per il collegamento alla
stampante.

Funz. Caratt. Comando

E possibile editare una sequenza di caratteri di comando specifici per la stam-
pante. Una sequenza di caratteri pud essere composta al massimo da 127 byte.
Sono permessi solo caratteri esadecimali.

Sequenza iniziale

Prima di ogni ordine di stampa viene trasmessa alla stampante una sequenza
iniziale.

Sequenza finale Dopo ogni ordine di stampa viene trasmessa alla stampante una sequenza finale.
Passo scrittura Qui viene impostata la densita di scrittura della stampante.

(10 car/pollice) NORMALE

(12 car/pollice) RISTRETTA

(17 car/pollice) SUPERSTRETTA

Tabulatore orizzontale

Esso permette alla testina della stampante di posizionarsi sulla colonna iniziale. Il
codice per l'introduzione dinamica di questa posizione calcolata & 00. Viene cal-
colata la posizione successiva con una carattere stampabile a partire dalla posi-
zione instantanea della testina della stampante ed il numero di spazi successivi.
Questa posizione viene inserita nella sequenza di caratteri di comando.

Indice colonna sinistra

Qui viene calcolato il codice per il tabulatore orizzontale. Esso é I'indice della co-
lonna di sinistra della pagina della stampante e definisce se inizia con 0 oppure 1.

STEP 5/ST V7.0
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Nomi di stampanti

Chiarimenti sui nomi di stampanti dei file stampante forniti nella directory di sistema:

Nome Significato
Emul. Emulazione
A3, Ad Formato carta: A3, A4
Norm. Tipo di scrittura: normale
Comp. Tipo di scrittura: compatto
L/P Righe/pagina
© contrassegna stampanti di altri costruttori per il loro funzionamento impeccabile

la Siemens non assume alcuna garanzia.

Tasti Funzionali

In questa maschera di editazione si attivano determinate funzioni mediante tasti
funzionali.

Tasto

Funzione

F3

1. (Scegl)

Quando il cursore si trova su un campo nel quale possono essere impostati pa-
rametri diversi, viene visualizzato il tasto funzionale Scegli. Con F3 si seleziona
un parametro.

2. (Edita)

Se il cursore si trova su un campo nel quale possono essere introdotti caratteri,
viene visualizzato il tasto funzionale Edita. Con F3 il cursore si porta sul campo
di caratteri.

3. (Edita funzione caratteri comando)

Anche quando il cursore si trova sul campo di Funzione caratteri comando,
viene visualizzato il tasto funzionale Edita. Con F3 si apre una finestra di edita-
zione nella quale possono essere introdotti caratteri di comando specifici della
stampante. Le introduzioni devono essere confermate con il tasto INSERT.

F5
= Salva_ come

Premendo questo tasto, viene richiamato il box di scelta file per File stampante
e Nome stampante, salva come. Il cursore si trova sul campo File stampante. E’
possibile selezionare un file stampante (doppio click) oppure introdurne uno
nuovo. Con il tasto di introduzione si memorizzano sotto questo nome i parame-
tri impostati.

F6
= Salva

Memorizzazione dei parametri impostati nel file-stampante corrente.

F7
= Info

Emissione di un testo INFO relativo al campo sul quale si trova il cursore. Que-
sti testi vengono abbandonati con i tasti cursore (- Appendice, Assegnazione
della tastiera).

F8
= Annulla

Ritorno al livello richiamante.

13-4
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Sommario

Sommario del
capitolo
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14

Con questa funzione ¢ possibile generare un nuovo file di piedinatura o modificarne
uno gia presente. In relazione al numero di caratteri della piedinatura, viene visualiz-
zata una diversa finestra di editazione nella quale & possibile definire liberamente i
testi di piedinatura. Il campo in cui & possibile effettuare introduzioni € visualizzato
in modo evidenziato. Campi contrassegnati con ## non possono essere sovrascritti
in quanto contengono testi inseriti automaticamente quali, per esempio

* SIMATIC S5

¢ file programma

* blocco

* segmento

* numero pagina

5_ Test AG Gestione Docu (
‘ Blocco STEP 5 ... F1

Blocco dati ... F2

Maschera DB ... Ctrl+F1

Lista di attribuzione F7

Vie bus F1

Parametri stampante  Ctrl+F4

'Editor piedinatura ~ Ctrl+F5

Capitolo

Argomento trattato

Pagina

141

Editazione piedinatura

14-2
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Editor di piedinatura

14.1 Editazione piedinatura

Impostazioni

Operativita

\ Editor

Editor
piedinatura

Finestra di
editazione

14-2

Selezionare sotto File » Progetto »Imposta (- Documentazione)unfile piedinatura
deltipo*Fx.INI. L'asterisco (*) &€ indicato al posto del nome di sei caratteri del file piedi-
natura, x=1per piedinaturalarga 80 caratterie x=2 per piedinaturalarga 132 caratteri.
Informazioni relative, come impostare il file, si trovano nel capitolc 4.1.1.

Dopo aver attivato la funzione di piedinatura viene visualizzata una finestra di edita-
zione. Essa e relativa al numero di caratteri della piedinatura preimpostato. Il campo
superiore costituisce il campo d’introduzione e solo qui possono essere definiti i
testi. Il campo inferiore costituisce invece la piedinatura che "registra” i testi intro-
dotti. | testi possono essere inseriti nei campi evidenziati della piedinatura, quando
il campo d’'introduzione € attivo. Per rendere attivo il campo d’introduzione, bisogna
premere F1 = Int.testo. Nel corso del capitolo (- Operativita dei tasti per la piedina-
tura) si prendera confidenza con le funzioni dei tasti, che sono rilevanti per I'Editor
della piedinatura.

Avvertenza

Campo d'introduzione Data:
Nella stampa tramite emissione confortevole (KOMDOK) la data viene sempre
sovrascritta con la data di sistema attuale.

Le zone contrassegnate con ### non possono essere sovrascritte.

Il video visualizza la finestra di editazione per la piedinatura di 132 caratteri. Nella
finestra per 80 caratteri la piedinatura dispone solo di 4 campi. In alto a sinistra viene
visualizzato il nome del file. In alto a destra se il file viene generato o modificato.

FILE PIED.: C:NONAMEF2.INI Modifica

Campo d’introduzione

Data:
Piedinatura

* #H

#HH#
##
HAHHIR | i it
F F F F F F F F Help
1 Int. testo 2Fine testo 3 4 ->80car.5 gy come 6Conferma 7 8 Annulla

Figura 14-1 Finestre di editazione per piedinature di 132 caratteri

STEP 5/ST V7.0
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Editor di piedinatura

Operativita dei Con i tasti da F1 a F8si attivano le seguenti funzioni:
tasti
Tasto Funzione

F1 = Int. testo

Introduzione di un testo nella finestra sopra visualizzata

F2 = Fine testo

Conclusione dell'introduzione del testo

F4

80 caratteri
Commutazione della larghezza della piedinatura su 80 caratteri

132 caratteri
Commutazione della larghezza della piedinatura su 132 caratteri

F5 = Salva come

Premendo questo tasto, viene richiamato il box di scelta file per il File piedinatura,
salva come. |l cursore si trova sul campo File piedinatura. Con F3 oppure un dop-
pio click & possibile selezionare un file.

F7 = Conferma

Memorizzazione del file piedinatura modificato

F8 = Annulla

Interruzione e ritorno al livello precedente

SHIFT F8 = Help

STEP 5/ST V7.0
C79000-G8572-C920-02

Cursore sulla piedinatura:  (SHIFT + un tasto cursore)
(4) Posiziona il cursore sul campo adiacente della piedinatura verso sinistra.
(6) Posiziona il cursore sul campo adiacente della piedinatura verso destra.

(2) Posiziona il cursore sul campo adiacente della piedinatura verso il basso
(8) Posiziona il cursore sul campo adiacente della piedinatura verso l'alto
(anche senza SHIFT).

Cursore sul campo d’introduzione

(4) Posiziona il cursore sul carattere precedente.
(6) Posiziona il cursore sul carattere successivo.

(2) Posiziona il cursore sulla riga successiva. Se nel far cio il cursore esce dal
campo d’introduzione, l'introduzione del testo viene conclusa.

(8) Posiziona il cursore sulla riga precedente. Se nel far cid il cursore esce dal
campo d’introduzione, l'introduzione del testo viene conclusa.

Cancellazione carattere

Il carattere sul quale si trova il cursore viene cancellato ed i caratteri successivi ven-
gono spostati.
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Sommario

Premessa

/N

Sommario del
capitolo

STEP 5/ST V7.0
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In questo sottomenu si trovano le funzioni per il test, I'informazione e la messa in
servizio, che si possono eseguire in funzionamento online del PG.

]
\_AG Gestione Documentazion (

a

Stato blocco ... Shift+F6
Stato variabile Shift+F7
Forza variabili Shift+F8
Forza uscite Shift+F5

Controllo elaborazione ON ...
Controllo elaborazione OFF

Premessa per I'esecuzione delle funzioni online &€ un collegamento fisico e logico tra
PG e AG. Oltre ad un cavo di collegamento, bisogna provvedere ad una corretta via
bus (SINEC H1, SINEC L2 o0 anche AS511) ed impostare sul PG il modo di funziona-
mento.

Pericolo

L'interruzione dei cavi di collegamento non & consentita se le funzioni online sono
attive.

Potrebbero verificarsi errori funzionali gravi, come lo STOP dell’AG o la caduta
del programma nel PG.

Capitolo Argomento trattato Pagina
15.1 Funzioni online 15-2
15.2 Stato blocco 15-3
15.3 Stato variabile 15-7
15.4 Forzamento variabili 15-12
15.5 Forzamento uscite 15-14
15.6 Controllo elaborazione ON 15-16
15.7 Controllo elaborazione OFF 15-17
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15.1 Funzioni online

Sommario

La seguente tabella fornisce un sommario sulle funzioni online possibili.

Le seguenti funzioni di test

* visualizzazione stato degli operandi (Stato variabile)

e forzamento di segnali di uscita (Forza uscite) e

* Forzamento variabili di processo (Forza variabili)

richiedono un elenco divariabili di processo, che sipud memorizzare dopol'editazione
in un blocco immagine (BBnn (1 <=nn <= 255)). In questo modo non & piu hecessaria
I'introduzione degli operandi ad ogni richiamo di una funzione di test. | blocchi imma-
gine sono memorizzati nel file programma.

Funzione online Stato AG Elaborazione in AG Chiarimento

Stato blocco RUN Punto di controllo Test di una sequenza di istruzioni nel
utente programma

Stato variabilil RUN Punto di controllo di | Emissione stato di variabili
sistema (E,A,M, S, T,2,D)

Start AG STOP > RUN | Start ciclo Come per comando manuale

Stop AG RUN > STOP | Stop ciclo Come per comando manuale

Compressione RUN, STOP Area RAM AG Compressione memoria

memoria

Forzamento RUN Punto di controllo di | Modifica di variabili di processo

variabilil 2 sistema (E,A,M, S, T, 2, D)

Forzamento uscitel | STOP Punto di controllo di | Impostazione dei segnali di uscita su stati
sistema periferia determinati (AB, AW, AD)

REG.INT./ REG.BL. |STOP Memoria AG, Emissione registro interruz. / registro
area di sistema blocchi

Emissione contenuto | RUN RAM/EPROM, bus Emissione in esadecimale di indirizzi di

memoria STOP S5, periferia memoria e periferia

Configurazione RUN STOP RAM-AG, EPROM Dati relativi alla memoria utente in AG

memoria (RAM/EPROM)

Parametri sistema RUN Versione SW AG, Info relative a configurazione interna AG

STOP CPU e versioni SW (CPU)

Controllo elaboraz. CONTR.EL Punto di controllo Test di singoli passi di programma:

ON utente PB, FB, FX, OB, SB, ricerca

Controllo elaboraz. CONTR.EL > [ Punto di controllo Fine controllo elaborazione; eseguito

OFF STOP utente direttamente

1 Gli elenchi degli operandi sono memorizzabili in blocchi immagine.

2 Il forzamento variabili € possibile anche Offline per I'editazione di blocchi immagine.

15-2
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15.2 Stato blocco

\ Test

Con questa funzione si possono testare e correggere i blocchi caricati in AG (me-

Stato blocco moria utente). Lo STEP 5 emette lo stato attuale delle seguenti variabili:

ingressi (E), temporizzatori (T) e contatori (Z)
uscite (A) (tipo parametro A delle sigle di un FB (FX))
merker (M, S)

dati (D) (i dati sono in funzione del DB richiamato al momento dell’emissione).

Per I'elaborazione di stato sussistono le seguenti limitazioni:

L'emissione dello stato dei parametri attuali di blocchi funzionali & possibile
solo per S5-135U, S5-155U e S5-115U.

Nelle dichiarazioni dei parametri (parametri formali) e le istruzioni LIR in FB o
FX non é visualizzato lo stato dei segnali.

Le istruzioni BDW/BMW sono elaborate assieme all'istruzione successiva
come un’unica istruzione. Viene pertanto emesso lo stato relativo all'istruzione
successiva.

Alcune istruzioni concludono I'elaborazione di stato, poiche la loro esecuzione
conduce al sistema operativo o in altri blocchi, come p. es. LIR, BEB ed anche
tutti i salti ed i richiami blocchi.

Un’hardcopy & possibile dopo l'interruzione dell’elaborazione di stato.

Durante I'elaborazione di stato in corso, non € possibile 'uso del mouse.

Introduzione Dopo lasceltafunzioni nelmenu Test appare il box di scelta Stato blocco, in cui specifi-
care il blocco da testare (— Interfaccia operatore, Box di comando, capitolo 3.6).

Campo Chiarimento
d’introduzione

Blocco — senza concatenamento: introdurre il tipo ed il numero di
blocco oppure il nome simbolico del blocco.

— con concatenamento: nella prima posizione il blocco da
testare e quindi la catena dei blocchi (max. 5) concatenati
nel programma, attraverso i quali si deve visualizzare lo
stato per il test.

Crit. ricerca Qui si puo introdurre il criterio di ricerca all'istruzione da

testare. Lo STEP 5 ricerca automaticamente questa istru-
zione ed emette sul video la parte di blocco relativa. Nel
box di help sono elencati tutti i possibili criteri.

STEP 5/ST V7.0
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Sovrascrit- In questa finestra si introduce se dopo una modifica si
tura vuole sovrascrivere direttamente il vecchio blocco o solo
dopo conferma.
File sorgente Contrassegnare qui se si vuole 'aggiornamento del file
seq. Z0.SEQ oppure no.
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Esempio di un
concatenamento

Rappresenta-
zione dello stato
dei segnali su
video

Esempio in FUP

15-4

Si deve visualizzare lo stato di FB21, richiamato da PB2. In questo caso introdurre
nella lista blocchi: FB 21, PB 2, OB 1

Concatenamento dei blocchi: Lista blocchi:

BLOCCO 1: FB 21

BLOCCO 2: PB 2

0oB1
BLOCCO 3: OB 1
SPA PB1
PB1 PB4 FB21
PB PB2

S PB2

SPA PB3 B3 S
AWL: Gli stati dei segnali sono emessi come elenco di

informazioni di stato.

KOP/FUP: Nello schema a contatti e nello schema logico

'emissione dello stato dei segnali avviene mediante
una diversa rappresentazione delle linee di collega-
mento.

Stato segnale 1
Stato segnale 0

Stato segnale non rappresentabile (p.es. al di fuori
delle 20 istruzioni rappresentabili; il numero delle
istruzioni dipende dall’AG.)

Dopo I'OK, il PG inizia I'elaborazione di stato ed emette in FUP, p. es. la seguente

immagine:

PB1

Segmento 1

E320 - -1 &
E321 ==

0000 Esempio 1

E A32.0
L. E M 1.1

Figura 15-1 Elaborazione di stato

L'immaginenon éaggiornataad ognielaborazione ciclica. Tutte le funzionirichiamabili
tramite tasti funzionali (— Editor, Blocco STEP 5, capitolo 5.1) sono eseguibili durante
I'elaborazione di stato.

Avvertenza

Non é possibile visualizzare gli indirizzi.
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Esempio in AWL In AWL, lo STEP 5 emette la seguente rappresentazione della maschera (esempio):
PB1 IND.-DB=0000 LUN=35
Segmento 1 Stato AWL RLC St/ACCU1 —ACCU2—— Stato IND
U E 320 0 0 00000000 D054
U E 321 0 1 00000000 D056
= A 320 0 0 00000001 D058
= M 11 0 0 00000001 DOSA

s

Segmento 1

1a%

Nome
INGR1 :
USC1
INGR2 :

:SPA PB
UN T
L KT
SV T
L T
T KT
:SPB FB

TEST

M
MW
MW

:BE

IND.-DB= LUN=20\

Stato AWL RLC St/ACCU1l ——ACCU2—— Commento riga
1 start temporizz.

10.0
12
12

L'immagine non € aggiornata ad ogni ciclo di elaborazione. Tutte le funzioni richiama-
bili tramite tasti funzionali (- Editor, Blocco STEP 5) sono eseguibilidurante I'elabora-
zione di stato con eccezione della funzione di visualizzazione indirizzi.

Abbreviazioni RLC

STATO

DBy
ACCU 1
ACCU 2

Abbreviazioni STATO

IND
Codici relativi all’emissione di stato:

L
A

mwn o<

STEP 5/ST V7.0
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Risultato logico combinatorio
Operandi a bit

Blocco dati attuale
Contenuto ACCU 1
Contenuto ACCU 2

Visualizzazione risultato
Contatore indirizzi Step

Tempo che scorre

Bit negato su interrog., cioé per interrog. UT (timer AND) il
risultato & 0.

Ingresso di conteggio avanti
Ingresso di conteggio indietro
Ingresso di set o di start
Ingresso di abilitazione
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Elaborazione stato
blocco

E costituita dalle seguenti azioni:

Azione Operativita Segnalazioni/Chiarimenti
Spostamento Mediante i tasti cursore o Cerca posi- Lo STEP 5 prosegue con 'elaborazione
punto di alt zionare il cursore prima dell’operando di stato. Segnalazione: Elaboraz.

desiderato. Richiamare altri segmenti sul
video con i tasti cursore o con + / —.

stato in corso

Interruz. elaboraz.

Premere una volta ESC = Annulla

La segnalazione: Elaboraz. stato
in corso  scompare.

Prosec. elaboraz.

Premere INSERT = Conferma.

Segnalazione: Elaboraz. stato in
corso .

Correzione Premere F6 = Edita Elaborazione stato interrotta ed entrata
programma Stesse modalita dell’editazione. in modo Editor.
Conferma 1. Premere INSERT = Conferma. Richiesta: Conferma segmento mo-
correzione 2. Confermare con Si. dificato? ...Gia in AG, sovra-

3. Confermare con Si, nel caso si voglia | scrivere? . Il blocco corretto si trova in

"Sovrascrittura”

AG e I'elaborazione viene proseguita.

Interruzione/
conclusione
elaborazione

=

Premere due volte ESC = Annulla
2. Confermare con Si.

Richiesta: Abbandono stato?

Possibili segnalazioni

Cause:

Istruzione non elaborata -

Blocco non richiamato

Istruzione saltata

Blocco della catena non esistente
AG in STOP

Blocco non esistente in AG -

Blocco da testare non esistente
Il blocco da testare richiama un altro
blocco, che non esiste in AG.

15-6
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Test

15.3 Stato variabile

\ Test

Stato variabile

Nel sottomenu
relativo sono
utilizzabili:

Domanda di
sicurezza

STEP 5/ST V7.0
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Con l'ausilio di questa funzione si pud emettere sotto forma di lista lo stato attuale
dei segnali di operandi selezionati, come si trovano durante I'elaborazione nel punto
di controllo di sistema (- Appendice, Glossario).

Gli operandi da controllare (variabili di processo) si introducono in una lista, emessa
vuota dallo STEP 5 dopo il richiamo della funzione di test Stato variabile.

Con F6 = Attivo o con il tasto Conferma viene visualizzato lo stato attuale di segnale
degli operandi elencati.

Durante I'elaborazione gli operandi elencati sono richiamati ed il loro stato viene
emesso, prima che siano modificati dal programma utente.

Operandi: Formati:

F F F F F
1 Preleva 2 3 cancella 4 Blocco 5Sv.come

Figura 15-2 Tabella vuota per I'editazione della lista operandi

Tasto Funzione

F1= Preleva Richiamo di un blocco immagine.

F3 = Cancella Cancellazione della riga attuale.

F4 = Blocco Emissione di variabili a blocchi, tramite i tasti + 0 — si puo
prelevare il blocco di variabili prec. o succ.

F5 = Sv.come Salvataggio dela lista operandi come blocco immagine.

F6 = Attivo Attivazione elaboraz. stato (= Conferma). Solo eseguibile se

stato registrato almeno un operando.

F7 = Salva Salvataggio della lista operandi nel blocco immagine attuale
(solo eseguibile se ¢ stato registrato almeno un operando).

F8= Annulla Ritorno alla scelta menu.

SHIFT F8 = Help Informazioni su certe procedure

Se, durante l'introduzione della lista operandi sono state eseguite delle modifiche che
non sono memorizzate in un blocco immagine, allora compare una domanda di sicu-
rezza, da confermare con S/ opp. No.

e Annulla= ESC
e F[8 =Indietro
e F[1 = Preleva

Il testo della domanda di sicurezza dipende dal fatto se € elezionato un blocco imma-
gine o no.

Nessun blocco immagine selezionato: Annullare modifiche?

Blocco immagine selezionato: Annullare blocco immagine
modificato?
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Editazione della li-
sta degli operandi

15-8

Azione Reazione in casodi Si Reazione in caso di No
Annulla Modifiche vengono Continuazione dell’editazione della
F8 = annullate; lista operandi; le modifiche possono
Indietro | STEP 5 emette il ment di | SSere memorizzate in un blocco

funzioni. immagine.
Nota: la memorizzazione delle
modifiche deve essere eseguita come
sequenza operativa (F5 = Salva_come
opp. F7 = Salva).
Fl= Modifiche vengono Continuazione dell’editazione della
Preleva annullate; lista operandi; le modifiche possono

Dopo la compilazione
della riga di comando
viene indicato il blocco
immagine BBnn.

essere memorizzate in un blocco
immagine.

Nota: la memorizzazione delle
modifiche deve essere eseguita come
sequenza operativa (F5 = Salva_come
opp. F7 = Salva). Richiamo di un
nuovo blocco immagine con F1 =
Preleva.

Nella lista operandi si possono introdurre i seguenti operandi:

Operando Formato dati consentito
M/A/EIS KM

MB/AB/EB/SY KH (KM, KY, KC, KF)
MW/AW/EW/SW KH (KM, KY, KC, KF, KT, KZ)
T KT (KM, KH)

z KZ (KM, KH)

DW/DL/DR KH (KM, KY, KC, KF, KT, KZ)
DB -

MD/AD/ED/DD/SD KH (KG, KY KC)

Dopo lintroduzione di un operando il PG emette il relativo formato, che nella tabella
riportata sopra non si trova tra parentesi. Questo pud essere sovrascritto.

Nella lista, agli operandi DD, DW, DB, DL, DR, bisogna anteporre il relativo blocco
dati. In caso contrario il PG segnala

Nessun DB selezionato

Lasequenzad’introduzione caratteri (sintassi) di un operando varispettata, altrimenti
il cursore resta nel campo d'introduzione.

La lista degli operandi pud essere memorizzata in un blocco immagine (BB). Un
blocco immagine esistente puo essere richiamato con la funzione F1 =Preleva.

Avvertenza

Il blocco immagine (BB) memorizzato per ultimo viene caricato automaticamente
al richiamo di stato variabili.

STEP 5/ST V7.0
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Operazioni di
editazione
Funzione Operazione Segnalazioni/Chiarimenti
Introduzione 1. Dopo lintroduzione operando Lo STEP 5 propone di volta in volta il for-
operandi Premere freccia larga a destra mato dati. Il cursore si trova sul formato.
2. Modificare o lasciare inalterato Il cursore salta all'inizio della nuova riga.
il formato
3. Concludere la riga con il tasto
d'introduzione
Correzione Sovrascrivere l'introduzione errata Il cursore non abbandona il campo d'in-
troduzione fin tanto che la sintassi non &
corretta.
Inserimento 1. Posizionare il cursore con gli
operandi appositi tasti (su/giu)

N

Premere I' inserimento verticale
3. Introdurre I'operando

Anteposizione di
operandi

1. Posizionare il cursore sulla riga piu in
alto

2. Premere I'inserimento verticale

3. Introdurre I'operando

Si possono aggiungere operandi alla li-
sta, quando il cursore €& posto sotto I'ul-
tima riga.

Cancellazione
operandi

1. Portare il cursore sul primo carattere
dell’'operando

2. Premere ripetutamente
cancellazione carattere

Cancellazione
riga

1. Portare il cursore sulla prima riga da
cancellare
2. Premere F3 = Cancella

La riga attuale viene cancellata, ope-
rando e formato inclusi ed le successive
righe occupano il posto diventato libero.

Prelievo lista
operandi

1. Premere F1 = Preleva
2. Compilare la riga di comando
Emiss. blocco immagine BBnn

Se sono state eseguite precedenti modifi-
che, che non sono state memorizzate in
un blocco immagine, compare per sicu-
rezza una richiesta (Perdita modifi-

che? oppure Perdita blocco modifi-

cato? ).

Se non sono state eseguite modifiche op-
pure si conferma con Sj alla richiesta di
sicurezza, lo STEP 5 preleva la lista degli
operandi dal blocco immagine BBnn,
dopo la compilazione della riga di co-
mando.

Salvataggio lista
operandi

Premere F7 = Salva

Lo STEP 5 salva la lista degli operandi
nel blocco immagine attualmente selezio-
nato. Al contrario di F5 = Salva come,
non viene indicato nessun numero di
blocco immagine. La funzione é esegui-
bile solo se e selezionato un blocco im-
magine.

Memorizzazione
lista operandi

=

Premere F5 = Salva come
2. Compilare la riga di comando
Memorizz. blocco immagine BBnn

Lo STEP 5 memorizza la lista operandi
dal blocco immagine BBnn.

Prelievo a blocchi
lista operandi

L

Premere F4 = Blocco

2. Compilare la riga di comando
Emissione blocco da variabile:
AB 26 Formato: KH

Lo STEP 5 genera sul video una lista
operandi con 20 byte consecutivi a par-
tire da AB 26.

STEP 5/ST V7.0
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Emissione stato
degli operandi (va-
riabili di processo)

15-10

La lista operandi pud comprendere al massimo 20 operandi (10 a word, 5 a doppia
word).

Nella parte inferiore del video compare la percentuale di occupazione della lista ope-
randi.

Gli stati attuali delle variabili nella lista operandi vengono emessi prima che il pro-
gramma utente li modifichi (nel punto di controllo di sistema). Se una lista operandi
e stata editata sul video o € stata prelevata,

* Premere F6 = Attivo o Conferma.
Il PG emette lo stato delle variabili elencate e la segnalazione

Elaboraz. stato in corso

BB 5 C:PROBSPST.S5D AG in ciclo
Operandi: Stato segnali:
—COMMUT.PRINC. E 32.0 KM=1
—EMERGENZA E 32.1 KM=0
-E32.2 E 32.2 KM=1
—-AUTO IN POSIZ. E 32.3 KM=0
—STRUTT. AVANTI E 324 KM=0
—STRUTT. IND. E 325 KM=0
—PORTA APERTA E 32.6 KM=0
—PORTA CHIUSA E 32.7 KM=1
START E 33.0 KM=1
AVANZ. STRUTT. A 32.0 KM=0
RITORNO STR. A 32.1 KM=0
CHIUSURA PORTA A 32.2 KH=00

1184: Elaboraz. stato in corso

n

Figura 15-3 Lista operandi con ingressi/uscite binari ed un merker
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Operazioni du-
rante I'elabora-
zione di stato

Possibili
segnalazioni e
operazioni errate

STEP 5/ST V7.0
C79000-G8572-C920-02

Azioni

Operativita

Segnalazioni/Chiarimenti

Interruzione
elaborazione stato

Premere Annulla

Il cursore salta sulla prima riga
della lista operandi.

Prosecuzione
elaborazione stato

Premere F6 = Attivo

Lo STEP 5 emette nuovamente lo
stato delle singole variabili.

Conclusione/interruz.
elaborazione stato

Premere 2 volte
Annulla

Se sono presenti delle modifiche
non ancora memoaorizzate in un
blocco immagine, compare una
domanda di sicurezza: (Annul-
lare le modifiche? oppure
Annullare blocco modifi-

cato? .

Se non sono state eseguite modi-
fiche oppure la domanda di sicu-
rezza viene confermata con Si, lo
STEP 5 emette il menu funzioni.

Segnalazioni Cause
Nessun DB Ad un operando manca l'indicazione del blocco dati relativo.
richiamato

KH=* elemento
dati mancante

troppo piccolo.

Il blocco dati relativo all’'operando indicato (DD, DW, DB, DL,
DR) non € in memoria AG oppure il numero di parole dati &

KT = fermo Il temporizzatore selezionato non € stato attivato (avviato).
KH=*DB Il blocco dati non esiste nel file programma selezionato.
mancante

* non consentito

Operando in AG non consentito
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15.4 Forzamento variabili

\ Test

Forza variabili

Procedimento

Operativita

Editazione lista
operandi

15-12

Questa funzione online consente la modifica delle variabili e I'accesso diretto al
processo. Bisogna pertanto considerare, prima del forzamento (modifica) delle
variabili, le possibili reazioni del processo!

Si possono modificare le variabili E, A, M, S, T, Z, D. Il PG puo agire sulle va-
riabili E, A e M solo a byte o a word nellimmagine di processo.

Per le variabili T e Z nel formato KM e KH bisogna fare attenzione al comando
del fronte di salita.

La funzione é eseguibile con il controllore programmabile in STOP e in RUN.

La visualizzazione dello stato di segnale € interrotta, nel caso di introduzione
di un operando o di un formato errato.

Lo STEP 5 segnala: Forzamento non possibile

Poiche lo STEP 5 esegue le modifiche a byte, le variabili non sono modificabili
a blocchi.

Per lavorare con la funzione Forza variabili, si consiglia il seguento procedimento:

1.

Richiamare Test » Forza variabili .

Lo STEP 5 propone una tabella vuota per la scrittura della lista operandi
quando non sono inserite delle variabili. Altrimenti viene emesso il blocco im-
magine memorizzato per ultimo.

Editare la lista operandi e concludere con Conferma .

Viene visualizzato lo stato delle variabili.

Interrompere la visualizzazione dello stato con ESC.

Viene visualizzata la lista operandi con i valori attuali.

Madificare i valori attuali e concludere il procedimento con Conferma .

Si puo ripetere il procedimento dal punto 2.

Dopo la selezione della funzione Forza variabili, lo STEP 5 emette la tabella vuota
per I'editazione della lista operandi (figura 15-3), oppure il blocco immagine selezio-
nato per ultimo in Forza variabili.

Operando Formati consentiti

M/A/E/S D) KM

MB/AB/EB/SY KH (KM, KY, KC, KF)
MW/AW/EW/SW KH (KM, KY, KC, KF)
T KT (KM, KH)

z Kz1) (KM, KH)
DW/DL)/DRY) KH (KM, KY, KC, KF)
DB -

MD/AD/ED/DD/SD KH (KG, KY, KC)

-Simbolo dipendente dal tipo di operando

1) Questi operandi e formati possono essere solo visualizzati (non forzati).

STEP 5/ST V7.0
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Emissione stato
degli operandi (va-
riabili di processo)

Impostazione delle
variabili con il PG

Modifica dei valori
delle variabili

STEP 5/ST V7.0
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Dopo l'introduzione di un operando a byte o aword, STEP 5 emette il relativo formato,
che nellatabellariportata sopra non si trova tra parentesi. Questo puo essere diretta-
mente sovrascritto con un’introduzione.

Per gli operandi DD, DW, DB, DL, DR, bisogna introdurre il relativo blocco dati nella
lista operandi. In caso contrario STEP 5 segnala

Nessun DB selezionato.

Lasequenzad’introduzione caratteri (sintassi) di un operando varispettata, altrimenti
il cursore resta nel campo d’introduzione.

La lista degli operandi pud essere memorizzata in un blocco immagine (BB). Un
blocco immagine esistente puo essere richiamato con la funzione F1 = Preleva.

La lista pud comprendere al massimo 20 operandi (10 aword, 5 a doppia word). Nella
parte inferiore del video appare di volta in volta la percentuale di occupazione della
lista operandi.

Le possibili operazioni di editazione sono uguali a quelle della funzione Stato variabili.

Avvertenza

Il blocco immagine (BB) memorizzato per ultimo viene caricato automaticamente
al richiamo di Forza variabili.

Gli stati attuali delle variabili nella lista operandi possono essere emessi.
Se una lista operandi é stata editata sul video o & stata prelevata,
* premere F6 = Attivo o Conferma .

Il PG emette lo stato delle variabili elencate e la segnalazione Elaboraz. stato
in corso

Se si vuole interrompere 'elaborazione di stato,
* premere ESC = Annulla

Il cursore salta sulla prima riga della lista degli operandi.

E emesso sul video lo stato attuale delle variabili elencate. | valori delle variabili visua-
lizzate possono essere ora modificati in AG (forzamento variabili).

Il PG emette la lista degli operandi con la colonna Stato segnaliin cui sono visualizzati
gli statimomentaneideisegnali. Sonoinoltre visualizzatila segnalazione Elaboraz.
stato in corso e il funzionamento dell’AG.

1. Premere ora una volta ESC = Annulla

Il PG ridefinisce ora la colonna Stato segnali con Forza immag. processo ed
attende I'introduzione dei valori di comando. Il cursore salta sulla prima riga.

2. Introdurre per ciascuna riga i valori desiderati e concludere ogni introduzione
con il tasto di introduzione
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L'introduzione dei valori delle variabili viene terminata
3. premendo Conferma .

Lo STEP 5 emette la segnalazione Forzamento eseguito e trasferisce le
variabili modificate in AG.

4. premendo Conferma .

Il PG ridenomina la colonna Forzamento in Stato segnale. Gli stati di segnale
modificati possono essere visualizzati.

Se si vuole interrompere il forzamento delle variabili,
5. premere 2 volte ESC = Annulla

Se sono presenti delle modifiche non ancora memorizzate in un blocco imma-
gine, compare una domanda di sicurezza: (Annullare le modifiche?

oppure Annullare blocco modificato? . Se non sono state eseguite
modifiche oppure la domanda di sicurezza viene confermata con Si, lo STEP
5 emette il menu funzioni. Leggere al riguardo il capitolo|15.3 Stato Variabile.

15.5 Forzamento uscite

\ Test

Forza uscite

Procedimento

15-14

Con questa funzione € possibile impostare direttamente le uscite sullo stato desi-
derato. La funzione non ha nessun effetto sull'immagine di processo o sull’elabo-
razione, poiche il controllore programmabile deve essere in STOP.

Le uscite di un controllore programmabile (AG) sono comandabili singolarmente. E
pertanto possibile verificare la loro corretta assegnazione agli attuatori (p.es. elettro-
valvole, motori di un impianto). In questo modo si riconoscono unita di uscita guaste
0 non inserite e anche errori di cablaggio.

Non sono consentiti formati a bit singoli, ma soltanto a byte, a word o doppia word.

La funzione Forzamento uscite viene eseguita come segue:
1. Mettere 'AG in STOP
2. Richiamare Forza uscite.

Lo STEP 5 emette una tabella vuota per la scrittura della lista degli operandi.
Altrimenti viene emesso il blocco immagine memaorizzato per ultimo.

3. Editare la lista operandi e concludere con Conferma .

4. Introdurre o modificare i valori desiderati e concludere il procedimento con
Conferma .

Il PG trasferisce i valori sulle uscite dell’AG.
Il procedimento puo essere ripetuto dal punto 3.

Dopo la selezione della funzione Forza uscite, lo STEP 5 emette la tabella vuota per
I'editazione dellalista operandi(figura 15-3) opp.I'ultimobloccoimmagine selezionato
con Forza uscite.

STEP 5/ST V7.0
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Editazione lista
operandi

Introduzione
operandi

Impostazione delle
variabili di uscita
con il PG

Modifica dei valori
di uscita

Correzioni
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Operando Formato

AW KH (KM)

AW KH (KM)

AD KH (KM)

-Simbolo dipendente dal tipo di operando

Dopo l'introduzione di un operando, lo STEP 5 emette il relativo formato, che nella
tabella riportata sopra non si trova tra parentesi. Questo puo essere direttamente so-
vrascritto con un’introduzione.

Lasequenzad’introduzione caratteri (sintassi) di un operando varispettata, altrimenti
il cursore resta nel campo d’introduzione.

Lalistadeglioperandipud essere memorizzatain unbloccoimmagine (BB). Unblocco
immagine esistente puo essere richiamato con la funzione F1 = Preleva.

La lista pud comprendere al massimo 20 operandi (10 aword, 5 a doppia word). Nella
parte inferiore del video appare di volta in volta la percentuale di occupazione della
lista operandi.

Le possibili operazioni di editazione sono riassunte al capitolo 15.3.

Lo STEP 5 emette sul video il blocco immagine selezionato per ultimo o unalista vuota
in cui introdurre segnali e stati.

Lo STEP 5 emette la lista degli operandi con le colonne Operandie Forzam. segnali.

1. Introdurre per ciascuna riga i valori desiderati e premere il tasto di introdu-
zione dopo ogni introduzione.

Lo STEP 5 emette una X dopo ciascun valore acquisito. Se la lunghezza dei
caratteri introdotti & minore della possibile lunghezza, i posti relativi ai valori
piu alti sono automaticamente riempiti con zeri.

L'introduzione dei valori delle uscite viene terminata
2. premendo Conferma

Il PG emette la segnalazione Forzamento eseguito e trasferisce i
valori delle uscite modificati in AG.

Se si vuole interrompere il forzamento delle uscite,
3. premere ESC = Annulla

Se sono presenti delle modifiche non ancora memorizzate in un blocco imma-
gine, compare una domanda di sicurezza: (Annullare le modifiche?
oppure Annullare blocco modificato?.

Se non sono state eseguite modifiche oppure la domanda di sicurezza viene
confermata con Si, lo STEP 5 emette il menu funzioni. Leggere al riguardo il
capitolo 15.3 Stato Variabile.

Se l'introduzione non € scritta correttamente, il cursore non abbandonail campo d'in-
troduzione stesso.
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15.6 Controllo elaborazione ON

| Test

Controllo
elaborazione ON

15-16

Questa funzione fa in modo che I'AG elabori un blocco a passi. Con il richiamo
del controllo elaborazione, il programma viene arrestato nella posizione indicata
dal punto di alt (istruzione in cui si trova il cursore) e i comandi di uscita sono
bloccati (tutte le uscite disattivate). Cio significa che il programma viene elaborato
fino all'istruzione selezionata e sono emessi gli stati attuali dei segnali e il RLC.
Sul’AG e acceso il diodo (LED) BASP (BefehlsAusgabeSPerren = comandi di
uscita bloccati).

Avvertenza

Il controllo elaborazione non é sostenuto da ogni AG — Manuale AG .

Durante il controllo elaborazione
¢ il ciclo di elaborazione € interrotto,

® nessun ingresso o uscita € piu elaborato, solo 'immagine di processo puo es-
sere modificata,

¢ il programma pu0 essere proseguito istruzione per istruzione, spostando il
punto di alt.

Durante il controllo elaborazione I'AG si trova sull’ultimo punto di alt selezionato. Le
seguentifunzioni ditest (eventualmente con possibilita di correzione) si possono sele-
zionare in parallelo per il controllo elaborazione:

* stato variabili

e forzamento variabili

¢ forzamento uscite

¢ informazioni tramite registro interruzione
* informazioni tramite registro blocchi.

Particolarita del controllo elaborazione peridiversi controllori programmabili sono de-
scritte nelle istruzioni di servizio dei manuali AG.

Dopoilrichiamo dellafunzione Controllo Elaborazione ONintrodurre nel box discelta,
sotto Scelta:

1. un blocco (in simbolico o assoluto) o la lista (concatenamento) di blocchi di cui
si vuole controllare I'elaborazione.

2. Come Cirit. ricerca:, un operando che si vuole osservare nel blocco definito.

3. Dopo OK lo STEP 5 emette in AWL il blocco selezionato. La rappresentazione
sul video € identica a quella della funzione Stato blocco (capitolo 15.2).|Al po-
sto della scritta Stato appare qui Controllo elaborazione

4. Premere il tasto cursore in basso .
E selezionato il punto di alt.

Lo STEP 5 emette le informazioni relative all’'istruzione appena eseguita. Il
cursore si trova sulla riga dell'istruzione successiva. Il processore dellAG &
fermo, cioé non viene eseguita nessuna operazione del programma utente,
che non sia esplicitamente comandata.

STEP 5/ST V7.0
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5. Premere il tasto cursore in basso .

E selezionato il successivo punto di alt.

L'AG esegue listruzione successiva e il processore interrompe nuovamente
I'elaborazione. Se durante il controllo elaborazione si scoprano errori e siano
necessarie modifiche,

6. premere due volte ESC = Annulla, per abbandonare il controllo elaborazione e
richiamare quindi un editor.

Poiche il controllo elaborazione & ancora attivo, il processore dell’AG é fermo.
Si ritorna nel modo Controllo elaborazione,
7. richiamando nuovamente la funzione Controllo elaborazione ON.

Ora € possibile testare le correzioni del programma editate.

Avvertenza

Non sono attivi tutti i tasti funzionali. Il menu principale visualizza se il Controllo
elaborazione é attivato.

15.7 Controllo elaborazione OFF

\ Test

Controllo
elaborazione OFF

STEP 5/ST V7.0
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Con questa funzione il controllo elaborazione viene di nuovo disattivato. Richia-
mare pertanto Test » Controllo elaborazione OFF . L'AG va in STOP e deve es-
sere nuovamente avviato (tramite Forza AG - Start AG oppure con I'azionamento
del commutatore STOP-RUN sulla CPU).
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Sommario In questo menu si trovano le funzioni di start e stop di un AG collegato in modo online
ed anche di compressione della memoria utente in AG.

\- Gestione Documentazione Cambio (
‘ Start AG Shift+F11

Stop AG Shift+F12

Comprimi memoria AG  Ctrl+Shift+F2

Info AG: REG. INT. Shift+F9

Info AG: REG. BL. Shift+F10

Visualizza contenuto memoria AG ...
Configura memoria AG
Parametri di sistema AG

Sommario del Capitolo Argomento trattato Pagina
capitolo 16.1 Start AG 16-2
16.2 Stop AG 16-2
16.3 Compressione memoria AG 16-2
16.4 Info AG: REG.INT 16-3
16.5 Info AG: REG.BL 16-5
16.6 Emissione del contenuto della memoria 16-5
16.7 Configurazione della memoria AG 16-7
16.8 Parametri di sistema dellAG 16-8
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16.1 Start AG

| AG

Start AG

16.2 Stop AG

| Test

Stop AG

La funzione Start AG esegue un nuovo avviamento o un riavviamento del control-
lore programmabile. Dopo la selezione della funzione, prima che I'AG sia avviato,
appare la relativa richiesta:

e confermare la segnalazione con Si:
L'AG si porta nello stato selezionato, oppure
¢ confermare la segnalazione con No:
La funzione di start non viene eseguita.

Se si verificano degli errori, questi sono visualizzati tramite segnalazioni. Le segnala-
zioni visualizzate dipendono dalla CPU.

La funzione di Stop AG mette il controllore programmabile nello stato di stop. Il
processore interrompe I'elaborazione delle istruzioni del programma.

In funzionamento multiprocessore (S5-135U) sono messi in stop tutti i processori.

Dopo la selezione della funzione, prima che I'AG sia messo in stop, appare larelativa
richiesta:

e confermare la segnalazione con Si:
L'AG si porta nello stato di stop, oppure
* confermare la segnalazione con No:
La funzione di stop non viene eseguita.

Le segnalazioni visualizzate dipendono dalla CPU.

16.3 Compressione memoria AG

| Test

Comprimi memoria
AG

16-2

Quando si cancellano i blocchi in AG, essi vengono dichiarati "non validi” nella
RAM AG, ma non effettivamente cancellati. Analogamente la correzione di un
blocco lo rende non valido (vecchio) e genera in aggiunta il blocco corretto nella
RAM. Pertanto € possibile che la memoria AG si riempia completamente. La
funzione Comprimi memoria elimina i blocchi non validi e compatta uno accanto
all'altro quelli validi, in modo che si formi nuovo spazio in memoria per altri bloc-
chi.

La funzione Comprimi memoria riconosce i seguenti errori:

* lunghezza blocco errata,

e codice 7070 errato nella testata del blocco,

¢ tipo di blocco non valido (per OB: numero di blocco non valido).

Se lo STEP 5 rileva uno di questi tipi di errore, la funzione viene interrotta e viene
emessa una segnalazione.

STEP 5/ST V7.0
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16.4 Info AG: REG.INT

| AG

Info AG: REG.INT

REG.INT.
Registro interru-
zione di AG

STEP 5 Window Mode - S50XSOKZ

STOANZ

Le funzioni online, selezionabili in questo sottomenu, forniscono informazioni rela-
tive al’AG collegato.

¢ registro d'interruzione (REG.INT.)

* registro blocchi (REG.BL.)

¢ indirizzi esadecimali di memoria e periferia (emissione contenuto memoria)
¢ informazioni sulla memoria utente dellAG (configurazione memoria)

¢ informazioni sulla struttura interna del’AG e sulla versione software della CPU
(parametri sistema)

DopoilrichiamodelREG.INT. appare sul video dapprima unatabelladeibitdi controllo
con le relative attuali assegnazioni. Il significato delle abbreviazioni € chiarito in una
finestra nella parte inferiore del video. Per visualizzare di questi chiarimenti posizio-
nare il cursore sulla sigla di abbreviazione.

| chiarimenti relativi ai bit di controllo sitrovano anche nei manuali degli AG. Per I'emis-
sione della maschera dei bit di controllo I'AG non deve necessariamente essere nello
stato di STOP.

S Annulla

Figura 16-1 Tabella dei bit di controllo (p. es. CPU 928 B)

STEP 5/ST V7.0
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Se ¢ visualizzata la tabella dei bit di controllo, richiamare il REG.INT. portando 'AG
in STOP e

1. premere Conferma .
Nella parte inferiore del video, una finestra richiamabile
2. premendo SHIFT + F8 =HELP

chiarisce le relative funzioni emesse.

STEP 5 Window Mode - S50XSOKZ

52 Annulla

Figura 16-2 Rappresentazione del registro d’interruzione

Con F2 si puo saltare direttamente al punto d’interruzione segnalato per modificare
eventualmente il programma.

Avvertenza

Vi possono essere altre pagine di video.

STEP 5/ST V7.0
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16.5 Info AG: REG.BL

Funzione

' AG

Info AG: REG.BL

Ogni volta che si richiama un blocco, I'AG introduce nel registro blocchi I'indirizzo in-
iziale del blocco valido ed anche l'indirizzo assoluto e relativo del salto di ritorno, che
e l'indirizzo di memoria da cui si deve proseguire il programma dopo I'elaborazione
del blocco richiamato.

Queste informazioni sono richiamabili con la funzione REG.BL., con AG in STOP.

REGISTRO BLOCCHI

N. Blocco Ind.Blocco Ind.Salto-Rit. Ind.Rel. N.DB. Ind.DB
PB 3 DO5A D05B 0001
OB 1 DOC2 DOC7 0005

Figura 16-3 Registro blocco

Eventuale segnalazione:

1. Funzionamento errato in AG
L'’AG non € in STOP.

2. Registro vuoto o incompleto.

16.6 Emissione del contenuto della memoria

Funzione

' AG

AG Visualizza
contenuto memo-
ria AG

STEP 5/ST V7.0
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Questa funzione emette gli indirizzi assoluti di memoria ed il loro contenuto, su video,
stampante o file stampa.

L'emissione degli indirizzi & possibile solo in funzionamento online.

Avvertenza

Intervenendo nell’AG, puo accadere che esso si porti in stati di funzionamento
non definiti. Considerare bene le conseguenze.

Selezionare AG » Visualizza contenuto memoria AG. E emesso il box di co-
mando Visualizza contenuto memoria AG. In questo box ci si pud muovere ed
eseguire selezioni.

1. Sotto Emiss. da indir.:, introdurre in esadecimale I'indirizzo del primo byte da
emettere (p.es. ADAC; per S5 155 U (indirizzo a 20 bit): p.es. FADAC).

2. Premere Emissione

Lo STEP 5 emette gli indirizzi ed il loro contenuto su 4 colonne, facendoli
scorrere sul video.

L'emissione degli indirizzi inizia sempre con un indirizzo pari.
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Aree dimemorianon equipaggiate sono contrassegnate con XX. Sono emessial mas-
simo 1024 indirizzi assoluti.

Per sospendere/interrompere I'emissione degli indirizzi
3. premere ESC = Annulla

Proseguire confermando la segnalazione oppure premendo Conferma .
Nel caso si voglia apportare una correzione:

4. Eseguire un click su correzione e posizionare il cursore con SHIFT + cursore
a destra/sinistra sul relativo valore.

5. Introdurre il valore e concludere il procedimento con Conferma .
Rispondere alla segnalazione Conferma indirizzi modificati in AG?
6. eseguendo un click su Sio No.

Per interrompere e abbandonare I'emissione

7. premere 2 volte ESC = Annulla

senza premendo una volta ESC = Annulla e confermando la
correzione segnalazione con No.

dopo indirizzi modificati vengono emessi; confermare la
correzione segnalazione

STEP 5/ST V7.0
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16.7 Configurazione della memoria AG

| AG

AG Configura me-
moria AG

STEP 5/ST V7.0
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Questa funzione consente di emettere gli indirizzi assoluti ed il loro contenuto sul
video, sulla stampante o sul file di stampa.

L'occupazione di memoria e le possibilita di equipaggiamento sono contenute nelle
rispettive istruzioni di programmazione dei vari AG. Gli indirizzi sono rappresentati
inesadecimale. L'occupazione dellamemoriaedipossibiliequipaggiamentisono con-
tenuti nelle istruzioni di programmazione relative al’AG.

Sulvideocompareladimensione dellamemoriadilavorodell’AG elasuaoccupazione,
in forma grafica o alfanumerica. La rappresentazione dipende dal tipo di AG.

Memoria utente: Tipo AG S5100U Identif.-CPU. CPU 90
Ind. finale DFFF f _— —‘

[~ ] memoria libera
| | L
‘ ‘ . memoria occupata

525; I
Ind. iniziale. D000

Figura 16-4 Dimensione della memoria utente e occupazione della memoria di un
AG 100U

/Configurazionememoria \

Configurazione memoria

Ind. finali in AG-RAM (esa)

AG-RAM fino a: 3FFE Segnalazione —

Avanti?

Mem. AG occupata fino a: 70

L =1

Figura 16-5 Dimensione ed occupazione della memoria utente in forma di testo
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16.8 Parametri di sistema dellAG

Funzione

Questa funzione consente di emettere sul video i seguenti parametri di sistema

dellAG:

| AG |

Parametri di
sistema AG

identificazione CPU
tipo CPU

numero CPU
suddivisione memoria

lunghezza liste blocchi

Selezionare il comando di menu AG » Parametri di sistema . Viene visualizzato il
box di comando Parametri sistema. In questo box ci si pud muovere ed eseguire
selezioni.

Lo STEP 5 emette sul video i parametri di sistema dell’AG:

L’elenco & suddiviso in due pagine video. La seguente figura mostra un esempio per
la pagina 1. Proseguire e concludere con Avanti — Si.

Parametri sistema

Indicaz. numero esadecim.
Versione software AG Z01
Identif.-CPU S5100 U CPU 90
Versione software PGAS Z 00
Format. segnali ingresso 0
Format. segnali uscita 0
Immagine degli ingressi EFO00
Immagine delle uscite EF80
Memoria merker EEOO
Memoria tempi EC00
Memoria contat. EDOO
Area memoria-BS EAOQ0

16-8
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In questo menu principale sono riassunte una serie di funzioni di servizio.

\_ Documentazione Cambio (

a

Elabora EPROM Ctrl+F2

Interconnessione automatica ...
Interconnessione manuale ...

Liste di attribuzione >
Converti ...

Lingua ...

Imposta colori

Capitolo Argomento trattato Pagina
171 Generazione XREF 17-2
17.2 Elaborazione EPROM 17-2
17.3 Interconnessione automatica 17-7
17.4 Interconnessione manuale 17-8
17.5 Liste di attribuzione 17-11
17.6 Conversione 17-16
17.7 Scelta lingua 17-17
17.8 Impostazione colori 17-17
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17.1 Generazione XREF

Funzione

\ Gestione

Genera XREF F11

Con questa funzione si genera una lista di riferimenti (lista incrociata), relativa al file
programma impostato, in un file S5 con il nome *XR.INI. Questa € la sorgente per
i riferimenti nei segmenti KOP, FUP, AWL, nella tabella di occupazione, nella struttura
del programma, nelle liste di controllo e per la stampa della lista dei riferimenti stessa.
Dopo una correzione nel programma STEP 5, si deve generare nuovamente la lista
dei riferimenti.

Selezionare il comando di menu Gestione » Genera XREF

Dopoaverselezionatolafunzione nelmenuprincipale,ilprocedimentodielaborazione
parte automaticamente.

Lalista deiriferimenti generata & necessaria nell’editor blocchi per ladocumentazione
in formato KOMDOK e nel GRAPH 5 per I'elaborazione della funzione F2 = Riferim.

| file XREF (liste incrociate) si possono generare anche all'interno dell’editor blocchi
e prima dell’emissione KOMDOK.

17.2 Elaborazione EPROM

Funzione

17-2

Con questa funzione si trasferiscono blocchi STEP 5 da un file programma su moduli
EPROM/EEPROM. Questa operazione viene anche comunemente detta di scrittura.

Questi moduli EPROM devono essere inseriti in un’interfaccia apposita del PG.
L'utente viene supportato nella scelta dei parametri corretti per i diversi tipi di moduli.
Sono a disposizione le seguenti funzioni:

e caricamento blocchi nei moduli EPROM/EEPROM (scrittura)

¢ |ettura blocchi da moduli EPROM/EEPROM e trasferimento nel file pro-
gramma preimpostato (lettura)

¢ cancellazione moduli EEPROM (cancellazione)
¢ visualizzazione informazioni su EPROM/EEPROM (Info-E)

¢ trasferimento parametri SISID (INTR-SID, EM-SID)

Avvertenza

Sul modulo non & possibile scrivere blocchi di commento o di documentazione o
di immagine.

STEP 5/ST V7.0
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Gestione

Elabora EPROM

Parametrizzazione
funzione
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Selezionare il comando di menu Gestione » Elabora EPROM  Ctrl+F2. Dopo
aver selezionato questa funzione, appare il box Programmazione EPROM.

Programmazione EPROM
File programma C:\ STEP5\S5_DATEN\NONAMEST.S5I
Funzionamento WORD
A f i A q > BLocco © F Help
1 serivi 2 leggi  3cancella 4 5 6 InfoE 7 8 Annulla

Figura 17-1 Programmazione EPROM

In qusto box viene visualizzato il file programma indicato nell'impostazione progetto,
scheda Blocchi, il quale in questo caso non € modificabile. Il tipo di funzionamento
selezionabile nell'impostazione progetto, scheda EPROM, ¢ selezionabile anche qui
tramite SHIFT F5. Mediante la barra dei tasti funzionali si attivano le singole funzioni.

L'operativita e la parametrizzazione della funzione Scrittura sono rappresentative an-
che per le rimanenti funzioni (qui: lettura e cancellazione)

* Premere SHIFT F6 = Modo di Funzionamento
e Premere F1 = Scrivi.
* Premere F12 = Help relativo all'indicazione dei blocchi

Nella parte inferiore del video viene richiesto all’utente di effettuare il trasferimento
con la seguente riga d’introduzione. Di seguito sono chiarite le possibili introduzioni:

Introduzioni Chiarimenti
Blocco Questa introduzione va confermata con il tasto di
introduzione .
PBn (p.es.) Nome di un singolo blocco.
PB (p.es.) Tutti i blocchi di un tipo.
* Viene visualizzata una lista, in cui si possono introdurre
max. 6 blocchi.
B Tutti i blocchi del file programma preimpostato
(- Progetto)
Sta Questa introduzione va confermata con Conferma .
Vuoto Emissione solo su video.
* Stampa standard.
1 Stampa normale.
2 Stampa ristretta.
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Numero di
programmazione

Scelta
NUM. PROGR.

Informazioni
modulo

17-4

Dopo aver confermato le introduzioni, viene visualizzata un’ulteriore riga d’'introdu-
zione:

NUM.PROGR:

Qui sideve introdurre il numero di programmazione, che identifica il modulo EPROM/
EEPROM desiderato.

Ci sono due possibilita per introdurre questo numero:
1. introduzione diretta del numero
2. introduzione del numero tramite il tasto di HELP.

Vengono visualizzati gli abbinamenti in una lista, contenuta nello STEP 5. Con
il tasto di HELP si puo visualizzare e sfogliare questa lista. Dopo aver posizio-
nato il cursore nella lista su un determinato modulo ed aver confermato con il
tasto di introduzione , il relativo numero di programmazione viene inserito nel
campo NUM. PROGR.

Chiarimenti relativi alla lista dei moduli EPROM/EEPROM:

Terminologia Chiarimenti
MLFB Numero di ordinazione di un modulo.
Num. Progr. Il dispositivo di programmazione identifica il modulo EPROM/

EEPROM tramite questo numero di programmazione. Questo
numero € associato in modo fisso al numero di ordinazione.

Capacita Capacita di memoria del modulo EPROM/EEPROM.

Avvertenza

Il Num. Progr. 500 é riservato per le Memory Card SIMATIC. La scrittura e la veri-
fica sono identiche ai procedimenti descritti in questo capitolo.

Dopo averintrodotto il NUM. PROGR. e premuto il tasto di Conferma , vengono visua-
lizzate le informazioni modulo da confermare con I'apposito tasto (Conferma ).

Avvertenza

Se si introduce un numero di programma incorretto, i moduli EPROM/EEPROM
possono venire distrutti.

Se, per esempio, per il modulo 6ES5 372-1AA61 si introduce solo 57 al posto del nu-
mero di programma completo 475, il modulo verra distrutto.

STEP 5/ST V7.0
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INFORMAZIONI-MODULO

NUMERO ORDINAZIONE ~ : 6ES5 373-0AA81

NUMERO PROGRAMMAZ. : 163

RICONSC. HARDWARE : ——  —MODULO SENZA RICONOSC. HW
EQUIPAGGIAMENTO : POSTO 1:*27256 POSTO 2 :*27256

POSTO 3 :*27256 POSTO 4 :*27256

TIPO FUNZIONAMENTO WORD-WORD/BLOCCO, IN ALTERN. BYTE

CAPACITA : 64 KWORD OR 128 KBYTE
NUM. PROGR. ? SE MODULO ESATTO, SOLO CONFERMA
SCRITTURA EPROM BLOCCO. : PB44 PTR :

Figura 17-2 Esempio di informazioni relative ad un modulo EPROM/EEPROM

Attivazione Diseguitovengono chiarite le singolifunzioniEPROM, attivabili tramite itastifunzionali
funzioni (F1 - F8):
Livello tasti Effetto dei tasti funzionali
1 2
Tasti cursore -~ Appendice A4, Assegnazione tastiera
F1 Scrivi: Trasferimento in un modulo EPROM/EEPROM. Le introduzioni avvengono
come descritto alla pagina 17-3. Il trasferimento si conclude con la segnalazione:
Funzione principale Indirizzo finale nnnnnnnn
Indirizzo:

Gli indirizzi visualizzati sono gli indirizzi fisici della EPROM/EEPROM.

Interruzione del procedimento di trasferimento con ESC:

Il blocco in trasferimento viene trasferito completamente e poi il procedimento si con-
clude.

F2 Leggi:

Trasferimento da un modulo EPROM/EEPROM nel file programma preimpostato (-
Progetto). |l trasferimento si conclude con la segnalazione:

Verifica EPROM Limite libero nnnnnnnn

F3 Cancella:
Il procedimento di cancellazione (solo per EPROM + Memory Card) si conclude con
la segnalazione:

Funzione principale Indirizzo finale nnnnnnnn
Cancellazione di EPROM con l'unita di cancellazione.
F5 Info E:

Emissione informazioni relative al modulo EPROM inserito nell'interfaccia. Cambio
nel successivo livello di tasti funzionali.

STEP 5/ST V7.0
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Livello tasti Effetto dei tasti funzionali
1 2

F1 Indice:
Emissione su video o su stampante dell'indice dei blocchi del modulo EPROM/EE-
PROM. La lista dei blocchi & emessa sul video, se viene trovato un blocco o la te-
stata di un blocco.
A seconda dell'impostazione, I'emissione viene conclusa con la seguente segnala-
zione: per un blocco o per un gruppo di blocchi:
Blocco trovato per indirizzo finale testata nnnnnnnn
Per tutti i blocchi:
Verifica EPROM Limite libero nnnnnnnn
Il Limite libero & I'indirizzo fisico dell’'ultimo blocco nel modulo EPROM/EEPROM.

F2 Confronta:
Confronto dei blocchi S5 memorizzati nella EPROM/EEPROM con quelli del file pro-
gramma preimpostato. Il risultato del confronto viene emesso su video o0 su stam-
pante. Durante il confronto vengono emesse segnalazioni. Le seguenti segnalazioni
concludono il procedimento di confronto:
Confronto di tutti i blocchi:
Verifica EPROM Limite libero nnnnnnnn
Il Limite libero & lindirizzo fisico dell'ultimo blocco nel mod. EPROM/EEPROM.
Confronto di un blocco o di un gruppo di singoli blocchi:
Funzione principale Indirizzo finale nnnnnnnn
Per differenze rilevate durante il confronto vengono emesse le seguenti segnalazioni:
Indirizzo indirizzo relativo nel modulo.
Set (valore di) set = contenuto della locazione di memoria

all'indirizzo relativo del blocco nel file programma.
Ist valore attuale = contenuto della locazione di memoria
all'indirizzo relativo del blocco nel modulo EPROM/EEPROM.

F3 Parametri:
Emissione su video dei parametri EPROM/EEPROM e confronto con i valori dei pa-
rametri del modulo inserito nellinterfaccia EPROM. In caso di uguaglianza viene
emesso il risultato (vedere figura 17-2).

F5 Int SYSID:
Trasferimento nel modulo EPROM/EEPROM dei dati contenuti nel File-SISID.
Se il modulo EPROM/EEPROM non € completamente vuoto, compare la segnalazione:
Scrittura SISID vietata
Il trasferimento viene concluso con la segnalazione:
Funzione principale Indirizzo finale nnnnnnnn

F6 Em SYSID:
Trasferimento dei dati SISID contenuti nel modulo EPROM/EEPROM nel file SISID preim-
postato e visualizzazione su video. Il file SISID preimpostato pud pertanto essere sovra-
scritto. Il trasferimento viene concluso con la segnalazione:
Funzione principale Indirizzo finale nnnnnnnn

F8 Help
Visualizzazione dell’assegnazione dei tasti funzionali

F8 Annulla

17-6

Ritorno alla scelta funzioni.
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17.3 Interconnessione automatica

Funzione

Regole

Esempio
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Con la funzione Interconnessione & possibile ridenominare degli operandi:

¢ automaticamente, utilizzando due file simbolici oppure

* manualmente, costruendo una lista di modifica (vedere capitolo 17.4)

Si copia il file simbolico appartenente al programma utente e qui si modificano gli indi-
rizzi degli operandi modificati.

Questo "nuovo” file simbolico € utilizzato dal PG come lista di riferimenti, per rilevare
automaticamente intuttoil"vecchio” programma utente (o neisingoliblocchi) gliope-
randi modificati e per memorizzare gli operandi ridenominati nel secondo file pro-
gramma come "nuovo programma utente”.

II"vecchio” programma utente rimane inalterato se i file sorgente e destinazione sono
differenti. Il numero di operandi modificabili & a piacere.

GlioperandiE, A,M, ToZpossono essere nominatiin assoluto oin simbolico. | merker
"S” non sono tenuti in considerazione

E possibile modificare solo gli indirizzi, ma non il simbolo di un operando.

I blocchi, in cui nessun operando e stato modificato, vengono memorizzati dallo
STEP 5 inalterati anche nel nuovo file programma.

I blocchi dati non possono essere interconnessi in simbolico. Per trasferire il pro-
gramma utente con struttura invariata occorre trasferire separatamente i blocchi dati
nel nuovo file.

I simboli-Merker0 e -Ingr0 nelfile simbolico SIMVECZ0.SEQ sono associati agli ope-
randi M 0.0 e E 0.0 nel file programma INTVECST.S5D.

Inun nuovo file simbolico SIMNUOZO0.SEQ i simboli-Merker0 e -Ingr0 sono associati
agli operandiM 1.2 e E 2.0.

Con l'interconnessione automatica, nel nuovo file programma INTNUOST.S5D
vengono assegnati a tutti i simboli uguali (in SIMVECZ0.INI e SIMNUOZO.INI) i nuovi
operandi.

Avvertenza
Alla sostituzione di E1.0 - E20.0, EB o EWM non diventa EB/EW20!
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Gestione

Interconnessione
automatica ...

Errori

Interruzione
anticipata

Selezionare il comando di menu Gestione » Interconnessione automatica..

Dopoaverselezionato questafunzione,lo STEP 5 visualizzail relativo box dicomando
Interconnessione automatica.

Sotto File-Programma: viene visualizzato il nome del programma utente, in cui
ridenominare gli operandi. Introdurre i nomi dei "nuovi” file generati tramite queste
modifiche, sotto a File-Programma: e con nuovo File-Simbolico: intro-
durre il nome del file della copia della lista di attribuzione.

Se si vogliono ridenominere gli operandi solo in determinati blocchi, introdurre questi
blocchi sotto Scelta , altrimenti indicare B (vedere capitolo 3.9) per tutti i blocchi.

Dopo I'lnterconnessione lo STEP 5 emette un protocollo con i file interessati alla
ridenominazione su video, stampante o file, a seconda della preselezione.

Sedurantel'interconnessione subentraunerrore, ilblocco che sitrovain elaborazione
non viene trasferito nel nuovo file programma. Appare una corrispondente segnala-
zione.

Premere ESC = Annulla

Il PG non memorizza il blocco che si trova in elaborazione.

17.4 Interconnessione manuale

Funzione

Gestione

Interconnessione
manuale ...

17-8

La funzione consente la ridenominazione di operandi tramite una lista definita sul vi-
deo. Oltre ai nuovi indirizzi di operandi si deve anche definire un nome per il "nuovo”
programma utente.

Selezionare il comando di menu Gestione » Interconnessione manuale..
Dopo la scelta della funzione , il PG visualizza il relativo box di comando.

Sotto File programma viene visualizzato il nome del programma utente, in cui
ridenominare gli operandi. Sotto File-Programma  introdurre dei nomi "nuovi” per
i file modificati.
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STEP 5 Window Mode

- S5KXS01z

File programma

in file programma

—>C:\S5_DATEN\EXAMPLE

—>C:\S5_DATEN\EXAMPLE

Interconnessione manuale

[PROBSPST.S5

— Scelta
Lista blocchi

— Emetti su
(X) Schermo
(X) Stampante
(X) File

[NONAMELS.INI]
—>C:\STEP5\S5_DATEN

— Opzioni

< Storia F1>

Tipo protocollo:

Standard <Scegli F3>

[ </Interconnetti > < Annulla ESC >

< Info F7 >
< Help Shift+F8 >

Figura 17-3 Lista degli operandi per interconnessione manuale (esempio)

Protocollo di
stampa

STEP 5/ST V7.0
C79000-G8572-C920-02

Dopo OK, STEP 5 emette sul video la tabella vuota Interconnessione manuale per
l'introduzione degli operandi nel vecchio file programma. Questa lista pud compren-
dere ogni volta fino a 16 operandi con vecchio e nuovo indirizzo in assoluto (figura
17-3). Concludere ogni introduzione con il tasto di introduzione

Dopo l'editazione degli indirizzi degli operandi modificati, si conclude I'introduzione
premendo Conferma .

Lo STEP 5 esegue ora la ridenominazione ed emette il nome del blocco elaborato
nel protocollo Interconnessione manuale (figura 17-4).

All'introduzione deglioperandilo STEP 5verificaimmediatamente ognicampo d'intro-
duzione compilato per quanto concerne gli errori di sintassi ed eventualmente emette
la segnalazione Sintassi errata

Se é stato selezionato nel box di scelta Emetti su stampante, lo STEP 5 emette, dopo
la conferma, un protocollo delle ridenominazioni. Questo visualizza oltre agli indirizzi
indicati "vecchi e nuovi”, il numero delle ridenominazioni eseguite nei blocchi con le
loro lunghezze dalla testata di blocco.

Le segnalazioni di errore contengono I'indicazione relativa all'operando in cui & stato
riscontrato un errore. Dopo un errore si interrompe l'interconnessione.
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Interruzione
anticipata

Errore
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Interconnessione manuale Pagina 1

Vecchio file programma: ~ WASCHAST.S5D Nuovo file programma: PROBSPST.S5D

—>C:\S5_DATEN\EXAMPLE —>C:\S5_DATEN\EXAMPLE
Vecchio operando: A 32.0 Nuovo operando: A 1.1
Vecchio operando: M 10.2 Nuovo operando: E 7.5

PB 2 LUNGHEZZA= 1
Numero di interconnessioni:
PB 10 LUNGHEZZA = 2
Numero di interconnessioni:
PB 11 LUNGHEZZA= 0

Numero di interconnessioni:

Figura 17-4  Protocollo di stampa a seguito di una interconnessione manuale
(esempio)

Premere ESC = Annulla
I PG non memorizza il blocco che si trova in elaborazione.
Sedurantel'interconnessione subentraunerrore, il blocco che sitrovain elaborazione

non viene trasferito nel nuovo file programma. Appare una corrispondente segnala-
zione.

STEP 5/ST V7.0
C79000-G8572-C920-02



Gestione

17.5 Liste di attribuzione

Funzione

Editazione lista
attribuzione

Generazione file
simbolico

Ulteriore
elaborazione in AG

STEP 5/ST V7.0
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Con questafunzione si elabora la lista di attribuzione, necessaria per I'indirizzamento
simbolico degli operandi nel programma utente.

Sono disponibili le seguenti funzioni:
¢ traduzione di una lista di attribuzione in un file simbolico (*20.SEQ - *ZO0.INI).

e traduzione di un file simbolico in una lista di attribuzione ordinata secondo
operandi assoluti o simbolici (*Z0.INI - *Z0.SEQ) o senza ordinamento degli
operandi.

e correzione veloce della lista di attribuzione, direttamente nel file simbolico tra-
dotto (*Z0.INI).

¢ traduzione di un vecchio file simbolico in una lista di attribuzione (conversione
da livello V1.x V2.x).

* cancellazione di una lista di attribuzione con il relativo file errori.
e cancellazione di un file simbolico.
* emissione della lista degli errori di traduzione (file errori).

In AG sono elaborati soltanto operandi con indirizzamento assoluto. Successiva-
mente & necessaria una lista di attribuzione e quindi un file simbolico (*Z0.INI) per
I'attribuzione di un indirizzo simbolicoad un indirizzo assoluto (p.es.tasto 1 - E 1.1).

L'editazione della lista di attribuzione & descritta nel paragrafo 11.3. Il file sorgente
(*20.SEQ) generato con I'editazione, viene convertito tramite un procedimento di tra-
duzione in tre file simbolici assegnati (*Z0.INI, *Z1.INI, *Z2.INI).

I file simbolici vengono generati automaticamente dallo STEP 5, dopoil richiamo della
funzione Converti SEQ - INI oppure editando la lista attribuzione.

Per una corretta traduzione del programma utente, al caricamento sono necessari
solo i file simbolici.
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17.5.1 Conversione SEQ - INI

Funzione

\ Gestione

Liste di

attribuzione
Converti
SEQ>INI

Con questa funzione si traduce la lista di attribuzione nel file simbolico assegnato.

Selezionare il comando di menu Gestione » Lista di attribuzione > Converti
SEQ—>INl.....

Dopo aver selezionato questa funzione lo STEP 5 emette il box di comando Traduci
liste di attribuzione SEQ - INI, in cui introdurre il nome della lista di attribuzione da
tradurre. Se nella lista di attribuzione gli operandi assoluti sono stati introdotti senza
i corrispondenti simbolici, viene emessa la segnalazione

Acquisire operandi assoluti come simboli?

Confermare con si 0 no questa segnalazione.

Se I'elaborazione & corretta, compare la segnalazione

n righe elaborate, nessun errore trovato

da confermare con OK.

Se durante la traduzione sono subentrati errori, viene segnalato
n righe elaborate, x errori trovati

Confermare ugualmente con OK questa segnalazione.

Avvertenza

Se e stata generata una lista di attribuzione con sigle degli operandi assoluti in
lingua inglese (ZO.SEQ), nell'emissione in tedesco del file gli operandi saranno
ancora emessi in inglese. Per emettere gli operandi in tedesco, bisogna
cancellare la lista di attribuzione in inglese e ritradurre il file simbolico nel file sor-
gente (INI —> SEQ)

17.5.2 Conversione INI > SEQ

Funzione

\ Gestione

Liste di

attribuzione
Converti
INI>SEQ

17-12

Conquestafunzioneilfile simbolicoviene tradotto nellalistadi attribuzione assegnata,
dove é possibile scegliere I'ordinamento secondo operandi assoluti e simbolici.

Selezionare il comando di menu Gestione » Liste di attribuzione > Converti
INI->SEQ....

Dopo aver selezionato la funzione lo STEP 5 emette il box di comando Traduci file
simbolico INI —> SEQ, in cui definire il nome del file simbolico da tradurre e I'ordina-
mento della lista di attribuzione. Dopo aver dato I'OK, il file viene tradotto.

La traduzione si conclude con la segnalazione
n righe elaborate, nessun errore trovato

da confermare con OK.
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17.5.3 Correzione INI

Funzione

\ Gestione

Liste
attribuzione
Correggi INI

Introduzione riga
di attribuzione

STEP 5/ST V7.0
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Avvertenza

In una lista attribuzioni esistente, nell’ordinamento "in parametri assoluti” e "in
simboli” (file SEQ), vanno persi tutti i commenti aggiuntivi (;), gli spazi e
I'avanzamento di pagina (.PA).

Nell'ordinamento "come nel file simbolico” si conservano solo i commenti
aggiuntivi.

Avvertenza
Nell'ordinamento vanno perse tutte le istruzioni di comando (.PA), gli spazi e le
righe di commento (;).

Questafunzione consente la correzione disingole attribuzioninelle liste diattribuzione
lunghe (risparmio di lunghi tempi di traduzione per tutte le attribuzioni).

Selezionare il comando di menu Gestione » Liste di attribuzione > Correggi

Dopo aver selezionato la funzione, lo STEP 5 emette il box di comando Correggi file
simbolico, in cui definire, nel caso non sia gia correttamente preimpostato, il nome
del file simbolico da correggere. Dopo aver selezionato Correggi , viene proposto il
seguente box:

-
File-Simbolico: C:PROEXAZO.INI
Operando  Simbolo Commento
Attribuzione a operando:
Attribuzione a simbolo:
F F F F F F
1 Inserisci 2 Visual. 3Canc. ASS 4 Canc.simb.5 Opz.ZULlI 6
La riga si trova sotto all'intestazione Operando — Simbolo — Commento . Intro-

durre qui una nuova attribuzione nel file simbolico.

Il cursore € posizionato all'inizio dellariga d’'introduzione. Lariga diintroduzione viene
editata in Sovrascrittura.

Il tasto DEL = Cancella cancella il carattere sotto il cursore.

Il tasto Inserimento orizzontale inserisce uno spazio nella posizione del cur-
sore.

Con i tasti di scorrimento (verso I'alto e verso basso) € possibile scambiare
alternativamente il contenuto delle righe di introduzione e visualizzazione.

Il tasto di introduzione sposta, come il tasto TAB, il cursore nel successivo
campo verso destra.
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Per I'editazione delle attribuzioni nel file simbolico, lo STEP 5 mette a disposizione
le seguenti funzioni, richiamabili tramite tasti funzionali.

Funzione Chiarimento

F1 = Inserisci L'attribuzione nella riga d’introduzione viene acquisita, se
I'indirizzo dell’operando non & ancora occupato. In caso con-
trario, segnalazione d’errore: Chiave gia esistente

F2 = Visual. Viene visualizzata l'attribuzione relativa al parametro asso-
luto o simbolico, se questa € contenuta nel file simbolico.
La visualizzazione rimane fino alla successiva pressione di
F2.

F3 = Canc. ASS Viene cancellata nel file simbolico I'attribuzione relativa al
parametro assoluto (operando) nella riga d'introduzione. Se
I'attribuzione introdotta non é definita, appare una segnala-
zione di errore.

F4 = Canc. Viene cancellata nel file simbolico I'attribuzione relativa al

simb. parametro simbolico (simbolo) nella riga d’introduzione. Se
I'attribuzione introdotta non € definita, appare una segnala-
zione di errore.

F5=0pz. ZULI Lalista di attribuzione viene ottimizzata.

F8 = Indietro Dopo le modifiche nel file simbolico, lo STEP 5 chiede se
deve essere generata la lista di attribuzione (Z0.SEQ). In
caso affermativo, premere Conferma , altrimenti tornare in-
dietro introducendo NO.

1. Se sivuole inserire un nuovo operando nel file simbolico,

introdurre un indirizzo assoluto e simbolico non ancora occupato ed anche un
commento operando, e premere F1 = Inserisci

2. Se si vuole ridenominare l'indirizzo assoluto di un operando gia esistente,

introdurre I'operando in questione e cancellare il suo indirizzo assoluto tramite
F3 = Canc. ASS. Sovrascrivere ora I'operando con il suo nuovo indirizzo e
premere F1.

3. Se si vuole ridenominare I'indirizzo simbolico di un operando gia esistente,
seguire lo stesso procedimento del punto 2), ma cancellare con F4 = Canc.
simb.

17.5.4 Conversione V1x > V2x

Sommario L'indirizzo dibyte diun parametro assoluto nelle "vecchie” liste attribuzioni del software
STEP5V1.xe V2.xsotto PCP/M € lungo 3 byte. Nello STEP 5 a partire dalla versione
3.x, & lungo 4 byte. Cio dipende dall'introduzione dei nuovi merker (S) e richiede una
conversione del "vecchio”file simbolico inuna”nuova’ lista di attribuzione, prima della
sua elaborazione.

Le liste di attribuzione generate con versioni superiori non devono essere convertite.

STEP 5/ST V7.0
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Gestione

Liste

attribuzione
Converti li-
vello V1.x V2.x

Selezionare il comando di menu Gestione » Liste di attribuzione > Converti
V1.x e V2.x

Introdurre nel box di comando visualizzato il nome dellalista di attribuzione da conver-
tire. Dopo aver dato I'OK, il file viene tradotto.

Se nella lista di attribuzione sono stati introdotti parametri assoluti senza i corrispon-
denti simbolici, appare la segnalazione:

Confermare questa segnalazione secondo quanto si desidera
fare.

17.5.5 Cancellazione SEQ

\ Gestione

Liste
attribuzione
Cancella SEQ

Con questa funzione si cancella una lista di attribuzione. Cio vale anche per i re-
lativi file errori ed i file di assegnazione tasti.

Dopo l'avvio della funzione, lo STEP 5 emette un box di comando, in cui introdurre,
nel caso non sia preimpostato correttamente, il nome del file sorgente da cancellare.

Dopo aver dato I'OK, vengono cancellati i file sequenziali. Dopo I'esecuzione della
funzione, i file cancellati vengono elencati.

17.5.6 Cancellazione INI

\ Gestione

Liste
attribuzione
Cancella INI

Con questa funzione si cancellano i file simbolici (*Z0.INI, *Z1.INI e *Z2.INI).

Dopo l'awvio della funzione, lo STEP 5 emette un box di comando, in cui introdurre, nel
caso non sia preimpostato correttamente, il nome del file simbolico da cancellare.

Dopo aver dato I'OK, vengono cancellati i file simbolici. Dopo I'esecuzione della fun-
zione, i file cancellati vengono elencati.

17.5.7 Emissione lista errori

\ Gestione

Liste

attribuzione
Emetti lista
errori

STEP 5/ST V7.0
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Nella lista errori lo STEP 5 riassume le segnalazioni d’errore, subentrate per uno
dei seguenti procedimenti di traduzione.

* Traduzione della lista di attribuzione *Z0.SEQ nei file simbolici (*Z0.INI,
*Z1.INI, *Z2.INI)

¢ Ritraduzione dei file simbolici nella lista di attribuzione (INI - SEQ).

Dopo il richiamo della funzione, appare un box di comando, in cui introdurre il nome
del file errori da emettere (*2F.SEQ), nonche il supporto (video, stampante o file) sul
quale deve avvenire I'emissione. Dopo aver cliccato Emetti, lo STEP 5 emette il file
errori.
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Esempio

17.6 Conversione

Funzione

\ Gestione \
Converti ...

17-16

File C:\S5_DATEN\DEFAULT\PROBSPZ0.SEQ

Compilazione lista attribuzione C:\S5_DATEN\DEFAULT\PROBSPZ0.SEQ
=> File simbolico C:\S5_DATEN\PROBSPZO0.INI

M1.71

***  Errore allariga 6: parametro assoluto non conforme a SGOP (sigla operando)  ***

susi
**  Errore allariga 7: sigla operando errata bkl
el 8 righe elaborate, 2 errori trovati ok

Figura 17-5 Lista errori dopo I'editazione della lista di attribuzione (esempio)
Una segnalazione di errore riporta 'operando assegnato in modo errato e indica la
posizione ed il tipo dell’errore.

Ad ogninuovatraduzione della stessa lista di attribuzione, il PG sovrascrive automati-
camente la lista errori precedentemente generata.

Il file viene generato anche nel caso che non si € presentato alcun errore.

Con questa funzione si convertono i dati di progettazione e i file utente dal formato
dello STEP 5/ST versione 6.x nel formato della versione 7. Il nuovo formato dei file
contiene completi percorsi DOS. Ci sono i seguenti tipi di conversione:

* File progetto PJ » PX da versione 6.x a versione 7.x
* File progetto PX » PJ da versione 6.x a versione 7.x

* File progetto PJ+AP » PX da versione 6.x, con considerazione dei file assegnati
alle Vie Bus, a versione 7.x.

Selezionare il comando di menu Gestione » Converti. Appare sul video il box di co-
mando Converti formati file. Indicare il tipo di conversione, il file sorgente e il file desti-
nazione.

STEP 5/ST V7.0
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17.7 Scelta lingua

\ Gestione

Lingua...

Selezionare il comando di menu Gestione » Lingua. Appare sul video il box di co-
mando Scelta lingua di STEP 5/ST.

Contrassegnare con una crocetta la lingua desiderata e confermare.

17.8 Impostazione colori

\ Gestione

Imposta colori

Rappresentazione
in bianco e nero
per STEP 5/ST
V7.0

Rappresentazione
a colori personaliz-
zata di STEP 5/ST
V7.0

STEP 5/ST V7.0
C79000-G8572-C920-02

Selezionare il comando di menu Gestione » Imposta colori . Appare sul video il box
di comando Colori schermo.

STEP 5/ST é predisposto per monitor a colori.

Se il PC ¢ collegato ad un monitor monocromatico, lo schermo viene visualizzato con
toni di grigio. Se si preferisce una rappresentazione in bianco e nero, € possibile
attivarla per la propria workstation copiando il fle MONO@ @FT.DAT nella propria
directory home e rinominandolo in @@ @@ @ @FT.DAT.

Il file MONO@ @FT.DAT & disponibile nella sottodirectory \S5_INST della directory
di sistema.

La rappresentazione in bianco e nero riguardera STEP 5/ST, i pacchetti opzionali e
i pacchetti COM, nonché i tool come S5DRV.EXE della propria workstation.

La rappresentazione in bianco e nero ha la priorita sulla rappresentazione a colori
personalizzata.

Per disattivare la rappresentazione in bianco e nero della workstation, eliminare il file
@@@@@@FT.DAT dalla propria directory home (vedere anche il capitolo relativo
alla sequenza di ricerca).

| colori dello schermo di STEP 5/ST possono essere modificati dall’'utente.

Tale operazione si rivela particolarmente utile se si vogliono migliorare i toni di grigio
di uno schermo monocromatico oppure se alcuni colori non sono ben distinguibili.

La rappresentazione a colori personalizzata viene impostata con la voce di menu
Gestione/Imposta colori e memorizzata nel file S5@ @@ @FT.DAT della directory
home.

Larappresentazione a colori personalizzata riguardera solo STEP 5/ST nella propria
workstation.

I pacchetti COM eitool quali SSDRV.EXE vengono rappresentati coniloro colori stan-
dard.

Per disattivare la rappresentazione a colori personalizzata nella propria workstation,
eliminare il file SS@@ @ @FT.DAT dalla propria directory home.
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Sommario

Sommario del
capitolo
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18

I menu Documentazione mette a disposizione una serie di funzioni che permette di
emettere su video, su stampante (DIN A3, DIN A4) o su file parti di programmi come,

per esempio:

* blocchi di programma, blocchi dati, liste, strutture
¢ file di testo (file ASCII)

Inoltre esiste la possibilita dianalizzare alcuni dati secondo diversi criteri, per esempio:

* emissione di liste incrociate riferite ad operandi selezionati

¢ ordinamento di liste di attribuzione secondo operandi simbolici

N
| IDocumentazione Cambio |
h Blocchi STEP 5 ... ‘
Blocchi dati ...
Maschere DB...
Lista di attribuzione...
Struttura programma ...
Lista incrociata ...
Tabella occupazione ...
Ordine globale...

Emissione confortevole >
Istruzioni di comando >

|
Capitolo Argomento trattato Pagina

18.1 Panoramica sulle funzioni di documentazione 18-2
18.2 Emissione standard 18-3
18.3 Emissione confortevole 18-11
18.4 Istruzioni di comando 18-20
185 Editazione istruzioni di comando 18-25
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18.1 Panoramica sulle funzioni di documentazione

Emissione
standard

Emissione
confortevole

Istruzioni di co-
mando per emis-
sione confortevole

Hardcopy

18-2

Con questa funzione si emettono parti di programma nel modo in cui sono stati editati.
E' selezionabile la piedinatura. Nel far cio si decide anche se I'emissione avviene da
un file programma o dall’AG (vedere capitolo|18.2)

Le partidel programmavengono emesse con elementigraficiaccessori(linee, caselle,
ecc.) ed una piedinatura. L’emissione puo avvenire soltanto da un file programma e
non direttamente da AG (vedere capitolo (18.3).

Tutte le funzioni per un’emissione confortevole si possono eseguire anche tramite
istruzioni di comando, che si editano e si memorizzano in file. Con queste istruzioni
Si pOossoNo eseguire emissioni ripetute in successione senza dover ogni volta interve-
nire. Tramite le istruzioni di comando sicombinanoi singolifile e si ottiene una struttura
sequenziale. Cio é rappresentabile graficamente mediante la funzione Edita struttura
(vedere capitolo 18.5.6).

Un’hardcopy si ottiene con:
1. iltasto SHIFT + PRINT, sulla stampante collegata

Sotto Windows 95, con questo tasto si ottiene una copia del video che puo
essere emessa su una stampante mediante i mezzi a disposizione nel si-
stema.

STEP 5/ST V7.0
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18.2 Emissione standard

Comandi di menu

Esempio stampa

STEP 5/ST V7.0

C79000-G8572-C920-02

Figura 18-1 mostra i comandi di menu possibili del’emissione standard. Con questa
funzione vengono emessiparti di programmanellaloro forma base (come al momento
dell’editazione) su carta (formato DIN A3, DIN A4), in file o sullo schermo. Nel far cid
si decide anche se I'emissione avviene da un file programma o dall’AG.

S

" [Documentazione | _Cambio
a

Blocchi STEP 5 ...
Blocchi dati ...
Maschere DB...

Lista di attribuzione...
Struttura programma ...
Lista incrociata ...
Tabella occupazione ...
Ordine globale...

{
R

Emissione standard

Emissione confortevole >
Istruzioni di comando >

Figura 18-1 Comandi di menu dell’emissione standard

Avvertenza

Per I'emissione standard non & necessaria una lista incrociata (file *XR.INI).

Il seguente esempio nella rappresentazione KOP (PB 1, SEGMENTO 1) contiene
un blocco STEP 5 nella forma base, cioe¢ il blocco viene stampato cosi come € stato
editato. La piedinatura esistente non viene rappresentata.

PB 1 C:ESE4095ST.S5D LUN=27
Pagina 1

Segmento 1 Titolo SEGM. PB 1 SEGM.. 1

Commento segmento PB 1, SEGM. 1

07.04.92

IE1.2E1.1 All
+—] [+ + + + + +---( )
! :BE

Figura 18-2 Immagine di stampa di un blocco STEP 5
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Impostazioni

Operativita

Emissione

18-4

Deve essere impostato quanto segue:

file programma

il modo di rappresentazione AWL, KOP o FUP

file piedinatura (solo se selezionato Piedinatura: Si)

file simbolico (solo se selezionato SIMBOLICO: Si)

Lista incrociata (- Generazione XREF)

Modo di funzionamento (Online, per emissione da AG)

File stampante (predisposizione NONAMELS.INI valida per PT88).

Con o senza commento

Informazioni circa le relative predisposizioni si trovano al capitolo 4.1.1.

Selezionare un comando di menu, qui p.es. Documentazione » Blocchi STEPS5...

Viene visualizzato il box di comando in questo caso Emetti blocchi STEP 5. In questo
box é possibile muoversi ed eseguire selezioni (- capitolo 3.6 ).

L'emissione avviene a scelta su file, su video o su stampante.

Nel caso di unavisualizzazione di pit pagine su video, una parte dell'immagine risulta
copertadallarichiestain sovraimpressione Avanti?  Si/No . Questo box disegnala-
zione puo essere rimosso premendo il tasto di spazio.

Tutte le stampe possono essere corredate di una piedinatura editabile e selezionabile.

STEP 5/ST V7.0
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18.2.1 Emissione blocchi STEP 5

Funzione Con questa funzione e possibile emettere i blocchi di un file programma nei tipi di rap-
presentazione KOP, FUP o AWL. L'emissione puo avvenire in un file o su stampante.

' Documentazione | Selezionare il comando di menti Documentazione » Blocchi STEP 5 . Appare il
Blocchi STEP 5 box di comando Emetti blocchi STEP 5. Compilare ora i campi di introduzione.

Di seguito vengono illustrati solo i campi di introduzione specifici, in cui appaiono que-
ste alternative:

Campo Chiarimenti
d’introduzione
Numero Vengono emessi i segmenti di un blocco di programma con
segmento i numeri da/a
daf ]
al ]
Rappresentaz. Solo se ¢ selezionata la rappresentazione AWL:
con indirizzo Scelta del tipo di indirizzamento
AWL
18.2.2  Blocchi dati
Funzione Con questa funzione ¢ possibile emettere i blocchi dati di un programma, a piacere,

singolarmente oppure tutti insieme.

\ Documentazione \ Selezionare il comando di menu Documentazione » Blocchi dati . Appare il box
Blocchi dati di comando Emetti blocchi dati. In questo box €& possibile muoversi ed eseguire
selezioni.
Esempio di Nelbox Imposta (vedere capitolo4.1.1, scheda Blocchi)  stato selezionato Con com-
emissione menti.
DB 10 C:BSPXXXST.S5D LUN=25 /16
Pagina 1
0: KH = 0000; Figura
1: KC ='DB 10 per AG 90'; Blocco per AG90
10: KT = 010.1;
11: KT = 020.1;
12: Kz = 010;
13: Kz = 020;
14: KM = 00000000 00000000; Rappres. a bit 1
15: KM = 00000000 00000000; Rappres. a bit 2
16: KF = +00010;
17: KF = +00020;
18: KH = 000;
19: KH = 000;

Figura 18-3 Esempio di emissione di blocchi dati

STEP 5/ST V7.0
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18.2.3 Maschere DB

Funzione Con questa funzione € possibile emettere su stampante o infile i blocchi dati che con-
tengono maschere.

' Documentazione ' Selezionare il comando di menti Documentazione > Maschere DB . Appare il
Maschere DB box di comando Emetti maschere DB.

18.2.4 Emissione lista di attribuzione

Funzione Congquestafunzione & possibile emettere sustampante oinfile unalistadiattribuzione.
\ Documentazione \ Selezionare il comando di menu Documentazione » Lista di attribuzione . Ap-
Lista di attri- pare il box di comando Visualizza lista di attribuzione.
buzione
Esempio File C:WXA409Z0.SEQ
Operando Simbolo Commento
E 1.1 ING 1 Ingresso 1.1
E 1.2 ING 2 Ingresso 1.2
E 13 ING 3 Ingresso 1.3
E 21 S 21 Ingresso 2.1

Figura 18-4 Esempio: emissione di una lista di attribuzione

18.2.5  Struttura del programma

Funzione Con questa funzione vengono emesse le relazioni di richiamo (panoramica sul pro-
gramma) dei singoli blocchi di un programma utente. La panoramica sul programma
puo essere emessa dal file programma oppure dallAG. L'emissione si suddivide in
3 parti:

1. Elenco di tutti i blocchi, eventualmente con i nomi simbolici, inclusa la lunghezza
(numero di word) dei singoli blocchi.

2. Elenco di tutti i tipi di blocco del file programma, inclusa la lunghezza dei bloc-
chi di un tipo.

3. Panoramica dei programmi nella quale viene dato il concatenamento dei ri-
chiami (profond. max. di annid. pari a 8 richiami di blocco) dei singoli blocchi a
partire dal tipo di blocco OB. Viene inoltre emesso per ciascun blocco la lun-
ghezza e il simbolo, per ciascun tipo di blocchi la lunghezza totale di tutti i
blocchi di questo tipo, e la lunghezza di tutti i blocchi.

Documentazione \ Selezionare il comando di mend Documentazione » Struttura programma . Ap-
Struttura pro- pare il box di comando Emetti struttura programma.
gramma

STEP 5/ST V7.0
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Esempio

Identificazioni
blocco
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Emissione standard di una struttura di programma con blocchi.

Struttura programmaconDB Pagina 1
PB 1 Lunghezza : 9
PB 2 Lunghezza : 21
PB 3 Lunghezza : 9
PB 12 Lunghezza : 25
FB 10 Lunghezza : 50
OB 1 Lunghezza : 13
DB 10 Lunghezza : 28
Lunghezza : PB 64
Lunghezza : SB 0
Lunghezza : FB 50
Lunghezza : FX 0
Lunghezza : OB 13
Lunghezza : DB 28
Lunghezza : DX 0
Lunghezza : 155
Struttura programma con DB Pagina 2
+-OB l—I+:PB l—TDB 10—

| +=PB 3-+FB 10

| |

| |

Figura 18-5 Struttura programma con DB

Nel protocollo di stampa i blocchi sono corredati di identificazioni. Queste definiscono
il tipo di richiamo del blocco all'interno del programma.

Simbolo Chiarimento

- Blocco richiamato in modo assoluto.

= Blocco richiamato in modo condizionato.

# Richiamo di blocco dopo un comando B DW oppure B MW
(indirizzamento indiretto)

? Richiamo di blocco come operando formale. Un operando attuale
puo essere emesso come costante o come codice operazione MCS5.

??????? |l blocco richiamato non é presente nel file programma.

IF113! Sono presenti altri richiami di blocco che non possono perod essere
rappresentati (profondita di annidamento troppo elevata).

IF114! Richiamo di blocco ricorsivo, per esempio richiamo di un OB in un

PB.
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18.2.6 Emissione lista incrociata

Funzione Con questa funzione & possibile generare una lista incrociata da un file programma
presente o dalla memoria del’AG

In particolare & possibile richiedere:

¢ Riferimenti alla sigla operando, per esempio E, A, M, T, Z.
Riferimenti a dati
Riferimenti alla periferia
Riferimenti a richiami di blocco

(I merker S non possono essere emessi in una lista incrociata.)
¢ Riferimenti ai singoli operandi simbolici o assoluti (p.es. -MOTORE, E1.0)

| riferimenti incrociati sono ordinati secondo gli operandi assoluti. Una registrazione
€ quindi costituita da:

* operando,
e simbolo,
* blocco con segmento,

e carattere di identificazione aggiuntivo per il tipo di utilizzo (vedere la figura 18-6)

Documentazione Selezionare il comando di menu Documentazione » Lista incrociata. Dopo il ri-
Lista incrociata chiamo della funzione appare il box di comando Emetti lista incrociata. Nella se-
guente tabella sono illustrate soltanto alcune specifiche introduzioni.

Campo d'introduzione Chiarimento

Lista incrociata

tutti elementi Tutti gli elementi (operandi) di seguito riportati
vengono emessi nell'ordine E, A, M, T, Z, B, P,
D.

Merker, blocchi dati, Viene emessa la lista incrociata solo per quanto

ingressi, temporizzatori, selezionato.

periferie, uscite, contatori,
richiami di blocchi

Operando singolo Definizione della presenza di un operando in
tutti i blocchi. Se & indicato solo un blocco
viene emessa una segnalazione. F3 = Scegli
non & qui possibile.

STEP 5/ST V7.0
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Lista incrociata: Merker N. segmento

M 32.1 -Merk321 PB1 1%, 2, 4

M 32.2 -Merk322 PB1 1, 2, 5,7?
PB 2 1

M 33.3 -Merk333 PB1 3%, 4 ,5,6*

Operando Nome /N. blocco \ Operando come

) . assegnazione
simbolico  Bjocco

Operando come interrogazione

Figura 18-6 Esempio di lista incrociata

Significato dei Simbolo Chiarimento
simboli Blank Operando utilizzato in interrogazione (p.es.: -U E 1.0)
* Operando utilizzato in assegnazione (p.es.: A 1.1).
? Operando come parametro di richiamo di FB. E possibile emettere

un’operando attuale come costante o codice macchina MC 5.

# Operando segue comando B DW o B MW (indirizzamento indi-
retto).
S Operando utilizzato in un FB standard.

! Operando utilizzato in un FB standard ed in un blocco utente.
Carattere di continuazione dei riferimenti degli operandi

A Significata continuazione dei riferimenti degli operandi.

18.2.7  Emissione tabella occupazione

Funzione Con questa funzione € possibile emettere su video, stampante o file una tabella di
occupazione. Essa fornisce una panoramica di quali bit sono utilizzati nei vari byte
dei campi di operandi E, A, M. Per ogni 2 byte di un campo di operandi & prevista una
riga nella quale vengono contrassegnati gli 8 bit possibili (vedere figura 18-7).

* un byte (B)
e una word (W)

* una doppia word (D)

Documentazione . Selezionare il comando di ment Documentazione » Tabella occupazione . Ap-
Tabella pare il box di comando Emetti tabella occupazione.
occupazione

STEP 5/ST V7.0
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Esempio Pagina 1

Tabella occupazione E/A/M

PB 1 Elaborato
PB 2 Elaborato
PB 3 Elaborato
PB 12 Elaborato
FB 10 Elaborato
OB 1 Ealborato
Pagina 2
Tabella occupazione
Ingressi presenti nel programma
176543210 BWD | 176543210 BWD !
—_ — — 1 — — —— —
Byte 0 !-——— 1 _ 1 Byte 1 |- —— ——— 1 _ |
Byte 2 |- - — XX-!—- - -1 Byte 3 !-—-—-—-—--—— - = =1
Byte 4 - _ X-l—— -1 Byte 5 !————————l— — _1I
Bytt 6 !-———————1- — —1 Byte 7 l-——————— - - 1
Byte 8 1-——- - ———— - — -1 Byte 9 I-—————— -1 — |
Byte10 - ——— - ——— [ Byte 11 - ———————1— — —1
\/’\! \_A|
Figura 18-7 Esempio: tabella occupazione standard
Significato dei simboli contenuti in una tabella di occupazione:
Simbolo Chiarimento
"Blank” Operando utilizzato in istruzione a byte, word o doppia word, e
non come istruzione a bit.
- Operando non utilizzato.
X Sull’'operando viene eseguita un’istruzione a bit.
# Operando dopo un’istruzione B MW oppure B DW.
S Operando utilizzato in un FB standard.
? Operando come parametro di richiamo di FB.
! Operando utilizzato in un FB standard ed in un FB utente.
18.2.8  Emissione ordine globale
Funzione Con questa funzione si attiva un ordine globale grazie al quale € possibile emettere

senza interruzioni, su video, su stampante o in un file:
* panoramica programmi

¢ tabella occupazione

¢ |ista incrociata

Per I'emissione standard non si necessita di una lista incrociata (file *XR.INI).

Documentazione \ Selezionare il comando di menu Documentazione » Ordine globale . Appare il
Ordine globale box di comando Emetti ordine globale.

STEP 5/ST V7.0
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18.3 Emissione confortevole

Sommario

Scelta funzioni
confortevoli

Esempio di stampa

STEP 5/ST V7.0
C79000-G8572-C920-02

La funzione Emissione confortevole, conosciuta finora anche come KOMDOK, per-
mette di documentare in modo completo e quasi automaticamente (tramite istruzioni
di comando) programmi STEP 5 e GRAPH 5. Al contrario dell’emissione standard
qui si puo, per esempio, catalogare o analizzare i dati di programma che inoltre ven-
gono anche preparati per la rappresentazione grafica .

Un'ulteriore particolarita rispetto all’Emissione standard é la possibilita di emettere
iprogrammiconlinee diseparazione (vedere alriguardolefigure 18-9e 18-10). L'emis-
sione é possibile in formato A4 oppure A3. | programmi da emettere si devono trovare
sudischetto o hard disk. Seiprogrammisitrovano solo nellamemoriadell’AG, bisogna
provvedere innanzitutto al trasferimento da AG a dischetto o hard disk.

L'emissione confortevole si contraddistingue dal fatto che definendo le cosiddette —
Istruzioni di comando (vedere cap.18.4) diventa possibile automatizzare la sequenza
di emissione senzainerenti operativi. Per tutte le funzioni dell’emissione confortevole
esistono le relative istruzioni. Le istruzioni di comando vengono memorizzate in un
file a scelta.

Dopo la scelta della funzione Emissione confortevole viene visualizzato un menu nel
guale si possono selezionare le seguenti possibilita di emissione:

| [Documentazione " Cambio

a Blocchi STEP 5 ... ‘r

Blocchi dati ...

Ma:
List | Blocchi ...

Stri | Maschere DB1 ...
List| Lista blocchi ...
Tat| Lista di attribuzione ...

Orc

Struttura programma. ...
Lista incrociata ...
Em Tabella di occupazione ...
Col| Tapella occupazione merker S
mmm | Lista di controllo ...

File di testo ...

La prima stampa, nella figura 18-8, & stata eseguita con I'emissione confortevole, la
seconda, nella figura 18-9, con I'emissione standard. Notare le differenze.

18-11
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Schema logico
Blocco: PB 1 Simbolo: Garage Commento: Comando porta garage tramite tasti N. bibl.:  Lungh: 25
Segmento 1 0000 APERTURA PORTA da interno o esterno
Esterno: premere tasto APRE e commutatore a chiave
Interno: premere tasto APRE.
La porta si apre fino al finecorsa superiore a all'attivazione del tasto ALT-EMERGENZA
-APRE-est
-CHIAVE >=1
-APRE-int ———
-PORTA-ap &
-FIN.sup. 0
-ALT-EMER 0 *—{=_ |-APPORTA
Operando Operando simbolico Commento operando
E 1.2 APRE est Tasto APRE dall’esterno
E 1.5 APRE int Tasto APRE dall'interno
E 1.0 FIN.sup. finecorsa superiore
E 0.0 ALT-EMER Tasto ALT o emergenza
E 1.4 CHIAVE Commutatore a chiave esterno
A 1.0 AP.PORTA Apertura porta tramite motore
DATA: 8.09.92 TEST COLLAU: KOMDOK/ST SIEMENS TEST: CON EMULATORE PCP/M PER N.FM.:
ELAB: Xz VERSIONE: V4.0(7.9.92) MILANO (v2.1, 8/92) PERN.PR.: BLNR
SOTTO: MS-DOS (V5.0
TEST SYSTEM: AUT E1 161 B 1
PG 770 File programma: Blocco:  Segm:
con DR21IN ‘ PIEDINATURA: KODOEMF2.INI H SIMATIC S5 A:GARAGEST.S5D PB 1 1
Figura 18-8 Stampa confortevole di uno schema funzionale
PB 1 -Garage A: GARAGEST.S5D N. bibl.: Lungh: 25
Segmento 1 0000 APERTURA PORTA da interno o esterno.
Esterno: premere su tasto APRE e chiave
Interno: premere su tasto APRE
La porta si apre fino al finecorsa superiore o all'attivazione del tasto ALT
-APRE est —‘7&7
-CHIAVE —‘ j —— J>:ﬂ
-APREINt ——
-PORap | | — Tgl
-FINsup — — 0‘ |
-ALTEMER — —o| _f——*—{= _ |AP-PORTA
E 1.2 = APREest Tasto APRE dall’esterno
E 1.5 = APREint Tasto APRE dall'interno
E 1.0 = FIN.sup Finecorsa superiore
E 0.0 = ALT-EMER Tasto ALT o emergenza
E 1.4 = CHIAVE Commutatore a chiave esterno
A 1.0 = AP-PORTA Apertura porta tramite motore
[DATA: 80092 | TESTCOLLAU:  KOMDOK/ST |SIEMENS | TEST CONEMULATOREPCPM | PERNFM: | |
. . Vvao(e9 [ (v2.1, 8/92) PER N.PR.:
ELA%S?STJTY% _| VERSIoNE: Va0t | MiLANO | sorro: MS-DOS (V50) | — — — — — —] | BLAR|
| e o L Lareiss b s Biowo Segm: | Y
l con DR21IN PIEDINATURA: KODOEMF2.INI LSIMATIC S5 A:GARAGEST.S5D PB 1 1 J J J

Figura 18-9 Stampa semplice di uno schema funzionale

STEP 5/ST V7.0

18-12 C79000-G8572-C920-02



Documentazione

18.3.1 Emissione blocchi KOMDOK

Funzione Questa funzione permette di emettere in formato DIN A3 o DIN A4 blocchi nei tipi di
rappresentazione KOP, FUP o AWL, con o senza liste incrociate (riferimenti), con o
senza dati di set diagnosi. L'emissione puo anche avvenire in un file (*LS.INI).

Documentazione \ Selezionare il comando di menu Documentazione » Emissione confortevole »
Emiss. confort. Blocchi . Appare il box di comando Emetti blocchi KOMDOK. In questo box &
Blocchi possibile muoversi ed eseguire selezioni. Di seguito vengono spiegate le introdu-

zioni specifiche:

Introduzione Chiarimento
Con riferimenti Riferimenti diretti : se nel segmento stampato gli operandi
diretti e indiretti sono oggetto di operazioni di assegnazione, vengono stam-

pate le parti di programma nelle quali avvengono le relative
interrogazioni.

Riferimenti indiretti : se nel segmento stampato vengono
interrogate uscite o merker, vengono stampate le parti di
programma nelle quali avvengono le relative assegnazioni.

Ad ogni stampa vengono stampati tanti riferimenti per istru-
zione quanti permessi dal layout di una riga. Ulteriori riferi-
menti nel programma sono contrassegnati con la sequenza
>>> alla fine della riga.

Layout Con F7 viene visualizzato un esempio per layout standard e
per layout opzionale.

Aggiornamento Prima dell’emissione dei blocchi viene aggiornato il file
XREF QVL.

18.3.2 Emissione maschere DB1 KOMDOK

Funzione Questa funzione emette il blocco dati con I'assegnazione periferia in formato DIN A3
o DIN A4. E anche possibile emettere in un file (*LS.INI)

\ Documentazione Selezionare il comando di menu Documentazione » Emissione confortevole »
Emiss. confort. Maschere DB1 . Appare il box di comando Emetti maschere DB1 KOMDOK.
Maschere DB1

18.3.3 Emissione lista blocchi KOMDOK

Funzione Con questa funzione ¢ possibile emettere in formato DIN A3 o DIN A4 una lista di
blocchi su stampante o in un file (*LS.INI). Nella lista sono riportati tutti i blocchi di
programma ed i blocchi dati del file programma impostato.

STEP 5/ST V7.0
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Documentazione

Emiss. confort.
Lista blocchi

18.3.4

Funzione

Documentazione

Emiss. confort.
Lista di attri-
buz.

18-14

Per i blocchi interessati, nella lista si ottengono informazioni circa:

¢ tipo di blocco

e numero di blocco

* nome simbolico (se impostato "Simbolico: Si”)

e commenti di operandi

* |unghezza del blocco

* numero biblioteca (BIB)

¢ file di documentazione con indicazione delle lunghezze

* piedinatura

Selezionare il comando di menu Documentazione » Emissione confortevole »
Lista blocchi. Secondo le impostazioni viene emessa una lista di blocchi su
stampante, su carta o sul file predisposto. Durante la generazione della lista di
blocchi appare la segnalazione

Stampa lista di blocchi

Quando questa segnalazione scompare e non appare alcuna segnalazione di errore,
la lista blocchi &€ emessa e la funzione € completata.

Emissione lista attribuzione KOMDOK

Una lista di attribuzione pud essere emessa:

* in forma sequenziale, come editato

¢ ordinata secondo operandi assoluti

¢ ordinata secondo operandi simbolici

Selezionare il comando di menu Documentazione » Emissione confortevole »

Lista di attribuzione

DOK.

. Appare il box di comando Emetti lista di attribuzione KOM-

La lista di attribuzione puo essere emessa nei seguenti modi:

Introduzione

Chiarimento

Emissione stan-
dard della lista di
attribuzione

Emissione non ordinata. Predisposizione Simbolico non
rilevante.

Llista di
attribuzione
ordinata secondo
operandi assoluti

Emissione ordinata secondo gli operandi assoluti. Per que-
sti operandi vale la sequenza E, A, M, S, T, Z, B, P, D, e per
ogni tipo viene iniziata una nuova pagina. Deve essere
predisposto Simbolico: Si.

Lista di
attribuzione
ordinata secondo
operandi simbolici

Emissione ordinata secondo gli operandi simbolici. Per
guesti operandi vale la sequenza E, A, M, S, T, Z,B,P, D, e
per ogni tipo viene iniziata una nuova pagina. Deve essere
predisposto Simbolico: Si.

Layout Con SHIFT F8 o con il tasto Help viene visualizzato un
Standard esempio di formato standard.
Opzionale Rilevante solo in formato DIN A3. Operativita come sopra.

STEP 5/ST V7.0
C79000-G8572-C920-02




Documentazione

Dopo aver lasciato il box di comando con OK, appare il messaggio:

Stampa lista di attribuzione

Quando questa segnalazione scompare, la funzione viene completata e, se non &
apparso alcun errore, la lista di attribuzione viene emessa.

18.3.5 Emissione struttura del programma KOMDOK

Funzione

Documentazione

Emiss. conf.
Strutt. pro-
gramma

STEP 5/ST V7.0
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Con questa funzione & possibile emettere le relazioni di richiamo dei blocchi di un
file programmainformato DINA30oDIN A4 sucartaoinunfile (*LS.INI). PerI'emissione

vale quanto segue

¢ |l tipo di richiamo €& definito prima di ogni blocco.

¢ |l nome del blocco viene definito in modo assoluto e simbolico , ma solo se &
stato selezionato SIMBOLICO: Si (- Progetto capitolo 4.1.1).

¢ La profondita di annidamento protocollabile & al massimo 9.

¢ |l protocollo pud avvenire con o senza blocchi dati.

Possono essere protocollati i seguenti tipi di richiamo:

Richiamo Significato

SPA richiamo assoluto di un blocco

BA richiamo assoluto di un blocco funzionale (FX)
SPB richiamo condizionato di un blocco

BAB richiamo condizionato di un blocco funzionale (FX)
A richiamo di un blocco dati

AX richiamo di un blocco dati (DX)

E generazione di un blocco dati

EX generazione di un blocco dati (DX)

Al blocco come parametro (richiamo operando formale)
# richiamo di un blocco

*REK* richiamo ricorsivo di un blocco

Selezionare il comando di menu Documentazione » Emissione confortevole »
Struttura programma. Appare il box di comando Emetti struttura programma
KOMDOK. Di seguito vengono illustrate le introduzioni specifiche.

Introduzione

Chiarimenti

File programma

Qui non selezionabile. Deve essere predisposto
(- Progetto, cap. 4.1.1)

Struttura
programma del
blocco

La struttura del programma viene emessa a partire dal
blocco definito.

senza richiami
DB

I blocchi dati non vengono considerati nella struttura.

con richiami DB

| blocchi dati vengono considerati nella struttura.

Emissione

Come in tutti i box di comando.
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Esempio di
emissione

Dopo aver lasciato il box di comando con Emetti, appare la segnalazione:

Stampa struttura programma

Quando questa segnalazione scompare, se non € apparsa alcuna segnalazione di
errore, la struttura del programma viene emessa e la funzione completata.

Struttura del programma senza blocchi dati

Livello 1 Livello 2 Livello 3 Livello 4 Livello 5

OB 1 PB1 FB 10 FX 11 DX 11
BI.Org. | + SPA —_ PROG 1 +_SPB | Bl.Funz-+_BAB — —+_AX — Esp.DB
DB 10 FX 20 DX 12 DB 16
+ A | Dati ++_BA | Esp.FX I+ EX — |+ # — Esp.DB

DB 14
+ Al —| Dati -
v

Figura 18-10 Emissione di struttura del programma senza DB

18.3.6 Emissione lista incrociata KOMDOK

Funzione

Documentazione

Emiss. conf.
Lista
incrociata

18-16

Con questa funzione e possibile emettere da una lista incrociata (*XR.INI), secondo
criteri predefiniti, i riferimenti all'interno del file programma.

In particolare é possibile ottenere:
* Liste incrociate secondo sigla operando, p. es. E, A, M ...

* Liste incrociate secondo singoli operandi simbolici o0 assoluti (per esempio
E 1.0, MOTORE) del file impostato.

Avvertenza

Al riguardo bisogna fare attenzione che sia sempre presente una lista incrociata
(file L1) del file programma valido per I'emissione dei riferimenti (- Gestione,
Genera XREF).

Se il programma viene modificato, deve essere generata una nuova lista incrociata.

Selezionare il comando di menu Documentazione » Emissione confortevole »
Lista incrociata. Appare il box di comando Emetti lista incrociata KOMDOK. Di
seguito vengono illustrate le introduzioni specifiche.

STEP 5/ST V7.0
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18.3.7

Funzione

Documentazione

Emiss. conf.
Tabella di
occupazione

STEP 5/ST V7.0
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Introduzione

Chiarimento

Scelta

tutti gli elementi

Tutti gli elementi vengono emessi secondo la
sequenza E, A, M, S, T, Z, B, P, D, una pagina per
ogni tipo.

Merker, merker S,
blocchi dati, ingressi,
temporizzatori, periferie,
uscite, contatori,
richiami di blocchi,
operandi singoli

Questi operandi vengono singolarmente selezionati e
solo per quello selezionato viene emessa la lista in-
crociata.

Operando singolo

L'indicazione di un singolo operando (assoluto o
simbolico). F3 = Sceglinon € qui possibile. SHIFT F8
fornisce chiarimenti sul campo d’introduzione.

Layout
Standard Con SHIFT F8o il tasto Help, viene visualizzato un
esempio di formato standard.
Opzionale Rilevante solo in formato DIN A3. Operativita come

sopra.

Standard in forma
compatta

Compatta significa: se un operando viene utilizzato n
volte nello stesso segmento e con la stessa opera-
zione, il segmento non viene riportato n volte ma una
sola.

Dopo aver lasciato il box di comando con Emetti, appare il messaggio:

Stampa lista incrociata

Quando questa segnalazione scompare, la funzione viene completata e, se non &
apparsa alcuna segnalazione di errore, viene emessa la lista incrociata.

Emissione tabella di occupazione KOMDOK

Con questa funzione é possibile emettere una tabella di occupazione. Essa fornisce
una panoramica di quali bit sono utilizzati nei vari byte dei campi operandi M, E, A.
Per ogni byte di un campo di operandi € prevista una riga nella quale vengono rappre-
sentati gli 8 bit. Viene inoltre evidenziato se I'istruzione elabora

* un byte (B)
e una word (W)

* una doppia word (D)

Una tabella di occupazione viene emessa senza ulteriori richieste da parte dello
STEP 5 su carta o sul file predisposto. Durante I'emissione della tabella occupa-
zione appare la segnalazione:

Stampa tabella occupazione
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Quando questa segnalazione scompare, lafunzione € completatae, se non € apparsa
alcuna segnalazione di errore, la tabella occupazione € stata emessa e la funzione
€ completata.

Avvertenza

Si tenga presente che deve essere sempre presente una lista incrociata attuale
(file L1) del corrente file programma per I'emissione di riferimenti (- Gestione -

Genera XREF).
Simbolo Chiarimento
Blank Operando utilizzato in un’istruzione a byte, word o doppia word, e
non in un’istruzione a bit.
- Operando non utilizzato.
X Con I'operando viene realizzata un’istruzione a bit.
# Operando dopo un’istruzione B MW oppure B DW.
S Operando utilizzato in un FB standard.
? Operando come parametro di richiamo di FB.
! Operando utilizzato in un FB standard ed in un FB utente.
Esempio Tabella
occupazione Tabell _ | _
Ingressi abella occupazione Ingressi
176543210 BWD 1 176543210 BWID !
Bte 0 1__ _ ____ _1_ _ 1 Byte 32 1. __ __ _1_ _ 1
Byte 1 1 _ X X-=!- = ! Byte 33 - - - - - — - - 1
Byte 2 !_ _ _ _ _ _ X! - - 1 Byte 34 !_ _ _ _ _ _ __1_ _ _1
Byte 3 !l _ _ _ _ _ _ _ ([ Byte 35 ) R |
Byte 4 0V Byte 36 [ [ I
Byte 5 e — - — — ' ! Byte 37 [
N T N T

Figura 18-11 Tabella di occupazione

18.3.8  Emissione tabella di occupazione merker S KOMDOK

\ Documentazione \ Con questa funzione € possibile emettere la tabella di occupazione dei merker S

Emiss. conf. (vedere la figura 18-11 Tabella di occupazione).
Tabella occupa-
zione merker S

STEP 5/ST V7.0
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18.3.9 Emissione lista di controllo KOMDOK

Funzione

Documentazione

Emiss. conf.
Lista di
controllo

Questa funzione analizza il file programma. Secondo I'opzione viene emesso:
Opzione Chiarimento

Operandi liberi Sono operandi presenti nella lista di attribuzione ma non nei
blocchi di programma. Sequenza E, A, M, S, T, Z, B, P, D.

Sigla mancante Sono quegli operandi nei blocchi programma ai quali
non é associato alcun simbolo nella lista di attribuzione.
Tra gli operandi viene emessa una sequenza crescente.

Selezionare il comando di ment Documentazione » Emissione confortevole »
Lista di controllo . Appare il box di comando Emetti lista di controllo KOMDOK.

18.3.10 Emissione file di testo KOMDOK

Funzione

Documentazione

Emiss. conf.
File di testo

STEP 5/ST V7.0
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Con questa funzione e possibile emettere file LS oppure altri file ASCII su stampante
oinun file LS.INI. Esiste la possibilita di emettere i file di testo con una piedinatura,
anche se questa non fa parte del file di testo. E dunque possibile inserire a posteriori
una piedinatura.

Selezionare il comando di menu Documentazione » Emissione confortevole »
File di testo . Appare il box di comando Emetti file di testo KOMDOK.
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18.4 Istruzioni di comando

Sommario delle
funzioni

Struttura delle
istruzioni di
comando

18-20

Tuttele funzionidiun’emissione confortevole possono essererealizzate anche tramite
istruzionidicomando. Taliistruzioni vengono disposte come un programma, memoriz-
zate in un file (file Submit) e quindi eseguite tramite un richiamo di questo file. Confor-
memente all’editazione di tali istruzioni viene effettuata un’emissione confortevole.

Una sequenza di istruzioni di comando é costituita da istruzioni di comando per
e predisposizioni ($)
e comandi(-)

e commenti ( ;) (se necessario)

I singoli file diistruzioni di comando possono essere richiamati da un comando conte-
nuto in una sequenza di istruzioni di comando (figura 18-12). Subito dopo vengono
eseguite le istruzioni di comando contenute nel file richiamato. Quando la sequenza
diistruzioni del file &€ eseguita, viene proseguita la sequenza di istruzioni di comando
richiamante.

Con questi comandi & possibile generare sequenze di istruzioni (strutture) a piacere.
Per rendere comprensibile una sequenza di istruzioni anche molto complessa ven-
gono messe a disposizione due funzioni:

- Editazione struttura. La combinazione dei singoli file di istruzioni di
comando viene rappresentata in forma grafica.

- Emissione struttura. Rappresentazione grafica.

ESEMPIO1 ESEMPIO2 ESEMPIO3
$Predisposizione $Predisposizione $Predisposizione
—Comando —Comando —Comando
—Comando —Comando —Comando
—Comando —Comando —Comando
—ISTR.COM.:ESEMP23 | _|STR.COM..ESEMP3}-

—Comando
—ISTR.COM..ESEMP3}-

EXAMP3
$Predisposizione
—Comando
—Comando
—Comando

Figura 18-12 Strutture di istruzioni di comando (esempio)

STEP 5/ST V7.0
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18.4.1

Preimpostazioni

Tabella 18-1 Sintassi delle istruzioni di comando

Istruzioni di comando

Chiarimento

$KOP, $FUP, $SAWL

Rappresentazione: secondo schema a contatti (KOP), schema logico
(FUP) o lista istruzioni (AWL).

SKAT: XN ..\

Impostazione directory: la directory impostata e utilizzata nei comandi
SUBMIT $PROG, $SYMB, $SFUSS, $DLST e -STEUERANW (vedere
tabella 18-5).

$PROG:X:NNNNNN

File programma: selezione nel drive X con il nome NNNNNNST.S5D.

$SIMB:X:NNNNNN

File simbolico: selezione nel drive X con il nome NNNNNNZO.INI.

$SIMB:NO

Operandi simbolici: non vengono emessi.

$PIED:X:NNNNNN

File piedinatura: selezione nel drive X con il nome NNNNNNF2.INI.

$STAMPA:X:NNNNNN

Il file stampante € identificato sotto questo nome. Pertanto viene dapprima
ricercato nella directory ..\S5_HOME\ (file stampante modificati o generati
dall'utente) e successivamente nella directory ..\S5_SYS\DR_INN (file
stampante forniti, che sono copiati in questa directory dal programma di
installazione).

$VIA:X:NNNNNN

Nome Via: I'indicazione non ha alcun effetto.

$PAGINA:nnnn

Numero pagina: si inizia il conteggio pagine dal numero nnnn.

$DLST:X:NNNNNN

Emissione su file: tutte le emissioni vengono memorizzate sul drive X con il
nome NNNNNNLS.INI

$DLST:NO

Emissione nuovamente su stampante.

$CARATT:ASCII

Layout: costruito con il set di caratteri ASCII (tratti realizzati con lineette).

$CARATT:SEMI-GRAFICA

Layout: costruito con il set di caratteri IBM.

$CONTENUTO Indice: da questa istruzione di comando viene generato un indice del con-
tenuto. Questa predisposizione non puo essere resettata nel Submit cor-
rente.

$PAUSA:COMMENTO Interruzione dell’'elaborazione dell'istruzione di comando; il commento

viene visualizzato nell’'ultima riga dello schermo; premendo un tasto ter-
mina l'interruzione.

I comandi $PROG, $SYMB, $SFUSS, $DLST e STEUERANW devono identificare completamente la directory. Pertanto ci

sono tre possibilita:

1. Vieneindicato un comando $KAT per I'impostazione della directory e soltanto il drive e il nome file nel comando SUBMIT,

p.es.:
$KAT:C:\DATEN\TEST
$PROG:C:NONAME

Nel SUBMIT come file programma viene utilizzato C:\DATEN\TEST\NONAMEST.S5D.

2. Non viene utilizzato nessun comando $KAT e vengono indicati solo il drive e il nome file, p.es.:

$PROG:C:NONAME

Come directory viene utilizzata la directory usata nell'impostazione progetto per i vari tipi di file (in questo caso per il file

programma).

3. Nel comando SUBMIT viene descritta la directory completa, p.es.:
$PROG:C:\DATEN\TEST\NONAME

STEP 5/ST V7.0
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18.4.2 Comandi

Tabella 18-2 Istruzioni comandi blocchi

(p.es. PB1, PB2-PBn)

Istruzione di comando Chiarimento
—-BLOCCO:B Tutti i blocchi
-BAUST:# Tutti i file di documentazione
—BLOCCO:0OB Tutti i blocchi organizzativi
—BLOCCO:PB Tutti i blocchi di programma
—BLOCCO:FB Tutti i blocchi funzionali
—BLOCCO:FX Tutti i blocchi funzionali estesi
—-BLOCCO:SB Tutti i blocchi sequenziali
—BLOCCO:DB Tutti i blocchi dati
—BLOCCO:DX Tutti i blocchi dati estesi
—BLOCCO: Una lista di blocchi

—BLOCCO:PBx, 1, 3-5

Una lista di singoli segmenti di un blocco.

Se si vogliono emettere i blocchi con riferimenti, cid deve essere indicato tramite opzione.

Tabella 18-3 Istruzioni di comando per blocchi con opzioni

Istruzione di comando

Chiarimento

—BLOCCO(R):B

Tutti i blocchi con riferimenti

—BLOCCO):PBx

PBx in layout opzionale (rilevante solo in FUP in formato A3).

—BLOCCO(RO):PBx

PBx con riferimenti in layout opzionale (rilevante solo in FUP in formato

A3).

—BLOCCO:#NNNNNN

Blocco di documentazione con nome NNNNNN (max. 8 caratteri).

Tabella 18-4 Istruzioni di comando per lista di blocchi

Istruzione di comando

Chiarimento

—BLIST

Emissione della lista di blocchi del file programma preimpostato.

18-22
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Tabella 18-5 Istruzione di comando con annidamento

Istruzione di comando Chiarimento
—ISTRUZ_COM:x:nnnnnn | Il file di istruzioni di comando nnnnnnSU.INI viene richiamato ed elaborato.

Da una sequenza di istruzioni di comando & possibile richiamare altre sequenze di istruzioni di comando. La mas-
sima profondita di annidamento € pari a 6. La ricorsivita non & permessa e non viene accettata in fase di test o
di attivazione di un file di istruzioni di comando (- Editazione struttura).

Tabella 18-6 Indice del contenuto

Istruzione di comando Chiarimento

—CONTENUTO L'indice viene emesso con la piedinatura corrente. Il numero di pagina ini-
zia automaticamente da | e viene ripristinato alla fine dell'indice.

—CONTENUTO:n La numerazione di pagina dell'indice iniziada n (n=1, 2...)

Viene emesso l'indice di tutte le emissioni effettuate qualora precedentemente sia stata attivata I'impostazione
$CONTENUTO (vedere tabella 18-1).

Tabella 18-7 Lista di controllo

Istruzione di comando Chiarimento

—LISTA CONTR/FO Vengono elencati gli operandi presenti nella lista di attribuzione ma non
utilizzati nei blocchi.

—LISTA CONTR/FB Vengono elencati gli operandi utilizzati nei blocchi ma non hanno un corri-
spondente simbolo nella lista di attribuzione.

Tabella 18-8 Struttura del programma

Istruzione di comando Chiarimento
—XREF:programma, Emissione della struttura del programma da OBn (n=0-255), senza blocchi
(OBnN) dati.
—XREF(D):programma, Emissione della struttura del programma dal PBn (n=0-255), con blocchi
(PBn) dati.

Tabella 18-9 Lista incrociata

Istruzione di comando Chiarimento
—XREF:GENERAZIONE Dal file programma impostato viene generata la lista di riferimenti (*XR.INI).
—XREF:STAMPA, (E) Emissione degli operandi di ingresso.
—XREF:STAMPA, (A) Emissione degli operandi di uscita.
—XREF:STAMPA, (M) Emissione dei merker.
—XREF:STAMPA, (S) Emissione di tutti i merker S.
—XREF:STAMPA, (T) Emissione di tutti i temporizzatori.
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Tabella 18-9 Lista incrociata, continuazione

Istruzione di comando

Chiarimento

—XREF:STAMPA, (2)

Emissione di tutti i contatori.

—XREF:STAMPA, (B)

Emissione di tutti i blocchi.

—XREF:STAMPA, (P)

Emissione di tutte le periferie.

—XREF:STAMPA, (D)

Emissione di tutti i dati.

—XREF:STAMPA, (X)

Ordine globale per tutti gli elementi emettibili.

—XREF:STAMPA, (E1.n)

Emissione della lista incrociata di un operando assoluto (n =0 - 7).

~XREF:STAMPA,
(-SIMB)

Emissione della lista incrociata di un operando simbolico (p. es.
-SIMBOLO).

—XREF(C):STAMPA, (E)

Emissione della lista incrociata di un operando di ingresso in forma com-
patta. In caso 'ingresso vengono utilizzato n volte in un segmento, il seg-
mento viene rappresentato una sola volta.

—XREF(O):STAMPA, (A)

Emissione della lista incrociata in forma opzionale. Diversamente dallo
standard, i riferimenti non sono ordinati secondo i blocchi, ma secondo
(nell'ordine) operazioni, blocchi e segmenti

Tabella 18-10 Tabella di occupazione

Istruzione di comando

Chiarimento

—XREF:OCCUPAZIONE

Emissione della tabella di occupazione

—XREF:OCCUPAZIONE
MERKER S

Emissione della tabella di occupazione dei merker S

Tabella 18-11 Lista di attribuzione

Istruzione di comando

Chiarimento

—ZULI:SEQ Emissione non ordinata della lista di attribuzione.

—ZULI:SIM Emissione ordinata secondo operandi simbolici.

—ZULI:ASS Emissione ordinata secondo operandi assoluti.

—ZULI(O):SEQ Emissione non ordinata ad una colonna (rilevante solo in formato A3).
18-24 C79000§58EBP73{%BZ\(§-762




Documentazione

18.5 Editazione istruzioni di comando

Sommario Per I'editazione di istruzioni di comando sono messe a disposizione delle funzioni di
aiuto attivabili tramite i tasti funzionali. Le istruzioni generate vengono memorizzate
in un file Submit (*SU.INI).

Oltre a questa assegnazione dei tasti funzionali, € possibile associare ad essi testi
e comandi che vengono poi richiamati premendo SHIFT F1 ... SHIFT F7.

Documentazione \ Selezionare il comando di menu Documentazione » Istruzioni di comando »
Istruzioni di Edita. Viene visualizzato un box di comando nel quale si deve selezionare un file
comando Submit. | nuovo nome del file viene introdotto nel box di impostazione (- Pro-

Edita getto, Imposta, capitolo|4.1.1)| Non appena appare sul video la rappresentazione

(vedere sotto), il cursore si posiziona nella prima riga. E ora possibile editare.

Editor File-Submit

C:\STEP5V7.005\S5_Daten\KOMDOK\SFUS@DSU.INI
001 ;DOCUMENTAZIONE TOTALE DEL FILE-PROGRAMMA SU DIN A3

002 $PROG:A:STDRAN

003  $SIMB:A:STDRAN

004  $PIED:A:KODOTE

005 $STAMPA:A:PTS9

006  -BLIST

007 -XREF:GENERAZIONE

008 -XREF(D):PROGRAMMA, (OB1)
008  -ZULI:SEQ

009  -ZULL:SIM

010 . -ZULI:ASS

012 S
S

F' Testol F Testo2 F Testo3 F Testo4 F Testo5 FTesto6 F Testo7 F Help
1 Blocco 2Prel.BLC.3Prel. FILE 4 Prel.RIGA5Extra 6 Tastifz. 7 Salta 8Annulla

Figura 18-13 Editor File-Submit

18.5.1 Tasti funzionali

Assegnazione dei Nelle sequenze di tasti funzionali di seguito riportate viene spiegato, con l'aiuto della
tasti funzionali tabella, come determinare I'operativita di un tasto funzionale.
F1 (livello 1) Introduzione del primo limite di blocco. Passaggio al

secondo livello di tasti.

F3 (livello 2) Scelta del nome per la memorizzazione del blocco.
Passaggio al terzo livello dei tasti.

F6 (livello 3) Memorizzazione del blocco con il nome del file scelto.
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Tabella 18-12 Assegnazione tasti funzionali

Livello dei tasti

Effetto del tasto funzionale

1 2 3
Memorizzazione dell'introduzione con il tasto di Conferma (Insert) . Tasti cursore
- Appendice A.1, Assegnazione tastiera.
F1 Blocco
Il primo limite di blocco viene contrassegnato da B nella riga corrente. Il secondo
limite di blocco puo essere posizionato in altre righe tramite i tasti cursore.
F1 Blocco
Il blocco evidenziato viene memorizzato per la sessione corrente.
F3 File
Il blocco viene memorizzato con un nome di file a scelta e rimane in memoria.
F3 Scegli
Viene aperto il box di dialogo Scegli file.
F6 Conferma
Il blocco viene memorizzato nel file scelto.
F8 Annulla
Riporta al livello precedente senza ulteriori azioni.
SHIFT | Help
F8
F4 Cancella
F4 Ricerca (testo)
Ricerca in un blocco di una stringa di 30 caratteri al massimo. Se la stringa viene
trovata, il secondo limite di blocco viene impostato in tale riga.
F5 Ripeti
Ripetizione dell'ultima ricerca.
F6 Ricerca/Avanti
Il testo viene ricercato andando verso la fine del file
F7 Ricerca/Indietro
Il testo viene ricercato andando verso l'inizio del file.
F8 Annulla
Riporta al livello precedente senza ulteriori azioni.
SHIFT | Help
F8
F6 Conferma
Il blocco viene memorizzato nel file scelto.
F7 Salta
Salto all'inizio/fine del file, oppure ad un numero di riga definibile.
F6 Inizio
Salto all'inizio del file.
F7 Riga
Salto alla riga scelta.
F8 Fine
Salto alla fine del file.
SHIFT | Help
F8
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Tabella 18-12 Assegnazione tasti funzionali, continuazione

1

Livello dei tasti
2 3

Effetto del tasto funzionale

F8

Annulla
Riporta al livello precedente senza ulteriori azioni.

SHIFT

Help

F2

Prelievo blocco
Il blocco corrente memorizzato viene prelevato ed inserito a partire dalla posizione
del cursore.

Tabella 18-13 File Submit presente

Livello dei tasti Effetto del tasto funzionale
1 2 3
F3 Prelievo file
Prelivo di un file Submit scelto da un drive selezionabile.
F1 File
Il file viene prelevato senza assegnazione dei tasti funzionali.
2 Tasti funzionali
Dal file viene prelevata solo 'assegnazione dei tasti funzionali che diventa istantanea-
mente attiva.
F3 Scegli
Viene aperto il box di dialogo Scegli file.
F6 Conferma
Il file viene prelevato senza assegnazione dei tasti funzionali. (come F1)
F8 Indietro
Riporta al livello precedente senza ulteriori azioni.
SHIFT Help
F8
STEP 5/ST V7.0
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Tabella 18-14 Prelievo riga/ Ricerca testo

1 2

Livello dei tasti

3

Effetto del tasto funzionale

F4

Prelievo riga
Viene ripresa una riga precedentemente cancellata con — Assegnazione tasti

F5

Extra

F4

Cancella riga

F5

Cerca

F5

Ripeti
Ripetere I'ultima ricerca.

F6

Cerca/Avanti
Ricerca del testo verso la fine del file.

F7

Cerca/lndietro
Ricerca del testo verso l'inizio del file.

F8

Annulla
Riporta al livello prec. senza ulteriori azioni.

Tabella 18-15 Sostituzione stringa caratteri

2 3

Livello dei tasti

4

Effetto del tasto funzionale

F6

Sostituisci

Una stringa di caratteri viene sostituita da un’altra. Esse possono essere al mas-
simo di 30 caratteri e pud essere impostato un fattore di ripetizione. Quando il testo
da ricercare viene trovato, € sostituito dal secondo testo.

F1

Sostituzione?/Avanti
Ricerca verso la fine del file. E necessaria la conferma per ogni sostituzione.

F1

Si - Il testo viene sostituito.

F3

No - Il testo non viene sostituito.

F8

Annulla
Riporta al livello precedente senza ulteriori azioni.

F2

Sostituzione?/Indietro
Ricerca verso l'inizio del file. E necessaria la conferma per ogni sostituzione.

F1

Si - |l testo viene sostituito.

F3

No - Il testo non viene sostituito.

F8

Annulla
Riporta al livello precedente senza ulteriori azioni.

SHIFT
F8

Help

F3

Sostituzione/Avanti
Ricerca verso la fine del file. Sostituzione senza conferma.
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Tabella 18-15 Sostituzione stringa caratteri, continuazione

Livello dei tasti Effetto del tasto funzionale
2 3 4
F4 Sostituzione/Indietro
Ricerca verso l'inizio del file. Sostituzione senza conferma.
F6 Ripeti
Ripetizione dell'ultima ricerca. Preimpostato & F3.
F8 Annulla
Riporta al livello precedente senza ulteriori azioni.
SHIFT Help
F8

Tabella 18-16 Esecuzione di salti

Livello dei tasti

Effetto del tasto funzionale

2 3 4
F7 Salta
Salto all'inizio/fine del file, oppure ad un numero di riga definibile.
F6 Inizio
Salto all'inizio del file.
F7 Riga
Salto alla riga scelta.
F8 Annulla
Conclude I'assegnazione extra dei tasti funzionali.
F8 Fine
Salto alla fine del file.
SHIFT Help
F8

Tabella 18-17 Editazione tasti funzionali

Livello dei tasti Effetto del tasto funzionale
1 2 3
F8 Tasti funzionali
Tramite i tasti SHIFT F1-F7. Ai tasti funzionali possono essere associati testi di 30
caratteri al massimo. Premendo il relativo tasto in Editazione (SHIFT F1 - F8), tale
stringa viene inserita nella riga nella quale si trova il cursore. Per esempio:
SHIFT+F1: |$PROG:C:FILE]
SHIFT+F2: |$SZMB:C:SYMDAT|
F4 Prelievo riga
Viene prelevata una riga precedentemente cancellata con il tasto di cancellazione
(- Assegnazione tasti ).
F6 Conferma
L'assegnazione del tasto funzionale viene memorizzata.
F8 Annulla
Riporta al livello precedente senza ulteriori azioni.
SHIFT Help
F8
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18.5.2 Test dell’istruzione di comando KOMDOK

Funzione

Documentazione

Emiss. conf.
Istruz. comando
Test

Emissione lista er-
rore

Segnalazione di
errore

18-30

Viene controllato se le istruzioni di comando contenute in un file selezionabile sono
eseguibili. Se nelfar cio sipresentano deglierrori, le cause ditali errorivengono memo-
rizzate in un file *SF.INI file.

Selezionare il comando di menu Documentazione » Istruzioni di comando
»Test. Appare il box di comando Test istruzioni di comando. Introdurre in questo il
nome del file da controllare. Non appena si conferma Test la verifica viene atti-
vata e successivamente emesso il risultato.

Glierroritrovatinell’esecuzione dellafunzione Istruzionidicomando » Test vengono
memorizzatiin un file di errore. Questo file pud essere stampato con la funzione Istru-
zioni di comando » Emetti file protocollo

Avvertenza

Se non e rilevato alcun errore, non si predispone alcun file per gli errori.

Risultato del test per C:ESEMP1SU.INI

001 $FUP

002 $PROG:C:BSP400

*** Errore:  *** C:BSP400ST.S5D mancante
003

004 $SIMB:C:BSP409 eseguibile
005 $STAMPA:C:BSP409 eseguibile

1 errore trovato nel file C:ESEMP1SU.INI

Figura 18-14 Segnalazione di errore

STEP 5/ST V7.0
C79000-G8572-C920-02



Documentazione

18.5.3  Emissione del file protocollo

Funzione

\ Documentazione

Istruz. comando
File protocollo

Con questa funzione & possibile emettere il file di protocollo, che & stato generato du-
rante il test.

Selezionare il comando di menu Documentazione » Istruzioni di comando »
File protocollo . Appare il box di comando Emetti file protocollo. In questo box e
possibile muoversi ed eseguire selezioni. Qui € predisposto il nome del file errori
generato.

Campo di Chiarimento
introduzione
File protocollo Nome del file errori. E predisposto il nome del file errori
generato. Con F3 & comunque definibile un’altro nome.
Su video Emissione diretta su video.
Su stampante Emissione diretta su stampante, relativamente ai para-

metri definiti sotto Definizione parametri stampante.

Su file Emissione su un file a scelta.

18.5.4 Esecuzione delle istruzioni di comando

Funzione

Documentazione \

Emiss. conf.
Istruz. comando
Esegui

Conquestafunzione viene attivatal'esecuzione delle istruzioni di comando contenute
nel file scelto. Le impostazioni correnti sono valide fino a quando sono sostituite da
Istruzioni di impostazione ($PROG.:...$FUP, ecc.) eventualmente presenti. Tali /stru-
zioni di impostazione valgono pero soltanto per la durata dell’esecuzione di queste
istruzioni di comando.

Selezionare il comando di ment Documentazione » Istruzioni di comando »
Esegui . Appare il box di comando Esegui istruzioni di comando. Introdurre nel
campo Nome file: il nome del file le cui istruzioni di comando devono essere
eseguite. Una selezione del file pud essere effettuata con I'aiuto del tasto F3. Non
appena il box di comando Start File-Istruz.-Comando viene confermato con OK,
le istruzioni di comando in esso contenute vengono eseguite.

Avvertenza

Quando si presentano degli errori € possibile la diramazione ad una lista di errori.

18.5.5 Emissione istruzioni di comando

Funzione

\ Documentazione

Emiss. conf.
Istruz. comando
Emetti

STEP 5/ST V7.0
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Con questa funzione e possibile stampare il contenuto di un file di istruzioni di co-
mando.

Selezionare il comando di menu Documentazione » Istruzioni di comando »
Emetti . Appare il box di comando Emetti file istruzioni di comando. Introdurre nel
campo Nome file: il nome del file cche deve essere stampato. Una selezione
del file puo essere effettuata con I'aiuto del tasto F3. Non appena il box di co-
mando Documentazione file istruzioni di comando viene confermato con Emetti,
le istruzioni di comando in esso contenute vengono stampate.
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18.5.6 Editazione struttura

Funzione

Esempio

Documentazione

Emiss. conf.
Istruz. comando
Edita strut-
tura

Spostamento del
contrassegno

Assegnazione tasti
funzionali

18-32

Nelleistruzionidicomando possono essere inserite istruzioni( - Istruzionidistruttura)
che richiamano altri file di istruzioni di comando e li attivano. Questa funzione illustra
come sono combinati i vari file di istruzioni di comando tramite queste istruzioni di
struttura.

Esiste pertanto la possibilita, tramite questa funzione, di attivare I'editor delle istruzioni
di comando e di modificare le istruzioni di comando del file corrente.

La figura illustra come viene rappresentata dall’'editor struttura la combinazione dei
singolifile di istruzioni di comando. La combinazione viene generata tramite istruzioni
di struttura.

C:ESEMP1SU.INI Interfaccia operatore grafica E
C:ESEMP1 C:ESEMP2 C:ESEMP3
C.ESEMP3
F F F F F
1 Edita 2 Test 3 Start 4 ListaE 5 Stampa

Figura 18-15 Combinazione dei singoli file di istruzioni di comando

Selezionare il comando di menu Documentazione » Istruzioni di comando
»Edita struttura . Appare il box di comando Edita struttura istruzioni. In questo
box & possibile muoversi ed eseguire selezioni. Introdurre in questo box il nome
del file di istruzioni di comando oppure selezionarlo con l'aiuto di F3.

Viene quindi visualizzata la combinazione dei file di istruzioni di comando a partire
dal file selezionato.

Non appena il box di comando viene confermato con Edita, € visualizzata la struttura
delle istruzioni di comando. Viene contrassegnato il file di istruzioni di comando dal
guale e stato richiamato I'editor di struttura.

Ilcontrassegno che evidenziaisingolifile diistruzioni dicomando pu0 essere spostato
all'internodella struttura tramite i tasti cursore (- Appendice A.1, Assegnazione della
tastiera).

Nelle sequenze di tasti funzionali, riportate nella seguente tabella, viene spiegato
come determinare 'operativita di un tasto funzionale.

F6 (livello 1) Ricerca di un file di istruzioni di comando nel file di
struttura. Passaggio al secondo livello di tasti.

F1 (livello 2) Viene contrassegnato il primo file di istruzioni di comando.
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Di seguito viene illustrato I'effetto dei tasti funzionali e quali combinazioni di tasti sono
possibili.

Tabella 18-18 Assegnazione dei tasti funzionali

Livello di tasti Effetto del tasto funzionale
1 2
F1 Edita
Viene richiamato I'editor delle istruzioni di comando e visualizzato il contenuto del file
istruzioni di comando attuale (con sfondo grigio). Queste istruzioni di comando possono
essere modificate (- Editazione istruzioni di comando).
F2 Test
Viene testato il file di istruzioni di comando contrassegnato nella struttura (con sfondo
grigio). ll risultato viene visualizzato immediamente sul video. In caso di errori, questi
vengono memorizzati in un apposito file.
F3 Start
Viene attivato il file di istruzioni di comando contrassegnato nella struttura. Gli errori che
si verificano durante I'esecuzione vengono memorizzati in un file e visualizzati sul video.
F4 Lista errori
La lista errori contrassegnata nella struttura viene visualizzata sul video e, a scelta, an-
che stampata.
F5 Stampa
Emissione del file di istruzioni di comando contrassegnato nella struttura. L'emissione
avviene su stampante o su file a seconda della predisposizione.
F6 Cerca
Passaggio al livello di ricerca.
F1 Inizio
Il primo file di istruzioni di comando viene contrassegnato e quindi diventa "corrente”.
F2 Fine
L'ultimo file di istruzioni di comando viene contrassegnato e quindi diventa "corrente”.
F3 Richiama
Viene contrassegnato il file di istruzioni di comando dal quale € stata chiamata la
struttura e diventa pertanto "corrente”.
F4 Errore
Viene contrassegnato il primo file di istruzioni di comando contenente errori a partire dal
corrente, e diventa "corrente”.
F6 Ricerca/Avanti
Viene effettuata la ricerca di un file di istruzioni di comando a scelta verso la fine del file.
Se esso € presente, viene contrassegnato e diventa "corrente”.
F7 Ricerca/Indietro
Viene effettuata la ricerca di un file di istruzioni di comando a scelta verso l'inizio del file.
Se esso e presente, viene contrassegnato e diventa "corrente”.
F8 Indietro
Ritorno al livello richiamante.
SHIFT | Help
F8
F8 Indietro
Ritorno al livello precedente, senza nessuna azione
SHIFT Help
F8
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18.5.7 Emissione struttura

Funzione

\ Documentazione

Istruz. comando
Emetti strut-
tura

18-34

Lastrutturadelfilediistruzionidicomandotradiloro combinativiene emessainformato
A3 0 A4, su stampante o su file (*LS.INI).

Selezionare il comando di menu Documentazione » Istruzioni di comando »
Emetti struttura . Appare il box di comando Emetti struttura istruzioni di co-

mando.
Campo Chiarimenti
d’introduzione
File Submit Nome del file di istruzioni di comando del quale si vuole av-

Struttura con istru-
zioni di comando

ere la struttura. A partire da questo file viene visualizzata la
combinazione tra i file di istruzioni di comando.

Qui e stampato, su pagine separate, anche il contenuto
dei file di istruzioni di comando interessati.
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\ Cambio

Altri F9

Accoppiamento
PG
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Con questa funzione & possibile commutare su altri programmi S5. Tali
programmi, se non sono gia caricati, devono essere installati in un qualunque
drive e directory. Con la funzione Cambio si esce dal pacchetto STEP 5.

| [Cambio" Help J

COM DB1
AWL Batch
altri ... F9

Vengono visualizzati tutti i programmi S5 che sono presenti nel drive e directory
scelti e sui quali & possibile commutare.

Conlafunzione "Altri”si abbandonail pacchetto STEP 5. Viene visualizzata I'interfac-
cia operatore del pacchetto S5 selezionato con cui, da questo momento, € possibile
lavorare.

llritornoal pacchetto STEP 5 e possibile daognipacchetto S5 selezionato. Leimposta-
zioni del pacchetto STEP 5 sono conservate. Dopo il ritorno nel pacchetto STEP 5
e dunque possibile riprendere a lavorare senza dover impostare alcunché.

Assieme al pacchetto STEP 5 viene fornito anche il pacchetto S5 Accoppiamento
PGcheeinstallatonelladirectory C\STEP5\S5_ST\PG_PG. llprogramma Accoppia-
mento PG é aperto e avviato se le vie erano impostate corrispondentemente nel box
di scelta.

Viene visualizzato il box di comando Altri pacchetti S5 in cui si selezionano il drive
e la directory. Per il pacchetto S5, sul quale € posizionato il cursore, viene emessa
nella parte inferiore della finestra una riga in cui sono riportate informazioni.

Nel box e possibile muoversi ed eseguire selezioni (- Interfaccia operatore grafica,
Box di comando). Confermando con Awvio , viene visualizzata I'interfaccia operatore
del pacchetto S5 scelto.

19-1



STEP 5/ST V7.0
C79000-G8572-C920-02



Help

Sommario

Sommario del
capitolo

STEP 5/ST V7.0
C79000-G8572-C920-02

Grazie alle funzioni presenti sotto questo menu, € possibile ottenere le seguentiinfor-
mazioni relative al pacchetto STEP 5 avviato:

* una lista di tutti i tasti funzionali veloci (F1 - F10 e SHIFT F1 - SHIFT F9). Con
questi tasti & possibile selezionare le funzioni STEP 5 direttamente dal menu
principale,

¢ informazioni sulla versione di STEP 5 con cui si sta operando,

* una lista di tutte le parti di programma dello STEP 5 attivato.

Ene Documentazione  Cambio ‘Help J

Info su versione STEP 5/ST ... F12
Versione pacchetti S5 ... Ctrl+F11

Informazioni sull’'uso >

Capitolo Argomento trattato Pagina
20.1 Lista assegnazione tasti 20-2
20.2 Informazioni relative alla versione STEP 5 20-2
20.3 Versione pacchetti S5 20-2
20.4 Informazioni sull’'uso 20-4

20-1



Help

20.1 Lista assegnazione tasti

\ Help

Lista assegn.
tasti

20.2 Informazioni relative alla versione STEP 5

\ Help

Info su versione
STEP 5/ST

La lista visualizzata fornisce informazioni circa i tasti funzionali che possono es-
sere attivati direttamente all’interno dell'interfaccia operatore. Tali tasti permettono
la selezione diretta di certe funzioni senza dover utilizzare i singoli menu.

Non appena selezionata la funzione, viene visualizzata una lista nella quale viene
illustrata la funzione dei singoli tasti. Tale lista puo essere sfogliata.

Viene visualizzato un box nel quale sono contenute informazioni relative alla ver-

sione del software STEP 5 attivato.

20.3 Versione pacchetti S5

\ Help \

Versione
pacchetti S5

Con questa funzione viene visualizzata una lista delle singole parti di programma
del software STEP 5 attivato. E’ possibile impostare il drive e la directory in cui
cercare le parti di programma.

L'emissione avviene su video, stampante o in un file. L'emissione su stampante ed
in un file avviene secondo il layout definito in Emissione standard.

Directory: C\STEP5\S5_ST Pagina 1
Versione del supporto dati:

Nome Sigla Data N. seriale PG Denominazione
C:S5DXBPX6.VER  S792xxxxx 090395 7994-0102-654321 665 PC BASIS V7.0
Versione dei interpretatori di comando S5:

Nome Sigla Data N. seriale PG Denominazione
C:S5KXS01X.CMD V6.6 44 010995 7994-0102-654321 XX S5-KOMI
C:S5KDS01X.DAT V6.6 44 010995 7994-0102-654321 7XX S5-KOMI
C:S5KXS03X.CMD V6.6 44 010995 7994-0102-654321 TXX S5-MENU-MANAGER
C:S5KDS03X.DAT V6.6 44 010995 7994-0102-654321 7XX S5-MENU-MANAGER
C:S5KXS02X.CMD V6.6 44 050995 7994-0102-654321 XX S5-KOMI-UP’S
C:S5KDS02X.DAT V6.6 44 050995 7994-0102-654321 7XX S5-KOMI-UP’S
C:S5KXS04X.CMD V6.6 44 050995 7994-0102-654321 TXX DIALOGMANAGER
C:S5KDS04X.DAT V6.6 44 050995 7994-0102-654321 7XX DIALOGMANAGER
Versione dei pacchetti:

Nome Sigla Data N. serialePG Denominazione
C:S5PXS03X.CMD V6.6 44 010995 7994-0102-654321 TXX QL,VERGL,UMV
C:S5PDS03X.DAT V6.6 44 010995 7994-0102-654321 7XX QL,VERGL, UMV

Figura 20-1 Esempio per la visualizzazione della versione dei pacchetti S5
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Impostazioni

Operativita

Directory
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Deve essere impostato quanto segue:
¢ file piedinatura (solo se selezionato Piedinatura: Si)

¢ file stampante (in caso di emissione su stampante/file, la preimpostazione vale
per PT 88)

Per informazioni circa le relative impostazioni vedere capitolo 4.1.1.

E visualizzato il box di comando Versione dei pacchetti S5. Spostarsi al suo interno
e selezionare quanto desiderato (- Interfaccia operatore, box di comando).

L'emissione della versione avviene dalla directory qui visualizzata. L'impostazione
standard, alrichiamodellafunzione, € sempre ladirectory disistema. Nelcampo Direc-
tory non é possibile editare, il campo stesso € pero selezionabile tramite cursore o
mouse. Se é selezionato il campo Directory, si pud impostare la directory desiderata
con F3 = Scegli o doppio click del mouse.
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20.4 Informazioni sull’'uso

\ Help \ Il comando di menu Help » Informazioni sull'uso  offre una descrizione delle possi-
Informazioni bilitd a disposizione per trovare determinate informazioni nell’Help.
sull'uso >

STEP 5/ST V7.0
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Editor AWL/Batch-Compiler 2 1

Sommario Il pacchetto software editor AWL/Batch-Compiler offre un editor autonomo per
programmi in rappresentazione AWL ed un Compiler anch’esso autonomo per la
compilazione di queste liste istruzioni in programmi STEP 5 eseguibili.

Con il Batch-Compiler vengono anche eseguite decompilazioni, partendo da
programmi STEP 5, cioé le modifiche del programmatestato possono essere riportate
nel programma sorgente e la lista istruzioni risulta quindi aggiornata.

Sommario del Capitolo Argomento trattato Pagina
capitolo 21.1 Modalita operative dell'editor AWL/Batch-Compiler 21-2
21.2 Creazione di blocchi STEP 5 21-3
21.3 Il file intermedio A1.SEQ 21-8
21.4 Modifica e completamento di blocchi STEP 5 21-11
215 Verifica 21-11
21.6 Lista errori 21-11
21.7 Introduzione di istruzioni STEP 5 con altri editor 21-12
21.8 Uso del dispositivo di programmazione 21-13
21.9 | caratteri di comando dell’editor AWL/Batch-Compiler 21-18
21.10 Introduzione di blocchi di programma 21-23
21.11 Introduzione di blocchi funzionali 21-29
21.12 Introduzione di blocchi dati (esempio) 21-32
21.13 Modifica di un file sorgente AWL 21-33
21.14 Compilazione con la funzione COMPILER 21-34
21.15 Lista errori 21-36
21.16 Stampa 21-37
21.17 Funzione SPECIALE per I'elaborazione di file sorgenti e 21-38
file intermedi
21.18 Segnalazioni di errore 21-41

L'editor offre inoltre la possibilita di eseguire una verifica, specifica per I'AG, per il
programma STEP 5 compilato e una lista degli errori.
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21.1 Modalita operative dell’editor AWL/Batch-Compiler

Sommario

Editazione

Conferma

Compilazione

Verifica

Decompilazione

Ciclo di verifica

21-2

La creazione di un programma STEP 5 nell’editor AWL/Batch-Compiler differisce da
quello creato nel pacchetto KOP, FUP, AWL nei seguenti punti:

* nel pacchetto KOP, FUP, AWL la lista istruzioni viene subito editata nel file di
programma e compilato immediatamente in codice macchina.

¢ nel pacchetto editor AWL/Batch-Compiler I'editazione e la compilazione sono
procedimenti che avvengono in tempi diversi.

Per I'editazione, come primo passo, si scrive con I'editor AWL un file di testo
sequenziale che ¢ il file sorgente AWL. Esso pud contenere una lista istruzioni che
€ stata creata esclusivamente con i simbolici.

Memorizzando con la funzione Conferma o con il tasto conferma, il pacchetto crea
automaticamente oltre al file sorgente AWL, un file intermedio. Questo contiene un
codice che é indipendente dal linguaggio nazionale, perd non & ancora il codice
macchina. Con questa prima compilazione vengono controllatila sintassi ed il formato
della lista istruzioni.

Il secondo passo, la compilazione, viene avviata tramite un tasto funzionale. Allo
stesso tempo il Batch-Compiler trasforma il file intermedio in un file programma
STEP 5. Se la lista istruzioni & stata programmata in simbolico, il Batch-Compiler
necessita a questo punto del file simbolico con le attribuzioni specifiche dell'impianto.

Durante la compilazione in file programma viene eseguita una verifica delle
attribuzioni. Se é stato indicato un determinato tipo di AG, viene anche verificato se
le operazioni utilizzate sono ammesse ed eseguibili dall’AG di destinazione (verifica
specifica dellAG). Un file programma creato con l'editor AWL/Batch-Compiler &
identico ad un file programma creato in KOP, FUP, AWL.

Da un file programma, con I'editor AWL/Batch-Compiler, pud essere creato anche
un file sorgente; questo, per esempio, puo essere utile quando un programma STEP
5 é stato testato e corretto nellAG. Per questo non ha alcuna importanza se il
programma €& stato editato nel pacchetto KOP, FUP, AWL o nel pacchetto editor
AWL/Batch-Compiler. Con la decompilazione, il Batch-Compiler genera, prima di
tutto, un file intermedio dal file programma. Da questo file intermedio viene costruito
il file sorgente AWL relativo al file programma. La creazione di un file sorgente da un
file programma pud avvenire anche in un unico passo.

Durante la compilazione vengono eseguite delle verifiche. Inoltre, dopo la
compilazione, viene eseguito un ciclo di verifica dei blocchi del file programma; per
esempio, durante questo ciclo, viene verificato se gli operandi formali e gli operandi
attuali nei blocchi funzionali sono stati associati in modo corretto e coincidono. Tultti
gli errori individuati vengono riuniti in una lista errori e possono essere stampati.

Nella lista di errori sono contenuti sempre solo gli errori dell’'ultimo passo di lavoro;
essa viene sovrascritta con ogni nuova compilazione e ciclo di verifica. Per questo
motivo stampare sempre la lista errori! Se un passo di lavoro viene superato senza
errori non viene creata alcuna lista errori e se ne esiste una, questa viene cancellata!
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21.2 Creazione di blocchi STEP 5

Sommario Nell'editor AWL il programma del controllore viene creato come lista istruzioni con
un confortevole editor di testi. La lista istruzioni si scrive con lo stesso repertorio di
istruzioni e la stessa sintassi del pacchetto KOP, FUP, AWL. L'unica differenza é che
bisogna rispettare precise convenzioni come, per esempio, caratteri di comando per
inizio blocchi e commenti.

Tutti i tipi di blocco che e possibile creare nel pacchetto KOP, FUP, AWL possono
essere creati anche nell’editor AWL/Batch-Compiler. Allo stesso modo possono
essere scritti tutti i commenti che & possibile scrivere in un blocco, ma nessun
commento dellimpianto (fle DOK). Inoltre, I'editor AWL permette i cosiddetti
commenti aggiuntivi in ogni punto della lista istruzioni. Questi commenti comunque
non vengono trasferiti nel file programma e quindi vanno persi durante una
decompilazione nello stesso sorgente AWL.

Non sono ammessi il DBO (riservato nell’AG per la lista degli indirizzi dei blocchi), il
DB1 (riservato perlasuddivisione dellaperiferia del’AG dell’AG135U e dellAG155U),
il DXO (riservato per la parametrizzazione di sistema, CPU 928, processore R, AG
155U), il DB2 (riservato per la lista dei regolatori del’R64), il GRAPH 5 e i blocchi As-
sembler.

Predisposizione Nella predisposizione vengono definiti quattro file:
1. il file sorgente AWL, che si vuole editare (A0.SEQ);

2. il file intermedio, creato memorizzando con il tasto conferma e contenete la
lista istruzioni compilata in codice intermedio (A1.SEQ);

3. il file simbolico in cui si trova la lista di attribuzione (Z0.INI) e

4. il file programma in cui deve essere scritto il programma STEP 5 dopo la
compilazione (ST.S5D).

Questi quattro file vengono registrati con gli stessi nomi ed eventualmente possono
essere modificati. Il file sorgente AWL ed il file intermedio hanno perd sempre gli stessi
nomi.

Nella scelta funzioni, il pacchetto dell'editor AWL/Batch-Compiler offre le seguenti
funzioni:

Tasto Funzione

EDITA Per creare ed elaborare il file sorgente AWL

COMPILER Per tradurre e ridecompilare

LISTA-E Lista errori dei cicli di verifica
STAMPA Per la stampa del file sorgente AWL

STEP 5/ST V7.0
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21.21

Sommario

Funzioni

21-4

Tasto Funzione
SPECIALE Funzioni con cui possono essere generati i file intermedi ed i
file sorgente
PREDISP. Per modificare la Predisposizione
AUSIL. Funzioni per gestire i blocchi nel file programma preimpostato
INDIETRO Per abbandonare il pacchetto Editor AWL/Batch-Compiler

Funzioni di editazione

L'editor AWL emette sullo schermo una maschera di editazione che é pronta per
I'editazione della lista istruzioni. La maschera di editazione € costituita da:

* una riga d’intestazione con il nome del file sorgente AWL,

¢ i campi d’introduzione assegnati alle colonne INDIRIZZO, ISTRUZIONE,
SIMBOLO OPERANDO e COMMENTO ISTRUZIONE,

¢ il menu con le funzioni di editazione.

L'editor AWL offre una serie di funzioni con cui si edita il programma in modo
confortevole. Esse sono confrontabili con quelle dell’editor simbolico:

SOSTIT. CONFERMA| SALVA MODO

7 ANNOTA COPIA CANCELLA

Le funzioni ANNOTA e COPIA permettono di scrivere ("esportare”) qualsiasi
sequenza di caratteri e blocchi di testo in un buffer o in un file sequenziale e copiarlo
in un qualsiasi punto. In questo modo, per esempio, Si possono spostare segmenti
0 inserirne di nuovi nel programma.

Inoltre, con la funzione Copia, si possono leggere anche altri file sorgenti o singoli
blocchi. Le funzioni di ANNOTA, COPIA e CANCELLA possono essere combinate
con un fattore di ripetizione.
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Caratteri di
comando
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Le funzioni CERCA e SOSTITUISCI facilitano la correzione del proprio programma:

e Ci si pud muovere velocemente ed in modo indirizzato nel proprio file. Si puo
modificare con una sola funzione ed in tutta la lista istruzioni del programma, ogni
singola sequenza di caratteri, come, per esempio, simbolici o operandi. Inoltre
vengono offerti a scelta il modo inserimento ed il modo sovrascrittura.

® Con SALVA sihala possibilita di salvare il proprio file senza abbandonare I'editor.
Ogni tanto sarebbe utile interrompere la seduta di editazione per salvare il proprio
file sorgente AWL. Con la funzione CONFERMA si salva il file, si traduce
contemporaneamente nel file intermedio e si abbandona I'editor.

Per permettere la compilazione del file sorgente AWL in un file programma STEP 5,
devonoessere utilizzati, durante lafase di editazione, determinati caratteri dicomando
e convenzioni di scrittura.

#TY evidenzia il Tipo di AG. Dopo questi caratteri di comando puo essere indicato
I’AG in cui il programma deve essere eseguito. Questo dato deve coincidere con la
registrazione che si trova nel campo "linguaggio” della Predisposizione. Il
Batch-Compiler controlla durante la compilazione in file programma, se le operazioni
editate sono comprese nel repertorio delle istruzioni del’AG indicato. Il Tipo di AG
puo stare, in un file sorgente AWL, all'inizio del file ed alla fine di un blocco.

Di seguito sono elencate le sigle ammesse per il linguaggio AG:

Tipo AG Processore Sigla linguaggio
AG 100 U CPU100 CPU100
CPU102 CPU102
CPU103 CPU103
AG 101U AG 101U
AG 110 S AG 110S
AG 115U CPU 941 CPU 941
CPU 942,943, 944 CPU 942
AG130WB AG 130 W
AG 135U CPU 921 CPU 921
CPU 922 CPU 922
CPU 928 CPU 928
CPU 928B CPU 928B
AG135W AG 135 W
AG 135 WB AG 135B
AG 150 A/K AG 150A
AG 150 S/U AG 150S
AG155U CPU 946/947 AG 155 U
Processore 1/0 IP257 IP 257
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Comando Include

La compilazione nel file programma viene eseguita solo quando la sigla del’AG nella
Predisposizione (campo "LINGUAGGIO") coincide con quello indicato nellariga #TY
del file sorgente AWL. In caso di discrepanza la compilazione viene interrotta nella
riga#TY. Se nella Predisposizione, per il linguaggio, siregistra "NO”, la compilazione
viene eseguita senza il ciclo di verifica specifico dellAG.

Il comando Include #l permette I'integrazione di un qualsiasi file e pud stare, nel file
sorgente AWL, all'inizio del file ed alla fine di un blocco cioé dopo BE. Dopo #l segue
ilnome del file. E’importante che venga indicato anche il drive (esempio: #| B:TEST).

L'inclusione del file avviene al livello di codice intermedio cioe il file da includere deve
esistere come file intermedio. Se non viene indicato il drive, il sistema accede al drive
fissato nella Predisposizione per il file intermedio.

Seinambedueifilerisultanoblocchiconlo stessonome, essidevono essere rinominati
prima della compilazione. Si pu0 evitare questo problema se nel file sorgente AWL
i blocchi vengono definiti con nomi simbolici.

Per fare questo € necessario che esista il file simbolico adeguato poiché per la
compilazione sono indispensabili il tipo di blocco ed il numero.

Il comando Include € adatto in particolare per la biblioteca specifica per I'utente:
programmi standardizzati potrebbero essere modificati secondo I'applicazione che
si sta realizzando con il file Include. Per esempio, per una modifica & necessario
scambiare solo i file Include. In questo modo dopo la modifica per tutti i programmi
verra utilizzata la nuova versione per la creazione del file programma.

21.2.2 Compilazione

Creazione di un
file programma

Decompilazione di
un file programma

21-6

Con il Batch-Compiler tutti i blocchi, un gruppo di blocchi o un singolo blocco possono
essere compilati, dal file intermedio o dal file sorgente AWL, in file programma. Se
ogni modifica della lista istruzioni & stata memoarizzata nel file sorgente con Conferma,
e sufficiente la compilazione del file intermedio. In caso contrario bisogna avviare la
compilazione del file sorgente AWL che crea automaticamente un file intermedio
aggiornato.

Se il file sorgente AWL e stato programmato in simbolico, durante la compilazione
nel file programma, viene collegato il file simbolico preimpostato con il file intermedio.
Un file simbolico non viene creato dall’editor AWL, ma deve essere creato con |'editor
simbolico. Se conilcomando Include #l viene integrato un altrofile, bisogna osservare
che i simbolici per questo file siano contenuti nel file simbolico preimpostato.

Nella riga di comando del Compiler puo essere indicato se deve essere generato il
codice macchina o se deve essere eseguito solo un test per verificare la presenza
dieventualierrori, ed anche se sivuole richiedere una conferma per sicurezza durante
lasovrascritturadeiblocchi. Contemporaneamente sipud decidere anche distampare
il programma compilato.

Per i blocchi creati con il pacchetto KOP, FUP, AWL non esistono né i file sorgenti
AWL ne ifile intermedi. L'editor AWL/Batch-Compiler puo creare questi file da un file
programma.
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Verifiche durante
la compilazione

21.2.3 Stampa

Sommario

Layout
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Decompilando un blocco, un gruppo di blocchi, o tutti i blocchi si pud, in primo luogo,
creareilfileintermedio o direttamente il file sorgente AWL sequenziale che puo essere
modificato e completato.

Con la decompilazione si sceglie come deve essere il "nuovo” file sorgente AWL.: le
istruzioni vengono rappresentate o solo in simbolico o solo con i parametri assoluti,
0 con tutti e due. Inoltre il carattere di comando per l'identificazione del linguaggio
viene registrato nel file intermedio se nella Predisposizione € registrata
un’identificazione del linguaggio (Tipo AG).

L’editor AWL puo elaborare file con un massimo di 65535 righe. Il numero di righe
del file sorgente AWL dipende pero non solo dal numero delle istruzioni STEP 5, ma
anche dalle istruzioni speciali, dalle righe di commento ecc. Se il file programma che
sivuole decompilare e troppo lungo, bisogna suddividere i blocchi in pit file intermedi.

I blocchi funzionali standard, come pure i blocchi di GRAPH 5 e di Assembler non
possono essere decompilati.

Durante la compilazione o la decompilazione del codice intermedio, viene verificata
'ammissibilita delle istruzioni esistenti. Viene anche verificata 'ammissibilita delle
istruzioni in relazione al tipo di blocco. Il linguaggio viene controllato se nella

Predisposizione € stato indicato un tipo AG. Nella programmazione simbolica
vengono controllate le attribuzioni in relazione agli operandi.

Se nel file sorgente AWL é stato usato sia un operando assoluto che uno simbolico
allora viene controllata la concordanza con il file simbolico. Se i parametri sono
discordanti viene utilizzato il parametro assoluto associato al simbolo presente nel
file simbolico e nella lista errori viene registrato un avvertimento. Nella
programmazione assoluta non avviene alcun accesso al file simbolico. Gli errori che
vengono riscontrati durante questi controlli vengono registrati nella lista errori.

Un listato del file sorgente AWL puo essere generato tramite lafunzione Stampa (nella
sceltafunzioni). Questafunzione emette su stampante soloil file sorgente AWL preim-
postato.

Nella riga di comando della funzione Compiler, durante la compilazione, viene
proposta una emissione su stampante. In questo modo puo essere documentato il
risultato di ogni fase della compilazione e del ciclo di verifica.

Per il layout di stampa, I'editor AWL/Batch-Compiler offre i soliti formati di stampa del
pacchetto STEP 5. Si pu0 scegliere tra emissione di stampa standard, scrittura
normale, scrittura ristretta, scrittura superstretta. Per le stampe in formato A3, la
piedinatura deve essere di 132 caratteri (file F2.INI), in formato A4 di 80 caratteri (file
F1.INI). Nelle stampe in scrittura ristretta appare anche il commento agli operandi.
Nelle stampe in scrittura superstretta appare anche il commento ai simboli.
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21.3 Il file intermedio A1.SEQ

Il file intermedio costituisce il file centrale nel pacchetto Editor AWL/Batch-Compiler.
Indipendente dal linguaggio e non ancora in codice macchina MCS5, esso ¢ la base
per tutte le fasi della compilazione. Da esso possono essere creati in ogni momento

* File programma STEP 5,

* File sorgenti AWL,

¢ Versioni di un programma specifiche dell'impianto,
¢ Versioni di un programma dipendenti dalla lingua.

Per questo motivo € necessario salvare sempre il file intermedio ed & consigliabile
abbandonare il file sorgente AWL sempre con Conferma; in questo modo il file
intermedio € sempre aggiornato.

2131 Relazione tra file sorgente AWL e file intermedio

Decompilazione

21-8

Editor AWL

File sorgente
AWL

File
intermedio

Compiler

File
programma

Il file sorgente AWL ed il file intermedio sono legati strettamente I'uno all’altro: hanno
lo stesso nome e la loro identificazione differisce solo di un carattere (A0.SEQ,
A1.SEQ). Il nome di un file intermedio non pud essere mai cambiato in modo
indipendente dal file sorgente AWL. | due file possono trovarsi pero su differenti drive.
Il fatto che abbiano lo stesso nome garantisce che il programma editato venga
compilato nel corrispondente file intermedio quando viene salvato con Conferma.

Anche con una decompilazione avviene il salvataggio nel file sorgente AWL
nominalmente corrispondente. Questo e datenere presente quandofile sorgente AWL
e file intermedio non vengono aggiornati contemporaneamente o la "vecchia” lista
istruzioni non deve essere sovrascritta, per esempio, quando il primo file sorgente
AWL contiene commenti supplementari. Questi non vengono trasferiti nel file
programma e dopo la decompilazione vanno persi.

STEP 5/ST V7.0
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Per quanto concerne la generazione di un file sorgente AWL da un file intermedio
possiamo fare le seguenti considerazioni:

* Se non esiste alcun file sorgente AWL, esso viene automaticamente creato

quando si richiama EDITA. Esso riceve il nome che €& stato definito
precedentemente nella Predisposizione.

* Se esiste gia un file sorgente AWL con lo stesso nome, il file intermedio deve
essere riportato esplicitamente nel file sorgente AWL. Cid avviene con la
funzione speciale ZWI>SEQ (vedi sotto). In questo modo viene sovrascritto il
vecchio file sorgente AWL.

* Se si deve mantenere un "vecchio” file sorgente AWL, prima della
decompilazione di un file programma, bisogna registrare nella Predisposizione
un nome per il nuovo file sorgente AWL. Sotto questo nome viene decompilato
nel file intermedio e salvato nel file sorgente.

Per questo, primadi una fase di compilazione ed in particolare di una decompilazione,
€ importante controllare se nella predisposizione sono registrati i nomi esatti dei file.

Avvertenza

Le funzioni SEQ>MC5 e MC5>SEQ creano automaticamente un file intermedio
aggiornato.

21.3.2 Funzioni speciali

VERIFICA GEN-SIMB | INDIETRO

SEQ>ZWI ZWI>SEQ |CANC-SEQ |CANC-ZWI COPIA

Le funzioni speciali offrono diverse conversioni per creare file sorgenti AWL e file
intermedi. Questo puo essere utile perche file sorgente AWL e file intermedio hanno
sempre lo stesso nome ma a volte diverse versioni.

Tabella 21-1 Funzioni speciali
Tasto Funzione

SEQ>ZWI Converte un file sequenziale in un file intermedio. Questa funzione si utilizza quando, per
esempio, il file sorgente AWL e stato scritto con un altro editor di testo e deve essere
compilato in un file programma STEP 5 o se il file intermedio non esiste piu.

ZWI>SEQ Traduce un file intermedio in un file sequenziale, per esempio, nel caso si sia decompilato
un file programma e lo si voglia modificare con I'editor AWL. A questo scopo il file
intermedio deve essere convertito in un file sequenziale. Questa funzione é
particolarmente importante quando esiste una vecchia versione del file sorgente. Questa
funzione € anche molto utile se si vuole aprire il file sorgente in un editor AWL in lingua
straniera.

CANC-SEQ | Con questa funzione possono essere cancellati file sequenziali nel caso questi, per

esempio durante le fasi di compilazione, debbano essere rigenerati. Se si editano poi i file

compilati, vengono creati automaticamente dall’editor i file sequenziali.

STEP 5/ST V7.0
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Tabella 21-1 Funzioni speciali, continuazione

Tasto Funzione

CANC-zZWI Cancella i file intermedi (per esempio vecchie versioni). Essi possono essere
nuovamente creati o con la funzione SEQ>ZW!I da un file sorgente aggiornato o
confermando un file sorgente editato.

COPIA Questa funzione viene utilizzata quando si desidera, per ragioni di sicurezza, copiare il
file intermedio ed il file sorgente AWL su un altro drive. | file perd possono essere
rinominati solo nel programma ausiliario AUSIL-F.

VERIFICA Offre la possibilita di controllare, in un secondo tempo, non solo i blocchi compilati di un
file programma, ma anche blocchi del pacchetto KOP, FUP, AWL sulla plausibilita delle
istruzioni per il tipo di AG impostato.

GEN-SIMB Crea dal file sorgente AWL un file sorgente simbolico che contiene tutti i simboli ed i

parametri assoluti. Le attribuzioni ed i commenti di questi sorgenti simbolici possono
essere ampliati con I'editor simbolico senza dover nuovamente digitare i simboli ed i
parametri assoluti gia presenti nel sorgente AWL.

21.3.3 Programmi standard

Sommario

La possibilita di creare una lista istruzioni solo in simbolico e un file intermedio

indipendente dalla lingua, permette di creare programmi standard.

Moduli e blocchitestati possono essere archiviati in una biblioteca ed essere integrati,
conilcomandoInclude, inprogrammiparticolari specificidell'impianto. Inquestomodo
occorre solo collegare i nuovi programmi cosi combinati con una speciale lista di
attribuzione per ottenere programmi STEP 5 specifici dellimpianto per singole

problematiche di controllo.

21.3.4 Versioni in lingua straniera di un programma STEP 5

Sommario

21-10

Con il Batch-Compiler possono essere create versioni in lingua straniera di un
programma STEP 5, se il programma €& stato scritto con parametri assoluti o se si
dispone di un file intermedio decompilato con i parametri assoluti: con la versione di
software in inglese e francese di questo pacchetto si creano sorgenti AWL in inglese

ed in francese.

A questo scopo andare nel programma ausiliario AUSIL-F, TRASF-F e copiare il file
sorgente AWL e il file intermedio tedeschi con un nuovo nome. Questo nuovo nome
va registrato nella Predisposizione della versione software inglese/francese. Con la
funzione speciale ZWI>SEQ (vedisopra) trasferireil file intermedio indipendente dalla
lingua nel file sorgente sequenziale. Questo viene emesso nellEDITAZIONE con le

istruzioni STEP 5 in inglese/francese.

Un’altra possibilita consiste nel fatto di cancellare il file sorgente sequenziale nel
pacchetto in inglese/francese (funzione speciale CANC-SEQ). Un nuovo file viene

automaticamente generato se si richiama la funzione EDITA.

| simboli ed i commenti non vengono emessi nella lingua straniera.

STEP 5/ST V7.0
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21.4 Modifica e completamento di blocchi STEP 5

Creazione di
blocchi con
I'editor AWL

Creazione di
blocchi con il
pacchetto KOP,
FUP, AWL

21.5 Verifica

Verifica di un file
programma

Verifica di blocchi
speciali

21.6 Lista errori

STEP 5/ST V7.0
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Nella Predisposizione indicare ilnome del file sorgente AWL ed eventualmente anche
il drive per il file intermedio. Richiamando I'editor AWL appare sullo schermo la lista
istruzioni desiderata ed il menu di editazione. La lista istruzioni pud essere ora
modificatao completataservendosidellefunzionidieditazione. Salvareilfile sorgente,
modificato, sempre con Conferma. In questo modo il file intermedio viene aggiornato
ed il "nuovo” file programma non viene quindi creato con un "vecchio” programma.

Se si abbandona I'editor AWL con il tasto interruzione e si conferma l'interruzione,
le modifiche o i completamenti non vengono trasferiti nel file sorgente AWL.

I blocchi devono essere decompilati da un file programma in modo da poter operare
con l'editor AWL. Se essi si trovano in un file sorgente AWL, vengono elaborati
nell’editor AWL come descritto sopra.

Nella verifica viene avviata la compilazione e vengono controllati i blocchi del file
programma. La verifica si fa carico, per esempio, di controllare il trasferimento dei
parametri per i blocchifunzionali e I'esistenza dei blocchi richiamati. Essa puo essere
eseguita per un blocco, un gruppo di blocchi o tutti i blocchi di un file programma. Se
nella Predisposizione € stata registrata un’identificazione del linguaggio, viene
controllata anche la plausibilita delle istruzioni per quel tipo di AG. Nella lista errori
vengono stampate le istruzioni non consentite.

I blocchi funzionali standard, i blocchi GRAPH 5 e quelli Assembler non possono
essere creati e decompilati con I'editor AWL/Batch-Compiler, ma possono essere
testati in fase di verifica. Questo vuol dire che ne viene controllata I'esistenza, il
trasferimento dei parametri ed anche la plausibilita delle istruzioni AWL per il tipo di
AG preimpostato.

Le segnalazioni di errore vengono generate nei seguenti passi di operativi:
* Compilazione del file sorgente AWL nel file intermedio.

* Compilazione del file intermedio nel file programma

¢ Decompilazione del file programma nel file intermedio

* Decompilazione del file intermedio nel file sorgente AWL

e Test del file programma (verifica)

Le segnalazioni di errore vengono memorizzate dal dispositivo di programmazione
in una lista errori nel file errore <nome>AF.SEQ.
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Nel file errore € contenuta sempre solo la lista errori dell’ultimo passo operativo
eseguito. Il file errore pud essere emesso sullo schermo o stampato con il formato
di stampa desiderato. Il file errore non esiste se l'ultimo passo operativo & stato
terminato senza errori!

21.7 Introduzione di istruzioni STEP 5 con altri editor

Il file sorgente
AWL come
interfaccia

Formato del file
sorgente
sequenziale
dell’'editor

Caratteri di
comando #TAB per
I'elaborazione di
altri file
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IIfile sorgente AWL puo essere creato anche conaltrieditor. [l presupposto & che questi
editor possano elaborare "veri” tabulatori (cioé, codice esadecimale 09H). In caso
contrario si devono definire nella prima riga del file sorgente AWL, tramite il carattere
di controllo #TAB, le colonne iniziali dei singoli campi.

| primi sei caratteri del nome del file si possono scegliere liberamente, ma devono
essere forzatamente sei caratteri. Per gli ultimi due caratteri del nome e I'estensione
deve essere indicato A0.SEQ. Una successiva elaborazione di questo file con gl
strumenti del pacchetto Editor AWL/Batch-Compiler non crea problema solo se si
rispetta il formato del file sorgente sequenziale descritto sotto. Si viene supportati
dall'editor AWL/Batch-Compiler con la funzione speciale SEQ>ZWI, con la
compilazione successiva nel file intermedio e con la compilazione diretta con la
funzione SEQ>MCS.

JPerognirigaistruzionevieneintrodottounsetdidati. Unsetdidatiiniziaconil carattere
di tabulazione (09H) ed é costituito da 4 campi di dati che a loro volta solo divisi I'uno
dall'altro tramite tabulatori. L'etichetta che indica la fine del set di dati, costituita da
"Carriage Return, CR”(=0DH) e "Line Feed” (=0AH), viene aggiunta automaticamente
dall'editor, concludendolariga conil tasto Return. Pericampi sonoammessii seguenti
numeri massimi di caratteri:

TAB TAB TAB TAB CR, LF
Indirizzo Istruzione Simbolo operando  Commento istruzione
4 caratteri 13 caratteri 24 caratteri 32 caratteri

Il set di dati di una linea vuota € costituito da quattro caratteri del tabulatore seguiti
dai caratteri "CR” e "LF".

Il set di dati per le righe di commento inizia con i caratteri del tabulatore (=09H),
immediatamente seguiti dai caratteri di comando Q e ; per i commenti al segmento
e aggiuntivi. Pertanto massimo 79 caratteri per il commento e fine riga con i caratteri
"CR” (=0DH) e "LF” (=0AH).

| set di dati possono avere caratteri maiuscoli e minuscoli. Durante la lettura I'editor
converte automaticamente in maiuscolo tutti i caratteri minuscoli che si trovano nei
campi indirizzo e istruzione. Nei campi simbolo operando e commento istruzione i
caratteri minuscoli e maiuscoli vengono invece mantenuti. Non € ammesso usare
"dieresi”.

| caratteri di controllo #TAB permettono la compilazione di file senza veri caratteri di
tabulazione. Questifile vengono creati da molti programmi di elaborazione testi come,
per esempio, 1st Wordplus. L’editor AWL perd non puo elaborare questi file ed emette
la segnalazione di errore "Formato del file errato”.

STEP 5/ST V7.0
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Esempio:

| caratteri#TAB devonotrovarsiproprio all'inizio delfile sorgente. Primasono ammessi
solo "spazi”. Successivamente devono esserci 4 numeri, separati da virgola, che
indicano le colonne iniziali dei campi. Nella prima riga non sono ammessi altri dati!

Se tra i campi deve essere presente uno spazio come separatore, la prima riga del
file sorgente AWL si presenta cosi:

#TAB 1,6,21,46 RETURN (CR LF)

| dati della colonna sono calcolati sempre dall'inizio della riga. La differenza tra i dati
successivi deve corrispondere alla lunghezza del campo.

21.8 Uso del dispositivo di programmazione

Caricamento del
pacchetto editor
AWL /

Batch-Compiler

PREDISPOSI-
ZIONE

STEP 5/ST V7.0
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Procedere come segue:
1. Selezionare, nel menu STEP 5, la funzione Cambio

2. Richiamare AWL-Batch
Appare quindi la maschera PREDISPOSIZIONE

PREDISPOSIZIONE SIMATIC S5/ PDS 09
LUNGHEZZA SIMBOLO 8 (8-24) FILE SIMBOLICO
LINGUAGGIO : NO FILE SORGENTE AWL: A0.SEQ

FILE INTERMEDIO

FILE PROGRAMMA

PIEDINATURA : NO FILE PIEDINATURA

FILE STAMPANTE

NOME VIA : FILE VIA

CONFERMJ ‘

Figura 21-1 Maschera per la PREDISPOSIZIONE

Il cursore lampeggia nella riga del FILE SORGENTE AWL (A0.SEQ). In questo file
viene memorizzata la lista istruzioni. Esso e contrassegnato come un file sequenziale
cioé come un file ASCII ed & il sorgente per la fase di compilazione.

Introdurre in questa posizione il nome del proprio file. Nel nostro esempio il file si
chiamera Test.

1. Introdurre la sequenza di caratteri Test,

2. Premere il tasto Return .
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Sovrascrittura del
nome file

Linguaggio

21-14

Ora, come drive viene registrato il disco fisso del dispositivo di programmazione ed
ilnome viene completato con @. Cosifacendo anche il FILE INTERMEDIO (A1.SEQ)
viene automaticamente chiamato con lo stesso nome. In questo modo essi vengono
contrassegnati come appartenenti allo stesso genere.

Se non esiste alcun FILE SIMBOLICO e lista di attribuzione con il nome indicato, si
viene avvisati di cio0 in tre punti: dopo il nome del file si trova (GESP), il dispositivo
diprogrammazione segnala”File B:TEST@@ Z0.INI: File non esistente”, e nel campo
LUNGHEZZA SIMBOLICO viene impostato 0 al posto del valore preimpostato 8.

Se il file sorgente, durante la compilazione, deve essere collegato con un altro file
simbolico che ha gia un nome e/o deve essere compilato in un file programma che
hagidunnome,isingolinomipossonoessere sovrascritti. Concludere lasovrascrittura
coniltasto Return. Questifile sono attivianche in altri pacchetti STEP 5 e, caricandoli,
vengono registrati nelle loro Predisposizioni. | file per la Piedinatura, Stampante e
Via vengono automaticamente adattati nominalmente al file programma.

* Posizionare il cursore nella rispettiva riga,
* Premere il tasto freccia a destra
* |l campo di introduzione € riempito.

Il PG controlla se i file indicati esistono. Se devono essere utilizzati altri file bisogna
registrare il loro nome. Se la stampante ed il file della via non esistono i loro nomi
vengono cancellati spostando il cursore verso I'alto o verso il basso.

Le righe NOME VIA e PIEDINATURA vengono gestiti come nel pacchetto KOP, FUP,
AWL.: per il nome via introdurre il nome, per la piedinatura scegliere la larghezza.

Nel campo LINGUAGGIO deve essere utilizzato assolutamente il tasto di Help
(posizionare il cursore su NO): il tasto di Help visualizza il controllore programmabile
(AG) ed il processore centrale (CPU) per i quali il Batch-Compiler, specifico dell’AG,
traduce e verifica.

Registrare eventualmente dalla lista nel campo LINGUAGGIO, I'apparecchiatura
sulla quale deve eseguito il proprio programma. Il Batch-Compiler controlla, durante
la compilazione in file programma, se la lista istruzioni concorda con il linguaggio
dellAG.

Il campo LUNGHEZZA SIMBOLICO indica la lunghezza dei simboli del file simbolico
registrato. Non € possibile modificare questo campo percheé e solo divisualizzazione.

Per memorizzare questa PREDISPOSIZIONE premere
e CONFERMA (F6)

oppure

¢ il tasto conferma

Si ottiene ora la SCELTA FUNZIONI.

STEP 5/ST V7.0
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Scelta funzioni

21.8.1 Editazione

Richiamo del
modo editazione

Riga d’'intestazio

ne

La SCELTA FUNZIONI offre, nella barra delle softkey, le funzioni di elaborazione e
di editazione sottoelencate. Il loro utilizzo verra spiegato nei capitoli che seguono.

INDIETRO

EDITA COMPILER LISTAE STAMPA SPECIALE PREDISP AUSIL
Richiamare EDITA (F1).
Sorgente AWL: B.TEST@@AO0.SEQ RIGA: 1 —MODO INSERIMENTO —  178kB
MR CISTRUZIONETD  SIMBOLOOPERANEO: %
NUOVO FILE
ANNOTA | COPIA | CANCELLA| CERCA | SOSTIT.| CONFERMA| SALVA MODO

Figura 21-2 Maschera di editazione

Questa maschera € predisposta per editare una lista istruzioni, cioe per introdurne
una nuova o per visualizzarne una gia esistente per rielaborazione (correzioni,
modifiche).

Qui si trova:

¢ Il nome del file sorgente AWL preimpostato ed il relativo drive,

¢ [lindicazione della riga per la posizione del cursore

¢ il modo editazione, inserimento o sovrascrittura e

¢ |e dimensioni del buffer di memoria. Questo indicazione & interessante per la
velocita di elaborazione.

Campo di Il campo di editazione & suddiviso in 4 colonne la cui larghezza non puo essere
editazione modificata. Valori e contenuto previsto delle colonne sono qui brevemente riassunti:
IND ISTRUZIONE SIMBOLO OPERANDO COMMENTO ISTRUZIONE
4 caratteri 13 caratteri 24 caratteri (max. lunghezza simbolo) 32 caratteri
Indirizzi, Operazioni, Simbolo Commenti
etichette di operandi assoluti, e
salti costanti relativo valore

STEP 5/ST V7.0
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Riga di fondo In questa riga si trovano tutte le segnalazioni dell’apparecchiatura, per esempio
"Nuovo file” quando si crea una nuova lista istruzioni.

Barra delle softkey Queste funzioni di editazione sono identiche a quelle dell’editor SIMBOLICO. Esse
servono per la creazione e I'elaborazione di una lista istruzioni.

Funzioni della Il grafico successivo offre una panoramica degli "strumenti” che sono disponibili nelle
barra delle softkey singole funzioni di editazione. Se si preme uno dei tasti del menu Edita viene
EDITA visualizzato il corrispondente menu (alla fine della freccia).

STEP 5/ST V7.0
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ANNOTA

COPIA

CANCELLA

CERCA

SOSTITUISCI

Tasti speciali

Hardkey

STEP 5/ST V7.0
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ANNOTA | COPIA ERCA | SOSTIT
1

. . 8
TA INDIETRO

FATTORE DI RIPETIZIONE:

£ Fa
BLOCC.TXT

C

RIGA INDIETRO

TESTO

FATTORE DI RIPETIZIONE:

3 g
INIZIOBL | FINE BL INDIETRO

FATTORE DI RIPETIZIONE:

TESTO +|  TESTO' INIZIO FINE | INDIETRO

FATTORE DI RIPETIZIONE:

TR E2
CON

g
INDIETRO

CONF |SENZ.CONF

Oltre a queste funzioni, con i tasti speciali si hanno altri "strumenti” per elaborare il
proprio file.

Per lo spostamento del cursore sono disponibili i tasti di comando del cursore.
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21.9 | caratteri di comando dell’'editor AWL/Batch-Compiler

Sommario

L'editor AWL richiede, per determinate introduzioni, una serie di caratteri di comando
con cui & possibile la compilazione della lista istruzioni in un file programma STEP
5. Peresempio, titolie commenti dei segmenti, operandi attuali e identificazioni blocco
devono essere contrassegnati come tali.

La tabella riassuntiva elenca questi caratteri di comando. Essa mostra la sequenza
definita per una compilazione in file programma ed intermedio senza problemi. Inoltre
essa informa sulle convenzioni di scrittura (per esempio il carattere (_ rappresenta
uno spazio), la posizione dei caratteri di comando all'interno della lista istruzioni e
altre spiegazioni.

Tabella 21-2 Caratteri di comando nella colonna relativa alle istruzioni

Colonna Identificazione per Convenzionidi | Posizione Chiarimenti
ISTRUZIONI scrittura con all'interno della
Caratteri di esempi lista istruzioni
comando
#TAB File sorgente senza veri | #TAB 1,6,21,46 Sempre la prima | Consente la compilazione di file creati
tabulatori riga del file con un altro editor, per esempio 1st
Wordplus. Vale solo per il Compiler,
non per I'editor AWL.
#TY Tipo AG Con spazio Sempre la prima | Eventuali commenti si trovano solo nel
istruzione di un file sorgente AWL, essi non vengono
#TY_AG155U file compilati e vanno persi con la
#TY_CPU928 decompilazione.
Senza spazio Inizio di un Campo valori: n=0 - 255, a seconda
#PBn Inizio blocco di #PB11 blocco; dopo un | del tipo AG. Se si desidera introdurre
#0Bn programma #0B1 BE altre istruzioni dopo la fine di un
#FBn, #FXn Inizio blocco organizzativo | #FB25, #FX12 (fine blocco, vedi | blocco, queste devono essere
#DBn, #DXn Inizio blocco funzionale #DB5, #DX33 sotto, operazioni) | precedute da un nuovo inizio blocco,
(#SBn, nessun Inizio blocco dati #SB3 altrimenti queste istruzioni andranno
blocco GRAPH 5) | Inizio blocco sequenziale perse durante la compilazione nel
dispositivo di programmazione. DBO,
DB1 e DB2 non sono consentiti..
#BI Numero di biblioteca Con spazio Dopo l'inizio del | Per i propri numeri di biblioteca. Non &
#Bl_12345 blocco o dopo il | necessario e non & possibile introdurre
Non maggiore di | nome del blocco  |i numeri di biblioteca dei blocchi
65535 (vedi sotto, #N) funzionali standard. Eventuali
commenti si trovano nel file sorgente
AWL, essi non vengono compilati e
vanno persi durante la
decompilazione.
#N Nome di un blocco Con spazio Prima o dopo il
funzionale #N_GARAGE numero di
Max. 6 caratteri biblioteca, ma
allinizio del
blocco
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Tabella 21-2 Caratteri di comando nella colonna relativa alle istruzioni, continuazione

Colonna Identificazione per Convenzioni di | Posizione Chiarimenti
ISTRUZIONI scrittura con all'interno della
Caratteri di esempi lista istruzioni
comando
#UB Titolo segmento II carattere di Solo allinizio di | Questi testi di commento vengono
comando si trova |un segmento acquisiti nel file programma. Se si
nella colonna desiderano informazioni
ISTRUZIONE, il particolareggiate sulle modalita di
testo del titolo commento di un programma STEP 5,
nella colonna consultare la descrizione dello STEP
COMMENTO 5, nel manuale volume 2 del
ISTRUZIONE dispositivo di programmazione.
0 Tipo di parametro formale | Il tipo di Direttamente
parametro sotto il nome del
formale deve blocco
stare tra parentesi
(D)
(E)
, Operandi attuali per la Primo carattere | All'interno di un
parametrizzazione di un | della colonna; il | blocco
blocco funzionale parametro segue
immediatamente
,E1.0
# File Include Con spazio, Solo alla fine del  |Il carattere di comando consente di
indicazione drive | blocco: prima del |integrare altri file. Questi file devono
€ primi sei primo blocco o tra | essere presenti come file intermedi,
caratteri del nome |BE e #PBn cioé devono essere stati conclusi con il
del file tasto conferma nell'editor AWL o con
#_A:UEBUNG la decompilazione. Fare attenzione
che non ci sia nel file alcun nome di
blocco uguale a quello che deve
essere integrato. Questo perché
durante la creazione il file programma
sovrascrive l'ultimo blocco con lo
stesso nome del precedente. Il file
Include, durante la compilazione, viene
collegato al file simbolico
preimpostato. Questo deve pertanto
mettere a disposizione le attribuzioni
anche al file Include.
# Nome di blocco simbolico

STEP 5/ST V7.0
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Tabella 21-3 Caratteri di comando nella colonna IND

Colonna Identificazioni per Convenzioni di Posizione Chiarimenti

IND scrittura all'interno della

Caratteri di con esempi lista istruzioni

comando

* Commento segmento Il carattere di comando
si trova solo all'inizio di
un segmento; se esiste
un titolo segmento,
esso deve
assolutamente
precederlo.

; Commento aggiuntivo Il carattere di comando | In qualunque Questi commenti aggiuntivi si
si trova nella colonna punto all'interno | trovano solo nel file sorgente
IND, per il testo & del blocco AWL. Durante la compilazione
disponibile tutta la non vengono considerati. Se si
larghezza dello decompila nello stesso file
schermo, sorgente AWL, questi commenti
indipendentemente vanno persi.
dalle colonne.

21.9.1 Le istruzioni STEP 5 nell’editor AWL/Batch Compiler e le loro convenzioni di

scrittura

Nell'editor AWL/Batch Compiler sono possibili tutte le istruzioni STEP 5. Un limite
€ rappresentato solo dal linguaggio ammesso dal controllore programmabile e dalla
CPU. Per questo motivo durante la programmazione consultare la lista delle
operazioni relativa alla propria apparecchiatura.

La seguente tabella, che si riferisce alle colonne dello schermo, riassume le
convenzioni di scrittura per la programmazione assoluta e simbolica.

Tabella 21-4 Operazioni STEP 5

INDIRIZZO ISTRUZIONE SIMBOLO COMMENTO
OPERANDO ISTRUZIONE
Operazione con Operazione e operando Pulsante "apri esterno”
operando assoluto assoluto
U E12
introduzione senza
formato
Con operando Operazione U Simbolo
simbolico APRI-E
senza lineetta
Operazione con dati Operazione e formato | Valore del dato
et 005.2
introduzione senza
formato
Operando formale Nome Tipo
TEMPO (D)
AP-E (E)
M-IN (A)
Max. 4 caratteri tra parentesi
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Tabella 21-4 Operazioni STEP 5, continuazione

INDIRIZZO ISTRUZIONE SIMBOLO COMMENTO
OPERANDO ISTRUZIONE
Dati Indirizzo 11 Formato dati Valore, 1 parola dati per
KH riga
KF 6248
+
KCoC 13512'Visualizzazione'
KG Solo semplici virgolette,
KT fino a 11 parole dati per
riga
KZ
-1169368-38
KYoA .
max. 1 doppia parola
KM per riga
123.1
735
125,018
00011100 11101111
Operazione con Operazione e operando
operando formale formale
U_=TA-A
= =MAB
introduzione senza
formato, I'operando
formale deve essere
preceduto
immediatamente dal
segno di uguale.
Simbolico Carattere di comando | Simbolo
con operando MAB
,E1.2
,DW1
senza spazio
Dati Carattere di comando
Dati Carattere di comando | Valore
con tipo di dati, KT 005.2
Etichetta di salto Etichetta
EIN
MO003
Indirizzi relativi, 17
indirizzi parole dati
Fine blocco BE

STEP 5/ST V7.0
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Simboli

21-22

Trale colonne dello schermo ci si muove con i tasti Shift + Freccia e Return . Il tasto
Return posiziona il cursore sempre sul primo carattere della colonna ISTRUZIONE.

Se siprogrammain simbolico tenere presente che, contrariamente al pacchetto KOP,
FUP, AWL, non si deve mettere nessuna lineetta davanti al simbolo. L'inizio del blocco
puo essere introdotto quando esiste I'associazione del tipo di blocco e del numero
al simbolo. Se cosi non &, bisogna programmare ['inizio del blocco in assoluto, per
esempio #PB3, perché il Batch-Compiler, per creare il file intermedio, ha bisogno del
tipo di blocco e del suo numero.

I simboli che si utilizzano nell’editor AWL, devono coincidere assolutamente con quelli
del file simbolico. Questo vale anche per gli spazi:

_EMERG=/ EMERG_NO

Ulteriori differenze rispetto al pacchetto KOP, FUP, AWL sono
e caratteri di comando,
* inserimento automatico degli spazi nelle operazioni,

e costanti e valori si trovano in colonne diverse.

STEP 5/ST V7.0
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21.10 Introduzione di blocchi di programma

Esempio di Sulla base di questo esempio vengono illustrate le modalita operative e le funzioni

programmazione del pacchetto Editor-AWL/Batch Compiler. Il programma realizza il comando della
portadiungarage e prevede lapossibilitadimanovradall’esterno mediante unachiave
e i pulsanti di apertura e chiusura, mentre dall’interno sono previsti soltanto i pulsanti
"apri” e "chiudi”. La porta si chiude con un ritardo di 5 secondi.

Sorg-AWL B:TEST@ @AO0.SEQ

IND ISTRUZIONE SIMBOLO OPERANDO  COMMENTO ISTRUZIONE
#PB1 APERTURA DALL'ESTERNO E
#UB DALLINTERNO

*IL PULSANTE "APRI ESTERNO” E L'INTERRUTTQRE A CHIAWE. QRRIIREI_RIU.SANMTE "APRI
*INTERNO” DETERMINANO IL MOVIMENTO AVANTI DEL MOTORE. Il MOTORE GIRA FINTANTO
*CHE VIENE RAGGIUNTO IL FINECORSA SUPERIORE, OPPURE VIENE PREMUTO IL
*PULSANTE DI STOP DI SICUREZZA

U(
U E1l2 PULSANTE APRI ESTERNO
U E1l4 INTERRUTTORE A CHIAVE
O E15 PULSANTE APRI INTERNO
)
UN E 1.0 FINECORSA SUPERIORE
S A10 MOTORE AVANTI
*kk
#UB APERTURA DALL'ESTERNO E
DALLINTERNO

*RESET USCITA MOTORE AVANTI
O E 1.0 FINECORSA SUPERIORE
O E17 PULSANTE DI STOP DI
R A1.0 SICUREZZA
bl MOTORE AVANTI
#UB

CHIUSURA DALL'ESTERNO O
DALLINTERNO

*IL PULSANTE "CHIUDI ESTERNO” E L'INTERRUTTORE A CHIAVE OPPURE IL PULSANTE
*CHIUDI INTERNO” DETERMINANO IL MOVIMENTO INDIETRO DEL MOTORE CON UN RITARDO
*DI 5 SECONDI. Il MOTORE GIRA FINTANTO CHE VIENE RAGGIUNTO IL FINECORSA INFERIORE

STEP 5/ST V7.0
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*OPPURE VIENE PREMUTO IL PULSANTE DI STOP DI SICUREZZA

U(

n =z

w Il C—|(|__)—||_;UOO(D|_CVOCC

m

CHIUDI-E
CHIAVE
CHIUDI-I

FC-INF
KT 005.2

RITARDO

FC-INF

STOP

RITARDO

RITARDO
MW 100

RITARDO
MW 102

RITARDO

MOT-IND

Premesse

Inizio di un blocco
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Deve essere caricato il pacchetto Editor AWL/Batch Compiler, riempita la maschera
di Predisposizione e richiamata la funzione di editazione.

¢ Definizione del MODO (F8)

Questa funzione consente la scelta tra due modi di editazione: inserimento o
sovrascrittura. La scelta effettuata e indicata dal PG nella riga d’intestazione dello
schermo.

* Premere MODO (F8), fintanto che la scelta desiderata viene attivata.

Procedere nel modo seguente (la sequenza di caratteri da introdurre € indicata in
corsivo, le funzioni da utilizzare in grassetto ):

* Introdurre #PB1 come inizio del blocco,

* Premere due volte il tasto Return , la riga vuota serve per una separazione visiva
durante l'introduzione,

e #UB per il titolo del primo segmento

* Premere due volte Shift + freccia destra , per raggiungere la colonna
COMMENTO ISTRUZIONE,

* Apertura dall’esterno o dall'interno

* Premere il tasto Return

* Premere unavolta Shift + freccia sinistra , per raggiungere la colonna INDirizzo,
* Introdurre * come carattere di comando per il commento segmento.

Oraépossibileinserireil primotesto dell’esempio. Perquestaoperazione é disponibile
I'intera larghezza dello schermo. Concludere ciascuna riga con Return . Una nuova
riga di testo si inizia, come descritto, con Shift + freccia sinistra e *, poi il cursore
salta automaticamente soltanto sulla colonna ISTRUZIONE.

Scrivendo nel modo inserimento, occorre fare attenzione alla fine riga! Potendo infatti
inserire solo all'interno di unariga, il testo puo oltrepassare la fine riga, andando cosi
perduto.

STEP 5/ST V7.0
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SALVA (F7)

Per I'elaborazione del testo sono disponibili i tasti di comando cursore e speciali,
precedentemente descritti. Il carattere di comando * non pud essere tolto con un
normale "cancella carattere”, ma soltanto mediante le funzioni CANCELLA e RIGA.

Con questa funzione si memorizza il file sorgente AWL, senza abbandonare I'editor.
E’ inoltre possibile eseguire memorizzazioni intermedie e interrompere
momentaneamente 'editazione.

Questo a differenza del pacchetto KOP, FUP, AWL, dove alla memorizzazione veniva
abbandonata l'introduzione e per un’ulteriore elaborazione si doveva andare in
emissione.

21.10.1 Utilizzo della lista di softkey EDITA

Sommario

/N

La funzione
ANNOTA

STEP 5/ST V7.0
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Per illustrare I'utilizzo della funzione di editazione verra spiegato specificatamente
l'impiego combinato delle funzioni ANNOTA, COPIA e CANCELLA , come potere
memorizzare su file parti di programma per ulteriori elaborazioni ed assegnare a tasti
funzionali sequenze di caratteri.

Uno strumento molto utile & il fattore di ripetizione: dopo il richiamo di una funzione
si introduce, mediante la tastiera del dispositivo di programmazione, un numero con
il quale viene eseguita la successiva funzione, p.es. copia una riga 7 volte.

La funzione attivata si trova nella riga dintestazione sopra a COMMENTO
ISTRUZIONE. Unafunzione deve sempre essere abbandonatapremendo INDIETRO
(F8), prima di potere operare ulteriormente nel testo.

Se si vuole interrompere un procedimento all'interno di una funzione, bisogna
utilizzare il tasto d’'interruzione e/o il tasto F8 INDIETRO.

Attenzione

Utilizzando il tasto d’interruzione, & possibile perdere dei dati! P. es. se si
corregge un file e poi si preme il tasto d’interruzione, vengono perse tutte le
correzioni.

Mediante questa funzione € possibile annotare parti di testo. Sequenze qualsiasi di

caratteri (fino ad un massimo di 40 caratteri), righe singole e blocchi di caratteri
(massimo 500 righe) vengono scritti in un apposito buffer e possono essere copiati
in una posizione qualsiasi. Il testo annotato nel buffer pud anche essere memorizzato
in un file sequenziale.
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Mediante la funzione di annotazione & anche possibile assegnare ai tasti funzionali
sequenze di caratteri.

FATTORE DI RIPETIZIONE:

TESTO | INIZ.BL. FINE BL. TASTI F. INDIETRO'

La funzione COPIA Mediante questa funzione il testo annotato viene prelevato dal buffer o dal file
sequenziale (file annota o sorgente) e inserito nella posizione del cursore. E’ anche
possibile copiare un file sorgente AWL completo o un blocco nella posizione del
cursore.

FATTORE DI RIPETIZIONE:

E 6

TESTO | BLOCC-TXT FILE BLOCCO INDIETRO
La funzione Il menu di cancellazione prevede la possibilitd di cancellare righe singole o blocchi
CANCELLA ditestoannotati. Il testo cancellato viene scritto per sicurezzanel buffer. Viene pertanto

perduto il precedente testo "annotato”.

FATTORE DI RIPETIZIONE:

£: BRI

RIGA INIZ.BL. | FINE BL. INDIETRO
La funzione Tramite CERCA ¢ possibile saltare all'inizio o alla fine del file oppure ad una singola
CERCA riga. La riga O non é consentita. E’ inoltre possibile cercare una qualsiasi sequenza

di caratteri, fino ad un massimo di 20 caratteri (parole e numeri), che sitrova all'interno
di un campo. Testo + cerca questa sequenza di caratteri dalla posizione del cursore
in avanti, Testo - cerca all'indietro. Con CERCA ci si sposta quindiin modo indirizzato
e confortevole all'interno del file.

FATTORE DI RIPETIZIONE:

INDIETR

FINE

Bisognafare attenzione ad indicare iltesto da cercare in modo corretto nellasequenza
dei caratteri in maiuscolo e minuscolo. | testi che si trovano nei campi "IND” e
"ISTRUZIONE”", devono pertanto essere introdotti in maiuscolo!

STEP 5/ST V7.0
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La funzione
SOSTITUISCI

Scrittura
maiuscola e
minuscola

Sostituzione di
una sequenza di
caratteri

Fattore di
ripetizione

STEP 5/ST V7.0
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Una qualsiasi sequenzalunga al massimo 20 caratteri (parole e numeri) nelle colonne
IND, SIMBOLO OPERANDO e COMMENTO ISTRUZIONE pu0 essere sostituita con
un’altra. Si pud scegliere tra la sostituzione singola con o senza conferma e la
sostituzione globale (TUTTO). La sostituzione singola avviene solo dalla posizione
del cursore in avanti, occorre pertanto, per questa funzione, posizionare il cursore
almeno una riga piu in alto.

Bisognafare attenzione ad indicare il testo da cercare in modo corretto nellasequenza
dei caratteri in maiuscolo e minuscolo. | testi che si trovano nei campi "IND” e
"ISTRUZIONE”", devono pertanto essere introdotti in maiuscolo!

FATTORE DI RIPETIZIONE:

PR CEBnIEe R g
CON CONF.|SENZ.CONF INDIETRO

SOSTITUISCI offre la possibilita di correggere velocemente un file, p.es. quando si
deve sostituire nell'intero file un’istruzione o un simbolo. Fare attenzione
all'identificazione corretta della sequenza di caratteri cercata, anche gli spazi sono
importanti.

Se si deve sostituire soltanto una volta una sequenza di caratteri, si ha una possibilita
di controllo selezionando CON CONF.; La selezione SENZ.CONF esegue subito la
sostituzione. Il cursore deve stare in questo caso al di sopra della sequenzadi caratteri
da sostituire, in quanto la sostituzione singola viene eseguita dalla posizione del
cursore in avanti.

Nel caso compaia nella riga di segnalazione il messaggio "Non trovato”, significa che
nella parte ditestotrala posizione attuale del cursore e la fine non sitrovala sequenza
cercata. In questo caso bisogna portare il cursore all'inizio del file e ripetere |l
procedimento con SOSTIT. (F5), CON CONF. (F1), due volte il tasto di conferma e
SI (F1). La funzione SENZ.CONF ha un comportamento analogo, con la differenza
che non si ha nessun controllo.

E’ possibile combinare la sostituzione singola con il fattore diripetizione. Le sequenze
di caratteri sono cercate anche nei commenti. Introducendo un fattore di ripetizione
gueste vengono conteggiate dal programma. Si pud avere la sostituzione oppure no
richiamando la funzione CON CONF,, SI. Mediante il tasto d’interruzione si conclude
anticipatamente la sostituzione; le sequenze di caratteri gia sostituite restano tali.

e Con INDIETRO (F8) si abbandona la funzione di SOSTITUZIONE e tutte le
correzioni vengono perse premendo il

e tasto d'interruzione ; si conferma con il

¢ tasto di conferma . Ci sitrova a questo punto di nuovo nella SCELTA
FUNZIONI.

Indicare nuovamente il file originario:

e EDITA (F1)
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Le funzioni di
memaorizzazione
SALVA e
CONFERMA

21-28

La funzione SALVA ¢ gia conosciuta. Con essa si esegue una memorizzazione ed
e possibile interrompere e poiriprendere il lavoro, senza dovere indicare nuovamente
il file.

La funzione CONFERMA (F6) o il tasto di conferma memorizza il file, genera
automaticamente il corrispondente file intermedio e conclude le operazioni di
editazione. Durante la compilazione viene verificata la lista istruzioni generata. Nel
caso si sia verificato piu di un errore, viene generata una lista errori. Se c’e stato un
solo errore viene visualizzata sullo schermo la posizione relativa ed € quindi possibile
eseguire la correzione grazie alla segnalazione di errore visualizzata nell’'ultima riga
dello schermo.

Per quanto concerne la lista errori, consultare il capitolo 21.6|e 21.15.

Con CONFERMA (F6) si memorizza il file: questo viene compilato e si conclude
I'editazione. Viene emessa la maschera SCELTA FUNZIONI.

STEP 5/ST V7.0
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21.11 Introduzione di blocchi funzionali

Esempio Il file B:FBTESTAO.SEQ, stampato nel seguito, serve come esempio operativo. E’
ancorailcomandodellaportadiungarage, maquestavoltaprogrammato comeblocco
funzionale, in modo da illustrare la differente editazione di questo tipo di blocco.

In questo caso si deve programmare il richiamo del blocco in simbolico. Bisogna
pertanto costruire la seguente lista di attribuzione nelfile simbolico TEST@@70.SEQ
mediante I'editor simbolico nel programma STEP 5.

FILE-SEQ: TEST@@ZO.INI

E1.0 FC-SUP FINECORSA SUPERIORE

E11 FC-INF FINECORSA INFERIORE

E1.2 APRI-E PULSANTE APRI ESTERNO

E1.3 CHIUDI-E PULSANTE CHIUDI ESTERNO

El14 CHIAVE INTERRUTTORE A CHIAVE ESTERNO
E15 APRI-I PULSANTE APRI INTERNO

El1.6 CHIUDI-I PULSANTE CHIUDI INTERNO

E1.7 STOP PULSANTE DI STOP DI SICUREZZA
Al.0 MOT-AV MOTORE AVANTI

Al.1l MOT-IND MOTORE INDIETRO

T1 RITARDO TEMPO DI RITARDO, 5 SEC

FB1 GARAGE FB PER IL COMANDO PORTA GARAGE

File-AWL: B: FBTESTAO.SEQ

IND ISTRUZIONE SIMBOLO COMMENTO ISTRUZIONE
OPERANDO

# GARAGE FB1 PER UNA PORTA

#N GARAGE
FC-S (E) FINECORSA SUPERIORE
FC-I (E) FINECORSA INFERIORE
AP-| (E) PULSANTE APRI INTERNO
AP-E (E) PULSANTE APRI ESTERNO
CH-I (E) PULSANTE CHIUDI INTERNO
CH-E (E) PULSANTE CHIUDI ESTERNO
CHIA (E) INTERRUTTORE A CHIAVE
STOP (E) PULSANTE DI STOP DI
M-AV (A) SICUREZZA
M-IN (A MOTORE AVANTI

MOTORE INDIETRO

STEP 5/ST V7.0
C79000-G8572-C920-02 21-29



Editor AWL/Batch-Compiler

#UB
UN =STOP
U(

U =AP-E
U =CHIA
O =AP-
)

UN =FC-S
S =M-AV
*kk

#UB

*RESET DELL'USCITA MOTORE AVANTI

O =FC-S
O =STOP
RB =M-AV

*k%k

#UB

*QUI LA PORTA SI CHIUDE SUBITO

U(

U =CH-E
U =CHIA
O =CH-l
)

UN =FC-|
S =M-IN
*k%k

#UB

O
O
RB
BE

*RESET DELL'USCITA MOTORE INDIETRO

=FC-|
=STOP
=M-IN

APERTURA DALL'ESTERNO O
DALL'INTERNO

CHIUSURA DALL'ESTERNO O
DALL'INTERNO

CHIUSURA DALL'ESTERNO O
DALL'INTERNO

CHIUSURA DALL'ESTERNO O
DALL'INTERNO

Premesse per
I'introduzione
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Il pacchetto Editor AWL/Batch Compiler deve essere caricato. Entrare nuovamente
nell’esempio, riempire lamascheradiPREDISPOSIZIONE conilnomedifile FBTEST
per il file sorgente AWL e il file intermedio, e TEST@@ per il file programma e il file
simbolico. Confermare e richiamare la funzione di editazione.

Senonsié uscitidal pacchetto Editor AWL/Batch Compiler, viene emessalamaschera

di SCELTA FUNZIONI del pacchetto.

Entrare nella PREDISPOSIZIONE e modificare il nome del file sorgente AWL in

FBTEST.

STEP 5/ST V7.0
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Parametrizzazione

Per parametrizzare il blocco funzionale, cioé fornire gli operandi attuali, occorre
scrivere un blocco di programma:

IND

Sorg-AWL: B: FBTESTAO.SEQ

ISTRUZIONE SIMBOLO COMMENTO ISTRUZIONE
OPERANDO

#PB2 PARAMETRIZZAZIONE DI

#SPA GARAGE FB1

,E1.0

E1L11

, APRI-I

, APRI-E

) CHIUDI-I

, CHIUDI-E

, CHIAVE

, STOP

, MOT-AV

, MOT-IND

BE

STEP 5/ST V7.0

Glioperandi attuali possono essere introdottiin simbolico o in assoluto. In questo caso
fare attenzione che:

* ogni operando attuale deve essere preceduto da una virgola come carattere di
comando, e

* | parametri nella loro sequenza siano concordi con la lista delle sigle degli
operandi formali nel blocco funzionale.
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21.12 Introduzione di blocchi dati (esempio)

Sommario

Il seguente blocco dati € la base di lavoro di questo capitolo. Se si desiderano
informazioni relative ai blocchi dati, bisogna consultare l'introduzione e il relativo
capitolo nella descrizione STEP 5 del manuale del PG, volume 2.

IND

~N~NobhwN B O

100
111

Sorg-AWL: B: FBTESTAO0.SEQ

ISTRUZIONE SIMBOLO COMMENTO ISTRUZIONE
OPERANDO

#DB 12

KH FFFF

KM 1111111 11000000 NUMERO DI PEZZI

KH 0013

KF -32768

KF +32767

KG -2740000+22

KG -1234000+05

KY 022,033

KY 022,033

KY 022,033

KY 022,033

KH ADAC

KH 4538

KF +32767

KF +32767

KF +32767

KF +32767

KF +32767

KY 022,033

KY 022,033

Premesse per
I'introduzione
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Il pacchetto Editor AWL/Batch Compiler deve essere caricato. E’ stato appena
eseguito 'esempio per i blocchi funzionali, ci si trova nella funzione di editazione ed
e emesso il file FBTEST.

Entrare nuovamente in questo esempio, riempire lamascheradiPREDISPOSIZIONE
con il nome di file FBTEST per il file sorgente AWL e il file intermedio, e TEST@@
per il file programma e il file simbolico. Confermare e richiamare la funzione di
editazione.

Avvertenza

Se si introduce un indirizzo che non & coerente con I'effettivo indirizzo nel DB, nella
compilazione gli spazi vuoti creatisi vengono riempiti con KH 0000 (nell'esempio
dall'indirizzo 9 al 99). In questo modo si puo creare spazio per i dati dal processo.

A differenza del pacchetto KOP, FUP, AWL, il fattore di ripetizione non puo essere
utilizzato direttamente, ma soltanto in combinazione con la funzione COPIA.
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21.13 Modifica di un file sorgente AWL

Sommario

Premessa
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Se sivuole modificare unfile sorgente AWL all'interno dell’editor AWL/Batch Compiler,
bisogna emetterlo sullo schermo conI'editazione ed elaborarlo con le funzioni di edita-
zione.

Nel nostro esempio si vuole incorporare il file FBTEST, mediante il comando Include,
nel file sorgente AWL TEST@@. Per questo scopo deve essere esistente
FBTESTAO.SEQ come file intermedio. Nel nostro caso questa premessa € gia
soddisfatta (vedere sopra).

Nella Predisposizione introdurre TEST@@ come file sorgente AWL.

e EDITA (F1) file TEST@@.

Saltare alla fine del file con

e CERCA (F4),

* FINE (F7), e ritornare poi nel modo editazione con INDIETRO (F8).
E’ impostato il modo inserimento.

* Posizionare il cursore prima del primo blocco, tra BE e #PBn oppure alla fine del
file dopo I'ultimo fine blocco BE;

* Eseguire uninserimento in verticale; in questo modo si ha spazio per il comando
Include. # Spazio B:FBTEST.

* Premere CONFERMA (F6), per memorizzare e tradurre. In questo modo il file
intermedio € aggiornato.

Se adesso si traduce il file sorgente AWL TEST@@AO.SEQ nel file programma
STEP 5 TEST@@ST.S5D, anche FBTESTA1.SEQ viene compilato e trasferito nel
file programma, dove si trovano tutti i blocchi editati durante questa esercitazione.
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21.14 Compilazione con la funzione COMPILER

Sommario

Sequenza
operazioni:
compilazione nel
file programma
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Il file sorgente AWL memorizzato dopo la conferma si trova ora nella forma di file
intermedio (ZWI). Per tradurlo in un file programma STEP 5, bisogna richiamare la
funzione COMPILER. La lista istruzioni & compilata nel file programma che viene
indicato nella Predisposizione. Con ZWI>MCS5 il file intermedio viene convertito nel
codice macchina MC5, con SEQ>MCS5 ci0 avviene per il file sorgente AWL attraverso
la generazione automatica del file intermedio.

In modo analogo si pud eseguire la decompilazione: da un file programma in MC5
con MC5>ZWI viene generato un file intermedio (questo puo essere ulteriormente
elaborato con la funzione SPECIALE per un file sorgente AWL), oppure con
MC5>SEQ si ottiene direttamente il file sorgente AWL con il corrispondente file inter-
medio.

La funzione SEQ>MCS5 esegue dapprima la compilazione SEQ>ZW!I. Nel caso si
verifichino degli errori, non viene avviata la compilazione ZWI>MC5, ma si conclude
la funzione. In questo caso nella lista errori si trovano le segnalazioni degli errori
verificatisi nella generazione del file intermedio. In modo analogo la funzione
MC5>SEQ avvia inizialmente la compilazione MC5>ZWI e soltanto nel caso di
generazione senzaerroridelfile intermedio prosegue con la compilazione ZWI>SEQ.

Nella Predisposizione si trova il file sorgente AWL FBTESTAO.SEQ.
Procedere come segue:

* Richiamare con F2 la funzione COMPILER

* Premere ZWI>MC5 (F2) oppure SEQ>MCS5 (F1).

* Riempire la seguente riga di comando:

Compilazione dei blocchi: OPT: DRU:

Il tasto Help propone per ciascun campo d’introduzione le possibili alternative.
* Nel campo BLOCCHI premere il tasto Help.

Oltre alle solite indicazioni possibili nel pacchetto STEP 5 si possono indicare anche
gruppi di blocchi che devono essere elaborati, p.es. PB12-21.

* Scrivere B in questo campo e concludere
* con il tasto Return
* Premere il tasto Help nel campo OPZione.

Con "2” si pud avviare un test di compilazione: il file intermedio viene compilato e
verificato per quanto concerne eventuali errori, ma non viene memorizzato nel file
programma. Gli errori verificatisi sono accessibili tramite la lista errori.

¢ Introdurre 2
* e premere il tasto Return

e Se il file programma contiene gia gli stessi nomi di blocchi e il campo OPZione
€ vuoto, il dispositivo di programmazione richiede la conferma per ogni copia; in
questo caso i blocchi esistenti vengono di volta in volta sovrascritti con quelli
nuovi con lo stesso nome. Utilizzando I'opzione "1”, i blocchi nel file programma
vengono sovrascritti senza conferma.

* Premere il tasto Help nel campo STAmpa.
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Sequenza
operazioni:
decompilazione
del file programma
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| formati per le stampe sono quelli soliti del pacchetto STEP 5: scrittura normale,
scritturaristretta e scrittura superstretta. La dimensione del foglio DIN A3 0 Ad dipende
dalla stampante collegata.

Nel nostro esempio questo campo resta vuoto.

Compilazione dei blocchi: B OPT: 2 DRU:

e Premere il tasto conferma .

Il dispositivo di programmazione esegue ora la compilazione e la verifica. Esso
segnala quali blocchi sono in elaborazione e quanti errori si sono verificati oppure se
la compilazione & senza errori. Il dispositivo di programmazione si riporta poi nella
scelta funzioni.

Se la compilazione & senza errori, ripetere il procedimento di compilazione. Lasciare
vuoto il campo opzione, in modo che venga generato il file programma, e introdurre
un * nel campo STAmpa, per avere una stampa.

Compilazione dei blocchi: B OPT: 2 DRU: *

e Premere il tasto conferma

I blocchi del file sorgente AWL FBTESTAO.SEQ vengono compilati e memorizzati
come codice macchina nel file programma TEST@@ST.S5D. E’ ora possibile
elaborare ulteriormente i blocchi FB1 e PB2 nel pacchetto KOP, FUP, AWL (p.es. in
test AG).

Le operazioni sono analoghe alla compilazione. Si utilizza solo la funzione MC5>ZWI
(F4) oppure MC5>SEQ (F5). Importante per la decompilazione & che i file
corrispondenti si trovino nella Predisposizione. Per la riga di comando valgono le
stesse convenzioni della compilazione. Il tasto Help offre nel campo OPZione le
seguenti varianti rispetto alla compilazione:

* Richiamare COMPILER (2)
* Selezionare MC5>ZW!I (F4)

* Riempire la riga di comando
* Premere il tasto Return

¢ Viene ora nuovamente generato il file intermedio. Se ne esiste gia uno con lo
stesso nome, viene sovrascritto (dopo conferma). La funzione MC5>SEQ genera
automaticamente il file sorgente AWL, che si puo elaborare con I'editor AWL (vedi
3.4). Con la funzione MC5>ZW!I bisogna richiamare appositamente la funzione
SPECIALE e quindi la funzione ZWI>SEQ per generare dal file intermedio un file
sorgente sequenziale.
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21.15 Lista errori

Nella lista errori non si trovano soltanto gli errori verificatisi durante la compilazione,
ma un completo protocollo della compilazione stessa: sono elencati anche i blocchi
compilati senza errori e nel caso di una interruzione € indicata la posizione relativa.

Peravere un esempio reale, introdurre un errore nel’FB1: EDITARE in FB1 e scrivere
p.es.l'istruzione direset solo con R. Gia durante lamemorizzazione con CONFERMA
si ha I'avvertimento che si e verificato un errore.

1. Richiamare ora la LISTA-E (F3)

2. Riempire nella riga di comando il campo di STAmpa,; risulta infatti pit agevole
correggere sulla stampa la sorgente AWL. Il tasto Help mostra i parametri per
il campo di STAmpa.

3. Premere il tasto conferma : ogni istruzione errata viene visualizzata e chiarita
con l'indicazione del blocco e il numero di riga; sono anche elencati i blocchi
compilati in modo corretto.

FILE B:FBTESTAF.SEQ

*»** FB1 COMPILATO

COMPILAZIONE SORG-AWL B:FBTESTAO.SEQ => FILE INTERMEDIO B:FBTESTA1.SEQ

R =M-AV

*** ERRORE ALLA RIGA 28: OPERANDO NON CONSENTITO ***
R =M-IN

*»** ERRORE ALLA RIGA 45: OPERANDO NON CONSENTITO ***

*»** PB1 COMPILATO, BLOCCO CORRETTO ***
*** COMPILAZIONE CONCLUSA; 2 ERRORI, NESSUN AVVERTIMENTO ***

2 ERRORI TROVAT] ***

Emissione della
lista errori

21-36

La lista errori € emessa sullo schermo, se non e stato riempito il campo STAmpa nella
riga di comando. Per liste errori pit lunghe, I'emissione sullo schermo viene arrestata
ogni 20righe ed & quindi possibile o interrompere I'emissione coniltasto d'interruzione
0 visualizzare le successive parti con il tasto di conferma.
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21.16 Stampa

Sommario

Premessa

Operazioni
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Con questa funzione si stampa solo il file sorgente AWL preimpostato. E’ necessario
soltanto definire nellariga di comando il layout dell'emissione di stampa (per i dettagli
relativi si rimanda alla descrizione STEP 5, manuale volume 2, capitolo relativo a
introduzione/emissione di blocchi AWL). | file compilati possono essere emessi su
stampante solo mediante la riga di comando della funzione COMPILER.

La stampante € stata collegata ed € pronta al funzionamento; se si ha una stampante
di altro fornitore, occorre parametrizzarla opportunamente nell’apposito programma
di servizio. E’ preimpostata la stampante PT88. Nella Predisposizione dell’'editor
AWL/Batch Compiler si trova il nome del file da stampare, p.es. FBTEST. E’ emessa
sullo schermo la scelta funzioni.

¢ Richiamare STAMPA (F4),

* Riempire il campo STAmpa; risulta preimpostata I'emissione standard con
scrittura normale,

e Premere il tasto conferma .

Il file sorgente AWL FBTESTAO.SEQ viene stampato. Il dispositivo di
programmazione ritorna nella scelta funzioni.

E’ possibile, come nel pacchetto KOP,FUP,AWL, mandare su un file I'emissione di
stampa. Questo file va definito nel programmadi servizio STAMPANTE, introducendo
ilnome delfile stampante nella PREDISPOSIZIONE. Per I'attuale comando di stampa
definire nella riga di comando il layout che solitamente si utilizza. Questo layout viene
trasferito nel file di stampa.
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21.17 Funzione SPECIALE per I'elaborazione di file sorgenti e file intermedi

Sommario

COPIA

SEQ>ZWI
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La funzione speciale serve per I'elaborazione e la conversione di file sequenziali
e intermedi e consente la verifica dei file programma compilati. Tutti i procedimenti
siriferiscono aifile definiti nella Predisposizione. Fare pertanto attenzione alla corretta
indicazione dei file nella relativa maschera. Nel nostro esempio la Predisposizione
viene lasciata inalterata.

Ogni procedimento puo essere interrotto con il tasto d'interruzione.

7,
CANC-ZWI

Per effettuare delle copie di sicurezza si utilizza la funzione COPIA. Essa consente
la copia del file intermedio ed anche del file sorgente AWL su un altro drive. Il
procedimento di copia € commentato dal dispositivo di programmazione, p.es. con
"Errore hardware”, nel caso non sia chiuso il floppy disk drive.

Per elaborare i file di esempio senza pericolo, fare delle copie su dischetto.
* Registrare nella Predisposizione il file sorgente AWL,

* Richiamare la funzione SPECIALE (F5),

¢ Richiamare COPIA (F5),

* Indicare il drive: A

¢ Premere il tasto conferma . Il file intermedio & ora salvato su dischetto. Alla
domanda "Copia anche file sorgente SEQ ?”

* Premere il tasto conferma (si)

¢ llfile intermedio e il file sorgente AWL sono ora copiati su dischetto. Il dispositivo
di programmazione ritorna alla scelta funzioni.

Richiamare SEQ>ZWI (F1), se si desidera tradurre un file sorgente AWL, costruito
con un altro editor di testi. Con questa funzione il file di testo viene convertito in un
file intermedio, come premessa per una successiva compilazione nelfile programma.

¢ Registrare il file di testo nella PREDISPOSIZIONE,
¢ Attivare la funzione SPECIALE (F5),

* Richiamare SEQ>ZWI (F1), il dispositivo di programmazione richiede "Tradurre
il file sorgente AWL nel file intermedio ?”

* Premere il tasto conferma (si)

* Ora e disponibile un file intermedio per ulteriori elaborazioni. Il dispositivo di
programmazione ritorna nella scelta funzioni.
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ZWI>SEQ

CANC-SEQ e
CANC-ZWI

VERIFICA
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Richiamare ZWI>SEQ (F2), se & stato decompilato un file programma (con
COMPILER, MC5>ZWI) € lo si vuole modificare nell’editor. A questo scopo bisogna
convertire il file intermedio in un file sequenziale. | commenti aggiuntivi del rispettivo
file sorgente AWL vanno persi.

¢ Definire nella PREDISPOSIZIONE i file appositi
¢ Attivare la funzione SPECIALE (F5),

¢ Richiamare ZWI>SEQ (F2), il dispositivo di programmazione richiede "Tradurre
il file intermedio nel file sorgente AWL?”

* Premere il tasto conferma (si)

In questo modo si genera nuovamente un file sorgente AWL. Il dispositivo di
programmazione ritorna alla scelta funzioni.

Le funzioni CANC-SEQ e CANC-ZWI cancellano il file intermedio e il file sorgente
AWL preimpostati.

¢ Definire nella PREDISPOSIZIONE gli appositi file
¢ Richiamare la funzione SPECIALE (F5)

¢ Richiamare CANC-SEQ (F3), il dispositivo di programmazione richiede
"Cancella il file sorgente AWL?"

* Premere il tasto conferma (si)
¢ |l dispositivo di programmazione ritorna alla scelta funzioni
¢ Richiamare la funzione SPECIALE (F5)

* Richiamare CANC-ZWI (F4), il dispositivo di programmazione richiede "Cancella
il file intermedio?”

* Premere il tasto conferma (si) o interrompere (no)

Il dispositivo di programmazione ritorna alla scelta funzioni.

LaVERIFICA é unulteriore testdei blocchinelfile programma preimpostato. Quiviene
anche verificato seiblocchifunzionali standard sono alimentati coniparametri corretti.
Nel caso si verifichino errori, questi sono accessibili nella lista errori.

Nellariga di comando di questa funzione & possibile introdurre blocchi singoli, gruppi
di blocchi, tipi di blocchi o tutti i blocchi di un file programma; utilizzare il tasto di Help
per ottenere queste informazioni.

¢ Definire nella PREDISPOSIZIONE il file programma ed eventualmente il tipo di
AG da verificare

* Richiamare la funzione SPECIALE (F5),

¢ Richiamare VERIFICA (F6)

* Riempire la riga di comando: p.es. introdurre *
* Premere il tasto conferma

* Riempire la lista blocchi con PB1

* Premere il tasto Return

¢ Introdurre in modo analogo FB1, DB12

* Premere il tasto conferma

Il dispositivo di programmazione commenta la verifica. Se vengono individuati errori,
si puo emettere la lista errori.
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GEN-SIMB

21-40

La funzione GEN-SIMB genera da un file sorgente AWL un file sorgente simbolico,
che contiene tutti i parametri assoluti e i simbolici utilizzati. Il file sorgente simbolico
pud essere ulteriormente elaborato mediante I'editor simbolico, p.es. per completare
leattribuzionieintrodurre commenti. Lafrequenzaconcuiricorronoiparametriassoluti
e i simboli nella sorgente del simbolico, dipende da quanto sono stati utilizzati nel file
sorgente AWL. Per eliminare le indicazioni multiple, si deve procedere come segue:

* Generare il file sorgente simbolico con GEN-SIMB

Esempio

Assoluto Simbolico Commento
STOP-EM
STOP-EM
STOP-EM

¢ Entrare in Editor Lista assegnazioni di STEP 5.

e Completare le attribuzioni alla prima comparsa del simbolo o del parametro
assoluto

Esempio:
Assoluto Simbolico Commento
E1.0 STOP-EM

STOP-EM

STOP-EM

e Tradurre in file simbolico. Le segnalazioni di errore "Simbolo gia esistente” qui
possono essere ignorate

* Decompilare il file simbolico nel file sorgente simbolico (INI>SEQ)

Esempio:
Assoluto Simbolico Commento
E 1.0 STOP-EM Stop-Em

Il file sorgente simbolico contiene ora soltanto un’attribuzione con il simbolo
STOP-EM.
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21.18 Segnalazioni di errore
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Annidamento parentesi errato: _ _
Chiusura parentesi non corretta (controllare livello parentesi).

Blocco commento troppo lungo:
Suddividere o accorciare il programma (max. 16 kbyte).

Blocco Dok troppo lungo:
Suddividere o accorciare la documentazione del programma (max. 16 kbyte).

Blocco non corretto nel file intermedio:

File intermedio (A1.SEQ) errato (errore di formato)

Generare nuovamente il file intermedio con la funzione SEQ>ZWI dal file di lavoro sequenziale
(A0.SEQ).

Blocco senza BE:
Manca l'istruzione BE (contrassegno di fine blocco)

Blocco troppo lungo:
Suddividere il programma (max. 8 kbyte)

Campo di parametri del tipo di AG superato:
Per il tipo di AG indicato questo valore di parametro non & consentito.

Carattere di comando non consenti.to: _
Al carattere # segue un carattere di comando non consentito.

Carattere non consentito: )
E’ presente un carattere non consentito.

Comandi di sistema non consentiti:
mancante.

Comando SYS non consentito:
mancante

Commento troppo lungo:
Errore di sistema ! Formato del file sorgente AWL errato. Commento istruzione troppo lungo (max.
32 caratteri).

Consentito solo per blocchi AWL:
Blocco dati.

Dati errati nel File-SEQ:
File sorgente sequenziale AWL o file intermedio errato (errore di formato).

Errore di lettura:
Errore nel dischetto, file errato.

Errore n_eII_a conversione:
Errore di sistema !

Errore nella compilazione:
Campo numerico superato.

Etichetta non consentita:
Etichetta di salto in una posizione non consentita.

Etichetta non definita:
Etichetta per I'indicazione di destinazione del salto (indirizzo simbolico) nel campo "IND” non
registrata.

Etichetta non valida:
Etichetta di salto con caratteri non consentiti.

Etichetta troppo lunga:
Nel campo "ISTRUZIONE” la destinazione del salto (indirizzo simbolico) indicata & troppo lunga
(max. 4 caratteri).

Etichette uguali:
Etichette di salto indicate piu volte.

21-41




Editor AWL/Batch-Compiler

21-42

File DVS non aperto

File intermedio gia esistente, cancellare ?:
Esiste gia un file intermedio con lo stesso nome.

File intermedio non corretto:
II file intermedio (A1.SEQ) ¢ errato (errore di formato). Generare nuovamente il file intermedio con
la funzione SEQ>ZWI dalla lista di attribuzione (A0.SEQ).

File simbolico esistente, sovrascrivere ?:
Un file simbolico con lo stesso nome & gia esistente (funzione GEN-SIMB).

File simbolico non esistente: _ S
Manca il file simbolico per una programmazione puramente simbolica.

Fine segmento mancante o segmento troppo lungo:
Manca il carattere di fine segmento *** o il comando di configurazione video per fine segmento
(BLD 255), oppure il segmento & troppo lungo (max. 255 righe).

Formato del file intermedio non valido:
II file intermedio (A1.SEQ) & errato (errore di formato). Generare nuovamente il file intermedio con
la funzione SEQ>ZWI dalla lista di attribuzione (A0.SEQ).

Formato errato:
Formato con errori

Identificazione del file intermedio errata:
II file & stato generato con un tool con diversa versione. Generare nuovamente il file intermedio
con la funzione SEQ>ZWI dalla lista di attribuzione (A0.SEQ).

Indirizzo DB non valido:
Indirizzo DB troppo lungo, oppure contenente caratteri non consentiti (max. 5 caratteri).

Il simbolo non si adatta al parametro assoluto: y _ _
L'operando assoluto e 'operando simbolico sono assegnati in modo diverso nel file sorgente AWL
e nel file simbolico.

Istruzione non consentita: _
Non & un'istruzione STEP 5 consentita.

Istruzione non consentita nel blocco: _ _
Le istruzioni del "repertorio esteso” sono consentite solo in FB.

Istruzione non consentita per tipo AG:
L'istruzione non & consentita per il tipo di AG indicato.

Istruzione non definita:
Non & un’istruzione MC5 consentita, il file programma (ST.S5D) é errato.

Istruzioni Include annidate non sono consentite:
Un file intermedio, incorporato con #INCLUDE, contiene un’ulteriore istruzione #INCLUDE.

La riga non é stata elaborata;
II tipo di blocco & indefinito.

Manca inizio blocco: . S .
Carattere # con sigla blocco in assoluto e/o simbolico non esistente

Nessuna sigla operando indicata:
Manca la sigla operando.

Nessun dato indicato:
Dopo l'indicazione di un tipo di costante nel campo "ISTRUZIONE" manca l'indicazione del valore
della costante nel campo "SIMBOLO OPERANDO".

Nessun nome del blocco indicato: . .
Nel blocco funzionale manca il carattere di comando #N e il nome del blocco.

Nessun numero BIB indicato:
Dopo #BI manca l'indicazione del numero di biblioteca.

Nessun operando formale indicato:
Al parametro attuale indicato dopo il richiamo dellFb manca nel campo "IND” dell'FB la
dichiarazione del parametro formale assegnata.
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Nessun parametro indicato: _
Manca l'indicazione del parametro (per programmazione puramente assoluta).

Nessun simbolo indicato: _ _ _
Manca il simbolo dell'operando (per programmazione puramente simbolica).

Nome del blocco gia esistente:
Il carattere di comando #N é indicato piu volte.

Non € stato indicato nessun parametro formale:
Dopo il richiamo dell’FB manca nel campo "ISTRUZIONE” I'indicazione del parametro attuale
necessario.

N. Bibl. gia esistente:
II carattere di comando #BlI ¢ indicato piu volte.

N. Bibl. non valido:
Numero di biblioteca troppo lungo, oppure contenente un carattere non consentito (max. 5 cifre).

Numero_di_funzione errato:
Errore di sistema !

Numero di parametri errato:
I numero di parametri formali dichiarati nel’FB ¢ diverso dal numero dei parametri attuali indicati
dopo il richiamo dell'FB. (Verifica)

Operando non consentito:
Operando non consentito.

Operando troppo lungo:
Sigla operando troppo lunga (max. 2 caratteri).

Operatore non indicato: _ _ _
Manca l'indicazione operatore nella programmazione simbolica.

Operatore non valido:
Operatore non definito nello STEP 5.

Operatore troppo lungo:
(max. 3 caratteri).

Parametro assoluto troppo lungo:
Errore di sistema ! Formato errato del file sorgente AWL

Parametro attuale non consentito:
L'indicazione di parametri attuali & consentito solo dopo un richiamo di FB

Parametro errato:
Parametro non valido.

Parametro formale non definito:
Nome e tipo di parametro non definiti in FB

Parametro formale non valido: _ . . o
Nel nome del parametro sono contenuti caratteri non validi oppure il tipo di parametro non &
consentito.

Parametro non consentito:
Parametro non consentito.

Parametro troppo lungo (max. 4 caratteri):
Nel campo "ISTRUZIONE" il parametro formale introdotto & troppo lungo (max. 4 caratteri).

Parametri formali gia esistenti:
Nome del parametro indicato piu volte.

Posizione dati errata:
Per le costanti il valore va introdotto nel campo "SIMBOLO OPERANDO”

Piu commenti che istruzioni.

Riga non consentita: o . .
Fare attenzione alla sequenza (caratteri di comando) nell'introduzione blocco.

Riga non valida: o _ _
Fare attenzione alla sequenza (caratteri di comando) nellintroduzione blocco.

STEP 5/ST V7.0
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Simbolo non consentito: o _
L'istruzione non consente nessuna indicazione di operando.

Simbolo troppo lungo:
Errore di sistema! Formato del file sorgente AWL errato. (max. 24 caratteri)

Solo dopo il richiamo FB:

| parametri attuali sono consentiti solo immediatamente dopo il richiamo FB.

Solo per blocchi funzionali: _
Repertorio esteso istruzioni non consentito.

Solo un titolo per ogni segmento:
II carattere di comando #UB all'inizio segmento € indicato piu volte.

Sigla operando non definita:
Sigla operando non definita nello STEP 5.

Sigla operando non consentita:
La sigla operando non si adatta all'operatore.

Tipo AG non consentito:
Indicazione di un tipo di AG non consentito

Tipo di blocco non definito (simbolo non trovato):
Manca la sigla blocco simbolica per programmazione puramente simbolica.

Tipo di parametro errato:

Nell'FB nel campo "ISTRUZIONE” il tipo di parametro formale indicato € diverso dal tipo di

parametro assegnato dopo il richiamo dell’FB. (Verifica)

Troppi parametri attuali:
(Max. 40).

Troppi parametri formali:
(Max. 40).
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Sommario Il software di parametrizzazione COM DB1 consente una parametrizzazione conforte-
vole ed esente da errori delle CPU di bassa e media potenzialita. Il tempo necessario
per una corretta parametrizzazione della CPU & minimo.

Finoraerapossibile parametrizzare le CPU tramite il DB1 soloin formaditesto. L'edita-
zione del DB1 in forma di testo avveniva con I'editor dei DB del pacchetto STEP 5.

Sommario del Capitolo Argomento trattato Pagina
capitolo 22.1 Funzioni del COM DB1 22-2
22.2 Utilizzo del COM DB1 22-6
22.3 Struttura a video delle maschere del COM DB1 22-9
22.4 Esempio di una parametrizzazione di DB1 con il 22-18

COM DB1
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22.1 Funzioni del COM DB1

Sommario

Vantaggi della
parametrizzazione
del DB1 coniil
COM DB1

Componenti del
pacchetto software
COM DB1
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In questo capitolo si pud apprendere:

quali funzioni offre il COM DBL1 e di quali limitazioni si deve tener conto,

quali CPU si possono parametrizzare con il COM DBL1.

Si hanno i seguenti vantaggi:

I COM DB1 puo interpretare e modificare ogni DB1 con dati di parametrizza-
zione commentarli.

Non & pil necessario tener conto delle regole illustrate nei manuali sui control-
lori per la parametrizzazione del DB1, poiché queste regole sono gestite dal
COM DB1. All'utente vengono presentati su video i parametri specifici della
CPU. Gli argomenti ed i campi dei valori degli argomenti possono essere sele-
zionati in speciali finestre.

I COM DB1 ¢ in grado di riconoscere errori di introduzione in DB1 e di segna-
larli in forma di testo. Errori nel DB1 vengono riconosciuti al piu tardi al mo-
mento del trasferimento nel’AG o su file di programma. Una parametrizza-
zione errata con il COM DBL1 puo cosi essere esclusa.

Con il COM DB1 possono essere generati altri blocchi dati, necessari alla pa-
rametrizzazione (p. es. le caselle di trasmissione e di ricezione).

I COM DB1 puo funzionare in modo online, cioé un DB1 creato precedente-
mente puo essere caricato in una CPU in modo online. Inoltre € possibile cari-
care un DB1 in modo online dalla CPU in un PG.

In ogni momento della parametrizzazione € possibile richiamare un testo di
supporto (help) relativo all'introduzione in corso sul video.

Il pacchetto software COM DB fa parte della fornitura di STEP 5/ST, V6.6. ESso si
trova nella directory \STEP5\S5_SYS\S5_COM\COM_DBL1

File contenuti nel pacchetto COM DB1.:

Nome del file Contenuto
s5pxcdbx.cmd COM DB1 (Command-File)
s5pdcdbx.dat Testi in tedesco
s5pecdbx.dat Testi in inglese
s5pfcdbx.dat Testi in francese
s5picdbx.dat Testi in italiano
s5pscdbx.dat Testi in spagnolo

STEP 5/ST V7.0
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22.1.1 Quali funzioni offre il COM DB17?

Creazione di un
nuovo DB1

Creazione di
blocchi dati vuoti

Introduzione di
commenti

Trasferimento di
un DB1

Emissione di un
DB1 su stampante
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Il software di parametrizzazione COM DBL1 e uno strumento confortevole per la para-
metrizzazione delle CPU di bassa e media potenzialita.

Il COM DBL1 offre le funzioni descritte di seguito. Alcune funzioni possono essere ese-
guite solo nello stato di funzionamento online della CPU e vengono opportunamente
evidenziate nel testo. Tutte le altre funzioni possono essere utilizzate sia nello stato
di funzionamento online che nello stato offline. Il funzionamento online o offline viene
selezionato nella maschera delle preimpostazioni del COM DBL1.

Siegeneratoun DB1 conil pacchetto COMDB1 elosivuole annullare: nellamaschera
Tabella panoramicapremereiltasto F1 =nuovo DB1. || DB1 appena creato viene can-
cellato e nella tabella panoramica compaiono le parametrizzazioni del DB1 di default.

Si possono modificare i parametri di un DB1 gia esistente nelllAG, selezionando il
Funzionamento online, caricando il DB1 dal’AG e sovrascrivendo i parametri che si
vogliono modificare.

Si possono modificare i parametri di un DB1 gia esistente in un file di programma
STEP 5. Caricare il file di programma STEP 5 o dalla maschera di preimpostazione
onellamaschera Caricamento di DB1. Caricare poi il DB1 dal file diprogramma STEP
5 e sovrascrivere i parametri che si vogliono modificare.

Se in un blocco parametri viene indicato un DB, il COM DBL1 verifica se questo DB
esiste gia nell’AG (possibile solo in Funzionamento online) oppure in un file di pro-
gramma STEP 5. Se il DB non esiste, il DB viene generato. Se il DB esiste, ma la
sualunghezzanon é sufficiente perla parametrizzazione, viene eseguitalacorrezione
(p. es. il DB della casella di trasmissione nella parametrizzazione SINEC L1)

Si pud introdurre un commento a tutto il DB1 ed ai singoli parametri. Un commento
puo essere lungo max. 80 caratteri (spazi compresi).

Si puo trasferire un DB1 nellAG se precedentemente si € scelto il Funzionamento
online. Se nell'’AG esiste gia un DB1, viene posta la domanda se esso debba essere
sovrascritto o no.

Sipud trasferire un DB1 in un file di programma STEP 5. Indicare il file di programma
STEP 5 nella maschera Preimpostazione oppure nella maschera Trasferimento di
DB1.

Sipuotrasferirelaparametrizzazione diDB1 suunastampante. Possono essere stam-
pate tutte le maschere di parametrizzazione e quella Panoramica. Se per la stampa
si vuole utilizzare un file di stampa e/o un file di piedinatura, si presuppone che i file
di stampa e di piedinatura esistano gia, cioé siano stati generati con il pacchetto
STEP 5. Indicare il file di stampa e di piedinatura nella maschera Preimpostazione.
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Emissione di un
DB1 in un file

Cancellazione di
un blocco
parametri

Funzioni AG

Funzioni ausiliarie

Si pud emettere un DB1 in unfile. Cio & necessario quando si vuole stampare un DB1
tramite una stampante che al momento non € collegata al PG. Indicare il file di stampa
nella maschera Preimpostazione. Se si vuole utilizzare un file di stampa e/o un file
di piedinatura, valgono le stesse condizioni che per la stampa diretta del DB1 su una
stampante. Sulfile vengono stampati gli stessi contenuti che possono essere stampati
sulla stampante (— Emissione di un DB1 su una stampante).

Se nonsivogliono utilizzare blocchi parametri, questi ultimi possono essere cancellati
nella maschera panoramica del COM DBL1.

Esecuzione delle seguenti funzioni AG se si é scelto precedentemente Funziona-
mento online:

e compressione della memoria AG

e commutazione del’AG da STOP a RUN; i parametri di DB1 nella CPU ven-
gono aggiornati

e commutazione del’AG da RUN a STOP

IlCOM DB offre poiunaserie difunzioniausiliarie che facilitano laparametrizzazione.
Una parametrizzazione errata si puo escludere , poiché il COM DB1:

¢ riconosce errori nell'introduzione di parametri,

¢ verifica, nel’ambito di un DB1, tutte le interdipendenze tra i parametri,

¢ verifica che gli argomenti si trovino entro i campi dei valori,

* emette una segnalazione in caso di errore e costringe alla correzione dell’er-
rore (un DB1 errato non pud essere memorizzato).

22.1.2 Particolarita del COM DB1

22-4

Fare attenzione alle seguenti particolarita:
e || COM DBL1 puo elaborare solo un DBL1 alla volta.

¢ || COM DB1 non puo verificare l'interdipendenza dei parametri tra diversi con-
trollori (p. es., se in una rete SINEC L2 il baudrate é stato impostato in modo
uguale in tutti i partecipanti).

* La parametrizzazione diretta nei dati di sistema non & possibile.

* Sipossono parametrizzare con il COM DBL1 solo quelle funzioni che finora
erano parametrizzabili nel DB1.

* Se un blocco parametri nella tabella panoramica del COM DB1 non contiene
alcuna parametrizzazione, il sistema operativo del’AG scrive automatica-
mente nei dati di sistema i parametri di default presenti.

STEP 5/ST V7.0
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¢ | parametri di default che sono racchiusi tra caratteri di commento (#) (— Fi-
gura del DB1 di default nel manuale del’AG corrispondente) non vengono ri-
conosciuti dal COM DBL1 e vanno persi. (Se i parametri di default che sono
racchiusi tra caratteri di commento (#) si trovano direttamente prima del codice
finale END del DB1, essi vengono interpretati come commento a tutto il DB1.)

e Con il COM DBL1 si possono parametrizzare i controllori elencati nel capitolo
22.1.3| Per gli apparecchi che sono stati ulteriormente sviluppati, cioé stessa
CPU/stesso AG con una nuova versione, vale la regola seguente:

Il COM DBL1 fa riferimento all’'ultima versione dell’apparecchio ad esso nota. Questo
significa che per un apparecchio che sia stato potenziato, vengono parametrizzate
solo le funzioni che erano parametrizzabili nell’'ultima versione. Nuovi parametri/bloc-
chi parametri disponibili e/o campo di valori variati non sono noti al COM DBL1.

L'impiegodelle singolefunzionidel COMDB1 é descrittoinmodo precisoinunesempio
di una parametrizzazione completa di un DB1, alla fine di questo capitolo.

22.1.3 Quali controllori si possono parametrizzare con il COM DB1?

Con il COM DBL1 si possono parametrizzare tutti i controllori/CPU che sono elencati nella tabella seguente:

Controllore programmabile / CPU Parametrizzabile con COM DB1 da
ordinazione/versione
Controllore programmabile S5-90U 6ES5 090-8MAO01 A01
Controllore programmabile S5-95U:
¢ Apparecchio base 6ES5 095-8MAO1 AO01
¢ con interfaccia SINEC L2 6ES5 095-8MB01 AO1
¢ con due interfacce seriali 6ES5 095-8MCO01 A01
¢ con interfaccia SINEC L2-DP 6ES5 095-8MDO01 AO1
Controllore programmabile S5-100U:
¢ CPU 103 6ES5 103-8MAO03 A01
Controllore programmabile S5-115U:
¢+ CPU941 6ES5 941-7UB11 A0l
¢+ CPU942 6ES5 942-7UB11 A0l
¢ CPU 943 con una interfaccia seriale 6ES5 943-7UB11 A01
¢ CPU 943 con due interfacce seriali * 6ES5 943-7UB21 AO01
¢ CPU 944 con una interfaccia seriale e 6ES5 944-7UB11 AO01
modulo del sistema operativo 6ES5 816-1BB11/21 AO1
¢ CPU 944 con due interfacce seriali * 6ES5 944-7UB21 AO01
e modulo del sistema operativo 6ES5 816-1BB11/21 AO1
¢ CPU 945 con memoria da 256 kByte e 6ES5 945-7UA11 AO01
modulo del sistema operativo 6ES5 816-5AA01 A01
¢ CPU 945 con memoria da 384 kByte e 6ES5 945-7UA21 AO1
modulo del sistema operativo 6ES5 816-5AA01 AO01
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22.2 Utilizzo del COM DB1

Avvio del COM Il COM DB1 si avvia come descritto di seguito:
DB1 1. Awviare lo STEP 5.
2. Selezionando il ment Cambio » COM DB1 viene caricato il COM DB1.

Sul monitor del PG compare la maschera di avvio del COM DB1, la maschera Scelta
lingua.

22.2.1  Gerarchia operativa del COM DB1

Sommario In questo capitolo si apprende come si procede nella parametrizzazione con il COM
DB1 (concetti generali), come sono strutturate le maschere del COM DB1 sul video
del PG, come si eseguono le introduzioni nelle maschere del COM DB1 e quali regole
occorre rispettare e quali aiuti e segnalazioni di errore sono resi disponibili dal COM
DB1.

L'impiego del COM DB1 avviene tramite maschere che sono ordinate in diversi livelli
operativi. Per tutti i livelli operativi vale:

¢ premendo i tasti da F1 a F7 si avvia una funzione del COM DBL1 e si arriva in
una maschera sottordinata.

* ogni maschera del COM DB1 puo essere abbandonata con il tasto F8 =
Ritorno con il quale si torna alla maschera sovraordinata.

STEP 5/ST V7.0
22-6 C79000-G8572-C920-02



Software di parametrizzazione COM DB1

Nellaseguente organizzazione gerarchicadelle maschere viene chiaritoil concetto operativo nellaparametrizza-
zione con il COM DB1.

Maschera di avvio:

Scelta lingua COM DB1

A . Per tutte le maschere
‘ ! e attivo con <F8> il
ritorno alla maschera

sovraordinata

[ Preimpostazione

1° livello operativo

2° livello operativo Tabella panoramica

ol : |
3° livello operativo 2 I ‘ - I ‘ E6 |
i Y

(Blocco parametri, p.es. CLP
L

Funzioni AG

Trasferimento di DB1
[ Stampadi DB1

L Jm-7 Lo

4° livello operativo

Figura 22-1  Struttura gerarchica del COM DB1

Dopo l'avvio, compare la prima maschera del COM DB1, la maschera Scelta lingua.
Premendo un tasto funzionale si sceglie il COM DB1 nella lingua desiderata.

1. livello operativo: Dopo la scelta della lingua, si arriva nella maschera di preimpostazione. In questa
preimpostazione maschera si definiscono le preimpostazioni necessarie al COM DB1.

Nella maschera di preimpostazione si devono definire:

¢ il tipo di funzionamento del COM DB1 con la CPU (funzionamento
online/offline),

¢ il numero di ordinazione della CPU (MLFB) e

e |aversione dellAG.

STEP 5/ST V7.0
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2° livello
operativo: tabella
panoramica

3° livello opera-
tivo: funzioni di
servizio di
DB1/Blocco para-
metri .../Funzioni
AG

CASO
PARTICOLARE

40 livello opera-
tivo: blocco para-
metri SINEC L2
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Le introduzioni negli altri campi della maschera di preimpostazione dipendono dalle
funzioni che sivogliono eseguire nelle maschere successive. (Se ad esempio sivuole
memorizzare unDB1inunfilediprogramma, alloranellamascheradipreimpostazione
sipuointrodurreilnome delfile (file destinazione) nel campo File programmaprevisto).

Dopo laconfermadelle preimpostazioni, siarriva nellamaschera Tabellapanoramica,
nella quale sono presentati tutti i blocchi parametri possibili per il tipo di CPU definito
nella maschera delle preimpostazioni. Accanto ai blocchi parametri compare l'indica-
zione dello stato di parametrizzazione di ogni singolo blocco parametri (p. es. non
parametrizzato, parametrizzato (default), ecc.).

Nella maschera Tabella panoramica si puo decidere:

* se sivuole caricare, trasferire o stampare un DB1 gia presente nell’AG o in un
file di programma (funzioni di servizio di DB1),

* se si vogliono modificare o cancellare i blocchi parametri di un DB1 caricato,
* se sivuole generare un nuovo DB1 oppure
* se sivuole operare in una funzione AG.

Al primo passaggio dallamascheradelle preimpostazioniallamaschera Tabellapano-
ramica, nella riga di segnalazione viene comunicato se un DB1 si trova nel file di pro-
gramma e/o nell’AG. Nel caricamento di un DB1 gia presente, la tabella panoramica
viene aggiornata.

Se nel 2° livello operativo si € scelta una funzione di servizio DB1 (p. es: Caricamento
DB1) oppure una funzione AG, nel 3° livello operativo compare la maschera corrispon-
dente per poter eseguire la funzione.

Se nel 2° livello operativo si € scelto un blocco parametri, nel 3° livello operativo si
arriva nella maschera di parametrizzazione. Tale maschera di parametrizzazione esi-
ste per ognuno dei blocchi parametri. Una maschera di parametrizzazione contiene
un elenco di tutti i parametri relativi al blocco parametri. Dati di parametrizzazione gia
presenti (p. es. dopo il caricamento di un DB1), vengono presentati nei campi di introdu-
zione della maschera di parametrizzazione. Nei campi di introduzione senza parame-
trizzazione si trovano i valori di default.

3° livello operativo: Tabella panoramica SINEC L2

Per il blocco parametri SINEC L2 non & sufficiente una pagina video per I'elencazione
di tutti i parametri. In questo caso, il blocco parametri & suddiviso in sotto-gruppi di
parametri logicamente correlati tra di loro. Dopo la scelta di questo blocco parametri
nella maschera Tabella panoramica, si arriva nella maschera Tabella panoramica Sl-
NEC L2 che contiene i sotto-gruppi.

Il quarto livello operativo esiste solo se nel 3° livello operativo del COM DB1 compare
la maschera Tabella panoramica SINEC L2 con i sotto-gruppi di parametri. Per ogni
sotto-gruppo esiste una propria maschera di parametrizzazione. Nel 4° livello opera-
tivo Blocco parametri SINEC L2 valgono le stesse possibilita di introduzione del 3°
livello operativo "Blocco parametri ...".
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22.3 Struttura a video delle maschere del COM DB1

Sommario

Riga di
intestazione

Riga di commento

Area di ingresso o
di uscita
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Tutte le funzioni del COM DB1 possono essere eseguite con le introduzioni nelle ma-
schere. Le maschere del COM DB1 hanno, in linea di principio, la stessa struttura.
Esse sono suddivise in 5 campi. Nell'esempio della maschera di parametrizzazione
Parametrizzazione orologio (CLP), viene illustrata la suddivisione delle maschere del
COM DB1.

'Ritgat (Parametrizzazione orologio (CLP) SIMATIC S5/COM DBﬂ
intest.
Riga comm.
”””” Posizione della parola di stato: _ N
Posizione dei dati dell'orologio: N.:
Fattore correz.: Aggiornamento orologio in Stop:
Salvataggio ora:
i(r:]grrgzgcg' Data/ora: Modo orologio:
uscita GiornSett.: Data (gg mm aa): Ora (hh mm ss):
Sveglia: Modo orologio:
GiornSett.: Data (gg mm): Ora (hh mm ss):
Impostare contatore (hhhhhh mm ss):
7777777 Abilitare contatore:
Riga di
segna-
lazione
Riga di F F F F F R F F
menu 1 2 3Scelta 4 5 6 Enter 7 Info 8 Ritorno

Figura 22-2 Maschera del COM DB1 "Parametrizzazione orologio (CLP)”; suddivi-
sione in campi parziali delle maschere a video del COM DB1

La riga di intestazione di tutte le maschere del COM DB & costituita da una sola riga
e separata dal resto della maschera da una linea. Essa contraddistingue il contenuto
dellamascheradel COM DBL1. Lariga diintestazione nelle singole maschere non puo
essere modificata.

Nella riga di commento & possibile introdurre un commento ad un blocco parametri
(nelle singole maschere di parametrizzazione) o atutto il DB1 (nellamaschera Tabella
panoramica. Lariga dicommento & una sola e pud contenere al massimo 80 caratteri.

L'ampia parte centrale € laveraareadiingresso delle maschere COMDBL1. Inquest'a-
rea, infunzione dellivello operativo, vengono presentati testi statici e campi di introdu-
zione nei quali si puo effettuare la parametrizzazione. Tramite la tastiera si scrivono
in questi campi di introduzione i dati di parametrizzazione rilevanti e ammessi per la
funzione selezionata e che successivamente possono essere trasferiti nel file di pro-
gramma o nell’AG.
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Riga di
segnalazione

Riga di menu

Nella stessa area si possono visualizzare a video i dati di parametrizzazione di un
DB1 presente in un file di programma o nell’AG (area di uscita). In quest'area il COM
DB1 presenta anche finestre di selezione, finestre di help e avvertimenti a supporto
dell'impiego del COM DB1.

Nella riga di segnalazione, il COM DB fornisce informazioni sull’'andamento attuale
della funzione, su errori di impiego o anomalie. Nel primo passaggio dalla maschera
delle preimpostazioni alla maschera Tabella panoramicail COM DB1 comunica nella
riga di segnalazione se il DB1 si trova in un file di programma e/o nel’AG.

Lariga di menu (tasti funzionali F1 ... F8) sul bordo inferiore del video indica quali fun-
zioni si possono eseguire con i tasti funzionali della tastiera. Funzioni del COM DB1
non possibiliin offline (p. es. Carica da AG) non vengono avviate, in modo offline, dallo
stesso tasto funzionale.

22.3.1 Possibilita e regole nell'introduzione nelle maschere del COM DB1

Sommario

Le introduzioni nei
campi d’introdu-
zione
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In questo capitolo viene spiegato:

* come avvengono le introduzioni nei campi d’'introduzione,
* come si introducono i commenti e

* dove occorre porre I'attenzione in editazione.

Tutte le introduzioni nelle maschere del COM DB1 vengono supportate dal cursore.

Sono possibili due modi per introdurre i valori dei parametri con I'aiuto del cursore:
. Il testo viene introdotto a caratteri tramite la tastiera.

. Il testo viene selezionato nella finestra di scelta (se esiste) relativa al
campo di introduzione (con F3 = Scegli).

Avvertenza

Con il tasto F6 = Enter vengono poi trasferiti in DB1 i parametri modificati. Il tras-
ferimento avviene solo quando tutti i dati di parametrizzazione del blocco sono
esenti da errori. Dopo I'esecuzione del trasferimento, il COM DB1 commuta auto-
maticamente nella maschera Tabella panoramica.

Esempio relativoa [1]: Introduzione a caratteri del fattore di correzione
1. Posizionare il cursore sul campo Fattore di correzione..
2. Introdurre tramite la tastiera il parametro desiderato (p. es.: "9”).

3. Concludere lintroduzione con (O ) oppure INSERT. (Con ESC il testo viene
annullato.)

STEP 5/ST V7.0
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Esempio relativo a [2]: Introduzione del giorno della settimana tramite la

finestra di scelta
1. Posizionare il cursore sul campo Giorno della settimana..

2. Aprire la finestra relativa al campo di introduzione. Per questo premere F3=
Scegli.
Posizionare il cursore sulla riga di testo interessata nella finestra di scelta.
4. Trasferire il giorno della settimana scelto nel campo di introduzione. Per

questo premere ( [1) oppure INSERT. Nel campo di introduzione compare
allora il testo selezionato. (Con ESC viene interrotto il trasferimento.)

Parametrizzazione orologio (CLP) SIMATIC S5/COM DB1

Posizione della parola di stato: _ N.:
Posizione dei dati dell’orologio: N.:
Fattore correz.: Aggiornamento orologio bo
Salvataggio ora: in Stop: LU
MA
Data/ora: Modo orologio: ME
GiorSett.: Data (gg mm aa): Gl
VE
Sveglia: Modo orologio: SA
GiornSett.: Data (gg mm): XX
Impostare contatore (hhhhhh mm ss):
Abilitare contatore:
F F F F F F F F
1 2 3 Scelta 4 5 6 Enter 7 Info 8 Ritorno

Figura 22-3 Maschera del COM DB1 "Parametrizzazione orologio (CLP)"; scelta del giorno della settimana

Introduzione dei
commenti

STEP 5/ST V7.0
C79000-G8572-C920-02

Nel COM DBL1 é possibile introdurre:
un commento a tutto il DB1 nella maschera Tabella panoramica ed

un commento ad ogni blocco parametri nella rispettiva maschera
di parametrizzazione

Il commento viene introdotto nell’apposita riga di commento nella parte alta dello
schermo della maschera COM DBL1. Il commento puo essere lungo max. 80 caratteri
(spazi inclusi).

Esempio relativo a [2]: Introduzione del commento al blocco parametri

Parametrizzazione orologio (CLP)

1. Premere nella maschera Parametrizzazione orologio (CLP) il tasto di com-
mento COM. Il cursore salta allora nella riga di commento.

2. Introdurre il commento tramite la tastiera (p. es.: Impostare il tempo di sveglia
del complesso di manutenzione 1).

3. Concludere l'introduzione con ( [1) oppure INSERT. (Con ESC si abbandona
la riga di commento senza variazioni del contenuto originario.)
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Particolarita e re-
gole delle introdu-
zioni nelle ma-
schere del COM
DB1
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Avvertenza

Un commento ad un blocco parametri viene trasferito in DB1 insieme al blocco
parametri (con F6 = Enter).

Nel riquadro seguente sono state raccolte alcune particolarita e regole nella parame-
trizzazione di DB1 con il COM DB1:

Avvertenza

Se nella maschera delle preimpostazioni non si indica la versione della CPU, al-

lora il COM DB1 accede al set di parametri (blocchi parametri, campi dei valori)

della versione pil elevata ad esso nota. | COM DB1 presenta la versione attuale

nel corrispondente campo di introduzione della maschera delle preimpostazioni.

Per la CPU 944 con due interfacce seriali si deve inoltre introdurre, nella maschera

delle impostazioni, il numero di ordinazione e la versione del modulo di sistema

operativo.

Nel caricamento di un DB1 creato con lo STEP 5 possono andare perduti i com-

menti, se:

— il commento & piu lungo di 80 caratteri,

— il commento al DB1 non si trova immediatamente prima del carattere finale
"END” oppure

— il commento ad un blocco parametri non si trova immediatamente dopo il
codice di blocco. Blocchi parametri che nel DB1 di default sono racchiusi
tra i caratteri di commento (#), vanno in ogni caso perduti.

Se, prima della conferma del blocco parametri, si cancella un parametro al quale e

attribuito un valore di default, allora il valore di default resta valido nel’AG. Dopo

una nuova selezione della maschera di parametrizzazione, il valore di default

viene presentato nel campo di introduzione del parametro.

STEP 5/ST V7.0
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22.3.2 La Guida online e le segnalazioni di errore del COM DB1

Sommario

Guida online

Riga di
segnalazione

Maschera di help

Esempio

STEP 5/ST V7.0

C79000-G8572-C920-02

Nellaprogrammazione del DB1, il COM DB1 offre un’ampia guida e varie segnalazioni
di errore. In questo capitolo viene fornita una panoramica:

* su tutte le informazioni di help che sono offerte dal COM DB1 durante la
parametrizzazione

¢ i tutte le segnalazioni di errore che il COM DB1 emette durante la
parametrizzazione di DB1.

La Guida online del COM DBL1 si orienta su quella dello STEP 5.

In dipendenza dalla maschera del COM DBL1 scelta e dalla posizione attuale del cur-
sore, si possono richiedere sul video testi di help. I COM DBL1 offre tre tipi di aiuto:

Riga di segnalazione: avvertenze e segnalazioni di errore nella riga di
segnalazione delle maschere del COM DB1

Maschere di help: testi di aiuto con chiarimenti relativi alla maschera attuale
del COM DBL1 e all'assegnazione dei tasti funzionali.

Finestre di informazione: testi di aiuto con informazioni relative ai campi di
introduzione.

Nellariga di segnalazione delle maschere del COM DB1 (— Figura 22-4) il COM DB1
fornisce informazioni relative a:

e gli errori nell'impiego del COM DB1 (p. es. Introduzione non valida)
e gli errori di parametrizzazione

¢ ['andamento attuale del funzionamento del COM DBL1 (p. es. I/l DB1 viene
caricato. Attendere ...)

* la presenza di un DB1 come file di programma e/o nell’AG nel passaggio dalla
maschera delle preimpostazioni alla maschera Tabella panoramica.

Se in una maschera del COM DBL1 si preme il tasto HELP, sul video viene presentata
una maschera di help con un breve chiarimento relativo alla maschera selezionata
ed all'assegnazione attuale dei tasti funzionali.

Il vecchio contenuto del video viene cancellato e viene presentato il corrispondente
testo di help.

Se unapaginadelvideo non é sufficiente per larappresentazione, si arriva alla pagina
video successiva premendo il tasto INSERT oppure L.

Coniltasto ESCsiesce dalla maschera di help. Viene ripristinato il vecchio contenuto
del video.

Maschera di help: chiarimentirelativi alla maschera attuale del COM DB1 Parametriz-
zazione orologio (CLP) ed all'assegnazione dei tasti funzionali.
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Parametrizzazione orologio (CLP) SIMATIC S5/COM DB1

Blocco parametri per I'orologio (CLP):

Si pud parametrizzare I'orologio incorporato per:

— ora e funzioni di calendario (p. es. per creare un comando dipendente dall’orario)

— funzioni di sveglia e di allarme (p. es. per il controllo della durata di un processo)

— contatore di esercizio (p. es. per il controllo di intervalli di ispezione)

L’impiego di memoria & determinato dalle funzioni orologio utilizzate. Se si utilizzano DB, il COM DB1,
dopo il trasferimento, verifica se questi sono dimensionati correttamente e li deposita, dopo una speci-
fica richiesta, nell’AG risp. in un file. L'AG funziona anche senza di loro!

<F3> Finestra di scelta delle introduzioni ammissibili
<F7> Informazione sul campo di introduzione su cui € posizionato il cursore
<F6> Le modifiche vengono acquisite

<ESC> opp. <F8> Le modifiche vengono annullate
<COM> opp. <-:-> Editazione di un commento per tutto il blocco parametri

<ESC> Chiusura di una finestra
F F F F F F F
1 2 3 Scelta 4 5 6 Enter 7 Info

F

8 Ritorno

Figura 22-4 Maschera di help: chiarimenti relativi alla maschera attuale del COM DB1 "Parametrizzazione orolo-

gio” ed all’'assegnazione dei tasti funzionali

Finestre di

informazione

22-14

Con il tasto funzionale F7 = Info (se selezionabile) si pud richiedere un aiuto relativo
ai campi di introduzione del COM DBL1. In funzione della posizione del cursore nel
campodiintroduzione, vengono brevemente descritte, inunafinestradiinformazione,
tutte le introduzioni possibili e ammesse.

Contrariamente a quanto descritto precedentemente per le maschere di help per la
descrizione dei tasti funzionali, la singola finestra di informazione si sovrappone solo
ad una parte del contenuto attuale del video. Il campo di introduzione resta visibile.

Si puo aprire una sola finestra di informazione alla volta.

Primadicompilare il campo diintroduzione o primadi posizionare il cursore nel campo
diintroduzione successivo, la finestra di informazione deve essere chiusa con il tasto
ESC.

Esempio:

Finestra diinformazione relativa al campo diintroduzione Giorno della settimanadella
maschera del COM DB1 Parametrizzazione orologio (CLP).

STEP 5/ST V7.0
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Segnalazioni di
errore

Errori che pos-
sSono essere rico-
nosciuti durante il
caricamento

STEP 5/ST V7.0
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Parametrizzazione orologio (CLP) SIMATIC S5/COM DB1

Indicare il codice per il giorno della settimana:

LU - Lunedi, MA - Martedi, ME - Mercoledi, Gl - Giovedi, VE - Venerdi,
SA - Sabato, DO - Domenica

Con l'introduzione di XX, I'orologio continua con il giorno della set-
timana attuale.

<ESC>: Chiusura di una finestra

GiornSett.: Tata (gg mm aa): Ora (hh mm ss):
Sveglia: Modo orologio:
GiornSett.: Data (gg mm): Ora (hh mm ss):

Impostare contatore (hhhhhh mm ss):

Abilitare contatore:

F F F F F F F F

1 2 3 Scelta 4 5 6Enter 7 Info 8Ritorno

Figura 22-5 Finestra di informazione relativa al campo di introduzione Giorno della
settimana della maschera del COM DB1 Parametrizzazione orologio
(CLP)

Le segnalazioni di errore sono ampiamente derivate da quelle dello STEP 5. Il COM
DB1pudriconoscere errorie comunicarliall’'utente nellarigadisegnalazione delvideo.

Il COM DB1 reagisce ai seguenti errori:

Errori che possono essere riconosciuti durante il caricamento o il
trasferimento del DB1.

Errori nella parametrizzazione del DB1 (errori operativi)
Il COM DB1 reagisce ad uno degli errori sopracitati:

* 0 conunasegnalazione di errore. Le segnalazioni di errore vengono emesse sul
video, come per lo STEP 5, in forma sintetica nella riga di segnalazione (p. es.:
Campo dei valori non valido ).

* oconunavvertimento (domanda di sicurezza). Gli avvertimenti vengono sempre
emessi in una finestra con cornice, posizionata nel centro del video (p. es.
Buttare via le parametrizzazioni? ). Le domande di sicurezza
devono essere sempre confermate con ESC oppure, in funzione della domanda,
si risponde con ESC No o interruzione oppure () Si.

Durante il caricamento del DB1 da un file di programma o dall’AG e durante il trasferi-
mentodel DBlinunfile diprogrammao nell’AG haluogo un controllo dituttii parametri:

¢ sul rispetto dei campi dei valori ammissibili
¢ sulla interdipendenza dei parametri nell'ambito di un blocco parametri

¢ sulla interdipendenza dei parametri tra i blocchi
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Se il COM DBL1 riconosce un errore (p. es. Area di ingresso o di uscita

con vuoti 0 assegnata piu volte ), allora viene richiamata automatica-
mente la maschera Tabella panoramica nella quale vengono contrassegnati come
errati i blocchi parametri interessati:

* Nel blocco "errato”, i "veri” errori di parametrizzazione sono contrassegnati con
un "!” davanti al campo di ingresso.

¢ In caso di dati "non interpretabili” in alcun modo per i parametri nel blocco
"errato” (errore che puo aversi solo in un DB1 parametrizzato con I'editor per
DB del pacchetto STEP 5), i campi di ingresso vengono riempiti con ™”.

Avvertenza

Se nella maschera di parametrizzazione si posiziona il cursore su un parametro
errato (!), nella riga di segnalazione compare la segnalazione corrispondente.

Esempio: evidenziazione dei parametri errati nel blocco Parametrizzazione orologio
(CLP)dopoilcaricamentodiDB1.1IDB1éstato creato conl'editor per DB del pacchetto
STEP 5.

1. Errore: per la posizione della parola di stato € stato indicato NB invece di MB
(errore di battitura, non interpretabile dal COM DB1)

2. Errore: per il modo orologio € stato indicato AM invece di PM (campo dei valori

errato).
Errore:
/ indicazione non interpretabile in DB1
Parametrizzazione orologio (CLP) /SIM/—G‘\C S5/COM DB1
Posizione della parola di stato: KK N KKK
Posizione dei dati dell’orologio: MW N.: 1 Errore:
interdi-

Fattore correz.: 1 Aggiornamento orologio in STOP: si rpendenza
Salvataggio ora: i tra para-

valaggl = metri non
Data/ora: Modo orologio: ! AM rispettata
GiornSett.: ve Data(gg mm aa): 3 9 03 Ora (hh mm ss): ! 14 0 0
Sveglia: Modo orologio: AM |
GiornSett.: LU Data (gg mm): 6 9 Ora (hh mm ss): 9 10 O :
Impostare contatore (hhhhhh mm ss): v

- Segnalaz.
Abilitare contatore: / del COM DB1
Indicazione per data/ora errata

F F F F F F F F
1 2 3 Scelta 4 5 6Enter 7 Info 8 Ritorno

Figura 22-6  Visualizzazione dei parametri errati nella maschera di parametrizzazione

22-16
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Errori nella
parametrizzazione
del DB1

STEP 5/ST V7.0
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Introduzioni non ammesse da parte dell’utente sono bloccate dal COM DB1 durante
la parametrizzazione:

¢ | testi di introduzione sono controllati da parte del COM DB1 dopo la
conclusione dell'introduzione con ([ ):
Gli errori di sintassi o il superamento dei campi dei valori sono evidenziati con
una segnalazione di errore (p. es. Campo dei valori non valido) . Le
parametrizzazioni errate sono contraddistinte con un ! posto prima del campo
di introduzione.

¢ Alla conferma dei dati di parametrizzazione nel DB1 con F6 = Enter, viene poi
controllata l'interdipendenza tra i parametri nel’ambito del blocco:
Le interdipendenze "non soddisfatte” vengono evidenziate tramite I'avver-
tenza Le parametrizzazioni non possono essere memorizzate,
poiché vi sono ancora errori presenti . Dopo la conferma con
ESC, le parametrizzazioni riconosciute errate sono evidenziate con un ! posto
prima del campo di introduzione.

Avvertenza

Se, nella maschera di parametrizzazione, si posiziona il cursore su un parametro
errato (! ), allora nella riga di segnalazione compare la segnalazione corrispon-
dente.

Solo dopo una introduzione corretta di tutti i parametri &€ possibile memorizzare |l
blocco parametri con F6 = Enter.
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22.4 Esempio di una parametrizzazione di DB1 con il COM DB1

Sommario

| compiti da svol-
gere nell’esempio

22-18

In questo capitolo si apprende, sulla base di un esempio concreto, come si deve
procedere nella parametrizzazione con il COM DB1. Contenuto di questo capitolo
e l'utilizzo del COM DBL1 e non le funzioni da parametrizzare in DB1.

Lefunzioniediloro parametrisitrovano nel manuale dell’AG corrispondente. E’ oppor-
tuno leggere I'esempio che segue per poitrasferirlo nella propria applicazione. In que-
sto modo si pud apprendere molto rapidamente il modo di impiego del COM DBL1.

Nella tabella che segue sono elencate:
* tutte le azioni necessarie per parametrizzare un AG;

¢ tutte le maschere nelle quali devono aver luogo le azioni (in particolare per il
nostro esempio: S5-95U con interfaccia SINEC L2 incorporata).

Le azioni sono poi riportate come titoli delle varie sezioni di questo capitolo.

Tabella 22-1 Procedimento per la parametrizzazione di un controllore con il COM
DB1 (panoramica)

Azioni da eseguire in successione per e le maschere che servono
1. Installare il COM DB1

2. Avviare il COM DB1

3. Scegliere la lingua Maschera Scelta lingua

4. Definire le preimpostazioni Maschera Preimpostazione

5. Portare I'AG da RUN a STOP Maschera Funzioni AG

6. Caricare il DB1 di default; introdurre | Maschera Caricamento di DB1

un commento al DB1; scegliere un
blocco parametri

7. Introdurre un commento al blocco Maschera Tabella panoramica

parametri SINEC L2
8. Editare i parametri Maschera Parametri di base
Maschera Collegamento standard
9. Stampare il DB1 Maschera Stampa di DB1
10. Trasferire il DB1 nellAG Maschera Trasferimento di DB1
11. Memorizzare il DB1 in un file di Maschera Trasferimento di DB1
programma STEP 5
12. Portare 'AG da STOP a RUN Maschera Funzioni AG

Un S5-95U con interfaccia SINEC L2 incorporata deve essere parametrizzato.
L'S5-95U deve comunicare conunaltro controllore tramiteiltipo di collegamento Colle-
gamento standard.

Il collegamento standard viene parametrizzato con il COM DB1 come descritto di se-
guito.

STEP 5/ST V7.0
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Presupposti per
I'esempio

(Iparametriediloro argomenti provengono dall’esempio di parametrizzazione di DB1
per il collegamento standard contenuto nel manuale Interfaccia SINEC L2 del control-
lore S5-95U)).

Fare attenzione ai seguenti presupposti:

* ¢ disponibile un S5-95U con interfaccia SINEC L2 (n. di ord. 6ES5
095-8MB12, versione 01);

* un PG 7xx € innestato sull'interfaccia PG dell’'S5-95U;
* la spina per il collegamento al bus non € innestata sull'interfaccia SINEC L2;
e ['S5-95U sitrova in RUN;

e con il pacchetto STEP 5 ¢ stato generato un file di programma
AG95L2ST.S5D;

¢ con il pacchetto STEP 5 non & stata creato un file di stampa o di piedinatura.

22.4.1  Operazioni di preparazione

Scelta della lingua

STEP 5/ST V7.0
C79000-G8572-C920-02

Dopo l'avvio, il COM DBL1 si presenta con la maschera Scelta lingua. Con i tasti
F1 ... F5si puo scegliere la lingua che deve essere impiegata con il COM DBL1.

* Premere F5 = ltaliano. (Con il tasto F8 = Ritorno oppure con il tasto ESC si
abbandona il COM DB1.)

SIMATIC S5/COM DB1
COM DB1
Versione x.y
F F F F F F F F
& deutsch 2 english 3 francais 4 espanol 5 italiano 6 7 8 Ritorno

Figura 22-7 Maschera del COM DB1 "Scelta lingua”; selezionare una lingua
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Definizione delle
impostazioni

Definizione del
numero di ordina-
zione

Definizione della
versione dellAG

22-20

Le preimpostazioni per la parametrizzazione con il COM DB1 vengono fissate nella
maschera Preimpostazione nel modo descritto di seguito.

Definizione del funzionamento del COM DB1 con la CPU:

Dopo la scelta della maschera di preimpostazione, il cursore si trova sul campo di
ingresso Online/Offline:.

1. Aprire la finestra di selezione relativa al campo di ingresso Online/Offline
premendo il tasto F3 = Scelta.

2. Trasferire online nel campo di ingresso con 00 oppure INSERT. Nel campo di
ingresso compare Online.

3. Posizionare il cursore sul campo di ingresso successivo premendo [ oppure
INSERT.

Per la definizione del numero di ordinazione procedere esattamente come per la Defi-
nizione del funzionamento del COM DB1 con la CPU. (Con il cursore ci si pu0 posizio-
nare sulla riga 095-8MB52 oppure 095-8MBO02 della finestra).

Introdurre la versione del’AG 01 tramite la tastiera e concludere I'introduzione con
[ oppure INSERT. Con ESC & possibile interrompere il trasferimento e di conse-
guenza il campo di ingresso si presenta nuovamente vuoto).

Introdotte tutte le preimpostazioni, compare la maschera seguente:

/
Preimpostazione SIMATIC S5/COM DB1
Online/Of- Online
fline:
MLFB: 6ES5 095-8MB12
Versione CPU: 01
Drive: File programma: @@@@@@ST.S5D
Drive: File stampante: @@@@@@DR.INI
Drive: File @@@@@@FL1.INI
piedinatura:

Drive: File uscita: @@@@@@LS.INI

F F F F F F F F

1 2 3 Scelta 4 5 6Enter 7 Info 8Ritorno

Figura 22-8 Maschera del COM DB1 "Preimpostazione”; introduzione delle preimpo-
stazioni

Confermare le introduzioni con F6 = Enter. Compare allora sul video la maschera Ta-
bella panoramica.

STEP 5/ST V7.0
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Portare il control-
lore da RUN a
STOP

Modificazione tipo
di funzionamento
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Per il controllore introdotto nella maschera Preimpostazione, il COM DB1 conosce
i blocchi parametri possibili e le parametrizzazioni nel DB1 di default.

Il COM DB1 presenta per I'S5-95U la maschera seguente:

Tabella panoramica SIMATIC S5/COM DB1
Parametrizzazioni ammesse Parametrizzazione
Interrupt onboard (OBI) parametrizzato (default)
Contatori onboard (OBC) parametrizzato (default)
Ingressi analogici onboard (OBA) parametrizzato (default)
SINEC L1 (SL1) non parametrizzato
Elaborazione a tempo (TFB) parametrizzato (default)
Parametrizzazione orologio (CLP) non parametrizzato
Caratteristiche di sistema (SDP) parametrizzato (default)
SINEC L2 (SL2) non parametrizzato

Blocco errori (ERT) non parametrizzato
F F F F F F F F
1 nuovo 2 DBl 3 DB1 4 DB1 5 Blocco 6 Blocco 7 AG- 8 Ritorno
DB1 Caricam. Trasfer. Stampa  Cancella Scelta  Funzione

Figura 22-9 Maschera del COM DB1 Tabella panoramica; scelta della funzione AG

IItipo difunzionamento del controllore puo essere modificato nellamaschera Funzioni
AG:

1. premere per questo il tasto F7 = Funzione AG.

2. Premendo il tasto F2 = Run — Stop si cambia il modo di funzionamento. ||
controllore € ora in STOP.

Funzioni AG SIMATIC S5/COM DB1

F F F F F F F F

1 AG 2 Run—> 3 Stop—> 4 5 6 7 8 Ritorno
Compress. Stop Run

Figura 22-10 Maschera del COM DB1 "Funzioni AG”; portare il controllore da RUN a
STOP

3. Con il tasto F8 = Ritorno, si va nella maschera Tabella panoramica.
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22.4.2 Caricamento del DB1 di default dal controllore; introduzione del commento
al DB1; scelta del blocco parametri

Caricare e Il DB1 presente nel controllore deve essere caricato nel COM DB1 e modificato.

Modificare Caricare il DB1 dal controllore:

1. Premere il tasto F2 = DB1 Caricamento nella maschera Tabella panoramica
(— Figura 22-11). Compare la seguente maschera Caricamento di DBI.:

Caricamento di DB 1 SIMATIC S5/COM DB1
Drive:
File programma: ST.S5D
F F F F F F F F
1 Caricam. Zaricam. 3 Scegli 4 5 6 7 Info 8 Ritorno
da FD da AG

Figura 22-11 Maschera del COM DB1 Tabella panoramica; scelta del Caricamento da
AG

2. Premere il tasto F2 = Caricamento da AG.
Alla fine del caricamento, nella tabella panoramica vengono visualizzate le
parametrizzazioni del DB1 presente in AG. Poiché non é stata eseguita finora
alcuna parametrizzazione in DB1, viene visualizzato il DB1 di default
(— Figura 22-11).

Introduzione del commento al DB1

1. Se sivuole introdurre un commento, occorre premere il tasto COM. Il cursore
si trova ora nella riga di commento della maschera Tabella panoramica.

2. Introdurre ora il commento, costituito da max. 80 caratteri; per il nostro
esempio: Parametrizzazione dell’interfaccia seriale (solo collegamento
standard) (— Figura 22-12).

3. Premere 0O oppure INSERT. Il cursore compare nella prima riga delle
Parametrizzazioni ammesse.

STEP 5/ST V7.0
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Introduzione del
commento al
blocco parametri
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Scelta del blocco parametri

1. Per la scelta del blocco parametri, posizionare il cursore sul blocco parametri
SINEC L2.

Tabella panoramica SIMATIC S5/COM DB1
Parametrizzazione dell'interfaccia seriale SINEC L2 (solo collegamento standard)
Parametrizzazioni ammesse Parametrizzazione
Interrupt onboard (OBI) parametrizzato (default)
Contatori onboard (OBC) parametrizzato (default)
Ingressi analogici onboard (OBA) parametrizzato (default)
SINEC L1 (SL1) non parametrizzato
Elaborazione a tempo (TFB) parametrizzato (default)
Parametrizzazioneorologio (CLP) non parametrizzato
Caratteristiche di sistema (SDP) parametrizzato (default)
SINEC L2 (SL2) non parametrizzato
Blocco errori (ERT) non parametrizzato
F F F F F F F F
1 nuovo 2 DB1 3 DB1 4 DB1 5 Blocco 6 Blocco 7 AG 8 Ritorno
DB1 Caricam.  Trasferim. Stampa  Cancella Scelta  Funzione

Figura 22-12 Maschera del COM DB1 Tabella panoramica; scelta del blocco
parametri

2. Premere [ oppure INSERT. La maschera Tabella panoramica SINEC L2
compare sul video.

Nella maschera Tabella panoramica SINEC L2 é possibile introdurre un commento
al blocco parametri SINEC L2.

1. Premere il tasto COM. Il cursore si trova ora nella riga di commento.

2. Introdurre il commento, costituito da max. 80 caratteri; per il nostro esempio
Parametrizzazione del collegamento standard dal partecipante 2 al
partecipante 1.

3. Premere [ oppure INSERT. Il cursore compare nella riga Parametri di base.
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Tabella panoramica SINEC L2 SIMATIC S5/COM DB1
Parametrizzazione del collegamento standard dal partecipante 2 al partecipante 1
Parametrizzazioni ammesse Parametrizzazione
Parametri di base non parametrizzato
Collegamento standard non parametrizzato
Collegamento AG-AG non parametrizzato
Master della periferia ciclica non parametrizzato
Slave della periferiaciclica non parametrizzato
Servizi FMA non parametrizzato
Servizi di livello 2 non parametrizzato
F F F F F F F F
1 2 3 4 5 Blocco 6 Blocco 7 8 Ritorno
Cancella Scelta

Figura 22-13 Maschera del COM DB1 Tabella panoramica SINEC L2; scelta della
funzione SINEC L2

Nella maschera Tabella panoramica SINEC L2 si possono scegliere le funzioni che
si vogliono parametrizzare.

Avvertenza

Come primo passo, si devono sempre definire i parametri di base, poiché essi
valgono per tutte le funzioni SINEC L2. Solo dopo si possono definire i parametri
per le funzioni speciali SINEC L2.

Scelta dei parametri di base:

1. dopo la scelta della maschera Tabella panoramica, il cursore si trova nella riga
Parametri di base.

2. Premere F6 = Enter U oppure INSERT.
La maschera Parametri di base compare sul video (— Figura 22-14).

Definizione del numero di partecipante:

Dopo la scelta della maschera Parametri di base, il cursore si trova nel campo di in-
gresso Numero di partecipante:

1. Introdurre "2”tramite la tastiera.

2. Confermare I'introduzione premendo [0 oppure INSERT. Il cursore si trova sul
campo di ingresso successivo. (Con ESC si puo interrompere il trasferimento,
cioé il campo di ingresso diventa nuovamente vuoto).

STEP 5/ST V7.0
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Definizione dello stato stazione

1. Aprire la finestra di selezione relativa al campo di ingresso Stato stazione,
premendo F3 = Scelta.

2. Il cursore si trova nella riga ATTIVO della finestra.

3. Confermare ATTIVO nel campo di ingresso premendo
U oppure INSERT.

4. Posizionare il cursore sul campo di ingresso successivo, premendo [0 oppure
INSERT.

5. Introdurre tutti gli altri argomenti dei parametri di base, come precedentemente
descritto:

— o direttamente tramite la tastiera (tramite F7 = Info vengono visualizzati i
campi dei valori degli argomenti)

— o tramite le finestre di scelta.
Gli argomenti dei parametri si trovano nella maschera della figura 22-14.

Dopo aver introdotto tutti gli argomenti, appare una maschera come la seguente:

Parametri di base SINEC L2 SIMATIC S5/COM DB1
Proprio numero di partecipante: z
Proprio stato stazione: ATTIVO
Baudrate: 500
N. partecipante piu alto delle stazioni attive: 10
Target-Rotation-Time: 5120
Setup - Time: 0
Slot - Time: 400
Minimo Station-Delay-Time: 12
Max. Station-Delay-Time: 360
F F F F F F F F
1 2 3 Scelta 4 5 6Enter 7 Info 8Ritorno

Figura 22-14 Maschera del COM DB1 Parametri di base SINEC L2; editazione dei
parametri di base

6. Premere F6 = Enter. Il parametri di base vengono trasferiti in DB1 e sul video
compare la maschera Tabella panoramica SINEC L2 (— Figura 22-14). Nella
riga Parametri di base sul video compare "parametrizzato”.

(Con ESC oppure F8 = Ritorno si pu0 interrompere il trasferimento. Sul video
compare la maschera Tabella panoramica SINEC L2 nel suo aspetto
originale.)
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Scegliere Collegamento standard:

Il cursore si trova nella riga Collegamento standard della maschera Tabella panora-
mica SINEC L2 (— Figura 22-15).

1. Premere F6 = Enter O oppure INSERT. Sul video compare la maschera
Collegamento standard SINEC L2.

2. Introdurre tutti gli argomenti cosi come descritto per i parametri di base:
direttamente tramite la tastiera oppure tramite le finestre di scelta.

Gli argomenti dei parametri si trovano nella maschera della figura 22-15.

Quando tutti gli argomenti sono stati introdotti, compare una maschera avente il se-
guente aspetto:

~

Collegamento standard SINEC L2 SIMATIC S5/COM DB1
Proprio n. partecipante 2 | Stato stazione attiva
Posizione della casella di ricezione: DB N.: 9 DW-NR.: 0
Posizione byte di coordinamento ricezione: MB N.: 61
Posizione casella di trasmissione: DB N.: 8 DW-NR.: 0
Posiz. byte di coordinamento trasmissione: MB N.: 60

F F F F F F F F

1 2 3 Scelta 4 5 6Enter 7 Info 8Ritorno

Figura 22-15 Maschera del COM DB1 Collegamento standard, editazione dei para-
metri per il collegamento standard

3. Premere F6 = Enter. | parametri vengono trasferiti in DB1 e sul video compare
la maschera Tabella panoramica SINEC L2 (— Figura 22-15). Nella riga Colle-
gamento standard sul video compare "parametrizzato”.

(Con ESC oppure F8 = Ritorno si pu0 interrompere il trasferimento. Sul video
compare la maschera Tabella panoramica SINEC L2 nel suo aspetto
originale).

Il DB1 di esempio & completamente parametrizzato.

STEP 5/ST V7.0
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Emissione del DB1 Si vuole stampare il DB1 appena creato.

Su stampante 1. Tornare nella maschera Tabella panoramica, premendo 2 volte F8 = Indietro.

La maschera Tabella panoramicaé cambiata; il blocco parametri SINEC L2 & presen-
tato come parametrizzato:

e
Tabella panoramica SIMATIC S5/COM DB1
Parametrizzazione dell’interfaccia seriale SINEC L2 (solo collegamento standard)

Parametrizzazioni ammesse Parametrizzazione
Interrupt onboard (OBI) parametrizzato (default)
Contatori onboard (OBC) parametrizzato (default)
Ingressi analogici onboard (OBA) parametrizzato (default)
SINEC L1 (SL1) non parametrizzato
Elaborazione a tempo (TFB) parametrizzato (default)
Parametrizzazioneorologio (CLP) non parametrizzato
Caratteristiche di sistema (SDP) parametrizzato (default)
SINEC L2 (SL2) parametrizzato
Blocco errori (ERT) non parametrizzato
F F F F F F F F
1 nuovo 2 DBl 3 DB1 4 DB1 5 Blocco 6 Blocco 7 AG 8 Ritorno
DB1 Caricam.  Trasferim. Stampa  Cancella Scelta  Funzione

Figura 22-16 Maschera del COM DB1 Tabella panoramica; scelta di Stampa di DB1

2. Premere F4 = DB1 Stampa.

La maschera Stampa di DB1 ha I'aspetto seguente:

Stampa di DB1 SIMATIC S5/COM DB1
F F F F F F F F
1 Stampa 2 Stampa 3 4 5 6 7 8 Ritorno

\_Stampante  su FD

Figura 22-17 Maschera del COM DB1 Stampa di DB1; scelta della stampa su
stampante

STEP 5/ST V7.0
C79000-G8572-C920-02 22-27



Software di parametrizzazione COM DB1

Trasferimento di
DB1 nel con-
trollore

22-28

3. Premere il tasto F1 = Stampa Stampante.
Vengono allora stampate la maschera Tabella panoramica, la maschera
Tabella panoramica SINEC L2 e tutte le maschere di parametrizzazione del
blocco SINEC L2. Nella riga di segnalazione compare I'indicazione di quante
pagine sono in corso di stampa.

Quando la stampa e terminata, compare automaticamente sul video la maschera Ta-
bellapanoramica. (Se DB1 non € stato stampato, compare lacorrispondente segnala-
zione).

Si vuole trasferire il DB1 appena creato nel controllore.

1. Premere il tasto F3 = DB1 Trasfer. nella maschera Tabella panoramica
(— Figura 22-18).

Compare la maschera Trasferimento di DB1 che ha il seguente aspetto:

Trasferimento di DB 1 SIMATIC S5/COM DB1

Drive:
File programma: ST.S5D
F F F F F F F F
1 Trasfer. T2asfer. 3 Scelta 4 5 6 7 Info 8 Ritorno
su FD in AG

Figura 22-18 Maschera del COM DB1 Trasferimento di DB1; scelta di Trasferimento
in AG

2. Premere il tasto F2 = Trasfer. in AG. Nella riga di segnalazione compare ora
I'informazione che il DB1 viene trasferito. Il DB1 presente nell’AG viene con-
temporaneamente sovrascritto.

Quando il trasferimento di DB1 é terminato, compare automaticamente sul video la
maschera Tabella panoramica. (Se il DB1 é errato, compare la segnalazione corris-
pondente ed il DB1 non viene trasferito. Il blocco parametri errato viene corrisponden-
temente evidenziato nella maschera panoramica).
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Il DB1 cosi trasferito nel controllore deve essere memorizzato/archiviato in un file
di programma STEP 5 (o su un dischetto). Per questo occorre, nella maschera
Trasferimento di DB1, indicare il file di programma STEP 5 nel quale si deve me-
morizzare il DB1. Per il nostro esempio, si € supposto che il file di programma
STEP 5 AG95L2ST.S5D sia gia stato creato con il pacchetto STEP 5.

1. Premere il tasto F3 = DB1 Trasfer. nella maschera Tabella panoramica
(— Figura 22-19). Compare la maschera Trasferimento di DB1.

2. Indicare il file di programma STEP 5 ed il drive (— Figura 22-19).

Trasferimento di DB 1 SIMATIC S5/COM DB1
Drive: C
File programma: AG95L2ST.S5D
F F F F F F F F
1 Trasfer. T2asfer. 3 Scelta 4 5 6 7 Info 8 Ritorno
\__su FD in AG

Figura 22-19 Maschera del COM DB1 Trasferim. di DB1; scelta di Trasferim. su FD

3. Premere il tasto F1 =Trasfer. su FD. Nella riga di segnalazione compare ora la
segnalazione che il DBL1 viene trasferito.

Quando il trasferimento del DB1 e terminato, compare automaticamente sul video
la maschera "Tabella panoramica”. (Se il DB1 é affetto da errori, compare la segnala-
zione corrispondente ed il DB1 non viene trasferito. Il blocco parametri errato viene
corrispondentemente evidenziato nella maschera panoramica).
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Commutazione del Il tipo di funzionamento del controllore puo essere modificato nella maschera Fun-
controllore da zioni AG.
STOP aRUN 1. Premere, nella maschera Tabella panoramica, il tasto F7 = AG-Funzione (—

Figura 22-20). Sul video compare la maschera Funzioni AG.

2. Cambiare il tipo di funzionamento premendo il tasto F3 = Stop —+ Run. Viene
richiesto se si vogliono aggiornare nel controllore le parametrizzazioni.

3. Per la conferma, premere O oppure INSERT. Le parametrizzazioni vengono
trasferite nel sistema operativo del controllore.

(Con ESC oppure F8 = Ritorno si pu0 interrompere I'aggiornamento).

Le parametrizzazioni nel controllore sono aggiornate ed il controllore € in RUN.

-
Funzioni AG SIMATIC S5/COM DB1
F F F F F F F F
1 AG 2 Run—> 3 Stop—> 4 5 6 7 8 Ritorno
Compress. Stop Run

Figura 22-20 Maschera del COM DB1 Funzioni AG; commutaz. controllore da STOP
a RUN

4. Abbandonare il COM DB1 premendo 4 volte il tasto F8 = Ritorno.

STEP 5/ST V7.0
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Il compito del pacchetto Accoppiamento PG € quello di scambiare blocchi o file STEP
5 tra i diversi dispositivi di programmazione.

Capitolo Argomento trattato Pagina
231 Hardware 23-2
23.2 Accoppiamento 23-2
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23.1 Hardware

Requisiti hardware

Lo scambio dati con il PG partner necessita di un’interfaccia attiva TTY (20 mA).
Se l'interfaccia COM1 & un’interfaccia V.24 oppure una TTY passiva, si deve
adattare l'interfaccia S5. Per far cio € possibile inserire, tra il PG ed il cavo verso
I'altro PG, un convertitore che trasformi l'interfaccia V.24 del PG in un’interfaccia
TTY attiva e quindi riproduca l'interfaccia S5 classica.

Il collegamento del PG con un altro PG puo dunque avvenire:
¢ tramite 'interfaccia COM 1 TTY attiva
Il PG viene collegato all’altro PG tramite due cavi con connettori.
oppure
* tramite l'interfaccia COM 1 TTY passiva o V.24

Sul PG con interfaccia TTY passiva 0 V.24, tale interfaccia passiva deve essere
trasformata in un’interfaccia S5 tramite un convertitore (Kdster box).

Il PG € collegato a questo convertitore tramite un cavo con connettori. Il connet-
tore € collegato a sua volta con il PG partner tramite un altro cavo con connettore.

| cavi con connettori sono descritti nei manuali dei PG 7xx.

23.2 Accoppiamento

Caricamento
pacchetto
Accoppiamento
PG

Accoppiamento
PG

23-2

Questo pacchetto viene caricato con il comando di menu Cambio » Altri ... F9
(- Cambio). 1l programma Accoppiamento PG si trova nella directory
..\S5_SYS\S5_COM\PG_PG

Dal momento in cui si attiva il pacchetto Accoppiamento PG, questo viene avviato
ed é quindi possibile lavorare con l'interfaccia di accoppiamento PG.

Con questo pacchetto possono essere realizzate le seguenti funzioni:

e Commutazione del PG a passivo. Per uno scambio di dati &€ necessario avere
un PG attivo ed uno passivo.

* Trasmissione di dati dal PG attivo a quello passivo.

* Prelievo di dati dal PG passivo da parte di quello attivo.

STEP 5/ST V7.0
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Definizione Dopo aver attivato I'accoppiamento PG, viene visualizzato il box Predisposizione.
predisposizioni Qui va introdotto il file programma (a cui far riferimento). Si accede a questo campo
tramite il tasto SHIFT cursore

| campi File Via e Nome File sono irrelevanti.

Nel box esistono le seguenti possibilita di introduzione:

Campo Chiarimenti
d’introduzione

F3 = Scegli Solo dopo aver premuto il tasto F3 il cursore salta nella po-
sizione in cui & possibile eseguire I'introduzione.

F6 = Conferma | parametri introdotti vengono accettati e viene richiamata la
Scelta funzioni. |l tasto Conferma ha lo stesso effetto.

F7 = Info Si ottengono informazioni relative al campo su cui si trova il
cusore.

ESC = Tasto Riporta senza ulteriori azioni nello STEP 5.

Annulla

Scelta funzioni Non appena vengono accettate le impostazioni (F6), viene visualizzato il box Scelta

funzioni. Sono disponibili le seguenti possibilita:

Livello di tasti Chiarimento
1 2

F1 PASSIVO

Il dispositivo di programmazione commuta dallo stato ATTIVO a quello PASSIVO. Il PG
che riceve deve sempre essere commutato su PASSIVO. Per uscire dallo stato PAS-
SIVO basta premere il tasto ESC.

F3 TRASMISSIONE
Passaggio al successivo livello di tasti nel quale puod essere attivato la scambio dati.

F1 BLOCCO (trasmissione)

Appare la riga di comando:

BLOCCO: DA TRASM. AL PARTNER

Nel campo "BLOCCOQ” possono essere fatte le seguenti introduzioni:

p.es. Chiarimento

PBx  Singoli blocchi

#DOK File di documentazione
FB Blocchi di un certo tipo

* Vari blocchi da una lista di blocchi
B Tutti i blocchi del file programma preimpostato
# Tutti i file di documentazione

vuoto Tutti i blocchi e tutti i file di documentazione

Chiudendo l'introduzione con il tasto Conferma , si avvia automaticamente la trasmis-
sione al PG partner.

STEP 5/ST V7.0
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Livello di tasti Chiarimento
1 2

F2 FILE (trasmissione)

Appare la riga di comando:

FILE: DA TRASM. AL PARTNER DRIVE-DEST:

Qui va introdotto il nome del file da trasmettere:

DR:NNNNNNNN.EEE (8 caratteri al massimo prima del punto).

p.es. C:PROGFILE.S5D

DRIVE-DEST: qui va introdotto il nome del drive di destinazione.

Chiudendo l'introduzione con il tasto Conferma , si avvia automaticamente I'emissione
sul video di una lista di blocchi.

F5 INDICE-P

Emissione dell'indice del PG partner. Appare la riga di comando:

EMISS.INDICE DAL PARTNER BLOCCO:

Introdurre i blocchi come indicato sotto F1. Una lista di blocchi (*) non é selezionabile.
Chiudendo l'introduzione con il tasto Conferma , inizia automaticamente I'emissione sul
video di una lista di blocchi.

F6 FIL-PRG-P

Impostazione del file programma del partner. Appare la riga di comando:

FILE-PRG DAL PARTNER INDICARE NOME-FILE: ST.S5D

Introdurre il nome di file desiderato. Chiudendo con il tasto Conferma , si imposta il nome
del file nel partner.

F4 PRELIEVO
Questa funzione ha la stessa funzionalitd di TRASMISSIONE, per0 trasferisce i file o i
blocchi dal PG passivo a quello attivo.

F6 PREDISP.
Viene visualizzato il box Predisposizione.
F7 AUSIL

Con questa funzione & possibile gestire blocchi e file di documentazione e selezionare
file programma.
Possono essere eseguite le seguenti funzioni:
- trasferimento blocchi e file di documentazione (F1 TRASFER)
- cancellazione di blocchi e di file di documentazione, cancellazione iniziale AG
(F2 CANCELL)
- emissione indice del contenuto (F3 INDICE)
- cambio file programma preimpostato (F6 FILE-PROG)

F8 INDIETRO
Ritorno nello STEP 5

STEP 5/ST V7.0
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24

Perfacilitare laconoscenzadello STEP 5 edillavoro con questo pacchetto di software,
eillustrato qui di seguito un esempio applicativo. Oltre alla definizione dei compiti "Co-
mando di un impianto di lavaggio auto”, € indicato passo dopo passo come editare,
testare, documentare e archiviare il relativo programma utente.

Capitolo Argomento trattato Pagina
24.1 Introduzione all’esempio (definizione dei compiti) 24-2
24.2 Generazione con STEP 5 del programma per I'impianto di 24-5

lavaggio
24.3 Trasferimento di file, blocchi e segmenti 24-16
24.4 Controllo e modifiche del programma 24-20
24.5 Caricamento e test del programma 24-24
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24.1 Introduzione all’esempio (definizione dei compiti)

Sommario

Breve descrizione
dei compiti di
comando

24-2

Con questa introduzione all’'uso dello STEP 5, con I'aiuto di un esempio si vuole:

¢ realizzare un veloce accesso alle funzioni di sistema e di editazione piu impor-
tanti sul dispositivo di programmazione e

¢ definire una guida per I'elaborazione di un progetto e la manipolazione degli
strumenti STEP 5 necessari.

Lo sviluppo delrelativo programma STEP 5, che comanda.il processo nel modorichie-
sto, non fa parte dell’esempio. In capitolo 24.5.4 Modello di programma per 'esempio
applicativo si trovano comunque i relativi chiarimenti, nel caso si voglia generare il
programmapercontoproprio. llprogrammaapprontato € costituito dalle seguenti parti:

* una lista di attribuzione (operandi assoluti, operandi simbolici),

* un blocco funzionale con 15 segmenti in rappresentazione Lista istruzoni
(AWL).

* un blocco dati

* i blocchi organizzativi per I'avviamento ed il funzionamento ciclico dell'im-
pianto.

Siconsiglia di eseguire personalmente sul PG i seguenti passi descritti (capitolo 24.2),
per la generazione del programma. Per questo € sufficiente editare soltanto alcuni
segmenti.

Il blocco funzionale come tutte le rimanenti parti del programma di esempio si trova
nella directory:

C:\STEP5\S5-SYS\EXAMPLE
La seguente figura mostra in modo dettagliato un impianto di lavaggio auto, in una

strutturatipica per molte stazionidiservizio e che deve essere automatizzato mediante
un programma STEP 5.

Figura 24-1 Impianto di lavaggio auto

STEP 5/ST V7.0
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Premesse per
I'esecuzione
dell'esempio
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Dalla struttura dell'impianto di lavaggio e dalle richieste del procedimento di lavaggio
deriva il seguente ciclo di processo:

* L'impianto deve assumere la sua posizione di partenza
* L’auto viene portata nella posizione di lavaggio
¢ La porta dell'impianto viene chiusa e si avvia il ciclo di lavaggio

* Segue il procedimento con spruzzatura di schiuma, lavaggio/risciaquo, appli-
cazione di cera e asciugatura della vettura.

¢ Alla fine viene aperta autmaticamente la porta e 'auto puo essere portata
fuori.

Alcune grandezze come Tempo di asciugatura o Tempo di diffusione cera possono
essere modificate dal personale di servizio. Il sistema tiene anche conto del numero
dei cicli di lavaggio eseguiti.

Dallo schema dettagliato dell'impianto relativo al procedimento di lavaggio sopra
schizzato é possibile ricavare le interfacce con il processo, cioe gliingrssi/uscite (E/A)
per la realizzazione del comando (fig. 24-2). Con le sigle dei segnali E/A, sulla base
di una descrizione verbale dello svolgimento del processo, viene quindi sviluppato
il programma di comando del procedimento di lavaggio.

Ingressi Uscite
Commut.princ. E32.0 ! A32.0 Avanzam. strutt.
Emergenza E32.1 Controll. = A32.1 Ritorno struttura
Avv. impianto E330__ | (S595) 0 A32.2 Apertura porta
Auto in posizione E32.3 . A32.3 Chiusura porta
Strutt. avanti E324 | A32.6 Rotaz. spazzoloni
Strutt. indietro E325 O A32.7 Spruzzatori deterg.
Porta aperta E326 . | A33.0 Spruzzatori acqua
Porta chiusa E32.7 . | A33.1 Diffusori cera
A33.2 Asciugatura
A32.4 ENTRATA AUTO
A325 USCITA AUTO
(RS

Figura 24-2 Apparecchiatura di comando con interfacce verso il processo
La figura seguente mostra i componenti hardware e software necessari per I'esecu-

zione dell'esempio. Il S5-95 ed il simulatore sono necessari soltanto per il test del pro-
gramma di comando.
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Controllore programmabile

S5-90/95

(contatti simulatore)

Simulatore dell'impianto
lavaggio auto

(N. ord. 6ES5788-8MK11)

[ B
Lista delle

‘ istruzioni ‘
di comando

‘ (programma) ‘

[

Uscite
(Rele)

rSW STEP 5 o

i

iE\Funzioni online

Contatti
Motori
Elettrovalvole
Visualizzatori

Attuatori
(LED sul controllore)
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24.2 Generazione con STEP 5 del programma per I'impianto di lavaggio

Concordemente almododi utilizzare le sigle dello STEP 5viene dato al nostroimpianto
dilavaggio ilnome di progetto. La generazione del programma utente sul PG si suddi-
vide nelle fasi:

* creazione e apertura del progetto

* generazione del contenuto del progetto (editazione e strutturazione del pro-
gramma),

* (gestione e cura del progetto.

24.2.1  Creazione del progetto

Poichelabasedelsistemaoperativo e I'avviamento del dispositivo di programmazione
dipendono dal tipo di PG utilizzato, vengono descritti il procedimento diimpostazione
e le modalita operative a partire dalla barra di menu STEP 5.

\ File \ Partendo dal comando di menu File » Progetto » Imposta F4 per predisporre tutte
Progetto> le impostazioni e parametrizzazioni necessarie alla programmazione.
Imposta F4

1. Selezionare pertanto per un nuovo progetto in primo luogo Progetto » Im-
posta . Una successiva selezione del progetto gia creato avviene tramite Pro-
getto » Carica.

Appare uno schedario per 'impostazione del progetto con 6 campi d’introduzione
(schede) per i diversi nomi di file. Questi campi sono preimpostati e denominati
con NONAME.

STEPS5 - S5KXS01Z

Figura 24-4  Impostazione del progetto

STEP 5/ST V7.0
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Salva come...

Procedere nelle impostazioni del progetto "Impianto di lavaggio auto” nel seguente
modo:

1.

Specificare il programma da generare per 'impianto di lavaggio,
sovrascrivendo nella scheda 5 la directory del progetto, con le seguenti deno-
minazioni:

C:\STEP5\S5_Daten

Selezionare nella scheda 1 AG il tipo di funzionamento. Fin tanto che non si
collega nessun controllore programmabile, come tipo di funzionamento e pos-
sibile soltanto il modo offline e quindi risulta impostato da STEP 5.

Selezionare nella scheda 2 Blocchi il file programma..
C:\WASCAST.S5D

Poiché si vuole programmare in Lista istruzioni, impostare con F3 il parametro
Rappresentazione su AWL.

Selezionare nella scheda 3 Simbolico il file simbolico.
C:\WASCHAZO.ini

Il parametro Visualizzazione simbolica si imposta premendo su [x] oppure con
F3.

Per una migliore gestione, conviene lasciare la massima lunghezza del simbolico
a 8 caratteri. Con cio & tuttavia possibile formulare testi di chiarimento dettagliati,
modificando la lunghezza del commento a 40 caratteri. Queste introduzioni de-
vono essere concluse con il tasto di introduzione

Selezionare nella scheda 4 Documentazione un file stampante ...DR.INI, op-
pure sovrascrivere la preimpostazione con NONAME.

Con Conferma si ritorna al menu principale.

Dopo la selezione Progetto » Salva come ... compare il box di scelta file, in cui indi-
care come nome di file WASCHA.

Confermare l'introduzione con Salva. Dopo la conferma della segnalazione File di
destinazione gia su FD, sovrascrivere ?lo STEP 5 creail file progetto WASCHAPX.INI
in cui sono portati e riuniti i file programma e le impostazioni.

STEP 5/ST V7.0
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24.2.2 Generazione del programma

Editazione della li-
sta di attribuzione
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Dopo aver specificato il progetto mediante denominazione e definizione dei parametri,
sivuole, in questo paragrafo, editare un blocco funzionale con le istruzioni e un blocco
dati con i valori di tempo e conteggio.

Una volta raggiunto lo scopo introduttivo dell’esempio e le operazioni d’introduzione
siripetono, si potra interrompere il lavoro di editazione. Il programma completo si pud
copiare sotto la sigla PROBSPPX.INI dalla directory CASTEP5\S5_SYS\EXAMPLE
nella propria directory di lavoro.

Per una migliore comprensione del programma, si opera con operandi simbolici nella
stesuradelleistruzioni. Ciorichiede che primadell’editazione in AWL sidebbaappron-
tare una lista di attribuzione.

La generazione del programma per I'impianto di lavaggio richiede quindi le seguenti
attivita di editazione:

* generazione di una lista con le attribuzioni simboliche dei segnali di processo
assoluti,

¢ generazione del blocco dati per la raccolta dei valori di set per il processo ed il
conteggio dei cicli di lavaggio,

* generazione di una lista di istruzioni in un blocco funzionale per la gestione
dello svolgimento del processo.

L'esecuzione di questi compiti offre I'opportunita di conoscere le caratteristiche dei
tre importanti editor dello STEP 5.

Gli operandi simbolici sono le sigle (p. es. PORTA-AP) degli operandi assoluti (p.es.
E 32.6,A 32.2,M 10.0) elaborati dal controllore programmablie. Affinché il dispositivo
diprogrammazione possa "capire” glioperandi simbolici selezionati, &€ necessaria una
lista di attribuzione (ZULI), che in questo caso € stata editata nel file simbolico con
il nome C: WASCHAZ0.SEQ

Come modello per la generazione di questa lista si pud prendere la lista dei segnali
d’'impianto (tabella 24-1), dove le attribuzioni sono gia collocate rispetto alla colonna
degli operandi. Prima della conferma della lista di attribuzione (ZULI) bisogna accor-
ciare gli operandi a 8 caratteri, secondo il formato di editazione impostato. In questo
modo e utilizzando lettere maiuscole si avra una rappresentazione piu chiara del pro-
gramma.
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\ Editor

Lista di attribu-
zione F7
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1. Richiamare I'editor STEP 5 Lista attribuzione nel menu Editor,
(opp. premere il tasto funzionale F7)

Sotto una riga d’'intestazione con l'indicazione del file IMPLAVZO.SEQ si presenta
un formulario vuoto con le colonne Operando, Simbolo e Commento. Le lunghezze
deicampiperglioperandisimboliciedicommentisono state definite nelle impostazioni
di progetto.

2. Introdurre ora la prima riga della lista di attribuzione:

Operando Simbolo Commento
E 32.0 PRINC_ON Commut. principale a chiave
Impianto ON

3. Introdurre quindi (in Inserimento) la sequenza di caratteri: E 32.0 e premere
SHIFT cursore verso destra 0 TAB.

4. Introdurre PRINC-ON. (Se il campo & completato, il cursore salta automatica-
mente avanti).

5. Introdurre Commut. principale a chiave Impianto ON e premere il tasto di in-
troduzione o TAB.

Un pezzo della lista di attribuzione € mostrato nella fig. 24-5. Prendere questa li-
sta senza modificarla come file simbolico. Concludere I'editazione tramite:

6. Conferma o F7 = OK.

con cui si memorizza i file e si avvia il procedimento di traduzione. Il PG ge-
nera quindi i file simbolici del tipo . . . Z*.INI necessari allo STEP 5.

File: C: IMPLAV.SEQ

Operando Simbolo Commento

E 32.0 PRINC-ON Commut. princ. a chiave "Impianto ON”
E 321 EMERGENZ Pulsante "Emergenza”

E 32.3 IN-POSIZ Segnale di risposta "Auto in posizione”
E 325 STRU-IND Finecorsa "Struttura indietro”

E 32.6 PORTA-AP Finecorsa "Porta aperta”

A32.1 RIT-STRU Comando "Ritorno struttura”

A32.2 AP-PORTA Comando "Apertura porta”

A324 ENT-AUTO Messaggio: ENTRATA AUTO

A 325 USC-AUTO Messaggio: USCITA AUTO

M 10.0 FRONTE-S Merker fronte di salita "Imp. ON/Avvi.”
M 10.7 AVVIAM. Ricon. avviamento da OB 20/21/22
Z2 PASSI Contatore passi di processo

Figura 24-5 Lista di attribuzione (pezzo da editare)

Dopo il procedimento di traduzione, STEP 5 segnala:
n righe elaborate, nessun errore trovato oppure
Errore alla riga n p.es. Chiave gia esistente oppure

n righe elaborate, x errori trovati

STEP 5/ST V7.0
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Nel caso non vengono trovati errori, I'editazione della lista di attribuzione viene con-
clusa correttamente. Se é stato trovato un errore, la riga errata viene visualizzata in
alto.

Con un’indicazione di x errori si deve consultare o stampare la lista errori. Procedere
quindi come indicato in seguito:

1.

2.

Per arrivare al menu, premere OK e Avanti .

Selezionare Gestione » Liste di attribuzione » Emetti lista errori

3. Consultare direttamente sul video la lista errori o emetterla su stampante.

Apportare le correzioni necessarie in editor della lista di attribuzione e awviare
nuovamente il procedimento di traduzione.

Richiamare I'editor per la generazione di blocchi dati nel menu sotto Editor e
Blocchi dati... (opp. premere il tasto funzionale F2). Prendere la fig. 24-13
come modello per il contenuto del blocco dati.

Nel box di comando, introdurre il tipo ed il numero del blocco dati da generare,
in questo caso: DB5. Premere quindi OK.

Nella riga di testata del campo d’introduzione vuoto compare ora la sigla del
blocco DB5 e il file di programma C:WASCHA.S5D. L'editor predispone gli indi-
rizzi delle parole dati partendo da O.

Introdurre dapprima il formato per la corrispondente parola dati (KH).

Se il formato e "valido”, il cursore salta al campo successivo. Introduzioni non
consentite vengono annullate e segnalate con Operazione non
consentita

Ora si deve introdurre il valore numerico nel formato precedentemente indicato
rispettando il relativo campo di valori ammessi.

Valori non consentiti non vengono accettati. Il cursore non salta al campo succes-
sivo anche se si preme il tasto di introduzione

La successiva introduzione di parole dati (riga seguente) si ripresenta con lo
stesso formato. Volendo un altro formato, tornare indietro con cursore a
sinistra e introdurre il formato desiderato.

DB5 IMPLAVST.S5D LUN=
0: KH= 0000;
1: KZ=000;

Introdurre le altre parole dati, come indicato nella figura 24-13.
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Funzione Impostazione

Cancellazione
carattere

Posizionare il cursore sul carattere e premere DEL.

Inserimento carattere | Posizionare il cursore sul carattere prima del quale si
desidera eseguire l'inserimento e premere Ins. oriz.

piu volte a seconda dei casi.

Cancellazione riga Posizionare il cursore nel campo del formato della riga

da cancellare e premere DEL.

Inserimento riga Posizionare il cursore nel campo del formato della riga
prima della quale si deve inserire una nuova riga e pre-

mere Ins. vert.

E possibile introdurre o sovrascrivere i commenti relativi a parole dati, lunghi al max.
32 caratteri , maiuscoli o minuscoli.

* Posizionare il cursore nel campo di commento mediante SHIFT + cursore a de-
stra. Saltare nella riga successiva premendo cursore in basso . Inserimento /
cancellazione di caratteri come nel campo dati (vedi sopra). Inserimento/cancel-
lazione di righe di commento tramite i tasti funzionali F1 = Inser. DK e F2 = Canc.
DK.

Il titolo ancora mancante /Impianto lavaggio: tempi/conteggi:
1. Introdurrlo dopo aver premuto SHIFT F6 oppure COM.

2. Ritorno nel campo di editazione DW con il tasto di introduzione

Si entra nell’editor del commento blocco tramite: SHIFT F7= Commento oppure due
volte COM.

* Prendere il testo dalla figura 24-13, e concludere ogni riga con il tasto di
introduzione .

Per verificare le funzioni Inserimento/Cancellazione in questo editor, posizionare il
cursore nella seconda riga sulla C di controllore e premere F1 = Inserisci

L'editor sitrovain Inserimento. La sigla del tasto funzionale cambiain F1 = Sovrascr.,
cioé il modo di volta in volta selezionabile € indicato nella sigla del tasto funzionale.

1. Introdurre Simatic. Si ritorna in Sovrascrittura premendo F1 = Sovrascr..

2. Posizionare ora il cursore sulla S di Simatic e premere F2 = Cancella, spo-
stare il cursore sulla C di controllore e premere ancora F2 = Cancella. L'inseri-
mento & cancellato.

Concludere il commento premendo F8 = Indietroe Conferma oppure due volte Con-
ferma.

Come ultimo passo dell’editazione siintroduce un n. di biblioteca per I'identificazione
del blocco (p.es. versione DB).

e Con SHIFT F2 = N. bibl. il cursore salta nel campo BIB, introdurre il numero di
biblioteca, in questo caso 2. Abbandonare il campo con Conferma oppure il tasto
di introduzione .

STEP 5/ST V7.0
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Se il video ha il contenuto indicato:

1. Concludere il lavoro di editazione del DB tramite Conferma .

2. Se ¢ il caso, confermare con Sila segnalazione: DB gia nel file, so-

vrascrivere?

Ora le istruzioni e/o le modifiche sono acquisite e memorizzate (in questo caso
confermare 2 volte).

DB 5 C:IMPLAVST.S5D
0:  KH= 0000;
1. KC= 0000;
2:  Kz= 000;

3:  KH= 0000;
4: KT = 030.2;
5. KH= 0000;
6: KF = +00000;
7: KH = 0000;
8. KT= 0452;
9:  KH= 0000;
10: KF= +00000;
11: KH 0000;
12:

BIB=2 LUN=17 [/ 24

Vuoto

Contatore lavaggi (KH)
Contatore lavaggi (K2)

Vuoto

Setpoint tempo diffus. cera TDC
Valore ist. tempo TDC (KH)
Valore ist. tempo TDC (KF)
Vuoto

Setpoint tempo asciugat. auto TAA
Valore ist. tempo TAA (KH)
Valore ist. tempo TAA (KF)
Vuoto

Richiamare I'editor per la generazione dei blocchi STEP 5 nel menu Editor

sotto Blocco STEP 5....F1. Appare quindi di nuovo il box di comando.

Introdurre nel box di comando il tipo ed il numero del blocco da generare.

Nel box di scelta sono indicati i possibili tipi di blocco, che, nel caso esistano, possono
essere emessi in questo modo:

1.
2.

Premere F3 = Scegli.

Introdurre nel campo blocco del box di scelta il tipo ed un numero di blocco da

generare non ancora utilizzato, in questo caso FB 5.

Selezionare, con la crocetta su Si, le opzioni

Sovrascrittura con conferma e

Aggiornamento File-Sorg. Seq.

e concludere con Edita.

Si apre cosi il campo d’introduzione dell’editore.
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Nella riga di testata si trovano la sigla del blocco (FB 5), il file programma (C:IM-
PLAVST.S5D) e la lunghezza del blocco compresa la testata (LUN=0). Il cursore si
trova nel campo Nome con 8 caratteri per la denominazione del blocco funzionale.

1. Introdurre: CAR-WASH e premere il tasto di introduzione

Il cursore salta nel campo Sigla...., che ha significato soltanto per blocchi fun-
zionali parametrizzabili.

2. Abbandonare pertanto questo campo premendo nuovamente il tasto di intro-
duzione .

Il cursore si trova ora nel campo d’introduzione della prima istruzione. Fare ora riferi-
mento alla stesura del programma nel capitolo 24.5.4, Fase 5.

1. Introdurre nel segmento 1 Iistruzione: A DB 5 e premere quindi SHIFT + cur-
sore a destra oppure TAB cursore a destra .

Il cursore si trova ora nel campo di commento istruzione.

2. Scrivere il testo Richiamo DB 5 tempi/conteggi e quindi con il tasto di intro-
duzione .

Nelsegmento 1 non sono contenute altre istruzioni. Manca soltanto il titolo segmento.
1. Premere pertanto COM e SHIFT F6 = Titolo segm.
2. Introdurre: Predisposiz. ciclo programma.

Si abbandona il campo con il tasto di introduzione o Conferma .

Ora si vuole editare il segmento 2.
1. Premere Fine segmento (*** oppure tasto di introduzione )
Il cursore si trova ora nel campo della prima istruzione del SEGM. 2.

2. Introdurre con l'aiuto dell’estratto del programma stampato le istruzioni ed i
commenti istruzione. Scrivere, come gia specificato, gli operandi con i nomi
simbolici definiti nella lista di attribuzione; nel campo istruzione preceduti da
una lineetta!

Nella parte istruzione si possono eseguire introduzioni senza blank. Bisogna scrivere
in maiuscolo i simboli definiti con caratteri maiuscoli.

STEP 5/ST V7.0
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Nelle righe diistruzione 4 e 6 si verifichera che dopo aver scritto IMPULSO il cursore
ritornasullalineetta e nonabbandonail campo. In questo caso mancaunaattribuzione
simbolica (segnalazione: manca attribuzione, simbolo non definito), da editare suc-
cessivamente.

1. Introdurre a questo punto dapprima I'operando formale M10.1, per poter conti-
nuare I'editazione. Concludere con Conferma .
Segnalazione:
Assumere segmento modificato ?

confermare con Si. Quindi avviene il passaggio nel modo Emissione.

2. Nel modo Emissione portare il cursore di nuovo sulla 42 istruzione e richia-
mare I'editor simbolico con F1 = Vis. simb.

Dal file simbolico ...*Z0.INI sono ora visualizzate nella sequenza delle istru-
zioni le attribuzioni simboliche con il cursore sull’'operando formale M 10.1.
Completare questa riga con il simbolo IMPULSO ed il relativo commento Mer-
ker impulsivo (solo 1 ciclo), quindi

3. F2 = Edita sim, e dopo l'introduzione di simbolo e commento premere F2 =
Inserisci Concludere la correzione con F8 = Indietro.

Dopo il ritorno nell’editor blocchi, il segmento 2 deve ora avere il seguente
contenuto:

FB5 C:IMPLAVST.S5D LUN= 23
Segmento 2 0007  "Definiz. stato di esercizio” Emissione

:0 -PRINC-ON Commutat. princ. "Impianto ON”
.0 -AVVIAM. Riconosc. avviam. da OB 20/21/22
‘UN -FRONTE-S Merker per fronte di salita
= -IMPULSO Merker impulsivo (solo 1 ciclo)
‘R -AVVIAM. Reset riconosc. avviamento
U -IMPULSO
S -FRONTE-S Impostaz. merker fronte di salita
‘UN -PRINC-ON Mancanza comando "Impianto ON”
‘UN -AVVIAM Mancanza riconosc. avviamento
‘R -FRONTE-S Reset merker fronte di salita
ok

La correzione nei campi istruzione e commento avviene nello stesso modo descritto
nell’editazione del blocco dati. C'e pero una differenza: le funzioni di cancellazione
einserimentorigasiriferiscono all'interariga. Perlacancellazione diunarigail cursore
deve stare sul "due punti” dell'istruzione stessa.

Si entra nell’editor del commento segmento:

1. premendo SHIFT F6 = Comm segm e SHIFT F7 = Commento oppure due
volte COM.

Sotto il carattere $ con il numero di segmento é possibile ora scrivere il testo
del commento (modello: stampa del programma alla fine dell’appendice A).

2. Scrivere i testi per il SEGM. 1 e il SEGM. 2, concludere ciascuna riga con il
tasto di introduzione . Ritorno all’editor del blocco con F8 = Indietro.
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Istruzioni del Dopo aver premuto Fine segmento , il cursore si trova sulla prima riga istruzione del
SEGM.4 e SEGM. 5 segmento 3. Introdurre qui le istruzioni ed i commenti dei segmenti 4 e 5. Il segmento
3 saltato sara inserito successivamente.

Una particolarita nel segmento 4 € una diramazione del programma costituita dal salto
condizionato all'istruzione 2. L'etichetta di salto PROS deve essere posta per contras-
segnare la destinazione del salto prima del "due punti” dellistruzione di arrivo.

* Premere due volte il tasto cursore a sinistra e scrivere I'etichetta di salto.

Inserimento
SEGM.3 1. Portarsi nel segmento 3 mediante i tasti pagina | = scorrimento avanti o
pagina t = scorrimento indietro e premere il tasto F5 = Funz. segm. e ancora

F5 =Inserisci

Dopo F1 = Nuovo, il cursore si trova sulla prima riga istruzione del nuovo seg-
mento inserito, ancora vuoto.

2. Editare il segmento e concludere il lavoro tramite Conferma e confermare
anche le successive richieste del sistema.

STEP 5/ST V7.0
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Ora si vuole generare un protocollo di stampa sia del programma in FB 5 che del
blocco dati e della lista di attribuzione. Come nome del file stampante & preimpostato
nella maschera Imposta progetto NONAMEDR.INI, che ora si pud sovrascrivere con
IMPLAVDR.INI.

Pertanto portarsi nel menu principale Documentazione e selezionare I'emissione
standard diblocchi STEP 5. Trale possibilita di scelta nel box di comando, sono offerte
emissioni STEP 5 per blocchi selezionabili ed anche per segmenti.

Procedere come segue:
1. Introdurre nel box di comando il blocco FB 5 del nostro file programma.

2. Come opzioni, contrassegnare con la crocetta la rappresentazione indirizzi
AWL e tipo protocollo Standard.

3. Premere OK per avviare ora il procedimento di stampa.
Il protocollo di stampa contiene per ciascun segmento:

¢ il titolo ed il commento di segmento,

¢ le istruzioni con i relativi commenti,

* |e sigle degli operandi della lista di attribuzione.

La stampa del programma IMPLAVST.S5D deve coincidere con lo stralcio del pro-
gramma nel capitolc 24.5.4, fase 5, fino alle sigle del simbolico.

Allo stesso modo si genera la stampa del blocco dati DB 5 e della lista di attribuzione
IMPLAVZ0.INI, selezionando le relative voci dei sottomenu.

Una stampa degli altri blocchi esistenti & eseguita tramite F3 = Scegli e box di scelta.

E possibile anche emettere la documentazione su un file.

* In questo caso, nel box di comando, contrassegnare con la crocetta il campo
Emetti su file ed indicare il nome del file IMPLAVLS.INI.
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L'editazione del programma Impianto di lavaggio € stata interrotta al segmento 5 e
ora si vuole completare la parte mancante con il programma fornito. In questo modo
si impara a conoscere le funzioni di indice, trasferimento, copia e cancellazione dello
STEP 5.

Il programma completo si trova sotto il nome PROBSP... nella directory
C:\STEP5\S5_SYS\EXAMPLE . Per il trasferimento del programma portarsi per-
tanto nelle funzioni file DOS.

1. Selezionare File » File DOS » Copia.

Appare ora il box di comando Copia file DOS, in cui si definiscono directory sor-
gente e destinazione del trasferimento.

2. Verificare dapprima che le directory siano impostate correttamente
Drive sorgente:  C: \STEP5\S5_SYS\EXAMPLE
Drive destinazione: C: \STEP5\S5_DATEN

Si devono trasferire tutti i file (PROBSP*.*) pertanto:

1. nella finestra Sovrascrivi con conferma, contrassegnare Si.

2. Avviare il procedimento di trasferimento premendo Copia o il tasto di
introduzione .

Se é stato selezionato Sovrascrittura con conferma,lo STEP 5 per ogni copia segnala
File gia esistente, sovrascrivere?

* Rispondere con Si e dopo il trasferimento abbandonare il box di comando con
ESC = Annulla.

Verificare nel menu Indice File DOS se tutti i file PROBSP..sono stati copiati.

* Impostare sotto /Indice /DRIVE la directory
C:\STEP5\S5_DATEN .

Oltre ai file del programma IMPLAV... qui devono ora essere registrati anche i file di
PROBSP...

Ora che entrambi i programmi si trovano nella directory di lavoro, si pud completare
il nostro programma,

¢ trasferendo i segmenti ancora mancanti,

¢ sostituendo il blocco FB5 incompleto con FB10 con il programma di lavaggio
completo e quindi ridenominandolo FB5,

¢ trasferendo i blocchi organizzativi ancora mancanti (i blocchi dati sono identici).
Si possono trasferire segmenti soltanto tra blocchi nello stesso programma. Bisogna

pertanto provvedere cheilbloccofunzionale FB10 siatrasferito dal programma S5DE-
MOST.S5D nel nostro programma IMPLAV... .

STEP 5/ST V7.0
C79000-G8572-C920-02



STEP 5 in un impiego pratico - Esempio applicativo

_ File

Blocchi>
Trasferisci

_ File

Blocchi>
Indice> F3

\ Editor

Blocco STEP 5
.F1
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Per il trasferimento di un blocco, lo STEP 5, dopo la selezione di Blocchi » Trasferi-
sci presenta un box di scelta file, in cui

1. bisogna indicare nel campo Trasferisci il file programma PROBSPST.S5D e
nel campo inil file programma WASCHAST.S5D.

Premendo F3 lo STEP 5 mostra quali file si trovano nella directory di lavoro.

2. Nel box di comando Trasferisci blocchi contrassegnare con la crocetta il
campo Lista blocchi e introdurre FB10 .

Dopo il trasferimento o dopo aver premuto il tasto di introduzione ,lo STEP 5
risponde con una domanda intermedia Scrivere intestazione su FD?

3. Confermare la segnalazione con Si,

Avvertenza
Le segnalazioni FC10 gia nel file, sovrascrivere? e #FBDO0.010
gia nel file, sovrascrivere? non appaiono al primo trasferimento.

4. Dopo il procedimento di copia abbandonare il box di comando con ESC =
Annulla.

Controllare questo trasferimento nell'indice blocchi del file programma.

1. Selezionare nel menu File » Blocchi » Indice oppure piu velocemente con >
F3il box di scelta Blocchi: impostazioni.

2. Introdurre nel box di scelta Lista blocchi B

3. Premendo Emetti - o Conferma (oppure tasto di introduzione ) appare subito
sul video I'elenco dei blocchi del file programma IMPLAV...

Questa lista si pud anche far emettere su stampante o su file, contrassegnando
opportunamente con la crocetta il campo Emetti su.

Per il trasferimento dei segmenti

1. Introdurre nel box di comando nel campo Lista blocchi il blocco funzionale
FB 10.

2. Mediante il tasto pagina | = scorrimento avanti o il tasto + posizionare il cur-
sore nel segmento 6.

3. Premere F5 = Funz. segm e F4 = Annota.
4. Con F8 = Indietro e ESC = Annulla si abbandona il FB10.
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Trasferimento e
ridenominazione
di blocchi

_ File

Blocchi>
Cancella>
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Una copia del segmento 6 si trova ora nel buffer del sistema. Per trasferirlo in FB5

1. selezionare nell’editor blocchi il FB5 e posizionare il cursore nel segmento 5
alla fine del programma.

2. Premere quindi F5 = Funz. segm e F6 = Aggiungi. Dopo aver premuto F2 =
Buffer il segmento 6 € aggiunto al nostro programma IMPLAV.. .

3. Concludere I'operazione con F8 = Indietro e F7 = Conferma. Rispondere alle
segnalazioni STEP 5 con Si.

Si e usciti dall’editor. Ripetere il procedimento di trasferimento per il segmento 7.

Si puo constatare che nei segmenti aggiunti non tutti gli operandi sono rappresentati
in simbolico. Cio & dovuto alla lista di attribuzione incompleta nel programma editato
fino ad ora.

Per ottenere anche qui una rappresentazione corretta:
1. Selezionare Imposta progetto

2. Introdurre come file simbolico: PROBSPZ0.INI

3. Salvare con F6

Poiche I'editor dei blocchi puo accedere alla lista di attribuzione completa del pro-
gramma fornito, anche nei segmenti 6 e 7 gli operandi sono rappresentati corretta-
mente in simbolico.

e Controllare cid con un nuovo richiamo del FB5 nell’editor blocchi.

Questo procedimento, consente I'inserimento o I'aggiunta di segmenti da altri blocchi
del file di programma. Per il trasferimento e il completamento di grosse parti di pro-
gramma cio € tuttavia troppo complicato.

Per sostituire nel programma IMPLAV... il FB5 completamente con il FB 10, si vuole
cancellare il FB5 compresi i commenti e quindi ridenominare il FB10 in FB 5.

1. Per cancellare FB5, selezionare File » Blocchi » Cancella
2. Introdurre nel box di scelta nel campo Lista blocchi"FB 5”.

3. Dopo l'avvio di Cancella lo STEP 5 chiede Cancellare anche i com-
menti?

4. Confermare con Si. Dopo, confermare la segnalazione Cancellati bloc-
chi con Si.

Una verifica dell'indice blocchi conferma la cancellazione di FB5, FK5 e #FBD0O.005.

STEP 5/ST V7.0
C79000-G8572-C920-02



STEP 5 in un impiego pratico - Esempio applicativo

_ File

Blocchi>
Trasferi-
sci...F5

Trasferimento dei
blocchi
organizzativi

_ File

Blocchi>
Trasferi-
sci...F5
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1. Perridenominare il FB10, selezionare nel menu File » Blocchi » Trasferisci
e introdurre e contrassegnare nel box di comando:

e Trasferisci da C\WASCHAST.S5D,

* jin C:\WASCHAST.S5D

* Scegli (x) Blocco [FB10] in [FB5]

2. Dopo l'avvio di Trasferisci , confermare le contro-domande dello STEP 5 con
Si.

Un controllo dell'indice blocchi mostra oltre ad FB5/FK5 anche I'esistenza di un nuovo

FB10/FK10.

¢ \Verificare nell’editor la completezza del nuovo FB5 con 15 segmenti, operandi
simbolici e tutti i commenti.

Per il completamento del nostro programma, costituito per ora da FB5 e DB5, bisogna
ancora trasferire i blocchi organizzativi mancanti.

1. Per il trasferimento degli OB, selezionare nel menu File » Blocchi »
Trasferisci .

2. Introdurre nel box di comando:
e Trasferisci da PROBSP...
e jnWASCHA..

* Scegli (x), selezionare con una crocetta Lista blocchi e introdurre OB1, OB20,
0OB21, OB22.

3. Dopo l'avvio di Trasferisci , il sistema emette la segnalazione Trasferi-
mento con commenti e la segnalazione conclusiva Blocchi
trasferiti! Confermare con Si.

Dopo aver modificato in OB 1 il salto assoluto in SPAFB 5 ed anche in FB 5l richiamo
del blocco dati A DB 10 in A DB 5, il programma IMPLAV... contiene ora tutti i blocchi
necessari per la gestione dell'impianto.
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24.4 Controllo e modifiche del programma

Oltre alle funzioni di editazione lo STEP 5 offre una serie di supporti per la verifica

e

la documentazione del programma utente, come per esempio la ridenominazione

degli operandi. Saranno utilizzate alcune di queste funzioni per il nostro programma
dell'impianto di lavaggio.

Riferimenti Lo STEP 5 memorizza nel file LI *XR.INI i riferimenti relativi alle istruzioni, cioé dove
sono utilizzatigli stessioperandi, ancheinaltriblocchi. Questofile € generato avviando
Genera XREF nel menu Gestione.

\ Gestione In File » Progetto » Imposta , scheda Blocchi, viene introdotto il file di lista incrociata
Genera XREF CXR.INI. Nell’Editor blocchi & ora possibile visualizzare per ciascun operando i riferi-
menti incrociati.
1. Richiamare nell’editor blocchi il FB 5 e posizionare il cursore nel segmento 2
sullistruzione :O -AVVIAM.
2. Dopo aver premuto F2 = Riferim ed ancora F2 = Vis. XREF il cursore lampeg-
gia sotto M 10.7, 'operando per il quale si devono visualizzare i riferimenti.
3. Confermare con il tasto di introduzione
Viene ora emessa una tabella con i riferimenti relativi all'operando selezionato
(fig. 24-6). Questa tabella contiene tutti i "punti”, in cui I'operando in questione
€ "richiamato”. Il cursore si trova sul primo riferimento al blocco OB 20 :1/UN.
4. Premere F2 = Salta.
Viene visualizzato il blocco organizzativo OB 20. Se necessario, € possibile
passare in Editazione e modificare. Si ritorna nella tabella
5. premendo due volte F2 e il tasto di introduzione
Da OB 20 si ritorna direttamente in FB5 tramite
6. F2 = Riferim. e successivamente F5 = Blc. orig.
Si ripete il salto in un blocco indirizzato, posizionando nella fig. 24-6 il cursore
su FB10:2/UN e premendo F2 = Salta. Viene visualizzato il SEGM. 2 di FB 10.
FB5 C:IMPLAVST.S5D BIB=2 LUN=166
Segmento 2 0007 "Definiz. stato di esercizio” Output
Riferimenti
M 10.7 AVVIAM Riconosc. avviam. da OB 20/21/22
OB 20:1/UN OB 20:1/S OB 21:1/UN OB 21:1/S
OB 22:1/UN OB 22:1/S FB 5:2/UN FB 5:2/0
FB 5:2/R FB 10:2/UN FB 10:2/0 FB 10:2/R
Figura 24-6  Riferimenti in IMPLAV relativi al’'operando AVVIAM.
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Nel menu Documentazione lo STEP 5 mette a disposizione una serie di liste, in cui
sono raccolti i riferimenti incrociati o per un singolo operando (qui M 10.7) o per un
gruppo di operandi (p.es. E, A, M, Contatori). L'esecuzione dei riferimenti pud essere
limitata ad un determinato blocco o estesa a tutti i blocchi del programma.

La fig. 24-7 mostra una stampa dei riferimenti relativi alle Uscite in FB5 e ai Contatori
e ai merker di avviamento (M 10.7) in tutti i blocchi. L'asterisco vicino al numero di
segmento segnala che I'operando € utilizzato in una istruzione di assegnazione del
risultato logico. La selezione nell’elenco si esegue nel box di comando, contrasse-
gnando con la crocetta Lista incrociata.

FB 5 C: IMPLAVST.S5D BIB=2 LUN=166 &
Lista incrociata: Uscite
A 32.0 -AV-STRUT SEG. : 7*, 8* 9* 10% 15*
A 32.1 -RIT-STRUT SEG. : 4x  8*  Or 10% 11* 15*
A 32.2 -AP-PORTA SEG. : 4* 12* 15*
A 32.3 -CH-PORTA SEG. : 6*, 7* 15*
A 32.4 -ENT-AUTO SEG. : 5% 6*
A 32,5 -USC-AUTO SEG. : 4*  B*  13* 14*
A 32.6 -ROT-SPAZ SEG. : 7, 9*
A 32.7 -DETERG. SEG. : 7*, 8*
A 33.0 -RIASCIACQ. SEG. : 8*, 9*
A 33.1 -CERA SEG. : 9* 10*
A 33.2 -ASCIUGAT. SEG. : 12*
AB 32 - SEG. : 3%, 4*
AB 32 - SEG. : 3%, 4*
Lista incrociata: CONTATORI
FB 5: Elaborato
FB 10 : Elaborato
OB 1: Elaborato
OB 20 : Elaborato
OB 21 : Elaborato
OB 22 Elaborato
z 2 -PASSI FB 5 3*, 4*, 5*, 6%, 7*, 8%, 9%, 10%, 11*
12*, 13*, 14*
FB 10 3%, 4* 5% 6% 7* 8* 9* 10* 11*
12*, 13, 14*
OB 20 1*
OB 21 1*
OB 22 1*
z 20 -NR. CICLI FB 5 6*
FB 10 6*
Ricerca diunoperando in tuttii blocchi
M 10.7 -AVVIAM. FB 5 2%
FB 10 2%
M 10.7 -AVVIAM. 0B 20 1*
OB 21 1*
OB 22 1*

Figura 24-7 Lista incrociata dei riferimenti del programma "Impianto di lavaggio”

Durante I'editazione & possibile emettere riferimenti anche in Ricerca.
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\ Editor

Blocco
STEP 5...

Interconnessione

Gestione

Interconnessione
manuale...

Confronto di
blocchi
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1. Nell'editor blocchi, richiamare il FB5 e premere F3 = Cerca.
2. Introdurre come criterio di ricerca (CRIT.RICERCA) un operando, qui
E 32.4 0 -STRUT-AV. Poi F2 = Dal 1° Seg.

Viene visualizzata la prima comparsa di questo operando nel SEGM. 8, riga istru-
zione 4.

3. Premendo di nuovo F3 = Cerca e ancora F3 = Avanti

Viene visualizzata SEGM. 10 con il cursore sull'istruzione 4, ecc.

Si vuole ora attribuire ad un operando un nuovo indirizzo all'interno del programma.
Con l'ausilio della funzione Interconnessione & possibile ridenominare gli operandi,
cioé associarli ad altri indirizzi della periferia. Per mostrare le modalita di questa fun-
zione, viene ridenominato un operando di uscita in FB10.

1. Verificare i nomi dei file:
file di programma C:IMPLAVST:S5D dopo
file di programma C:IMPLAVST:S5D

2. Introdurre nel box di comando FB10. Dopo Interconnetti appare una tabella in
cui introdurre a destra gli operandi validi fino ad ora (in assoluto) e a sinistra i
nuovi operandi.

3. Introdurre, vecchio operando: A 33.2, F7 = Conferma nuovo operando: A 1.7.

4. Concludere l'introduzione con Conferma e confermare con Sile successive
segnalazioni di sistema.

5. Controllare I'esecuzione della modifica richiamando nell’editor il blocco FB10 e
premendo F3 = Cerca, introdurre CRIT. RICERCA: A 1.7 e premere F2 = Dal
1% seg.

Nel segmento 12 é stato introdotto tre volte al posto di ASCIUGAT l'operando A 1.7,
cioé il segnale per I'apertura e la chiusura dell’elettrovalvola dell’aria per I'asciugatura
viene emesso tramite A 1.7.

Lo STEP 5 comprende una funzione di confronto con cui € possibile confrontare tra
diloro blocchi dello stesso tipo e numero nel controllore programmabile e PG. Se non
e collegato nessun controllore programmabile, si possono confrontare tra diloro bloc-
chiin diversi programmi. Questo & quanto si vuole fare con il nostro FB10, modificato
tramite Interconnessione in IMPLAV..., ed il blocco FB originario in SSDEMO... .
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_ File |

Blocchi>
Confronta...

1. Richiamare nel menu File » Blocchi » Confronta .

2. Introdurre nel box di comando sotto Confronto con File programma
C:PROBSPST.S5D e sotto Lista blocchi FB10.

3. Premere poi Confronta.

Siottiene ora per FB 10 un riassunto delle differenze nel SEGM. 12. Le operazioni
STEP 5 sono indicate in codice MC5.

4. Ripetere il confronto blocchi, contrassegnando questa volta nel box di co-
mando Tutti blocchi (B).

Lo STEP 5 presenta la funzione di confronto come rappresentato nella figura 24-8.
Blocchi non esistenti sono indicati con la segnalazione 020D, piu avanti si puo osser-
vare che in OB1 sono richiamate FB diverse.

Funzione di confronto
Blocco Segmento Indirizzo C:IMPLAV Indirizzo C:S5DEMO
DB 5 Segnal. Nr. 020D
DB 10 Segnalaz. Nr. 020D
FB 5 Segnal. Nr. 020D
FB 10
12 0084 D781 D2A1
0089 C781 C2A1
008B F781 F2A1
OB 1
1 0000 3D05 3D0A
OB 20
Confronto senza errori

Figura 24-8 Confronto dei blocchi tra IMPLAV e SSDEMO
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24.5 Caricamento e test del programma

Per il test del programma Impianto di lavaggio si deve ora collegare un controllore
programmabile S5-90/95 al dispositivo di programmazione. Eseguire un collega-
mento stabile tra PG e controllore programmabile (AG), e modificare nel Progetto,
scheda 1AG, I'impostazione del Funzionamento in Online e Modifiche in ciclico, pre-
mendo F3 = Scegli e confermare.

24.5.1 Caricamento del programma

_ File

Blocchi>
Trasferisci
F5

_ File

Blocchi>
Indice...F3

24-24

Il caricamento del programma & eseguito con l'ausilio della funzione Blocchi » Tra-
sferisci del menu File.

1. Selezionare File » Blocchi » Trasferisci .

2. Introdurre nel box di comando nel campo Trasferisci da (nel caso non sia gia
preimpostata) C:IMPLAVST.S5D

3. Introdurre nel box di comando nel campo in AG
4. Introdurre sotto Scelta, Lista blocchi FB 5, poi DB 5 e infine tutti OB.

5. Premendo Trasferisci vengono copiati in AG i blocchi sopracitati, da confer-
mare con Si.

1. Controllare il procedimento di caricamento, facendo emettere I'indice dei bloc-
chi presenti in AG.

2. Contrassegnare pertanto nel box di comando tutti blocchi (B).
3. Contrassegnare nel box di comando nel campo Indice di. AG

Viene emesso un elenco dei blocchi caricati in AG, che contiene soltanto le parti di
programmanecessarie. | commentie leintestazioni deiblocchinon sono statitrasferiti.

Avvertenza

Vengono emessi anche i blocchi di sistema del controllore.
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24.5.2 Test del programma

Il programma utente, in pratica il blocco funzionale FB5, puo ora essere testato in fun-
zionamento online, segmento per segmento e istruzione per istruzione, verificando
il corretto svolgimento. La tabella decisionale (pagina A-10) mostrale reazionidellAG
sulle uscite in relazione a determinate combinazioni dei segnali d’ingresso.

Perl'impostazione o lavariazione dei segnalid’ingresso sono adisposizione sul simu-
latore SIMATIC INPUT (N.Ord. 6ES5788-8MK11) otto interruttori On/Off (E 32.0 ...
E 32.7) e due pulsanti (E 33.0/E 33.1). A seconda del tipo di rappresentazione dello
stato dei segnali desiderato sul PG, si seleziona per il test la funzione Stato blocco
o Stato variabile.

24.5.3 Stato del blocco

| Test

Stato blocco ...
SHIFT+F6
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1. Predisporre sul simulatore tutti gli interruttori su Off e sull’AG il commutatore di
funzionamento su STOP.

2. Selezionare nel menu Test Stato blocco.

3. Introdurre nel box di comando FB5, contrassegnare le relative opzioni con Sie
premere Emetti.

Appare il segmento 1 in rappresentazione AWL. Sotto la riga di testata, accanto
all'istruzione sono visualizzati il risultato logico combinatorio RLC e lo stato
del’ACCU 1 e dellACCU 2.

4. Mettere ora I'AG in RUN.

Viene di volta in volta visualizzato il RLC e a destra in basso compare la se-
gnalazione Elaboraz. stato in corso

5. Mettere in funzionamento I'impianto di lavaggio, portando su OnE 32.0 e
E 32.1.

6. Spostare al segmento 3 il punto di alt per I'elaborazione di stato, premendo
due volte pagine | = scorrimento avanti.

7. Premendo 3 volte il tasto cursore in basso portare il cursore sulla riga dopo il
comando di salto.
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Correzioni

24-26

Le visualizzazioni spariscono e si puo constatare che questa istruzione (dopo la dira-
mazione) non viene elaborata (segnalazione in basso a destra). Nel segmento 4 si
verifica un fatto analogo. Anche qui I'elaborazione termina nel punto di diramazione.

8. Spostare ora il punto di alt nel segmento 5, in cui inizia il vero e proprio proce-
dimento di lavaggio.

RLC=1 nellariga 1 indica che tutte le premesse, come posizione iniziale impianto
e impostazione del contatore passi, sono soddisfatte e il procedimento di lavag-
gio puo iniziare.

9. Portare su On anche gli interruttori E 32.5 e E 32.6.

Il contatore passi e 'ACCU 1 hanno ora un valore = 1, gli ingressi impostati lo
stato 1. Sull’AG si accende l'uscita A 32.4, cioé e acceso il visualizzatore EN-
TRATA AUTO.

10. Spostare il punto di alt nel segmento 6 e portare su On l'interruttore E 32.3 per
Auto in posizione. Premendo il pulsante E 33.0 (Start) inizia il ciclo di lavaggio.

Il visualizzatore si spegne (A 32.4 = 0) e la porta si chiude (A 32.3 accesa). Il con-
tatore passi si porta su 2.

11. Spostare il punto di alt nel segmento 7 e simulare la chiusura della porta con
E 32.6 = Offe E 32.7 = On.

Sono avviate le operazioni di Spruzzatura schiuma, Rotazione spazzoloni e
Struttura avanti (variabili = 1). Il contatore passi si porta su 3.

12.Simulare gli altri procedimenti del lavaggio, variando a seconda dei punti di alt
gli ingressi come da tabella 24-2.

Nel segmento 11 si puo vedere, dopo che E 32.5 =1, come il valore di set di diffu-
sione cera indicato nel DB 5, sia decrementato ogni secondo fino a 0 sia generato
automaticamente, con il contatore passi (= 7), la condizione di start per
I'asciugatura.

13.Spostare il punto di alt nel segmento 12.

Si puo constatare lo scorrimento del tempo di asciugatura (TAA = 45 s). L'ulteriore
andamento nei passi 8 e 9 si simula nei modi gia descritti.

Nel segmento 14 il contatore passi ritorna ad 1, che contraddistingue lo stato di par-
tenza dell'impianto di lavaggio. Il programma esemplificativo & pertanto funzionante
per quanto era stato specificato. In caso di errori bisogna apportare delle modifiche
sulla base delle informazioni ricevute tramite il RLC, il contenuto degli accumulatori
e lo stato dei segnali.

1. Commutare pertanto con F6 in Editazione. Spostando il cursore posizionarsi
sull'istruzione che si vuole modificare, cancellare o inserire.

2. Dopo aver premuto Conferma , rispondere alla domanda Conferma del
segmento modificato? ed alle successive segnalazioni con Si.
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_ File |

Blocchi>
Trasferisci..F5

Test |

Stato
Variabile
Shift+ F7
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In questo modo viene modificato il programma in AG. Se si desidera avere il blocco
modificato nel PG, p.es. per archivazione:

1.

2
3.
4

Selezionare File » Blocchi » Trasferisci
Trasferisci da (x) AG
Introdurre nel campo in file programma (x) e nella lista blocchi F3.

Introdurre nel box di comando FB 5.

Predisporre sul simulatore tutti gli interruttori su Off e sul’AG il commutatore di
funzionamento su STOP.

Selezionare nel menu Test Stato variabile.
Appare una tabella vuota con le colonne Operandi: e Formati:.

Introdurre dalla lista dei segnali tutti gli operandi di uscita in assoluto o simbo-
lico e concludere ciascuna riga premendo il tasto di introduzione .

Lo STEP 5 completa le introduzioni con il formato. Se la lista degli operandi ha
il contenuto indicato nella figura 24-9.

premere F5 = Salva_come e introdurre la sigla del blocco immagine (qui BB 5).

BB 5 AG in CICLO
Operandi: Stato segnali:
—-AV-STRUT A 32.0 KM= 1
—RIT-STRUT A32.1 KM= 0
—-AP-PORTA A32.2 KM= 0
—CH-PORTA A 323 KM= 0
—-ENT-AUTO A324 KM= 0
-USC-AUTO A 325 KM= 0
—ROT-SPAZ A32.6 KM= 1
-DETERG. A 327 KM= 1
—RISCIACQ. A 33.0 KM= 0
—-CERA A 331 KM= 0
—ASCIUGAT A33.2 KM= 0
-TDC T20 KT= fermo
-TAA T22 KT= fermo
—PASSI zZ 2 Kz= 3
—NR.CICLI Z 20 KzZ= 1

Figura 24-9 Rappresentazione degli operandi di uscita nel blocco immagine BB 5

5. Concludere questa predisposizione con Conferma oppure F6 = Attivo.
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Forzamento delle
variabili

24-28

Per il test del blocco funzionale con l'ausilio della funzione Stato Variabile
6. Mettere I'AG in RUN e portare gli interruttori E 32.0 e E 32.1 su On.

La colonna Stato segnali visualizza ora i valori attuali degli operandi (dapprima
tutti 0) e sono inoltre visualizzate le segnalazioni AG in CICLO e Elaboraz.
stato in corso. Controllando la tabella decisionale e ora nuovamente possibile
verificare le reazioni del controllore programmabile in base a determinate con-
figurazioni degli ingressi.

7. Portare E 32.5 e E 32.6 su On.

L'impianto si porta nello stato di predisposizione alla partenza con A 32.4 =1
ez2=1.

8. Simulare ora l'ingresso di un’auto con E 32.3 = On ed avviare I'impianto pre-
mendo E 33.0.

La porta si chiude (A 32.3 = 1), il contatore passi va a 2 ed il ciclo stesso viene
conteggiato in Z 20 = 1.

9. Simulare lo stato Porta chiusa con E 32.6 = Off ed E 32.7 = On.

Il PG mostra ora lo stato dei segnali indicato della figura 24-9. La struttura si
sposta in avanti con gli spazzoloni in rotazione e I'elettrovalvola della schiuma
aperta.

10.Gli stati di Struttura avanti e Struttura indietro sono simulati dai corrispondenti
interruttori E 32.4 e E 32.5.

Ogni qual volta il controllore arriva ad un certo punto della sequenza, sono
emesse le indicazioni di scorrimento dei tempi TDC e TAA, conclusi dallo stato
contatore passi = 8.

Nel passo 9 (E 32.7 = Off, E 32.6 = On) si accende USCITA AUTO e nell'ul-
timo passo (E 32.3 = Off) si reimposta la predisposizione alla partenza con la
visualizzazione ENTRATA AUTO ed il contatore passi = 1.

11. Interrompendo la funzione STATO con ESC = Annulla si ritorna con F8 nel
menu.

Lo STEP 5 visualizza la stato dei segnali nel punto di alt impostato. Con ESC
= Annulla & possibile interrompere I'elaborazione di stato ed aggiungere ope-
randi nella lista. Premendo ancora Conferma I'elaborazione di stato prosegue.

Con questa funzione e possibile modificare le variabili (p.es. E/A/M) a byte nell'imma-
gine di processo. E anche possibile perod, con AG in RUN, visualizzare gli stati attuali
dei segnali. Si predispone questa funzione, preparando una lista di operandi.
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Test

Forza variabili
SHIFT+F8
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Nel menu Test selezionare Forza variabili ed introdurre nella tabella vuota Operandi
Formati gli ingressi e uscite come operandi a byte (EB e AB). Concludere ogni riga
con il tasto di introduzion e e sovrascrivere il formato proposto con KM.

1.

Completare la lista con Z 2/Z 20 e T 20/T 22 e premere quindi F6 = Attivo.

Sotto si pud vedere come dovrebbe essere all'incirca il video dopo le introduzioni
fatte. Mediante successive e opportune operazioni sugli interruttori del simula-
tore, € possibile visualizzare i valori delle uscite e dei contatori, allo stesso modo
delle funzioni di stato.

Premere il tasto ESC = Annulla, portare E 32.0/E 32.1 su On e 'AG da STOP
a RUN.

Ora il PG visualizza la colonna Forzamento immagine. E possibile ora, tramite
tastiera, forzare direttamente le uscite in AB 32/AB 33 e verificare pertanto la fun-
zionalita degli attuatori. Per controllare cio,

introdurre in AB 32 la configurazione a bit KM = 00110011 e premere
Conferma .

In AG si devono eccitare i relé di uscita 32.0/32.1 e 32.4/32.5 e sul video compare
la segnalazione Forzamento eseguito.

AG in CICLO \
Operandi: Stato segnali:
....................... AB 32 KM = 000000001
....................... EB 33 KM = 000000000
....................... AB 32 KM = 000000000
....................... AB 33 KM = 000000000
— PASSI Z2 Kz= 2
-TDC Z 20 KZ = fermo
- TAA T 22 KT = fermo
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24.5.4

Fase 1:

24-30

Modello di programma per I'esempio applicativo

La generazione degli elementi di un programma STEP 5 (blocchi di programma, seg-
menti, blocchi dati, lista di attribuzione) partendo da un problema definito, richiede
un certo processo di sviluppo. Per far cid € normalmente sufficiente avere il manuale
di programmazione del controllore programmabile (AG) e conoscenze di base circa
il sistema SIMATIC S5.

Per il semplice esempio di un impianto di lavaggio per automobili, il processo di svi-
luppo si limita all’esecuzione delle seguenti fasi:

S1: Rappresentazione schematica dell'impianto da controllare con
evidenziati gli elementi importanti per 'automazione.

S2: Stesura dell’elenco dei segnali di ingresso/uscita ed attribuzione dei
relativi nomi simbolici.

S3: Rappresentazione sotto forma di tabella decisionale della sequenza di
comandi con le condizioni ed azioni relative alla descrizione del
processo.

S4:  Predisposizione di un blocco dati.

S5: Programmazione in AWL dei blocchi contenenti il programma (un
segmento per ogni regola della tabella decisionale).

Schematizzazione dellimpianto da controllare

Perlapreparazione del programma, I'impianto dilavaggio deve essere schematizzato
in modo che le periferie (sensori/attuatori) nonché le loro azioni siano riconscibili nella
sequenza di controllo.

Per la combinazione logica nel controllore programmabile & anche importante cono-
scere il tipo di funzionamento degli elementi di ingresso. In fase di programmazione
si deve sapere se si tratta di contatti normalmente aperti (in chiusura) o normalmente
chiusi (in apertura).

Lo schema dell'impianto contiene le informazioni necessarie per generare I'elenco
degliingressie delle uscite che devono poi essere elaborate dal controllore come ope-
randi. Questa rappresentazione deve essere ampliata con i segnali degli elementi
di servizio e di visualizzazione riportati in figura 24-10.
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Fase 2:
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| (A32.4) b (A32.5) ~_ Visualizz.

} U @ @ ‘ Segnalazioni
S _
Commut. Puls. di Emerg. )
princ. awiam.  (E 32.1) Segp. di comando
(E 32.0) (E33.0) norm. (uscite)
chiuso!
Controllore
\ (%) > Imp. di lavaggio

Segn. di servizio

Segn. di processo (ingressi)

Figura 24-10 Struttura di controllo con ingressi/uscite di servizio

Come premessa per lagenerazione dellalista deglioperandi e perla descrizione delle
sequenze dell'impianto, siassume ora che siano noti tuttii dati che vengono trasmessi
dal/al programma di comando.

Riassunto delle grandezze di ingresso/uscita

Per la descrizione e programmazione é utile assegnare ad ogni ingresso/uscita un
nome simbolico. Gliingressi e le uscite di impianto e di servizio vengono raggruppati
in una tabella.

Tabella 24-1 Elenco dei segnali d'impianto

Operando
Elemento Tipo, funzionamento assoluto simbolico
processo
Sensore |Comm. a chiave, in chius. |E 32.0 Impianto ON
Sensore |Pulsante, in apertura E 32.1 Emergenza
Sensore Pulsante, in chiusura E 33.0 Start ciclo
Sensore | Contatto di pres., in chius. |E 32.3 Auto in posizione
Sensore | Finecorsa, in chiusura E 324 Struttura avanti
Sensore | Finecorsa, in chiusura E 325 Struttura indietro
Sensore |Finecorsa, in chiusura E 32.6 Porta aperta
Sensore | Finecorsa, in chiusura E 32.7 Porta chiusa
Attuatore |Relé di accoppiamento A 32.0 Avanz. struttura
Attuatore |Relé di accoppiamento A 321 Ritorno struttura
Attuatore |Relé di accoppiamento A 322 Apertura porta
Attuatore |Relé di accoppiamento A 323 Chiusura porta
Attuatore |Relé di accoppiamento A 32.6 Rotaz. spazz.
Attuatore |Relé di accoppiamento A 327 Spruzz. deterg.
Attuatore |Relé di accoppiamento A 33.0 Lavaggio
Attuatore |Relé di accoppiamento A 331 Diffusione cera
Attuatore |Relé di accoppiamento A 33.2 Asciugatura
Visualizz. |Lampada o display A324 ENTRATA AUTO
Visualizz. |Lampada o display A32.5 USCITA AUTO
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Fase 3

Sequenza di
processo

24-32

Descrizione della sequenza di processo, rappresentazione delle funzioni di co-
mando in una tabella decisionale.

Un importante passo nello sviluppo del programma, definiti lo schema funzionale e
la lista delle grandezze dell'impianto, & costituito dalla definizione della sequenza di
processo. Cio pu0 essere fatto sotto forma di schema di flusso.

Per motivi di chiarezza, viene qui data una descrizione verbale della sequenza di pro-
cesso che sara poi tradotta in una tabella decisionale.

Tale tabella (tabella 24-2) deve essere cosi interpretata:

* Sopra la doppia riga sono riportate le condizioni che devono essere analizzate
come sequenza logica di regole; sotto le azioni da eseguire al soddisfacimento
delle suddette regole.

* Una colonna corrisponde ad una regola di seguito verbalmente descritta e
quindi, nella fase 5 dello sviluppo del programma, verra tradotta in un se-
gmento di programma.

1. Preparazione della sequenza di programma.

2. Definizione dello stato di funzionamento.
Il controllore definisce lo stato di avviamento dell'impianto quando viene atti-
vato il commutatore principale (E 32.0 = 1) e I'AG & avviato (OB 20/21/22 =
1 eseguiti).

3. Disattivazione dell'impianto /Stop della procedura di lavaggio. Per l'interru-
zione del processo in un certo momento, per esempio per emergenza, € ne-
cessaria una procedura sicura: in funzione dell'attivazione del pulsante di
emergenza (E 32.1 = Imp.) o della disattivazione del commutatore a chiave
(E 32.0 = 0), il controllore resetta lo stato interno dell’AG e disattiva tutte le
uscite.

4. Raggiungimento della condizione iniziale.

In fase di avviamento del controllore viene fatto si che I'impianto di lavaggio rag-
giunga lo stato iniziale, nel caso che guesto stato non sia gia presente. Lo stato
iniziale € raggiunto quando la porta € aperta (E 32.6 = 1), la struttura con gli spaz-
zoloni per il lavaggio € tutta indietro (E 32.5 = 1) e non vi & alcun veicolo nella posi-
zione dilavaggio (E 32.3 = 0). Il controllore deve quindi verificare se tali condizioni
sono verificate. In caso contrario bisogna provvedere alle conseguenti opera-
zioni: Ritorno struttura (A 32.1 = 1) e/o Apertura porta (A 32.2 = 1) e, nel caso ci
sia ancora una vettura nell'impianto, emettere anche la segnalazione USCITA
AUTO (A 325 =1).

5. Definizione della situazione iniziale per il lavaggio.

Bisogna verificare lo stato iniziale, cioé deve essere: Porta aperta (E 32.6=1),
struttura indietro (E 32.5 =1) e nessuna auto presente (E 32.3=0). Questo stato
iniziale viene segnalato con la visualizzazione ENTRATA AUTO (A 32.4=1). La
visualizzazione USCITA AUTO (A 32.5) viene cancellata.

STEP 5/ST V7.0
C79000-G8572-C920-02



STEP 5 in un impiego pratico - Esempio applicativo

STEP 5/ST V7.0
C79000-G8572-C920-02

Ingresso auto ed inizio lavaggio.

L'auto da lavare viene portata nella posizione di lavaggio (E 32.3 = 1) e sul panello
di servizio all’'esterno viene premuto il pulsante di avviamento del lavaggio (E 33.0
= Imp.). Dopo la verifica di Auto in posizione (E 32.3 = 1) e Pulsante avviamento
premuto il controllore chiude la porta (A 32.3 = 1) e cancella la visualizzazione
ENTRATA AUTO (A 32.4 = 0).

La parte di processo che riguarda direttamente la procedura di lavaggio, compresa
la riapertura della porta dopo il lavaggio, &€ completamente automatica.

1.

Spruzzatura della schiuma.

Dopo la verifica del segnale Porta chiusa (E 32.7 = 1), la struttura si muove in
avanti (A 32.0 = 1) con gli spazzoloni in rotazione (A 32.6 = 1) e con gli ugelli della
schiuma aperti (A 32.7 = 1). L'auto viene insaponata e lo sporco rimosso.

Lavaggio, risciacquo.

Dopo la verifica del raggiungimento della posizione finale Struttura avanti (E 32.4
= 1), il controllore ferma il relativo motore (A 32.0 = 0) chiude gli ugelli della
schiuma (A 32.7 =0), apre la valvola per I'acqua (A 33.0 = 1) e provvede al ritorno
della struttura (A 32.1 = 1), sempre con gli spazzoloni in rotazione (A 32.6 = 1).
Con questa operazione la macchina viene pulita e risciacquata.

Diffusione della cera.

Dopo la verifica del raggiungimento della posizione Struttura indietro (E 32.5 =
1) si ha: disattivazione del motore (A 32.1 = 0), chiusura della valvola dell’acqua
(A 33.0 = 0) e arresto degli spazzoloni (A 32.6 = 0). Adesso la struttura deve tor-
nare in avanti (A 32.0 = 1) con gli ugelli della cera aperta (A 33.1 = 1).

Diffusione dello strato di cera.

Nella posizione in avanti (E 32.4 = 1) chiudere gli ugelli (A 33.1 = 0) e riportare
la struttura indietro (A 32.1 = 1).

Nella posizione indietro (E 32.5 = 1) arrestare il motore (A 32.1 = 0). Alla cera
spruzzata occorre ora un tempo TDC affinche si realizzi una stesura uniforme
sulla superficie del veicolo, fino a formare un sottilissimo strato ("film”). I
controllore deve verificare il trascorrere del tempo TDC. Solo quando tale tempo
e trascorso, puo essere affrontato il passo successivo.

. Asciugatura.

Il processo di asciugatura viene avviato con I'attivazione del tempo di asciugatura
TAA e la contemporanea apertura della valvola dell’aria (A 33.2 = 1). Trascorso
il tempo TAA, la valvola viene richiusa (A 33.2 = 0) e la porta viene aperta (A 32.2
=1).

Uscita auto.

Dopo l'apertura della porta (E 32.6 = 1) si ha: arresto del motore della porta
(A 32.2 = 0) e visualizzazione della segnalazione USCITA AUTO (A 32.5 = 1).

Impianto vuoto.

Se Nessuna auto in posizione (E 32.3 = 0), il controllore spegne la segnalazione
USCITA AUTO (A 32.5 = 0) e resetta il contatore interno di passi a 0.
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Il ciclo di lavaggio & cosi concluso. Quando I'auto € uscita, I'impianto si porta nello
statoiniziale (vedere il punto 5) ed emette la segnalazione ENTRATA AUTO. ll veicolo
successivo puo entrare ed il processo di lavaggio pud ricominciare.

Nota: L'ottimizzazione verticale e orizzontale del percorso delle spazzole per I'adatta-
mento al profilodella carozzerianonviene presoin considerazione nel presente esem-
pio. Questo compito viene svolto da un altro sottoprogramma.

Unarappresentazione grafica dello svolgimento del processo viene riportata in figura
24-11.Lecifretraparentesievidenzianolarelazione conil passo descritto o contempo-
raneamenterappresentanoilnumerodiregolaodisegmentodellatabelladecisionale.

Per l'identificazione e la limitazione dei singoli passi di processo viene utilizzato un
contatore interno. Dopo I'esecuzione di una parte di operazioni, il controllore incre-
mentadi 1 questo contatoreinmodo che il contenuto del contatore rappresenti sempre
ilpassodaeseguire. Attribuzione ed eleborazione deglistatidel contatore sonorappre-
sentati nella parte sinistra della figura 24-11.

START

Preparazione: seq. programma (1)
Definizione: stato funzionam. 2
no
IMPIANTO ON? ‘
Reset uscite e 3)
contatore passi
FINE
si
NUOVO AVV.? 1

Raggiun. stato iniziale )

) Reset contatore passi
Contatore passi P

interno I

.0 Stato iniziale ®)
Inizio: lavaggio (6)
12 Spruzzatura schiLma @)
Lavaggio/risciacquo (®)
4 Diffusione cera 9) - )
Ciclo di lavaggio
:5/6 Form. strato di cera (10/11)
7 Asciugatura (12)
18 Uscita auto (13)
L :9 Impianto vuoto | (14)
Controllo: segnalazione (15)

(1) = numero di regola nella tabella
FINE decisionale o numero di segmento
nel programma di esempio

Figura 24-11 Diagramma a blocchi del ciclo di lavaggio veicoli
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Tabella 24-2 Tabella decisionale per programma Lavaggio veicoli
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Prima di procedere con la prossima fase di stesura del programma STEP 5, bisogna
definire la struttura stessa del programma. Solo un programma strutturato puo girare
in modo soddisfacente in un controllore programmabile.

Anche questosemplice programmadiesempio, perunordinatofunzionamentoneces-
sita almeno di un blocco organizzativo (OB 1) oltre ai blocchi di programma funzionali
contenenti le istruzioni del programma di lavaggio, ed al relativo blocco dati. L'OB 1
provvede all’elaborazione ciclica del programma nel controllore. Inoltre sono necces-
sari dei blocchi di avviamento (OB 20/21/22) che garantiscono un avviamento o riav-
viamento dell'impianto in ogni condizione.

Senza approfondire le funzioni di questi blocchi organizzativi, in figura 24-12 viene
illustrata la struttura del programma con I'identificazione dei blocchi cosi come verra
poi utilizzata nell’esempio.
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OB1 FB 5 DB 5

OB 22

Progr. Impianto di lavaggio

Figura 24-12 Struttura del programma Impianto di lavaggio

Fase 4 Definizione dati blocchi
Oltre a quanto fin qui detto, il controllore deve garantire anche le seguenti prestazioni:

* | tempi di diffusione dello strato di cera TDC e di asciugatura TAA devono po-
ter essere modificati dal personale di servizio.

¢ Ogni lavaggio deve essere registrato ed il numero di cicli di lavaggio deve po-
ter essere emesso su richiesta.

Queste funzioni possono essere realizzate al meglio tramite 'uso di un blocco dati
(figura 24-13). Nel blocco dati vengono inseriti i tempi di riferimento per TDC e TAA
ed i valori instantanei di questi tempi nei formati KH e KF.

DB 5 "Impianto lavaggio: tempi/conteggi”

Nel blocco dati il personale di servizio introduce i setpoint di tempo di

diffusione cera TDC e di asciugatura della vettura TAA.

Il controllore programmabile deposita quii corrispondenti valori attuali

di tempi nei formati KH e KF.

DW Predisposizioni Commento

0: KH = 0000; Vuoto

1: KH = 0000; Contatore lavaggi (KH)

2: Kz - 000; Contatore lavaggi (KZ)

3: KH _ 0000; Vuoto

4: KT _ 030.2 Setpoint tempo diffus. cera TDC
5: KH : 0000 Valore ist. tempo (KH)

6: KF +00000 Vaore ist. tempo (KF)

7: KH = 0000; Vuoto

8: KT = 045.2 Setpoint tempo asciugat. auto TAA
9: KH = 000; Valore att. tempo TAA (KH)

10: KF = 0000; Valore att. tempo TAA (KF)

11: KH = 030.2 Vuoto

12:

Figura 24-13 Definizione del blocco dati per 'impianto di lavaggio (stampa)

STEP 5/ST V7.0
24-36 C79000-G8572-C920-02



STEP 5 in un impiego pratico - Esempio applicativo

Fase 5 Programmazione (qui solo i primi 5 segmenti)
FB5 C: IMPLAVST.S5D BIB=2 LUN=166
Segmento 1 0000 "Predisposizione ciclo programma”

Prima di poter elaborare il programma relativo all'impianto di lavaggio, memorizzato nel blocco
funzionale FB 5, si deve richiamare il blocco dati DB 5 (istruzione: A DB5).

0005 ‘A DB5 Richiamo DB5 (tempi/conteggi)
0006 i
Segmento 2 0007 "Definizione stato esercizio”

All'accensione o all’avviamento il programma imposta per un ciclo il merker impulsivo M 10.0 che viene
rilevato nel segmento 4 ed in questo caso porta I'impianto nelle condizioni iniziali di partenza.

Il merker di fronte di salita M 10.0 rappresenta lo stato di esercizio relativo all’evento "Commutatore
principale ON” o "Nuovo avviamento”. Solo dopo il reset di M 10.0 tramite "Commutatore principale
OFF" & possibile un riavviamento dellimpianto.

0007 :0 E: 32.0 -PRINC-ON Commutat. princ. "Impianto ON”

0008 :0 M : 107 -AVVIAM. Ricon. avviam. da OB 20/21/22

0009 :UN M : 10.0 -FRONTE-S. Merker per fronte di salita

000A = M: 101 -IMPULSO Merker impulsivo (solo 1 ciclo!)

000B ‘R M : 107 -AVVIAM. Reset riconosc. avviamento

000C U M : 10.1 -IMPULSO

000E S M : 10.0 -FRONTE-S. Impostaz. merker fronte di salita

000F ‘UN E: 32.0 -PRINC-ON Mancanza comando "Impianto ON”

0010 :UN M : 10.7 -AVVIAM. Mancanza riconosc. avviamento

0011 ‘R M : 100 -FRONTE-S. Reset merker fronte di salita
kkk

Segmento 3 0012 "Spegnimento impianto”

Spegnendo I'impianto, con commutatore su OFF, o premendo I'emergenza vengono messe a zero le
uscite e resettato il contatore passi ed il programma viene concluso.

0012 U E : 32.0 -PRINC-ON Commutat. princ. "Impianto ON”
0013 U E : 321 -EMERGENZA Puls. "Emergenza” non premuto
0014 :SPB =WEIT (diramazione programmal)
0015 ‘R z 2 -PASSI Reset contatore passi

0016 L KB 0

0017 T AW 32 Reset uscite in AB 32

0018 T AB 33 Reset uscite in AB 33

0019 ‘BEA Fine blocco

001A WEIT i
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STEP 5 in un impiego pratico - Esempio applicativo

FB5

Segmento 4

L’impulso generato all'accensione o all’avviamento riporta in questo caso I'impianto nelle condizioni
di partenza. La struttura di lavaggio si porta nella posizione sul finecorsa indietro, la porta si
apre e, con "Auto in posizione”, viene emesso il messaggio USCITA AUTO.

:UN
:SPB
‘R
L
T
T
:UN
'S
:UN
'S
U
'S

chkk

001B
ooic
001D
001E
0020
0021
0022
0023
0024
0025
0026
0027
0028 WEIT

Segmento 5

0029
002A
002C
002D
002E
002F
0030
0031
0032
0033

001B "Posizionamento di partenza”

0029

Viene verificata la posizione iniziale di partenza e se questa € soddisfatta, viene emesso il
messaggio "ENTRATA AUTO".

L
L
I=F

C: IMPLAVST.S5D BIB=2 LUN=166

M: 101 -IMPULSO Merker imp. "Impianto ON/Avv.”
=WEIT

z 2 -PASSI Reset contatore passi

KH 0000

AW 32 Reset delle uscite

AB 33 oo

E: 32.5 -STRU-IND Struttura non su finecorsa ind.
A 321 -RIT-STRU Marcia indietro struttura

E : 325 -PORTA-AP Porta non aperta

A 32.2 -AP-PORTA Apertura porta

E : 32.3 -IN-POSIZ Auto in posizione

A 325 -USC-AUTO Messaggio: USCITA AUTO

"Creazione situazione iniziale”

z 2 -PASSI Stato cont. passi in ACCU 1
Kz 000 Richiesta verifica: passo 0
E: 323 -IN-POSIZ "Auto non in posizione”
E: 325 -STRU-IND Strutt. su finecorsa indietro
E: 326 -PORTA-AP Porta aperta
A 324 -ENT-AUTO Messaggio: ENTRATA AUTO
A 325 -USC-AUTO Messaggio: USCITA AUTO
4 2 -PASSI Incremento di 1 cont. passi

24-38

Il programma completo compresi tuttii commenti e la lista di attribuzione sitrova nella
directory C:\S5_DATEN\DEFAULT sotto il nome PROEXAST.S5D.
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Sommario

Sommario del
capitolo
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Questo capitolo offre una panoramica sulla configurazione e sulla suddivisione della
memoria dello STEP 5. Inoltre vengono riassunte in una tabella le directory che
contengono i file che fanno riferimento allo STEP 5. Informazioni dettagliate sulle
directory e sui file che si trovano nell'apparecchiatura di programmazione sono
contenute nella documentazione "Informazioni sul prodotto”.
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25.1 Memoria RAM necessaria per lo STEP 5/ST V 7.0 25-2
25.2 Organizzazione della memoria 25-3
25.3 Struttura della directory STEP 5 25-7
254 File STEP 5 25-9
25.5 Limiti parametri e blocchi disponibili 25-11
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25.1 Memoria RAM necessaria per lo STEP 5/STV 7.0

Sommario

Espansione della
memoria

Memoria di lavoro

25-2

Per fare in modo che lo STEP 5/ST V 7.0 possa funzionare nella memoria di lavoro
convenzionale, cioé si possano utilizzare tutte le sue funzioni, dopo il caricamento
del sistema operativo, si deve avere a disposizione una capacita di memoria RAM
libera di almeno 550 kbyte .

Su un PG che é stato fornito con lo STEP 5, la gestione della memoria di lavoro e
gia ottimizzata.

Sui PG in cui lo STEP 5 viene installato successivamente o quando per esempio si
cambia la configurazione del sistema, si caricano altri driver o programmi, puo essere
necessario modificare I'occupazione della memoria di lavoro per evitare errori di
occupazione della memoria.

L'espansione e la gestione della memoria possono influenzare:

* | programmi che possono essere eseguliti.

¢ La velocita di esecuzione dei programmi.

* La quantita di dati che un programma puo gestire ad ogni esecuzione.

* La quantita di dati che e possibile memorizzare da una sessione alla succes-
siva.

Laconfigurazione base dellamemoriadilavorositrovasullaschedamadre del disposi-
tivo di programmazione. La quantita della memoria di lavoro puo essere aumentata
inserendo una scheda aggiuntiva. Tuttii programmi devono essere caricati nella me-
moria di lavoro per poter essere eseguiti.

Esistono due tipi di memoria di lavoro:
* la memoria di lavoro convenzionale
* la memoria estesa (Extended Memory).

I programmieseguitiin MS-DOS utilizzano disolitolamemoriadilavoro convenzionale
(RAM). Affinché essi possano utilizzare la memoria estesa € necessario installare
un gestore di memoria che ne consenta I'accesso.
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25.2 Organizzazione della memoria

Esempio

Il grafico mostra, a mo’ di esempio, una possibile suddivisione della memoria.

Extended Memory

Memoria EMM386.EXE
estesa

VGA-BIOS

High Memory Area di HIMEM.SYS
HMA 64 kByte Area memoria alta
ROM-BIOS 1. MByte

cisponiilper

Espansioni hardware,

Video-RAM

DOS-DATA-AREA

Video-RAM Area video

programmi tramite ) )

EMM386.EXE Area di memoria  EMM386.EXE
superiore

UMBs

Area video

UMBs

640 kByte Memoria di lavoro convenzionale (RAM)

BIOS-DATA-AREA

Int. Vector

Memoria di lavoro
convenzionale

Area di memoria
superiore

STEP 5/ST V7.0
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Tutti i dispositivi di programmazione dispongono di norma di 640 Kbyte di memoria
di lavoro convenzionale. La memoria di lavoro convenzionale pud essere utilizzata
dai programmi senza alcuna specifica istruzione.

MS-DOS occupa una parte dellamemoria dilavoro convenzionale. | driver di periferica
ed i comandi elencati nei file CONFIG.SYS ed AUTOEXEC.BAT necessitano di ulte-
riore memoria di lavoro. Quella che rimane € disponibile per I'esecuzione dei pro-
grammi utenti.

Il dispositivo di programmazione dispone oltre alla memoria convenzionale di 640
Kbyte anche di uno spazio di 384 Kbyte chiamato area di memoria superiore. L'area
dimemoriasuperiore disolito e riservataall’esecuzione dell’hardware supplementare,
e possibile pero renderne utilizzabili alcune parti mediante un gestore di memoria.
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Area di memoria
alta

Memoria estesa

High Memory Area o HMA (= area di memoria alta) € un blocco speciale di 64 Kbyte
nella memoria estesa che si trova direttamente al di sopra dell'indirizzo di 1 Mbyte.

Quasi tutti i programmi che utilizzano la memoria convenzionale non possono utiliz-
zare la memoria estesa, in quanto i numeri o gli indirizzi che identificano la posizione
dei programmi in memoria estesa superano gli indirizzi che la maggior parte dei pro-
grammiéingradodiriconoscere. Sologliindirizzinei 640 Kbyte dimemaoria convenzio-
nale sono riconosciuti da tutti i programmi.

E possibile attivare ulteriore memoria di lavoro sul PG/PC installando un gestore di
memoria. Questi programmi consentono l'accesso alla memoria estesa (Exten-
ded Memory, XMS) e all'area di memoria superiore.

25.2.1 Gestori di memoria MS-DOS

Esecuzione di
MS-DOS nell'area
di memoria alta

25-4

Un gestore di memoria & un driver di periferica che consente o fornisce I'accesso ad
un particolare tipo di memoria.

MS-DOS (5.0 e 6.2) dispone dei seguenti gestori di memoria installabili:
* HIMEM.SYS gestisce I'accesso alla memoria estesa.

¢ EMM386 consente I'accesso alla memoria estesa e fornisce inoltre I'accesso
all'area di memoria superiore UMB (=Upper Memory Block).

Il gestore di memoria deve essere installato utilizzando un comando DEVICE nel file
CONFIG.SYS. | gestori di memoria compensano I'uso che essi fanno di memoria di
lavoro convenzionale (RAM) fornendo l'accesso a maggiori quantita di memoria
estesa 0 memoria superiore.

In genere, MS-DOS viene eseguito in memoria dilavoro convenzionale (RAM) sottra-
endo cosi parte di memoria ai programmi utente. Tuttavia, MS-DOS puo essere ese-
guito anche in memoria estesa. In tal caso, utilizza i 64 Kbyte dell’'area di memoria
altaHMA (=HighMemory Area). Dalmomento che pochi programmiutilizzanolaHMA,
il suo utilizzo, per eseguire MS-DOS, si rivela opportuno.

L'esecuzione di MS-DOS in memoria estesa ha i seguenti vantaggi:
* Libera circa 40 Kbyte di memoria di lavoro convenzionale (RAM).

e Utilizza I'area di memoria alta, cioé una parte della memoria estesa utilizzata
da pochi programmi.

Il comando DOS=HIGH,UMB determina I'area nella memoria di lavoro in cui si deve
trovare MS-DOS e stabilisce se debbono essere impiegatii blocchi di memoria supe-
riore (Upper Memory Blocks).

STEP 5/ST V7.0
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Come utilizzare
I'area di memoria
superiore

Come rendere
disponibile una
maggiore memoria
di lavoro

Ordine dei driver

STEP 5/ST V7.0
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Un altro modo per aggiungere al sistema una quantita maggiore di memoria di lavoro
oltre ai 640 Kbyte, consiste nell'installare il gestore di memoria EMM386.EXE.

Il gestore di memoria & in grado di inserire nell'area dei 640 Kbyte riservata all’esecu-
zione dell’hardware una quantita di memoria fino ad 1 Mbyte sottraendo una parte
della memoria estesa. Queste parti inserite sono chiamate blocchi di memoria supe-
riore 0 UMBs (= Upper Memory Blocks).

Utilizzo: Conil comando DEVICEHIGHc<file driver> nel file CONFIG.SYS idriver ven-
gono caricati nell'area di memoria alta.

Anche se il sistema dispone di memoria sufficiente, potrebbe accadere che non si
riesca ad eseguire un programma. Spesso la causa sono i programmi residenti in me-
moria (TSR) che utilizzano parte della memoria di lavoro lasciandone una quantita
insufficiente per gli altri programmi.

Di solito, il problema €& dovuto all'insufficienza di memoria convenzionale.

Se si desidera utilizzare la memoria estesa del sistema, I'utilizzo del gestore HI-
MEM.SYS ha i seguenti vantaggi:

¢ rende disponibile memoria estesa per quei programmi che utilizzano la memo-
ria estesa secondo le specifiche XMS (Extended Memory Specification);

¢ evita che i programmi in conflitto tra loro per la richiesta di memoria causino
degli errori di sistema;

¢ consente di eseguire MS-DOS in memoria estesa (HMA);
¢ consente a EMM386 I'utilizzo della memoria estesa,;

* insieme ad EMM386.EXE, consente di utilizzare I'area di memoria superiore
(UMBS).

L'ordine in cui vengono caricati i driver nel file CONFIG.SYS puo essere importante,
in quanto esso influisce sia sull'utilizzo efficiente della memoria sia sul funzionamento
dei vari programmi.

| driver sottoelencati vanno caricati (con il comando DEVICE o DEVICEHIGH) nel file
CONFIG.SYS nell'ordine seguente:

1. HIMEM.SYS

Esempio:
DEVICE=C:\DOS\HIMEM:SYS /M:1

L'opzione /M:1 specifica il ROM-BIOS utilizzato.

Il driver HIMEM.SYS dovrebbe essere il primo driver che viene caricato in
CONFIG.SYS.

2. EMMB386.EXE

Esempio:
DEVICE=C:\DOS\EMM386.EXE NOEMS I=B000-B7FF I=C800-DFFF
X=EO000-EOFF I1=E100-F5FF

Il comando carica (installato) il gestore di memoria MS-DOS EMM386.EXE
dalla directory \DOS nella memoria di lavoro. Esso gestisce la memoria estesa
e l'area di memoria superiore.

3. Qualsiasi driver che utilizzi memoria estesa.
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Affinché lo STEP 5/ST possa offrire la maggior quantita di memoria di lavoro
convenzionale libera, i driver che non vengono utilizzati non devono essere caricati.

Parametri
RAM Con questo parametro € disponibile una finestra EMS.
FRAME Questo parametroindica il punto della memoria in cui deve
trovarsi la finestra EMS.
I=B000-B7FF In genere quest'area di 32 Kbyte ¢ utilizzata dall'interfaccia

video in bianco e nero (Herkules). Siccome quest’area del
PG/PC non € occupata, puo essere utilizzata dalla memoria

di lavoro.

I=C800-DFFF Se quest'area non é occupata dall’hardware, essa puo es-
sere impiegata come memoria di lavoro.

X=EO000-EFFF Se quest’area di memoria € occupata dall’hardware, essa
deve essere eliminata (non per PG 740 e PG 760).

I=E100-F5FF Siccome EMM386.EXE attiva il Protected Mode ed il pro-

gramma SETUP non & eseguibile in questo mode (stato
operativo), quest'area del programma SETUP pu0 essere
utilizzata (non per PG 740 e PG 760).

Nota: | = Include, X = Exclude

25.2.2 Ottimizzazione dell'accesso al disco fisso (per MS-DOS e Windows 3.x)

SMARTDRIVE & un programma per la gestione della memoria cache per velocizzare
I'accesso al disco fisso unter MS-DOS und Windows 3.x.

DEVICEHIGH=C:\DOS\SMARTDRV.SYS 2048/X

Il comando carica SMARTDRV.SYS nell'area di memoria superiore della memoria
dilavoroaldisopradei640Kbyte. Il valore 2048 indicalamassima quantita dimemoria
cache possibile. | valori della memoria cache vanno dai 128 Kbyte fino ai 8192 Kbyte
(8 Mbyte).

STEP 5/ST V7.0
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25.3 Struttura della directory STEP 5

Lo STEP 5/ST utilizza una struttura di directory ben definita. Questa struttura e
costituita da 4 directory separate.

Directory di Directory di Qui vengono installati tutti i file necessari al

sistema sistema funzionamento. All'interno della directory di sistema
l'utente non puo effettuare nessun tipo di modifica. Per
l'intera directory di sistema pud essere prevista una
protezione alla scrittura (eccezione: la sottodirectory
S5_COM\... non pud essere impostata READ-ONLY).
Directory home Qui vengono depositati i file modificati dall’'utente. Questi
possono essere i File Batch necessari all’avviamento,
diversi File INI che descrivono la postazione di lavoro
(dati specifici del dispositivo) ed anche File Via e File
Parametri Stampante modificati dall'utente (DR.INI e
AP.INI).

SINEC Qui vengono inseriti i driver MS-DOS forniti per SINEC
L2, SINEC H1 (driver di rete SIMATIC NET). La
directory € definita in modo fisso con C:\SINEC.
S5_INFO Qui ci sono le informazioni di prodotto e i file Readme
(Leggimi). Questa directory & definita in modo fisso con
C:\S5_INFO.

Le directory di sistema e la directory Home possono stare su diversi drive, in directory
diverse. Le directory relative possono essere selezionate durante l'installazione.

Directory di Dr:\directory_sistema\S5_SYS\ Tutti | programmi STEP 5/ST e i
sistema file di sistema

S5_COM\ Com-Adapter per V5 & V6
Pacchetti COM (la directory non
puo essere impostata
READ-ONLY)

S5.COM\ AWLBAT\ AWL-Batch-Compiler
S5.COM\ COM_DB1\ COMDB 1

S5.COM\  PG_PG\ Accoppiamento PG-PG
EXAMPLE\ | programmi esemplificativi STEP 5
DR_INI File Parametri Stampante forniti
(*DR.INI)
AP_INI File Via forniti (*AP.INI)
S5_INST\ Parte relativa all'installazione

Tutti i nomi delle directory scritti in maiuscolo vengono automaticamente generati in
modo fisso. La parte scritta in minuscolo:

dr:\directory_sistema

puo essere selezionata liberamente dall’'utente.

STEP 5/ST V7.0
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Directory home Dr:\directory_home\S5_HOME\ Dati specifici del dispositivo

Directory utente Dr:\directory_home\S5_DATEN\ Directory preimpostata per i dati
utente, dopo l'installazione dello
STEP 5/ST. La directory € vuota
dopo la prima installazione.

Tutti i nomi delle directory scritti in maiuscolo vengono automaticamente generati in
modo fisso. La parte scritta in minuscolo dr:\directory_home pud essere
selezionata liberamente dall’'utente.

Nell'installazione standard é selezionabile soltanto il drive. La directory € definita in
modo fisso con \STEP5\S5 HOMEN\.

Sequenza di Acausadellasuddivisioneindirectory di sistema e directory home, ifile originali (come

ricerca forniti) e i file modificati dall’'utente risultano separati. | file forniti, modificati dall’'utente,
vengono depositatinella directory home (valido solo peripacchettidellaversione 7.0).
| file originali nella directory di sistema rimangono inalterati.

Da questa caratteristica risulta una sequenza di ricerca definita.

e STEP 5/ST V7.0: la ricerca viene sempre effettuata inizialmente nella directory
home e successivamente nella directory di sistema.

* Pacchetti COM: qui occorre fare attenzione che la directory di sistema V7.0 &
diversa dalla directory di sistema del COM-Adapter. | pacchetti COM utilizzano
la propria directory di sistema ... \S5_SYS\S5_COM .

Questa separazione € necessaria per consentire ai pacchetti COM di funzionare
ugualmente.

| file parametri stampante (*DR.INI) forniti e i file via (*AP.INI) si trovano, per avere
una visione globale, in una propria directory, al di sotto della directory di sistema.

File: inizialmente 2. tentativo
??2????DR.INI Directory Directory di sistema per
home \DR_INI pacchetti
V7.0
?2?2????AP.INI Directory Directory di sistema per
home \AP_INI pacchetti
V7.0
STEP5.S5K Directory Directory di sistema per
home pacchetti
V7.0
S5KXS06X.S5K | Directory Directory di sistema per
home \S5_COM pacchetti
COM
??7@@@@7?7?.IN| Directory Directory di sistema per
home pacchetti
V7.0

STEP 5/ST V7.0
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25.4 File STEP 5

Sommario Questo paragrafo fornisce una panoramica sulle directory e sui file che costituiscono
gli strumenti indispensabili dello STEP 5. Informazioni dettagliate su directory e file
disponibili nel PG vengono riportate nelle informazioni sul prodotto.

File CASTEPS
Impostazioni standard per I'installazione
CASTEP5\S5_SYS
Directory di sistema STEP 5 con il pacchetto base STEP 5
C:A\STEP5\S5_HOME
File S5.BAT, con cui avviare il pacchetto base, e i P-Tool

C:\STEP5\S5-SYS\EXAMPLE
In questa directory ci sono i programmi esemplificativi con blocchi di
programma e liste di attribuzione.
C:A\STEP5\S5_SYS\S5_INST
Contiene le sicurezze per l'installazione delle singole parti dei programmi
S5.
C:A\STEP5\S5_SYS\S5_COM\PG_PG
Accoppiamento tra due PG per lo scambio di blocchi e file STEP 5.
C:A\STEP5\S5_SYS\S5_COM
Directory di default per pacchetti opzionali (COM), COM DB1, AWL Batch

STEP 5/ST V7.0
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25.4.1 Funzioni di alcuni file STEP 5

Sommario Di seguito vengono riportati i file nei quali STEP 5 memorizza le proprie impostazioni
ed i propri dati. La maggior parte dei file vengono memorizzati nella directory di lavoro
per STEP 5. | punti interrogativi contenuti nei nomi dei file rappresentano caratteri
che I'operatore puo scegliere a proprio piacere.

Vie Impostazioni

S5 MEMORY.DAT Memoria per i val. ultimamente introdotti nei box di comando e di scelta.
S5@@@@CF.INI (STEP 5 Configuration File) Qui sono definiti la via ed il nome del file

Lista di attribu-
zione

Emissione
stampante

25-10

Dati definiti nella maschera Impostazioni.

File programma STEP 5

Lista di attribuzione sequenziale.
Lista errori di attribuzione: elenco degli errori di traduzione del file

File simbolico, lista di attribuzione tradotta.
Lista di attribuzione-File indice (# = 1 oppure 2).
Memorizzazione dell'assegnazione tasti funzionali

Parametri stampante.

File piedinatura (80 caratteri)
File piedinatura (132 caratteri)
Protocollo di stampa in un file

(Lista riferimenti) Lista incrociata (File LI)
Istruzioni di comando (submit)

Lista errori submit

Macrodefinizione dei tasti

File via. Qui vengono memorizzate le vie editate.

STEP 5/ST V7.0
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25.5 Limiti parametri e blocchi disponibili

Blocco Limiti dei parametri Annotazione
Nome Sigla Introd./ Rich.
STEP5 |em. sul nel
PG prog.
Blocco organizzativo OB 1-39 0 - 255 | Max. 4096 segmenti per blocco:
Blocco di programma PB 0-255 0-255 |~ Iungh. max. 4096 Kw per blocco
— 256 istruzioni per segmento
Blocco sequenziale SB 0-255 0- 255
Blocco funzionale FB 0-255 0-255
Blocco funzionale esteso | FX 0-255 0-255
Blocco di dati DB 0-255 0-255 |- max. 2048 DW per blocco
(senza intestazione)
Blocco di dati esteso DK 0-255 0-255 |_ max (6 + 256) + 40 blocchi per file S5D
B. di commento sul’ OB | OK 1-39 - — grandezza: max. 16 Kb
B. di commento sulPB | PK 0-25% |- — max.(6+ 256) + 40 blocchi per file S5D
B. di commento sul SB SK 0-255 -
B. di commento sul FB FK 0-255 -
B. di commento sul FX FKX 0-255 -
B. di commento sul DB DK 0-255 -
B. di commento sul DX DKX 0-255 -
Comm. di segm. sul’'OB [#OBDO |0 -39 - — grandezza: max. 16 Kb
Commento di segm. sul [#PBDO |0 - 255 - 8 Kw
PB per blocco
— max. 255 blocchi per file S5D
Commento di segm. sul |#SBDO |0 - 255 -
SB
Commento di segm. sul | #FBDO |0 - 255 -
FB
Comm. di segm. sul FX [#FXDO |0 - 255 -
Comm. di segm. sulDB [#DBDO |0 - 255 -
Comm. di segm. sul DX [#DXDO |0 - 255 -
Commento di impianto #Nome |#emax. |—
8 car.
Blocco di immagine BB 0-255 - Funzione AG

Grandezza massima del file S5D : 4 Mb

KOP + FUP: max. 400 elementi di immagine per blocco, max. 50 righe / 8 colonne

STEP 5/ST V7.0
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A.1 Assegnazione tastiera

Sommario

Tasti assegnati in
modo dinamico
(tasti funzionali)

Tasti assegnati in
modo fisso

Latastiera di un Personal Computer € assegnabile in modo variabile, cioé i tasti corri-
spondono di volta in volta alle funzioni associate al software attivato. Questo vale an-
che per il software STEP 5:

non appenaviene caricato il pacchetto STEP 5, i tasti assumono particolari significati.
Si puo disinguere tra due tipi di tasti:

* tasti assegnati dinamicamente (tasti funzionali), e

* tasti assegnati in modo fisso

| tasti da F1 a F8 sono i cosiddetti tasti funzionali. A seconda del livello software in
cui si trova, a questi tasti vengono assegnate le funzioni possibili e neccessarie in
quel punto. | tasti funzionali vengono evidenziati nei menu nella parte inferiore del
video. A volte questi tasti hanno una doppia assegnazione: tasti funzionali da F1 a
F8e da SHIFT F1a SHIFT F8.

A tali tasti sono associate sempre le stesse funzioni, per esempio le funzioni help o
il comando cursore nel pacchetto STEP 5. Essi possono essere utilizzati anche in-
sieme ai tasti SHIFT, ALT e CTRL.

All Assegnazione tastiera KOP/FUP

Tabella A-1  Tasti di comando funzione

Funzione Tasto Emissione Editazione Note
del tasto
HELP Visualizzazione sul vi- | Visualizzazione di infor- | Anche con— SHIFT F8
deo di un testo di aiuto | mazioni di aiuto
Hardcopy Emissione su stam- Emissione su stampante
pante o su file del con- | o su file del contenuto
tenuto del video del video
Meta video Inibito Nuova emissione del con- | In Editazione anche sotto Extra = SHIFT F7 e
@ tenuto dello schermo con | F2 = Nuova emissione
ottimizzazione
Zoom CTRL Inibito Passaggio in "correzione | In Emissione solo presente sotto F1. In
simbolica” Editazione anche sotto Extra =SHIFT F7
e F2 = Simb. vis.
Editazione Passaggio in editazione | Inibito In Emissione anche sotto F6.
(CORREZIONE)
Commento Passaggio in introdu- | Come "Emissione” In Emissione e Editazione anche sotto
segmento zione commenti e SHIFT F6.
quindi definizione del ti-
tolo 0 commento seg-
mento.

A-2

STEP 5/ST V7.0
C79000-G8572-C920-02



Appendice

Tabella A-1  Tasti di comando funzione, continuazione
Funzione Tasto Emissione Editazione Note
del tasto
Inserimento Prima del segmento at- | Inibito In Emissione anche in Funzioni segmento
segmento @ tuale viene inserito un sotto F5 = Inserisci In Funzioni segmento il
altro segmento. Nel far segmento viene "annotato” nel file di buf-
cio viene visualizzata fer.
una pagina vuota e Si
passa in Editazione.
Cancellazione SHIFT | Cancellazione del seg- | Inibito In Emissione anche in Funzioni segmento
segmento mento. Nel far cio il sotto SHIFT F4. In Funzioni segmento il
@ segmento non viene segmento viene "annotato” nel file di buf-
"annotato”. fer.
Tabella A-2  Tasti di chiusura
Funzione Tasto Emissione Editazione Note
del tasto
Annulla Ritorno al richiamante. | Le modifiche all'interno | Lasciando Editazione, il segmento viene
(ESC) @ di un campo possono visualizzato nel vecchio stato. Se il seg-
essere interrotte. Altri- mento € stato introdotto Ex novo”, viene
menti il ritorno avviene | visualizzato quello precedente. Tasto an-
dopo "Emissione”. | che come F8.
nuovi segmenti introdotti
vengono cancellati.
Conferma Memorizzazione del Memorizzazione del Tasto anche come F7.
> Insert blocco visualizzato se & | segmento editato. Vi-
stato modificato. Ri- sualizzazione del se-
torno al richiamante. gmento elaborato.
Tasto di Inibito Conclusione del procedi-

introduzione

mento d'introduzione per
i campi definiti. Se ci
SONO ancora campi vuoti
0 non definiti, il cursore
si sposta sul campo
verso destra.

Fine
segmento
(ENTER)

@ [ [k

Dopo il segmento vi-
sualizzato viene inserito
un altro segmento. Nel
far cio viene visualiz-
zata una pagina vuota
e sipassain
Editazione.

Acquisizione del seg-
mento appena editato
ed apertura del seg-
mento successivo.

In Editazione anche sotto F6.

STEP 5/ST V7.0
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indietro di una
pagina

Tabella A-3  Tasti di comando
Funzione Tasto Emissione Editazione Note
del tasto
Scorrimento Scorrimento del seg- Come Emissione Nei box di scelta sempre scorrimento di
indietro mento visualizzato di una pagina.
(Page up) una riga verso l'alto.
Scorrimento Scorrimento del seg- Come Emissione Nei box di scelta sempre scorrimento di
avanti mento visualizzato di una pagina.
(Page down) una riga verso il basso.
Scorrimento SHIFT Scorrimento del seg- Come Emissione

mento visualizzato di
una pagina verso il
basso.

Scorrimento SHIFT Scorrimento del seg- Come Emissione

avanti di una mento visualizzato di

pagina una pagina verso l'alto.

Segmento Viene visualizzato il Salto alla fine della riga | In Emissione anche in Funzioni segmento

successivo @ segmento successivo. | attualmente elaborata. | con F2.

Segmento Viene visualizzato il Salto all'inizio della riga

precedente @ segmento precedente. | attualmente elaborata.

Fine seg- SHIFT Inibito Salto alla fine del se- In Emissione anche in Funzioni segmento

mento @ gmento visualizzato. con F2.

Inizio seg- SHIFT Inibito Salto all'inizio del se-

mento gmento visualizzato.

Fine campo = Inibito Salto alla fine del campo

introduzione P TAB d'introduzione sul quale
si trova il cursore.

Inizio campo | SHIFT Inibito Salto all'inizio del campo

introduzione — d'introduzione sul quale

= TAB si trova il cursore.
+

Inserimento Inibito Ampliamento del seg- Non permesso sul margine sinistro di un

orizzontale @ mento di una colonna segmento KOP. In Editazione anche sotto
dalla posizione del cur- | SHIFT F7 = Extra, come F6 = Ins. orriz.
sore.

Inserimento Inibito Ampliamento del seg- Non permesso nelle prime due righe di un

orizzontale @ mento di una colonna segmento KOP.

dalla posizione del cur-
sore.
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Tabella A-3  Tasti di comando, continuazione

alla sinistra dell'attuale.
Alla fine di una riga si
salta alla prima posi-
zione della riga stessa.

d'introduzione € possible
selezionare la posizione
a sinistra del cursore
corto.

Funzione Tasto Emissione Editazione Note
del tasto
Cancellazione Inibito Cancellazione del carat-
carattere tere sul quale & posizio-
sotto cursore nato il cursore.
Cancellazione SHIFT Inibito Cancellazione di un in-
campo par- tero campo parziale.
Ziale
Cancellazione Inibito Cancellazione di un sin-
carattere e golo carattere a sinistra
del cursore.
Cursore a de- Posizionamento sul Come Emissione. Inoltre
stra campo di introduzione | all'interno del campo
alla destra dell'attuale. | d'introduzione & possible
Alla fine diunarigasi | selezionare la posizione
salta alla prima posi- a destra del cursore
zione della riga stessa. | corto.
Cursore a si- Posizionamento sul Come Emissione. Inoltre
nistra campo di introduzione | all'interno del campo

Cursore verso
I'alto

Posizionamento sul
campo di intr. al di so-
pra del cursore allun-
gato.

Come Emissione

Cursore verso
il basso

Posizionamento sul
campo di intr. al di sotto
del cursore allungato

Come Emissione

[9))

= G
@

\{

Cambio nel Come cursore a Viene attivata I'edita-
campo di in- destra zione per la modifica del
troduzione campo di introduzione.
In questo cambio di
modi, i campi d'introdu-
zione non definiti ven-
gono cancellati. Questo
tasto conclude il campo
di introduzione e con-
duce nel campo posizio-
nato a destra.
Cambio nel SHIFT Come cursore a Conclude il campo di in-
campo di in- sinistra troduzione e conduce
troduzione nel campo posizionato a
successivo sinistra.

STEP 5/ST V7.0
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Tabella A-4  Tasti speciali

per primo dopo la sele-
zione di un campo di in-
troduzione, quest'ultimo
viene contrassegnato
come non definito.

Funz. del Tasto Emissione Editazione Note
tasto
Connettore = Inibito Introduzione di un con- [ Anche F5 = Oper. bine F4 = #
F9 nettore nella posizione
attuale del cursore.
Connettore SHIFT Inibito Introduzione di un con- | Anche F5 = Oper. bin. e F5 =/.
negato = F9 nettore negato nella po-
sizione attuale del cur-
sore.
Non definito ? @ Inibito Premendo questo tasto

STEP 5/ST V7.0
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Al2

Sommario

Assegnazione tastiera in AWL

Diseguito vengonoillustrate solo le assegnazionidellatastierache hanno unadiversa
funzionerispetto alle assegnazioniin KOP e FUP. Tutte le altre assegnazioni sitrovano
sotto — Assegnazione tastiera KOP/FUP.

Tabella A-5 Assegnazione tasti AWL

Funz. del tasto

Tasto

Emissione

Editazione

Note

Annulla (ESC)

Ritorno al richia-
mante.

Cancellazione del segmento appena
introdotto.

Cambio segmento

Cambio del modo di

Come Emissione

Anche SHIFT F4

QROIO

tolo segmento e,
premendo una se-
conda volta, al com-
mento segmento/
blocco.

(Meta video) rappresentazione

tra commenti di ope-

randi e di istruzioni.
Commento Passaggio in Come Emissione In Emissione anche
segmento "Editazione” del ti- sotto SHIFT F6.

campo di introdu-
zione precedente

Cursore a destra Inibito Spostamento a destra all'interno del campo
di introduzione. Alla fine del campo si salta
alla prima posizione del campo di introdu-
zione successivo.
Cursore a sinistra Inibito Spostamento a sinistra all'interno del campo
di introduzione. Alla fine del campo si salta
alla prima posizione del campo di introdu-
zione successivo.
Passaggio al SHIFT Inibito Spostamento al campo di introduzione AWL
campo di introdu- successivo.
zione successivo
Passaggio al SHIFT Inibito Spostamento al campo di introduzione AWL

precedente.

STEP 5/ST V7.0
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A.2 Istruzioni operative in breve

Box di comando

Progetto

Impostazioni

Schede

A-8

La maggior parte delle funzioni selezionabili, prima di essere attivate, devono essere
parametrizzate. Perfarcio, dopoil richiamodellafunzione vengono visualizzatii cosid-
detti box di comando e di scelta.

In questi box ci si puo spostare con il mouse oppure tramite i tasti cursore ed il tasto
TAB. Su alcuni campi (evidenziati con "reverse”) tramite il tasto F3= Sceglié possibile
richiamare altri box di scelta.

Questo menu mette a disposizione funzioni con le quali diventa possibile organizzare
il programma ed i relativi file.

Tutte le impostazioni neccessarie per un programma devono essere qui definite e
quindi memorizzate nel cosiddetto file di progetto (*PJ.INI). Devono, per esempio,
essere impostati:

* |uogo di memorizzazione dei vari file
¢ file interessati

* rappresentazione (KOP/FUP/AWL)
¢ funzionamento

e parametri di stampa ecc.

Nei box di impostazione visualizzati vanno inseriti i file ed i parametri richiesti. Questo
box & suddiviso in schede.

| parametri impostati vengono prelevati dai box di comando e di scelta interessati.
Inunasedutadilavoro, ifile ed i parametriimpostati valgono per tutta la progettazione.

Nel box di impostazione ci si pud spostare con i tasti cursore oppure con il mouse.
Premendo due volte il tasto del mouse in corrispondenza dei vari parametri, o si apre
un box di scelta, o simodifica 'impostazione. Per raggiungere lo stesso risultato biso-
gna premere due volte il tasto F3.

STEP 5/ST V7.0
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Comandi di menu

File
Progetto

Imposta

Carica ... Viene caricato un file di questo tipo. Facendo cio tutte le impostazioni contenute
in questo file diventano valide. Le impostazioni presenti vengono sovrascritte.

Salva Memorizzazione nel file di progetto corrente (*PJ.INI) di tutte le impostazioni
fatte nei box Imposta.

Salva come ... Memorizzazione in un (nuovo) file di progettazione (*PJ.INI) selezionabile.

Blocchi Qui vengono gestiti i blocchi ed i file di documentazione che si trovano nel PG o
in AG. Sono a disposizione le seguenti funzioni:

Indice ... Emissione dell'indice (elenco del contenuto) sul dispositivo di emissione
(PG-AG) definito nella box di comando.

Trasferisci ... Trasferimento di blocchi e file di documentazione nelle direzioni:
file-file, file-AG, AG-file, AG-AG. Nei box di comando visualizzati si selezionano
le sorgenti e destinazioni desiderate.

Confronta ... Confronto tra singoli blocchi, tra singoli blocchi di un gruppo di blocchi oppure
tutti i blocchi di un file programma con un altro. E possibile confrontare: file-file,
file-AG, AG-file.

Cancella ... Cancellazione di blocchi su PG e AG, e di file di documentazione solo su PG.
Cancellazione iniziale dellAG.

Comprimi

File DOS Con questa funzione & possibile gestire file senza dover passare al livello del
sistema operativo. Nei box di comando visualizzati & possibile selezionare una
directory a scelta. Sono a disposizione le seguenti funzioni:

Indice ... Emissione dell'indice (elenco del contenuto) di una directory.

Copia ... Copia di singoli file o di gruppi di file.

Cancella ... Cancellazione di singoli file o di gruppi di file.

File PCP/M Con questa funzione & possibile elaborare i file PCPM.

Indice Nel box di comando Indice file PCPM viene visualizzato in una finestra, se-
condo quanto definito, un indice PCPM.

Copia Conversione di file PCPM in file S5-DOS ST/MT.

PCP/M ->DOS ...

Copia Conversione di file generati con S5-DOS ST/MT in file PCPM.

DOS -> PCP/M ...

Cancella | file PCPM su supporto di dati PCPM sono cancellati.

Comandi DOS Con questa funzione si salta nel livello dei comandi DOS.
Chiudi Lo STEP 5/ST viene concluso.

STEP 5/ST V7.0
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Editor

Blocco STEP 5 ...

Blocco dati ...
Maschere DB ...
Lista di attribuzione

Vie bus

Parametri stampante

Editor piedinatura

Test

Stato blocco

Stato variabile

Forza variabili

Forza uscite

Controllo
elaborazione ON

Controllo
elaborazione OFF

A-10

Tramite questo menu & possibile attivare i diversi editor.

Qui viene caricato ed attivato I'editor KOP/FUP o AWL. Viene visualizzato il box
di comando Edita blocchi STEP 5. In esso va selezionato un blocco. Subito
dopo viene visualizzato I'editor selezionato in Imposta.

Qui viene caricato ed attivato I'editor per blocchi dati.
Qui viene caricato ed attivato I'editor per maschere DB.

Subito dopo aver attivato questa funzione, viene richiamato I'editor per la lista di
attribuzione.

Questa funzione permette la generazione, la memorizzazione e I'attivazione dei
collegamenti non definiti punto-punto. Nel box di comando Scelta funzione/Pre-
disposizione bisogna attivare la generazione delle vie bus.

Definizione di un set di caratteri di comando specifici di una stampante che ven-
gono memaorizzati in un file stampante.

Generazione di un nuovo file piedinatura o modifica di uno gia esistente.

Tramite questo menu € possibile attivare funzioni di test, di informazione e di
messa in servizio che possono essere eseguite in funzionamento online del PG.
Condizione necessaria € un collegamento fisico e logico tra PG ed AG. Nei box
Imposta tale collegamento puo essere predisposto tramite Funzionamento.

Con questa funzione & possibile testare e modificare blocchi caricati in AG. Nel
box di comando STATO blocco va specificato il blocco da testare.

Con questa funzione & possibile visualizzare gli stati di segnale attuali degli
operandi selezionati, cosi come si vengono a trovare durante I'elaborazione del
programma nei vari punti di controllo di sistema. In una tabella vuota viene edi-
tata la lista degli operandi.

Questa funzione permette di modificare le variabili e di interagire con il pro-
cesso. In una tabella vuota viene editata la lista degli operandi.

Questa funzione permette di modificare le uscite con lo stato di segnale deside-
rato. In una tabella vuota viene editata la lista degli operandi.

Questa funzione fa in modo che I'elaborazione di un blocco avvenga a passi.
Nel box di comando Controllo elaborazione ON bisogna definire il blocco che si
vuole controllare e, con Ricerca I'operando che si vuole osservare.

Disattiva il controllo elaborazione.

STEP 5/ST V7.0
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AG

Start AG

Stop AG

Comprimi memoria
AG

Info AG:
REG. INT.

REG. BL.

Visualizza contenuto
memoria AG

Configura memoria
AG

Parametri di sistema
AG

Gestione

Genera XREF

Elabora EPROM

Interconnessione
automatica

Interconnessione
manuale

STEP 5/ST V7.0
C79000-G8572-C920-02

Questa funzione effettua un nuovo avviamento o un riavviamento del controllore
programmabile.

Questa funzione mette I'AG in stato STOP.

Questa funzione elimina i blocchi non validi presenti nella memoria dell’AG e
compatta quelli validi.

Trasmette informazioni circa lo stato del’AG collegato.

Sul video viene visualizzata una tabella contenente i valori attuali dei bit di con-
trollo. Con AG in STOP, il registro interruzione viene emesso per un’analisi delle
cause di errore.

Trasmette informazione circa l'indirizzo d'inizio del blocco valido e I'indirizzo di
ritorno relativo e assoluto nel registroblocco.

Vengono emessi sul supporto desiderato gli indirizzi assoluti del’AG con il loro
contenuto.

Fornisce informazioni circa la capacita ed il grado di riempimento della memoria
utente.

Visualizza sul video i parametri di sistema dell’AG.

Questo menu mette a disposizione una serie di funzioni che possono essere
richiamate in fase di editazione e test per la soluzione dei problemi che si ven-
gono a creare.

Le preimpostazioni delle singole funzioni devono essere state definite nei box
Imposta.

Questa funzione genera la lista di riferimenti (lista incrociata) del file programma
preimpostato. Dopo aver attivato questa funzione, la lista incrociata viene imme-
diamente generata.

Questa funzione provvede a trasferire (scrivere) programmi STEP 5 da un file
programma preimpostato in un modulo EPROM/EEPROM. Viene visualizzato il
box Predisposizione.

Un cambiamento automatico dei nomi degli operandi avviene definendo una
lista di attribuzione modificata o nuova. Viene visualizzato il box di comando
Interconnessione automatica. Qui puo essere definito il nuovo file programma
ed il nuovo file simbolico. La funzione viene eseguita senza ulteriori richieste.

Il cambiamento dei nomi degli operandi viene eseguito in modo interattivo in
una lista di operandi. Viene visualizzato il box di comando Interconnessione
manuale. Qui puod essere definito il nuovo file programma. Quindi, in una tabella
vuota, vengono introdotti interattivamente gli operandi.
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Liste di attribuzione

Questa funzione elabora le liste di attribuzione neccessarie al programma appli-
cativo per l'indirizzamento simbolico degli operandi.

Converti Converte il file sequenziale nel file simbolico assegnato. Nel box di comando
SEQ >INI ... Converti SEQ > INI bisogna introdurre il nome del file da convertire.

Converti Converte il file simbolico nel file sequenziale assegnato con ordinamento a

INI >SEQ ... scelta secondo operandi assoluti o simbolici. Nel box di comando Converti INI >

SEQ bisogna introdurre il nome del file da convertire ed il criterio di ordina-
mento.

Correzione INI ... Permette la modifica del nome del file simbolico da correggere. Nel box di co-
mando Correggi INI” bisogna introdurre il nome del file simbolico da correggere.

Quindi diventa possibile correggere interattivamente il file simbolico.

Converti File simbolici generati con precedenti versioni (V1.0, V2.0) possono essere con-
V1.x vertiti.
V2.X...
Cancella SEQ ... Permette la cancellazione di un file sorgente sequenziale.
Cancella INI ... Permette la cancellazione dei file simbolici (*20.INI, *Z1.INI, *Z2.INI).
Emetti lista Emette la lista di errori eventualmente generata in fase di conversione.
errori ...
Converti ... Con questa funzione i dati di progetto vengono convertiti dal formato dello
STEP 5/ST versione 6.x al formato della versione 7.x.
Lingua ... Selezionare la lingua desiderata.

Imposta colori Qui & possibile modificare i colori del video.

Documentazione

Blocchi STEP 5... Vengono emessi blocchi di un file programma nella rappresentazione KOP, FUP
e AWL, con o senza riferimenti incrociati. Cio che si vuole emettere, viene selezio-

nato nel box di comando visualizzato Emetti blocchi STEP 5.
Blocchi dati...
Maschere DB...

Vengono emessi a scelta singoli blocchi dati o tutti i blocchi dati di un programma.

Vengono emesse i blocchi dati che contengono le maschere. Selezionare i blocchi
nel box di scelta visualizzato Emetti maschere DB.

Viene emessa la lista di attribuzione. Selezionare nel box di scelta visualizzato Vi-
sualizza lista attribuzione, il file sequenziale, qualora non sia ancora impostato.

Lista di attribuzione...

Struttura
programma...

Vengono emesse le sigle di richiamo dei singoli blocchi. Selezionare nel box di co-
mando visualizzato Emetti struttura programma i blocchi desiderati.

Lista incrociata... Si genera una lista incrociata da un file programma esistente. Selezionare nel box
di comando visualizzato Emetti lista incrociata gli operandi desiderati. Non deve

esistere un altro file di riferimenti incrociati.

STEP 5/ST V7.0
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Tabella occupazione...

Ordine globale...

Viene emessa una tabella di occupazione. Selezionare nel box di comando visua-
lizzato Emetti tabella occupazione i campi degli operandi desiderati.

Viene emesso, senza interruzione, quanto segue: struttura programma, tabella oc-
cupazione, lista incrociata.

Emissione
confortevole

Blocchi ...

Maschere DB 1...

Lista blocchi ...

Lista di
attribuzione ...

Struttura
programma ...

Lista
incrociata ...

Tabella di
occupazione ...

Tabella occupazio-
ne
merker S ...

Lista di
controllo ...

File di testo ...

Questa funzione, nota finora con il nome KOMDOK, permette di documentare i
programmi STEP 5 in modo piu completo e piu automatico (tramite le istruzioni
di comando). L'emissione, diversamente dall’ Emissione standard, viene elabo-
rata graficamente. Tramite le istruzioni di comando & possibile realizzare una
sequenza di emissioni.

Emissione di blocchi di un file programma in rappresentazione KOP, FUP e
AWL, con o senza riferimenti.

Con questa funzione vengono emessi su stampante o su file i blocchi dati che
contengono le maschere.

Emissione di una lista di tutti blocchi (di programma e dati) del file programma
impostato.

Emissione di una lista di attribuzione in forma sequenziale (come editata) op-
pure ordinata secondo gli operandi assoluti o simbolici.

Emissione dei richiami dei singoli blocchi di un file programma.

Emissione secondo certi criteri dei riferimenti di una lista incrociata presente.

Emissione della tabella di occupazione. Essa fornisce una panoramica in forma
di tabella di quale bit & occupato nei byte dei campi di operandi M, E, A.

Con questa funzione viene emessa la tabella di occupazione dei Merker S.

Questa funzione ricerca i dati di progettazione. Secondo le opzioni vengono
emessi: operandi liberi, nomi simbolici mancanti degli operandi E/A/M.

Emissione di file *LS.INI o di altri file ASCII a piacere.

Istruzioni di comando

Edita ...
Test ...

Emetti file
protocollo ...

Esegui ...

STEP 5/ST V7.0
C79000-G8572-C920-02

Tutte le emissioni confortevoli possono essere realizzate tramite istruzioni di
comando. Tali istruzioni vengono gestite come un programma, memorizzate in
un file ed eseguite tramite il richiamo di tale file.

I singoli file di istruzioni di comando possono essere richiamati anche da un’ap-
posita istruzione contenuta in una sequenza di istruzioni di comando. Cio per-
mette la realizzazione di sequenze di istruzioni (strutture) a piacere.

Editazione di istruzioni di comando e loro memorizzazione in un file.

Vengono verificate le istruzioni di comando in un file selezionabile, per quanto
concerne la loro funzionalita. Gli errori esistenti vengono segnalati e memoriz-
zati in un file errore.

Con questa funzione & possibile emettere il file di protocollo, che & stato memo-
rizzato durante il test.

Elaborazione delle istruzioni di comando contenute in un file.
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Emetti... E’ possibile emettere su stampante il contenuto di un file istruzioni di comando.
Edita Questa funzione fornisce informazioni circa le combinazioni tra i vari file di istru-
struttura zioni di comando. E possibile editare i singoli file di istruzioni di comando.
Emetti struttura... Viene emessa su stampante o su file (*LS.INI), in formato DIN A3 o DIN A4, la

struttura di file istruzioni di comando accoppiati tra loro.

Passaggio ad altri pacchetti S5. Tali pacchetti devono essere installati su un

Cambio N
drive ed in una directory a piacere. E possibile passare ad uno dei pacchetti S5
li visualizzati, abbandonando l'interfaccia operatore STEP 5. Da ogni pacchetto
€ pero possibile tornare all'interfaccia operatore STEP 5.
COM DB1 Cambio nel software di parametrizzazione COM DB1, che consente una para-
metrizzazione confortevole e corretta delle CPU della fascia medio-bassa.
AWL Batch Cambio nel pacchetto software Editor AWL/Batch Compiler
Altri ... Nel box di comando Altri & possibile scegliere il pacchetto S5 al quale si vuole
passare.
Help
Lista assegnazione Informazioni circa i cosiddetti Tasti veloci. Essi sono tasti funzionali che permet-
tasti ... tono il richiamo diretto di certe funzioni.
Info versione Informazioni sulla versione STEP 5 presente.
STEP S5 ...
Versione pacchetti Visualizzazione di una lista delle singole parti di programma del software
STEP S ... STEP 5.
Informazioni sull’'uso Questo comando di menu offre una descrizione delle opportunita disponibili per
trovare determinate informazioni nell’'Help.
Guida ai menu Aiuti e avvertenze sull’'uso dei menu

Guida alle finestre  Aiuti e avvertenze sull'uso delle finestre di dialogo
Guida alle schede Aiuti e avvertenze sull’'uso delle schede

Indicazioni generali  Informazioni generali sull’'uso

Compatibilita Avvertenze sulla compatibilita dello STEP 5/ST versione 7.0 rispetto alle
versioni precedenti.
Informazioni har- Avvertenze su particolari argomenti.
dware

STEP 5/ST V7.0
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A.3 Macrodefinizione dei tasti

Sommario

Selezione

Esecuzione

Elaborazione di
macro

Macro di startup

Particolarita

STEP 5/ST V7.0
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ConilprogrammaMacrodefinizione deitasti & possibile specificare nell’editor dibloc-
chi delle sequenze di tasti che vengono memorizzate nel file S5 *TP.INI. Questo file
sitrova sul drive su cui é statoinstallato lo STEP 5, cioe nelladirectory che € impostata
per questo drive in Imposta, capitolo 4.1.1.

La selezione dei file delle macro tasti per la registrazione o I'esecuzione della macro,
viene effettuata in finestre di dialogo nella lingua selezionata per STEP 5.

L'esecuzione della macro tasti pud avvenire in passi. Nella finestra di dialogo si pos-
sono inoltre assegnare alla macro un breve titolo e un commento ed eventualmente
modificarli in seguito. Per consentire una selezione rapida, il nome del file e il titolo
della macro tasti vengono visualizzati in una finestra di dialogo. Il file della macro puo
essere memorizzato in una directory qualsiasi.

Quando sielaboraunamacro (lasiregistra o esegue) nell'angolo in alto a destra viene
visualizzato il tipo di funzionamento in inglese. Possono comparire le seguenti
indicazioni:

REQU  Request richiesta di elaborazione della macro
RECI Record Init inizializzazione della registrazione
REC Record registrazione

RECA  Record Abort interruzione della registrazione
RECE Record End fine della registrazione

PLAI Play Init inizializzazione dell’esecuzione
PLAY Play esecuzione

PLAA Play Abort interruzione dell’esecuzione

PLAE Play End fine dell’esecuzione

Lamacro conilnome START@TX.INI costituisce un’eccezione. Questa macro, detta
di startup, viene avviata automaticamente dopo che é stato richiamato STEP 5/ST,
a condizione che nella directory home si trovi il file della macro tasti START@TX.INI.
Se necessario la macro startup puo essere creata dall’'utente.

A causa delle modifiche apportate all'interfaccia utente di STEP 5/ST e del nuovo for-
mato diregistrazione, le macrotastidi STEP 5/ST non sono compatibilicon laversione
6.6.

Gli hotkey (CTRL- A, CTRL- E, CTRL- D) utilizzati nella versione 6.6 non vengono
pit impiegati per le funzioni delle macro tasti (registrazione, esecuzione).

Se si utilizzano gli hotkey, osservare la loro assegnazione dipendente dalla lingua
scelta.

Durante la registrazione non e possibile utilizzare STEP5/SR con il mouse.

A-15



Appendice

Tabella A-6  Uso delle macro tasti

Macro tasti

Significato

CTRL+ALT+D

Attivando questo hotkey in “modo normale” (il tipo di funzionamento non viene
visualizzato) si apre la finestra di dialogo “Scegli macro”. Puo essere selezio-
nata una macro da registrare o da eseguire.

CRTL+ALT+D

Attivando questo hotkey durante la registrazione di una macro (viene visualiz-
zato il tipo di funzionamento “REC”) si conclude la registrazione di una macro.

ESC

Attivando questo hotkey durante I'esecuzione di una macro (viene visualizzato
il tipo di funzionamento “PLAY”) si interrompe I'esecuzione della macro tasti.

CRTL+ALT+T

Se nella finestra di dialogo “ Scegli macro” e stata selezionata I'apposita op-
zione, con questo hotkey e possibile eseguire la macro in passi(ovvero tasto
per tasto). L'esecuzione di ogni passo deve essere confermatacon la combina-
zione di tasti CRTL+ALT+T .Questa funzione €& utile per controllare la funziona-
lita delle macro tasti. Il tipo di funzionamento in passi non viene visualizzato
separatamente.

Consigli per I'uso
delle macro tasti

Registrazione di co-
mandi attivabili con
i tasti nell'interfac-
cia utente

A-16

L'impiego delle macro tasti & consigliato per le sequenze di tasti ricorrenti all'interno
degli Editor. Le procedure automatiche deimenu e delle finestre didialogo con passag-
gio ad altri pacchetti funzionano correttamente solo se le condizioni presenti durante
I'esecuzione sono ugualia quelle presenti durante laregistrazione. Per questo motivo
si consiglia di limitarne I'uso a piccoli task di cui siano chiare le condizioni preliminari.

Per I'uso delle macro tasti attenersi a quanto segue:

Punto iniziale centrale

Definire pochi punti iniziali all'interno dei pacchetti dai quali si inizia la registra-
zione o I'esecuzione della macro tasti e documentarli nel commento della ma-
cro tasti.

Esempi di punti iniziali tipici:

Allinterno dei menu Voce di menu FILE non aperta
All'interno degli editor Modo correzione

Selezione rapida:

Definire lo scopo della macro tasti nel nome della macro stessa.In questo
modo é possibile rendere piu rapida la selezione nel campo “Scegli macro”.

Punto iniziale corretto o condizioni necessarie:

Documentare nel commento della macro tasti il punto iniziale o le condizioni
necessarie (es. AWL) per I'esecuzione della macro tasti.

Menu

All'interno dell'interfaccia utente limitarsi ai seguenti comandi:

ALT+< lettera> per passare nel menu corrispondente

<lettera>  per selezionare un’opzione nel menu scelto

Tasti di scelta rapida (tasti funzione combinati con UNSHIFT, SHIFT, CTRL e ALT)
per entrare direttamente nelle opzioni di menu pit importanti.

Per i comandi dell'interfaccia utente non usare i tasti di comando dello schermo (cur-
sore, tabstop ecc.).

Finestre di dialogo

Per i comandi all'interno delle finestre di dialogo non usare i tasti di comando dello
schermo (cursore, tabstopecc.). Durante laregistrazione non utilizzare caselle disele-
zione (contrassegnate daunacroce).Primadellaregistrazione dellamacro é necessa-
rio selezionare tutte le caselle delle finestre di dialogo.

STEP 5/ST V7.0
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Controllo delle macro tasti:

Dopo aver creato una macro tasti € possibile controllarne il funzionamento eseguen-
dola nel modo in passi.

Avvertenza

La registrazione o I'esecuzione vengono interrotte quando si selezionano altri
pacchetti con le voci di menu

“Passa ad altri ..."”, “AWL Batch”, “COM DB1” e “Comandi DOS” e vengono pro-
seguite alla chiusura dei pacchetti.

Editor di tasti

In STEP 5/ST é possibile modificare le funzioni assegnate ai tasti utilizzando I'editor
di tasti. Se sono stati generati i file S5K, occorre attenersi alla sequenza di ricerca.

Vengono forniticome esempioifile tasti STEP5.S5K e S5KXS06X.S5K nella directory
disistema\S5_INST. Questifile possono essere modificati dall’'utente mediante I'edi-
tor di tasti, dopo essere stati copiati nella directory home.

All'avvio di STEP 5/ST viene caricato il file tasti STEP5.S5K per la versione STEP
5/ST e il file S5KXS06X.S5K per la versione STEP 5/ST V 6.x (adattatore COM).

Lamaggior parte deitasti funzione possono essere modificati mediante I'editor di tasti.

Avvertenza

Assicurarsi che non venga assegnata alcuna funzione alle combinazioni di tasti
ALT—<numero> e ALT—<lettera> . Questi tasti vengono gia impiegati nel pac-
chetto STEP 5 e non sono utilizzabili per altre funzioni macro.
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A.4 Regole di programmazione

Sommario In questo capitolo vengono descritte alcune regole di programmazione per passare
dauntipodirappresentazioneall’altro (KOP, FUP, AWL). Non e infattisempre possibile
tradurre in KOP o FUP un blocco di programma scritto in AWL. Lo stesso vale anche
per la commutazione tra i due tipi di rappresentazione KOP e FUP.

AWL

Figura A-1  Tipi di rappresentazione del liguaggio di programmazione STEP 5 e
limitazioni

Avvertenza
| programmi scritti in KOP e FUP, sono sempre traducibili in AWL.

A4l Introduzione grafica in KOP e FUP
Introduzione in Un concatenamento eccessivo durante I'introduzione in KOP puo superare i limiti
KOP, emissione in del video durante I'emissione in FUP.
FUP
KOP
—INGR. 1 —INGR. 2 — INGR. 4— INGR. 6 —USCITA
Ly ] | | | | | | |
“néra | || ||
—INGR. 5
—INGR. 7
|
‘ T T T

Figura A-2  Esempio di un concatenamento durante I'introduzione in KOP

STEP 5/ST V7.0
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Introduzione in
FUP, emissione in
KOP

Uscita di una fun-
zione complessa

STEP 5/ST V7.0
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— USCITA

Figura A-3  Esempio del concatenamento sopra rappresentato durante l'introdu-

zione in FUP

Un numero eccessivo di ingressi in una casella FUP provoca il superamento dei
limiti del video (8 liveli) in KOP.

FUP
—INGR.1 —
—-INGR.2 —
—-INGR.3 —
—-INGR.4 —
-INGR.5 —
—INGR.6 —
-|NgR.$ _ __ - USCITA
Figura A-4  Esempio di un concatenamento durante I'introduzione in FUP
KoP
—INGR.1 —INGR.2 -INGR.3 -INGR.4 —INGR.5 —INGR.6 —INGR.7-USCITA
— e e e e e e e
Figura A-5  Esempio di un concatenamento durante I'emissione in KOP
L'uscita di una funzione complessa (memoria, comparaore, temporizzatore o
contatore) non puo essere ulteriormente combinata con un blocco OR.
- MERKER 1
—-INGR.1 g
-INGR.2 R Q
—INGR. 3 -USCITA
Figura A-6  Dopo una funzione complessa sono ammesse solo caselle AND
A-19
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Connessioni

A-20

Le connessioni sono memorie intermedie di appoggio che consentono di
risparmiare la ripetizione di combinazioni.

Per maggior chiarezza, le regole per le connessioni nel tipo di rappresentazione KOP
vengono qui separate da quelle per FUP. Alla fine del paragrafo diamo un esempio
di entrambi i tipi di rappresentazione.

Connessioni in KOP

KOP AWL
M... U M.
—(#>—  =M...

Figura A-7  Connessioni in KOP e AWL

Unaconnessione memorizzail risultato delle combinazioni delle operazioni, program-
mate a monte della connessione stessa. Percio valgono le seguenti regole:

Connessioni in serie

—AHHHOA -
AWL ‘U

U (

V)

Figura A-8  Connessioni in serie

Unaconnessione € in serie con altre connessioni. In questo caso laconnessione viene
trattata come un normale contatto.

Connessione in parallelo

KOP
—||——||—)_|-||—
o L

AWL UL ..
¢
o
UL
=M
U M
)
)
UL

Figura A-9  Connessioni in parallelo

All'internodiunramo parallelolaconnessionevienetrattatacome unnormale contatto.
Inoltre I'interno ramo parallelo deve essere chiuso tra parentesi di tipo O (...).

Un connettore non puo maistare immediatamente all’inizio diun montante (connettore
come primo contatto) oppure direttamente dopo I'apertura di un montante (connettore
come primo contatto in un ramo parallelo).

STEP 5/ST V7.0
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Connessione in FUP

FUP AWL
=M.
—#M...—
M...

Figura A-10 Connessione in FUP

Unaconnessione annota, come memoria intermedia, il risultato combinato delle com-
binazionibinarie amonte dellaconnessione stessa. Percio valgonole seguentiregole:

Connessione al primo ingresso di una casella AND o OR

FUP AWL
—H#M el & =M

|
|

Figura A-11 Connessione al primo ingresso

La connessione viene indicata senza parentesi.

Connessione non al primo ingresso di una casella OR

FUP AWL :0...
) 0 (
- VORVKP
=M.
VORVKP #M - ‘UM, ..
)

Figura A-12 Connessione non al primo ingresso

La combinazione globale binaria prima dell’ingresso viene racchiusa tra parentesi del
tipo O (...).

Connessione non al primo ingresso di una casella AND

FUP AWL :u...
- U (
- VORVKP
=M.
VORVKP #M  md = ‘U M...
2)

Figura A-13 Connessione non al primo ingresso

La combinazione globale binaria prima dell’ingresso viene racchiusa tra parentesi del
tipo U (...).
Consentito solo in FUP, non rappresentabile graficamente in KOP!

(Nella figura: VORVKP=combinazione precedente)
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AWL FUP —INGR. 1 —] &
—INGR. 2 —]
‘U —INGR. 1 —~MERKER 1 —]
:U —INGR. 2
: U — MERKER 1 —INGR. 3 — &
tU( —INGR. 4 —
U —INGR. 3 —MERKER 2 — >=1
: U —INGR. 4
:U — MERKER 2
:0
U —INGR. 5 —INGR. 5 — &
: )U — MERKER 3 — MERKER 3 —
:U - MERKER 4
1= — USCITA — MERKER 4 — — —USCITA
KOP
—INGR.1 -INGR.2 —-MERKER 1-INGR.3 -INGR.4 - MERKER 2 MERKER 4 USCITA
(I ; | I A ;
—ING‘R.S - MERKER 3
| |
‘ T T
Figura A-14 Esempio senza connessioni
AWL FUP
‘U ~INGR. 1
‘U ~INGR. 2 ~INGR.
(= — MERKER 1 ' ~INGR. #- MERKER 1__
U — MERKER 1} Connessione 1 H &
4(2:87:' ~INGR. 3 ~INGR. 3
U —INGR. 4 ~INGR. 4 #-MERKER 2—{521
o= —MERKER 2}Connessione 2
‘U — MERKER 2
eI U —INGR. 5 0( _inr. 5 #~MERKER 4
o= ~MERKER 3 Connessione 3 . # - MERKER 3) |- usciTA
‘U — MERKER 3
o= ~MERKER 41\, hessione 4
‘U — MERKER 4
o= — USCITA
KOP
~INGR.1 —INGR.2 —MERKER 1-INGR.3 —INGR.4 -MERKER 2-MERKER4 - USCITA
| | | | # | | | | | # # |
I ! [ ! [ ! [ ! !
—INGR.5 —MERKER 3
D
0o( )

Figura A-15 Esempio con connessioni
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A.4.2 Introduzione in AWL

Se sivuole convertire il programmain KOP o FUP, ci si deve attenere ad alcune regole
di programmazione. Se tali regole non vengono rispettate e si effetua una correzione
in KOP o FUP, durante la memorizzazione potrebbero sorgere degli errori che non
vengono segnalati dal PG.

Combinazione Nella combinazione AND gli operandi sono collegati in serie, lo stato dei segnali
AND delle operazioni U e UN viene interrogato e combinato secondo la funzione AND.
KOP ‘ KOP: Contatto in serie
FUP ﬂ FUP: Ingresso in una casella AND
AWL u.... AWL: Istruzione A...

Figura A-16 Connessione AND

AWL KOP FUP
| ~INGR.1 -INGR. 2 _INGR. 1
‘U —INGR.1
‘U —INGR.2 — _lNGR'ZM

Figura A-17 Connessioni AND in AWL,KOP, FUP

AWL KOP FUP
U —INGR. I ~INGR.1 —INGR.2 _INGR.1 o
U —INGR.2 . TINeR2 — :
0 —INGR.3 = >=1
0 ~INGR. 3
U —INGR. 4 T ~INGR.3 —
: - —INGR. 4
U INGR. 5 —INGR.4 —INGR.5 CINGR 5 &
U —INGR.1 ~INGR.1 —INGR.2 NGR.1 .
U —INGR.2 — Ner?
‘0 —INGR.3 o1
0 ~INGR. 3
.U —INGR.4 I ~INGR.3 ——
U -INGR.S ~INGR.4 —INGR.5 ::sgg-gq &

Figura A-18 Esempio di regola di combinazione AND

STEP 5/ST V7.0
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Combinazione OR

AWL

—INGR. 1
—INGR. 2

Interrogazione dello stato del segnale e combinazione secondo la funzione OR .

KOP: Solo un contatto in un ramo parallelo

FUP: Ingresso in una casella OR

AWL: Istruzione O...

—INGR. 3

-gcooce

—INGR. 4
—INGR. 5

_

KOP %‘ ﬁ }—'
FUP
AWL
KOP FUP
-INGR. 1 -INGR. 2 —-INGR.1 __ [& |
}_,_{ ‘7 —-INGR.2 | =1
NGR. 3
XS INGR. 3 e
—l . r —INGR.4 [ & |
‘G INGR. 5 —-INGR.5 |
\

R. 4
\
\

Figura A-19 Esempio di regola di combinazione OR
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Combinazione
AND prima di un
OR

1. ramo parallelo Success. ramol/i parallelo/i

wor pHH  brH

-1 & - &
FUP — - R — p— >—1
U O..
AWL U U
u..
KOP: Piu contatti in un ramo parallelo
FUP: Casella AND prima di una casella OR
AWL: Istruzioni O...
ramo parallelo u...
u...
AWL KOP FUP
—INGR.1 —INGR. 2
‘U ZINGR. 1 —INGR. 1
I——{— &
.U —INGR.2 — INGR. 2 = >=1
‘0 -INGR.3
O —INGR. 3
U —INGR. 4 — ~INGR. 3 —|
U -INGR.5 _INGR. 4 —_

—INGR. 4-INGR. 5 &

_I I 3 I I_ — INGR. 5 —

Figura A-20 Esempio relativo alla regola AND prima di OR
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Parentesi Questa regola riguarda la chiusura in parentesi di combinazioni binarie complesse
e di funzioni complesse precedute o seguite da combinazioni binarie.

U (

— COMBINAZIONE PREC. @ -

)
- ® — COMBINAZIONE SUCC:

Complesso

Combinazioni binarie complesse
A queste combinazioni appartengono le combinazioni OR prima di AND.

Combinazione OR prima di un AND

AWL U(
O..
O..
O..
)
u..

AWL: U(

Combinazione OR

)

U

KOP

=

KOP: Ulteriori collegamenti in serie di contatti in parallelo.

STEP 5/ST V7.0
A-26 C79000-G8572-C920-02



Appendice

FUP

>=1

]

FUP: Casella OR prima di una casella AND.

Queste combinazioni rappresentano un sottoinsieme delle combinazioni binarie com-
plesse. Due contatti in parallelo costituiscono la combinazione pit semplice.

Funzioni com- Per le funzioni complesse valgono le seguenti regole:
plesse (memoria,
temporizzazione,
comparatore, con- e Combinazione AND successiva: A (...).

tatore) o

¢ Nessuna combinazione successiva: nessuna parentesi

Combinazione OR successiva: O (...), solo per FUP.

¢ Una funzione complessa non pud avere combinaz. successive.

KOP / FUP
U (
—@— 1]
£8 ) e
EE
T S [—@—| COMBIN.SUCC.|
FUP
0(
—@—
) 21

Funzione
complessa

—@—| COMBIN. SUCC.| —

Figura A-21 Parentesi con funzioni complesse

Comparatori

Un confronto di numeri in virgola mobile & solo possibile in AWL.

STEP 5/ST V7.0
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Elementi com-

plessi, ingressi e

uscite non colle-
gati

In AWL, ingressi e uscite non collegati devono essere indicati con NOP 0. Per
ogni segmento & consentito un solo elemento funzionale complesso.

AWL
tU —INGR. 2
L DW 10
1SV T 100
"NOP 0
:NOP O
:NOP O
U T 100
1= — USCITA
: —INGR. 1
1 ZV — CONTAT.
:U —INGR. 2
1 ZR — CONTAT.
U —INGR. 3
L — VAL.
'S — CONTAT.
:NOP O
:NOP 0
:NOP O
:U — CONTAT.
1= — USCITA

—INGR. 2

KOP

T 100

DW 10

1nV
TW DU
DE

— USCITA

——+—C >—

—-INGR. 1

— CONTATORE

e

—INGR. 2

VA%

ZR

ZW DU
DE

— USCITA

20—+ C O>—

—INGR. 2
DW 10

—INGR. 1
—INGR. 2
—INGR. 3
- VAL.

T 100

1V

TW DU
DE

QL -uscITA

FUP

:BE

— CONTATORE

—ZW DU
DE

Qi

yAY
ZR
S

—USCITA

:BE

Figura A-22 Esempio di ingressi e uscite non collegati in AWL, KOP e FUP.
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Glossario

Accoppiamento

Blocchi funzionali
standard

Blocco

Blocco dati DB/DX

Blocco di
documentazione
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Collegamento diretto di due PG tramite cavo con connettori.

Blocchifunzionali gia programmati richiamabili per compiti definiti. Ad ogni blocco fun-
zionale standard & associato un numero di serie. Essi contengono funzioni complete
che vengono utilizzate sovente nei programmi applicativi.

Unblocco & una parte del programma applicativo limitata per motivi funzionali, struttu-
rali e di utilizzo. Nello STEP 5 si distingue tra blocchi contenenti istruzioni (OB, PB,
SB, FB/FX) e blocchi contenenti dati (DB/DX) oppure blocchi contenenti immagini
di configurazioni di dati (BB) che possono essere utilizzati nel programma, ma in cui
sono memorizzate, per esempio, liste di variabili per funzioni di test.

Contiene i dati (per esempio configurazioni di bit, valori costanti) con i quali opera il
programma applicativo. Dopo il suo richiamo, un blocco dati rimane "attivo” finché
ne viene richiamato un altro.

Contiene i commenti segmento associati ai vari blocchi (#0BDO.nnn, #PB..., #SB...,
#FB...) oppure, per i blocchi dati, un commento blocco (#DBDO.nnn).

- Blocco

Contiene programmi o parti di programma (sottoprogrammi), in particolare funzioni
che ricorrono spesso (- Blocchi funzionali standard), in forma di istruzioni STEP 5
(operazionifondamentali e supplementari). Un bloccofunzionale puo essere utilizzato
pit volte. Gli operandi attuali gli vengono forniti al momento del richiamo tramite la
lista di parametri.

Unbloccoimmagine memorizzail contenutodelvideo (operandi, variabilidi processo),
introdotto durante le funzioni di test STATO VARIABILI, FORZAMENTO e FORZA-
MENTO VARIABILI, - Blocco.

Contiene comandi STEP 5 (operazioni fondamentali), principalmente richiami di bloc-
chi. Gli OB vengono richiamati dal sistema operativo oppure dall’'utente. per
I'attivazione delle funzioni speciali e per reazione dell’AG. Gli OB sono parte del pro-
gramma applicativo e rappresentano un’interfaccia verso il sistema operativo.

Insieme di oggetti (caratteri/righe) contrassegnati (inizio/fine blocco) per un’elabora-
zione comune.

Finestradidialogo perladefinizione delle funzioni STEP 5daeseguire. Oltre alla defini-
zione dell'oggetto dell’elaborazione esiste la possibilita di selezionare opzioni circa
I'elaborazione e I'emissione del relativo elemento del programma.

Il box di comando e collegato (tramite "Scegl”) con un box di scelta, in cui & possibile
eseguire ricerche di blocchiffile.
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Finestradidialogo, richiamabile nelboxdicomando, perlaricercae selezione dioggetti
(blocchiffile) nei drive, directory e programmi da elaborare con una funzione STEP 5.

Memoriatampone cheinfase dieditazione memorizza partiselezionate diprogramma
o di testo per una successiva copia o trasferimento. La memoria viene sovrascritta
da operazioni successive.

Menu STEP 5 che rende possibilirichiamidi altri pacchetti S5 (per esempio GRAPH 5).
Il passaggio ad uno deipacchetti caricati o visualizzati nel box di scelta € sempre possi-
bile cosiccome il ritorno in STEP 5.

In ogni AG esistono tre campi di memoria: memoria utente, memoria di sistema (REG.
BL., REG. INT,, liste diindirizzi. contatori, temporizzatori. merker. IPI, IPU) e memoria
di periferia (indirizzi della periferia di processo).

Campo di operandi in KOP/FUP nel quale viene inserito I'operando con relativo tipo
e parametro, oppure in forma simbolica (con una lineetta). "Non definito” € un campo
di introduzione riempito con 9 punti interrogativi. "Non connesso” € invece un campo

diintroduzione acuinon é stato associato alcunoperando, mache pudrimanere vuoto.
Cancellazione di tutti i blocchi caricati nellAG.
Elemento funzionale

Lo STEP 5 offre molte possibilita di commenti che possono essere generati e memoriz-
zati insieme al relativo programma. | commenti non vengono mai trasferiti nel’AG.
Lo STEP 5riconosce commenti a livello di istruzione, di segmento e di impianto. Per
guanto concerneiblocchidati,nonavendo segmenti, sipud generare soltantoun com-
mento al blocco.

— | commenti istruzione, per DB/DX commenti riga (32 caratteri al massimo)
ed i titoli segmento (per DB titolo blocco) vengono memorizzati in un
blocco di commento (OK, PK, SK, FK).

— | commenti segmento, per DB/DX commento blocco, con 16 k caratteri al
massimo, vengono memorizzati in un blocco di documentazione (per
esempio #PBDO.nnn). Questi sono associati ai blocchi contenenti il pro-
gramma (PB, SB, FB ecc.) in modo fisso.

— Il commento impianto (spiegazioni relative al programma applicativo) viene
memorizzato in un file di documentazione S5 liberamente definibile
(#FILE-DOK, nome = max. 8 caratteri).

File di testo per il commento del programma applicativo. Esso non € legato ai blocchi.
Ilnome delfile deve iniziare con il carattere #. Gli altri caratteri sono liberamente sele-
zionabili.

Spiega l'istruzione AWL e viene memorizzato nel blocco di commento (OK, PK. SK.,
FK/FXK) insieme al commento segmento.

Puo essere introdotto nella lista di attribuzione per ogni operando simbolico. Introdu-
zioni e modifiche sono anche possibili direttamente nell’editor del blocco.

La cancellazione di un blocco nellAG comporta dapprima che tale blocco venga di-
chiarato "non valido” nella memoria utente. Anche la correzione di un blocco lascia
dietro di sé il vecchio blocco non modificato. La funzione STEP 5 "Test, Comprimi.
memoria” elimina nell’AG i blocchi non validi e compatta quelli validi.
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Funzione STEP 5 che visualizza sullo schermo la composizione ed il grado di riempi-
mento della memoria utente in AG.

Merkerdiappoggioche mantieneilRLC come memoriaintermediainmododarenderlo
utilizzabile in altri punti ed evitare combinazioni ripetute.

Nel corpo del blocco vengono memorizzate le istruzioni/connessioni suddivise in seg-
menti oppure i dati (nei DB).

Gli editor STEP 5 utilizzano un cursore grande (allungato) ed uno piccolo. Il cursore
allungato visualizzala posizione attuale di editazione nel campo di editazione. La sua
rappresentazione sotto forma di campo "reverse” corrisponde normalmente alla lun-
ghezza del campo di introduzione attuale. Il cursore piccolo si muove invece a livello
di carattere e serve per I'editazione locale nell’'ambito del campo di introduzione.

INKOP e FUP, ilcursore allungato supportala costruzione graficadel segmentotramite
mouse. Il cursore si muove nel reticolo del campo di editazione ad 8 colonne e 50
righe (= 2,5 volte I'altezza del video). Con "cursore piccolo” non é possibile I'utilizzo
del mouse.

Indice nel quale sono contenuti i nomi e riferimenti ai file, nonché le sotto-directorv
(- Box di scelta).

Con lo STEP 5 ¢ possibile operare anche tramite accoppiamento bus del PG. | file
vengono quindi dotati di attributi dal system manager: protetti contro la scrittura, non
protetti contro la scrittura oppure protetti contro la scrittura ed attuali. Questi diritti di
accesso ai programmi vengono definiti prima dell’editazione nel box "Imposta’.

I menu STEP 5 "Documentazione” permette I'emissione di blocchi di programma e
di elementi di programma su stampante o su file. Nella”Emissione Standard”, 'emis-
sione avviene cosi come editato, nella "Emissione confortevole” vengono aggiunti
degli elementi grafici supplementari (cornici) ed una piedinatura editabile.

Strumento software perlagenerazionedi - Blocchi,ognunosecondolaparametrizza-
zione definita nel box Imposta, in forma di lista istruzioni (AWL), schema a contatti
(KOP) o schema logico (FUP). Per la generazione di — Blocchidatio — Liste attribu-
zione vengono utilizzati editor speciali, cosiccome per la scrittura dei commenti seg-
mento e impianto.

Ilmenu STEP 5 "Editor’ permette I'accesso agli strumenti centrali per la generazione
di programmi con gli editor per blocchi che consentono la realizzazione di comandi
e lamemorizzazione di datirilevanti a livello di processo o di comando. Ulteriori editor
vengono automaticamente messi a disposizione durante |'utilizzo degli editor selezio-
nati.

Strumento per la creazione ed elaborazione di commenti segmento e operandi nei
blocchi di documentazione. Tali blocchi vengono richiamati tramite il box di comando/
scelta negli editor dei blocchi STEP 5 e blocchi dati.
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L'elemento funzionale (in KOP/FUP) costituisce I'insieme ingresso - elaborazione -
uscita di un comando e viene rappresentato simbolicamente da una casella con il
flusso di segnali condizioni - funzione - comando.

Lo STEP 5 riconosce elementi funzionali digitali, per esempio”&”, "= >", connettori,
temporizzatori/contatori ed elementi funzionali complessi con elaborazione a parole
(funzioni digitali), per esempio funzioni aritmetiche, di scorrimento o di conversione.
Gli elementi funzionali complessi sono anche denominati "casella”. A causa dei molti
tipi di operandi esistenti, una cascata di elementi funzionali digitali e complessi non
€ normalmente possibile.

Qui sitrovano programmi richiamabili sotto "Gestione” per scrivere, leggere e cancel-
lare i programmi applicativi su moduli EPROM/EEPROM.

Il file di documentazione (#NOME) contiene un commento globale indipendente dai
blocchi.

Nelfile SISID (Imposta, Pagina 1) sitrovanoidati di riconoscimento e le caratteristiche
di identificazione, per esempio per i processori di comunicazione (CP).

Lista di attribuzione degli operandi simbolici a quelli assoluti, memorizzata in un file
sorgente. | blocchi programmati con operandi simbolici, con 'aiuto del file simbolico
vengono automaticamente trasformatiin blocchi conindirizzamento assoluto in modo
che possano essere utilizzati dal processore.

Contiene i dati relativi alla stampante di emissione (formati, sequenze di controllo);
nome in "Imposta, Pagina 2’, *DR.INI; specificazione in "Documentazione, Imposta-
zioni”; memorizzazione in directory di sistema.

Memorizza una via bus selezionata (editata) con tutti i nomi di nodi e di indirizzi. Esso
vienerichiamato conilnome viadesideratodeltipo*AP.INI. I PG provvede poiautoma-
ticamente a realizzare la connessione selezionata.

Ilmenu STEP 5 "Gestione” offre funzioni che supportano la gestione del programma
applicativo (generazionediliste incrociate, interconnessione oppureridenominazione
di operandi, conversione di liste di attribuzione) e la scrittura di blocchi nei moduli
EPROM/EEPROM. Inoltre viene messo a disposizione un editor per la definizione
di file via per accoppiamento PG.

Per permettere all’editor di associare ad un segmento il relativo commento, esso ge-
neraautomaticamente una sequenzadi 7 caratteri conil simbolo $ come identificatore
di segmento (per esempio $ 11_@).

Se i campidi operandi E 0 A vengono utilizzati da istruzioni STEP 5, i bit non vengono
interrogati o modificati direttamente sull’'unita periferica, bensiin un campo particolare
della memoria di sistema nell’AG che contiene la cosiddetta immagine di processo.

L'immagine di processo degliingressi (IP1) e delle uscite (IPU) viene elaborata ed ag-
giornata ciclicamente della CPU. In fase di avviamento ed all’inizio di ogni ciclo, gli
stati di segnale delle unita di ingresso vengono trasferiti all'lPI. Alla fine del ciclo di
programma, la CPU trasferisce gli stati di segnale contenutinell’'lPU alle unita di uscita.
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Box di impostazione (2 pagine) nel menu "Oggetto” per definire un - Progetto per
guantoriguardainomideirelativifile diprogramma ed alla parametrizzazione dei modi
difunzionamento e di rappresentazione sul PG/PC. Tutte le operazioni nei vari editor
STEP 5 fanno riferimento al nome ed ai parametri preimpostati.

Con la funzione STEP 5 "Indice, nel File programma’ e "in AG” o "File", &€ possibile
emettere su stampante o su video I'indice di directory e file oppure la lista blocchi di
un file programma. Per ogni blocco viene evidenziato il tipo, il numero e la lunghezza
del blocco cosiccome il numero di biblioteca (non per AG).

Indica direttamente I'indirizzo fisico dellalocazione di memoria di un operando tramite
il quale si pud accedere a quest’ultimo.

Gliindirizzi iniziali di tutti i blocchi del programma applicativo sono memorizzati nella
lista indirizzi DB 0.

Attribuzione di altri indirizzi (anche nuovi) agli operandi del programma applicativo.
La funzione "Gestione, Interconnessione” provvede alla sostituzione dell’operando
in tutto il programma. L'attribuzione deve essere fatta una sola volta per ciascun ope-
rando nella lista. Viene modificato solo 'indirizzo e non il simbolo dell’operando.

Per i blocchi dati e quelli funzionali (DB/DX, FB/FX), lo STEP 5 genera un blocco di
intestazione supplementare coniformati dei dati utilizzati (DV/DVX) oppure coninomi
delle etichette di salto (FV/FVX). L'intestazione non viene trasferita né in AG, né sul
modulo EPROM/EEPROM.

La piu piccola unita di programma. Essa rappresenta un compito per il processore.
Unaistruzione € composta da una parte operazione e da una parte operando laquale,
asuavolta, € compostadaunasigla (per esempiodeltipo E,A, DW) e da un parametro
(per esempio 10.5, 25).

Lista generata dall’'utente nella quale agli operandiassoluti vengono associati dei sim-
boli significativi ed esplicativi, nonché dei commenti che possono poi essere utilizzati
in fase di editazione dei programmi.

La lista viene editata come file sorgente sequenziale (*20.SEQ) e, nel momento della
memorizzazione in fase di traduzione, genera il file simbolico (*Zn.INI, n =0, |, 2).

Viene generata dallo STEP 5 dal file programma preimpostato dopo la scelta (box
di comando) nel menu STEP 5 "Documentazione, Emissione”. La lista fornisce per
ogni operando (campo degli operandi) il nome simbolico ed i punti in cui esso & pre-
sente, contraddistinti da numero di blocco e di segmento.

I merker sono celle di memoria interne che possono essere interrogate a bit o a byte
(codice: M). Nei merker vengono memorizzati i risultati intermedi.

Inodisono partecipanti (AG, PG, Server) collegatiad unarete. Essivengono contraddi-
stinti da un nome univoco. Una "via” conduce dal nodo iniziale (per esempio PG/AS
511), tramite uno o piu nodi (per esempio CP), al nodo finale (per esempio CPU in
S5-135U). Ad ogni nodo € associato un indirizzo di rete (numero di nodo).

Numero di 5 cifre per l'identificazione del blocco.
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Serve per l'identificazione del tipo di modulo EPROM/EEPROM utilizzato. Esso € as-
sociato univocamente al numero di ordinazione del modulo stesso. Nel richiamo di
una funzione di elaborazione (per esempio, scrittura), lo STEP 5 richiede il numero
diprogrammagzione e visualizza quindii parametridelmodulo. Cid permette, peresem-
pio, di individuare errori nel cambio di moduli.

In fase di editazione in KOP/FUP, questa funzione (tasto: meta-video) provoca una
riorganizzazione del video con rappresentazione ottimizzata del segmento elaborato,
anche se non tutti gli operandi necessari sono stati definiti.

Argomento diunafunzione di elaborazione selezionabile nelmenu STEP 5" Oggetto”.
Secondo questa definizione un oggetto puo essere:

— un - Progetto, cioé la configurazione elaborativa per un programma appli-
cativo,

— un blocco, cioé un modulo di programma STEP 5 editato e richiamabile,

— un file PCPM che pu0 essere cancellato o convertito in un file
S5-DOS/ST/MT.

Variabile di processo che pu0 essere interrogata (indirizzata) in modo assoluto (per
esempio E 32.0) oppure simbolico (per esempio VALVOLAL).

Gli operandi attuali (lista di parametri nel blocco richiamante) in fase di richiamo di
un FB/FX sostituiscono gli -~ Operandi formali ivi definiti.

Operando parametrizzabile associato ad un’operazione di sostituzione. Nei blocchi
FB/FX I'operazione da eseguire €& definita esclusivamente con operandi formali ai
quali, tramite i riferimenti della - Lista parametri, vengono associati i relativi » Ope-
randi attuali nel blocco richiamante.

Sonodaticheriguardano laconfigurazione interna e le versioni del software contenuto
in AG. Informazioni al riguardo si possono ottenere con la funzione "Test, Info AG".

Tutti i datori di segnali che costituiscono gli ingressi del processo (finecorsa, pulsanti
ecc.) e gli attuatori e visualizzatori (rele, valvole ecc.) che costituiscono le uscite verso
il processo.

Campo di scrittura che in fase di emissione su stampante viene inserita alla fine di
ogni pagina. La piedinatura puo essere larga 80 o 132 caratteri e viene predisposta
in "Imposta, Pagina 2".

Coniltermine ”Progetto” (menu STEP 5) siintende I'insieme dituttiifile STEP 5 gene-
rati per un programma STEP 5 e raggruppati in un file di progetto (*PJ.INI). In questo
file di progetto, che puo essere caricato e memorizzato, sono contenute tutte le infor-
mazioni necessarie per unacomoda elaborazione e gestione del programma applica-
tivo, per esempio impostazioni di parametri ed identificazioni di directory e file.
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Il punto di controllo di sistema costituisce un’interfacciatrail sistema operativo del’AG
ed il programma applicativo. In questo punto viene richiamato I'OB 1. In ogni ciclo,
il sistema operativo dell’AG passa dal punto di controllo di sistema. In quel momento
le variabili di processo rappresentano I'immagine di processo attuale.

Nel punto di controllo di sistema (vedere la figura), con il PG & possibile controllare
e modificare gli stati delle variabili di processo ed eventualmente forzare lo stato di
un segnale su un’unita di uscita.
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Ciclo del programma applicativo
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Durantel’elaborazione delprogrammale variabilidi processovengono variate inmodo
dinamico, e solo dopolaconclusione diunciclovengonotrasmesse dall’AG alla perife-
ria. Per poter seguire I'evoluzione delle variabili durante I'elaborazione del pro-
gramma, gli stati dei segnali delle variabili possono essere emessi in qualsiasi punto
del programma stesso (stato variabili o controllo elaborazione ON).

Sistema OB 1 / PB / FB
opera- Organizza é
tivo del zione dellal A A
controllore elabora- %
program- zione
mabile dei blocchi
S A /' PB /’ FX
A A
SB FB
A A
Blocco Blocco di programma, Blocco

organizzativo (OB) sequenziale (PB, SB) funzionale (FB, FX)

S = punto di controllo di sistema A = punto di controllo utente (libero)

Per ogni livello di elaborazione ed in caso di errore, il programma di sistema dell’AG
introduce nel registro di interruzione alcuni dati che permettono di tornare al livello
di elaborazione del programma interrotto non appena l'interruzione é stata elaborata.

L'introduzione puod essere emessa (Test, Info AG) e contiene l'indirizzo del punto di
interruzione con i contenuti dei visualizzatori ed accumulatori validi in quel momento,
nonché la causa dell’errore.

Funzione che permette di trovare rapidamente operandi, segmenti o indirizzi all'in-
terno di un file programma. Prima di attivare tale funzione, si deve definire in modo
esatto, con lettere maiuscole e minuscole, I'oggetto da ricercare.

La funzione "Gestione, Genera XREF" fa si che lo STEP 5 predisponga in un file pro-
gramma *XR.INI i riferimenti per altre possibilita d’utilizzo di ogni operando. | dati ivi
memorizzati possono essere interrogati dall’editor dei blocchi (tramite F2 = Riferim.),
anche oltre i limiti di blocco.

Stato nel processore in un certo punto del programma che viene utilizzato per ulteriori
elaborazioni di segnali digitali. Il RLC ¢ il risultato di combinazioni logiche oppure di
operazioni di comparazione. Esso puo essere, per esempio, combinato con lo stato
di operandi oppure vengono eseguite operazioni (per esempio salti condizionati) in
dipendenza del RLC attuale. Il RLC si trova nel bit 1 del byte di visualizzazione.

Linguaggio grafico di editazione per blocchi STEP 5 derivato dallo schema elettrico
(DIN 19 39).
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Rappresentazione delle combinazioni logiche di un compito di comando tramite sim-
boli funzionali secondo DIN 49719, parte 6.

Trasferimento di blocco STEP 5 in un modulo EPROM/EEPROM.

Scorrimento del contenuto di una finestra nel box di comando/scelta, tramite il tratto
scorrevole laterale, eseguibile con il mouse nella posizione della finestra desiderata,;
contrassegno del tratto scorrevole: ™",

Unsegmento € unaparte del blocco nellaquale € contenutauna sequenzadicombina-
zioni (almeno una) che realizza una parte del compito, ottenendo unrisultato interme-
dio rilevante per la successiva elaborazione del programma o per 'andamento del
processo. Un segmento puo essere composto genericamente daun numero qualsiasi
di istruzioni. In KOP/FUP il numero delle combinazioni € limitato a 6 o 7 a causa del
reticolo dello schermo del campo di editazione. Un segmento viene sempre chiuso
da " * *”,

Conil pacchetto "Selezione bus” (Editor, Vie bus) & possibile editare ed attivare colle-
gamenti tra il PG ed un altro partecipante a piacere. Tramite una tale "via bus” sono
eseguibili tutte le funzioni STEP 5 valide per un collegamento punto a punto.

Sistema di comunicazione (rete) per I'utilizzo in ambiente industriale secondo IEEE
802.3 (ETHERNET). Possono essere collegati PG, PC ed AG. Un segmento di bus
puo avere fino a 100 partecipanti e puo essere lungo al massimo 500 m. | segmenti
vengono collegati tra di loro tramite repeater. Tra due partecipanti possono esserci
al massimo due repeater.

Sistema di comunicazione (rete) per la creazione in modo semplice di piccoli sistemi
diautomazionelocalidecentralizzati. Possono essere collegatisolo AG. Un AG dichia-
rato "master” organizza il traffico dati sulla rete. Gli altri AG vengono gestiti come
"slave”.

Sistema di comunicazione basato sulle normative PROFIBUS (DIN 19245). Esistono
partecipanti attivi e passivi. | partecipanti attivi possono accedere al bus solo quando
sono in possesso del diritto di trasmissione ("token”). Il passaggio del "token” avviene
secondo un "anello logico” in base agli indirizzi crescenti dei partecipanti. Tramite re-
peater € possibile collegare tra di loro fino a 8 segmenti, ognuno dei quali ha una lun-
ghezza, dipendente dalla velocita di trasmissione, compresa tra 0,2 e ,2 Km.

Visualizzazione dello stato di segnale dei vari operandi (bit 2 nel byte di visualizza-
zione). Lafunzionedistato e unafunzione"Online”eviene selezionatanelmenu” Test".

Panoramica del programma nella quale viene visualizzato il concatenamento dei sin-
goli blocchi a partire dall’lOB (Documentazione, Emissione).

Fornisce informazioni relative all'occupazione dei bit di ogni byte (W, DW) nei campi
di operandi ingressi (E), merker (M) ed uscite (A) (Documentazione, Emissione stan-
dard, Tabella occupazione e Emissione confortevole).

Possono avere un’assegnazione fissa (per esempio il tasto di cancellazione o diinter-
ruzione) oppure essere associati a funzioni variabili ammesse dal software e definite
tramite editor (softkey attivabili tramite i tasti da F1 a F8 oppure tramite il mouse in
relazione ai simboli evidenziati sul margine inferiore del video.
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Tempo di ciclo

Testata del blocco

Wildcards

Glossario-10

Tempo necessario per un’esecuzione completa del programma nella sua elabora-
zione ciclica. Esso determina il tempo di reazione di un AG ad un segnale esterno.

Lo STEP 5 deposita qui (lunghezza 5 DW) I'identificazione iniziale, il numero e il tipo
del blocco ed anche l'identificazione del PG, il numero di biblioteca e la lunghezza
del blocco stesso (compresa la testata del blocco).

* = carattere fittizio per un nome con formato vincolato o per una sequenza di caratteri.

? = carattere jolly, posizione sostitutiva di un carattere.

STEP 5/ST V7.0
C79000-G8572-C920-02



Indice analitico

A

accoppiamento PG, 19-1, 23-1
accumulo di connettori, FUP, &-8
AG
cancellazione iniziale, 4-20
compressione della memotia, 15-2
forzamento, 16-1
informazioni, 16-3
memoria, 16-7
nuovo avviamento, 16-2
suddivisione periferia, 10-2
ANNOTA, 21-25
area blocchi, 4-18
area di memoria alla, 25-4
area di memoria superiore, 25-3
assegnazione tastiera, AWL, A-7
assegnazione tasti
cancellazione, 2-40
funzioni complesse in FUP, 8
funzioni complesse in KOP, 7
limitazione, 2-39
salvataggic, 2-40
selezione lingua, 2-38
stampa, 2-41
assegnazione tastiera, 2-35-2-36, A-2
per S&, 2-35-2-36
assegnazioni dei tasti funzionali in Emissione, 5-6
attivazione, vie bus, 12-2
ausili per I'editazione, lista di attribuzione, 11-9
autorizzazione,, iii

-9
-9

B

barra del titolg, 3-2
barra delle softkey, 21-16
blocchi, A-9
cancellazione, 4-20
cancellazione di un segmento, 5-21
compressione, 4-21
confronto, 4-19
copia, 4-17
copia di un segmento, 5-18
editazione, 5-2
gestione, 4-13
indice, 4-21.
memorizzazione, 6+2
blocchi di programma, 21-23
introduzione, 21-23

STEP 5/ST V7.0
C79000-G8572-C920-02

blocchi speciali, 21-11
verifica, 21-11

blocchi STEP 5, 21-11
completamento, 21-11
modifica, 21-11

blocco dati
corpo del blocco, 9-3
costituzione, 9-2
intestazione, 9-2
intestazione del blocco, 9-2
introduzione, 21-32
introduzione di parole dati, 9-11
numero di biblioteca, 9:3
testata del blocco, 9-3

blocco di commento, 5-15
memorizzazione, 5-15

blocco di documentazione, 5-9
cancellazione testo, 5-9
comanda, 5-10
inserimento testo, 5-9

blocco funzionale, 6-5
corpo del blocco, 6+5
costituzione, 6-5
editazione, 6-6
intestazione blocco, 6-5
introduzione, 21-29
operazioni complementari, 6-5
operazioni fondamentali, 6-5
operazioni simboliche, 65

box di comando, 3{3-9
memoria, 3-11

C

cambio| 19-1
altri,[ 19-1
cambio pagina
commento segmento, 512
lista di attribuzione, 1147
campo di editazione dell’editor DB, 9-5
cancellazione
file DOS, 4-25
riga/elementg, 10-3
cancellazione riga, 9-17
capacita di memoria, 25-5
caratteri di comando, 21-5
#TAB per I'elaborazione di altri filz, 21-12
dell’Editor AWL/Batch-Compiler, 21-13

Indice-11



Indice

caratteri jolly, 4-22
caratteri speciali, 11-7, 21-7
caricamento, 25-5
del pacchetto Editor AWL/Batch-Compiler,
21-13
HIMEM.SYS, 25-5
progetto, 4-12
casella "lunga”
FUP, 8-10
KOP, 7-10
cavi di collegamento, 2-28, 2-29
COM 1| 2-30
COM 2| 2-30
interfaccia V.24, 2-29, 2-3
Koster-Box, 2-30
numero di ordinaziong, 2-30
panoramica, 2-30
chiusura con SHIFT+F4, 4-30
collegamento del PG con AG, 2-27-2-42
collegamento del PG EPROM al PC, 2:30-2-42
collegamento del prommer esterno al PC, 2-30
comandi, 18-22
comandi DOS CTRL+F1%-30
comando del cursore, 2-36
comando Include, 21-6
Command mode, 5-10
key strokes, 5-10
commenti aggiuntivi, lista di attribuzione, 11-6
commento, istruzioni, 6+3
commento blocco, memorizzare, 9-9
commento impianto, 5-8
commento operanco, 11-2, 11-6
numero dei caratteri, 11-2
commento segmento, 5-12
cambio pagina, 5-12
cancellazione caratteri, 5-14
conclusione, 5-14
inserimento carattefi, 5-13
memorizzazione, 5-14
numero dei caratteri, 5-12
commutazione del controllore da STOP a RUN,
22-30
compressione, di blocchi, 4-21
compressione memoria AG, 16-2

configurazione del video, lista di attribuzione, 11-4

configurazione della memorija, 16-7
configurazione memoria, 16-3
confronto, dei blocchi, 4-19

Indice-12

connettore

cancellare, 8-8

editazione, 8-8

FUP, 8-8

inserimento, 8-8

KOP, 7-8

negato, FUPR, 8-8

negato, KOPR, 7-8
contatto, inserimento, 7-5
contenuto della fornitura, 1-1
controllo del programma, 24-20
controllo elaborazione OFF, 15-17
controllo elaborazione ON, 15-16
convenzioni di scrittura, delle istruzioni STEP 5,

21-20
conversione

FUP, 8-16

KOP, 7-16
copia

di blocchi, 4-17

di file DOS/ 4-24
copia pool di dati, 2-17
corpo del blocco, 6-5, 9-3

blocco dati, 9-3

blocco funzionale, 6-5
correzione, file simbolico, 17-13
creazione, di blocchi STEP, 5, 2.-3
creazione di blocchi

con il pacchetto KOP, FUP, AWL, 21-11

con l'editor AWL| 21-11

D

denominazione dei tasti, 2-39, 2440
directory, emissiong, 4-23

directory di progetto, 4-10

directory di Windows, introduzione, 2-11
disattivazione, vie bus, 12-2

disco fisso, 1-1

disposizione dei connettori, interfaccia TTY attiva,

2-31
domanda di sicurezza, 15-7
drive di destinazione, modifica, 2-9
drive/indice, 4-23
DX 0
per AG 135 U, pagina |2, 10-5
per AG 155 U, pagina 2, 10-7

STEP5/ST V7.0
C79000-G8572-C920-02



Indice

E

editazione, 9-7, 21-15, 22-24, 24-11
blocchi funzionali, 24-11
campo, 21-15
commento blocco, 9-7
dei parametti, 22-24
funzioni,| 21-4
istruzioni di comando, 18-25
lista di attribuzione, 111
lista istruzioni, 6-1
lista operandi, 15-8
maschere DB, 10-1
operandi simbolic|, 8-5
piedinatura, 14-2
richiamo del modo editazione, 21-15
riga d’intestazione, 21-15
schema a contatti, 7-1
schema logico, 8+1
vie bus, 12-3
editor, interfaccia operatore grafica, 5-2
Editor AWL/Batch-Compiler, 21-1
caratteri di comando, 21-18
ciclo di verifica, 21-2
conferma, 21-2
editazione, 21-2
modifica, 21-2
traduzione, 21-2
traduzione a ritroso, 21-2
verifica, 21-2
Editor di tastiera, 2-33
Editor di tastiera per PC, menu, 2-37
elaborazione di stato
azioni, 15-6, 15-11
concatenamento di blocco, 15-4
limitazioni, 15-3
rappresentazione della maschera in AWL, 15-5
rappresentazione dello stato dei segnali, 15-4
richiamo, 15-4
segnalazioni, 15-6, 15-11
elementi funzional|, 7-2
elementi operativi3-4
hotkey, 3-4
interfaccia operatore, 3-4
macrodefinizione dei tasti, 3-4
tasti della barra delle funzioni, 3-5
emissione, 22-27
del DB 1 su stampante, 22-27
di directory, 4-23
file protocollo, 18-31
lista errori, 18-30, 21-11, 21-36
sul video, 4-16

STEP5/ST V7.0
C79000-G8572-C920-02

emissione confortevole, 18-11, A-13
file di testo, 18-19
lista di attribuzione, 18-14
lista di blocch|, 18-13
lista di controllg, 18-19
lista incrociata, 18-16
tabella di occupazione, 18-17
emissione standard, 18-2, 13-3
blocchi dati, 18-5
blocchi STEP 5, 18-5
lista di attribuzione, 18-6
lista incrociata, 18-8
maschere DB, 18-6
struttura programma, 18-6
tabella occupaziong, 18-9
EMM386.EXE, 25-5
EPROM, 17-2
"scrittura”, 17-2
cancellazione, 17-5
confronto, 17-6
elabora, A-11
Em-SISID, 17-6
indice, 17-6
Info-E, 17-5
Int-SISID, 17-€
lettura) 17-5
NUM.PROGR,, 17-4
numero di programmazione, 17-4
parametri, 17-5
parametrizzazione funziore, 17-3
scrittura, 17-&, 17-5
errori in editazione, lista di attribuzione, 11-8
esempio, lista di attribuzione, 11.-8
esempio di configurazione, MS-DOS 5.0, ottimiz-
zazione, 2-23
esempio di parametrizzazione di DB1 con il COM
DB1, 22-18
espansione della memoria, 25-2
extended memory, 25-2

F

fattore di ripetizione, 21-27
vedere editor di blocco dati, 9-15
file, 4-2
file di sistema, 4-3
file di testo, emissione confortevole, 18-19
file DOS,4-22|A-9
cancellazione, 4-25, A9
copia, 4-24, A-9
directory, A-S

Indice-13



Indice

file intermedio, 21-8
file intermedio A1.SEQ, 21-8
file istruzioni di comando, 4:9
file PCP/M,4-26
cancellazione, 4-30, A9
copia, A-9
DOS — PCP/V, 4-29
PCP/M —> DOS, 4-28
directory| A-S
emissione di directory, 4-27
file piedinatura, 4-9
file programma, 4-7, 21-11, 23-4
verifica, 21-11
file protocollo, 18-31
emissione, 18-31
file PX.INI, 4-12
file sequenziale, cancellazione, 17-15
file simbolico, 4-3, 4-3
file sorgente, cancellazione, 17415
file sorgente (*20.SEQ), 4-8
file sorgente AWL, 21-8
file sorgente sequenziale, 11-2
conversione, 17-12
salva, 11-5
file stampante, 449
file STEP 5
funzioni, 25-10
funzioni speciall, 25-10
file SYSID| 4-11
file via,| 4-6
vie bus, 12-2
finestre di dialogo, introduzione, 3-8
flusso dati, editor di tastiera, 2-34
formato, del file sorgente sequenziale dell’editor,
21-12
formato dati
forzamento uscite, 15-14
modifica, 9-11
forzamento uscite, 15-14
formato dat|, 15-14
forzamento variabili, 15-12
funzionamento multiprocessore, 10-2
funzione, 21-27
CANCELLA,| 21-26
CERCA| 21-26
COPIA| 21-26
richiamo,| 3-6
SOSTITUISCI, 21-27
funzioni) 21-4
della barra delle softkey EDITA, 21-16
funzioni ausiliarie del COM DB, 22:4
funzioni complesse
assegnazione tasti in FUP, 8-9
assegnazione tasti in KOP, 7-9
FUP, 8-10
KOP, 7-10

Indice-14

funzioni del COM DB1, 22-2

funzioni di documentazione, 18-2
hardcopy, 18-2
istruzioni di comando per emissione conforte-

vole, 18-2

funzioni di memorizzazione, 21-28
CONFERMA| 21-28
SALVA, 21-28

funzioni speciali, 21-3, 21-38
CANC-SEQ, 21-39
CANC-zZWI, 21-39
COPIA| 21-38
GEN-SIMB, 21-40
per I'elaborazione di file intermedi, 21-38
per I'elaborazione di file sorgenti, 21-38
SEQ>ZWI 21-38
VERIFICA, 21-39
ZWI>SEQ)| 21-39

funzioni STEP &, 3-2

FUP, 8-1
accumulo di connettori, 8-8
connettore, 8-8
funzioni complesse, 8-10
inserimento di operandi, 8-7
inserimento di un elemento funzionale, 8-8
operazioni combinatorie, 8-4
operazioni combinatorie digitali, 8-18
operazioni di caricamento e trasferimento, 8-14
operazioni di comparazione, 8-16
operazioni di memorizzazione, 8-15
operazioni di shift e di rotazione, 8-14
operazioni di temporizzazione, 820
suddivisione del video, 8-2

G

generazione XREF, 17:-2
gestione, dei blocchi, 4-13
gestione memoria, 25-2
ordine dei driver, 25-5
gestore di memoria
EMM386, 25-4-25-6
HIMEM.SYS, 25-4

H

hardkey, 21-17
Help,/ 3-3
help online, 3-7

richiamo, 3-7

temi, 3-7
help relativo al contesto, 3-7
High Memory Area, 25-4
HIMEM.SYS,| 25-4-25-6

STEP5/ST V7.0
C79000-G8572-C920-02



Indice

identificazione del sistema, 4411
identificazione progetto, 3-3
immagine di processo, 15-12
impostazione, 13-1

del progettc, 4-4

piedinatura, 14-2

vie bus, 12-3
Include, comando, 216
indice, 4-13

dei blocchi, 4-13
indirizzi assoluti, numero, 16-6
indirizzi AWL, 4-7
indirizzo, visualizzazione, 63
indirizzo Ethernet, vie bus, 12-4
info AG, A-11
Info versione STEP 5, 20-2
informazioni dettagliate, 2-:6
informazioni di prodotto, 1-1
informazioni sull’'uso,20-4
inizio blocco, 21-24
inserimento, riga/elemento, 10-3
inserimento riga, 9-17
installazione/ iii, 2-1, 2-9, 2-32, 25-5

conclusione, 2-13

dei driver per STEP 5, 2-32

di EMM386.EXE| 25-5

di STEP 5 in Windows, 2-20

esecuzione, 2-12

home, 2-17

personalizzata, 2-14

personalizzata dal server, 2:15

standard, 2-9
integrazione Windows, 2-10
interconnessione, 17-7

manuale, 17-8

protocollo di stampa, 17:9
interfaccia, 4-5

AG, 2-27

AG-S5| 2-27

AS 511/ 4-5

COM, 2-28

TTY, 2-28 23-2
interfaccia attiva, TTY, 23-2
interfaccia operators-1

finestre di dialogo3-8
interfaccia passiva, TTY, 23-2
interfaccia stampante, 4-9
interfaccia TTY

attiva, 2-28

disposizione dei connettori, 2-31

interfaccia utente, editor di tastiera, 2-37

interfaccia V.24, 2-23, 2-29, 23-2

STEP5/ST V7.0
C79000-G8572-C920-02

intestazione blocco, 4-17, 6-5, 9-2, 9-9

blocco dati, 9-2

blocco funzionale, 6-5

influenza sulla lunghezza, 9-9
intestazione blocco dati, 4-17
introduzione

blocchi dati, 21-32

blocchi di programma, 21-23

blocchi funzionali, 21-29

di istruzioni STEP 5 con altri Editor, 21-12

finestre di dialogg, 3-8
istruzioni

commento, 6-3

correzione, 6-2

introduzione, 6-2
istruzioni di comando, 18-20

editazione, 18-25

emissione lista errori, 18-30

esecuzione, 18-31

lista errori, 18-30

stampe, 18-31

struttura, 18-20

verifica, 18-30

K

KOP, operazioni combinatorie, 7-4
Kdster-Box, 2-28

L

linguaggio, 21-14
lista assegnazione tasti, 20-2
lista blocchi, 4-18
lista degli operandi
blocco immagine, 15-8

numero di variabili di processo, 15-10

Indice-15



Indice

lista di attribuzione, 4-8, 17-11
ausili per I'editazione, 119
blocchi immagine, 11-3
cambio pagina, 117
commenti aggiuntivi, 11-6
commento operanclo, 11-1, 11-6
configurazione del videp, 11-4
correzione, 17-13
emissione confortevole, 18-14
emissione standard, 18-6
errori in editazione, 118
esempig, 11-8
funzioni di editazione, 11-9
generazione, 11-6
gestione, A-12
inserimento righe, 11-14
modifica, 11-14
panoramica dei tipi di operandi, 11-3
sigla operando, 118
tasti funzionali, 11-4
tasti funzionali programmabili, 11-13
zona di editazione, 11-4
lista di blocchi, emissione confortevole, 18-:13
lista di controllo, emissione confortevole, 18-19
lista errori, 21-11
cancellazione, 17-15
emissione, 18-30, 21-11, 21436
lista incrociata, 4-7
emissione confortevole, 18-16
emissione standard, 18-8
visualizzazione, 5-22
lista operandi
editazione, 15-8
formato dat/, 15-12
lunghezza commento, 4-8
commento operando, 11-6
lunghezza del blocco, blocco dati, 9-3
lunghezza del commento, commento operando,
11-2
lunghezza dell’'operando, 11-2
operando simbolico, 11-2
lunghezza simbolico, 4-8

M

macrodefinizione dei tasti, A-15
maschere DB, 10-1
DB1,/10-2
DX 0, 10-4
DXO0, 10-6
emissione standard, 18-6
introduzione DB, 10-7
introduzione dei dati, 10-3
S5-135U, 10-1
S5-155U, 10-1
memoria, 3-13

Indice-16

memoria cache, 25-6

memoria convenzionale, 25-4

memoria di lavoro, organizzazione, 25-3-25-4

memoria di lavoro convenzionale (RAM), 25-2

memoria estesa, 25-4

memorizzazione del DB1 in un file di programma
STEP &, 22-29

Memory Cards SIMATIC, EPROM, 17-4

menu, 3-2

merker di accoppiamenio, 10-2

messaggi, 4-10

modalita operative dell’Editor AWL/Batch-Compi-
ler| 21-2

modifica
del drive di destinazione, 2-9
di un file sorgente AWL,, 21-33

modifiche del programma, 24-20

modo file, 4-7

modo modifica, 4-5

N

nodi, vie bus, 12-4
nodo di start, vie bus, 12-4
nome via, 4-6
vie bus, 12-2
NUM. PROGR., EPROM, 17-4
numeri in virgola mobile, 9-12
blocco dati, 9-16
test| 9-16
numero di biblioteca, 5:7
blocco dati, 9-5, 9-7
numero di programmaziorie, 17-4

O

oggetto, A-8
operandi attuali, 645
operandi formali, 6-5
operandi simbolici, editazione, &-5
operando
assoluta, 5-26
formale, 6-5
ricerca, 5-26, 11-11
simbolico, 5-27
operativita
parametri stampante, 13-2
piedinatura, 14-2
scelta blocco, 3-16
operazione di rotazione, FUP, 8:14
operazione di shift, FUP, 8-14
operazione di temporizzazione, FUP, §-20
operazioni, alla fine dell'installaziore, 2-13

STEP5/ST V7.0
C79000-G8572-C920-02



Indice

operazioni combinatorie richiamo
FUP, 8-4 dell’help online| 3-7
KOP, 7-4 delle funzioni| 3-6
operazioni combinatorie digitali, FUP, 8{18 richiamo delle funzioni di hel3-7
operazioni complementari, 6-5 richiedere guida, 216
operazioni combinatorie digitali, 8-18 riga d'intestazione, editazione, 21415
operazioni di shift e di rotazione, 8-14 riga di fondg, 21-16
operazioni di caricamento, FUP, 8:14 riga di informazione, 3-3
operazioni di comparazione, FUP, 8-16 riga/elemento
operazioni di conteggio, KCP, 8-18 cancellazione, 10-3
operazioni di conversione, 8-16 inserimento, 10-3
operazioni di memorizzazione, FUP, 8-15 risultato logico combinatorio, 7-16, 8-16

operazioni di trasferimento, FUP, 814
opzione via, 4-6
organizzazione della memoria, esempio PC, S

-3-- -/
(25-3125-4 , . s SALVA (F7), 21-25
ottimizzazione dell'accesso al disco fisso, 25-6 |
salvare come, progetto, 412

salvataggio, del progetio, 4-12

scelta
P blocchi, 4-18
pacchetti S5, cambio, 19-1 lista blocchi, 4-14
pacchetto Editor AWL/Batch-Compiler, carica- scelta blocco, 3-33-16
mento, 21-13 operativita,3-16
parametri della stampante, box di dialogo, 13-3 scelta della lingua di dialogo, 2-8
parole dati scelta directory, 3-14
duplicare, 9-15 scelta file| 3-8 3-14
introduzione, 9-11 scelta funzioni3-6. 21-15
PG link, 23-2 schede3-12| 25-2
piedinatura, editazione, 14-14-2 AG, 4-5
PREDISPOSIZIONE, maschera, 21-13 aggiuntiva, 25-2
predisposizione della tastiera|S5, 2-35-2-36 Blocchi, 4-7
predisposizioni, PG link, 23-4 Documentazione, 4-9
progetto EPROM, 4-11
caricamento4-12 Opzioni/ 4-10
creazione e modifica-1 Simbolico, 4-8
impostazione, 4-2, 4-4 schedario, 3-8
oggetto, A-8 uso| 3-12
salva come, 4-12 schema a contatti, 7-1
salvataggig4-12 connettore, negato, 7-8
struttura, 4-2 connettori, 7-8
programmi standard, 21-10 funzioni complesse, 7-10
prommer, 2-30 inserimento di contatti, 7-5
prommer parallelo, 2-30 operazioni di conteggio, 8-18

suddivisione del video, 7-2
schermo, commutazione colore/bianco e nero, 2-41
R scrittura, EPROM, 1742
scrittura maiuscola/minuscola, 21427

rappresentaziong, 4-7 segmento, 5-15

cambio, 5-7

REG.BL., emissione, 16-5 ngsgfjon \ 5-21
REG.INT., emissione, 16-3 e
copia, 5-18

registro d’interruzione, 16-3
requisiti hardware, accoppiamento PG, 23-2
ricerca, 5-26

lista di attribuzione, 11-11

spostamento, 5-21
trasferimenta, 5-21
segnalazioni di errore, 21-41

STEP5/ST V7.0 ,
C79000-G8572-C920-02 Indice-17



Indice

selezione lingua, assegnazione tasti, 2-38
set di caratteri, 449
sigla della lunghezza, 2-28, 2-29, 2-30
sigla operando, 11:8
simboli} 21-22
SINEC H1| 15-1
SINEC L1] 12-1
SINEC L2| 15-1
sintassi delle istruzioni di comando
indice del contenuto, 18-23

istruzione di comando con annidamento, 18-23

SMARTDRV.SYS 25-6
software, fornitura sul PG, 1-1
sostituzione sequenza di caratteri, 21-27
sovrascrittura, nome file, 21-14
stampa, 21-7, 21-3
layout, 21-7, 21-37
struttura, 18-34
stato Blocco, 15-3
stato di segnale
emissione, 15-7
operando, 15-7
rappresentazions, 15-4
stato variabili, 15-7
struttura
editazione, 18-32
esempio logico, 18-20
istruzioni di comando, 18-20
stampe, 18-34
struttura programma
emissione confortevole, 18-15
emissione standard, 18-6
suddivisione del video
FUP, 8-2
KOP, 7-2
suddivisione periferia, 10:2

T

tabella occupazione, 18-9, 18-17
emissione confortevole, 18-17
emissione standard, 18-9

tasti funzionali, 2-36, 13-4
lista di attribuzione, 114
programmazione, 114, 11-13

tasti specialj, 21-17

tastiera, A-2
comando del cursore, 2-36
comando del cursore MFII, 2-36
tasti funzionali, 2-36
tasti funzionali MFII, 2-36

Indice-18

tastiera MFII, 2-36
tastiera PG, 2-40
test, richieste, 15-2
testata del blocco, 9-3
blocco dati, 9-3
lunghezza, 9-3
numero di biblioteca, 943
tipi di blocchi, 4-18
tipi di installazione, 2-8
tipi di operando, 11-3
tabella] 11-3
tipo AG, 4-5
tipo di funzionamento
dinamico, 4-5
offline,|4-5
online,| 4-5
tipo prommer, 4-11
titolo del blocco, 9-9
titolo segmento, 5-15
lunghezzs, 5-15
traduzione, 21-5
a ritroso di un file programma, 21-6
con la funzione Compiler, 21-34
in un file programma, 21-34
creazione di un file programma, 21-6
verifica durante la traduzione, 21-7
trasferimento di DB1 nel controllore, 22-28
trasferimento di file, 24-16
TTY
interfaccia attiva,, 23-2
interfaccia passiva, 23-2

U

UMB, Upper Memory Blocks, 25-4
uso
dello schedario, 3-12
PG, 21-13
utilizzo della lista di softkey EDITA, 21-25

\%

variabili, modifica, 15-12

variabili di processo
emissione, 15-10, 15-13
operando, 15-7

verifica, 21-11
blocchi speciali, 21-11
file programma, 21-11

STEP5/ST V7.0
C79000-G8572-C920-02



Indice

versione, in lingua straniera di un programma STEP Z
5, 21-10
versione pacchetti S5, 20-2
vie bus, 12-1
attivazione, 12-3
cancellazione, 12-3
disattivazione, 12-3
editazione, 12-3, 12:4
impostazioni, 12-3
indice, 12-3
nodo di start, 12-4
scelta, 12-3
stampa, 12-3
tutte vie, 12-3
via attuale, 12-3

zona di editazione, lista di attribuzione, 11-4

STEP5/ST V7.0 .
C79000-G8572-C920-02 Indice-19



Siemens AG
AUT E 146
Ostliche Rheinbriickenstr. 50

D-76181 Karlsruhe
Repubblica federale di Germania

Mittente :

Indicare il corrispondente settore industriale:

Industria automobilistica Industria farmaceutica

Industria chimica Industria delle materie plastiche

Industria elettrotecnica Industria cartaria

O 0O 0o O

Industria alimentare Industria tessile
Tecnica di controllo e strumentaziorié Impresa di trasporti

Industria meccanica O Altre

O oo0oo0oooo

Petrolchimica

STEP 5/ST V7.0
6ES5998-0MA54-02 1



Critiche/suggerimenti

Vi preghiamo di volerci comunicare critiche e suggerimenti atti a migliorare la qualita
e, quindi, a facilitare l'uso della documentazione. Per questo motivo Vi saremmo grati
se vorreste compilare e spedire alla Siemens il seguente questionario.

Servendosi di una scala di valori da 1 per buono a 5 per scadente, Vi preghiamo di
dare una valutazione sulla qualita del manuale rispondendo alle seguenti domande.

Corrisponde alle Vostre esigenze il contenuto del manuale? D
E facile trovare le informazioni necessarie? D
Le informazioni sono spiegate in modo sufficientemente chiaro? D
Corrisponde alle Vostre esigenze il livello delle informazioni tecniche@

a kN

Come valutate la qualita delle illustrazioni e delle tabelle? D

Se avete riscontrato dei problemi di ordine pratico, Vi preghiamo di delucidarli nelle
seguenti righe:
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